
Board of Education Regular Meeting 
Monday, August 14, 2023 7:00 PM

District Office
410 South St

Seward, NE 68434

Agenda

1. Preliminary Procedures
1.1. Call meeting to order & announce Open Meetings Act is Posted
1.2. Public Notice as publicized per board policy
1.3. Roll Call

1.3.1. Action to excuse board members if necessary
1.4. Pledge of Allegiance
1.5. 1.5 Mission      The school district of Seward--where every student, every day is 

a success--affirms that all students will have the skills to become productive and 
contributing members of a global community.  In cooperation with family and 
community members, the district is committed to the development of each 
student academically, emotionally, socially, and physically.

1.6. Approval of Agenda
2. Public Forum: (The Board President reserves the right to place time limits on individuals 

and topics.)
2.1. Public Forum on Agenda Items: This is your opportunity to speak to items on the 

agenda. If you are not a part of the presentation of the agenda item you need to 
speak now. Thank you for your participation.

2.2. Public Forum on Any Topic: This is your opportunity to speak to any topic 
concerning the school district. Since it is not an agenda item the board cannot 
discuss or take action at this time on the matter. Future discussion can be requested 
as an agenda item. Thank you for your participation.

3. Public Hearing on Parent Involvement Policy 5018 and request input from the public in 
regard to potential policy changes

4. Reports
4.1. Administrator Reports

4.1.1. Superintendent's Report 
5. Discussion Items

5.1. Budget Discussion with Revenue Cap
5.2. Summer School Summary 
5.3. Externships 

6. Action Items 
6.1. K-12 Language Arts Standards Adoption 
6.2. Second Reading of New and Revised Policies 
6.3. Parent Involvement Policy 5018
6.4. Bullying Policy 5054 
6.5. 5001 Attendance and Excessive Absenteeism Policy 

7. Future Agenda Items
8. Consent Agenda

8.1. Approval of Minutes



8.2. Approval of Financial Reports
8.2.1. Treasurer
8.2.2. Budget
8.2.3. Activities
8.2.4. Athletic

8.3. Approval of Claims
8.3.1. General Fund
8.3.2. Special Building Fund
8.3.3. Depreciation Fund
8.3.4. Unemployment Fund

8.4. Approval of Consent Agenda
9. Adjournment
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5018 
Parent and Guardian Involvement In Education Practices 

 
The school district recognizes the importance of parental and guardian 
involvement in the education of their children.  The school district will take 
the following steps to ensure that the rights of parents and guardians to 
participate in the education of their children are preserved. 
 
1. Parents/Guardians will be provided access, as described in district 

procedures, to district-approved textbooks and other curricular 
materials and tests used in the district upon request. 

 
a. A parental request to review specific approved textbooks and 

other district- or building-approved curricular materials (written, 
visual, and audio) should be made to the principal of the building 
where the textbooks and curriculum materials are used.   

b. Parents may check out textbooks and may review curricular 
materials such as video and audio recordings within a time frame 
determined by the building principal to prevent disruption of the 
instructional process.   

c. A parental request to review specific standardized and criterion- 
referenced tests used in the district should be made in writing to 
the building principal.  Copies of the most recent tests used in 
the district will be available for parent review.  Parents wishing 
to review statewide assessments will be provided with sample 
questions and a copy of a practice test, but will not be provided 
with copies of the actual assessment due to testing security.  In 
the case of other secure tests such as the ACT, parents must 
contact the publisher to obtain copies of the test. 

 
2. Parents/Guardians will be permitted, within district procedures, to 

attend and observe courses, assemblies, counseling sessions, and 
other instructional activities. 

 
a. Parents/guardians are invited to make appointments with the 

building principal to visit classes, assemblies and other 
instructional activities.  The principal shall give permission after 
determining that parental/guardian observation would not 
disrupt the activity.  Observations that last more than 60 
minutes or occur on consecutive days are typically disruptive and 
will not be permitted absent unusual circumstances, in the sole 
discretion of the building principal.  
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b. Parents/guardians may contact the building principal to request 

permission to attend counseling sessions in which their child is 
involved.   

 
3. Parents/guardians will be permitted, within district procedures, to ask 

that their children be excused from school experiences that parents 
find objectionable. 

 
a. Building principals may excuse a student from any single school 

experience at the parent's written request.   
 

b. When appropriate, alternative experiences will be provided for 
the student by the school. 

 
4. Parents/guardians will be informed through the student handbook and 

district policies of the manner that the district will provide access to 
records of students. 

 
5. Parents/guardians will be informed of the standardized and criterion-

referenced district testing program.  Parents may request additional 
information from the building principal. 

 
6. Parents/guardians will be informed of the circumstances under which 

they may opt-out of state and federal assessments.  
 

a. In accordance with federal law, at the beginning of the school 
year, the District shall provide notice of the right to request a 
copy of this policy to parents/guardians of students attending 
schools receiving Title I funds. The District will provide a copy of 
this policy to a requesting parent in a timely manner. 
 

b. State Assessments 
 

State and federal law simultaneously require students to take 
state assessments, with few exceptions, but also permit parents 
or guardians to request to opt their students out of these 
assessments.  Approval of opt out requests is contrary to the 
mandatory testing laws, so the District cannot “approve” the 
request.  Parents who do not present their child for testing will 
result in the child receiving the lowest score possible on the 
assessment. 
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c. National Assessment of Educational Progress 

 
As a condition of receiving federal funds, the District participates 
in the National Assessment of Educational Progress (NAEP).  To 
help ensure that the District has a representative sample of 
students taking the NAEP, which will allow the District to assess 
the quality and effectiveness of its programming on a national 
level, the District strongly encourages all eligible students to 
participate. However, student participation in NAEP is voluntary. 
 
The District shall provide parents/guardians of eligible students 
with reasonable notice prior to the exam being administered.  
Parents/guardians wishing to opt their students out of the NAEP 
assessment must notify the district in writing at least three days 
prior to the exam date to ensure that the District can coordinate 
supervision and alternative activities for students who have 
opted out. 

 
7. Parents/guardians will be notified of their right to remove their 

children from surveys prior to district participation in surveys. 
 

a. The principal must approve all surveys intended to gather 
information from students before they are administered to 
students.   

 
b. Students’ participation in surveys is voluntary.  

Parents/guardians may restrict their child from participating in 
any survey. 

 
 
Adopted on: June 14, 2010 
Revised on: August 15, 2017, November 9, 2020 
Reviewed on: ________________________  
 























On June 22, 2023, Mr. Axt and nine HS teachers, and one elementary staff member joined the
Seward Chamber of Commerce on a tour of four Seward businesses.

The first stop of the day was at Memorial Hospital. The group was given a tour of the entire
facility by Mr. Roger Reamer (CEO) and Mr. Corey Mann (Director of Human Resources). After
the tour, Mr. Reamer and Mr. Mann shared some excellent information on the hospital and the
challenges that they are facing in filling positions, and their recruitment strategy. The visit
concluded with a question and answer session on how we could collaborate going forward.

The second stop of the day was a tour and round table discussion with Max Wake and Michelle
Spahr of Jones Bank. Mr. Wake gave us a historical background of the business and explained
the goals and objectives for the business. There was a very good discussion at the end of the
visit about our business curriculum at SHS and the skills that the bank was looking for in their
employees.

The group then headed south of town for a visit to Seward Motor Freight. The group had a
working lunch as they were very kind and provided lunch for all of our staff. We had a great
presentation from several members of the Seward Motor Freight team everywhere from the
mechanic shop to accounting. They gave us a full background of their business and they
shared some great information with our team. Our group as a whole did not have much
knowledge about the business and the challenges they were facing. We all knew there was a
shortage of drivers but we were very surprised to hear that they couldn’t hire drivers due to
insurance until they were 23.

This was frustrating for the business as it was hard to attract candidates from a younger age
and they told us that they usually saw younger drivers interested after they had failed in a
couple of different career moves before they could hire them. Both sides agreed how this put
them at a disadvantage in attracting recent school graduates.

They gave us a complete tour and shared all details of the operations and qualifications, salary,
and benefits for their employees. We ended the visit by taking a close look at one of their
newest trucks and many of the group had a good time climbing in the truck and getting behind
the wheel for a quick picture.

The last stop for the day was at Laminated Wood Systems. It would be fair to say that nearly all
of the group had yet to learn that this business existed West of La Cretta. We were greeted by
several members of their team and given a tour of the facility. They showed us several of their
products including their new prototype of an underground support system for city streets. It was
really interesting to see the design process. They did a great job of answering all questions and
we found that there were many different types of positions at the facility from linemen to sales to
architectural design and drafting.

Overall, it was a great experience for our team and all of the team was thankful for the
opportunity. It gave them tremendous insight into more of the career opportunities for people in



the Seward community. We also thought it was beneficial for the business partners as they had
good questions and learned quite a bit about our school and the programs that we offer our
students. They were all very impressed with the opportunities that we provide for our students
and it sparked good conversations about potential job shadowing opportunities, possible
internships, speaking opportunities, and knowledge of skills/training that our local employees
value.



Beliefs and Philosophy

We believe in an aligned and scaffolded curriculum K-12.

We believe that language arts instruction should be standards based.

We believe language arts curriculum should equip all students to communicate effectively and develop critical thinking skills in order to be successful, productive members of society. (college and career readiness)

We believe in fostering an appreciation of reading and writing in each student in all curricular areas

The purpose of our K-12 language arts curriculum is to prepare students with the necessary skills in reading, writing, speaking, and listening to communicate effectively in their world.

Priorities after reviewing standards and Science of Reading

Strong Foundational program, ideally with little supplementing needed,
Strong background knowledge, vocabulary building program
A balance of Fiction and Non-Fiction
Writing instruction that supports reading instruction
Dedicated grammar Resources



K

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master
Concepts of Print
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LA.K.F.1

Demonstrate knowledge of the 
organization and basic concepts of 
print.

Teacher’s Edition Unit 1: T480, 520, 522 Unit 2: 508, 510 Unit 3: T60, 346, 496, 498 
Unit 4: T496, 498 Unit 5: T498, 500

Students will demonstrate 
basic concepts of print.

knowledge, concepts of 
print Introduce

LA.K.F.1.a

a. Identify all upper and lowercase 
letters of the alphabet in isolation and in 
connected text. Teacher’s Edition Unit 1: S43, S73 Unit 4: T456 Unit 5: T146, 216, 458

Students will demonstrate 
basic concepts of print.

knowledge, concepts of 
print Introduce

LA. K.F.1.b

b. Recognize that spoken words are 
represented in written language by 
specific sequences of letters, and that 
print carries meaning.

Teacher’s Edition Unit 1: S52, S82, T260, 280, 302, 384, 444 Unit 2: T110, 280, 290, 
436, 446 Unit 3: T184, 300, 308, 378, 386, 456, 464 Unit 4: T60, 68, 138, 184, 224, 278, 
300, 346, 434, 464, 494 Unit 5: T224, 280, 310, 348, 358, 388, 426, 436, 466, 496

Students will demonstrate 
basic concepts of print.

knowledge, concepts of 
print Introduce

LA.K.F.1.c

c. Demonstrate understanding that 
words are separated by spaces in print; 
demonstrate understanding of one-to- 
one correspondence between voice 
and print.

Teacher’s Edition Unit 1: S94; T118, 260, 432, 434, 446, 456, 468, 508, 520 Unit 2: T50, 
58, 90, 120, 132, 508 Unit 3: T8, 28, 38, 60, 358, 496 Unit 4: T28, 496 Unit 5: T172, 
336, 414, 498

Students will demonstrate 
basic concepts of print.

knowledge, concepts of 
print Introduce

LA.K.F.1.d

d. Demonstrate knowledge that print 
reads from left to right, top to bottom, 
and page by page.

Teacher’s Edition Unit 1: S34, S64; T28, 38, 110, 120, 140, 202, 222, 310, 324, 362, 384, 
392, 406, 454, 466, 480, 488, 518, 522, 523 Unit 2: T38, 72, 120, 146, 154, 202, 288, 
290, 338, 358, 368, 390, 398, 468, 506, 510, 511 Unit 3: T68, 106, 116, 138, 146, 194, 
216, 224, 424, 494, 498, 499 Unit 4: T86, 146, 308, 378, 424, 494, 498, 499 Unit 5: T60, 
68, 138, 302, 328, 380, 496, 500, 501

Students will demonstrate 
basic concepts of print.

knowledge, concepts of 
print Introduce

Phonological Awareness 

LA.K.F.2

Demonstrate understanding of spoken 
words, syllables, and sounds 
(phonemes).

Teacher’s Edition Unit 1: S14, S20, S26, S44, S50; T14, 42, 56, 102, 108, 130, 138, 149, 
156, 190, 212, 231, 238, 278, 300, 318, 319, 326, 360, 382, 401, 408, 450, 464, 483, 490 
Unit 2: T26, 48, 56, 66, 67, 74, 108, 130, 138, 149, 156, 190, 231, 238, 286, 300, 315, 
322, 350, 356, 364, 372, 392, 393, 400, 434, 442, 471, 478 Unit 3: T26, 34, 63, 70, 104, 
112, 141, 148, 182, 190, 219, 226, 274, 288, 303, 310, 344, 352, 381, 388, 422, 430, 438, 
459, 566 Unit 4: T 34, 48, 54, 63, 70, 112, 141, 148, 182, 190, 226, 266, 274, 310, 344, 
352, 388 Unit 5: T26, 34, 48, 54, 63, 70, 104, 112, 126, 132, 141, 148, 182, 190, 219, 
226, 268, 276, 305, 312, 340, 346, 354, 362, 382, 383, 390, 432, 440, 460, 461, 468

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

LA.K.F.2.a

a. Segment and count spoken 
sentences into words. Teacher’s Edition: Start Smart: S14, S20, S26 Unit 3: T18 Unit 4: T350, T372, T392

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

LA.K.F.2.b

b. Recognize and begin to produce oral 
rhymes.

Teacher’s Edition Unit 1: T102, 124, 148, 208, 478, 493, 497, 533 Unit 2: T20, 42, 66, 
428, 450, 470 Unit 3: T44, 46, 198, 284, 360, 458 Unit 4: T44, 46, 98, 102, 120, 140, 
338, 360, 380 Unit 5: T98, 120, 140

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

LA.K.F.2.c

c. Count, produce, and segment 
spoken words into syllables and identify 
syllable parts.

Teacher’s Edition Unit 1: S74, S80, S86, S92, S96; T436, 458, 482 Unit 2: T184, 206, 
230 Unit 3: T20, 42, 62 Unit 4: T282, 302, 416, 438, 458 Unit 5: T20, 42, 62, 176, 198, 
218, 262, 284, 304

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

LA.K.F.2.d

d. Blend onsets and rimes to form simple 
words (e.g., v-an, gr-ab).

Teacher’s Edition Unit 1: T20, 42, 66, 184, 206, 230 Unit 2: T102, 124, 148, 272, 294, 
314 Unit 3: T98, 120, 140, 302 Unit 4: T20, 42, 176, 198

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

LA.K.F.2.e

e. Delete part of a syllable within a 
spoken word including compound 
words (e.g., “Say ‘parsnip.’ Say it again 
but don’t say ‘par;’ e.g., “Say ‘cowboy.’ 
Say it again but don’t say ‘cow’”).

Teacher’s Edition: Unit 3: T184, T206 Unit 5: T20, T42, T62 Unit 9: T20, T176, T198, 
T218 Unit 10: T284, T304

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce
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LA.K.F.2.f

f. Isolate and pronounce the initial, 
medial vowel, and final sounds 
(phonemes) in two- and three-
phoneme (VC or CVC) words, excluding 
CVC words ending with /l/, /r/, or /x/.

Teacher’s Edition Unit 1: T430, 442, 472, 482, 483, 490 Unit 2: T67, 74, 148, 156, 220, 
230, 231, 238, 314, 315, 322, 378, 384, 392, 393, 400456, 462, 470, 472, 478 Unit 3: 
T126, 132, 148, 218, 294, 303, 310, 366, 372, 381, 388 Unit 4: T62, 288, 294, 310, 458, 
466 Unit 5: T390, 412, 424

Students will  produce 
syllables and sounds in 
spoken words

phonemes, syllables, 
produce Introduce

Phonics and Word Analysis

LA.K.F.3

Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition Unit 1: T151, 158, 233, 240, 280, 286, 302, 321, 328, 329, 362, 368, 
384, 403, 410, 411, 444, 466, 485, 492, 493 Unit 2: T28, 34, 50, 110, 116, 132, 192, 198, 
214, 233, 240, 241, 280, 286, 316, 317, 324, 358, 394, 395, 402, 436, 442, 472, 473 Unit 
3: T28, 34, 64, 65, 72, 106, 112, 142, 143, 150, 184, 190, 220, 221, 228, 268, 304, 305, 
312, 346, 352, 382, 383, 390, 424, 430, 460, 461, 468 Unit 4: T28, 34, 64, 65, 72, 106, 
112, 142, 143, 150, 184, 190, 210, 220, 221, 228, 268, 274, 294, 304, 305, 312, 346, 352, 
372, 382, 383, 390, 424, 430, 460, 461, 468 Unit 5: T28, 34, 64, 65, 72, 106, 112, 142, 
143, 150, 184, 190, 220, 221, 228, 270, 276, 306, 307, 314, 348, 354, 384, 385, 392, 426, 
432, 462, 463, 470

Students will use phonics 
and decoding skills to read 
and write words. 

phonics, decoding, 
encoding introduce

LA.K.F.3.a

a. Demonstrate basic knowledge of 
one-to-one sound to letter 
correspondences by producing the 
primary or many of the most frequent 
sounds for each consonant.

Teacher’s Edition Unit 1: T14, 26, 28, 34, 36, 38, 48, 50, 56, 58, 178, 190, 192, 198, 200, 
202, 212, 214, 220, 222, 266, 278, 280, 286, 288, 290, 300, 302, 308, 310, 320, 327, 332, 
348, 360, 362, 368, 370, 372, 382, 384, 390, 392, 402, 408, 414, 430, 442, 444, 450, 452, 
454, 464, 466, 472, 474, 533 Unit 2: T96, 108, 110, 116, 118, 120, 132, etc. Unit 3: T14, 
26, 28, 34, 36, 38, 54, 142, 170, 182, 184, 190, 192, 194, 210, 254, 266, 268, 274, 276, 
278, 294, 332, 344, 346, 352, 354, 356, 372, 382, 410, 422, 424, 430, 432, 434, 450, 511 
Unit 4: T28, 34, 64, 65, 72, 106, etc. Unit 5: T412, 424, 426, 432, 436, 452 Introduce

LA.K.F.3.b

b. Demonstrate the long and short 
sounds with common spellings 
(graphemes) for the five major vowels.

Teacher’s Edition Unit 1: T96, 108, 110, 116, 118, 120, 130, 132, 138, 140, 150, 151, 
157, 162, 212, 220, 308, 390, 430, 450, 452, 464, 472 Unit 2: T14, 26, 28, 34, 36, 38, 56, 
58, 68, 69, 75, 76, 80, 266, 278, 280, 286, 288, 290, 306, 316, 323, 328, 366, 422, 442, 
444, 478, 521 Unit 3: T92, 104, 106, 112, 114, 116, 132, 142, 149, 154, 220, 410, 430, 
444, 450, 467, 511 Unit 4: T14, 26, 28, 34, 36, 38, 54, 64, 71, 76, 190, 410, 430, 444, 511 
Unit 5: T14, 26, 28, 34, 36, 38, 54, 64, 71, 76, 92, 104, 106, 112, 114, 116, 132, 142, 149, 
154, 170, 182, 184, 190, 192, 194, 210, etc. Introduce

LA.K.F.3.c

c. Decode consonant-vowel-consonant 
(CVC) words.

Teacher’s Edition: Unit 1: T109, T130, T138, T151, T158, T191, T212, T220, T233, 
T240 Unit 2: T279, T287, T300, T321, T328, T361, T369, T382, T451, T465 Unit 3: 
T27, T35, T48, T56, T76, T117, T130, T151, T158, T199, T213 Unit 4: T287, T300, 
T316, T324, T357, T379, T394 Unit 5: T27, T64, T72, T105, T113, T142, T150, T183, 
T191, T221, T228 Unit 6: T267, T275, T304, T345, T353, T382 Unit 7: T27, T35, T63, 
T113, T142, T191, T220 Unit 8: T267, T275, T345, T382

Students will use phonics 
and decoding skills to read 
and write words. 

phonics, decoding, 
encoding introduce

LA.K.F.3.d

d. Encode consonant-vowel-consonant 
(CVC) words.

Teacher’s Edition: Unit 1: T100, T199 Unit 2: T287, T301, T309, T369, T383, T473 Unit 
3: T35, T49, T117, T131, T139, T199, T213 Unit 4: T287, T300, T307, T365, T385, 
T443 Unit 5: T49, T55, T113, T127, T133, T191 Unit 6: T275, T289, T295, T367

Students will use phonics 
and decoding skills to read 
and write words. 

phonics, decoding, 
encoding introduce

LA.K.F.3.e

e. Distinguish between similarly spelled 
words by identifying the sounds of the 
letters that differ.

Teacher’s Edition Unit 1: T300, 382 Unit 2: T48, 69, 130, 151, 212, 300, 378, Unit 3: 
T48, 126, 204, 288, 366, 444 Unit 4: T48, 126, 204, 444 Unit 5: T48, 126, 204, 290, 368, 
446

Students will use phonics 
and decoding skills to read 
and write words. 

phonics, decoding, 
encoding introduce

Fluency

LA.K.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level texts to support 
comprehension.

Teacher’s Edition: Unit 1: T16, T98, T180 Unit 2: T268, T350 Unit 3: T16, T98, T174, 
T180 Unit 4: T268, T346 Unit 5: T16, T94, T172 Unit 6: T256, T334 Unit 7: T16, T94, 
T172 Unit 8: T256, T334

Students will read grade 
level texts accurately and 
fluently with expression. 

accuracy, phrasing, 
expression, prosody, 

comprehension Introduce
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Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.K.F.4.a

a. Recognize upper and lowercase 
letters automatically and accurately.

Teacher’s Edition: Unit 1: T39, T51, T59, T111, T121, T193, T203, T215, T223, T229, 
T237 Unit 2: T281, T291, T311, T363, T373, T385, T393, T455, T467, T475 Unit 3: 
T39, T51, T59, T111, T121, T133, T141, T203, T215, T223 Unit 4: T291, T313, T321, 
T359, T369, T391, T399, T405, T437, T447 Unit 5: T29, T39, T75, T107, T117, T147, 
T150, T185, T195, T217, T225, T231 Unit 6: T269, T279, T347, T357, T425, T435 Unit 
7: T29, T39, T69, T75, T107, T117, T147, T153, T185, T195, T225, T231 Unit 8: T269, 
T279, T309, T312, T315, T331, T347, T357, T387, T390, T393, T409, T425, T435, 
T461, T465, T468, T471 Unit 9: T29, T39, T107, T117, T185, T195 Unit 10: T271, 
T281, T349, T359, T385, T392, T395, T427, T437, T463, T470

Students will read grade 
level texts accurately and 
fluently with expression. 

accuracy, phrasing, 
expression, prosody, 

comprehension Introduce

LA.K.F.4.b

b. Read decodable consonant-vowel-
consonant (CVC) words with 
automaticity and accuracy.

Teacher’s Edition Unit 1: T28, 38, 50, 58, 64, 70, 72, 77, 78, 110, 120, 132, 140, 146, 
152, 154, 159, 160, 192, 202, etc. Unit 2: T28, 38, 50, 58, 64, 70, 72, 77, 78, 110, 120, 
etc. Unit 3: T28, 38, 60, 65, 67, 68, 72, 73, 74, 77, 106, 116, 138, 143, 145, 146, 150, 
151, 152, 155, etc. Unit 4: T28, 38, 60, 65, 67, 68, 72, 73, 74, 77, 106, 116, 138, 143, 
145, etc. Unit 5: T28, 38, 60, 65, 67, 68, 72, 73, 74, 77, 106, 116, 138, 143, 145, 146, 
150, 151, 152, 155, 184, 194, 216

Students will read grade 
level texts accurately and 
fluently with expression. 

accuracy, phrasing, 
expression, prosody, 

comprehension Introduce

LA.K.F.4.c

c. Read grade level high-frequency 
words with automaticity and accuracy 
(e.g. Fry or Dolch words or those 
included in instructional materials).

Teacher’s Edition Unit 1: S14, S20, S22, S26, S32, S34, S36, S44, S50, S52, S56, S62, 
S64, S66, S74, S80, S82, S86, S92, S94, S96; T16, 26, 28, 36, 38, 48, 50, 56, 58, 98, 108, 
etc. Unit 2: T16, 26, 28, 36, 38, 48, 50, 56, 58, 98, 108, etc. Unit 3: T16, 26, 28, 36, 38, 
48, 54, 94, 104, etc. Unit 4: T16, 26, 28, 36, 38, 48, 54, 94, 104, etc. Unit 5: T16, 26, 28, 
36, 38, 48, 54, 94, 104, etc.

Students will read grade 
level texts accurately and 
fluently with expression. 

accuracy, phrasing, 
expression, prosody, 

comprehension Introduce
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Central Ideas and Details

LA.K.RP.1

With prompting and support, orally retell 
familiar stories, including key details, 
and demonstrate understanding of their 
central message or lesson.

Teacher’s Edition Unit 1: T90 Unit 2: T8, 90, 172, 236, 242, 374, 404 Unit 3: T8, 74, 
184, 314, 326, 378, 392, 404, 470 Unit 4: T106, 268

Students will retell familiar 
stories with key details. 

orally, retell, familiar, 
understanding Introduce

LA.K.RP.2

With prompting and support, identify 
main character(s), setting, and 
important events in a literary text.

Teacher’s Edition Unit 1: S48; T480, 488, 484 Unit 2: T172, 390, 407 Unit 3: T8, 22, 60, 
67, 68, 74, 77, 300, 307, 308, 314, 317, 378, 385, 386, 392, 395, 418, 456, 464, 470 Unit 
4: T145, 151, 155, 248, 262300, 307, 308, 313, 314, 317, 404, 418, 456, 464, 470, 511 
Unit 5: T8, 74, 86, 146, 152, 248, 310, 316, 380, 388, 394

Students will be able to 
identify characters, setting, 
and main events of a 
story.

prompting, support, 
elements. Introduce

Author's Craft

LA.K.RP.3

With prompting and support, define the 
role of author and illustrator in a literary 
text. Teacher’s Edition Unit 1: S43, S73 Unit 3: T74, 164 Unit 4: T248, 404 Unit 5: T248, 316

Students will know the role 
of an author and illustrator. author, illustrator Introduce

LA.K.RP.4

With prompting and support, identify the 
basic characteristics of literary text.

Teacher’s Edition: Unit 1: T8, T22, T64-65, T72, T78, T90, T104, T146, T154, T160 
Unit 2: T480, T488, T494 Unit 3: T8, T18, T20, T22, T64, T72, T78, T90-95, T104, 
T146, T154, T160, T172, T186, T227-228, T236 Unit 4: T285, T338, T352, T390, T398, 
T404 Unit 5: T60, T68, T74, T111, T230 Unit 6: T308, T314, T351, T429 Unit 7: T187, 
T189, T197, T209, T216, T224, T230 Unit 8: T273, T327, T340, T418, T456, T470 Unit 
9: T60, T68, T74, T111, T138, T146, T152 Unit 10: T275, T302, T310, T316, T380, 
T388, T394

Students will identify 
important parts of a story.

characteristics, setting, 
plot, characters Introduce

Knowledge and Ideas

LA.K.RP.5

With prompting and support, compare 
and contrast the experiences of 
characters in familiar stories.

Teacher’s Edition Unit 1: S30, S38, S60, S68; T32, 62, 115, 144, 246 Unit 2: T33, 115, 
246, 338 Unit 3: T351, 429 Unit 4: T189, 234, 248, 273, 509 Unit 5: T58, 111, 275, 511

Students will compare 
characters in stories. compare, contrast Introduce
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LA.K.RP.6

With prompting and support, ask and 
answer questions about key details in a 
literary text.

Teacher’s Edition Unit 1: T8, 44, 46, 64, 71, 72, 77, 78, 81, 90, 126, 128, 146, 153, 154, 
159, 160, 163, 172, 228, 235, 236, 241, 242, 245, 260, 316, 323, 324, 329, 330, 333, 378, 
398, 405, 406, 411, 412, 415, 424, 460, 480, 487, 488, 493, 494, 497 Unit 2: T210, 236, 
242, 260, 276, 296, 298, 320, 326, 338, 362, 376, 398, 404, 416, 452, 454, 468, 476, 482 
Unit 3: 248, 326, 404, 463, 469 Unit 4: T124, 286 Unit 5: T8, 44, 77, 122, 328,

Students will ask and 
answer questions about a 
story. key details Introduce

LA.K.RP.7

With prompting and support, make 
connections between own experiences 
and other cultures in literary texts. Teacher’s Edition Unit 4: T339-342, T343, T398-399

Students will use 
background information to 
make connections.

connections, text to 
world, text to self, text to 

text Introduce
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Central Ideas and Details

LA.K.RI.1

With prompting and support, identify the 
main topic and key details in an 
informational text.

Teacher’s Edition Unit 1: S78, S85, T172, 186, 214, 228, 235, 236, 241, 242, 245, 260 , 
274, 296, 302, 316, 323, 324, 329, 330, 333, 342, 356, 378, 398, 405, 406, 411, 412, 415, 
460, 533 Unit 2: T44, 126, 208, 260, 274, 296, 312, 319, 320, 325, 326, 329, 416, 430, 
468, 475, 476, 481, 482, 485, 521 Unit 3: T86, 100, 106, 122, 138, 145, 146, 151, 152, 
155, 164, 178, 200, 216, 223, 224, 229, 230, 233, 268, 440, 502, 511 Unit 4: T28, 74, 
378, 386, 392, 424, 440, 502 Unit 5: T164, 200, 223, 224, 229, 230, 233, 286, 406, 420, 
426, 442, 458, 465, 466, 471, 472, 475, 504, 513

Students will identify topic 
and key details in 
informational text. main topic, key details Introduce

LA.K.RI.2

With prompting and support, identify 
key individuals, events, or pieces of 
information in an informational text. Teacher’s Edition Unit 1: T128, 276, 380 Unit 2: T430, 454 Unit 4: T200, 202, 284

Students will identify topic 
and key details in 
informational text.

key individuals, events, 
informational text Introduce

Author's Craft

LA.K.RI.3

With prompting and support, define the 
role of author and illustrator in 
presenting the ideas or information in a 
text. Teacher’s Edition Unit 1: T 342 Unit 2: T260, 416 Unit 4: T74, 326 Unit 5: T164

Students will know the role 
of an author and illustrator. author, illustrators Introduce

LA.K.RI.4

With prompting and support, use text 
features (titles, headings, visuals) to 
predict or confirm the topic of a text.

Teacher’s Edition: Start Smart: S35 Unit 1: T44-45, T126-127, T188 Unit 2: T276, T296-
297, T359, T378-379, T460 Unit 4: T260-264, T313, T321, T327 Unit 5: T122-123, 
T139, T147, T153, T166, T167, T168, T200-201, T217, T225, T231 Unit 6: T440-441 
Unit 9: T122-123, T200-201, T217, T225 Unit 10: T287, T365, T442-443, T459, T467, 
T473

Students will use text 
features to determine the 
topic of a text. title, heading Introduce

Knowledge and Ideas

LA.K.RI.5

With prompting and support, identify 
basic similarities and differences 
between two informational texts on the 
same topic.

Teacher’s Edition Unit 1: S90, S98; T197, 285, 367, 449, 531 Unit 2: T197, 285, 363, 
388, 441, 466, 519 Unit 3: T33, 111, 189, 234, 273, 509 Unit 4: T33, 111, 351, 429 Unit 
5: T33, 136, 189, 214, 234, 300, 353, 431, 456

Students will compare 
informational texts.

similarities, differences, 
informational texts Introduce

LA.K.RI.6

With prompting and support, explain the 
difference between facts and opinions 
about a topic. Teacher’s Edition Unit 4: T8, 22, 60, 68, 74, 326, 340, 378, 386, 392 Unit 5: T288, 364

Students will explain the 
difference between fact 
and opinion. fact, opinion Introduce

LA.K.RI.7

With prompting and support, make 
connections between own experiences 
and other cultures in informational texts.

Teacher’s Edition Unit 2: T261

Students will make 
connections between their 
own lives and other 
cultures in informational 
text.

experiences, cultures, 
informational text Introduce

Range of Reading and Level of 
Text Complexity

LA.K.RI.8

Actively engage in group reading 
activities with purpose and 
understanding.

Teacher’s Edition Unit 1: S90; T8, 44, 90, 126, 172, 208, 260, 342, 526 Unit 2: T8, 44, 
90, 126, 172, 208, 260, 296, 374, 416, 452, 514 Unit 3: T8, 44, 86, 122, 164, 178, 200, 
248, 284, 326, 362, 404, 504 Unit 4: T8, 44, 86, 122, 164, 200, 248, 284, 326, 362, 404, 
440, 504 Unit 5:T8, 44, 86, 164, 200, 248, 284, 364, 406, 442, 506

Students will participate in 
guided reading. Introduce
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Acquisition and Use

LA.K.V.1

Recognize and use conversational and 
grade-level academic vocabulary.

Teacher’s Edition: Unit 1: T7, T89, T171 Unit 2: T259, T341, T423 Unit 3: T7, T89, 
T171 Unit 4: T259, T337, T415 Unit 5: T7, T85, T163 Unit 6: T247, T325, T403 Unit 7: 
T7, T85, T163 Unit 8: T247, T325, T403 Unit 9: T7, T85, T163 Unit 10: T247, T327, 
T405

Students will build and use 
a range of grade level 
vocabulary. recognize, use Introduce

LA.K.V.1.a

a. With prompting and support, identify 
new meanings of familiar words (e.g., 
park, ring, fly).

Teacher’s Edition Unit 1: T272, 294, 354, 376, 533 Unit 2: T350, 521 Unit 3: T176, 198 
Unit 4: T98, 282 Unit 5: T192, 372, 379, 434, 508, 513

Students will build and use 
a range of grade level 
vocabulary. recognize, use Introduce

LA.K.V.1.b

b. With prompting and support, use 
commonly occurring inflections and 
affixes to determine the meaning of 
unknown words. Teacher’s Edition Unit 2: T485 Unit 4: T416 Unit 5: T340, 362, 513

Students will build and use 
a range of grade level 
vocabulary. recognize, use Introduce

LA.K.V.1.c

c. With prompting and support, 
determine the meanings of key words 
and phrases using provided reference 
materials and classroom resources.

Teacher’s Edition: Unit 1: T7, T33, T115, T197 Unit 2: T285, T367, T449 Unit 3: T33, 
T115, T197 Unit 4: T285, T363, T441 Unit 5: T33, T111, T189 Unit 6: T273, T351, 
T429 Unit 7: T33, T111, T189 Unit 8: T273, T351, T429 Unit 9: T33, T111, T189 Unit 
10: T275, T353, T431

Students will build and use 
a range of grade level 
vocabulary. recognize, use Introduce

Context and Connotations

LA.K.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher’s Edition: Unit 1: T128-129, T171 Unit 7: T11, T162, T165, T176, T198, T201 
Unit 8: T330, T417, T438, T439 Unit 9: T167 Unit 10: T407-409

Students will interpret a 
variety of language in 
grade level text. language, interpret Introduce

LA.K.V.2.a

a. With prompting and support, sort 
common words and phrases into 
conceptual categories to develop an 
understanding of word relationships.

Teacher’s Edition Unit 1: T272, 294, 354, 376, 533 Unit 2: T350, 521 Unit 3: T176, 198 
Unit 4: T98, 282 Unit 5: T192, 372, 379, 434, 508, 513

Students will interpret a 
variety of language in 
grade level text. language, interpret Introduce

LA.K.V.2.b

b. With prompting and support, deepen 
understanding of words by identifying 
and relating them to their opposites. Teacher’s Edition Unit 2: T485 Unit 4: T416 Unit 5: T340, 362, 513

Students will interpret a 
variety of language in 
grade level text. language, interpret Introduce

LA.K.V.2.c

c. With prompting and support, ask and 
answer questions about key words and 
phrases to determine their meaning.

Teacher’s Edition: Unit 1: T7, T33, T115, T197 Unit 2: T285, T367, T449 Unit 3: T33, 
T115, T197 Unit 4: T285, T363, T441 Unit 5: T33, T111, T189 Unit 6: T273, T351, 
T429 Unit 7: T33, T111, T189 Unit 8: T273, T351, T429 Unit 9: T33, T111, T189 Unit 
10: T275, T353, T431

Students will interpret a 
variety of language in 
grade level text. language, interpret Introduce

LA.K.V.2 .d

d. With prompting and support, identify 
and explain descriptive words and 
phrases that suggest feelings or appeal 
to the senses. Teacher’s Edition: Unit 1: T185, T210-211 Unit 2: T424-427 Unit 10: T482

Students will interpret a 
variety of language in 
grade level text. language, interpret Introduce

W
r
i
t
i
n
g

Apply handwriting skills to 
communicate ideas and 
information.

LA.K.FW.1

Demonstrate basic handwriting skills. Teacher’s Edition: Start Smart: S17, S29, S31 Unit 1: T16, T76, T98, T180 Unit 2: T268, 
T350, T432 Unit 3: T16, T98, T180 Unit 4: T268, T346, T424 Unit 5: T16, T94, T172 
Unit 6: T256, T334, T412 Unit 7: T16, T94, T172 Unit 8: T256, T334, T412

Students will learn basic 
handwriting skills. handwriting, basic Introduce
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LA.K.FW.1.a

a. Identify and match upper and 
lowercase manuscript letters.

Teacher’s Edition: Unit 1: T16, T98, T180 Unit 2: T268, T350 Unit 3: T16, T98, T174, 
T180 Unit 4: T268, T346 Unit 5: T16, T94, T172 Unit 6: T256, T334 Unit 7: T16, T94, 
T172 Unit 8: T256, T334

Students will learn basic 
handwriting skills. handwriting, basic Introduce

LA.K.FW.1.b

b. Print many upper and lowercase 
manuscript letters using reference 
materials and classroom resources.

Teacher’s Edition Unit 1: T16, 76, 98, 180, 268, 350, 432 Unit 2: T16, 98, 180, 268, 346, 
424 Unit 3: T16, 94, 172, 256, 334, 412 Unit 4: T16, 94, 172, 256, 334, 412 Unit 5: T16, 
94, 172, 258, 336, 414

Students will learn basic 
handwriting skills. handwriting, basic Introduce

LA.K.FW.1.c
c. Write left to right and use appropriate 
spacing between letters and words.

Teacher’s Edition: Unit 1: T18, T30, T40, T100, T112 Unit 2: T518 Unit 6: T258, T270 
Unit 7: T96, T108 Unit 8: T414 Unit 10: T260, T272

Students will learn basic 
handwriting skills. handwriting, basic Introduce

LA.K.FW.2

Demonstrate sound-letter concepts 
when writing.

Teacher’s Edition: Unit 1: T182, T194 Unit 2: T270, T352, T434, T446 Unit 3: T18, 
T100, T182, T221 Unit 4: T270 Unit 5: T96, T174 Unit 6: T258, T270, T336, T348, 
T426

Students will learn sound-
letter concepts while 
writing.

sound-letter concepts, 
writing Introduce

LA.K.FW.2.a

a. Segment phonemes orally in single-
syllable words.

Teacher’s Edition: Unit 2: T430, T442, T472, T482-483, T490 Unit 3: T220, T231, T238 
Unit 4: T378, T384, T393, T400, T456, T462, T471, T478 Unit 5: T126, T132, T141, 
T148 Unit 6: T294, T303, T310, T366, T372, T381, T388 Unit 8: T288, T294, T303, 
T310 Unit 10: T412, T424, T468, T460

Students will learn sound-
letter concepts while 
writing.

sound-letter concepts, 
writing Introduce

LA.K.FW.2.b

b. Demonstrate understanding that 
syllables are organized around vowel 
sounds.

Teacher’s Edition: Start Smart: S74, S80, S86, S92, S96 Unit 2: T436, T458, T482 Unit 
3: T184, T206 Unit 5: T20, T42, T62 Unit 9: T20, T176, T198, T218 Unit 10: T284, 
T304

Students will learn sound-
letter concepts while 
writing.

sound-letter concepts, 
writing Introduce

LA.K.FW.2.c

c. Form upper and lowercase 
manuscript letters using reference 
materials and classroom resources.

Students will learn sound-
letter concepts while 
writing.

sound-letter concepts, 
writing Introduce

LA.K.FW.2.d

d. Write left to right and use appropriate 
spacing between letters and words.

Students will learn sound-
letter concepts while 
writing.

sound-letter concepts, 
writing Introduce

Production of Writing

LA.K.W.1

With prompting and support, form and 
use complete simple sentences in 
shared language activities.

Teacher’s Edition: Unit 1: T18, T100, T122, T182 Unit 2: T270, T352, T434 Unit 3: T18, 
T40, T41, T61, T100, T101, T112, T113, T122, T123, T134, T135, T182, T183, T194, 
T204, T216 Unit 4: T302, T348, T380 Unit 5: T18, T30, T50, T96, T128, T174, T206 
Unit 6: T258, T290, T336, T368, T414, T446 Unit 7: T18, T96, T174, T206 Unit 8: 
T258, T336, T414 Unit 9: T18, T96, T174 Unit 10: T260, T338, T416

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.a
a. Capitalize the first word in a sentence 
and the pronoun I.

Teacher’s Edition Unit 1: T521 Unit 2: T40, 52, 122, 134, 194, 509 Unit 3: T497 Unit 4: 
T497 Unit 5: T292, 499

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.b

b. Recognize and name end 
punctuation.

Teacher’s Edition Unit 1: 521 Unit 2: 40, 52, 122, 134, 194, 204, 224, 509 Unit 3: 412, 
497 Unit 4: T38, 50, 128, 290, 356, 358, 368, 446, 497 Unit 5: T38, 50, 86, 128, 172, 
186, 196, 206, 258, 292, 336, 370, 414, 448, 499

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.c

c. Identify nouns (e.g., singular and 
plural) and simple verbs (e.g., action).

Teacher’s Edition: Unit 1: T19, T31, T41, T53, T61, T101, T113, T123, T135, T143, 
T183, T195, T205, T217, T225 Unit 2: T271, T282-283, T292-293, T305, T313, T353, 
T365, T375, T387, T395, T435 Unit 6: T259, T271, T281, T291, T297, T349, T415, 
T427, T436, T447, T452 Unit 7: T19, T31, T41, T51, T97, T99, T109, T119, T129, 
T135, T175, T187, T197, T207, T213

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.d
d. Form regular plural nouns by adding 
/s/ or /es/. Teacher’s Edition Unit 3: T20, 42, 258, 270, 280, 414, 426, 436

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.e
e. Use interrogatives to ask questions.

Teacher’s Edition Unit 2: T182, 194, 204, 216, 224 Unit 3: T416, 438 Unit 5: T98, 120
Students will write a 
simple sentence. 

form and use simple 
sentences Introduce

LA.K.W.1.f
f. Use subject-verb agreement in simple 
sentences. Teacher’s Edition Unit 7: T19, T31, T41, T51, T57

Students will write a 
simple sentence. 

form and use simple 
sentences Introduce
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LA.K.W.2

With prompting and support, use a 
recursive writing process to develop, 
strengthen, and produce writing 
appropriate to the discipline, audience, 
and/or context.

Teacher’s Edition Unit 1: T52, 134, 216, 304, 386, 468, 506 Unit 2: T52, 134, 216, 302, 
380, 458, 494 Unit 3: T50, 128, 206, 290, 368, 446, 482 Unit 4: T50, 128, 206, 290, 368, 
446, 482 Unit 5: T50, 128, 206, 292, 370, 448, 484

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

LA.K.W.2.a

a. Use prewriting activities and resources 
to generate ideas.

Teacher’s Edition: Unit 1: T40, T122, T194, T204 Unit 2: T292, T364, T446, T456, 
T502-503, T527 Unit 3: T40, T122, T194, T204 Unit 4: T282, T292, T360, T370, T490-
491 Unit 5: T40, T108, T118 Unit 6: T426 Unit 8: T478-479 Unit 10: T480-481

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

LA.K.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: T40, T52, T60, T122, T134, T142, T182, T194, T216, T224, 
T225 Unit 2: T292, T304, T312, T374, T386, T394, T476, T486, T504-505, T506, T509 
Unit 3: T40, T53, T60, T122, T134, T142, T216, T224 Unit 4: T302, T308, T376, T380, 
T386, T448, T458, T464, T492-493, T494, T497 Unit 5: T40, T50, T56, T118, T128, 
T134, T206, T212 Unit 6: T280, T290, T296, T358, T368, T374, T436, T446, T452, 
T480-481, T482, T485 Unit 7: T40, T50, T56, T118, T128, T124, T134, T196, T206, 
T212 Unit 8: T281, T290, T296, T358, T368, T374, T436, T446, T452, T482-483, T484, 
T487 Unit 9: T40, T50, T56, T118, T128, T134, T186, T196, T206, T212 Unit 10: T260, 
T272, T282, T292, T298, T350, T360, T370, T376, T428, T438, T448, T454, T482-483, 
T484, T487

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

LA.K.W.2.c

c. Use feedback from others to improve 
writing and/or add details.

Teacher’s Edition: Unit 1: T52, T134, T216 Unit 2: T304, T386, T468, T506-507 Unit 3: 
T52, T134, T216 Unit 4: T302, T380, T458, T494-495 Unit 5: T50, T128, T206, T290 
Unit 6: T368, T446, T482-483 Unit 7: T50, T128, T206 Unit 8: T290, T368, T446, T482-
483 Unit 9: T50, T128, T206 Unit 10: T292, T370, T448, T484-485

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

LA.K.W.2.d

d. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
font, graphics, symbols).

Teacher’s Edition: Unit 1: T52, T60, T134, T142, T216, T224 Unit 2: T304, T305, T312, 
T386, T394, T468, T476, T500-501, T506-507, T509, T530 Unit 3: T52, T60, T134, 
T142, T216, T224 Unit 4: T302, T308, T380, T386, T458, T464, T494-495, T497 Unit 5: 
T47, T50, T56, T128, T134, T206, T212, T290 Unit 6: T296, T368, T374, T446, T452, 
T482-483, T485 Unit 7: T50, T56, T128, T134, T206, T212 Unit 8: T290, T296, T368, 
T374, T446, T452, T482-483, T487 Unit 9: T50, T56, T128, T134, T206, T212 Unit 10: 
T292, T298, T370, T376, T448, T454, T484-48

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

LA.K.W.2.e

e. Use appropriate digital/multimedia 
tools to produce, enhance, and/or 
publish writing individually or with peers.

Teacher’s Edition Unit 1: T60, 142, 224, 312, 394, 476 Unit 2: T60, 142, 224, 308, 386, 
464 Unit 3: T56, 134, 212, 296, 374, 452, 502 Unit 4: T52, 56, 130, 134, 208, 212, 290, 
292, 296, 368, 370, 374, 446, 448, 452, 502 Unit 5: T50, 56, 128, 134, 206, 208, 212, 
292, 298, 370, 376, 448, 454, 504

Students will use the 
writing process.

develop, produce, 
strengthen Introduce

Modes of Writing

LA.K.W.3

With prompting and support, narrate 
personal or fictional events in a 
sequential order using a combination of 
drawing, dictating, and/or writing.

Teacher’s Edition: Unit 4: T464, T492, T493, T498, T499 Unit 5: T134, T186, T196 Unit 
6: T358, T476-485 Unit 7: T118, T125 Unit 8: T480 Unit 9: T23, T134 Unit 10: T298

Students will write a story 
with a beginning, middle 
and end. sequentional order Introduce

LA.K.W.4

With prompting and support, express an 
opinion about a topic or text with one 
supporting reason using a combination 
of drawing, dictating, and/or writing.

Teacher’s Edition Unit 1: T204, 292, 374, 434, 446, 456, 530 Unit 2: T112, 182, 270, 
348, 438, 518 Unit 3: T30, 40, 108, 118, 174, 258, 270, 280, 508 Unit 4: T186, 196, 270, 
426, 508 Unit 5: T30, 118, 196, 272, 478-486, 488, 489, 510

Students will write an 
opinion story. opinion introduce
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LA.K.W.5

With prompting and support, write 
informative/explanatory pieces about a 
topic or text with one supporting fact 
using a combination of drawing, 
dictating, and/or writing.

Teacher’s Edition Unit 1: T18, 30, 40, 100, 112, 122, 182, 194, 270, 282, 352, 364 Unit 
2: T18, 100, 122, 194, 282, 292, 360, 370, 426, 448, 516 Unit 3: T186, 196, 348, 506 
Unit 4: T30, 40, 280, 348, 358, 436, 506 Unit 5: T108, 186, 282, 350, 360, 428, 438, 508

Students will write an 
informative piece with 
supporting facts. informative, explanatory introduce

LA.K.W.6

With prompting and support, identify 
information from provided sources to 
answer a question using a combination 
of drawing, dictating, and/or writing.

Teacher’s Edition: Unit 1: T54, T136, T218 Unit 2: T306, T388, T470 Unit 3: T54, T136, 
T218 Unit 4: T304, T382, T460 Unit 5: T52, T130, T208 Unit 6: T292, T370, T448 Unit 
7: T52, T130, T208 Unit 8: T292, T370, T448 Unit 9: T52, T130, T208 Unit 10: 294, 
T372, T450

Students will answer 
questions using a variety 
of sources. 

identify, answer 
questions introduce

Comprehension and Collaboration
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LA.K.SL.1

With prompting and support, participate 
with peers and adults in structured 
discussions and routines about 
Kindergarten topics and texts.

Teacher’s Edition: Start Smart: S17, S69 Unit 1: T7, T32, T60, T89, T114 Unit 2: T284, 
T448 Unit 3: T32, T114, T170 Unit 4: T285, T308, T337, T363, T386, T464 Unit 5: T33, 
T56, T111, T134, T212 Unit 6: T273, T296, T374, T429, T452 Unit 7: T33, T56, T111, 
T134, T212 Unit 8: T296, T350, T351, T374 Unit 9: T33, T56, T111, T134, T189, T212 
Unit 10: T245, T275, T298, T353, T376, T454

Students will participate in 
discussions about 
kindergarten topics. structured introduce

LA.K.SL.1.a

a. Ask pertinent questions to acquire or 
confirm information.

Teacher’s Edition: Start Smart: S46, S47 Unit 1: T7, T54-55, T89 Unit 2: T259 Unit 3: 
T183, T195, T205, T217, T218, T219 Unit 4: T257, T259, T337, T382, T386, T460 Unit 
5: T4, T5, T11, T134, T163 Unit 6: T247, T273, T325, T417, T429, T439 Unit 7: T56, 
T85, T111, T134, T207, T212 Unit 8: T296, T325, T351, T452 Unit 9: T53, T111, T130, 
T189 Unit 10: T247, T275, T327, T353, T454

Students will participate in 
discussions about 
kindergarten topics. structured introduce

LA.K.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation. Teacher’s Edition: Unit 9: T85

Students will participate in 
discussions about 
kindergarten topics. structured introduce

LA.K.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Start Smart: S8, S79 Unit 1: T169 Unit 3: T7 Unit 4: T337 Unit 6: 
T325 Unit 7: T7, T85 Unit 8: T325 Unit 10: T327

Students will participate in 
discussions about 
kindergarten topics. structured introduce

LA.K.SL.1.d

d. Develop attentive listening skills (e.g., 
eye contact, nonverbal cues, recalling).

Teacher’s Edition: Start Smart: S17, S69 Unit 1: T7, T114, T168 Unit 3: T7, T32, T60, 
T114, T142, T170, T171, T224 Unit 4: T308, T337, T386, T464 Unit 5: T7, T33, T56, 
T85, T111, T134, T212 Unit 6: T273, T296, T374, T429, T452 Unit 7: T7, T33, T56, 
T111, T134, T212 Unit 8: T296, T351, T374, T452 Unit 9: T33, T56, T85, T111, T134, 
T189, T212 Unit 10: T245, T298, T376, T454, T486

Students will participate in 
discussions about 
kindergarten topics. structured introduce
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LA.K.SL.1.e

e. Complete a task following one/two-
step directions. Teacher’s Edition: Start Smart: S40, S71 Unit 8: T417 Unit 9: T99 Unit 10: T285

Students will participate in 
discussions about 
kindergarten topics. structured introduce

Presentation of Knowledge and Ideas

LA.K.SL.2

With prompting and support, describe 
familiar people, places, things, and 
events, and provide additional detail.

Teacher’s Edition Start Smart: S42, S46, S77 Unit 1: T19, T63 Unit 2: T380, T423, T479 
Unit 3: T142, T183 Unit 4: T308, T415, T516 Unit 6: T403 Unit 8: T403

Students will discuss 
relevant details in 
conversations. familiar introduce

LA.K.SL.2.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations.

Teacher’s Edition Start Smart: S61 Unit 2: T508 Unit 3: T60, T142, T224 Unit 4: T308, 
T386, T464 Unit 5: T56, T134, T212 Unit 6: T296, T374, T452 Unit 7: T56, T212 Unit 
8: T296, T374, T452, T484 Unit 9: T56, T134, T212 Unit 10: T298, T376, T454, T486 
Reading/Writing Companion: Unit 2: 100-101

Students will discuss 
relevant details in 
conversations. familiar introduce

LA.K.SL.2.b

b. Convey a personal perspective with 
clear reasons. Teacher’s Edition Unit 6: T452 Unit 7: T206 Unit 10: T245, T486

Students will discuss 
relevant details in 
conversations. familiar introduce

LA.K.SL.2.c

c. Explain the purpose of information 
being presented. Teacher’s Edition Unit 2: T506-508 Unit 6: T374 Unit 10: T486

Students will discuss 
relevant details in 
conversations. familiar introduce

LA.K.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., helpful/hurtful words). Teacher’s Edition Unit 4: T257, T335 Unit 7: T183 Unit 9: T53 Unit 10: T403

Students will discuss 
relevant details in 
conversations. familiar introduce

LA.K.SL.2.e

e. Use appropriate visual and/or digital 
tools to support verbal communication.

Teacher’s Edition: Unit 1: T54, T136, T218 Unit 2: T306, T388, T470 Unit 3: T54, T136, 
T218 Unit 4: T304, T382, T460 Unit 5: T52, T130, T208 Unit 6: T292, T370, T448 Unit 
7: T52, T130, T208 Unit 8: T292, T370, T448 Unit 9: T52, T130, T208 Unit 10: 294, 
T372, T450

Students will discuss 
relevant details in 
conversations. familiar introduce



K reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Start Smart Weeks 1-3

Students will demonstrate understanding 
of spoken words, syllables, sounds and 
upper and lowercase alphabet letters. LA.
K.F.1

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1 Week 1

Students will use phoneme isolation to 
identify the letter M and connect the 
sound /m/. Students will spell words with m 
and the word the.

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify initial and medial 
A and use the sound /a/ to blend and 
spell words. Students will identify 
rhyme. 

Week 3

Students will use phoneme isolation 
identify the letter S and use the sound 
/s/ to blend and spell words.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2 Week 1

Students will identify the letter P and 
use the sound /p/ to blend and spell 
words. 

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify the letter T and 
use the sound /t/ to blend and spell 
words. 

Week 3

Students will use phoneme 
segmentation and phoneme blending 
to read and write words using letters 
M, A, P, S and T.  Students will be 
introduced to the 'at' pattern. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3 Week 1

Students will identify initial and medial I 
and use the sound /i/ to blend and 
spell words. 

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify the letter N and 
use the sound /n/ to blend and spell 
words. 

Week 3

Students will count and blend 
syllables. Students will identify the 
letter C and use the sound /c/ to blend 
and spell words. Students will be 
introduced to the 'an' pattern.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing


K reading

Unit 4 Week 1

Students will identify initial and medial 
O and use the sound /o/ to blend and 
spell words.

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify the letter D and 
use the sound /d/ to blend and spell 
words. 

Week 3

Students will use phoneme blending 
and segmenting to read and write 
words using I, N, C, O and D. Students 
will also learn and use S blends. (sn, 
sp, st.) Students will be introduced to 
the 'ot' pattern. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 5 Week 1

Students will identify the letter H and 
use the sound /h/ to blend and spell 
words. Students will count and blend 
syllables.

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify initial and medial 
E and use the sound /e/ to blend and 
spell words. 

Week 3

Students will identify the letter F and 
the letter R. Students will use the 
sound /f/ and /r/ to blend and spell 
words. Students will be introduced to 
the 'en' pattern. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 6 Week 1

Students will identify the letter B and 
the letter L and use the sounds /b/ and 
/l/ to blend and spell words. 

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify the letter K and 
use the final ck spelling. Students will 
use the sound /k/  and final ck to blend 
and spell words.

Week 3

Students will use phoneme blending 
and segmenting to read and write 
words using H, E, F, R, B, L, K and 
final ck. Students will also learn and 
use l- blends (bl, cl, fl, sl).

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 7 Week 1

Students will identify initial and medial 
U and use the sound /u/ to blend and 
spell words. 

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify letter G and letter 
W and use sounds /g/ and /w/ to blend 
and spell words.

https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing


K reading

Week 3

Students will identify letter V and final 
X and use the sounds /ks/ and /v/ to 
blend and spell words. Students will 
learn and use the 'et' pattern. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 8 Week 1

Students will identify letter J and letters 
QU and use the sounds /j/ and /kw/ to 
blend and spell words. Students will 
use syllable addition. 

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will identify letter Y and letter 
Z and use the sounds /y/ and /z/ to 
blend and spell words. Students will 
continue to identify and produce 
rhyming words.

Week 3

Students will use phoneme blending 
and segmenting to read and write 
words using U, G, W, X, V, J, Qu, Y 
and Z. Students will learn and use r 
blends(br, cr, dr, gr, tr)

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 9 Week 1
Students will learn to read, write and 
decode the long vowel spelling a_e.

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2
Students will learn to read, write and 
decode the long vowel spelling i_e.

Week 3

Students will learn to read, write and 
decode the long vowel spelling o_e 
and also use the 'oke' spelling pattern.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 10 Week 1
Students will learn to read, write and 
decode the long vowel spelling u_e.

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKe
W_55zZRBl/view?usp=sharing

https://drive.google.
com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/v
iew?usp=sharing

Week 2

Students will learn to read, write and 
decode the long vowel spellings e, ee 
and e_e.

Week 3

Students will review long a, i, o, u, e 
and final blends (-st, -nd, -nk). 
Students will learn and use the 'eep' 
pattern.

https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing
https://drive.google.com/file/d/1_orI2ruFGiHIgKk4JWcYYKeW_55zZRBl/view?usp=sharing


K Writing

The Kindergarten Writing Curriculum can be found at this link:
https://drive.google.com/drive/folders/0B4xqohHXQGpSLUNZWUN0NHA2UWM?resourcekey=0-0zAcIHSppv7DH_Nix4bLsQ&usp=sharing

https://drive.google.com/drive/folders/0B4xqohHXQGpSLUNZWUN0NHA2UWM?resourcekey=0-0zAcIHSppv7DH_Nix4bLsQ&usp=sharing
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LA.1.F.1

Demonstrate knowledge of the 
organization and basic concepts of 
print.

Teacher’s Edition: Unit 1: S12, S18, S36, S44, S50, S56, S62, S68, S77, S82, 
S88, S94, S100, T331, T421, T422, T423 Unit 2: T9, T169, T415, T416, T417 
Unit 3: T9, T333, T421, T422, T423 Unit 4: T467, T468, T469 Unit 5: T469, 
T470, T471 Unit 6: T471, T472, T473

Students will understand 
basic concepts of print.

concepts of print, text, 
text features reinforce

LA.1.F.1.a

a. Recognize the distinguishing features 
of a sentence.

Teacher’s Edition: Unit 1: T17, T27, T43, T55, T61, T97, T107, T125, T137, 
T143, T339, T349, T420, T422, T423, T424 Unit 2: T414, T416, T417, T418 
Unit 3: T420, T422, T423, T424 Unit 4: T466, T468, T469, T470 Unit 5: 
T468, T470, T471, T472 Unit 6: T470, T472, T473, T474

Students will understand 
basic concepts of print.

concepts of print, text, 
text features reinforce

Phonological Awareness 

LA.1.F.2

Demonstrate understanding of spoken 
words, syllables, and sounds 
(phonemes).

Teacher’s Edition: Unit 1: S13, S19, S25, S31, S37, S45, S51, S57, S69, S101, 
T10-T11, T20-T21, T52, T66, T100-T101, T134, T148, T149, T254-T255, 
T274-T275, T294-T295, T308, T309, T352-T353, T384-T385 Unit 2: T146 
Unit 3: T10, T20, T52, T66, T67, T90, T147, T170, T228, T334, T354, T385 
Unit 4: T10, T20, T56, T72, T120, T161, T188, T250, T251, T374, T384, 
T416, T426 Unit 5: T10, T14, T20, T54, T60, T70, T98, T166, T167, T194, 
T204, T238, T244, T254, T255, T376, T396, T418, T428 Unit 6: T10, T14, 
T30, T58, T74, T75, T188, T208, T238, T254, T255, T284, T351, T378, T382, 
T398, T414, T420, T430, T431

Students will understand 
phonological awareness.

phoneme, syllable, 
phonological awareness reinforce

LA.1.F.2.a

a. Identify, segment and blend 
phonemes in single syllable spoken 
three and four phoneme words 
including words with blends.

Students will understand 
phonological awareness.

phoneme, syllable, 
phonological awareness reinforce

LA.1.F.2.b
b. Delete initial and final phonemes in 
words.

Teacher’s Edition: Unit 1: T274, T309, T352, T385 Unit 3: T100, T132, T147, 
T354, T385 Unit 4: T384, T416, T427 Unit 5: T150, T167 Unit 6: T398, T431 

Students will understand 
phonological awareness.

phoneme, syllable, 
phonological awareness reinforce

LA.1.F.2.c

c. Substitute phonemes in spoken words 
to build new words in single-syllable 
words with no blends.

Teacher’s Edition: Unit 1: T192, T229 Unit 2: T190, T223 Unit 3: T30, T67 
Unit 4: T240, T251, T336, T347 Unit 5: T108, T156, T167, T204, T255, T284, 
T338, T349 Unit 6: T64, T150, T161, T208, T244, T255, T340, T351

Students will understand 
phonological awareness.

phoneme, syllable, 
phonological awareness reinforce

LA.1.F.2.d

d. Add or substitute individual sounds 
(phonemes in simple, one-syllable words 
to make new words (e.g., “Say ‘map.’ 
Say it again and instead of /p/ say /t/. 
What is the new word? ‘Mat’”).

Teacher’s Edition: Unit 1: T192, T229 Unit 2: T190, T223, T338, T364, T379 
Unit 3: T20, T30, T67 Unit 4: T240, T251, T336, T347, T416, T427, T167 
Unit 5: T204, T238, T255, T338 Unit 6: T64, T150, T161, T208, T244, T255, 
T340, T414, T430

Students will understand 
phonological awareness.

phoneme, syllable, 
phonological awareness reinforce

Phonics and Word Analysis
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LA.1.F.3

Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition: Unit 1: S13, S19, S25, S31, S37, S45, S51, S57, S69, S101, 
T10, T20, T52, T66, T100, T134, T148, T254, T274, T294, T308, T352, T385 
Unit 3: T10, T20, T52, T67, T90, T147, T170, T228, T334, T354, T385 Unit 
4: T10, T20, T56, T72, T120, T161, T188, T250, T374, T384, T416, T427 
Unit 5: T10, T14, T20, T54, T60, T70, T98, T167, T194, T204, T238, T244, 
T255, T376, T396, T418 Unit 6: T10, T14, T30, T54, T75, T188, T208, T238, 
T255, T284, T374, T395, T414, T431

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.a

a. Decode and encode words using 
knowledge of sound-spelling 
correspondence for common 
consonant digraphs, tri-graphs, and 
blends.

Teacher’s Edition: Unit 1: T274 Unit 2: T174, T180, T190, T232, T248, T258, 
T290, T308, T328 Unit 3: T170, T180, T190 Unit 4: T10

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.b

b. Decode and encode simple words 
with r-controlled vowels.

Teacher’s Edition: Unit 5: T10-T11, T20-T21, T30-T31, T54, T60, T72, T73, 
T82, T98-T99, T104, T108-T109, T118-T119, T150, T156, T168, T169, T178, 
T194-T195, T204-T205, T210, T214-T215, T238, T244, T256, T257 Unit 6: 
T108, T378-T379, T388-T389, T398-T399, T414, T420, T432, T433

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.c

c. Decode and encode regularly 
spelled one-syllable words.

Unit 1: S20-S21, S26-S27, S32, S38-S39, S46-S47, S52, S58-S59, S64, S70-
S71, S78-S79, S84, S90-S91, S96, S102, T10-T11, T16, T20-T21, T26, T30-
T31, T52-T53, T58, T68, T69, T76, T90-T91, T96, T100-T101, T106, T110-
T111, T134-T135, T140, T150, T151, T158, T172-T173, T178, T182-T183, 
T192-T193, T214-T215, T220, T230, T231, T238, T254-T255, T260, T264-
T265, T270, T272-T273, T294-T295, T300, T311, T318, T332-T333, T342-
T343, T348, T352-T353, T370-T371, T376, T386, T387, T394 Unit 2: T10-
T11, T16, T20-T21, T26, T30-T31, T52-T53, T58, T68, T69, T76, T90-T91, 
T96, T100-T101, T106, T110-T111, T132-T133, T138, T148, T149, T156, 
T170-T171, T176, T180-T181, T186, T190-T191, T208, T214, T224, T225, 
T248-T249, T254, T258-T259, T264, T268-T269, T290, T296, T306, T307, 
T328-T329, T334, T338-T339, T344, T348-T349, T364-T365, T370, T380, 
T381 Unit 3: T10-T11, T16, T20-T21, T26, T30-T31, T52-T53, T58-T59, 
T68, T69, T90-T91, T96, T100-T101, T106, T110-T111, T132-T133, T138, 
T148, T149, T170-T171, T176, T180-T181, T186, T190-T191, T214-T215, 
T220, T230, T231, T254-T255, T260, T264-T265, T270, T274-T275, T296-
T297, T302, T312, T313, T334-T335, T340, T344-T345, T350, T354-T355, 
T370, T376, T386, T387 Unit 4: T10-T11, T16, T20-T21, T26, T30-T31, T56, 
T62, T74, T75, T100-T101, T106, T110-T111, T120-T121, T144, T150, T162, 
T163, T172, T188-T189, T194, T198-T199, T204, T208-T209, T234, T240, 
T252, T253, T280-T281, T286, T290-T291, T296, T300-T301, T330, T336, 
T348, T349, T374-T375, T380, T384-T385, T390, T394-T395, T410, T416, 
T428 Unit 5: T10-T11, T16, T20-T21, T26, T30-T31, T54, T60, T72, T73, 
T98-T99, T104, T108-T109, T114, T118-T119, T150, T156, T168, T169, 
T194-T195, T200, T204-T205, T210, T214-T215, T238, T284-T285, T290, 
T294-T295, T300, T304-T305, T332, T338, T350, T351, T376-T377, T382, 
T386-T387, T392, T396-T397, T412, T418-T419, T430, T431 Unit 6: T10-
T11, T16, T20-T21, T26, T30-T31, T58-T59, T64, T76, T77, T102-T103, 
T108, T112-T113, T118, T122-T123, T144, T150, T162, T163, T188-T189, 
T194, T198-T199, T204, T208-T209, T238, T244, T256, T257, T290, T300, 
T378-T379, T384, T388-T389, T394, T398-T399, T414, T420, T432, T433

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce



1

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

F
o
u
n
d
a
t
i
o
n
s
 
o
f
 
R
e
a
d
i
n
g

LA.1.F.3.d

d. Decode and encode final -e and 
common vowel team conventions for 
representing long vowel sounds.

Teacher’s Edition: Unit 3: T10, T20, T52, T90, T100, T110, T254, T264, 
T274, T296, T302 Unit 4: T20, T30, T100, T140, T150, T188, T198, T208, 
T284, T300

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.e

e. Decode and encode two-syllable 
words with regular patterns by breaking 
the words into syllables.

Teacher’s Edition: Unit 2: T259, T269, T291, T297, T308 Unit 3: T265, T275, 
T297, T303, T314 Unit 4: T39, T130, T199, T209, T213, T234, T240, T254 
Unit 5: T39, T129, T387, T397, T412, T418, T432 Unit 6: T113, T123, T144, 
T150, T164, T317, T389, T399, T414, T420, T434

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.f

f. Decode and encode words with 
inflectional endings.

Teacher’s Edition: Unit 1: T21, T31, T53, T59, T70, T183, T193, T215, T221, 
T232, T425 Unit 2: T21, T31, T53, T70, T181, T191, T209, T215, T226, 
T339, T349 Unit 3: T101, T111, T133, T150, T181, T191, T215, T232, T345, 
T371 Unit 4: T291, T301, T330, T350 Unit 5: T295, T305, T332, T352, T389, 
T473 Unit 6: T58, T78, T295, T305, T334, T354, T475

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.g

g. Use knowledge that every syllable 
must have a vowel sound to determine 
the number of syllables in a printed 
word.

Teacher’s Edition: Unit 2: T258, T268 Unit 3: T364, T274, T314 Unit 4: 
T208, T234, T240, T254

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

LA.1.F.3.h

h. Recognize and read grade-
appropriate, irregularly spelled words.

Teacher’s Edition: Unit 1: S15, T13, T15, T23, T33, T175, T177, T195, T257, 
T259, T267, T295, T301 Unit 2: T13, T23, T33, T71, T93, T103, T151, T173, 
T183, T209, T227, T261, T291, T309 Unit 3: T13, T23, T33, T71, T93, T103, 
T133, T151, T173, T183, T221, T233, T257, T267, T303 Unit 4: T13, T23, 
T33, T77, T103, T145, T165, T191, T201, T235, T255, T283, T302, T331 
Unit 5: T13, T23, T33, T75, T101, T151, T171, T197, T207, T239, T259, 
T287, T306, T339 Unit 6: T13, T23, T33, T79, T105, T124, T151, T191, 
T201, T239, T245, T259, T287, T306, T335

Students will use phonics 
strategies to decode and 
encode words. phonics, decode, encode reinforce

Fluency

LA.1.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level texts to support 
comprehension.

Teacher’s Edition: Unit 1: T65, T75, T79, T147, T157, T161, T227, T237, 
T241, T307, T317, T321, T383, T393, T397 Unit 2: T65, T75, T79, T145, 
T155, T159, T221, T231, T235, T303, T313, T317, T377, T387, T391 Unit 3: 
T65, T75, T79, T145, T155, T159, T227, T237, T241, T309, T319, T323, 
T383, T393, T397 Unit 4: T69, T81, T87, T157, T169, T175, T247, T259, 
T265, T343, T355, T361, T423, T435, T441 Unit 5: T67, T79, T85, T163, 
T175, T181, T251, T263, T269, T345, T357, T361, T425, T437, T443 Unit 6: 
T71, T83, T89, T157, T169, T175, T251, T263, T269, T347, T359, T365, 
T427, T439, T445

The students will develop 
accuracy, phrasing, and 
expression while reading a 
variety of grade-level texts 
to support comprehension.comprehension, accuracy, expression reinforce

LA.1.F.4.a

a. Read decodable text accurately with 
appropriate rate, intonation, and
 expression/prosody to reflect meaning.

Teacher’s Edition: Unit 1: T72, T77, T81, T155, T159, T163, T235, T239, 
T243, T315, T319, T323, T391, T395, T399, T441 Unit 2: T73, T77, T81, 
T153, T157, T161, T229, T233, T237, T311, T315, T319, T385, T389, T393, 
T435 Unit 3: T73, T77, T81, T153, T157, T161, T235, T239, T243, T317, 
T321, T325, T391, T395, T399, T441 Unit 4: T79, T85, T91, T156, T168, 
T174, T257, T263, T269, T433, T435, T445, T489 Unit 5: T77, T83, T89, 
T162, T174, T180, T261, T267, T273, T344, T356, T362, T447, T491 Unit 6: 
T72, T84, T90, T158, T176, T252, T261, T267, T273, T346, T358, T364, 
T437, T493

The students will develop 
accuracy, phrasing, and 
expression while reading a 
variety of grade-level texts 
to support comprehension.comprehension, accuracy, expression reinforce
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LA.1.F.4.b

b. Read grade level high-frequency 
words with automaticity and accuracy 
(e.g., Fry or Dolch words or those 
included in instructional materials).

Teacher’s Edition: Unit 1: S15, S21, S27, S33, S39, S47, S53, S59, S65, S71, 
S79, S85, S91, S97, S103, T13, T23, T33, T53, T59, T71, T76, T93, T103, 
T113, T135, T141, T153, T158, T175, T185, T195, T215, T221, T233, T238, 
T257, T267, T277, T295, T301, T313, T318, T335, T345, T355, T371, T377, 
T389, T394 Unit 2: T13, T23, T33, T53, T59, T71, T76, T93, T103, T113, 
T133, T139, T151, T156, T173, T183, T193, T209, T215, T227, T232, T251, 
T261, T271, T291, T297, T309, T314, T331, T341, T351, T365, T371, T383, 
T388 Unit 3: T13, T23, T33, T53, T59, T71, T76, T93, T103, T113, T133, 
T139, T151, T156, T173, T183, T193, T215, T221, T233, T238, T257, T267, 
T277, T297, T303, T315, T320, T337, T347, T357, T371, T377, T389, T394 
Unit 4: T13, T22, T32, T57, T63, T77, T84, T103, T112, T122, T145, T151, 
T165, T172, T191, T200, T210, T235, T241, T255, T283, T202, T302, T331, 
T337, T351, T377, T386, T396, T411, T417, T431 Unit 5: T13, T22, T32, 
T55, T61, T75, T101, T110, T120, T151, T157, T158, T171, T197, T206, 
T216, T239, T245, T259, T287, T296, T306, T333, T339, T353, T379, T388, 
T398, T413, T419, T433 Unit 6: T13, T22, T32, T59, T65, T79, T105, T114, 
T124, T145, T151, T165, T191, T200, T210, T239, T245, T259, T287, T296, 
T306, T335, T341, T355, T381, T390, T400, 415, T421, T435

The students will develop 
accuracy, phrasing, and 
expression while reading a 
variety of grade-level texts 
to support comprehension.comprehension, accuracy, expression reinforce
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Central Ideas and Details

LA.1.RP.1

Retell familiar stories, including key 
details, and demonstrate understanding 
of their central message or lesson from a 
literary text.

Teacher’s Edition: Unit 1: T9, T15, T65, T75, T79, T171, T177, T253 Unit 2: 
T9, T65, T75, T79, T89, T95, T145, T155, T159, T303 Unit 3: T9, T65, T75, 
T79, T89, T145, T155, T159, T169, T185, T227, T235, T237, T239, T241, 
T243 Unit 4: T24, T69, T70, T81, T82, T87, T88, T373 Unit 5: T9, T67, T68, 
T79, T81, T85, T87, T375 Unit 6: T101, T187, T347, T348, T357, T359, 
T360, T363, T365, T366, T369

The students will cite text 
evidence to support ideas 
and themes in grade level 
text.

text evidence, theme, 
retell, key details, 

characters, setting, 
events reinforce

LA.1.RP.2

Identify the main character(s), setting, 
and important events, drawing on key 
details in a literary text.

Teacher’s Edition: Unit 1: S16, T14, T105, T160, T187, T226, T235, T236, 
T239, T240, T243 Unit 2: T25, T64, T72, T73, T74, T77, T78, T81, T105, 
T144, T152, T153, T154, T157, T158, T161, T263, T302, T310, T311, T312, 
T316, T347 Unit 3: T25, T64, T73, T74, T77, T78, T81, T104-T105, T144-
T145, T153, T154-T155, T157, T158-T159, T161 Unit 4: T25, T29, T68, T70, 
T79, T80, T82, T85, T88, T91, T294-T295, T352 Unit 5: T24-T25, T29, T76, 
T112-T113, T117, T162-T163, T164, T173, T174, T176, T179, T180, T182, 
T185, T299, T344, T346, T355, T356, T358, T361, T362, T364, T367 Unit 6: 
T24, T29, T202, T252, T261, T262, T264, T267, T268, T270, T273, T298, 
T303, T486

The students will cite text 
evidence to support ideas 
and themes in grade level 
text.

text evidence, theme, 
retell, key details, 

characters, setting, 
events reinforce

Author's Craft

LA.1.RP.3

Explain the difference between the roles 
of author and narrator or speaker in a 
literary text.

Teacher’s Edition: Unit 1: T128, T129, T366 Unit 2: T89, T262 Unit 3: T24, 
T37, T38, T104 Unit 4: T295, T342, T344, T353, T354, T356, T359, T360, 
T362, T365 Unit 5: T25, T36, T38, T40, T66-T67, T68, T77, T78-T79, T80, 
T83, T84, T86, T89, T303, T312

The students will cite 
evidence to support the 
ideas of the author, and 
define basic 
characteristics of literary 
text. author, narrator, speaker, characteristics introduce

LA.1.RP.4

Identify the basic characteristics of 
literary text, drawing on a wide range of 
text types.

Teacher’s Edition: Unit 1: S87, T441 Unit 2: T435 Unit 3: T24, T441 Unit 4: 
T489 Unit 5: T491 Unit 6: T493

The students will cite 
evidence to support the 
ideas of the author, and 
define basic 
characteristics of literary 
text. author, narrator, speaker, characteristics introduce
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Knowledge and Ideas

LA.1.RP.5

Compare and contrast the experiences 
of characters in familiar stories.

Teacher’s Edition: Unit 1: S28, S72, T128, T144, T205, T224 Unit 2: T300 
Unit 3: T62, T224

Students will make 
connections with literary 
text. compare/contrast, key details, background knowledgereinforce

LA.1.RP.6

Ask and answer questions about key 
details in a literary text.

Teacher’s Edition: Unit 1: T252, T258, T306, T316, T320, T336, T382, T392, 
T396 Unit 4: T68, T80, T86, T317, Unit 5: T107, T235, T289, T312, T344, 
T356, T362, T385, Unit 6: T207, T486

Students will make 
connections with literary 
text. compare/contrast, key details, background knowledgereinforce

LA.1.RP.7

Make connections between own 
experiences and other cultures in literary 
texts. Teacher’s Edition: Unit 6: T223, T345, T361

Students will make 
connections with literary 
text. compare/contrast, key details, background knowledgereinforce

LA.1.RP.8

With prompting and support, read 
andcomprehend a wide range of 
literary texts of appropriate
complexity for Grade 1.

Unit 1: T14-T15, T34-T40, T64-T65, T74-T75, T78-T79, T94-T95, T114-
T122, T146-T147, T156-T157, T160-T161, T176-177, T196-T204, T291, 
T292-T293 Unit 2: T14-T15, T94-T95, T205, T252-T253 Unit 3: T14-T15, 
T94-T95, T174-T175, T194-T202, T208-T212, T226-T227, T236-T237, 
T240-T241 Unit 4: T14-T15, T34-T44, T68, T769, T70-T71, T80-T81, T82-
T83, T86-T87, T88-T89, T231, T232-T233, T284-T285, T304-T320, T342-
T343, T344-T345, T353, T354-T355, T356-T357, T359, T360-T361, T362-
T363, T365 Unit 5: T14-T15, T34-T42, T66-T67, T68-T69, T78-T79, T80-
T81, T84-T85, T86-T87, T102-T103, T122-T138, T162-T163, T64-T165, 
T173, T174-T175, T76-T177, T179, T180-T181, T182-T183, T185, T355, 
T361, T367, T484 Unit 6: T14-T15, T34-T46, T70-T71, T72-T73, T81, T82-
T83, T84-T85, T87, T88-T89, T90-T91, T93, T142-T143, T192-T193, T212-
T228, T250-T251, T252-T253, T261, T262-T263, T264-T265, T267, T268-
T269, T270-T271, T273, T288-T289, T308-T324, T346-T347, T348-T349, 
T357, T358-T359, T360-T361, T363, T364-T365, T366-T367, T369, T486

Students will make 
connections with literary 
text. compare/contrast, key details, background knowledgereinforce
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LA.1.RI.1

Teacher’s Edition: Unit 1: S80, S86, S92, S98, T269, T306, T315, T316, 
T319, T320, T323, T347, T382, T390, T391, T392, T395, T396, T399 Unit 2: 
T228, T343, T376, T384, T385, T386, T390 Unit 3: T316, T390 Unit 4: T115, 
T156, T158, T167, T168-T169, T170, T173, T174-T175, T176-T177, T179, 
T482 Unit 6: T121, T166, T397, T436

The students will cite 
evidence to support the 
ideas of the author, and 
define basic 
characteristics of 
informational text.main topic, key details, text features, informational textreinforce

LA.1.RI.2
Teacher’s Edition: Unit 1: T62, T99, T197, T198, T200, T202 Unit 3: T268, 
T308, T317, T318, T321, T322, T325 Unit 4: T119 Unit 6: T329

The students will cite 
evidence to support the 
ideas of the author, and 
define basic 
characteristics of 
informational text.main topic, key details, text features, informational textreinforce

complexity for Grade 1.

LA.1.RI.3

Define the role of the author and 
illustrator in presenting the ideas or 
information in a text.

Teacher’s Edition: Unit 1: T47, T268, T273 Unit 2: T184, T221, T229, T230, 
T233, T234, T237 Unit 3: T291 Unit 4: T139, T207, T393 Unit 5: T260 Unit 
6: T156, T158, T167, T168, T170, T173, T174, T176, T179, T392, T426, 
T438, T444, T488

Students will use text 
features to understand 
informational text. text features, informational text introduce

LA.1.RI.4

Use text features (titles, headings, 
visuals) to predict or confirm the topic of 
a text.

Teacher’s Edition: Unit 1: S50, S62, T45, T127, T209, T365, T432 Unit 2: 
T47, T127, T285, T361, T426 Unit 3: T47, T139, T325, T388, T414, T478, 
T482, T484 Unit 4: T49, T139, T325, T388, T414, T478, T482, T484 Unit 5: 
T47, T327.T390, T409, T480, T486 Unit 6: T51, T233, T242, T329, T411, 
T482, T488

Students will use text 
features to understand 
informational text. text features, informational text introduce

Knowledge and Ideas
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LA.1.RI.5

Identify basic similarities and differences 
between two informational texts on the 
same topic.

Teacher’s Edition: Unit 1: S104, S105, T241, T304, T380, T383, T393, T397 
Unit 2: T62, T142, T158, T218, T316, T374, T376, T386, T390 Unit 3: T142, 
T158, T306, T308, T318, T322, T380 Unit 4: T66, T86, T154, T156, T168, 
T174, T244, T264, T340, T342, T354, T360, T420, T440, T486 Unit 5: T84, 
T160, T162, T180, T248, T268, T342, T344, T356, T362, T422, T488 Unit 6: 
T68, T88, T154, T156, T168, T174, T248, T268, T344, T346, T358, T364, 
T424, T444, T490

Students will make 
connections with 
informational text. similarities/differences, topic, opinion reinforce

LA.1.RI.6

Identify an author’s opinion(s) about a 
text.

Teacher’s Edition: Unit 4: T207, T393 Unit 6: T116, T156, T158, T167, T168. 
T170, T173, T174, T176, T179, T392, T426, T428, T437, T438, T440, T443, 
T444, T446, T449, T462, T488

Students will make 
connections with 
informational text. similarities/differences, topic, opinion reinforce

LA.1.RI.7

Make connections between own 
experiences and other cultures in 
informational texts. Teacher’s Edition: Unit 1: T432-T433 Unit 6: T383

Students will make 
connections with 
informational text. similarities/differences, topic, opinion reinforce

Range of Reading and Level of 
Text Complexity

LA.1.RI.8

With prompting and support, read and 
comprehend a wide range of 
informational texts of appropriate 
complexity for Grade 1.

Teacher’s Edition: Unit 1: T46-T51, T210-T213, T258, T278-T287, T306, 
T316, T320, T336, T356-T359, T382, T392, T396, T444, T445, T446, T447 
Unit 2: T174-T175, T332-T333, T438, T439, T440, T441 Unit 3: T48-T50, 
T128-T130, T258-T259, T278-T286, T292-T294, T308-T309, T318-T319, 
T322-T323, T338-T339, T358-T361, T368-T369, T382-T383, T392-T393, 
T396-T397, T444, T445, T446, T447 Unit 4: T50-T54, T104-T105, T124-
T134, T140-T142, T156-T157, T158-T159, T167, T168-T169, T170-T171, 
T173, T174-T175, T176-T177, T179, T192-T193, T212-T226, T246-T247, 
T248-T249, T257, T258-T259, T260-T261, T263, T264-T265, T266-T267, 
T269, T326-T328, T378-T379, T398-T401, T408-T409, T422-T423, T424-
T425, T433, T434-T435, T436-T437, T439, T440-T441, T442-T443, T445,, 
T482, T484, T492, T493, T494, T495 Unit 5: T144-T148, T198-T199, T218,-
T228, T250-T251, T252-T253, T261, T262-T263, T264-T265, T267, T268-
T269, T270-T271, T273, T328-T331, T380-T381, T400-T403, T410-T411, 
T424-T425, T426-T427, T435, T436-T437, T438-T439, T441, T442-T443, 
T444-T445, T447, T486, T494, T495, T496, T497 Unit 6: T106-T17, T126-
T137, T156-T157, T158-T159, T167, T168-T169, T170-T171, T173, T174-
T175, T176-T177, T179, T330-T333, T382-T383, T402-T407, T412-T413, 
T426-T427, T428-T429, T437, T438-T439, T440-T441, T443, T444-T445, 
T446-T447, T449, T488, T496, T497, T498, T499

Students will read and 
comprehend a wide range 
of informational text. range, comprehend reinforce
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Acquisition and Use

LA.1.V.1

Build and use a range of conversational, 
academic, and discipline-specific 
grade-level vocabulary.

Teacher’s Edition: Unit 1: T19, T29, T99, T109, T242, T341, T351, T398 Unit 
2: T160, T236, T336 Unit 3: T99, T109, T324 Unit 4: T98, T112, T158, T170, 
T176, T278, T292, T344, T356, T362, T444 Unit 5: T192, T272, T366 Unit 6: 
T178, T368

Students will build and use 
a range of grade-level 
vocabulary. conversational, academic, discipline-specific reinforce

LA.1.V.1.a

a. Use sentence-level context clues to 
determine the meaning of a word or 
phrase.

Students will build and use 
a range of grade-level 
vocabulary. conversational, academic, discipline-specific reinforce

LA.1.V.1.b

b. Use commonly occurring affixes to 
determine the meaning of unknown 
words.

Teacher’s Edition: Unit 2: T19, T29, T382 Unit 3: T398 Unit 4: T110, T120, 
T144, T164, T178 Unit 5: T108, T118, T150, T170, T184, T206, T252, T264, 
T270, T282, T296, T346, T358, T364 Unit 6: T20

Students will build and use 
a range of grade-level 
vocabulary. conversational, academic, discipline-specific reinforce
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LA.1.V.1.c

c. Identify commonly occurring root 
words and their inflectional forms.

Teacher’s Edition: Unit 2: T257, T267 Unit 3: T232, T263, T273, T388 Unit 
4: T372, T386, T424, T436, T442 Unit 5: T150, T332, T374, T426, T438, 
T444 Unit 6: T30, T78, T238, T414

Students will build and use 
a range of grade-level 
vocabulary. conversational, academic, discipline-specific reinforce

LA.1.V.1.d

d. Determine the meanings of key words 
and phrases using provided reference 
materials and classroom resources.

Teacher’s Edition: Unit 1: T35, T181, T191 Unit 2: T35, T126 Unit 3: T35, 
T445 Unit 4: T9, T23, T35, T36, T70, T82, T88, T125, T35 Unit 5: T35 Unit 
6: T35, T41, T140

Students will build and use 
a range of grade-level 
vocabulary. conversational, academic, discipline-specific reinforce

Context and Connotations

LA.1.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher's Edition: Unit 1: S53, S65, S85 Unit 4: T187, T248, T260, T266, 
T331

Students will interpret a 
variety of language in 
grade-level text. figurative, connotative, technical, grammar vocabreinforce

LA.1.V.2.a

a. Sort common words and phrases into 
conceptual categories to develop an 
understanding of word relationships.

Teacher's Edition: Unit 1: S53, S65, S85 Unit 4: T187, T248, T260, T266, 
T331

Students will interpret a 
variety of language in 
grade-level text. figurative, connotative, technical, grammar vocabreinforce

LA.1.V.2.b

b. Define words by their category and 
simple attributes (e.g., a duck is a bird 
that swims).

Teacher's Edition: Unit 1: S21, S33, S65, S85, S97 Unit 4: T201, T331 Unit 6: 
T23, T43, T115, T335

Students will interpret a 
variety of language in 
grade-level text. figurative, connotative, technical, grammar vocabreinforce

LA.1.V.2.c

c. Ask and answer questions about key 
words and phrases to determine their 
meaning.

Teacher’s Edition: Unit 1: T44, T126, T208, T290, T364 Unit 2: T46, T204, 
T284, T360 Unit 3: T46, T126, T206, T290, T366 Unit 4: T18, T48, T108, 
T138, T196, T230, T324, T382, T406 Unit 5: T18, T46, T106, T142, T202, 
T232, T292, T326, T384, T408 Unit 6: T18, T50, T110, T140, T196, T232, 
T292, T328, T386, T410

Students will interpret a 
variety of language in 
grade-level text. figurative, connotative, technical, grammar vocabreinforce

LA.1.V.2.d

d. Distinguish nuances of meaning 
between common verbs (e.g., glance, 
stare) and adjectives differing in 
intensity (e.g., large, gigantic).

Teacher’s Edition: Unit 2: T109 Unit 4: T364 Unit 5: T96, T110, T164, T176, 
T182

Students will interpret a 
variety of language in 
grade-level text. figurative, connotative, technical, grammar vocabreinforce
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Apply handwriting skills to 
communicate ideas and 
information.

LA.1.FW.1

Demonstrate and apply handwriting 
skills.

Teacher’s Edition: Unit 1: S14, S20, S26, S32, S38, S46, S52, S58, S64, S70, 
S84, S90, S102, T10, T90, T172, T254, T332 Unit 2: T10, T90, T170, T248, 
T328 Unit 3: T10, T90, T170, T254, T334 Unit 4: T10, T100, T188, T280, 
T374, T466 Unit 5: T10, T98, T194, T284, T376 Unit 6: T10, T102, T188, 
T284, T378

Students will demonstrate 
and apply handwriting 
skills. upper and lowercase, grapheme reinforce

LA.1.FW.1.a

a. Print all upper and lowercase 
manuscript letters using correct 
formation.

Students will demonstrate 
and apply handwriting 
skills. upper and lowercase, grapheme reinforce

LA.1.FW.1.b

b. Write the common grapheme (letter 
or letter group) for each phoneme.

Teacher’s Edition: Unit 1: T16, T22, T26, T54, T96, T106, T178, T188, T260, 
T270, T338, T348, T420 Unit 2: T16, T26, T96, T106, T176, T186, T254, 
T264, T334, T344, T414 Unit 3: T16, T26, T96, T106, T176, T186, T260, 
T270, T340, T350 Unit 4: T16, T26, T106, T194, T204, T286, T296, T380, 
T390, T466 Unit 5: T16, T26, T104, T114, T200, T210, T290, T300, T382, 
T392 Unit 6: T16, T26, T108, T118, T194, T204, T290, T300, T384, T394

Students will demonstrate 
and apply handwriting 
skills. upper and lowercase, grapheme reinforce
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LA.1.FW.1.c

c. Use appropriate spacing between 
letters and words.

Teacher’s Edition: Unit 1: S17, S23, S29, S35, S41, S49, S55, S61, S67, S73, 
S81, S87, S93, S99, S105, T348, T362, T372, T422 Unit 2: T416 Unit 3: T422 
Unit 4: T468, T470 Unit 6: T472

Students will demonstrate 
and apply handwriting 
skills. upper and lowercase, grapheme reinforce

LA.1.FW.2

Demonstrate sound-letter concepts 
when writing.

Teacher’s Edition: Unit 1: S89, S95, T16, T22, T26, T54, T58, T67, T96, 
T102, T106, T140, T178, T188, T220, T229, T260, T264, T270, T300, T309, 
T338, T348, T384, T420 Unit 2: T16, T26, T58, T92, T96, T106, T138, T147, 
T148, T176, T186, T214, T254, T264, T296, T328, T334, T344, T370, T378, 
T379, T414 Unit 3: T16, T26, T58, T66, T96, T106, T110, T138, T146, T176, 
T180, T186, T214, T220, T229, T254, T260, T270, T274, T302, T310, T311, 
T334, T340, T350, T370, T384, T385 Unit 4: T16, T26, T62, T73, T106, 
T110, T150, T161, T194, T204, T286, T296, T300, T336, T347, T380, T390, 
T466 Unit 5: T16, T26, T60, T71, T104, T114, T200, T210, T244, T254, 
T290, T300, T382, T386, T392, T429 Unit 6: T16, T20, T26, T75, T108, 
T118, T194, T198, T204, T254, T290, T300, T384, T394

Students sound-letter 
concepts when writing.phoneme, syllables, vowel, consonant reinforce

LA.1.FW.2.a
a. Segment phonemes in two- and 
three-phoneme syllables.

Students sound-letter 
concepts when writing.phoneme, syllables, vowel, consonant reinforce

LA.1.FW.2.b

b. Write letters used to represent vowel 
phonemes and those used to represent 
consonants; demonstrate 
understanding that every syllable has a 
vowel.

Teacher’s Edition: Unit 1: T12, T16, T22, T26, T92, T178, T256, T260, T420 
Unit 2: T12, T96, T176, T414 Unit 3: T16, T26, T96, T186, T260 Unit 4: T16, 
T194, T390, T466 Unit 5: T104, T210, T382 Unit 6: T16, T26, T108, T118, 
T194, T384

Students sound-letter 
concepts when writing.phoneme, syllables, vowel, consonant reinforce

Production of Writing

LA.1.W.1

Write and expand grammatically 
correct simple sentences and 
paragraphs.

Teacher’s Edition: Unit 1: T424 Unit 2: T282, T292, T298, T418 Unit 3: T424 
Unit 4: T470 Unit 5: T472 Unit 6: T138, T146, T152, T474

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce

LA.1.W.1.a

a. Capitalize proper nouns (e.g., days of 
the week, names of people). Teacher’s Edition: Unit 1: T424 Unit 2: T282, T292, T298, T418 Unit 3: T424 

Unit 4: T470 Unit 5: T472 Unit 6: T138, T146, T152, T474

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce

LA.1.W.1.b

b. Use end punctuation, commas in 
dates, and commas to separate single 
words in a series.

Teacher’s Edition: Unit 1: T125, T137, T143, T207, T217, T223, T363, T373, 
T379, T408-T409, T423 Unit 2: T417 Unit 3: T423 Unit 4: T137, T147, T153, 
T469 Unit 5: T141, T153, T159, T471 Unit 6: T473

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce

LA.1.W.1.c

c. Identify and use nouns (e.g., 
common, proper), pronouns (e.g., 
personal and possessive), verbs (e.g., 
past, present), and descriptive 
adjectives.

Teacher’s Edition: Unit 2: T96, T106, T1245, T134, T140, T254, T264, T282, 
T292, T298, T402

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce

LA.1.W.1.d

d. Form and use regular and frequently 
occurring irregular plural nouns.

Teacher’s Edition: Unit 1: T183, T193, T215, T221, T232 Unit 2: T97, T107, 
T124, T125, T134, T135, T141, T335, T345, T358, T359, T366, T367, T373 
Unit 3: T101, T111, T133, T139, T150

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce

LA.1.W.1.e

e. Use subject-verb agreement in simple 
and compound sentences.

Teacher’s Edition: Unit 3: T97, T107, T125, T135, T141, T261, T271, T289, 
T299, TT305 Unit 4: T17, T27, T47, T59, T65, T107, T117, T137, T146, 
T153, T287, T323, T297, T333, T339

Students will write 
grammatically correct 
simple sentences and 
paragraphs. grammar, vocabulary, punctuation, capitalizationreinforce
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LA.1.W.2

Develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Teacher’s Edition: Unit 1: T406-T407, T413 Unit 2: T254, T264, T282, T292, 
T298, T334, T344, T358, T366, T372, T400 Unit 3: T60, T222, T364, T372, 
T407 Unit 4: T106, T116, T136, T194, T204, T228, T236, T380 Unit 5: T200, 
T210, T290, T300, T324, T382, T392, T406, T414, T454-T455, T456 Unit 6: 
T16, T26, T48, T60, T108, T118, T290, T300, T326, T336

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

LA.1.W.2.a

a. Use prewriting activities and resources 
to generate and organize ideas.

Teacher’s Edition: Unit 1: T406-T407, T413 Unit 2: T254, T264, T282, T292, 
T298, T334, T344, T358, T366, T372, T400 Unit 3: T60, T222, T364, T372, 
T407 Unit 4: T106, T116, T136, T194, T204, T228, T236, T380 Unit 5: T200, 
T210, T290, T300, T324, T382, T392, T406, T414, T454-T455, T456 Unit 6: 
T16, T26, T48, T60, T108, T118, T290, T300, T326, T336

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

LA.1.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: S11, S17, S23, S29, S35, S41, S49, S55, S61, S67, 
T73, S81, S87, S93, S99, S105, T16, T26, T42, T54, T60, T63, T96, T106, 
T124, T133, T136, T142, T145, T178, T188, T206, T222, T225, T260, T270, 
T288, T296, T302, T305, T338, T348, T362, T372, T378, T402-T411, T440 
Unit 2: T16, T26, T54, T60, T63, T96, T106, T124, T134, T140, T143, T176, 
T202, T210, T216, T219, T264, T282, T292, T298, T334, T344, T358, T366, 
T372, T375, T396-T405, T434 Unit 3: T16, T26, T44, T54, T60, T63, T96, 
T106, T124, T134, T140, T143, T176, T204, T216, T222, T225, T260, T288, 
T298, T304, T307, T340, T350, T364, T372, T378, T381, T402-T411, T437, 
T440 Unit 4: T16, T26, T46, T58, T64, T67, T106, T116, T136, T146, T152, 
T194, T204, T228, T236, T242, T245, T296, T322, T332, T338, T380, T390, 
T404, T412, T418, T421, T448-T457, T487 Unit 5: T16, T26, T44, T56, T62, 
T65, T104, T114, T140, T152, T200, T210, T230, T240, T246, T249, T290, 
T300, T324, T334, T340, T343, T382, T392, T406, T414, T420, T423, T450-
T459, T489, T491, T493 Unit 6: T16, T26, T48, T60, T66, T108, T118, T138, 
T146, T152, T155, T194, T204, T230, T240, T246, T290, T300, T326, T336, 
T342, T345, T384, T394, T408, T416, T422, T425, T452-T461, T495

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

LA.1.W.2.c

c. Use feedback from others to improve 
writing and/or add details.

Teacher’s Edition: Unit 1: T54, T136, T216, T296, T372, T408, T409 Unit 2: 
T54, T134, T210, T292, T366, T402 Unit 3: T54, T134, T216, T298, T372, 
T408, T409 Unit 4: T58, T146, T236, T332, T412, T454, T455 Unit 5: T56, 
T152, T240, T334, T414, T456, T457 Unit 6: T60, T146, T240, T336, T416, 
T458, T459

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

LA.1.W.2.d

d. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
font, graphics, symbols). Teacher’s Edition: Unit 1: T443 Unit 3: T333

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

LA.1.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Teacher’s Edition: Unit 1: T222, T302, T378, T408, T432 Unit 2: T140, T216, 
T298, T402, T426 Unit 3: T140, T304, T408, T432 Unit 4: T152, T338, T454, 
T478 Unit 5: T158, T340, T456, T480 Unit 6: T152, T342, T458, T482

Students will produce 
writing appropriate to the 
audience and purpose. purpose, audience, writing process reinforce

Modes of Writing
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LA.1.W.3

With prompting and support, write 
personal or fictional creative and/or 
expressive pieces that retell two or more 
appropriately sequenced events.

Teacher’s Edition: Unit 1: T178, T188, T206, T402, T404, T406, T410, T412, 
T413 Unit 2: T254, T264, T282, T396, T398, T400, T404, T406, T407 Unit 3: 
T16, T26, T44, T96, T106, T124, T176, T186, T204 Unit 4: T46, T286, T296, 
T322, T448, T450, T452, T456, T458, T459 Unit 5: T104, T114, T140, T290, 
T300, T324 Unit 6: T16, T26, T48, T194, T204, T230, T290, T300, T326

Students will write a 
sequenced narrative. narrative, sequence, details reinforce

LA.1.W.3.a
a. Include some relevant details. Students will write a 

sequenced narrative. narrative, sequence, details reinforce

LA.1.W.3.b
b. Use time order words to signal 
sequence of events. Teacher’s Edition: Unit 1: S17, T403, T406, T407, T413 Unit 2: T400, T407

Students will write a 
sequenced narrative. narrative, sequence, details reinforce

LA.1.W.3.c
c. Provide a sense of closure. Teacher’s Edition: Unit 1: T408, T413 Unit 2: T402, T407 Unit 5: T290, T324 

Unit 6: T26, T48, T290, T300, T326, T336
Students will write a 
sequenced narrative. narrative, sequence, details reinforce

LA.1.W.4

With prompting and support, express an 
opinion about a topic or text and 
provide a supporting reason.

Teacher’s Edition: Unit 1: S41, S55, S73 Unit 2: T16, T26, T44 Unit 3: T260, 
T270, T288, T340, T350, T364 Unit 4: T106, T116, T136 Unit 5: T16, T26, 
T44, T382, T392, T406 Unit 6: T384, T394, T408, T452, T454, T456, T460, 
T462, T463

Students will write a 
supported opinion piece of 
writing. opinion, topic, support reinforce

LA.1.W.4.a

a. Introduce a topic or text. Students will write a 
supported opinion piece of 
writing. opinion, topic, support reinforce

LA.1.W.4.b

b. State an opinion and provide a 
reason to support the opinion.

Teacher’s Edition: Unit 1: S41, S55, S73, T142, T145, T222, T378 Unit 2: 
T16, T26, T44, T54, T60, T372 Unit 3: T222, T225, T260, T288, T340, T364, 
T378 Unit 4: T64, T83, T106, T116, T136, T152, T171, T421, T437 Unit 5: 
T44, T62, T246, T382, T392, T406, T414, T420, T427, T439, T445 Unit 6: 
T66, T342, T384, T394, T408, T416, T441, T452, T456-T457, T458, T462

Students will write a 
supported opinion piece of 
writing. opinion, topic, support reinforce

LA.1.W.4.c

c. Provide a sense of closure.

Teacher’s Edition: Unit 5: T382, T392, T406, T414 Unit 6: T462

Students will write a 
supported opinion piece of 
writing. opinion, topic, support reinforce

LA.1.W.5

With prompting and support, write 
informative/explanatory pieces about a 
topic or text with supporting facts and 
details.

Teacher’s Edition: Unit 1: T16, T26, T42, T96, T106, T124, T260, T270, 
T288, T338 T348, T362, T429, T438, T440 Unit 2: T96, T106, T124, T176, 
T186, T202, T334, T344, T358, T423, T434 Unit 3: T402, T404, T406, T410, 
T412, T413, T429, T440 Unit 4: T16, T26, T194, T204, T228, T380, T390, 
T404, T475, T486, T488 Unit 5: T200, T210, T230, T450, T452, T454, T458, 
T460, T461, T477, T488, T490 Unit 6: T108, T118, T138, T479, T490

Students will write an 
informative piece with 
supporting facts and 
details. facts, support, details reinforce

LA.1.W.5.a

a. Introduce a topic. Students will write an 
informative piece with 
supporting facts and 
details. facts, support, details reinforce

LA.1.W.5.b

b. Develop a topic using supporting 
facts and details. Teacher’s Edition: Unit 1: T260, T288, T296, T338, T348, T362, T372 Unit 2: 

T334, T344, T358 Unit 3: T381, T406-T407, T412 Unit 4: T194, T228, T236

Students will write an 
informative piece with 
supporting facts and 
details. facts, support, details reinforce

LA.1.W.5.c

c. Use words and phrases related to the 
topic. Teacher’s Edition: Unit 2: T143, T219 Unit 3: T143 Unit 4: T67, T228, T245, 

T380, T404 Unit 5: T65, T249, T423 Unit 6: T345

Students will write an 
informative piece with 
supporting facts and 
details. facts, support, details reinforce
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LA.1.W.5.d

d. Provide a sense of closure.

Teacher’s Edition: Unit 3: T408, T413 Unit 4: T286, T322 Unit 6: T16

Students will write an 
informative piece with 
supporting facts and 
details. facts, support, details reinforce

LA.1.W.6

With prompting and support, identify 
information from provided sources to 
answer a question.

Teacher’s Edition: Unit 1: T56-T57, T138-T139, T218-T219, T298-T299, 
T305, T374-T375 Unit 2: T56-T57, T136-T137, T212-T213, T294-T295, 
T368-T369 Unit 3: T56-T57, T136-T137, T218-T219, T300-T301, T374-T375 
Unit 4: T60-T61, T148-T149, T238-T239, T334-T335, T414-T415 Unit 5: 
T58-T59, T154-T155, T242-T243, T336-T337, T416-T417 Unit 6: T62-T63, 
T148-T149, T242-T243, T338-T339, T418-T419

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

LA.1.W.6.a

a. Retell or recall information from 
provided sources.

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

LA.1.W.6.b

b. Use provided print and/or digital tools 
to gather information and ideas to 
answer questions.

Teacher’s Edition: Unit 1: T218-T219, T374-T375, T433 Unit 2: T136-T137, 
T212-T213, T427 Unit 3: T136-T137, T218-T219, T374-T375, T406, T412, 
T433 Unit 4: T60-T61, T148-T149, T238-T239, T334-T335, T414-T415, 
T479 Unit 5: T154-T155, T242-T243, T416-T417, T481 Unit 6: T242-T243, 
T418-T419, T483

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

LA.1.W.6.c

c. Sort evidence and information into 
categories. Teacher’s Edition: Unit 1: T56-T57, T263, T273, T298-T299 Unit 3: T56 Unit 

5: T58-T59, T65, T69, T81, T87 Unit 6: T7, T62-T63

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

LA.1.W.6.d

d. Use provided print and/or digital tools 
to gather information and ideas and to 
answer questions.

Teacher’s Edition: Unit 1: T218-T219, T374-T375, T433 Unit 2: T136-T137, 
T212-T213, T427 Unit 3: T136-T137, T218-T219, T374-T375, T406, T412, 
T433 Unit 4: T60-T61, T148-T149, T238-T239, T334-T335, T414-T415, 
T479 Unit 5: T154-T155, T242-T243, T416-T417, T481 Unit 6: T242-T243, 
T418-T419, T483

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

LA.1.W.6.e

e. Practice safe behaviors when 
communicating and interacting with 
others digitally (e.g., safe information to 
share, utilize appropriate sites and 
materials). Teacher’s Edition: Unit 1: T433

Students will answer 
questions with text 
evidence from a variety of 
sources. text evidence, sources reinforce

Comprehension and Collaboration
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LA.1.SL.1

Participate with peers and adults in 
structured discussions and routines 
about 1st grade topics and texts.

Teacher’s Edition: Unit 1: S10, S12, S18, S30, S44, S56, S76, S82, S88, S94, 
S100, T7, T54, T56-T57, T60, T87, T138-T139, T142, T169, T218, T222, 
T251, T298-T299, T302, T329, T374-T375, T378 Unit 2: T7, T56-T57, T87, 
T136-T137, T140, T167, T212-T213, T216, T245, T294-T295, T298, T325, 
T368-T369, T372 Unit 3: T7, T56-T57, T87, T136-T137, T167, T218-T219, 
T222, T251, T300-T301, T304, T331, T374-T375, T378 Unit 4: T7, T60-T61, 
T97, T148-T149, T152, T185, T238-T239, T242, T277, T334-T335, T338, 
T371, T414-T415 Unit 5: T7, T58-T59, T62, T95, T154-T155, T158, T191, 
T242-T243, T281, T336-T337, T340, T373, T416-T417, T420 Unit 6: T7, 
T62-T63, T99, T148-T149, T185, T242-T243, T281, T338-T339, T342, T375, 
T418-T419

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce

LA.1.SL.1.a

a. Ask pertinent questions to acquire or 
confirm information.

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce
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LA.1.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Teacher’s Edition: Unit 1: S12, S18, S56, S75, S76, S82, S100, T7, T56-T57, 
T138, T169, T218, T222, T298-T299, T302, T410 Unit 2: T7, T56-T57, T167, 
T212, T245, T294-T295, T325, T404 Unit 3: T56-T57, T87, T222, T251, 
T300-T301, T331, T374 Unit 4: T60, T242, T277, T334, T338, T374 Unit 5: 
T62, T95, T154, T191, T242, T281, T336, T340, T373, T416, T420 Unit 6: 
T7, T62-T63, T66, T148-T149, T242, T281, T338-T339, T342, T375, T418, 
T422

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce

LA.1.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Unit 1: S12, S18, S24, S30, S56, S100, T169, T218 Unit 2: 
T167, T212, T325, T368 Unit 3: T7, T56, T218, T251, T300, T331, T374 Unit 
4: T185, T277, T334, T371, T414 Unit 5: T95, T154, T191, T242, T373, T417 
Unit 6: T185, T242, T375, T418

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce

LA.1.SL.1.d

d. Develop attentive listening skills (e.g., 
eye contact, nonverbal cues, recalling).

Teacher’s Edition: Unit 1: S82, T56, T60, T142, T222, T302, T378, T410 Unit 
2: T60, T140, T167, T212, T216, T298, T325, T368, T372, T404 Unit 3: T60, 
T140, T222, T251, T300, T378 Unit 4: T64, T152, T242, T277, T334, T338, 
T418 Unit 5: T62, T95, T154, T158, T246, T340, T373, T416, T420 Unit 6: 
T66, T152, T246, T342, T422

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce

LA.1.SL.1.e

e. Complete a task following one/two-
step directions.

Teacher’s Edition: Unit 1: S8-S9, S18, S22, S75, T56-T57, T60, T63, T138-
T139, T142, T218, T222, T298-T299, T374-T375, T378, T381, T438 Unit 2: 
T56-T57, T60, T63, T136-T137, T212-T213, T294-T295, T301, T368-T369, 
T375, T432 Unit 3: T5, T56-T57, T136-T137, T143, T218-T219, T225, T300-
T301, T307, T374-T375, T438 Unit 4: T60-T61, T71, T89, T148-T149, T155, 
T177, T238-T239, T334-T335, T341, T414-T415, T488 Unit 5: T58-T59, 
T154-T155, T161, T242-T243, T336-T337, T343, T347, T416-T417, T490 
Unit 6: T62-T63, T69, T148-T149, T242-T243, T249, T338-T339, T418-
T419, T425, T492

Students will participate in 
discussions about 1st 
grade topics and texts. discussions, topics, text introduce

Presentation of Knowledge and Ideas

LA.1.SL.2

Tell a story or recount experiences with 
appropriate facts and pertinent 
descriptive details. Teacher’s Edition: Unit 1: T410 Unit 2: T404 Unit 3: T225, T300-T301

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce

LA.1.SL.2.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations, including interpreting 1st 
grade texts.

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce

LA.1.SL.2.b

b. Convey a personal perspective with 
clear reasons.

Teacher’s Edition: Unit 1: S24, S68, S100 Unit 2: T87, T136 Unit 4: T97 Unit 
6: T99, T148, T452-T460

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce

LA.1.SL.2.c

c. With prompting and support, explain 
the purpose of information being 
presented.

Teacher’s Edition: Unit 1: T57, T139, T219, T299, T375 Unit 2: T57, T137, 
T212, T295, T369 Unit 3: T57, T137, T219, T301, T375 Unit 4: T61, T149, 
T239, T335, T415 Unit 5: T59, T155, T243, T337, T417 Unit 6: T63, T149, 
T243, T339, T419

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce

LA.1.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., helpful/hurtful words).

Teacher’s Edition: Unit 1: S82, T410 Unit 2: T404, T422 Unit 3: T57, T63, 
T410, T428 Unit 6: T460, T478

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce
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e. Use appropriate visual and/or digital 
tools to support verbal communication.

Students will recount 
personal expriences with 
facts and details. recount, facts and details reinforce



1 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Smart Start Week 1
TSW identify and blend the sounds 
m, s, a, p, t, n, r, i. 

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2
 TSW identify and blend c, f, o, d, 
h, s, e, b, l, ll.

Week 3
 TSW identify and blend k, ck, u, g, 
w, x, v, qu, j, y, z.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1 Week 1
TSW identify and blend short o and 
inflectional ending -s.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2
TSW identify and blend short i and 
double final consonants.

Week 3

TSW identify and decode 
beginning consonant f-blends and 
plural -s.

Week 4

TSW identify and decode short o.
TSW organize words into 
alphabetical order.

Weeks 5 - 6

TSW identify and decode 
beginning consonant r-blends and 
s-blends.
TSW identify possessive nouns.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2 Week 1

TSW identify and blend short e 
spelled e and ea.
TSW decode words with 
inflectional ending -ed.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2

TSW identify and decode short u.
TSW will decode contractions with 
's.

Week 3

TSW identify and decode ending 
consonant blends.
TSW decode inflectional ending -
ing.

https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing


1 Reading

Week 4

TSW identify and decode 
consonant digraphs sh, th, -ng.
TSW identify closed syllables.

Weeks 5 - 6

TSW identify and decode 
consonant digraphs ch, tch, wh, 
ph.
TSW identify and decode words 
with plural ending -es.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3 Week 1

TSW identify and decode long a 
spelled a_e.
TSW identify and decode 
contractions with not.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2

TSW identify and decode long i 
spelled i_e.
TSW identify and decode plurals 
with CVCe.

Week 3

TSW identify and decode soft c 
and g/dge.
TSW identify and decode 
infledtional endings -ed and -ing 
when the final e is dropped.

Week 4

TSW identify and decode long o 
spelled o_e, long u spelled u_e, 
long e spelled e_e.
TSW identify and decode CVCe 
syllables.

Weeks 5 - 6

TSW identify and decode digraphs 
oo, u.
TSW identify and decode 
inflectional endings -ed and -ing 
when the final consonant is 
doubled.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 4 Week 1

TSW identify and decode the long 
a spelled a, ai, ay.
TSW identify and sort words into 
alphabetical order using the first 
two letters.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing


1 Reading

Week 2

TSW identify and decode the long 
e spelled e, ee, ea, ie.
TSW identify and decode prefixes 
re-, un-, pre-.

Week 3

TSW identify and decode the long 
o spelled o, oa, ow, oe.
TSW identify and decode open 
syllables.

Week 4

TSW identify and decode the long i 
spelled i, igh, y, ie.
TSW identify and decode 
inflectional endings with the y is 
changed to i.

Weeks 5 - 6

TSW identify and decode the long 
e spelled y, ey.
TSW identify and decode 
compound words.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 5 Week 1

TSW identify and decode the r-
controlled vowel or.
TSW identify and decode plurals 
when the -y is changed to -ies.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2

TSW identify and decode r-
controlled vowels  or, ir, ur, er.
TSW identify and decode the suffix 
-er.

Week 3

TSW identify and decode r-
controlled vowel or, ore, oar.
TSW identify and decode 
abbreviations.

Week 4

TSW identify and decode 
diphthongs ou, ow.
TSW identify and decode 
comparative inflectional endings -
er, -est.

Weeks 5 - 6

TSW identify and decode 
diphthongs ai, ay.
TSW identify and decode final 
stable syllables.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing


1 Reading

Unit 6 Week 1

TSW identify variant vowel 
spellings oo, ou, u_e, ew, ui, ue, u.
TSW identify and decode suffixes -
full and -less.

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEncSFJiAF
/view?usp=sharing

https://drive.google.
com/file/d/1cyK1-
tJxHSJ18i7teCA4VZTEnc
SFJiAF/view?usp=sharing

Week 2

TSW identify and and decode 
variant vowel spellings with 
digraphs au, aw, a, augh, al.
TSW identify and decode vowel-
team syllables.

Week 3

TSW identify and decode silent 
letter consonant digraphs wr, kn, 
gn.
TSW identify and decode 
compound words.

Week 4

TSW identify and decode three 
letter consonant blends scr, spl, 
spr, str, thr, shr.
TSW identify and decode 
inflectional endings -ed and -ing.

Weeks 5 - 6

TSW identify and decode r-
controlled vowels air, are, ear.
TSW identify and decode r-
controlled vowel syllables.

https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing
https://drive.google.com/file/d/1cyK1-tJxHSJ18i7teCA4VZTEncSFJiAF/view?usp=sharing


1 Writing

The first grade writing curriculum can be found at the following link:
https://drive.google.com/drive/folders/1KKAOlic51yxO2gnhu6a9QNe8SjjZDMYY?usp=drive_link

https://drive.google.com/drive/folders/1KKAOlic51yxO2gnhu6a9QNe8SjjZDMYY?usp=drive_link
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary Introduce/Reinforce/
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Concepts of Print

F
o
u
n
d
a
t
i
o
n
s
 
o
f
 
R
e
a
d
i
n
g

LA.2.F.1

Demonstrate knowledge of the 
organization and basic concepts of 
print.

Teacher’s Edition: Unit 1: T272 Unit 2: T42, T174, T178-179, T418 Unit 
3: T163, T164, T429 Unit 4: T29, T33, T46, T173, T174-175 Unit 5: T283, 
T288, T416-417, T420 Unit 6: T10, T30

Students will show 
understanding of print. concepts of print Reinforce

LA.2.F.1.a

a. Recognize the distinguishing features 
of a paragraph including that multiple 
sentences may be used to form a 
paragraph and the author may indent 
or skip a line to signal a new paragraph.

Teacher’s Edition: Unit 1: T282, 283 Unit 2: T389 Unit 3: T380 Unit 6: 
T370, T386

Students will show 
understanding of print. concepts of print Reinforce

Phonological Awareness 

LA.2.F.2

Demonstrate understanding of 
advanced phonemic awareness skills in 
spoken words, syllables, and sounds 
(phonemes).

Teacher’s Edition: Unit 1: T76, T90, T104, T184, T220, T234, T302, T324 
Unit 2: T328 Unit 3: T62, T76, T82, T104, T212, T222 Unit 4: T64, T78, 
T306, T320 Unit 5: T48, T74, T184, T308 Unit 6: T218

Students will show 
advanced phonemic 

awareness skills.

syllables, sounds, 
phonemes Reinforce

LA.2.F.2.a

a. Identify, segment, and blend 
phonemes in single syllable spoken five 
and six phoneme words including words 
with blends, digraphs, and trigraphs.

Teacher’s Edition: Unit 1: T54, T64, T68, T80, T96, T108, T198, T210, 
T212, T226, T238, T316, T328 Unit 2: T64, T76, T86, T92, T100, T104, 
T184, T198, T210, T220, T226, T234, T238, T316, T328 Unit 4: T56, 
T312 Unit 5: T90, T102, T302, T320 Unit 6: T86, T100, T104, T204, T308

Students will show 
advanced phonemic 

awareness skills.

syllables, sounds, 
phonemes Reinforce

LA.2.F.2.b

b. Substitute sounds in words with five or 
more phonemes.

Teacher’s Edition: Unit 1: T192, T206 Unit 2: T58, T72, T192, T206, 
T310, T324 Unit 3: T90, T194, T212 Unit 4: T84, T98, T106, T188, T202 
Unit 5: T56, T70, T84 Unit 6: T92, T212, T230, T302, T320

Students will show 
advanced phonemic 

awareness skills.

syllables, sounds, 
phonemes Reinforce

LA.2.F.2.c

c. Delete initial and final phonemes in 
words including words with blends.

Teacher’s Edition: Unit 3: T186, T304 Unit 5: T98, T212, T230, T294 Unit 
6: T72, T190, T202

Students will show 
advanced phonemic 

awareness skills.

syllables, sounds, 
phonemes Reinforce

Phonics and Word Analysis

LA.2.F.3

Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition: Unit 1: T214, T215, T221, T222, T223, T226, T227, 
T228, T229, T236, T238, T311, T312, T313, T315, T316, T317, T318, 
T319, T322, T328, Unit 2: T52, T53, T74, T76, T80, T81, T87, T88, T89, 
T92, T93, T98, T100, T101, T102, T103, T104, T198, T199, T222, T238, 
T317 Unit 3: T90 Unit 4: T71, T98, T99 Unit 5: T91

Students will use phonices 
strategies to decode and 

encode words.

decoding, endcoding, 
phonics Reinforce
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LA.2.F.3.a

a. Decode words with variable vowel 
teams and vowel diphthongs.

Teacher’s Edition: Unit 3: T56-T57, T60, T63, T64-T65, T67, T74, T77, 
T78, T80, T92, T93, T94, T95, T98, T99, T100, T102, T104, T105, T106, 
T107, T108, T188, T189, T192, T194, T195, T196, T197, T199, T202, 
T203, T208, T212, T216, T217, T220, T223, T224, T225, T227, T228, 
T229, T230, T231, T234, T237, T240, T306, T307, T310, T313, T314, 
T315, T317, T318, T319, T320, T321, T324, T327, T328, T329, T330 Unit 
5: T50-T51, T54, T56, T57, T58, T59, T61, T64, T65, T68, T71, T72, T74, 
T78-T79, T82, T178, T179, T182, T185, T189, T191, T192, T193, T196, 
T199, T200, T201, T202, T206-T207, T210, T213, T217, T219, T223, 
T224, T227, T228, T229, T230, T231, T296, T297, T300, T303, T304, 
T305, T307, T310, T311, T314, T317, T318, T319, T320, T206, T207, 
T210, T213, T214, T215, T219, T220, T221, T224, T226, T227, T228-
T229, T230 Unit 6: T206, T207, T210, T213, T214, T215, T218, T220, 
T221, T224, T227, T228-T229, T230

LA.2.F.3.b

b. Decode regularly spelled two-syllable 
words with long vowels.

Teacher’s Edition: Unit 1: T64, T77, T102, T188, T202, T222, T228, T318, 
T322, T328 Unit 2: T66, T82, T90, T92, T93, T96, T100, T101, T104, 
T198, T199 Unit 3: T64-T65, T68, T86, T92, T93, T94, T98, T99, T100, 
T104, T105, T108, T202, T208, T224, T225, T227, T230, T231, T240, 
T314, T315, T317, T327, T328, T330 Unit 4: T60, T94, T269, T310, T316, 
T324 Unit 5: T298 Unit 6: T56, T58, T60, T61, T62-T63, T64, T66, T67, 
T73, T74, T80, T81, T84, T87, T88, T89, T92, T93, T98, T100, T101, 
T102-T103, T104, T178-T179, T182, T184, T186, T190, T192, T193, 
T196, T198, T199, T200-T201, T202, T206, T207, T210, T216-T217, 
T222, T226, T227, T228-T229, T230

Students will use phonices 
strategies to decode and 

encode words.

decoding, endcoding, 
phonics Reinforce

LA.2.F.3.c

c. Decode words with open and closed 
syllables and consonant -le.

Teacher’s Edition: Unit 6: T52-53, T59, T60-61, T66-67, T73, T74-75, 
T76, T178-179, T185, T186-187, T192-193, T199, T200-201, T202, T398-
399, T402-403

Students will use phonices 
strategies to decode and 

encode words.

decoding, endcoding, 
phonics Reinforce

LA.2.F.3.d

d. Decode words with common Anglo 
roots and suffixes.

Teacher’s Edition: Unit 1: T11, T13, T14, T15, T111, T143 Unit 2: T11, 
T216, T224, T230, T239, T240-241, T272, T274-275, T337, T344, T350 
Unit 3: T111 Unit 4: T60, T68, T74, T83, T112, T237 Unit 5: T133, T135, 
T137, T138-139, T156, T159, T161, T244, T246 Unit 6: T82, T90-T91, 
T96, T105, T107

Students will use phonices 
strategies to decode and 

encode words.

decoding, endcoding, 
phonics Reinforce

LA.2.F.3.e

e. Decode words with silent letter 
combinations. Teacher’s Edition: Unit 4: T58-59, T65, T66-67, T72-73, T79, T80-81, T82

Students will use phonices 
strategies to decode and 

encode words.

decoding, endcoding, 
phonics Reinforce

Fluency

LA.2.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level texts to support 
comprehension.

Teacher’s Edition: Unit 1: T26, T50, T158, T180, T286, T333, T338, T341, 
T347, T420 Unit 2: T26, T46, T154, T180, T286 Unit 3: T26, T50, T158, 
T182, T373, T422 Unit 4: T24, T52, T158, T176, T239, T247, T253, T269, 
T282, T329, T337, T343 Unit 5: T24, T44, T107, T115, T121, T150, T235, 
T243, T249, T278, T414 Unit 6: T24, T46, T152, T172, T278, T414

Students will use phrasing 
and expression while 

reading grade level text.

accuracy, phrasing, 
expression, 

comphrehension
Introduce
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LA.2.F.4.a

a. Read a variety of texts accurately 
using appropriate rate, expression, and 
intonation to reflect meaning.

Teacher’s Edition: Unit 1: T26, T113, T121, T127, T180, T225, T237, 
T248, T315, T327 Unit 2: T26, T46, T63, T91, T103, T109, T117, T123, 
T154, T180, T197, T225, T420 Unit 3: T67, T107, T158, T288, T317, 
T335, T340, T343, T349 Unit 4: T24, T52, T69, T81, T97, T109, T115, 
T123, T129, T158, T176, T193, T205, T221, T233, T282, T311, T323 Unit 
5: T24, T44, T61, T73, T278, T279, T325, T333, T339, T414 Unit 6: T24, 
T46, T71, T99, T109, T117, T123, T152, T172, T197, T225, T278, T315

Students will use phrasing 
and expression while 

reading grade level text.

accuracy, phrasing, 
expression, 

comphrehension
Introduce

LA.2.F.4.b

b. Read grade level high-frequency 
words with automaticity and accuracy 
(e.g., Fry or Dolch words or those 
included in instructional materials).

Teacher’s Edition: Unit 1: T26, T50, T61, T75, T89, T103, T158, T180, 
T191, T205, T219, T225, T233, T237, T286, T309, T315, T323, T327, 
T333, T341 Unit 2: T26, T46-47, T57, T63, T71, T75, T85, T91, T99, 
T103, T117, T154, T180, T191, T197, T205, T209, T219, T225, T233, 
T237, T286, T309, T315, T323, T327 Unit 3: T26-27, T50, T61, T67, T75, 
T79, T89, T95, T103, T107, T113, T121, T127, T158, T182, T193, T199, 
T207, T211, T221, T227, T288 Unit 4: T24, T52, T62, T77, T90, T105, 
T158, T176, T186, T201, T214, T221, T229, T282, T304, T318 Unit 5: 
T24, T44, T54, T69, T74, T83, T97, T102, T183, T197, T202, T211, T225, 
T230, T278, T298, T315, T320 Unit 6: T57, T76, T85, T104, T152, T172, 
T183, T202, T211, T230, T278, T301, T320

Students will use phrasing 
and expression while 

reading grade level text.

accuracy, phrasing, 
expression, 

comphrehension
Introduce
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Central Ideas and Details

LA.2.RP.1

Recount narratives and determine their 
central message, lesson, or moral.

Teacher’s Edition: Unit 1: T9-T13, T119, T141-T145, T152, T178, T249, 
T250, T252, T255, T258, T261 Unit 2: T146-T147, T150-T151, T152-
T153, T158-T169, T172-T173, T242-T243, T249, T255, T261, T269, 
T332, T340, T346 Unit 3: T139, T145, T179, T251 Unit 4: T328-T329, 
T336-T337, T342-T343, T334, T335, T341, T347 Unit 5: T132-T133, 
T140-T141 Unit 6: T43, T139, T146-T147, T148-T149, T150-T151, 
T163B, T164-T165, T169, T234-T235, T236-T237, T241, T242-T243, 
T244-T245, T247, T248-T249, T250-T251, T253, T324-T325, T332-T333, 
T338-T339, T433

Students will summarize 
parts of the narrative 

describing main idea and 
theme.

central message, moral, 
theme Reinforce

LA.2.RP.2

Describe characters and how they 
interact with one another.

Teacher’s Edition: Unit 1: T7, T9-T13, T18, T23,T31, T36, T38, T39, 
T112-T113, T114-T115, T117, T119, T120, T125, T126-T127, T131, 
T150, T154-T155, T156-T157, T178, T242, T244, T248, T249, T250, 
T251, T252-T253, T256-T257, T258-T259 Unit 2: T135, T146-T147, 
T148-T149, T152-T153, T159, T160, T163, T166, T168, T172-T173, 
T176, T244-T245, T250-T251, T252-T253, T256-T257, T258-T259, T332-
T333, T346-T347 Unit 3: T156-T157 Unit 4: T30, T34, T328-T329, T336-
T337, T342-T343, T384-T385 Unit 5: T39, T40, T106-T107, T112, T142-
T143, T148-T149, T234-T235, T242-T243, T248-T249 Unit 6: T44-T45, 
T158, T160, T168, T234-T235, T236-T237, T240, T241, T242-T243, 
T244-T245, T247, T248-T249, T250-T251, T253, T324-T325, T338-T339, 
T414-T415

Students will describe 
character's traits in a story. characters, interactions Reinforce

Author's Craft
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LA.2.RP.3

Determine and explain who is telling a 
story within and across literary texts.

Teacher’s Edition: Unit 1: T22, T23 Unit 2: T139, T140, T141, T420-T421 
Unit 3: T141, T143, T150-T151, T154-T155, T156-T157, T251 Unit 4: 
T328-T329 Unit 5: T42-T43, T135, T136, T137, T144-T145, T146-T147, 
T155, T156, T159, T234-T235, T242-T243, T247, T248-T249, T236-T237, 
T241, T247, T250-T251, T253, T420-T421 Unit 6: T168, T263, T264, 
T272-T273, T276-T277, T283, T284, T287-T288, T289, T324-T325, T330, 
T331, T332-T333, T337, T338-T339, T343

Students will identify who 
is telling the story. point-of-view Introduce

LA.2.RP.4

Describe the basic structure of a literary 
text, including how literary elements are 
introduced and developed and 
conflicts are resolved.

Teacher’s Edition: Unit 1: T7, T9, T10, T11, T12, T13, T18-19, T20-21, 
T31, T32, T33, T34, T36, T38, T39, T42, T114, T119, T122, T125, T128, , 
T131, T141, T177, T423 Unit 5: T39 Unit 6: T144-145, T240, T417

Students will identify the 
elements of the story.

literary elements, 
conflict, solution Reinforce

Knowledge and Ideas

LA.2.RP.5

Compare and contrast two or more 
versions of the same literary text by 
different authors or from different 
cultures. Teacher’s Edition: Unit 2: T171, T176, T177 Unit 6: T166

Students will compare and 
contrasts different versions 

of a story.

compare, contrast, 
culture Introduce/Reinforce

LA.2.RP.6

Ask and answer literal (e.g., 
recall/details) and simple inferential (e.
g., why or how) questions about key 
details in a literary text.

Teacher’s Edition: Unit 1: T52, T174, T242-T243, T244-T245, T255, 
T256-T257, T258-T259, T270-T271, T276-T277, T332-T333, T339, T340-
T341, T351, T418-T419 Unit 2: T144-T145, T150-T151, T248, T249, 
T258-T259, T282-T283, T284-T285, T294-T295 Unit 3: T174-T175, 
T244-T245, T252-T253, T259-T259, T441 Unit 4: T22-T23, T44-T45, 
T114-T115, T116-T117, T122-T123, T124-T125, T128-T129, T130-T131, 
T278-T279, T280-T281, T290-T291 Unit 5: T137, TT234-T235, T242-
T243, T248-T249, T236-T237, T250-T251 Unit 6: T137-T139, T142- 
T143, T146-T147, T150-T151, T433

Students will recall text 
details through asking and 

answering questions.
recall, details Introduce

LA.2.RP.7

Compare and contrast topics in a 
variety of literary texts to build 
knowledge of cultures (e.g., history, 
values, beliefs, and behaviors).

Teacher’s Edition: Unit 1: T8-13, T17, T22-23, T37, T39, T40, T41, T44, 
T53, T114-115, T120-121, T122-123, T126-127, T128-129 Unit 2: T176, 
T177, T178 Unit 4: T11, T18-19, T30, T32, T34, T35, T36, T37, T38, T40, 
T43, T44-45

Students will compare and 
contrasts a variety of 

cultural texts.
culture Introduce

LA.2.RP.8

With scaffolding as needed, read 
andcomprehend a wide range of literary 
texts of appropriate
complexity for Grade 2.

Teacher's Edition: Unit 1: T16, T18, T20, T112-T113, T114-T115, T125, 
T126-T127, T244-T245, T249, T251, T252-T253, T261, T423, T439 Unit 
2: T146-T147, T158-T171, T174-T177, T270-T273, T280-T281, T282-
T283, T298-T299, T342-T343 Unit 3: T140-T145, T162-T173, T176-T179, 
T441 Unit 4: T8-T11, T28-T41, T121, T127, T133, T272-T273, T286-
T289, T296, T334, T335, T341, T347 Unit 5: T140-T141 Unit 6: T42-T43, 
T156-T162, T166-T169, T174, T262-T265, T270-T271, T282-T285, T288-
T289, T433

Students will compare and 
contrasts a variety of 

cultural texts.
culture Introduce
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LA.2.RI.1
comprehend a wide range of literary 
texts of appropriate

Teacher’s Edition: Unit 1: T45, T46, T47, T271, T272, T273, T280, T282, 
T283, T338, T339, T341, T345, T346, T347, T351, T418-T419, T422, 
T426, T427 Unit 2: T8-T13, T20-21, T43, T114, T115, T116, T118-T119, 
T121, T123, T125, T127 Unit 3: T118, T273, T274, T275, T282-T283, 
T284-T285, T293, T294, T296-T297, T299, T334-T335, T336-T337, T347, 
T341, T342-T343, T344-T345, T348-T349, T350-T351, T353, T424-T425, 
T428-T429 Unit 4: T164, T170-T171, T173, T238-T239, T240-T241, 
T246-T247, T252-T253, T254-T255, T414-T415, T432, T433, T434 Unit 
5: T8, T11, T14-T15, T22-T23, T32, T106-T107, T169, T265, T268-T269, 
T330, T354-T355, T372-T373, T420-T421 Unit 6: T7, T14-T15, T18-T19, 
T20-T21, T29, T30, T31, T32, T33, T36, T108-T109, T110-T111, T114, 
T115, T116-T117, T118-T119, T121, T122-T123, T127, T354-T355, 
T358-T359, T368-T369, T370-T371, T372-T373, T376-T377, T430, T431, 
T433

Students will identify main 
idea and details.

main idea, details, 
paragraph Introduce

LA.2.RI.2

Teacher’s Edition: Unit 1: T426-T428 Unit 2: T44-T45, T48, T115, T121, 
T127, T418–T419 Unit 3: T38, T424-T426, T428-T430, T438, T440 Unit 
4: T245, T251, T257, T422-T424 Unit 5: T268-T269, T416-T418 Unit 6: 
T420-T241

Students will describe real 
life connections. connections Reinforce

complexity for Grade 2.

LA.2.RI.3

Determine and explain the author’s 
purpose in an informational text, 
including what the author wants to 
answer, explain, or describe.

Teacher’s Edition: Unit 1: T334, T335, T342, T343, T348, T349 Unit 2: 
T115, T121, T127, T178-T179, T437 Unit 3: T8-T13, T20-T21, T33, T36, 
T39, T40, T45, T46, T48-T49, T112-T113, T114-T115, T119, T120-T121, 
T123, T125, T128-T129, T131, T336-T337, T344-T345, T350-T351, 
T390-T391, T424-T425, T428-T429, T440 Unit 4: T47, T152-T153, T154-
T155, T156-T157, T163, T164, T166, T168, T173, T238-T239, T240-
T241, T244, T245, T246-T247, T248-T249, T251, T254-T255, T257, 
T418-T419, T422-T423 Unit 5: T9, T18-T19, T29-T32, T34, T108-T109, 
T113, T114-T115, T116-T117, T119, T122-T123, T125, T164, T263, 
T265, T272-T273, T283, T284, T285, T286-T287, T289, T331, T332-
T333, T326-T327, T331, T334-T335, T337, T340-T341, T343, T412-T413 
Unit 6: T368-T369, T370-T371, T412-T413, T416-T417, T420-T421, 
T431, T433

Students will state the 
author's purpose.

author's purpose, 
informational text Reinforce
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LA.2.RI.4

Explain how text features (titles, 
headings, table of contents, glossaries, 
captions, graphs, maps, and/or other 
visuals) contribute to the meaning of 
texts.

Teacher’s Edition: Unit 1: T45, T46, T273, T278, T283, T332, T335, T340, 
T343, T345, T347, T349, T351, T418-T419, T422, T436, T437, T438 Unit 
2: T16, T18-T19, T33, T34, T37, T43, T44-T45, T115, T121, T127, T418-
T419, T422, T426-T427, T437, T438 Unit 3: T12, T18-T19, T24-T25, T31, 
T34, T35, T37, T112-T113, T114-T115, T119, T120-T121, T122-T123, 
T125, T128-T129, T131, T178, T180-T181, T274, T278, T293, T294, 
T300-T301, T334-T335, T341, T347, T348-T349, T353, T420-T421, 
T424-T425, T428-T429, T438, T439, T440 Unit 4: T47, T48, T50-T51, 
T143, T144, T145, T150-T151, T154-T155, T173, T174-T175, T238-T239, 
T240-T241, T245, T246-T247, T248-T249, T251, T252-T253, T254-T255, 
T257, T414-T415, T422-T423, T432, T433, T434 Unit 5: T9-T11, T16-
T17, T21, T33, T106-T107, T108-T109, T113, T116-T117, T119, T122-
T123, T125, T170-T171, T265, T270-T271, T283, T284, T332-T333, 
T326-T327, T334-T335, T340-T341, T331, T337, T343, T412-T413, 
T416-T417, T420-T421, T430, T431, T432 Unit 6: T9, T10, T16-T17, 
T20-T21, T31, T34, T108-T109, T110-T111, T115, T116-T117, T118-
T119, T121, T122-T123, T124-T125, T127, T412-T413, T416-T417, 
T420-T421, T430, T431, T432

Students will explain all 
text features. text features Introduce

Knowledge and Ideas

LA.2.RI.5

Compare and contrast the two most 
important ideas presented by two 
informational texts on the same topic.

Teacher’s Edition: Unit 1: T293, T296, T297, T424, T428, T430 Unit 2: 
T39, T42, T43, T111, T123, T119, T125, T424, T428 Unit 3: T41, T47, 
T295, T298, T299, T426, T430 Unit 4: T169, T172, T173, T241, T253, 
T420, T424 Unit 5: T35, T285, T288, T289, T339, T418, T422 Unit 6: 
T39, T418, T422 Reading/Writing Companion: Unit 1: 86 Unit 2: 34 Unit 
3: 62 Unit 4: 32 Unit 5: 32

Students can compare and 
contrast the main ideas on 

two topic texts.
compare, contrast Introduce

LA.2.RI.6

Explain an author’s opinion(s) and 
supporting evidence from the text.

Teacher’s Edition: Unit 1: T282-T283, T298-T299, T418 Unit 2: T22-T23, 
T24-T25, T44-T45 Unit 3: T10, T11, T12, T13, T39, T45, T112, T115, 
T120, T126, T128 Unit 4: T152-T153, T155, T163, T164, T166, T240-
T241, T248-T249, T255, T414 Unit 5: T265, T272-T273, T286-T287, 
T289, T290-T291, T324-T325, T326, T332, T334, T338, T340, T354-
T355, T358-T359, T370-T371, T372-T373, T386-T387, T412 Unit 6: T18-
T19, T30, T31, T32, T33, T36, T108, T117, T412

Students will state the 
author's purpose using text 

evidence. 

text evidence, author's 
purpose Introduce

LA.2.RI.7

Compare and contrast topics in a 
variety of informational texts to build 
knowledge of cultures (e.g., history, 
values, beliefs, and behaviors).

Teacher’s Edition: Unit 1: T44, T45, T46, T47, T113, T121, T127 Unit 4: 
T26-27, T46

Students will compare and 
contrasts a variety of 

cultural texts.
compare, contrast Introduce

Range of Reading and Level of 
Text Complexity

LA.2.RI.8

With scaffolding as needed, read and 
comprehend a wide range of 
informational texts of appropriate 
complexity for Grade 2.

Teacher's Edition: Unit 1: T44-T47, T119, T120, T270-T273, T422, T426, 
T427, T436, T437, T438, T439 Unit 2: T30-T39, T42-T43, T182, T426-
T427, T438 Unit 3: T8-T13, T16-T17, T30-T41, T44-T47, T272-T275, 
T278-T279, T280-T281, T292-T295, T438, T439, T440, T441 Unit 4: T46-
T49, T142-T145, T148-T149, T162-T169, T172-T173, T245, T251, T257, 
T435 Unit 5: T16-T17, T168-T169, T292 Unit 6: T8-T11, T14-T15, T28-
T36, T430, T431, T432, T433

Students will read and 
comprehend grade level 

informational texts.

comprehend, 
informational text Introduce
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Acquisition and Use

LA.2.V.1

Recognize and use conversational and 
grade-level academic vocabulary.

Teacher’s Edition: Unit 1: T6, T124, T138, T254, T268, T344 Unit 2: T6, 
T120, T134, T254, T266, T344 Unit 3: T6, T124, T138, T256, T270, T346 
Unit 4: T6, T126, T140, T250, T264, T340 Unit 5: T6, T118, T132, T246, 
T260, T336 Unit 6: T6, T120, T134, T246, T260, T336

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

LA.2.V.1.a

a. Use sentence-level context clues to 
determine the meaning of a word or 
phrase.

Teacher’s Edition: Unit 1: T6, T14, T110, T112, T240, T246, T268-T269, 
T336, T342, T344, T436, T438 Unit 2: T9, T10, T11, T13, T14-T15, T112, 
T113, T126, T140, T142-T143, T162, T164, T240-T241, T246-T247, 
T254, T260, T268 Unit 3: T6, T14-T15, T110-T111, T124, T139, T145, 
T146, T270-T271, T273, T332-T333, T439, T440 Unit 4: T11, T112, T141, 
T143, T144, T145, T165, T236-T237, T238-T239, T240-T241, T242, 
T243, T246-T247, T248-T249, T250, T252-T253, T254-T255, T256, 
T264-T265, T267, T269, T270-T271 Unit 5: T12-T13, T108-T109, T116-
T117, T122-T123, T238, T266-T267, T322-T323, T328, T336, T342 Unit 
6: T6, T137, T140, T260, T266, T322-T323, T328 Reading/Writing 
Companion: Unit 4: 40, 43

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

LA.2.V.1.b

b. Use commonly occurring prefixes and 
suffixes to determine the meaning of 
unknown words (e.g., happy/unhappy).

Teacher’s Edition: Unit 1: T111, T240 Unit 2: T11, T188, T196, T202, 
T208, T211 Unit 3: T275, T276-T277, T333, T334, T339, T342, T346, 
T348, T352 Unit 4: T60, T68, T74, T80, T83 Unit 5: T322 Unit 6: T82, 
T90-T91, T96, T102, T105, T107

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

LA.2.V.1.c

c. Use known root words to determine 
the meaning of unknown words (e.g., 
addition, additional).

Teacher’s Edition: Unit 1: T14-T15, T110-T111, T117, T124, T130, T143, 
T146-T147, T224, T230, T240-T241, T242, T244, T247, T252, T254, 
T259, T260, T330, Unit 2: T11, T106, T202, T208, T230, T240, T272, 
T274-T275, T330-T331, T332 T337, T340, T344, T346, T350 Unit 3: 
T110, T242, T276-T277, T332, T346, T352 Unit 4: T60, T68, T74, T88, 
T96, T102, T112, T236, T326, Unit 5: T104, T137, T138-T139, T159, 
T161, T232, T234, T236, T239, T244, T246, T251, T252, T322 Unit 6: 
T17, T82, T90-T91, T96, T102, T106-T107, T135, T232, T322-T323

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

LA.2.V.1,d

d. Determine the meaning of 
compound words by using knowledge 
of individual words (e.g., birdhouse).

Teacher’s Edition: Unit 1: T331 Unit 2: T306, T314, T320, T326, T329 
Unit 3: T45, T141, T142, T143, T146-T147, T168, T243, T244, T246, 
T249, T252, T254, T256, T258, T260, T262 Unit 4: T269 Unit 6: T54, 
T62-T63, T68, T74, T77, T88, T107, T209

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

LA.2.V.1.e

e. Determine the meanings of key words 
and phrases using provided reference 
materials and classroom resources.

Teacher’s Edition: Unit 1: T368, T413 Unit 2: T107, T124, T331, T409, 
T411, T437 Unit 4: T243, T246, T252, T271, T327, T364 Unit 5: T104, 
T322-T323, T430 Unit 6: T107, T140, T233, T322-T323, T380-T381

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

Context and Connotations

LA.2.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher’s Edition: Unit 1: T35 Unit 2: T126, T260, T350, T393, T418 Unit 
3: T130, T262, T280-281, T345, T350, T351, T352 Unit 4: T9, T10, T12-
13, T30, T268, T280, T289, T290, T330, T338, T344, T368, T372 Unit 5: 
T124, T252, T342 Unit 6: T126, T252, T332, T338, T342, T380-381, T417

Students will use grade 
level language to describe 

an informational text.

informational text, 
figurative, connotative, Introduce

LA.2.V.2.a

a. Ask and answer questions about key 
words and phrases to determine their 
meaning.

Teacher’s Edition: Unit 1: T124, T254, T344 Unit 2: T120, T254, T344 
Unit 3: T124, T256, T346 Unit 4: T126, T250, T340 Unit 5: T118, T246, 
T336 Unit 6: T120, T246, T336

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce
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LA.2.V.2.b

b. Distinguish nuances of meaning 
between closely related verbs (e.g., 
toss, throw) and closely related 
adjectives (e.g., thin, slender).

Teacher’s Edition: Unit 1: T111, T241, T331 Unit 2: T107, T241, T331 
Unit 3: T111, T243, T333 Unit 4: T113, T237, T327 Unit 5: T105, T233, 
T323 Unit 6: T107, T233, T323

Students will use grade 
level appropriate 

vocabualry 
vocabulary Introduce

W
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i
t
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n
g

Apply handwriting skills to 
communicate ideas and 
information.

LA.2.FW.1

Demonstrate and apply handwriting 
skills.

Teacher’s Edition: Unit 1: T61, T89, T191, T219, T309 Unit 2: T57, T85, 
T191, T219, T309 Unit 3: T61, T89, T193, T221, T311 Unit 4: T63, T91, 
T187, T215, T305 Unit 5: T55, T83, T183, T211, T301, T362 Unit 6: T57, 
T85, T183, T211, T301

Students will demonstrate 
correct handwriting. handwriting Reinforce

LA.2.FW.1.a

a. Write legibly using correct formation 
of letters with automaticity and proper 
spacing between words.

Teacher’s Edition: Unit 1: T61, T89, T191, T219, T309 Unit 2: T57, T85, 
T191, T219, T309 Unit 3: T61, T89, T193, T221, T311 Unit 4: T63, T91, 
T187, T215, T305 Unit 5: T55, T83, T183, T211, T301, T362 Unit 6: T57, 
T85, T183, T211, T301

Students will demonstrate 
correct handwriting. handwriting Reinforce

LA.2.FW.2

Demonstrate sound-letter concepts 
when writing. Teacher’s Edition: Unit 1: T56, T63, T304 Unit 2: T87

Students will use sound-
letter spelling when 
writing.

Sound-letter, concepts Reinforce

LA.2.FW.2.a

a. Write common graphemes (letters or 
letter groups) for each phoneme.

Teacher’s Edition: Unit 1: T56, T63, T304 Unit 2: T87, T186, T193, T214 
Unit 3: T56, T63, T84, T91, T188, T195, T216, T406, T408, T410, T412, 
T414 Unit 4: T58, T65, T93

Students will use sound-
letter spelling when 
writing.

Sound-letter, concepts Reinforce

Production of Writing

LA.2.W.1

Write and expand grammatically 
correct sentences (e.g. declarative, 
imperative, interrogative, exclamatory).

Teacher’s Edition: Unit 1: T361, T378-T379, T391, T402-T403 Unit 2: 
T414-T415 Unit 4: T360-T361, T398-T399 Unit 5: T385 Unit 6: T366 
Reading/Writing Companion: Unit 1: 97, 104, 107 Unit 2: 95, 96, 98-99 
Unit 6: 130, 131

Students will write 
sentences correctly.

declarative, imperative, 
interrogative, 
exclamatory

Reinforce

LA.2.W.1.a

a. Capitalize proper nouns (e.g., 
holidays, countries, product names).

Teacher’s Edition: Unit 3: T397 Unit 4: T395 Unit 5: T393, T395 Unit 6: 
T395

Students will write 
sentences correctly.

declarative, imperative, 
interrogative, 
exclamatory

Reinforce

LA.2.W.1.b

b. Use commas in greetings and closings 
of letters; use apostrophes to form 
contractions and frequently occurring 
possessives.

Teacher’s Edition: Unit 3: T401 Unit 4: T360, T385, T391, T399, T411 
Unit 5: T395

Students will write 
sentences correctly.

declarative, imperative, 
interrogative, 
exclamatory

Reinforce
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LA.2.W.1.c

c. Identify and explain the use of nouns 
(e.g., collective and irregular plural), 
pronouns (e.g., demonstrative), verbs 
(e.g., past tense irregular), simple 
prepositions, and frequently occurring 
conjunctions. Teacher’s Edition: Unit 2: T398-T399 Unit 3: T387, T402

Students will write 
sentences correctly.

declarative, imperative, 
interrogative, 
exclamatory

Reinforce

LA.2.W.1d

d. Maintain consistent verb tense across 
sentences or paragraphs.

Teacher’s Edition: Unit 3: T157, T365, T392, T400-401, T404 Unit 4: 
T396-397, T393, T394-395 Unit 6: T385

Students will write 
sentences correctly.

declarative, imperative, 
interrogative, 
exclamatory

Reinforce

LA.2.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Teacher’s Edition: Unit 1: S40, S41, T245, T253, T259, T354, T356-387, 
T390-403 Unit 2: T356-371, T372-387, T388-389, T390-391, T395, T397, 
T399 Unit 3: T358-373, T374-389, T390-391, T392-393, T397, T399 Unit 
4: T352-367, T368-383, T384-385, T388-389, T391, T424 Unit 5: T348-
365, T366-383, T384-385, T389, T391, T393, T419, T428-429 Unit 6: 
T348-365, T366-383, T413, T419, T245, T251

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.a

a. Use prewriting activities and resources 
to plan, organize, and draft writing.

Teacher’s Edition: Unit 1: S40, T358-359, T360-361, T362-363, T374-375, 
T376-377, T378-379, T388-389 Unit 2: T358-359, T362-363, T374-375, 
T378-379 Unit 3: T360-361, T362-363, T364-365, T376-377, T380-381 
Unit 4: T354-355, T356-357, T358-359, T370-371, T372-373, T374-375 
Unit 5: T360-361, T362-363, T378-379, T380-381 Unit 6: T360-361, 
T362-363, T378-379, T380-381

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: S40, S41, T245, T253, T259, T354, T356-387, 
T390-403 Unit 2: T356-371, T372-387, T388-389, T390-391, T395, T397, 
T399 Unit 3: T129, T358-373, T374-389, T390-391, T392-393, T397, 
T399 Unit 4: T352-367, T368-383, T384-385, T388-389, T391, T424 Unit 
5: T348-365, T366-383, T384-385, T389, T391, T393, T419 Unit 6: T348-
365, T366-383, T413, T419, T245, T251

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

Teacher’s Edition: Unit 1: S40, T364-365, T366-367, T380-381, T382-383 
Unit 2: T364-365, T366-367, T380-381, T382-383 Unit 3: T366-367, 
T368-369, T382-383, T384-385 Unit 4: T360-361, T362-363, T376-377, 
T378-379 Unit 5: T364-365, T382-383 Unit 6: T364-365, T382-383

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.d

d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

Teacher’s Edition: Unit 1: S40, T368-369, T384-385 Unit 2: T368-369, 
T384-385 Unit 3: T370-371, T386-387 Unit 4: T364-365, T380-381

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.e

e. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
font, graphics, symbols).

Teacher’s Edition: Unit 1: T46, T48-49, T278-279, T291, T372 Unit 2: 
T11, T18-19, T34, T44-45, T110, T111, T125, T291 Unit 3: T18-19, T47, 
T178, T180-181, T300-301 Unit 4: T48, T150-151, T167, T174-175, T241, 
T249, T255 Unit 5: T14, T333, T338 Unit 6: T9, T20, T111, T119

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce

LA.2.W.2.f

f. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Teacher’s Edition: Unit 1: T28-T29, T301, T379, T434 Unit 2: T362, T368, 
T370, T434 Unit 3: T360, T362, T364, T368, T370, T378-T379, T380, 
T384, T386-T387, T388-T389, T416, T434, T436 Unit 4: T358, T362, 
T364-T365, T366, T374, T378, T380-T381, T382, T389, T410, T430 Unit 
5: T152-T153, T280-T281, T386-T387, T428 Unit 6: T280-T281, T428

Students will use a writing 
process to produce a 

written piece.

Recursive, Audience, 
Discipline Reinforce
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Modes of Writing

LA.2.W.3

Write personal or fictional narratives that 
retell two or more appropriately 
sequenced events.

Teacher’s Edition: Unit 1: T356-T357, T358-T359, T360-T361, T362-
T363, T364-T365, T366-T367, T368-T369, T390-T391 Unit 3: T358-T359, 
T360-T361, T362-T363, T364-T365, T366-T367, T368-369, T370-T371, 
T372-T373, T392-T393, T416-T417 Unit 4: T352-T353, T354-T355, 
T356-T357, T358-T359, T360-T361, T362-T363, T364-T365, T366-T367, 
T384-T385, T386-T387, T410-T411

Students will write a 
narrative with two or more 

events.

personal narrative, 
fictional narrative Reinforce

LA.2.W.3.a

a. Include relevant details about 
characters and settings.

Teacher’s Edition: Unit 1: T356, T358, T362 Unit 4: T352-353, T354-355, 
T356-357, T360

Students will write a 
narrative with two or more 

events.

personal narrative, 
fictional narrative Reinforce

LA.2.W.3.b

b. Use time order words to signal a 
sequence of events.

Teacher’s Edition: Unit 1: T356, T358, T360, T370 Unit 4: T362-363, 
T364-365, T372, T416

Students will write a 
narrative with two or more 

events.

personal narrative, 
fictional narrative Reinforce

LA.2.W.3.c

c. Provide a sense of closure. Teacher’s Edition: Unit 1: T356, T358, T370 Unit 3: T358, T362-363, 
T364, T372, T416 Unit 4: T385

Students will write a 
narrative with two or more 

events.

personal narrative, 
fictional narrative Reinforce

LA.2.W.4

Express an opinion and provide 
supporting reasons.

Teacher’s Edition: Unit 5: T47, T166-T167, T348-T349, T350-T351, T352-
T353, T354-T355, T356-T357, T358-T359, T360-T361, T362-T363, T364-
T365, T366-T367, T368-T369, T370-T371, T372-T373, T374-T375, T376-
T377, T378-T379, T380-T381, T382-T383

Students will write their 
opinion with supporting 

reasons
opinion Reinforce

LA.2.W.4.a

a. Introduce a topic or text. Teacher’s Edition: Unit 3: T421 Unit 5: T47, T348-349, T356, T362, T380-
381, T387

Students will write their 
opinion with supporting 

reasons
opinion Reinforce

LA.2.W.4.b

b. State an opinion and provide reasons 
to support the opinion.

Teacher’s Edition: Unit 1: T418 Unit 3: T129, T421 Unit 5: T47, T293, 
T348-349, T350-351, T356, T360-361, T362-363, T366-367, T378-379, 
T380-381, T386-387

Students will write their 
opinion with supporting 

reasons
opinion Reinforce

LA.2.W.4.c

c. Provide a concluding statement or 
section.

Teacher’s Edition: Unit 3: T421 Unit 5: T47, T348-349, T356, T362, T380-
381, T387

Students will write their 
opinion with supporting 

reasons
opinion Reinforce

LA.2.W.5

Write informative/explanatory pieces 
about a topic or text with supporting 
facts and details.

Teacher’s Edition: Unit 1: T24-T25, T42-T43, T53, T372-T373, T374-
T375, T376-T377, T378-T379, T380-T381, T382-T383, T384-T385, T386-
T387, T392-T393, T425, T429 Unit 2: T294-T295, T356-T357, T358-
T359, T360-T361, T362-T363, T364-T365, T366-T367, T368-T369, T370-
T371, T390-T391, T425 Unit 3: T42-T43, T160-T161, T374-T375, T376-
T377, T378-T379, T380-T381, T382-T383, T384-T385, T386-T387, T388-
T389, T394-T395, T416-T417 Unit 4: T26-27, T179 Unit 5: T36-T37, 
T175, T412, T413 Unit 6: T348-T349, T350-T351, T352-T353, T356-
T357, T360-T361, T362-T363, T364-T365, T366-T367, T378-T379, T380-
T381, T382-T383, T384-T385, T386-T387

Students will write an 
imformative piece with 

supporting details.

informative, supporting 
details Reinforce

LA.2.W.5.a

a. Introduce a topic or text. Teacher’s Edition: Unit 1: T373 Unit 2: T356-357 Unit 3: T374-375, T382-
383, T388, T416 Unit 6: T364, T382

Students will write an 
imformative piece with 

supporting details.

informative, supporting 
details Reinforce

LA.2.W.5.b

b. Develop a topic with facts, details, 
and definitions.

Teacher’s Edition: Unit 1: T288-289, T392 Unit 2: T356-357, T391 Unit 3: 
T374 Unit 4: T179 Unit 5: T175 Unit 6: T348, T350, T360-361, T362-363, 
T364, T384-385

Students will write an 
imformative piece with 

supporting details.

informative, supporting 
details Reinforce
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LA.2.W.5.c

c. Use words and phrases related to the 
topic. Teacher’s Edition: Unit 1: T393 Unit 2: T356, T391

Students will write an 
imformative piece with 

supporting details.

informative, supporting 
details Reinforce

LA.2.W.5.d

d. Provide a concluding statement or 
section.

Teacher’s Edition: Unit 1: T372 Unit 3: T395, T416 Unit 6: T368-369, 
T383

Students will write an 
imformative piece with 

supporting details.

informative, supporting 
details Reinforce

LA.2.W.6

Locate information from provided 
sources to answer questions about a 
topic.

Teacher’s Edition: Unit 1: T160, T288-289, T376, T419 Unit 2: T360-361 
Unit 3: T160-161, T290-291, T378-379, T421 Unit 4: T26-27 Unit 5: T413 
Unit 6: T413

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

LA.2.W.6.a

a. Retell information from provided 
sources to support ideas while avoiding 
plagiarism.

Teacher’s Edition: Unit 1: T284, T288-T289, T294, T300, T418-T419 Unit 
2: T28-T29, T49, T110-T111, T118-T119, T122, T123, T284-T285, T294-
T295, T300, T372-T373 Unit 3: T286-T287, T296-T297, T426-T427 Unit 
4: T22-T23, T44-T45, T156-T157, T170-T171, T280-T281, T290-T291, 
T414-T415 Unit 5: T22-T23, T36-T37, T108-T109, T116-T117, T122-
T123, T148-T149, T276-T277, T286-T287, T356-T357, T358-T359, T374-
T375, T376-T377, T412-T413, T424-T425, T433 Unit 6: T22-T23, T40-
T41, T150-T151, T154-T155, T164-T165, T276-T277, T286-T287, T292

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

LA.2.W.6.b

b. Identify print and digital tools to 
gather information and ideas and 
answer questions.

Teacher’s Edition: Unit 1: T28-29, T376, T419 Unit 2: T360-361 Unit 3: 
T160-161, T290-291, T378-379, T421 Unit 4: T26-27 Unit 5: T413 Unit 6: 
T413

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

LA.2.W.6.c

c. Sort evidence and information into 
categories.

Teacher’s Edition: Unit 1: T288-289, T376 Unit 2: T362-363 Unit 3: T160-
161, T290 Unit 4: T26-27 Unit 6: T378-379

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

LA.2.W.6.d

d. Demonstrate academic integrity by 
referencing sources in writing and 
speaking.

Teacher’s Edition: Unit 1: T28, T288 Unit 2: T360 Unit 3: T378-379 Unit 
5: T413

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

LA.2.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives). Teacher’s Edition: Unit 1: T419

Students will be able to 
look back in the text to 

answer questions.
Sources Reinforce

Comprehension and Collaboration

S
p
e
a
k
i
n
g
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n
d
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LA.2.SL.1

Participate with peers and adults in 
structured discussions and routines 
about 2nd grade topics and texts.

Teacher’s Edition: Unit 1: T4, T7, T136, T138-T139, T160, T266-T267, 
T268-T269, T288-T289, T366, T382-T383, T430, T432, T434-T435, T439 
Unit 2: T4-T5, T40-T41, T134-T135, T266-T267, T268-T269, T298-T299, 
T366-T367, T382-T385, T430-T431, T432-T433, T434-T435, T439 Unit 3: 
T4, T6, T123, T129, T136-T137, T139, T148-T149, T150-T151, T152-
T153, T184, T185, T248, T249, T256, T262, T268-T269, T282-T283, 
T290-T291, T338, T346, T368-T369, T384-T385, T432, T433, T434-T435, 
T441 Unit 4: T4-T5, T7, T138-T139, T148-T149, T262-T263, T362-T363, 
T366-T367, T378-T379, T427, T428, T430 Unit 5: T4-T5, T6-T7, T130-
T131, T258, T260-T261, T364-T365, T424-T425, T428-T429 Unit 6: T4-
T5, T7, T132-T133, T258-T259, T260, T374-T375, T382-T383, T424, 
T426-T427, T428-T429

Students will participate in 
grade level discussions. Structured reinforce



2

Seward Public 
Schools A L I G N M E N T

U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary Introduce/Reinforce/
Master

S
p
e
a
k
i
n
g
 
a
n
d
 
L
i
s
t
e
n
i
n
g

LA.2.SL.1.a

a. Ask pertinent questions to acquire or 
confirm information.

Teacher’s Edition: Unit 1: T4, T136, T266, T430, T431, T432-T433, T435 
Unit 2: T4, T132, T266, T430, T431, T432-T433, T435 Unit 3: T4, T136, 
T268, T385, T432, T433, T434-T435, T437 Unit 4: T4, T138, T262, T426, 
T427, T428-T429, T431 Unit 5: T4, T130, T258, T365, T424, T425, T426-
T427, T429 Unit 6: T4, T132, T258, T383, T424, T425, T426-T427, T429

Students will participate in 
grade level discussions. Structured reinforce

LA.2.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Teacher’s Edition: Unit 1: T266, T366, T386, T432, T434 Unit 2: T4, 
T370, T432, T434 Unit 3: T4, T136 Unit 4: T4 Unit 5: T4, T130, T426, 
T428-T429

Students will participate in 
grade level discussions. Structured reinforce

LA.2.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Unit 1: T366, T367, T382, T383, T432 Unit 2: T4, 
T266, T366, T382, T430 Unit 3: T4, T136, T384, T385, T368, T369 Unit 
4: T138, T262, T362, T378 Unit 5: T4, T364, T382, T383 Unit 6: T258, 
T364, T382

Students will participate in 
grade level discussions. Structured reinforce

LA.2.SL.1.d

d. Develop active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, recalling).

Teacher’s Edition: Unit 1: T4, T136, T266, T366, T382, T386, T433, T435 
Unit 2: T366, T367, T382, T433, T435 Unit 3: T384, T385, T368, T369 
Unit 4: T4, T362, T378 Unit 5: T130, T258, T364, T382, T427, T429 Unit 
6: T132, T364, T382, T427

Students will participate in 
grade level discussions. Structured reinforce

LA.2.SL.1.e
e. Complete a task following multi-step 
directions.

Teacher’s Edition: Unit 1: T366, T382 Unit 2: T366, T382 Unit 3: T384, 
T368 Unit 4: T362, T378 Unit 5: T364, T382 Unit 6: T364, T382

Students will participate in 
grade level discussions. Structured reinforce

Presentation of Knowledge and Ideas

LA.2.SL.2

Tell a story or recount an experience 
with appropriate facts and pertinent 
descriptive details.

Teacher’s Edition: Unit 1: T370-T371 Unit 2: T301, T386-T387 Unit 3: 
T53, T368-T369, T372-T373 Unit 4: T428, T430 Unit 5: T426-T427, 
T428-T429 Unit 6: T175, T426-T427, T428-T429

Students will tell a story 
using facts and details. Pertinent Reinforce

LA.2.SL.2.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations, including interpreting 2nd 
grade texts.

Teacher’s Edition: Unit 1: T366, T371, T382, T386, T387, T432, T434 
Unit 2: T370, T371, T386, T432, T434 Unit 4: T4, T366, T382 Unit 5: 
T258, T426, T428 Unit 6: T426

Students will tell a story 
using facts and details. Pertinent Reinforce

LA.2.SL.2.b
b. Convey a personal perspective with 
clear reasons. Teacher’s Edition: Unit 5: T47, T167

Students will tell a story 
using facts and details. Pertinent Reinforce

LA.2.SL.2.c
c. Explain the purpose and credibility of 
information being presented. Teacher’s Edition: Unit 1: T386 Unit 2: T370 Unit 3: T388

Students will tell a story 
using facts and details. Pertinent Reinforce

LA.2.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., helpful/hurtful words).

Teacher’s Edition: Unit 1: T366, T367, T382, T383 Unit 2: T366, T370, 
T382 Unit 3: T384, T385, T368, T369 Unit 4: T362, T378 Unit 5: T364, 
T365, T382, T383 Unit 6: T364, T382

Students will tell a story 
using facts and details. Pertinent Reinforce

LA.2.SL.2.e
e. Use appropriate visual and/or digital 
tools to support verbal communication.

Teacher’s Edition: Unit 1: T370, T432, T434 Unit 2: T370, T386, T434 
Unit 3: T160, T388 Unit 4: T366, T382 Unit 5: T423, T426, T428

Students will tell a story 
using facts and details. Pertinent Reinforce



2 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1 / Realistic Fiction Weeks 1 and 2
TSW identify and decode nouns and verbs with 
infelctional endings -s, -es

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW identify plot structure and describe main 
story elements in a literary text.
TSW explain how captions contribute to the 
meaning of texts.
TSW explain an author's purpose in an 
informational text.

Fantasy Weeks 3 and 4

TSW decode words with two-letter blends- r-
blends, s-blends, t-blends, l-blends; short a, long 
a :
TSW identify and decode words with inflectional 
endings -ed, -ing
TSW identify plot structure and describe main 
story elements in a literary text.
TSW identify and explain a theme of a literary 
text.

Expository Text Weeks 5 and 6 TSW decode words with short i, long i : i_e
TSW explain how charts contribute to the 
meaning of texts.
TSW identify the central idea, or main topic, and 
relevant, or key, details in a text.
TSW explain an author's opinion (s) and 
supporting evidence. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2/ Informational Text Weeks 1 and 2
TSW identify and decode words with short o, long 
o: o_e; short u, long u: u_e

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW explain how diagrams and labels contribute 
to the meaning of texts.
TSW identify the central idea, or main topic, and 
relevant, or key, details of a multiparagraph text 
as well as the focus of specific paragraphs within 
the text.

Fable Weeks 3 and 4

TSW identify and decode words with soft c and g 
: dge, ge, lge, nge; consonant digraphs: ch, -tch, 
sh, ph, th, -ng, wh
TSW identify plot structure and describe main 
story elements in a literary text.

https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing


2 Reading

TSW describe the overall structure of a story, 
including describing how the beginning 
introduces the story and the ending concludes 
the action.
TSW explain an author's purpose in an 
informational text.
TSW will compare and contrast two or more 
versions of the same story (e.g. Cinderella 
Stories)

Poetry Weeks 5 and 6
TSW identify and blend words with three-letter 
blends scr, spr, str, thr, spl, shr
TSW describe how words and phrases supply 
rhythm and meaning in a story, poem or song.
TSW idenify plot and structure and describe main 
story elements in a literary text.
TSW identify and explain lines and line breaks in 
poems

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3/  Narrative Nonfiction Weeks 1 and 2
TSW explain how photos and captions contribute 
to the meaning of texts

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW identify the main purpose of a text, 
including what the author wants to answer, 
explain, or describe.

Fiction Weeks 3 and 4
TSW indentify and blend words with long o; oa, 
ow, oe; Long e: e,ee,ea,ie,y, ey, e_e
TSW describe the overall structure of a story, 
including describing how the beginning 
introduces the story and the ending concludes 
the action. 
TSW acknowledge differences in the points of 
view of characters, inlcuding by speaking in a 
different voice for each character when reading 
dialouge aloud.
TSW explain how headings and sbuheadings 
contribute to the meaning of texts.

Expository Text Weeks 5 and 6
TSW identify and decode words Long u: u_e, ue: 
Long u, ew
TSW explain how diagrams contribute to the 
meaning of texts.
TSW Identify the central idea, or main topic, and 
relevant, or key, details of a multiparagraph text 
as well as the focus of specific paragraphs within 
the text.
TSW identify and explain idioms in texts. 

https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing


2 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 4/ Realistic Fiction Weeks 1 and 2
TSW identify and decode words with silent letters 
wr, kn, gn, mb, sc;r-controlled vowel 

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW acknowledge differents in points of views of 
characters, including by speaking in a different 
voice for each character when reading dialogue 
aloud. 
TSW describe the overall structure of a story, 
including describing how the begining introduces 
the story and the ending concludes the action.
TSW explain how maps contribute to the 
meaning of texts. 

Expository Text Weeks 3 and 4
TSW identify and decode words r-controlled 
vowels
TSW explain how headings and bold print 
contribute to the meaning of texts.
TSW Explain author's purpose in an informational 
text.

Poetry Weeks 5 and 6
TSW identify and decode words with  r-controlled 
vowels
TSW identify plot structure and descrive main 
story elements in a literary text.
TSW understand and identify free verse in 
poems.

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 5/ Biography Weeks 1 and 2
TSW identify and decode words with diphthongs 
ou, ow, oy, oi

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW acknowledge differences in the points of 
view of characters
TSW explain how bold print and timelines 
contribute to the meaning of texts.
TSW identify the main purpose of a text, 
including what the author wants to answer, 
explain, or describe.

Realistic Fiction Weeks 3 and 4

TSW describe the overall structure of a story, 
including describing how the beginning 
introduces the story and the ending concludes 
the action.

https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing


2 Reading

TSW acknowledge differences in the points of 
view of characters, including by speaking in a 
different voice for each character when reading 
dialogue aloud
TSW explain how graphic features and callouts 
contribute to the meaning of texts.

Persuasive Text Weeks 5 and 6
 TSW identify and decode words with short vowel 
digraphs.
TSW explain how charts contribute to hte 
meaning of texts.
TSW identify the main purpose of a text, 
including what the author wants to answer, 
explain, or describe.
TSW describe how reasons support specific 
points the author makes in a text. 

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 6/ Expository Weeks 1 and 2
TSW identify words with closed and open 
syllables.

https://drive.google.
com/file/d/1IiqYQkmwDDhkZk9JY
D_jkAn8WOQGLu80/view?
usp=sharing

https://drive.google.
com/file/d/1IiqYQkmwD
DhkZk9JYD_jkAn8WO
QGLu80/view?
usp=sharing

TSW describe main story elements in a literary 
text.
TSW explain how bar graphs contribute to hte 
meaning of texts.
TSW identify the central idea, or main topic, and 
relevant, or key, details of a multiparagraph text 
as well as the focus of specific paragraphs within 
the text.

Drama/Myth Weeks 3 and 4
TSW identify and decode words with final stable 
syllables, le, el, al, tion, 
TSW identify plot structure and describe main 
story elements in a literary text. 
TSW use information gained from the illustrations 
and words in a print or digital text to demonstrate 
understanding of its characters, setting or plt.
TSW identify and explain a theme of a literary 
text.
TSW recognize and describe alliteration and 
similes in a tet.

Poetry Weeks 5 and 6 TSW recognize stanzas in a poem.
TSW describe how words and phrases supply 
rhythm and meaning in a story, poem, or song.

https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing
https://drive.google.com/file/d/1IiqYQkmwDDhkZk9JYD_jkAn8WOQGLu80/view?usp=sharing


2 Reading

TSW acknowledge differences in the points of 
view of characters, including by speaking in a 
different voice for each character when reading 
dialogue aloud.
TSW determine or clarify the meaning of 
unknown and multiple meaning words and 
phrases



2 Writing

The Second Grade Writing Curriculum can be found at the following link:
https://drive.google.com/drive/folders/0B4xqohHXQGpSN0ZXcVFRRVN2YjQ?resourcekey=0-nwZEGJBbytO-Sb98Hp2lmw&usp=drive_link

https://drive.google.com/drive/folders/0B4xqohHXQGpSN0ZXcVFRRVN2YjQ?resourcekey=0-nwZEGJBbytO-Sb98Hp2lmw&usp=drive_link
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Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

Phonics and Word Analysis

LA.3.F.3

Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition: Unit 1: T26-T27, T50-T51, T60, T61, T63, T104-T105, 
T136-T137, T146, T147, T188-189, T210, T211 Unit 2: T26-T27, T60-
T61, T70, T71, T144-T145, T155, T196-T197, T218, T219 Unit 3: T26-
T27, T52-T53, T62, T63, T106-T107, T150, T151, T214, T215 Unit 4: 
T24-T25, T58-T59, T68, T69, T110-T111, T134-T135, T144, T145, 
T186-T187, T208, T209 Unit 5: T24-T25, T56-T57, T66, T67, T108-
T109, T140-T141, T150, T151, T192-T193, T214, T215 Unit 6: T46-T47, 
T56, T57, T98-T99, T126-T127, T136, T137, T178-T179, T200, T201

Students will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding mastering

LA.3.F.3.a

a. Decode words with common Latin 
suffixes. Teacher’s Edition: Unit 3: T217, T224, T230 Unit 6: T47, T127

Students will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding mastering

LA.3.F.3.b

b. Decode words with common 
derivational suffixes and describe how 
they turn words into different parts of 
speech.

Teacher’s Edition: Unit 3: T14, T177, T180, T208, T224, T230 Unit 5: 
T37, T60, T69, T76, T82, T93, T95, T125, T193, T209

Students will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding mastering

LA.3.F.3.c

c. Decode multisyllabic words. Teacher’s Edition: Unit 1: T26-T27, T50-T51, T60, T61, T104-T105, 
T136-T137, T146, T147, T188-189, T210, T211 Unit 2: T26-T27, T60-
T61, T70, T71, T144-T145, T155, T196-T197, T218, T219 Unit 3: T26, 
T52-T53, T62, T63, T106-T107, T150, T151, T214, T215 Unit 4: T24-
T25, T58-T59, T68, T69, T110-T111, T134-T135, T144, T145, T186-
T187, T208, T209 Unit 5: T24-T25, T56-T57, T66, T67, T108-T109, 
T140-T141, T150, T151, T192-T193, T214, T215 Unit 6: T46-T47, T56, 
T57, T98-T99, T126-T127, T136, T137, T178-T179, T200, T201

Students will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding mastering

Fluency

LA.3.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level text to support 
comprehension.

Teacher’s Edition: Unit 1: T27, T57, T64, T67, T73, T137, T189, T207, 
T214, T217, T223, T240 Unit 2: T27, T67, T77, T83, T115, T151, T161, 
T167, T197, T215, T225, T231, T304 Unit 3: T27, T53, T59, T69, T75, 
T107, T141, T147, T157, T163, T193, T211, T221, T227, T302 Unit 4: 
T25, T59, T65, T75, T81, T135, T187, T205, T215, T221, T296 Unit 5: 
T57, T70, T109, T141, T195, T211, T218, T221, T227 Unit 6: T25, T53, 
T60, T63, T69, T99, T133, T139, T143, T148, T179, T197, T207, T213

Students will increase 
fluency to support 
comprehension.

fluency, comprehension, 
expression, phrasing, 
prosody  reinforcing

LA.3.F.4.a

a. Read a variety of text accurately 
using appropriate rate, 
expression/prosody and intonation to 
reflect the meaning of text.

Teacher’s Edition: Unit 1: T27, T51, T57, T64, T67, T73, T105, T137, 
T143, T153, T159, T189, T207, T214, T217, T223 Unit 2: T27, T61, T67, 
T77, T83, T115, T145, T151, T161, T167, T304 Unit 3: T27, T59, T69, 
T75, T107, T141, T147, T157, T163, T193, T211, T221, T227, T302 Unit 
4: T25, T59, T65, T75, T81, T111, T135, T141, T151, T157, T187, T205, 
T215, T221, T296 Unit 5: T25, T63, T73, T109, T141, T147, T157, T163, 
T193, T195, T211, T218, T221, T227 Unit 6: T25, T53, T60, T63, T69, 
T99, T133, T139, T143, T148, T179, T197, T207, T213

Students will increase 
fluency to support 
comprehension.

fluency, comprehension, 
expression, phrasing, 
prosody  reinforcing
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Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.3.F.4.b

b. Adjust pace and prosody based on 
the purpose, complexity, form, and/or 
style of a text.

Teacher’s Edition: Unit 1: T51, T57, T67, T73, T105, T137, T143, T153, 
T159, T246-T247, T262-T263, T296-T297 Unit 2: T27, T61, T67, T77, 
T83, T145, T254-T255, T270-T271, T304-T305, T316 Unit 3: T27, T59, 
T69, T75, T141, T302-T303 Unit 4: T25, T59, T65, T75, T81, T111, 
T141, T151, T157, T187, T205, T215, T221, T296-T297, T308, T310 
Unit 5: T25, T63, T73, T79, T109, T141, T147, T154, T157, T163, T193, 
T211, T221, T227, T302-T303 Unit 6: T25, T53, T60, T63, T69, T179, 
T288-T289

Students will increase 
fluency to support 
comprehension.

fluency, comprehension, 
expression, phrasing, 
prosody  reinforcing

LA.3.F.4.c

c. Read grade level high-frequency 
words with automaticity and accuracy 
(e.g., Fry or Dolch words or those 
included in instructional materials).

Teacher’s Edition: Unit 1: T26, T62, T212 Unit 3: T216 Unit 5: T68, 
T152, T216 Unit 6: T58, T202

Students will increase 
fluency to support 
comprehension.

fluency, comprehension, 
expression, phrasing, 
prosody  reinforcing
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Central Ideas and Details

LA.3.RP.1

Identify the central message or lesson in 
a literary text and explain how key 
details support that idea.

Teacher’s Edition: Unit 1: T84-T85 Unit 2: T94-T95, T96-T101, T108-
T109, T136-T137, T152-T153, T159, T162-T163, T165, T166-T167, 
T168-T169, T171 Unit 3: T50-T51, T86-T87, T98-T99, T104-T105, 
T146-T147, T148-T149, T155, T156-T157, T158-T159, T161, T162-
T163, T164-T165, T167 Unit 4: T22-T23, T66-T67, T76-T77, T82-T83, 
T132-T133, T170-T173, T180-T181, T194-T195, T198-T199, T204-
T205, T206-T207, T212, T213, T214-T215, T216-T217, T219, T220-
T221, T222-T223, T225, T296-T297 Unit 5: T90-T91, T92-T95, T98-
T99, T100-T101, T104-T105, T146-T147, T148-T149, T155, T156-T157, 
T158-T159, T161, T162-T163, T164-T165, T167 Unit 6: T80-T81, T82-
T85, T92-T93, T96-T97, T118-T119, T132-T133, T134-T135, T141, 
T142-T143, T144-T145, T147, T148-T149, T150-T151, T153, T176-T177

Students will identify the 
main idea of a story and 
support it with details from 
the story. main idea, details Introduce/Reinforcing

LA.3.RP.2

Explain how characters respond to 
major events and challenges in a 
literary text.

Teacher’s Edition: Unit 1: T86-T91, T94-T95, T98-T99, T102-T103, 
T128-T129, T142-T143, T144-T145, T150, T151, T152-T153, T154-
T155, T157, T158-T159, T160-T161, T163, T298-T299 Unit 2: T106-
T107, T110-T111, T112-T113, T150-T151, T152-T153, T160-T161, 
T162-T163, T166-T167, T168-T169, T194-T195, T204-T205, T223, 
T224-T225, T229, T230-T231, T235, T240-T241, T304-T305 Unit 3: 
T100-T101, T146-T147, T154, T155, T156-T157, T161, T162-T163, 
T167 Unit 4: T8-T11, T16-T17, T18-T19, T48-T49, T64-T65, T66-T67, 
T72, T73, T74-T75, T76-T77, T79, T80-T81, T82-T83, T85 Unit 5: T92-
T95, T104-T105, T132-T133, T146-T147, T148-T149, T154, T155, T156-
T157, T161, T162-T163, T164-T165, T167, T302-T303 Unit 6: T90-T91, 
T118-T119, T124-T125, T132-T133, T134-T135, T141, T142-T143, 
T144-T145, T147, T148-T149, T150-T151, T153, T162-T165, T172-
T173, T174-T175, T204, T205, T288-T289, T290-T291

Students will explain how 
characters respond to a 
problem and solution in a 
text. 

problem/solution, 
characters, plot Introduce 

Author's Craft

LA.3.RP.3

Determine and explain the point of view 
in a literary text.

Teacher’s Edition: Unit 2: T229, T235 Unit 5: T161, T167 Unit 6: T211, 
T217

Students will identify point 
of view/author's purpose in 
a story. 

point of view-1st person, 
3rd person Introduce/Reinforce 
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LA.3.RP.4

Explain how sections of a literary text (e.
g., chapters, scenes, stanzas) build on 
one another and contribute to 
meaning.

Teacher’s Edition: Unit 1: T296-T297 Unit 2: T180-T183, T186-T187, 
T188-T189, T192-T193, T208-T209, T216-T217, T226-T227, T232-
T233, T256-T257, T262-T263 Unit 3: T148-T149, T158-T159, T164-
T165 Unit 4: T170-T173, T176-T177, T178-T179, T206-T207, T216-
T217, T222-T223 Unit 6: T94-T95, T140, T162-T165, T168-T169, T170-
T171, T198-T199, T208-T209, T214-T215

Students can use sections 
(stanza, chapers, scene)  
of the text to comprehend 
the story. 

chapters, scenes. 
stanzas Introduce 

Knowledge and Ideas

LA.3.RP.5

Compare and contrast the themes, 
settings, and plots of literary texts written 
by the same author about the same or 
similar characters (e.g., books from a 
series). Teacher’s Edition: Unit 4: T16-T17

Students will compare and 
contrast stories written by 
the same author. plots, themes, setting Introduce 

LA.3.RP.6

Explain what the text says explicitly and 
draw inferences when asking and 
answering questions.

Teacher’s Edition: Unit 1: T86-T91, T96-T97, T100-T101, T102-T103, 
T128-T129, T142-T143, T144-T145, T152-T153, T154-T155, T158-
T159, T160-T161 Unit 2: T96-T101, T104-T105, T108-T109, T110-111, 
T112-T113, T136-T137, T150-T151, T160-T161, T178-T179, T180-
T183, T190-T191, T214-T215, T216-T217, T223, T224-T225, T226-
T227, T229, T230-T231, T232-T233, T235, T240-T241 Unit 3: T88-T93, 
T96-T97, T102-T103, T104-T105, T132-T133, T154 Unit 4: T8-T11, 
T14-T15, T20-T21, T22-T23, T48-T49, T60, T61, T64-T65, T73, T74-
T75, T79, T80-T81, T85, T168-T169, T182-T183, T184-T185, T194-
T195, T204-T205, T206-T207, T216-T217, T222-T223 Unit 5: T92-T95, 
T102-T103, T106-T107, T132-T133, T142, T323 Unit 6: T48, T82-T85, 
T88-T89, T94-T95, T96-T97, T118-T119, T124-T125, T128, T160-T161, 
T174-T175, T186-T187, T192, T196-T197, T198-T199, T205, T206-
T207, T208-T209, T211, T212-T213, T214-T215, T217, T309

Students will answer literal 
and inferential questions 
while reading a text. explicitly, inferences Introduce 

LA.3.RP.7

Compare and contrast themes, topics, 
and/or patterns of events in a range of 
literary texts.

Teacher’s Edition: Unit 1: T145, T155, T306 Unit 2: T124, T135, T153, 
T163, T167, T169, T203, T204, T206, T210, T215, T217, T314 Unit 3: 
T116, T131, T134, T149, T159, T163, T312 Unit 4: T47, T53, T54, T55, 
T60, T65, T67, T75, T77, T182-T183, T184, T193, T194, T196, T205, 
T207, T306 Unit 5: T131, T149, T165, T312 Unit 6: T120, T133, T135

Students will compare and 
contrast themes, topics, 
and events in a story. themes, events Introduce 

Range of Reading and level of text 
complexity

LA.3.RP.8

Read and comprehend a wide range 
of literary texts of appropriate 
complexity for Grade 3 independently 
and proficiently.

Teacher’s Edition: Unit 1: T317 Unit 2: T188-T189, T223, T229, T235, 
T325 Unit 4: T213, T219, T225 Unit 6: T170-T171, T211, T217, T309

Students will read and 
comprehend grade-level 
literary texts 
independently. comprehend, complexity, Reinforce
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Central Ideas and Details



3

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

R
e
a
d
i
n
g
 
I
n
f
o
r

m
a
t
i
o
n
a
l
 
T
e
x
t

LA.3.RI.1

Identify the central idea and explain 
how key details support that idea.

Teacher’s Edition: Unit 1: T172-T175, T182-T183, T196-T197, T200-
T201, T206-T207, T208-T209, T214, T215, T216-T217, T218-T219, 
T221, T222-T223, T224-T225, T227, T294-T295, T298-T299, T302-T303 
Unit 2: T16-T17, T24-T25, T76-T77, T82-T83, T158, T302-T303, T310-
T311, T312-T313, T322, T323, T324, T325 Unit 3: T6-T7, T8-T13, T16-
T17, T20-T21, T24-T25, T58-T59, T60-T61, T66, T67, T68-T69, T70-
T71, T73, T74-T75, T76-T77, T79, T176-T179, T182-T183, T204-T205, 
T210-T211, T220-T221, T222-T223, T226-T227, T228-T229, T256-
T257, T300-T301, T304-T305, T306-T307, T308-T309 Unit 4: T140-
T141, T142-T143, T150-T151, T152-T153, T156-T157, T158-T159, 
T232-T233, T234-T235, T236-T237, T240-T241, T250-T251, T254-
T255, T258-T259, T294-T295, T302-T303, T304-T305 Unit 5: T188-
T189, T190-T191, T308-T309, T310-T311 Unit 6: T8-T11, T14-T15, 
T18-T19, T22-T23, T40-T41, T52-T53, T54-T55, T60, T61, T62-T63, 
T64-T65, T67, T68-T69, T70-T71, T73, T226-T227, T228-T229, T232-
T233, T246-T247, T250-T251, T286-T287, T290-T291, T294-T295

Students will identify the 
main idea of a non-fiction 
text and support it with 
details from the text. central idea, key details Introduce/reinforce 

LA.3.RI.2

Explain the relationship between 
individuals, historical events, scientific 
ideas or concepts, or steps in a process.

Teacher’s Edition: Unit 1: T8-T13, T44-T45, T64 Unit 2: T58-T59, T142-
T143 Unit 3: T60-T61, T70-T71, T76-T77 Unit 4: T94-T97 Unit 5: T186-
T187, T190-T191 Unit 6: T8-T11, T52-T53, T61, T62-T63, T67, T68-
T69, T73

Students will explain the 
relationship between 
events and ideas in a 
nonfiction text. 

relationship, individuals, 
relationships, events Introduce/reinforce 

Author's Craft

LA.3.RI.3

Determine and explain the author’s 
purpose in an informational text.

Teacher Edition: Unit 1: T32, T41, T42, T48-T49, T185, T209, T302 Unit 
2: T50, T56, T58-T59, T127, T134, T302, T310 Unit 3: T44, T204-T205 
Unit 4: T126, T303 Unit 5: T11, T18, T46, T52, T136, T138-T139, T223, 
T308 Unit 6: T37, T38, T291

Students will identify the 
author's purpose in a 
nonfiction text. author's purpose reinforce 

LA.3.RI.4

Explain how text features (titles, 
headings, table of contents, glossaries, 
captions, graphs, maps, and/or other 
visuals) contribute to meaning.

Teacher’s Edition: Unit 1: T56-T57, T66-T67, T72-T73, T184-T185, 
T206-T207, T294-T295 Unit 2: T8-T13, T18-T19, T22-T23, T78-T79, 
T302-T303, T306-T307, T324 Unit 3: T18-T19, T46-T47, T138-T139, 
T176-T179, T184-T185, T300-T301 Unit 4: T94-T97, T294-T295 Unit 5: 
T62-T63, T64-T65, T72-T73, T74-T75, T78-T79, T80-T81, T184-T185, 
T188-T189, T204-T205, T218, T300-T301 Unit 6: T16-T17, T286-T287, 
T294-T295

Students will identify and 
explain text features in a 
nonfiction text. 

headings, glossaries, 
captions, visuals reinforce 

Knowledge and Ideas

LA.3.RI.5

Compare and contrast the two most 
important ideas and key details 
presented by multiple informational 
texts on the same topic.

Teacher’s Edition: Unit 2: T54, T57, T62, T77, T79, T135, T138, T141, 
T310-T312 Unit 3: T202, T211, T221 Unit 4: T143, T153, T298-T300, 
T302-T303 Unit 5: T50, T53, T73, T75, T202, T221, T223, T304-T306, 
T308-T310

Students will compare and 
contrast important ideas 
and details on the same 
topic in informational texts. 

multiple informational 
text reinforce 

LA.3.RI.6

Identify an author’s claim(s) and explain 
how the author supports the claim(s) in 
the text.

Teacher Edition: Unit 1: T132, T173, T174, T175, T182-T183, T194, 
T198, T199, T200-T201, T208-T209, T215, T218-T219, T303 Unit 2: 
T20-T21, T32, T34, T35, T36, T40, T44, T46, T47, T49 Unit 3: T9, T10, 
T12, T20-T21, T31, T32, T34, T36, T40, T45, T58, T60, T134, T136, 
T202, T306, T309 Unit 4: T232-T233, T299, T302 Unit 6: T173, T286, 
T291, T294

Students will identify a 
claim and support it with 
details in a nonfiction text. claim, text introduce
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LA.3.RI.7

Compare and contrast topics and/or 
patterns of events in a range of 
informational texts.

Teacher Edition: Unit 1: T43, T46, T57, T59, T67, T69, T198, T199, 
T207, T209, T217, T302-T303, T304, T306 Unit 2: T51, T54, T67, T69, 
T77, T79, T306-T307, T308, T310-T312 Unit 3: T45, T61, T71, T202, 
T211, T213, T308-T310 Unit 4: T95, T96, T97, T116, T120, T127, T130, 
T136, T143, T153, T298-T300, T302-T304 Unit 5: T50, T63, T65, T73, 
T75, T199 Unit 6: T39, T42, T55, T69, T294-T296, T298

Students will compare and 
contrast topics and events 
in informational texts. 

compare/contrast, 
informational text reinforce 

Range of Reading and Level of 
Text Complexity

LA.3.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity for Grade 3 independently 
and proficiently.

Teacher’s Edition: Unit 1: T215, T221, T227, T317 Unit 2: T66-T67, T76-
T77, T82-T83, T322, T323, T324, T325 Unit 3: T219, T225, T231, T242-
T243, T260-T261, T320, T321, T322, T323 Unit 4: T236-T237, T254-
T255, T314, T315, T316, T317 Unit 5: T16-T17, T184-T185, T225, T231, 
T242-T243, T260-T261, T320, T321, T322, T323 Unit 6: T228-T229, 
T232-T233, T246-T247, T306, T307, T308, T309

Students will read and 
comprehend grade-level 
non-fiction texts 
independently. 

comprehend, 
informational text, 
complexity reinforce 
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Acquisition and Use

LA.3.V.1

Acquire and use grade-level academic 
vocabulary appropriately.

Teacher’s Edition: Unit 1: T14-T15, T62, T70, T76, T92-T93, T139, 
T140-T141, T148, T149, T156, T162, T176-T177, T204-T205, T212, 
T213, T220 Unit 2: T14-T15, T72, T80, T86, T102-T103, T156, T164, 
T170, T184-T185, T220, T221, T228, T234, T306-T307, T308-T309, 
T310-T311, T312-T313, T322, T323, T324 Unit 3: T4-T5, T8-T13, T14-
T15, T64, T65, T72, T78, T84-T85, T94-T95, T144-145, T152, T153, 
T160, T166, T172-T173, T180-T181, T208-T209, T216, T224, T230, 
T246-T247, T248-T249, T306-T307 Unit 4: T12-T13, T61, T62-T63, 
T70, T71, T78, T84, T98-T99, T138-T139, T146, T147, T154, T160, 
T166-T167, T174-T175, T202-T203, T211, T218, T224, T240-T241, 
T258-T259, T268-T269, T296-T297, T307, T314, T315, T316 Unit 5: 
T12-T13, T60-T61, T68, T76, T82, T96-T97, T143, T144-T145, T152, 
T153, T160, T166, T180-T181, T208-T209, T216, T224, T230, T246-
T247, T256-T257, T264-T265, T304-T305, T306-T307, T308-T309 Unit 
6: T12-T13, T49, T50-T51, T58, T66, T72, T86-T87, T129, T130-T131, 
T138, T139, T146, T152, T166-T167, T193, T194-T195, T202, T210, 
T216, T224-T225, T242-T243, T258-T259, T292-T293, T296-T297

Students will use grade-
level vocabulary 
appropriately. 

vocabulary, context 
clues, affixes, root 
words, meaning, key 
words reinforce/master 

LA.3.V.1.a

a. Use sentence-level context clues to 
determine the meaning of a word or 
phrase.

Teacher’s Edition: Unit 1: T8-T13, T14-T15, T54-T55, T63, T70, T76, 
T92-T93, T140-T141, T144-T145, T149, T156, T160-T161, T162, T176-
T177, T204-T205, T208-T209, T213, T216-T217, T218-T219, T220, 
T222-T223, T224-T225, T226, T314, T315, T316 Unit 2: T8-T13, T14-
T15, T64-T65, T96-T101, T148-T149, T180-T183, T323 Unit 3: T14-
T15, T56-T57, T86-T87, T94-T95, T146-T147, T148-T149, T153, T156-
T157, T158-T159, T160, T162-T163, T164-T165, T166, T176-T179, 
T180-T181, T320, T321, T322 Unit 4: T62-T63, T98-T99, T138-T139, 
T142-T143, T147, T152-T153, T154, T158-T159, T160, T210, T314, 
T315, T316 Unit 5: T12-T13, T60-T61, T144-T145, T158-T159, T208-
T209, T212-T213, T217, T222-T223, T224, T228-T229, T230, T320, 
T321, T322

Students will use grade-
level vocabulary 
appropriately. 

vocabulary, context 
clues, affixes, root 
words, meaning, key 
words reinforce/master 
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LA.3.V.1.b

b. Use affixes to determine the meaning 
of unknown words (e.g., comfortable, 
uncomfortable).

Teacher’s Edition: Unit 2: T14-T15, T64-T65, T66-T67, T68-T69, T73, 
T76-T77, T78-T79, T80, T82-T83, T84-T85, T86 Unit 3: T14-T15, T52-
T53, T56-T57, T58-T59, T60-T61, T65, T68-T69, T70-T71, T72, T74-
T75, T76-T77, T78, T106-T107, T140-T141, T174-T175, T176-T179, 
T180-T181, T208-T209, T217 Unit 4: T8-T11, T12-T13, T62-T63, T64-
T65, T66-T67, T71, T74-T75, T76-T77, T78, T80-T81, T82-T83, T84, 
T202-T203 Unit 5: T6-T7, T8-T11, T12-T13, T60-T61, T62-T63, T64-
T65, T69, T76, T82, T208-T209 Unit 6: T126-T127, T150-T151

Students will use grade-
level vocabulary 
appropriately. 

vocabulary, context 
clues, affixes, root 
words, meaning, key 
words reinforce/master 

LA.3.V.1.c

c. Use known root words to determine 
the meaning of unknown words (e.g., 
company, companion).

Teacher’s Edition: Unit 2: T78-T79 Unit 3: T208-T209 Unit 4: T110-
T111, T138-T139 Unit 6: T6-T7, T8-T11, T12-T13, T24-T25, T50-T51, 
T52-T53, T54-T55, T59, T62-T63, T64-T65, T66, T68-T69, T70-T71, 
T72

Students will use grade-
level vocabulary 
appropriately. 

vocabulary, context 
clues, affixes, root 
words, meaning, key 
words reinforce/master 

LA.3.V.1.d

d. Determine the meanings of key words 
and phrases using reference materials 
and classroom resources.

Teacher’s Edition: Unit 1: T280-T281, T282-T283, T284-T285, T286-
T287, T288-T289 Unit 2: T288-T289, T290-T291, T292-T293, T294-
T295, T296-T297 Unit 3: T286-T287, T288-T289, T290-T291, T292-
T293, T294-T295 Unit 4: T280-T281, T282-T283, T284-T285, T286-
T287, T288-T289 Unit 5: T286-T287, T288-T289, T290-T291, T292-
T293, T294-T295 Unit 6: T272-T273, T274-T275, T276-T277, T280-
T281

Students will use grade-
level vocabulary 
appropriately. 

vocabulary, context 
clues, affixes, root 
words, meaning, key 
words reinforce/master 

Context and Connotations

LA.3.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher’s Edition: Unit 1: T39, T120, T131 Unit 2: T35, T99, T102, 
T122, T129, T131, T193, T216, T221, T256 Unit 3: T9, T10, T11, T13, 
T18, T35, T38, T43, T39, T70, T111, T113, T119, T125, T127, T129 Unit 
4: T39, T43, T56-T57, T117, T123, T125, T206-T207, T217 Unit 5: T45, 
T119 Unit 6: T29, T31, T54, T55, T70, T115, T165, T166-T167, T175, 
T190

Students will use 
strategies to interpret 
author's language in grade 
level text.

technical language, 
interpret, Introduce 

LA.3.V.2.a

a. Distinguish between literal and 
nonliteral meanings of words and 
phrases in context (e.g., take steps).

Teacher’s Edition: Unit 2: T102-T103, T148-T149, T157, T164, T170, 
T178-T179, T180-T183, T184-T185, T192-T193, T204-T205, T208-
T209, T212-T213, T214-T215, T221, T224-T225, T228, T230-T231, 
T234, T256-T257, T272-T273, T276-T277 Unit 3: T144-T145, T153 Unit 
4: T56-T57, T168-T169, T170-T173, T174-T175, T182-T183, T204-
T205, T206-T207, T211, T214-T215, T218, T220-T221, T224 Unit 6: 
T194-T195, T196-T197, T198-T199, T203, T206-T207, T208-T209, 
T210, T212-T213, T214-T215, T216, T290-T291

Students will use 
strategies to interpret 
author's language in grade 
level text.

technical language, 
interpret, Introduce 

LA.3.V.2.b

b. Identify real-life connections between 
words and their use (e.g., describe 
people who are friendly or helpful).

Teacher’s Edition: Unit 1: T82-T83 Unit 2: T73 Unit 3: T144-T145, T153, 
T217 Unit 4: T71, T147 Unit 5: T4-T5, T69, T153, T217 Unit 6: T44-T45, 
T59, T130-T131, T139, T203

Students will use 
strategies to interpret 
author's language in grade 
level text.

technical language, 
interpret, Introduce 

LA.3.V.2.c

c. Distinguish nuances of meaning 
between related words that describe 
states of mind or degrees of certainty 
(e.g., believed, suspected). Teacher’s Edition: Unit 1: T54-T55 Unit 2: T148-T149, T212-T213

Students will use 
strategies to interpret 
author's language in grade 
level text.

technical language, 
interpret, Introduce 
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Apply handwriting skills to 
communicate ideas and 
information.
Production of Writing

LA.3.W.1

Write paragraphs using a variety of 
sentence types.

Teacher Edition: Unit 1: T240-T241, T260-T261, T267, T278-T279 Unit 
2: T275, T284-T285 Unit 3: T236, T252, T270, T275, T284 Unit 4: T246, 
T264, T267, T269, T276-T277 Unit 5: T239, T241, T256-T257, T259, 
T270, T272, T275 Unit 6: T238, T245, T254-T255, T256, T261, T271, 
T283

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.a

a. Capitalize proper nouns (e.g., historic 
periods, nationalities, languages), 
proper adjectives (e.g., South 
American), and appropriate words in 
titles. Teacher’s Edition: Unit 3: T282-T283

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.b

b. Use commas in addresses and 
commas and quotation marks in 
dialogue; use an apostrophe to form 
and use possessives.

Teacher’s Edition: Unit 2: T284-T285 Unit 3: T284-T285 Grammar 
Handbook: 502

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.c

c. Use frequently occurring nouns (e.g., 
concrete and abstract), verbs (regular 
and irregular), and simple verb tenses.

Teacher’s Edition: Unit 1: T274-T275, T276-T277 Unit 2: T278-T279, 
T280-T281, T282-T283, T284-T285, T286-T287 Unit 3: T276, T278-
T279, T280-T281, T282-T283, T284 Unit 4: T270, T274-T275, T278 Unit 
5: T276, T278, T280 Grammar Handbook: 475, 478, 479, 480

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.d

d. Distinguish between and use 
coordinating and subordinating 
conjunctions and independent and 
dependent clauses.

Teacher’s Edition: Unit 1: T260-T261, T278-T279 Unit 2: T284-T285 
Unit 4: T276-T277

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.e

e. Explain the function of adjectives and 
adverbs in simple, compound, and 
complex sentences.

Teacher’s Edition: Unit 6: T259, T262-T263, T264-T265, T266-T267, 
T268-T269

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.f

f. Use correct subject-verb and 
pronoun-antecedent agreement in 
speaking and writing.

Teacher’s Edition: Unit 3: T278-T279, T282, T284-T285 Unit 4: T270-
T271, T275, T278-T279 Unit 5: T276-T277, T278-T279, T280-T281 
Grammar Handbook: 482, 483, 489

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.1.g

g. Use frequently occurring prepositions 
and prepositional phrases. Teacher’s Edition: Unit 1: T240-T241, T260-T261 Unit 6: T270-T271

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 
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LA.3.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Teacher’s Edition: Unit 1: T234-T235, T236-T237, T238-T239, T240-
T241, T242-T243, T244-T245, T250-T251, T252-T253, T254-T255, 
T256-T257, T258-T259, T260-T261, T264-T265, T266-T267, T268-
T269, T290-T291 Unit 2: T242-T243, T244-T245, T246-T247, T248-
T249, T250-T251, T252-T253, T258-T259, T260-T261, T262-T263, 
T264-T265, T266-T267, T268-T269, T272-T273, T274-T275, T276-
T277, T298-T299 Unit 3: T244-T245, T248-T249, T250-T251, T252-
T253, T262-T263, T266-T267, T268-T269, T270-T271, T296-T297 Unit 
4: T238-T239, T242-T243, T244-T245, T246-T247, T256-T257, T260-
T261, T262-T263, T264-T265, T290-T291 Unit 5: T244-T245, T248-
T249, T250-T251, T252-T253, T262-T263, T266-T267, T268-T269, 
T270-T271, T296-T297 Unit 6: T230-T231, T234-T235, T236-T237, 
T238-T239, T248-T249, T252-T253, T254-T255, T256-T257, T282-T283

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.2.a

a. Use prewriting activities and resources 
to plan, organize, and draft writing.

Teacher’s Edition: Unit 1: T232-T233, T234-T235, T236-T237, T238-
T239, T240-T241, T250-T251, T252-T253, T254-T255, T264-T265, 
T266-T267, T268-T269, T290-T291 Unit 2: T242-T243, T244-T245, 
T246-T247, T258-T259, T260-T261, T262-T263, T272-T273, T274-
T275, T276-T277 Unit 3: T244-T245, T248-T249, T250-T251, T262-
T263, T266-T267, T268-T269 Unit 4: T238-T239, T242-T243, T244-
T245, T256-T257, T260-T261, T262-T263 Unit 5: T244-T245, T248-
T249, T250-T251, T262-T263, T266-T267, T268-T269, Unit 6: T230-
T231, T234-T235, T236-T237, T248-T249, T252-T253, T254-T255

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: T24-T25, T43, T44-T45, T52, T53, T69, T67, 
T234-T247, T250-T263, T264-T265, T266-T267, T268-T269 Unit 2: T57, 
T62, T63, T69, T135, T136-T137, T242-T255, T258-T271, T315 Unit 3: 
T24, T46, T59, T69, T104-T105, T244-T253, T262-T271 Unit 4: T22, 
T48, T65, T75, T81, T108, T128, T238-T247 Unit 5: T63, T73, T79, T90, 
T106, T110-T111, T131, T132-T133, T137, T163, T200-T201, T244-
T253 Unit 6: T22, T40, T53, T69, T80, T96, T118, T133, T176, T207, 
T213

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

Teacher’s Edition: Unit 1: T240-T241, T242-T243, T256-T257, T258-
T259, T267 Unit 2: T248-T249, T250-T251, T264-T265, T266-T267, 
T275, T277 Unit 3: T252-T253, T270-T271, T319 Unit 4: T246-T247, 
T264-T265, T267, T269, T290-T291, T313 Unit 5: T252-T253, T270-
T271, T296-T297 Unit 6: T238-T239, T256, T305

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.2.d

d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

Teacher’s Edition: Unit 1: T244-T245, T260-T261, T271, T273, T275 
Unit 2: T252-T253, T268-T269, T279, T283 Unit 3: T277, T279, T319 
Unit 4: T271, T275, T277, T290-T291, T313 Unit 5: T277, T281, T296-
T297

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

LA.3.W.2.e

e. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
cursive, font, graphics, symbols).

Teacher’s Edition: Unit 1: T28-T29, T106-T107, T190-T191, T253-T254, 
T294-T295, T310, T312 Unit 2: T28-T29, T116-T117, T198-T199, T302-
T303 Unit 3: T28-T29, T108-T109, T194-T195, T300-T301, T307, T316 
Unit 4: T26-T27, T112-T113, T188-T189, T294-T295, T310, T312 Unit 
5: T26-T27, T110-T111, T194-T195, T300-T301 Unit 6: T26-T27, T100-
T101, T180-T181, T286-T287

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 
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LA.3.W.2.f

f. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Teacher’s Edition: Unit 1: T28-T29, T106-T107, T190-T191, T253-T254, 
T294-T295, T310, T312 Unit 2: T28-T29, T116-T117, T198-T199, T302-
T303 Unit 3: T28-T29, T108-T109, T194-T195, T300-T301, T307, T316 
Unit 4: T26-T27, T112-T113, T188-T189, T294-T295, T310, T312 Unit 
5: T26-T27, T110-T111, T194-T195, T300-T301 Unit 6: T26-T27, T100-
T101, T180-T181, T286-T287

Students will write 
paragraphs using a variety 
of sentence types.

compound, complex, 
simple reinforce/master 

Modes of Writing

LA.3.W.3

Write creative and/or expressive pieces 
that describe a well-developed event 
or experience. Teacher’s Edition: Unit 2: T244-T245

Students will write creative 
and expressive pieces 
using sequence of events. expressive, experience Reinforce

LA.3.W.3.a

a. Engage and orient the ready by 
establishing a situation and introducing 
a narrator and/or character(s).

Teacher’s Edition: Unit 1: T234-T235, T236-T237, T266 Unit 2: T242-
T243, T244-T245, T258-T259, T272, T274

Students will write creative 
and expressive pieces 
using sequence of events. expressive, experience Reinforce

LA.3.W.3.b

b. Include descriptive details about 
characters, events, or settings. Teacher’s Edition: Unit 1: T238-T239, T266-T267 Unit 2: T246-T247

Students will write creative 
and expressive pieces 
using sequence of events. expressive, experience Reinforce

LA.3.W.3.c

c. Use words and phrases to signal a 
sequence of events. Teacher’s Edition: Unit 2: T248-T249, T274-T275

Students will write creative 
and expressive pieces 
using sequence of events. expressive, experience Reinforce

LA.3.W.3.d

d. Provide a closure related to the 
creative or expressive event or 
experience. Teacher’s Edition: Unit 2: T248-T249, T274-T275

Students will write creative 
and expressive pieces 
using sequence of events. expressive, experience Reinforce

LA.3.W.4

Write opinion pieces with supporting 
reasons and/or evidence.

Teacher’s Edition: Unit 1: T252-T253, T254-T255, T256-T257, T268-
T269 Unit 3: T250-T251, T272-T273, T274-T275 Unit 5: T250-T251, 
T274-T275

Students will write an 
opinion piece using 
supporting 
reasons/evidence. opinion, reasoning Reinforce 

LA.3.W.4.a

a. Introduce a topic or text, state an 
opinion, and develop a structure that 
includes reasons and/or evidence.

Teacher’s Edition: Unit 1: T256-T257 Unit 3: T250-T251, T272-T273 
Unit 5: T274-T275

Students will write an 
opinion piece using 
supporting 
reasons/evidence. opinion, reasoning Reinforce 

LA.3.W.4.b

b. Use linking words and phrases to 
connect opinions and reasons. Teacher’s Edition: Unit 1: T260-T261, T268-T269 Unit 3: T274-T275 

Unit 5: T250-T251, T272-T273

Students will write an 
opinion piece using 
supporting 
reasons/evidence. opinion, reasoning Reinforce 

LA.3.W.4.c

c. Provide a concluding statement or 
section related to the opinion.

Teacher’s Edition: Unit 3: T268-T269 Unit 5: T274-T275

Students will write an 
opinion piece using 
supporting 
reasons/evidence. opinion, reasoning Reinforce 

LA.3.W.5

Write informative/explanatory pieces to 
examine a topic or text and convey 
ideas and information.

Teacher’s Edition: Unit 1: T190-T191 Unit 3: T190-T191, T194-T195, 
T307 Unit 4: T230-T247, T248-T265, T266-T267, T268-T269 Unit 6: 
T230-T239, T240-T257, T258-T259, T260-T261

Students will write 
informative/explanatory 
pieces to share 
information on a topic. informative, explanatory Reinforce 

LA.3.W.5.a

a. Introduce a topic and group related 
information together, including 
illustrations when useful to provide 
clarity. Teacher’s Edition: Unit 4: T244-T245, T266-T267 Unit 6: T236-T237

Students will write 
informative/explanatory 
pieces to share 
information on a topic. informative, explanatory Reinforce 
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LA.3.W.5.b

b. Develop the topic with information 
(e.g., facts, definitions, details) clearly 
related to the topic.

Teacher’s Edition: Unit 1: T190-T191, T254-T255 Unit 4: T244-T245, 
T266-T267 Unit 6: T236-T237, T258-T259, T260-T261

Students will write 
informative/explanatory 
pieces to share 
information on a topic. informative, explanatory Reinforce 

LA.3.W.5.c

c. Use linking words and phrases and 
key vocabulary to connect ideas and 
categories of information. Teacher’s Edition: Unit 4: T266-T267 Unit 6: T254-T255, T260-T261

Students will write 
informative/explanatory 
pieces to share 
information on a topic. informative, explanatory Reinforce 

LA.3.W.5.d

d. Provide a concluding statement or 
section related to the topic.

Students will write 
informative/explanatory 
pieces to share 
information on a topic. informative, explanatory Reinforce 

LA.3.W.6

Locate evidence from literary and/or 
informational text sources to answer 
questions about a topic.

Teacher’s Edition: Unit 1: T52, T102-T103, T138, T190-T191, T252-
T253, T268-T269, T294-T295, T300, T301 Unit 2: T52-T53, T303 Unit 3: 
T108, T190-T191, T194-T195, T242-T243, T246-T247, T248, T264-
T265, T272, T274, T301 Unit 4: T112-T113, T188-T189, T240-T241, 
T250-T251, T258-T259, T267, T268, T294-T295 Unit 5: T26-T27, T194-
T195 Unit 6: T26, T100, T180, T232-T233, T236, T242-T243, T250, 
T252

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 

LA.3.W.6.a

a. Paraphrase information from sources 
to support ideas while avoiding 
plagiarism.

Teacher Edition: Unit 3: T28, T194, T256-T257, T275 Unit 4: T26, T188, 
T268 Unit 5: T301 Unit 6: T26, T180, T236-T237, T258, T261

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 

LA.3.W.6.b

b. Identify print and digital tools to 
gather information and ideas to answer 
questions.

Teacher’s Edition: Unit 1: T52, T102-T103, T138, T190-T191, T252-
T253, T268-T269, T294-T295, T300, T301 Unit 2: T52-T53, T303 Unit 3: 
T108, T190-T191, T194-T195, T242-T243, T246-T247, T248, T264-
T265, T272, T274, T301 Unit 4: T112-T113, T188-T189, T240-T241, 
T250-T251, T258-T259, T267, T268, T294-T295 Unit 5: T26-T27, T194-
T195 Unit 6: T26, T100, T180, T232-T233, T236, T242-T243, T250, 
T252

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 

LA.3.W.6.c

c. Sort evidence into categories using 
an appropriate note-taking format to 
collect and organize information.

Unit 1: T28, T190, T252-T253, T300, T301, T306 Unit 3: T108, T194-
T195, T248-T249, T264-T265, T266-T267, T310, T312 Unit 4: T112-
T113, T188-T189, T260-T261, T269, T295, T300, T303, T306 Unit 5: 
T26-T27, T194-T195, T266-T267 Unit 6: T26, T100, T180, T234-T235, 
T252

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 

LA.3.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and referencing sources in 
writing and speaking; provide a list of 
sources.

Teacher’s Edition: Unit 3: T28, T194, T256-T257, T275 Unit 4: T26, 
T188, T268 Unit 5: T301 Unit 6: T26, T180, T236-T237, T258, T261

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 

LA.3.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Teacher’s Edition: Unit 1: T295 Unit 2: T303 Unit 3: T301 Unit 4: T295 
Unit 5: T301 Unit 6: T287

Students will use evidence 
from text sources to 
answer questions about a 
topic. evidence , informational Introduce/Reinforce 
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LA.3.SL.1

Prepare for and participate in structured 
discussions and collaborations about 
3rd grade topics and texts.

Teacher’s Edition: Unit 1: T310-T311 Unit 2: T314, T318-T319 Unit 3: 
T312, T314-T315, T316-T317 Unit 4: T306, T308-T309, T310-T311 Unit 
5: T312, T314-T315, T316-T317 Unit 6: T298, T300-T301, T302-T303

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

LA.3.SL.1.a

a. Ask relevant questions to build on 
ideas and acquire or confirm 
information.

Teacher’s Edition: Unit 1: T4-T5, T82-T83 Unit 2: T4-T5, T266-T267 
Unit 3: T4-T5, T84-T85, T172-T173 Unit 4: T6-T7, T14-T15, T90-T91 
Unit 5: T88-T89

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

LA.3.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
discussion or collaboration.

Teacher’s Edition: Unit 1: T4, T6-T7, T82, T84-T85, T168, T217, T242, 
T246, T258, T296-T297, T306, T307, T309, T311, T313 Unit 2: T4, T6-
T7, T92, T266, T314, T317, T321 Unit 3: T4, T84, T174, T315, T319 
Unit 4: T90, T166, T309, T313 Unit 5: T4, T88, T172, T312, T315, T319 
Unit 6: T4, T53, T63, T69, T78, T158, T301, T305

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

LA.3.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Unit 1: T168-T169, T258-T259, T306, T307, T312-
T313 Unit 2: T92-T93, T176-T177, T250-T251, T315, T320-T321 Unit 3: 
T174-T175, T252-T253, T270-T271, T313, T318-T319 Unit 4: T4-T5, 
T246-T247, T264-T265, T307, T312-T313, T317 Unit 5: T4-T5, T172-
T173, T252-T253, T270-T271, T313, T323 Unit 6: T4-T5, T78-T79, 
T158-T159, T238-T239, T299

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

LA.3.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, recalling, questioning).

Teacher’s Edition: Unit 1: T4, T6-T7, T82, T84-T85, T168, T217, T242, 
T246, T258, T296-T297, T306, T307, T309, T311, T313 Unit 2: T4, T6-
T7, T92, T266, T314, T317, T321 Unit 3: T4, T84, T174, T315, T319 
Unit 4: T90, T166, T309, T313 Unit 5: T4, T88, T172, T312, T315, T319 
Unit 6: T4, T53, T63, T69, T78, T158, T301, T305

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

LA.3.SL.1.e

e. Complete a task following multi-step 
directions.

Teacher’s Edition: Unit 1: T28-T29, T106-T107, T190-T191, T296-T297, 
T305, T306, T308-T309, T310-T311, T312-T313 Unit 3: T28-T29, T108-
T109, T194-T195, T270, T307, T310, T311, T312 Unit 4: T26-T27, 
T112-T113, T296-T297, T300, T306, T310-T311 Unit 6: T26-T27, T100-
T101, T128, T129, T256, T297, T298

Students will participate in 
discussions about grade 
level topics and texts.

structured discussions, 
collaborations Reinforce 

Presentation of Knowledge and Ideas

LA.3.SL.2

Report on a topic or text, tell a story, or 
recount an experience with appropriate 
facts and relevant, descriptive details.

Teacher’s Edition: Unit 1: T53, T203, T308-T309, T310-T311, T312-
T313 Unit 2: T63, T147, T211, T316-T317, T318-T319, T320-T321 Unit 
3: T55, T143, T207, T316-T317, T318-T319 Unit 4: T137, T201, T310-
T311, T312-T313 Unit 5: T207, T314-T315, T316-T317, T318-T319 Unit 
6: T300-T301, T302-T303, T304-T305

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 

LA.3.SL.2.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations, including interpreting 3rd 
grade texts.

Teacher’s Edition: Unit 1: T308-T309, T310-T311, T312 Unit 2: T255, 
T316, T318-T319 Unit 3: T314, T316-T317, T318 Unit 4: T308, T310-
T311, T312 Unit 5: T314, T316-T317, T318 Unit 6: T300, T302-T303, 
T304

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 
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LA.3.SL.2.b

b. Convey a perspective with clear 
reasoning and support.

Teacher’s Edition: Unit 1: T28, T53, T203, T268-T269, T308-T309, 
T310-T311, T312-T313 Unit 2: T28, T63, T116, T238, T248, T316-T317, 
T318-T319, T320-T321 Unit 3: T28, T55, T194, T207, T238, T256, T272, 
T316-T317, T318-T319 Unit 4: T26, T137, T310-T311, T312-T313 Unit 
5: T26, T110, T194, T207, T314-T315, T316-T317, T318-T319 Unit 6: 
T300-T301, T302-T303, T304-T305

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 

LA.3.SL.2.c

c. Identify the purpose and credibility of 
information being presented. Teacher’s Edition: Unit 1: T258-T259, T309, T313 Unit 2: T317, T321 

Unit 3: T252-T253, T270-T271, T315, T319 Unit 5: T252-T253, T315, 
T319 Unit 6: T256-T257, T301, T305

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 

LA.3.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Teacher’s Edition: Unit 1: XV, S2, S3, S5, T4, T242, T258-T259, T313 
Unit 2: T176, T266-T267, T271, T317, T321 Unit 4: T90, T166, T264, 
T311 Unit 5: T315, T317 Unit 6: T158, T238, T303, T305

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 

LA.3.SL.2.e

e. Use appropriate visual and/or digital 
tools to enhance verbal communication 
and add interest.

Teacher’s Edition: Unit 1: T28-T29, T106-T107, T190-T191, T203, T310-
T311, T312-T313 Unit 2: T63, T144-T145, T147, T196-T197, T198-
T199, T211, T318-T319, T320-T321 Unit 3: T55, T108-T109, T143, 
T194-T195, T316-T317, T318-T319 Unit 4: T110-T111, T112-T113, 
T186-T187, T188-T189, T201, T310-T311, T312-T313 Unit 5: T24-T25, 
T26-T27, T59, T194-T195, T316-T317, T318-T319 Unit 6: T24-T25, 
T100-T101, T180-T181, T193, T302-T303, T304-T305

Students will share about 
a grade level topic, text, 
story, or experience 
supported by facts and 
details.

report, recount, relevant 
descriptive  Reinforce 



3 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1 Weeks 1-2 TSW Ask and answer questions

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW identify the text structures of 
chronology, comparison and 
coause/effects in texts
TSW explain how heading and maps 
contribute to meaning in a text
TSW explain the development of an 
author's purpose in an informational text

Weeks 3-4
TSW explain different characters 
perspectives in a literary text
TSW explain how one or more characters 
develop in a literary text
TSW explain the development of an 
authors purpose in an informational text\

Weeks 5-6

TSW explain how text features 
contriobute to meaning and idenfify the 
text structures of chronology, comparison, 
and cause/effect in texts.
TSW identify the central idea and explain 
how relevant details support the idea in a 
text
TSW identify an authors claim and 
explain how and author uses evidence to 
support the claim

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2 Weeks 1-2

TSW explain how text features contribute 
to meaning and identify the text structures 
of chronology, comparison and 
cause/effect in texts

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW explain how text features contribute 
to meaning and identify the text structures 
of chronology, comparison and 
cause/effect in texts
TSW identify an authors claim and 
explain how and author uses evidence to 
support the claim
TSW explain the development of an 
author's purpose in an informational text

https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing


3 Reading

Weeks 3-4

TSW explain how one or more characters 
develop throughout the plot in a literary 
text
TSW explain theme and how it develops, 
using details, in a literary text

Weeks 5-6
TSW explain different characters 
perspectives in a literary text
TSW identify different kinds of poems; 
free verse, rhymed verse, haiku, and 
limmerick
TSW explain how rhyme scheme 
contributes to the meaning of the text

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3 Weeks 1-2

TSW explain how text features contribute 
to meaning and identify the text structures 
of chronology, comparison and 
cause/effect in texts

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW identify the central idea and explain 
how relevant details support that idea in a 
text

Weeks 3-4
TSW explain a theme and how it 
develops using details in a literary text.
TSW explain different characters 
perspectives in literary text.
TSW how text features contribute to 
meaning and identify the text features of 
chonology, comparison, and cause/effect 
in texts.

Weeks 5-6
TSW explain how timeslines and captions 
contribute to the meaning of the text
TSW identify the text structure of 
chronology
TSW explain the development of an 
authors purpose oin an informational text

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 4 Weeks 1-2
TSW explain different characters 
perspective in a literary text

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW explain how one or more characters 
develop throughout the plot in a literary 
text

https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing


3 Reading

TSW identify and explain metaphors 
personification and hyperbole in trext

Weeks 3-4
TSW explain a theme and how it 
develops using details in a literary text
TSW explain how text features contribute 
to meaning and identify the text structures 
of chronology, comparison and 
cause/effect in texts

Weeks 5-6
 TSW identify types of poems: free verse, 
rhymed verse, haiku and limerick
TSW explain a theme and how it 
develops using details in a literary text
TSW explain a theme and how it 
develops using details in a literary text

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 5 Weeks 1-2
TSW explain how captions and timelines 
contribute to the meaning of a text

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW explain the development of an 
authors purpose in an informational text
TSW identify an authors claim and 
explain how an author uses evidence to 
support the claim
TSW identify the text structures of cause 
and effect

Weeks 3-4
TSW explain a theme and how it 
develops using details in a literary text
TSW explain different characters 
perspectives in a literary text
TSW explain the development of an 
authors purpose in an informational text

Weeks 5-6

TSW identify an authors claim and 
explain how an author uses evidence to 
support the claim
TSW explain how sidebars and maps 
contribute to the meaning of the text
TSW identify the text structure of cause 
and effect

https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing


3 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 6 Weeks 1-2
TSW identify and explain metaphors 
personification and hyperbole in trext

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydj
KqUqevZ5yyhm/view?usp=sharing

https://drive.google.
com/file/d/12gQgzm4Idgb64pFWjydjKqUqev
Z5yyhm/view?usp=sharing

TSW how text features contribute to 
meaning and identify the text features of 
chonology, comparison, and cause/effect 
in texts.
TSW explain the development of an 
authors purpose in an informational text
TSW identify the central idea and explain 
how relevant details support that idea in 
the text

Weeks 3-4
TSW explain different characters 
perspective in a literary text
TSW explain a theme and how it 
develops using details in a literary text
TSW explain how  one or more 
characters develop throughout the plot in 
a literary text

Weeks 5-6
TSW identify and explain metaphors 
personification and hyperbole in trext
TSW explain different characters 
perspectives in a literary text
 TSW identify types of poems: free verse, 
rhymed verse, haiku and limerick

https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing
https://drive.google.com/file/d/12gQgzm4Idgb64pFWjydjKqUqevZ5yyhm/view?usp=sharing


3 Writing

The third grade writing curricum can be found at the following link:
https://drive.google.com/drive/folders/0B4xqohHXQGpSZjB5MVRUd0Nyalk?resourcekey=0-tNY2WsvaOMR_Rrj1xXxu0g&usp=drive_link

https://drive.google.com/drive/folders/0B4xqohHXQGpSZjB5MVRUd0Nyalk?resourcekey=0-tNY2WsvaOMR_Rrj1xXxu0g&usp=drive_link
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Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master
Concepts of Print

Phonics and Word Analysis

LA.4.F.3

Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition: Unit 1: T24-25, T47, T56-57, T98-99, T132-133, T196-197, 
T268-269, T270-271, T272-273, T274-275, T276-277 Unit 2: T24-25, T62-63, 
T134-135, T144-145, T201, T208-209, T282-283, T284-285, T286-287 Unit 3: 
T24-25, T50-51, T60-61, T102-103, T144-145, T208-209, T280-281, T282-283, 
T284-285, T286-287, T288-289 Unit 4: T24-25, T50-51, T60-61, T102-103, 
T133, T142-143, T206-207, T278-279, T280-281, T282-283, T284-285, T286-
287 Unit 5: T24-25, T56-57, T66-67, T108-109, T138, T139, T148-149, T190-
191, T212-213, T282-283, T286-287, T288-289, T290-291 Unit 6: T24-25, T57, 
T66-67, T108, T144-145, T186, T208-209, T278-279, T280-281, T286-287

TSW will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding Mastery

LA.4.F.3.a

a. Decode words with common Latin 
derived words.

Teacher’s Edition: Unit 2: T138 Unit 3: T171, T172, T173, T174, T175, T202, 
T203, T211, T216, T218, T222, T224 Unit 4: T10, T11, T12, T13, T34, T54, 
T55, T58, T63, T68, T70, T74, T76, T132, T133 Unit 5: T25, T108, T109, T191 
Unit 6: Unit T9, T10, T12, T13, T14, T34, T56, T57, T64, T69, T74, T76, T80, 
T82, T135

TSW will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding Mastery

LA.4.F.3.b

b. Use combined knowledge of letter-
sound correspondences, syllabication 
patterns, and morphology (e.g., roots 
and affixes) to read accurately 
unfamiliar multisyllabic words in and out 
of context.

Teacher’s Edition: Unit 1: T24, T46, T56, T57, T98, T122, T132, T133, T156, 
T158, T162, T174, T190, T192, T194, T196, T197, T199, T204, T202, T206, 
T208, T210, T212 Unit 2: T6, T41, T52, T58, T60, T62, T63, T65, T68, T70, 
T72, T74, T76, T78, T104, T134, T144, T145, T186, T202 Unit 3: T24, T50, 
T54, T60, T61, T100, T102, T134, T145, T186, T208, T209 Unit 4: T24, T60, 
T61. T292, T312, T313 Unit 5: T24, T56, T66, T67, T108, T138, T148, T149, 
T108, T138, T190, T212 Unit 6: T24, T30, T32, T56, T60, T66, T67, T108, 
T134, T186, T208, T209, T312

TSW will use phonics 
strategies to decode and 
encode words.

phonics, decoding, 
encoding Mastery

Fluency

LA.4.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level text to support 
comprehension.

Teacher’s Edition: Unit 1: T158, T174, T305 Unit 2: T28, T302, T315 Unit 3: 
T234, T236, T238, T252, T254, T256 Unit 4: T232, T234, T236, T250, T252, 
T254 Unit 5: T190 Unit 6: T119

TSW accurately and 
fluently read grade level 
text to support 
comprehension

accuracy, phrasing, 
rhythm reinforce

LA.4.F.4.a

a. Read a variety of text accurately 
using appropriate rate, 
expression/prosody and intonation to 
reflect the meaning of text.

Teacher’s Edition: Unit 1: T24, T46, T58, T60, T122, T134, T136, T174, T193, 
T198, T200, T202, T209, T284 Unit 2: T24, T52, T64, T66, T104, T134, T146, 
T186, Unit 3: T24, T50, T62, T64, T100, T102, T134, T146, T148, T186, T210, 
T212, T62, T64, T296 Unit 4: T50, T24, T294, T310 Unit 5: T24, T56, T68, T70, 
T108, T138, T150, T152, T108, T138, T190, T214, T216, T298 Unit 6: T24, 
T56, T68, T70, T108, T134, T140, T150, T156, T186, T210, T212, T294

TSW accurately and 
fluently read grade level 
text to support 
comprehension

accuracy, phrasing, 
rhythm reinforce

LA.4.F.4.b

b. Adjust pace and prosody based on 
the purpose, complexity, form, and/or 
style of a text.

Teacher’s Edition: Unit 1: T24-25, T46-47, T58, T60, T122-123, T134, T136, 
T174, T193, T198, T200, T202, T209, T284, T305 Unit 2: T24, T28, T52, T64, 
T66, T104, T134, T146, T186, T302 Unit 3: T24, T50, T62, T64, T100, T102, 
T134, T146, T148, T186, T210, T212, T232, T234, T236, T250, T254, T256, 
T296 Unit 4: T50, T24, T294, T310 Unit 5: T24, T56, T68, T70, T108, T138, 
T150, T152, T108, T138, T190, T214, T216, T298 Unit 6: T24, T56, T68, T70, 
T108, T119, T134, T140, T150, T156, T186, T210, T212, T294

TSW accurately and 
fluently read grade level 
text to support 
comprehension

accuracy, phrasing, 
rhythm reinforce
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master
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LA.4.RP.1

Determine a theme in a literary text and 
how it is conveyed through key details.

Teacher’s Edition: Unit 2: T88, T90, T98, T110, T112, T116, T120, T122, T123, 
T125, T129, T129, T130, T131, 140, 142, T150, T152, T155, T156, T158, T161, 
T192 Unit 3: T6, T8, T11, T38, T41 Unit 4: T315 Unit 5: T126, T130 Unit 6: 
T51, T53, T93, T94, T95, T100, T102, T114, T117, T126, T140, T142, T150, 
T152, T156, T158, T168, T170, T172, T173, T180, T192, T193, T196, T197, 
T200, T204, T206, T212, T123, T125, T213, T214, T216, T219, T220, T225, 
T266

TSW be able to determine 
theme in a text by using 
detaiis

theme, text, key details reinforce 

LA.4.RP.2

Analyze a character, setting, or event in 
a literary text, drawing on specific 
details such as a character’s thoughts, 
words, or actions.

Teacher’s Edition: Unit 1: T80, T82, T90, T92, T94, T96, T128, T130, T136, 
T137, T138, T140, T143, T144, T146, T149, T128, T130, T284 Unit 2: T88, 
T89, T96, T100, T102, T109, T111, T113, T114, T115, T117, T119, T121, T126, 
T130, T140, T142, T147, T150, T152, T155, T156, T158, T161, T204 Unit 3: 
T8, T14, T16, T20, T22, T21, T31, T33, T35, T36, T37, T39, T42, T56, T296, 
T298 Unit 4: T169, T176, T294 Unit 5: T51, T52, T90, T98, T100, T104, T102, 
T106, T114, T116, T118, T120, T122, T124, T127, T130, T133, T134, T136, 
T144, T146, T152, T153, T154, T156, T159, T160, T162, T165 Unit 6: T51, 
T54, T90, T94, T98, T100, T104, T106, T118, T120, T122, T197

TSW be able to identify 
character, setting, and plot 
in story

character, setting, plot reinforce 

Author's Craft

LA.4.RP.3

Distinguish reader perspective from the 
perspective and point of view of the 
narrator or the characters in a literary 
text.

Teacher’s Edition: Unit 2: T170, T180, T182, T192 Unit 3: T8, T9, T10, T29, 
T30, T34, T37, T41, T56, T58, T64, T65, T66, T68, T71, T72, T74, T77, T18, 
T20, T56, Unit 5: T133 Unit 4: T96 Unit 6: T198, T213, T219, T225, T230, T262

TSW be able to 
recongnize different points 
of view in a text

perspective, point of 
view reinforce

LA.4.RP.4

Compare and contrast the structural 
elements of literary texts (e.g., dramas, 
narratives, and poems).

Teacher’s Edition: Unit 1: T82 Unit 2: T86, T89, T91, T94, T96, T100, T109, 
T110, T116, T119, T126, T140, T142, T150, T152, T156, T158, T168, T170, 
T173, T176, T178, T191, T192, T198, T168, T170, T176, T180 Unit 3: T296 
Unit 4: T166, T168, T170, T171, T174, T176, T180, T294 Unit 5: T126, T130, 
T298 Unit 6: T50, T168, T170, T171, T172, T178, T191, T204, T206, T214, 
T216, T220, T246

TSW be able to compare 
and contrast in a story 

compare, contrast, 
structural elements reinforce 

Knowledge and Ideas

LA.4.RP.5

Compare and contrast the treatment of 
similar themes and topics and patterns 
of events in literary texts by different 
authors or from different cultures.

Teacher’s Edition: Unit 2: T125, T128, T137 Unit 3: T41 Unit 4: T171, T198 
Unit 6: T47, T54, T184, T200

TSW be able to compare 
and contrast from text to 
text and text to world

theme, patterns, cultures introduce 

LA.4.RP.6

Explain what the text says explicitly and 
draw inferences when asking or 
answering questions, quoting or 
paraphrasing specific evidence from 
the text as appropriate.

Teacher’s Edition: Unit 1: T88, T94, T96, T156 T164, T170, T172 Unit 2: T20, 
T46, T48, T49, T89, T102, T111, T115, T119, T126, T184, T194, T197 Unit 3: 
T9, T22, T31, T33, T42, T100, T176, T184, T194, T306, T317 Unit 4: T9, T180, 
T181 Unit 5: T51, T52, T54, T98, T100, T104, T115, T117, T121, T134, T136, 
T186, T188 Unit 6: T22, T45, T51, T52, T62, T64, T70, T72, T74, T78, T80, 
T93, T94, T98, T104, T106, T115, T116, T117, T119, T121, T126, T140, T142, 
T150, T152, T156, T158, T174, T194, T192, T196, T212, T230, T304

TSW be able to draw 
inferences from text

inference, evidence, 
paraphrasing reinforce 

LA.4.RP.7

Explain an author or narrator/speaker’s 
treatment of similar themes and/or 
patterns of events in a wide range of 
literary texts.

Teacher’s Edition: Unit 2: T125, T128, T137 Unit 3: T41 Unit 4: T171, T198 
Unit 6: T47, T54, T184, T200

TSW be able to explain 
the author's purpose in a 
story 

themes, patterns, literary 
text introduce 

Range of Reading and level of text 
complexity
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
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Master
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Read and comprehend a wide range 
of literary texts of appropriate 
complexity for Grade 4 independently 
and proficiently.

Teacher’s Edition: Unit 1: T16, T82, T90 Unit 2: T178 Unit 3: T14, T16, T40, 
T213, T219, T225 Unit 4: T8 Unit 5: T100 Unit 6: T14, T125, T180, T100

TSW be able 
independently to read and 
comprehend 4th grade 
texts 

comprehend, 
independent, proficient reinforce 
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Central Ideas and Details

LA.4.RI.1

Determine the central idea of an 
informational text and how it is 
conveyed through key details.

Teacher’s Edition: Unit 1: T6, T14, T52, T54, T62, T64, T68, T70,T158, T159, 
T160, T161, T168, T181. T184, T185, T192, T194, T200, T201, T202, T204, 
T208, T210, T213, T224, T286, T290, T292, T304 Unit 2: T6, T8, T14, T18, 
T20, T30, T31, T32, T34, T36, T37, T38, T39, T40, T41, T42, T45, , T46, T58, 
T60, T66, T67, T68, T70, T73, T74, T76, T79, T232, T236, T240, T250, T252, 
T254 Unit 3: T47, T84, T89, T132, T137, T168, T170, T193, T196, T197 T232, 
T240, T258 Unit 4: T8, T11, T14, T36, T39, T41, T45, T47, T238, T248, T256, 
T314 Unit 5: T6, T8, T14, T62, T64, T71, T72, T74, T77, T78, T80, T83, , T170, 
T174, T180, T200, T208, T210, T218, T220, T250, T300, T318 Unit 6: T6, T8, 
T18, T20, T22, T30, T32, T36, T39, T40, T42, T44, T47, T62, T64, T71, T72, 
T74, T77, T78, 80, T83, T129, T131

TSW be able to find the 
central idea and details in 
an informational text

central (main) idea, key 
details, informational text reinforce

LA.4.RI.2

Analyze an individual, event, scientific 
idea or concept, or steps in a process.

Teacher’s Edition: Unit 1: T20, T22, T186, T288 Unit 2: T8, T302 Unit 3: T250, 
T298 Unit 4: T9, T10, T21, T35, T296 Unit 5: T6, T14, T18, T20, T22, T62, T64, 
T70, T72, T74, T78, T80, T174 Unit 6: T6, T14, T33, T48, T300, T302

TSW be able to sequence 
the events in an 
informational text 

analyze, steps in a 
process reinforce

Author's Craft

LA.4.RI.3

Compare and contrast authors’ 
perspectives in multiple informational 
texts of the same topic. Teacher’s Edition: Unit 1: T31, T34, T176 Unit 2: T236, T254 Unit 4: T45

TSW be able to compare 
and contrast in 
informational text 

compare/contrast, 
perspective, 
informational text

reinforce

LA.4.RI.4

Describe the overall structure of an 
informational text and how it contributes 
to meaning.

Teacher’s Edition: Unit 1: T8, T14, T18, T20, T22, T52, T54, T60, T61, T62, 
T64, T67, T68, T70, T73, T172, T179, T180, T184, T186 Unit 2: T48, T244, 
T302, T316, T316 Unit 3: T46, T48, T89, T98, T168, T182, T194, T196, T198, 
T232, T250, T268 Unit 4: T8, T9, T18, T20, T22, T30, T32, T36, T38, T42, T44, 
T45, T46, T56, T58, T64, T72, T74, T77, T230 Unit 5: T8, T18, T22, T30, T32, 
T36, T38, T39, T43, T44, T46, T48, T62, T64, T70, T71, T72, T74, T77, T78, 
T80, T83, T170, T184, T186, T174, T195, T200, T208, T210, T216, T217, T218, 
T220, T222, T224, T226, T229, T304 Unit 6: T29, T35, T44, T129, T130

TSW be able to recognize 
text features in an 
informational text 

structure, meaning reinforce 

Knowledge and Ideas

LA.4.RI.5

Integrate information from multiple 
informational texts on the same topic in 
order to demonstrate knowledge of the 
topic.

Teacher’s Edition: Unit 1: T26-27, T49, T100-101, T176-177, T189, T289 Unit 
2: T26-27, T106-107, T188-189, T230-269, T301 Unit 3: T26-27, T104-105, 
T137, T188-189, T268 Unit 4: T26-27, T104-105, T186-187 T228-267 Unit 5: 
TT26-27, T110-111, T192-193, 254-265 Unit 6: T26-27, T110-111, T159, T188-
189

TSW be able to use 
multiple texts to better 
understand a topic

integrate, research reinforce 

LA.4.RI.6

Identify an author’s claim(s) and explain 
how the author supports the claim in the 
text.

Teacher’s Edition: Unit 1: T14, T44, T61, T67, T73, T120, T170, T171, T180, 
T202, T204, T208, T210, T213, T220, T222, T238, T240, T242, T246, T286 
Unit 2: T37, T46, T232, T234, T240, T250, T252, T258 Unit 3: T45, T87, T88, 
T96, T100, T116, T120, T126, T129, T170, T176, T178, T180, T182, T184, 
T192, T204, T206, T212, T213, T214, T216, T219, T220, T222, T224, T225, , 
T234, T236, T240, T252, T254, T258, T302 Unit 4: T22, T31, T33, T36, T37, 
T38, T232, T234, T238, T250, T252, T256, T300; Unit 5: T41, T45, T200, T202, 
T217, T222, T229, T302, T306 Unit 6: T37, T42, T46, T48

TSW be able to 
understand an author's 
point of view on a text 

author's claim, opinion, 
perspective reinforce 
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LA.4.RI.7

Explain an author or speaker’s 
treatment of similar topics and/or 
patterns of events in a wide range of 
informational texts.

Teacher’s Edition: Unit 1: T44, T100, T105, T112, T114, T117, T120, T176, 
T179, T181, T182, T184 Unit 2: T26, T37, T46, T54, T55 Unit 3: T87, T88, T96, 
T100, T104, T132 Unit 4: T104, T124 Unit 5: T41, T45, T46, T188, T192, T196, 
T202 Unit 6: T26

TSW be able to find the 
author's purpose in 
informational texts 

topic, patterns reinforce 

Range of Reading and Level of 
Text Complexity

LA.4.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity for Grade 4 independently 
and proficiently.

Teacher’s Edition: Unit 1: T164, T166, T290 Unit 2: T14, T16, T317 Unit 3: 
T317 Unit 4: T8, T14, T16, T312, T313, T315 Unit 5: T16, T71, T77, T83, T182, 
T304, T316, T317, T318 Unit 6: T312, T313, T314, T315

TSW be able 
independently to read and 
comprehend 4th grade 
informational texts

comprehend, 
independent, proficient reinforce 

V
o
c
a
b
u
l
a
r
y

Acquisition and Use

LA.4.V.1

Acquire and use grade-level academic 
vocabulary appropriately.

Teacher’s Edition: Unit 1: T12-13, T50-51, T72, T86-87, T126-127, T148, T162-
163, T190-191, T212, T257 Unit 2: T13, T55-57, T78, T138-139, 1T60, T175, 
T202-203, T218, T224 Unit 3: T13, T54-55, T76, T91, T138-139, T160, T174, 
T175, T202-203, T224, T262-263 Unit 4: T13, T54-55, T76, T91, T136-137, 
T158, T173, T200-201, T222 Unit 5: T13, T60-61, T82, T97, T142-143, T155, 
T164, T179, T206-207, T228 Unit 6: T13, T60-61, T82, T97, T138-139, T151, 
T160, T175, T202, T224

TSW be able to use 
vocabulary appropraitely vocabulary reinforce 

LA.4.V.1.a

a. Use context clues (e.g., definitions, 
examples, or restatements) to 
determine the meanings of words and 
phrases.

Teacher’s Edition: Unit 1: T6, T8, T12, T50, T52, T54, T59, T62, T64, T66, T68, 
T70, T72, T80, T126, T190, T161, T190, T284, T286 Unit 2: T8, T268, T298, 
T314, T315 Unit 3: T6, T8, T12, T56, T168 Unit 4: T48, T166, T168, T169, 
T172, T312, T313 Unit 5: T12, T60, T69, T76, T82, T92, T96, T142, T151, 
T158, T164, T170, T208, T215, T222, T228, T300, T316 Unit 6: T90, T93, T94, 
T96 T138, T140, T142, T150, T152, T156, T158, T168, T206, T216, T294, T96, 
T312

TSW be able to use 
vocabulary appropraitely vocabulary reinforce 

LA.4.V.1.b

b. Use commonly occurring Latin affixes 
and roots to determine the meanings of 
words and phrases (e.g., photograph, 
autograph).

Teacher’s Edition: Unit 2: T12, T56, T138 Unit 3: T54, T174, T202, T206, T211, 
T216, T218, T220, T222, T224, T294 Unit 4: T6, T8, T10, T11, T12, T13, T34, 
T54, T55, T56, T58, T63, T70, T72, T74, T76 Unit 5: T24, T25, T108, T109, 
T206 Unit 6: T6, T8, T9, T10, T12, T13, T24, T34, T56, T60, T62, T64, T69, 
T72, T74, T76, T78, T80, T82, T134 T282, T284, T286, T292

TSW be able to use 
vocabulary appropraitely vocabulary reinforce 

LA.4.V.1.c

c. Determine or clarify the meanings or 
pronunciations of words using reference 
materials and classroom resources.

Teacher’s Edition: Unit 1: T190, T286 Unit 2: T154, T160, T198, T290, T314, 
T315 Unit 3: T290 Unit 4: T63, T166, T170, T172 Unit 5: T300 Unit 6: T238, 
T242, T254, T258

TSW be able to use 
vocabulary appropraitely vocabulary reinforce 

Context and Connotations

LA.4.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher’s Edition: Unit 1: T35, T84, T85, T86, T105, T119, T135, T140, T142, 
T146, T148 Unit 2: T171-175, T203, T204, T206-207, T216, T217, T222, T223 
Unit 3: T113, T117, T124 Unit 4: T9, T39, T45, T87, T115, T119, T205, T221 
Unit 5: T94-95, T117, T121, T133, T134, T142, T146-147, T151, T156-158, 
T162-164, T195 Unit 6: T35, T37, T43, T95, T117, T121, T206, T211, T216, 
T218, T222, T224, T250-252

TSW be able to interpret 
an author's use of 
language in a variety of 
formats 

interpret, figurative 
language, connotation, 
technical language

reinforce 



4

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

V
o
c
a
b
u
l
a
r
y

LA.4.V.2.a

a. Explain the meaning of commonly 
occurring similes and metaphors (e.g., 
light as a feather) in grade-level text.

Teacher’s Edition: Unit 2: T39, T129, T168, T174, T184, T192, T196 Unit 3: 
T314, T315, T316 Unit 5: T33, T42, T115, T90, T92, T96, T134, T142, T144, 
T146, T151, T154, T156, T158, T160, T162, T164 T119, T123, T128, T191, 
T90, T142, T296, Unit 6: T115, T116, T170, T173, T174, T194 204, T206, T211, 
T217, T218, T220, T224, T246, T250, T252, T267

TSW be able to interpret 
an author's use of 
language in a variety of 
formats 

interpret, figurative 
language, connotation, 
technical language

reinforce 

LA.4.V.2.b

b. Recognize and explain the meaning 
of commonly occurring idioms and 
adages.

Teacher’s Edition: Unit 1: T80, T86, T126, T128, T130, T135, T138, T140, 
T142, T144, T146, T148, T126, T128, T130 Unit 2: T168, T171, T174, T194, 
T202 Unit 3: T11, T113, T117, T124 Unit 4: T39, T45, T294 Unit 5: T121, T133, 
T142, T195, T196, T178, T218, T206, T210, T215, T218, T220, T222, T224, 
T226, T228 Unit 6: T117, T121

TSW be able to interpret 
an author's use of 
language in a variety of 
formats 

interpret, figurative 
language, connotation, 
technical language

reinforce 

LA.4.V.2.c

c. Use knowledge of words by relating 
them to their antonyms and synonyms.

Teacher’s Edition: Unit 1: 135 Unit 2: T86, T88, T90, T92, T118, T140, T142, 
T147, T150, T152, T154, T156, T158, T160, T294 Unit 3: T88, T89 Unit 4: 
T266, T284 Unit 5: T6, T12, T35, T60, T62, T64, T69, T72, T74, T76, T78, T80, 
T82 Unit 6: T69, T136, T262

TSW be able to interpret 
an author's use of 
language in a variety of 
formats 

interpret, figurative 
language, connotation, 
technical language

reinforce 

Production of Writing

LA.4.W.1

Create grammatically correct 
sentences and paragraphs using a 
variety of sentence types and phrasing.

Teacher’s Edition: Unit 1: T262, T263, T264, T265 Unit 2: T279 Unit 5: T279, 
T281 Unit 6: T265, T274, T276, T277

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.a

a. Capitalize proper nouns (e.g., 
organizations, geographic regions, 
monuments and landmarks).

Teacher’s Edition: Unit 2: T271 Unit 4: T267, T269 Unit 5: T263 Unit 6: T243, 
T271

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.b

b. Use commas and quotation marks to 
indicate direct speech and quotations 
from a text; use a comma before a 
coordinating conjunction in a 
compound sentence and with 
dependent clauses.

Teacher’s Edition: Unit 1: T96 Unit 3: T268 Unit 4: T272 Unit 5: T272 Unit 6: 
T242, T270, T274

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.c

c. Identify and use simple appositive 
phrases. Teacher’s Edition: Unit 5: T279, T281

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.d

d. Identify and use frequently occurring 
pronouns (e.g., subject, object), 
adverbs (e.g., relative), and verbs (e.g., 
helping and linking). Teacher’s Edition: Unit 1: T264 Unit 4: T268 Unit 6: T263

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.e

e. Distinguish between frequently 
confused words (e.g., to, too, two; 
there, their, they’re). Teacher’s Edition: Unit 1: T12, T48, T50, T126 Unit 4: T48 Unit 5: T60

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 

LA.4.W.1.f

f. Identify and revise fragment and run-
on sentences in speaking and writing. Teacher’s Edition: Unit 1: T258 Unit 5: T246, T258

TSW be able to create a 
grade level appropriate 
sentence and paragraph 

grammatically correct, 
sentences, paragraphs, 
variety

reinforce 
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LA.4.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Teacher’s Edition: Unit 1: T220-221, T222-223, T230-231, T232-233, T238-239, 
T240-241, T248-249, T250-251, T300-301 Unit 2: T232-233, T234-235, T242-
243, T244-245, T260-261, T262-263, T308-309, T310-311, T312-313 Unit 3: 
T232-233, T238-239, T242-243, T244-245, T256-257, T262-263, T310-311, 
T312-313 Unit 4: T230-231, T240-241, T242-243, T248-249, T258-259, T260-
261, T308-309, T310-311 Unit 5: T236-237, T238-239, T240-241, T244, T248-
249, T252-253, T254-255, T256-257, T264-265, T314-315 Unit 6: T232-233, 
T234-235, T236-237, T240, T244-245, T248-249, T250-251, T252-253, T260-
261, T310-311

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.a

a. Use prewriting activities and resources 
to plan, organize, and draft writing.

Teacher’s Edition: Unit 1: T220-221, T222-223, T230-231, T232-233, T238-239, 
T240-241, T248-249, T250-251 Unit 2: T232-233, T234-235, T242-243, T244-
245, T260-261, T262-263 Unit 3: T232-233, T238-239, T242-243, T244-245, 
T256-257, T262-263 Unit 4: T230-231, T240-241, T242-243, T248-249, T258-
259, T260-261 Unit 5: T236-237, T238-239, T240-241, T244, T252-253, T254-
255, T256-257 Unit 6: T232-233, T234-235, T236-237, T240, T248-249, T250-
251, T252-253

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: T27, T49, T55, T101, T147, T177, T218-257, T289, 
T293 Unit 2: T27, T55, T71, T107, T137, T189, T207, T230-269, T301 Unit 3: 
T27, T69, T105, T137, T189, T201, T230-269, T301 Unit 4: T27, T59, T96, 
T105, T135, T137, T143, T153, T187, T228-267 Unit 5: T75, T81, T147, T157, 
T200-207, T234-249, T258-265 Unit 6: T27, T59, T159, T207, T217, T230-246, 
T263-264

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

Teacher’s Edition: Unit 1: T210-211, T234-235, T252-253, T258-259, T260-261, 
T262-263, T264-265, T266-267, T268-269, T270-271, T272-273, T274-275, 
T276-277 Unit 2: T246-247, T264-265, T270-271, T272-273, T274-275, T276-
277, T278-279, T280-281, T282-283, T288-289 Unit 3: T246-247, T264-265, 
T270-271, T272-273, T274-275, T276-277, T278-279, T280-281, T282-283, 
T288-289 Unit 4: T244-245, T262-263, T268-269, T270-271, T272-273, T274-
275, T276-277 Unit 5: T242-243, T244-245,T246-247, T258-259, T260-261, 
T262-263, T272-273, T274-275, T276-277, T286-287, T288-289, T290-291 Unit 
6: T238-239, T240-241, T242-243, T254-255, T256-257, T258-259, T268-269, 
T270-271, T272-273, T274-275, T276-277, T278-279, T280-281, T286-287

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.d

d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

Teacher’s Edition: Unit 1: T268-269, T270-271, T272-273, T274-275, T276-277 
Unit 2: T265, T280-281, T282-283, T284-285, T286-287, T288-289 Unit 3: 
T265, T280-281, T282-283, T284-285, T286-287, T288-289 Unit 4: T262-263, 
T278-279, T280-281, T282-283, T284-285, T286-287 Unit 5: T263, T282-283, 
T284-285, T286-287, T288-289, T290-291 Unit 6: T259, T278-279, T280-281, 
T282-283, T284-285, T286-287

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.e

e. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
cursive, font, graphics, symbols).

Teacher’s Edition: Unit 1: T55, T147, T293 Unit 2: T55, T61, T71, T77, T207, 
T301 Unit 3: T69, T188, T201 Unit 4: T157 Unit 5: T75, T81, T307 Unit 6: T59, 
T159, T188-189, T303

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

LA.4.W.2.f

f. Use appropriate print and digital/ 
multimedia tools to produce, enhance, 
and/or publish writing individually or in 
collaboration with peers.

Teacher’s Edition: Unit 1: T55, T147, T293 Unit 2: T55, T61, T71, T77, T207, 
T301 Unit 3: T69, T188, T201 Unit 4: T157 Unit 5: T75, T81, T307 Unit 6: T59, 
T159, T188-189, T303

TSW be able to go through 
the writing process

recursive writing process 
(the writing process in 
any order)

reinforce 

Modes of Writing
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LA.4.W.3

Write creative and/or expressive pieces 
that describe a well-developed event 
or experience.

Teacher’s Edition: Unit 2: T137 Unit 4: T135 Unit 5: T234-249 Unit 6: T137, 
T230-246, T263-267

TSW be able to write a 
personal narrative 

creative, expressive, 
well-developed reinforce 

LA.4.W.3.a
a. Establish a situation and introduce a 
narrator and/or character(s). Teacher’s Edition: Unit 5: T234, T238, T268 Unit 6: T232; T234, T264

TSW be able to write a 
personal narrative 

creative, expressive, 
well-developed reinforce 

LA.4.W.3.b

b. Use precise words and phrases, 
descriptive/sensory details, and 
dialogue to develop characters, events, 
and settings.

Teacher's Edition Unit 2: T33, T113, T118, T196 Unit 3: T250, T266 Unit 5: 
T270 Unit 6: T254, T262

TSW be able to write a 
personal narrative 

creative, expressive, 
well-developed reinforce 

LA.4.W.3.c

c. Use transitional words and phrases to 
organize a sequence of events that 
unfolds naturally. Teacher’s Edition: Unit 5: T234, T238, T240, T266 Unit 6: T234

TSW be able to write a 
personal narrative 

creative, expressive, 
well-developed reinforce 

LA.4.W.3.d

d. Provide a conclusion related to the 
creative or expressive event or 
experience. Teacher’s Edition: Unit 5: T242 Unit 6: T234, T264, T265

TSW be able to write a 
personal narrative 

creative, expressive, 
well-developed reinforce 

LA.4.W.4

Write opinion pieces that explain a 
perspective with supporting reasons 
and/or evidence. Teacher’s Edition: Unit 1: T218-257 Unit 3: T230-269

TSW be able to write an 
opinion piece 

opinion, supporting 
reasons/evidence reinforce 

LA.4.W.4.a

a. Introduce a topic or text clearly, state 
an opinion, and develop a structure 
that includes reasons and/or evidence.

Teacher’s Edition: Unit 1: T218, T230, T323, T236, T248, T250, T252, T254, 
T256 Unit 3: T242, T266 Unit 6: T298

TSW be able to write an 
opinion piece 

opinion, supporting 
reasons/evidence reinforce 

LA.4.W.4.b
b. Use facts and details to support 
reasons and/or evidence.

Teacher’s Edition: Unit 1: T218, T230, T232, T236, T248, T250, T254, T256 
Unit 3: T242, T246, T264, T266

TSW be able to write an 
opinion piece 

opinion, supporting 
reasons/evidence reinforce 

LA.4.W.4.c
c. Use linking words and phrases to 
connect ideas. Teacher’s Edition: Unit 1: T252, T256 Unit 3: T244, T250, T264, T266

TSW be able to write an 
opinion piece 

opinion, supporting 
reasons/evidence reinforce 

LA.4.W.4.d
d. Provide a concluding statement or 
section related to the opinion. Teacher’s Edition: Unit 1: T256 Unit 3: T242, T260, T268

TSW be able to write an 
opinion piece 

opinion, supporting 
reasons/evidence reinforce 

LA.4.W.5

Write informative/ explanatory pieces to 
examine a topic or text and convey 
ideas and information.

Teacher’s Edition: Unit 1: T49, T189, T289 Unit 2: T230-269, T301 Unit 3: T137 
Unit 4: T228-267 Unit 5: T258-265

TSW be able to write an 
informational piece informative, explanatory reinforce 

LA.4.W.5.a

a. Introduce a topic clearly and group 
related information into paragraphs and 
sections including text features, 
illustrations, and/or multimedia 
elements.

Teacher’s Edition: Unit 2: T230, T248, T262, T266, T300 Unit 3: T312 Unit 4: 
T228, T240, T242, T258, T264 Unit 5: T254, T256, T264

TSW be able to write an 
informational piece informative, explanatory reinforce 

LA.4.W.5.b

b. Develop the topic with information 
(e.g., facts, definitions, details, 
quotations) related to the topic.

Teacher’s Edition: Unit 2: T242, T260, T262, T266, T268 Unit 4: T240, T242, 
T244, T258, T260, T262 Unit 5: T252, T256, T266, T270

TSW be able to write an 
informational piece informative, explanatory reinforce 

LA.4.W.5.c

c. Use linking words and phrases and 
key vocabulary to connect ideas and 
categories of information. Teacher’s Edition: Unit 4: T230, T244, T266 Unit 5: T256, T258

TSW be able to write an 
informational piece informative, explanatory reinforce 

LA.4.W.5.d

d. Provide a concluding statement or 
section related to the information or 
explanation(s). Teacher’s Edition: Unit 2: T248, T268 Unit 4: T240, T258, T264 Unit 5: T256

TSW be able to write an 
informational piece informative, explanatory reinforce 
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LA.4.W.6

Locate and summarize relevant 
evidence from literary and/or 
informational text sources to answer 
questions about a topic.

Teacher’s Edition: Unit 1: T16-17, T33, T36, T43, T54, T55, T106, T119, T181 
Unit 2: T16-17, T40, T89, T111, T121, T129 Unit 3: T36, T109, T115, T130, 
T131, T178-179 Unit 4: T30, T31, T47, T75, T112, T116, T127, T128, T129, 
T292-293 Unit 5: T37, T42, T135, T176, T177, T182-183, T197, T201 Unit 6: 
T31, T38, T45, T116, T122, T132-133

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

LA.4.W.6.a

a. Paraphrase information and 
evidence to support ideas while 
avoiding plagiarism.

Teacher’s Edition: Unit 1: T6, T92, T156 Unit 3: T6, T104-105 Unit 5: T9, T90, 
T172 Unit 6: T52, T90, T168, T293

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

LA.4.W.6.b
b. Identify print and digital tools to 
gather information and evidence.

Teacher’s Edition: Unit 2: T295 Unit 3: T188-189, T295 Unit 4: T186-187, T293 
Unit 5: T26-27 T270, T297 Unit 6: T65, T188-189, T293

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

LA.4.W.6.c

c. Sort evidence into categories using 
an appropriate note-taking format to 
collect and organize information. Teacher’s Edition: Unit 5: T270

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

LA.4.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and referencing sources in 
writing and speaking; provide a list of 
sources.

Teacher’s Edition: Unit 1: T26-27, T100-101, T176-177, T233, T256 Unit 2: 
T26-27, T106-107, T188-189 Unit 3: T26-27, T104-105, T188-189, T268 Unit 4: 
T26-27, T104-105, T186-187 Unit 5: T26-27, T110-111, T192-193 Unit 6: T26-
27, T110-111, T188-189, T293

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

LA.4.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives). Teacher’s Edition: Unit 1: 283

TSW be able to 
summarize a story or text

summarize, relevant 
evidence reinforce 

Comprehension and Collaboration
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LA.4.SL.1

Prepare for and participate in structured 
discussions and collaborations about 4th 
grade topics and texts.

Teacher’s Edition: Unit 1: T294 Unit 2: T304, T306 Unit 3: T304, T306, T307 
Unit 4: T302, T304, T305 Unit 5: T308 Unit 6: T166, T260, T302, T304, T305

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce

LA.4.SL.1.a

a. Ask relevant questions to build on 
ideas or acquire or confirm information.

Teacher’s Edition: Unit 1: T78, T154, T240, T296, T298, T300 Unit 2: T246, 
T312 Unit 3: T310, T312 Unit 4: T308, T310 Unit 5: T88, T260, T309, T310, 
T314 Unit 6: T4, T8, T59, T306, T310

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce

LA.4.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Teacher’s Edition: Unit 1: T4, T210, T234, T252, T297, T301 Unit 2: T6, T84, 
T204, T222, T309, T311, T313 Unit 3: T84, T204, T264, T311, T309, T310, 
T313 Unit 4: T186, T202, T220, T307, T309, T311 Unit 5: T70, T91, T202, 
T218, T310, T313, T315 Unit 6: T166, T198, T214, T306, T309, T311

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce

LA.4.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Unit 1: T4, T78, T154 Unit 2: T4, T84, T221 Unit 3: T4, T82, 
T166 Unit 4: T4, T82, T164 Unit 5: T4, T88, T170 Unit 6: T4, T88, T166

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce

LA.4.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, recalling, questioning).

Teacher’s Edition: Unit 1: T4, T210, T234, T252, T297, T301 Unit 2: T6, T84, 
T204, T222, T309, T311, T313 Unit 3: T84, T204, T264, T311, T309, T310, 
T313 Unit 4: T186, T202, T220, T307, T309, T311 Unit 5: T70, T91, T202, 
T218, T310, T313, T315 Unit 6: T166, T198, T214, T306, T309, T311

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/
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LA.4.SL.1.e

e. Complete a task following multi-step 
directions.

Teacher’s Edition: Unit 1: T25, T47, T99, T123, T175, T205, T229, T247 Unit 2: 
T25, T53, T105, T135, T187, T199, T217, T241, T259 Unit 3: T25, T51, T103, 
T135, T187, T199, T241, T259 Unit 4: T25, T51, T103, T133, T185, T239, 
T257, T281 Unit 5: T25, T57, T109, T139, T191, T213, T255 Unit 6: T25, T57, 
T109, T135, T159, T187, T235, T251

TSW be able to 
appropriately debate grade 
level texts 

collaboration, structured 
discussion/debate introduce

Presentation of Knowledge and Ideas

LA.4.SL.2

Report on a topic or text, tell a story, or 
recount an experience in an organized 
manner with appropriate facts, and 
relevant, descriptive details to support 
themes or central ideas

Teacher’s Edition: Unit 1: T49, T125, T189, T296, T298, T300 Unit 2: T55, 
T106, T137, T201, T308, T310, T312 Unit 3: T53, T104, T300, T308, T310, 
T312 Unit 4: T53, T306, T308, T310 Unit 5: T59, T141, T205, T248, T310, 
T312, T314; Unit 6: T244, T260, T306, T308, T310 Unit 6: T137, T188, T201

TSW be able to report on 
a topic or text using 
descriptive details collaboration, structured 

discussion/debate

introduce 

LA.4.SL.1.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations, including interpreting 4th 
grade texts.

Teacher’s Edition: Unit 1: T296, T298, T299, T300 Unit 2: T308, T310, T311, 
T312 Unit 3: T308, T310, T311, T312 Unit 4: T306, T308, T309, T310 Unit 5: 
T310, T312, T313, T314 Unit 6: T306, T308, T309, T310

TSW be able to report on 
a topic or text using 
descriptive details 

collaboration, structured 
discussion/debate

introduce 

LA.4.SL.1.b

b. Convey a perspective with clear 
reasoning and support.

Teacher’s Edition: Unit 1: T296, T298, T299, T300 Unit 2: T308, T310, T311, 
T312 Unit 3: T308, T310, T311, T312 Unit 4: T306, T308, T309, T310 Unit 5: 
T310, T312, T313, T314 Unit 6: T306, T308, T309, T310

TSW be able to report on 
a topic or text using 
descriptive details 

collaboration, structured 
discussion/debate

introduce 

LA.4.SL.1.c

c. Identify the purpose and credibility of 
information being presented.

Teacher’s Edition: Unit 1: T296, T298, T299, T300 Unit 2: T308, T310, T311, 
T312 Unit 3: T308, T310, T311, T312 Unit 4: T306, T308, T309, T310 Unit 5: 
T310, T312, T313, T314 Unit 6: T306, T308, T309, T310

TSW be able to report on 
a topic or text using 
descriptive details 

collaboration, structured 
discussion/debate

introduce 

LA.4.SL.1.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Teacher’s Edition: Unit 1: T296, T298, T299, T300 Unit 2: T308, T310, T311, 
T312 Unit 3: T308, T310, T311, T312 Unit 4: T306, T308, T309, T310 Unit 5: 
T310, T312, T313, T314 Unit 6: T306, T308, T309, T310

TSW be able to report on 
a topic or text using 
descriptive details collaboration, structured 

discussion/debate

introduce 

LA.4.SL.1.e

e. Use appropriate visual and/or digital 
tools to enhance verbal communication 
and add interest.

Teacher’s Edition: Unit 1: T296, T298, T300 Unit 2: T55, T300, T310, T312 Unit 
3: T26, T188, T310, T312 Unit 4: T308, T310 Unit 5: T248, T310, T312, T314 
Unit 6: T244, T260, T308, T310 Unit 5: T192, T205 Unit 6: T188, T204

TSW be able to report on 
a topic or text using 
descriptive details 

collaboration, structured 
discussion/debate

introduce 



4 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1
Week 1 and 2
Text set 1

TSW use diagrams and headings to read and understand 
expository text
TSW identify compare and contrast text structure.
TSW identify author's perxpective to understand personal 
narratives

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW make predictions to understand realistic fiction
TSW identify an author's claim to help us understand 
expository text
TSW identify plot in realistic fiction
TSW read and understand realistic fiction by identifying 
how conflict contributes to plot

Week 5
text set 3

TSW use graphs and headings to read and understand 
argumentative text
TSW can read and understand text by identifying the 
central idea and relevant details
TSW identify sequence text structure to help us read and 
understand procedural text

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2
Week 1 and 2
Text set 1

TSW summarize to understand expository text
TSW use photographs,captions,and headings to read and 
understand expository text
TSW read and understand expository text by identifying 
the central idea and relevant details
TSW identify charachter development to help us read and 
understand trickster tales

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW ask and answer questions to understand a drama
TSW read and understand drama by identifying the theme.
TSW can identify hyperboles to help read and understand 
tall tales
TSW identify how dialogue, setting, stage directions. and 
other elements of a play contribute to the plot

Week 5
text set 3

TSW use rhyme and structure to understand poetry
TSW use text structures to read and understand poetry
TSW read and understand poetry by identifying character 
perspective
TSW identify imagery and assonance to help us 
understand poetry.

https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing


4 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3
Week 1 and 2
Text set 1

TSW visualize what we read to help us understand 
realistic fiction
TSW use flashback to understand plot in realistic fiction
TSW identify the narrator's point of view and character 
perspective in a text
TSW identify a problem-and-solution text structure to read 
and understand expository text

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW reread to understand a biography
TSW use a timeline to understand a biography
TSW read and understan a biography by identifying the 
author's perspective
TSW identify author's purpose to help us read and 
understand and autobiography.

Week 5
text set 3

TSW reread to understand argumentative text.
TSW can identify sequence text structure to help us read 
and understand procedural text
TSW use maps and headings to read and understand 
argumentative text
TSW can read and understand argumentative text by 
identifying the author's claim

Unit/GENRE/THEME Pacing Learning Goals Learning Goals Assessment

Unit 4
Week 1 and 2
Text set 1

TSW ask and answer questions to understand narrative 
nonfiction
TSW identify homophones and homographs to help us 
read and understand narrative nonfiction
TSW use headings and pronunciations to read and 
understand narrative nonfiction
TSW read and understand narrative nonfiction by 
identifying the cause-and-effect text structure

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW will make predictions to understand historical fiction
TSW use setting to read and understand historical fiction
TSW read and understand historical fiction by identifying 
the narrator's point of view and character's perspective
TSW can use description to help us read and understand 
expository text

Week 5
text set 3

TSW determine a poem's structure to understand narrative 
poetry
TSW use literary elements to read and understand 
narrative poetry.
TSW can read and understand narrative poetry by 
identifying the theme.
TSW can identify rhyme and structure to help us read and 
understand poetry

Unit/GENRE/THEME Pacing Learning Goals Learning Goals Assessment

https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing


4 Reading

Unit 5
Week 1 and 2
Text set 1

TSW summarize to understand expository text
TSW use photographs and captions to read and 
understand expository text
TSW read and understand expository text by identifying 
the chronological text structure
TSW use imagery to help us read and understand fantasy

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW can visualize to better understand realistic fiction
TSW use foreshadowing to read and understand realistic 
fiction
TSW read and understand realistic fiction by identifying 
the conflict in the plot
TSW analyze character development to help us read and 
understand realistic fiction

Week 5
text set 3

TSW summarize to understand expository text
TSW identify author's perspective to help us read and 
understand an informative article
TSW use sidebars and maps to read and understand 
expository text
TSW read and understand expository text by identifying 
teh chronological text structure

Unit/GENRE/THEME Pacing Learning Goals Learning Goals Assessment

Unit 6
Week 1 and 2
Text set 1

TSW ask and answer questions to understand narrative 
nonfiction
TSW use sidebars to read and understand narrative 
nonfiction
TSW read and understand narrative nonfiction by 
identifying the central idea and relevant details
TSW identify the conflict in a plot to help us read and 
understand myth

https://drive.google.com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing

https://drive.google.
com/file/d/19Xxq9MR-
CGMGSkxQDK3KItKFy5whz_a
z/view?usp=sharing

Week 3 and 4
Test set 2

TSW reread to understand historical fiction
TSW use setting to read and understand historical fiction
TSW read and understand historical fiction by identifying 
theme
TSW use maps to help us read and understand expository 
text

Week 5
text set 3

TSW use imagery and personification to understand free 
verse poetry
TSW use characteristics of free verse to read and 
understand poetry
TSW read and understand free verse poetry by identifying 
the theme
TSW identify character perspective to help us read and 
understand poetry

https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing
https://drive.google.com/file/d/19Xxq9MR-CGMGSkxQDK3KItKFy5whz_az/view?usp=sharing


4 Writing

The fourh grade writing curriculm can be found at the following link:
https://drive.google.com/drive/folders/0B4xqohHXQGpSanhrSFRvY1N6alk?resourcekey=0-og1IyboarGr22o0xbs6V6Q&usp=drive_link

https://drive.google.com/drive/folders/0B4xqohHXQGpSanhrSFRvY1N6alk?resourcekey=0-og1IyboarGr22o0xbs6V6Q&usp=drive_link
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Master

Concepts of Print

Phonics and Word Analysis

LA.5.F.3
Know and apply phonics and word 
analysis skills in decoding and encoding 
(spelling) words.

Teacher’s Edition: Unit 1: 280, 281, 282, 283, 284, 285, 286, 287, 288, 289 Unit 2: 
280, 281, 282, 283, 284, 285, 286, 287, 288, 289 Unit 3: 274, 275, 276, 277, 278, 
279, 280, 281, 282, 283 Unit 4: 276, 277, 278, 279, 280, 281, 282, 283, 284, 285 
Unit 5: 276, 277, 278, 279, 280, 281, 282, 283, 284, 285 Unit 6: 278, 279, 280, 
281, 282, 283, 284, 285, 286, 287

Decode and encode 
spelling words. 

phonics, decoding, 
encoding Master

LA.5.F.3.a a. Decode words with common Greek 
derived words.

Teacher’s Edition: Unit 1: 173, 174, 175, 203, 207, 211, 218, 223, 224 Unit 3: 137, 
141, 147, 148, 152, 154 Unit 5: 10, 11, 12, 29, 57, 65, 72, 204 Unit 6: 24, 25, 62, 
63

Decode and encode 
spelling words. 

phonics, decoding, 
encoding Master

LA.5.F.3.b

b. Use combined knowledge of letter-
sound correspondences, syllabication 
patterns, and morphology (e.g., roots 
and affixes) to decode unfamiliar 
multisyllabic words in and out of 
context.

Teacher’s Edition: Unit 1: T24, T54, T64, T65, T106, T134, T145, T186, T208, 
T209 Unit 2: T24, T54, T58, T64, T65, T106, T134, T138, T144, T145, T186, 
T208, T209, T280 Unit 3: T48, T58, T59, T100, T128, T139, T180, T202, T203 
Unit 4: T6, T24, T64, T65, T106, T140, T141, T182, T204 Unit 5: T24, T29, T38, 
T52, T62, T104, T132, T142, T143, T166, T184, T206, T207, T282, T284 Unit 6: 
T24, T52, T62, T63, T104, T134, T144, T145, T186, T208, T209, T278

Decode and encode 
spelling words. 

phonics, decoding, 
encoding Master

Fluency

LA.5.F.4

Develop accuracy, phrasing, and 
expression/prosody while reading a 
variety of grade-level texts to support 
comprehension.

Teacher’s Edition: Unit 1: T106-107, T134, T148, T150-151, T156-157, T186-
187, T212 Unit 2: T14, T25, T54-55, T106-107, T134-135, T140-141, T151, 
T156-157, T186-187, T204, T214 Unit 3: T8, T100, T128, T142, T164, T181, 
T206 Unit 4: T54-55, T90, T107, T144, T182-183, T208 Unit 5: T25, T53, T105, 
T133, T146, T185, T199 Unit 6: T25, T53, T88, T105, T135, T187

Read grade level text with 
accuracy/prosody to 
support comprehension

accuracy, expression, 
comprehension master 

LA.5.F.4.a

a. Read a variety of texts accurately 
using appropriate rate, 
expression/prosody, and intonation to 
reflect meaning.

Teacher’s Edition: Unit 1: T106-107, T134, T148, T150-151, T156-157, T186-
187, T212 Unit 2: T14, T16, T25, T54, T60, T70, T76, T96, T106, T134, T140, 
T151, T156, T176, T186, T204, T214 Unit 3: T8, T100, T128, T142, T164, T181, 
T206 Unit 4: T54, T90, T107, T144, T182, T208 Unit 5: T25, T53, T105, T133, 
T146, T185, T199 Unit 6: T25, T53, T88, T105, T135, T187

Read grade level text with 
accuracy/prosody to 
support comprehension

accuracy, expression, 
comprehension master 

LA.5.F.4.b
b. Adjust pace and prosody based on 
the purpose, complexity, form, and/or 
style of a text.

Teacher’s Edition: Unit 1: T106-107, T134, T148, T150-151, T156-157, T186-
187, T212 Unit 2: T14, T16, T25, T54, T60, T70, T76, T96, T106-107, T134, 
T140, T151, T156-157, T176, T186, T204, T214 Unit 3: T8, T100, T128, T142, 
T164, T181, T206 Unit 4: T54, T90, T107, T144, T182, T208 Unit 5: T25, T53, 
T105, T133, T146, T185, T199 Unit 6: T25, T53, T88, T105, T135, T187

Read grade level text with 
accuracy/prosody to 
support comprehension

accuracy, expression, 
comprehension master 
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LA.5.RP.1
Explain the theme in a literary text and 
how it is conveyed through key details.

Teacher’s Edition: Unit 1: T90, T102, T104, T113, T116, T120, T122, T123, 
T126, T142, T152, T158 Unit 2: T90, T100, T102, T112, T114, T116, T118, T122, 
T140, T142, T148, T149, T150, T152, T155, T156, T158, T161, T170, T180, 
T191, T194, T206, T212, T213, T214, T216, T219, T220, T222, T225 Unit 3: T8, 
T18, T22, T30, T32, T34, T35, T36, T37, T39, T38, T42, T50, T56, T62, T63, 
T64, T66, T69, T70, T72, T75 Unit 4: T104, T124, T164, T166, T176, T200, 
T202, T208, T209, T210, T212, T215, T216, T218, T221 Unit 5: T48, T88, T111, 
T114, T115, T121 Unit 6: T8, T18, T30, T34, T36, T37, T38, T39, T44, T58, T60 ,
T67, T68, T70, T73, T79, T129, T130, T170, T191, T194, T196, T197, T206, 
T216, T222

Explain the theme of a text 
using key details.

explain, theme, key 
details reinforce

LA.5.RP.2
Compare and contrast two or more 
characters, settings, or events in a 
literary text or texts.

Teacher's Edition Unit 1: T90, T98, T102, T104, T142, T148, T152, T155, T158 
Unit 2: T90, T118, T142, T152, T158 Unit 3: T16, T42, T56, T66, T72 Unit 4: 
T102, T132, T138, T148, T154 Unit 5: T88, T98, T102, T112, T116, T120, T124, 
T138, T140, T147, T153, T159 Unit 6: T20, T129, T130, T230, T234, T236, T246, 
T252

Compare and contrast 
characters, settings, and 
events in a text. 

compare/contrast.        
character, setting, 
events

master

Author's Craft

LA.5.RP.3
Describe how a narrator or speaker’s 
point of view influences the meaning of 
a literary text.

Teacher’s Edition: Unit 1: T104 Unit 2: T100, T104, T126 Unit 3: T37, T54, T56, 
T64, T70 Unit 4: T100, T104, T122, T125, T126, T136, T145, T146, T151, T152, 
T157, T174, T202, T212, T218 Unit 5: T98, T100, T109, T111, T114, T115, T121 
Unit 6: T18, T20, T31, T35, T37, T39, T41, T132, T180, T191, T192, T204, T212, 
T213, T214, T219, T220, T225

Understand how the 
narrator's point of view 
affects the meaning of the 
text.

POV     narrator reinforce

LA.5.RP.4
Explain how a sequence of chapters, 
scenes, or stanzas fit together to provide 
the overall structure of literary texts.

Teacher’s Edition: Unit 2: T168, T176, T178, T191, T196, T198, T206, T216, 
T222 Unit 4: T90, T98, T115, T116, T136, T138, T144, T146, T148, T152, T154, 
T172, T178, T187, T188 Unit 6: T32, T171, T178, T182, T184, T192, T194, T206, 
T207, T212, T216, T217, T218, T219, T223, T224, T250, T262, T266, T267

Explain how text is 
organized by sequence of 
chapters, scenes, and 
stanzas.

explain   sequence 
structure introduce

Knowledge and Ideas

LA.5.RP.5
Compare and contrast the treatment of 
themes and topics in literary texts of the 
same genre.

Teacher’s Edition: Unit 1: T88, T128, T136, T142, T152, T158, T161 Unit 2: T88, 
T143, T152, T158, T184, T194, T200 Unit 3: T6, T56, T66, T73 Unit 4: T88, 
T124, T132, T136, T139, T146, T149, T152, T155, T157, T180 Unit 5: T86, T141, 
T151, T157 Unit 6: T178, T200

Compare and contrast 
different texts of the same 
genre.

compare/contrast     
genre.     theme.   topics reinforce

LA.5.RP.6

Analyze a literary text to answer and 
develop inferential questions to 
enhance the comprehension of self and 
others, quoting or paraphrasing specific 
evidence from the text.

Teacher’s Edition: Unit 1: 9, 10, 11, 14, 15, 30, 31, 34, 36, 41, 47, 49, 114, 127, 
185 Unit 2: 36, 41, 117 Unit 3: 85, 86, 90, 91, 107, 109 Unit 4: 35, 36, 40, 116 
Unit 5: 9, 10, 11, 14, 15, 30, 33, 34, 36, 40, 48, 73, 169, 170, 171, 174, 175 Unit 6: 
33, 40, 89, 91, 94, 95, 111, 115, 120

Analyze text to 
answer/develop questions 
using text evidence to 
better comprehend. 

text evidence. questions 
comprehension reinforce

LA.5.RP.7
Explain the relationships between two or 
more characters, events, or ideas in a 
range of literary texts.

Teacher’s Edition: Unit 1: 45, 48, 49, 51, 63, 73, 79, 125, 128, 131, 143, 153, 159, 
193, 196, 197, 207 Unit 2: 48, 51, 63, 73, 79, 125, 128, 131, 143, 153, 159, 193, 
196, 197, 207 Unit 3: 41, 44, 45, 57, 67, 72, 73, 119, 122, 125, 137, 147, 153, 187, 
190, 191, 201, 211 Unit 4: 45, 48, 51, 63, 73, 79, 121, 124, 127, 139, 149, 155, 
189, 192 Unit 5: 45, 48, 49, 123, 126, 129, 141, 151, 191, 194, 195, 205 Unit 6: 45, 
46, 48, 51, 63, 73, 79, 125, 128, 131, 143, 153, 159, 193, 196, 197, 207

 Explain relationships 
between characters, 
events, or ideas in various 
texts.

relationships characters, 
events, ideas master

Range of Reading and Level of 
Text Complexity
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LA.5.RP.8

Read and comprehend a wide range 
of literary texts of appropriate 
complexity for Grade 5 independently 
and proficiently.

Teacher’s Edition: Unit 1: T90, T110, T128, T149, T152, T155, T161, T296, 
T298, T300 Unit 2: T90, T98, T110, T128, T142, T149, T155, T161, T170, T178, 
T190, T196, T213, T219, T225, T296, T306, T315, T317 Unit 3: T8, T16, T28, 
T42, T63, T66, T69, T72, T75, T290, T300, T311 Unit 4: T90, T110, T124, T166, 
T186, T194, T196, T209, T215, T221, T292, T312, T313 Unit 5: T73, T88, T108, 
T140, T147, T153, T292, T310, T311, T313 Unit 6: T16, T176, T178, T294, T300, 
T315

Read and comprehend 
grade-level texts 
independently.

grade level text   
idependent.  proficiently master
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Central Ideas and Details

LA.5.RI.1
Explain the central idea in an 
informational text and how it is 
conveyed through key details.

Teacher’s Edition: Unit 1: 6, 14, 21, 29, 31, 36, 45, 46, 49, 52, 62, 72, 78, 88, 91, 
96, 97, 98, 100, 102, 104, 111, , 125, 126, 132, 168, 170, 180, 181, 192, 194, 204, 
205, 206, 213, 214, 215, 216, 219, 225, 295, 315 Unit 2: 14, 21, 22, 35, 45, 81, 96, 
98, 100, 113, 115, 117, 125, 130, 142, 148, 151, 152, 161, 172, 180, 181, 212, 214, 
219, 225, 295 Unit 3: 85, 86, 94, 95, 105, 106, 108, 112, 115, 116, 118, 119, 120, 
134, 136, 142, 143, 144, 146, 147, 149, 150, 152, 153, 155, 162, 165, 170, 174, 
178, 185, 186, 188, 206, 207, 213, 219, 288, 289, 293, 296, 297 Unit 4: 9, 11, 14, 
17, 18, 19, 22, 23, 29, 30, 32, 36, 38, 42, 45, 52, 71, 73, 78, 79, 81, 92, 93, 96, 100, 
101, 102, 103, 104, 112, 113, 114, 118, 147, 153, 157, 167, 176, 177, 179, 180, 
194, 209, 215, 221, 230, 290 Unit 5: 9, 10, 14, 18, 19, 30, 31, 35, 37, 38, 40, 45, 
69, 73, 79, 91, 119, 123, 127, 146, 169, 174, 210, 217, 223, 298, 311 Unit 6: 9, 10, 
11, 14, 18, 19, 21, 22, 31, 34, 39, 43, 50, 67, 73, 79, 89, 91, 94, 96, 101, 102, 125, 
143, 149, 180, 184, 191, 193, 194, 212, 213, 219, 221, 225, 292, 296

Explain the central idea in 
a text and how key details 
support it.

central idea.  key details.  
informational text reinforce

LA.5.RI.2

Compare and contrast two or more 
individuals, events, scientific ideas or 
concepts, or steps in a process, drawing 
on supporting details from an 
informational text or texts.

Teacher’s Edition: Unit 1: T49, T170 Unit 2: T14, T130, T132, T232, T234, T236, 
T298, T302, T304 Unit 3: T84, T94, T98, T106, T111, T115, T116, T120, T126, 
T134, T142, T143, T144, T149, T155, T164, T170, T176, T230, T292, T296, 
T309, T310, T311 Unit 4: T8, T14, T22, T30, T34, T39, T46, T52, T60, T62, T68, 
T70, T72, T76, T78, T226, T228, T230, T232, T248, T250, T254, T262, T298 
Unit 5: T8, T18, T22, T30, T31, T32, T35, T42, T46, T67, T73, T79, T127, T168, 
T174, T195, T228, T234, T296, T298, T300 Unit 6: T47, T88, T129, T132, T292, 
T296

Compare and contrast 
elements of an 
informational text and find 
supporting details.

compare/contrast, 
informational text introduce 

Author's Craft

LA.5.RI.3

Determine the author’s purpose(s) and 
describe how the author's perspective 
(e.g., beliefs, assumptions, biases) 
influences the meaning of an 
informational text.

Teacher’s Edition: Unit 1: 33, 39, 44, 52, 53, 113, 121, 124, 196, 198, 199, 298 
Unit 2: 31, 33, 39, 44, 50, 117, 298, 303 Unit 3: 31, 40, 46, 47, 109, 117, 118, 123, 
124, 293 Unit 4: 49, 111, 119, 120, 126, 193, 295 Unit 5: 31, 119, 122, 128, 189, 
295 Unit 6: 31, 35, 111, 130, 296

Determine the AP and how 
the author's perspective 
affects the meaning of the 
text.

AP   author's perspective introduce 

LA.5.RI.4

Explain how text features (titles, 
headings, table of contents, glossaries, 
captions, graphs, maps, and/or other 
visuals) contribute to the meaning of 
texts.

Teacher’s Edition: Unit 1: 50, 63, 73, 178, 179, 196, 197 Unit 2: 10, 16, 17, 27, 52, 
53 Unit 3: 103, 107, 162, 167, 190, 201, 306 Unit 4: 16, 17, 49, 50 Unit 5: 37, 39, 
43, 61, 171, 176, 177, 194, 205 Unit 6: 48, 50, 89, 96, 106, 143, 153

Explain how text features 
help us understand the 
meaning of a text.

text features Master

Knowledge and Ideas

LA.5.RI.5
Integrate information from multiple texts 
on the same topic in order to 
demonstrate knowledge of the topic.

Teacher’s Edition: Unit 1: T14, T56, T69, T76, T136, T200, T214, T240, T244, 
T254, T290, T294, T298, T300, T302, T304 Unit 2: T39, T44, T46, T52, T56, 
T62, T72, T79, T136, T160, T240, T294, T300, T304 Unit 3: T45, T92, T98, 
T136, T152, T167, T176, T177, T194, T200, T210, T216, T234, T288, T292, 
T294, T296 Unit 4: T16, T51, T62, T72, T78, T236, T290, T296, T298, T300 Unit 
5: T20, T32, T37, T54, T61, T71, T77, T134, T155, T180, T181, T198, T205, 
T215, T219, T221, T290, T291, T310, T312 Unit 6: T26, T100, T106, T292

Read multiple texts on the 
same topic to increase 
understanding on the 
topic.

multiple texts introduce
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LA.5.RI.6
Analyze the development of an author’
s claim(s) and how supporting evidence 
is used to support the claim(s).

Teacher’s Edition: Unit 1: T132, T168, T170, T176, T178, T180, T182, T184, 
T192, T194, T206, T212, T213, T216, T219, T222, T225, T230, T234, T236, 
T252, T254, T258, T298, T302 Unit 2: T43, T52, T132, T230, T240, T254, T258, 
T294, T302 Unit 3: T105, T107, T109, T113, T120, T164, T172, T174, T178, 
T186, T188, T190, T200, T206, T207, T208, T210, T213, T214, T216, T219, 
T224, T226, T228, T230, T234, T244, T246, T248, T252, T263, T294 Unit 4: T18, 
T20, T31, T49, T50, T56, T68, T69, T75, T81, T127, T230, T294, T296, T300 
Unit 5: T33, T37, T39, T43, T46, T111, T114, T115, T168, T178, T180, T182, 
T192, T189, T190, T202, T204, T210, T211, T212, T217, T218, T221, T223, 
T296, T302 Unit 6: T47, T48, T100

Analyze the author's 
opinion is and how the 
author supports.

development of author's 
claim introduce

LA.5.RI.7

Explain the relationships between two or 
more individuals, events, ideas, or 
concepts in a range of informational 
texts.

Teacher’s Edition: Unit 1: T8, T18, T20, T22, T32, T35, T38, T46, T48, T50, T60, 
T62, T68, T69, T70, T72, T75, T76, T77, T78, T81, T299, T314, T315, T316 Unit 
2: T6, T9, T16, T18, T20, T21, T22, T32, T37, T42, T46, T60, T61, T67, T68, 
T69, T70, T72, T73, T75, T76, T78, T81, T314, T315, T316 Unit 3: T308, T309, 
T310 Unit 4: T310, T311, T312 Unit 5: T18, T20, T21, T22, T31, T38, T39, T46, 
T58, T60, T66, T67, T68, T73, T74, T79, T180, T181, T198, T202, T205, T213, 
T215, T221, T295, T297, T310, T311, T312 Unit 6: T50, T98, T140, T142, T148, 
T149,T150, T152, T155, T156, T158, T161

Explain relationship 
between two or more 
people, events, or ideas 
using multiple 
informational texts.

relationships of people,
events,ideas reinforce

Range of Reading and Level of 
Text Complexity

LA.5.RI.8

Read and comprehend a wide range 
of informational text of appropriate 
complexity for Grade 5 independently 
and proficiently.

Teacher’s Edition: Unit 1: T8, T22, T28, T46, T48, T69, T75, T81, T170, T184, 
T190, T196, T294, T314, T315, T316, T317 Unit 2: T8, T22, T28, T48, T69, T75, 
T81, T128, T236, T294, T302, T306, T314, T315, T316, T317 Unit 3: T84, T92, 
T98, T104, T122, T230, T254, T288, T289, T300, T308, T309, T310, T311 Unit 4: 
T8, T16, T22, T28, T48, T69, T75, T81, T232, T290, T291, T310, T311, T312, 
T313 Unit 5: T8, T22, T28, T168, T182, T188, T194, T294, T310, T311, T312, 
T313 Unit 6: T46, T88, T96, T108, T292, T296, T300, T312, T313, T314, T315

Read and understand a 
range of IT at the 5th 
grade level independenlty.

comprehend 
informational grade level 
texts

master
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Acquisition and Use

LA.5.V.1 Acquire and use grade-level academic 
vocabulary appropriately.

Teacher’s Edition: Unit 1: 57, 59, 63, 94, 95, 138, 139, 174, 175, 203, 207, 250, 
251, 269 Unit 2: 59, 94, 95, 137, 138, 139, 159, 174, 175, 203, 207 Unit 3: 27, 51, 
53, 73, 88, 89, 133, 153, 168, 169, 183, 195, 196, 226 Unit 4: 58, 59, 79, 94, 95, 
134, 135, 155, 170, 171, 197, 198, 199, 297 Unit 5: 56, 57, 92, 93, 134, 136, 137, 
157, 172, 173, 199, 200, 201 Unit 6: 55, 56, 57, 61, 91, 92, 93, 138, 139, 159, 174, 
175, 202, 203, 223

Learn and use grade-level 
academic vocabulary.

aquire and use GL 
vocabulary introduce

LA.5.V.1.a

a. Use context clues (e.g., cause/effect 
relationships and comparisons in text) to 
determine the meanings of words and 
phrases.

Teacher’s Edition: Unit 1: T88, T94, T117, T130, T138, T142, T147, T152, T154, 
T158, T160, T298, T302 Unit 2: T6, T8, T12, T58, T60, T62, T67, T70, T72, T74, 
T76, T78, T80, T170, T298 Unit 3: T12, T52, T56, T61, T66, T72, T74, T124, 
T132, T185, T196, T200, T205, T210, T216, T218, T309, T310, T311 Unit 4: T12, 
T58, T67, T74, T80, T94, T113, T128, T134, T140, T143, T150, T156, T164, 
T166, T170, T198, T207, T310, T311 Unit 5: T32, T52, T56, T63, T88, T92, 
T136, T138, T140, T145, T152, T154, T158, T170, T200, T279, T310, T311, 
T312 Unit 6: T48, T86, T92, T138, T142, T147

Use context clues to 
determine meanings of 
unknown words or 
phrases. 

context clues  meanings 
of words reinforce

LA.5.V.1.b
b. Use commonly occurring Greek and 
Latin affixes and roots to determine the 
meanings of words.

Teacher’s Edition: Unit 1: T58, T138, T168, T191, T202, T206, T216, T222, T294 
Unit 2: T138 Unit 3: T82, T88, T113, T132, T136, T146, T152, T196 Unit 5: T6, 
T12, T56, T60, T70, T76, T172, T200, T204, T214, T220, T276, T280, T310, 
T311, T312 Unit 6: T56, T278, T280

Use Greek and Latin 
affixes and roots to 
determine meanings of 
words 

G&L Roots    meaning
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LA.5.V.1.c

c. Determine or clarify the precise 
meanings or pronunciations of words 
and phrases using reference materials 
and classroom resources.

Teacher’s Edition: Unit 2: T58 Unit 5: T92, T130, T172, T196, T277, T279, T281 
Unit 6: T24, T198

Determine 
meanings/pronunciations 
of words/phrases using 
classroom 
resources/materials.

meanings/pronunciation    
resources/materials reinforce

Context and Connotations

LA.5.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Teacher’s Edition: Unit 1: T10, T168, T169, T170, T172 Unit 2: T94, T111, T115, 
T119, T123, T128, T129, T138, T147, T154, T160 Unit 3: T96, T126, T192 Unit 
4: T29, T31, T35, T39, T46, T94, T128, T166, T170, T188, T198, T202, T207, 
T212, T214, T218, T220 Unit 5: T29, T30, T31, T32, T34, T36, T38, T43, T44, 
T50, T100, T117, T178 Unit 6: T56, T126, T174, T182, T184, T194, T198, T202, 
T206, T222

Understand author's use of 
figurative, connotative, and 
technical language in 
grade-level texts (literary 
and informational). 

figurative, connotative, 
technical language reinforce

LA.5.V.2.a
a. Interpret figurative language, 
including similes and metaphors, in 
context.

Teacher’s Edition: Unit 2: T94, T111, T115, T119, T123, T129, T138, T147, 
T154, T160 Unit 3: T96, T126, T192 Unit 4: T29, T31, T35, T39, T46, T94, T128, 
T166, T170, T188, T198, T202, T207, T212, T214, T218, T220 Unit 5: T50, T100, 
T117 Unit 6: T174, T182, T184, T194, T198, T206, T222

Understand author's use of 
figurative, connotative, and 
technical language in 
grade-level texts (literary 
and informational). 

figurative, connotative, 
technical language reinforce

LA.5.V.2.b
b. Recognize and explain the meaning 
of commonly occurring idioms, adages, 
and proverbs.

Teacher’s Edition: Unit 1: T33, T34, T39, T44, T117, T173 Unit 2: T35, T49, 
T113, T121, T131, T137, T192 Unit 3: T9, T11, T36, T39, T52, T74, T85, T113, 
T118, T123, T125, T167 Unit 4: T88, T90, T94, T113, T134, T143, T148, T150, 
T154, T156 Unit 5: T86, T92, T109, T112, T114, T128, T136, T145, T152, T158, 
T196 Unit 6: T9, T11, T33, T123, T171, T295

Understand author's use of 
figurative, connotative, and 
technical language in 
grade-level texts (literary 
and informational). 

figurative, connotative, 
technical language reinforce

LA.5.V.2.c

c. Demonstrate knowledge of 
relationships between particular words 
(e.g., synonyms, antonyms, 
homographs) to better understand 
each of the words.

Teacher’s Edition: Unit 1: T6, T8, T12, T36, T58, T62, T67, T72, T74, T78, T202 
Unit 2: T67, T147, T168, T174, T192, T206, T211, T216, T218, T222, T224 Unit 
3: T52, T148 Unit 4: T58, T134 Unit 5: T52, T57, T72, T136, T137, T201 Unit 6: 
T34, T72, T78, T90, T138, T202, T211

Understand author's use of 
figurative, connotative, and 
technical language in 
grade-level texts (literary 
and informational). 

figurative, connotative, 
technical language reinforce

Production of Writing

LA.5.W.1
Create grammatically correct multi-
paragraph compositions with varied 
sentence structures.

Teacher’s Edition: Unit 1: 63, 73, 79, 207, 238, 239, 251, 256, 257, 266 Unit 2: 
143, 238, 239, 251, 256, 257, 266 Unit 3: 51, 57, 137, 195, 224, 226, 228, 232, 
242, 246, 250 Unit 4: 15, 139, 197, 234-265 Unit 5: 55, 61, 199, 236-263 Unit 6: 
15, 61, 91, 137, 143, 230-265

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 

LA.5.W.1.a

a. Apply knowledge of rules for 
capitalization; use underlining, 
quotation marks, or italics to indicate 
titles of works.

Teacher’s Edition: Unit 1: 42, 102, 245, 263 Unit 2: 270, 271, 279 Unit 3: 271 Unit 
4: 269, 271, 275 Unit 5: 241, 257, 270, 271 Unit 6: 239, 243, 269

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 

LA.5.W.1.b

b. Use a comma to separate an 
introductory element from the rest of a 
sentence, to separate clauses, to set off 
a question, and to indicate direct 
address. Teacher’s Edition: Unit 1: 273, 275 Unit 5: 269 Unit 6: 275, 313

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 

LA.5.W.1.c

c. Explain the function of and use 
frequently occurring interjections, verb 
tenses (e.g., perfect), and correlative 
conjunctions.

Teacher’s Edition: Unit 1: 271 Unit 2: 245 Unit 3: 266, 267, 268, 269, 272, 273 
Unit 4: 270, 271 Unit 6: 274-275

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 
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LA.5.W.1.d
d. Distinguish between and use types of 
adjectives (e.g., comparative, 
superlative). Teacher’s Edition: Unit 5: 272, 273, 274, 275 Unit 6: 269

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 

LA.5.W.1.e
e. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tenses. Teacher’s Edition: Unit 1: 274, 278-279 Unit 3: 271

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

grammatically correct, 
mult-paragraph, varied 
sentence structure 

Reinforce 

LA.5.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Teacher’s Edition: Unit 1: 232, 233, 242, 243, 244, 245, 248, 249, 250, 251, 260, 
261, 262, 263 Unit 2: 230, 231, 232, 233, 242, 243, 244, 245, 248, 249, 250, 251, 
260, 261, 262, 263 Unit 3: 224, 225, 226, 227, 228, 229, 230, 231, 232, 233, 236, 
237, 238, 239, 254, 255, 256, 257 Unit 4: 226, 227, 228, 229, 230, 231, 232, 233, 
234, 235, 236, 237, 238, 239, 240, 241, 244, 245, 256, 257, 258, 259 Unit 5: 230, 
231, 232, 233, 234, 235, 244, 246, 247, 248, 249, 250, 251, 263 Unit 6: 232, 233, 
234, 235, 236, 237, 248, 249, 250, 251, 252, 253

Students will apply the 
writing process

recursive writing 
process, audience, 
purpose, discipline

Reinforce

LA.5.W.2.a
a. Use prewriting activities and resources 
to plan, organize, and draft writing.

Teacher’s Edition: Unit 1: 232, 233, 242, 243, 244, 245, 248, 249, 250, 251, 260, 
261, 262, 263 Unit 2: 230, 231, 232, 233, 242, 243, 244, 245, 248, 249, 250, 251, 
260, 261, 262, 263 Unit 3: 224, 225, 226, 227, 228, 229, 230, 231, 232, 233, 236, 
237, 238, 239, 254, 255, 256, 257 Unit 4: 226, 227, 228, 229, 230, 231, 232, 233, 
234, 235, 236, 237, 238, 239, 240, 241, 244, 245, 256, 257, 258, 259 Unit 5: 230, 
231, 232, 233, 234, 235, 244, 246, 247, 248, 249, 250, 251, 263 Unit 6: 232, 233, 
234, 235, 236, 237, 248, 249, 250, 251, 252, 253

Students will use 
prewriting activities plan, organize, draft reinforce

LA.5.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Teacher’s Edition: Unit 1: 63, 73, 79, 207, 238, 239, 251, 256, 257, 266 Unit 2: 
143, 238, 239, 251, 256, 257, 266 Unit 3: 51, 57, 137, 195, 224, 226, 228, 232, 
242, 246, 250 Unit 4: 15, 139, 197, 234-265 Unit 5: 55, 61, 199, 236-263 Unit 6: 
15, 61, 91, 137, 143, 230-265

Students will write stories 
of various lengths and 
complexity.

sustain, engagement, 
length, complexity reinforce

LA.5.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

Teacher’s Edition: Unit 1: 246, 247, 248, 260, 262, 264, 265, 268 Unit 2: 246, 247, 
248, 260, 262, 264, 265, 268 Unit 3: 240, 241, 258, 259, 260, 261, 262, 263 Unit 4: 
242, 243, 260, 261 Unit 5: 236, 237, 240, 241, 252, 253, 256, 257, 261 Unit 6: 238, 
239, 242, 243, 264, 265, 268, 269

Student will use outside 
feedback to revise writing. 

clarify, content, 
structure, organization, 
revising, feedback, peers

reinforce

LA.5.W.2.d
d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

Teacher’s Edition: Unit 1: 265, 271, 274, 275, 276, 277, 282, 283, 284, 285, 286, 
287, 288, 289 Unit 2: 247, 265, 271, 280, 281, 282, 283, 284, 285, 286, 287, 288, 
289 Unit 3: 240, 241, 258, 259, 271, 274, 275, 276, 277, 278, 279, 280, 281, 282, 
283 Unit 4: 269, 271, 273, 275, 276, 277, 278, 279, 280, 281, 282, 283, 284, 285 
Unit 5: 241, 267, 269, 270, 271 Unit 6: 243, 275

Student will use outside 
feedback to edit writing. proofreading, feedback, reinforce

LA.5.W.2.e
e. Use or decipher multiple formats of 
print and digital text (e.g., manuscript, 
cursive, font, graphics, symbols).

Teacher’s Edition: Unit 1: 244, 262, 313 Unit 2: 244, 262 Unit 3: 238, 256 Unit 4: 
240, 258 Unit 5: 234, 250 Unit 6: 236, 252

Students will use a variety 
of texts. multiple formats reinforce

LA.5.W.2.f

f. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Teacher’s Edition: Unit 1: T294, T295, T310 Unit 2: T262, T266, T268, T294, 
T295, T310, T312 Unit 3: T102, T236, T289, T304, T306 Unit 4: T184, T228, 
T258, T286, T291 Unit 5: T186, T230, T232, T236, T242, T258, T260, T262, 
T291, T306 Unit 6: T26, T106, T244, T252, T260, T293, T308

Students will use a variety 
of texts. multiple formats reinforce

Modes of Writing
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LA.5.W.3
Write creative and/or expressive pieces 
that describe a well-developed event 
or experience. Teacher’s Edition: Unit 2: 143 Unit 4: 63, 155 Unit 5: 244-265 Unit 6: 230-267

Students will write a 
creative or personal 
narrative.

creative, expressive reinforce

LA.5.W.3.a
a. Establish a situation and introduce a 
narrator and/or characters.

Teacher’s Edition: Unit 5: T228, T234, T244, T246, T248, T258, T264, T266 Unit 
6: T234, T236, T250, T262, T264, T266, T288

Students will write a 
creative or personal 
narrative.

creative, expressive reinforce

LA.5.W.3.b

b. Use precise words and phrases, 
descriptive/sensory details, dialogue, 
and sensory language to convey 
thoughts, feelings, experiences, and 
events.

Teacher’s Edition: Unit 1: T313 Unit 2: T313 Unit 5: T50, T250, T252, T260 Unit 
6: T246, T248, T254, T252, T254, T256, T260, T262, T266, T267, T289

Students will write a 
creative or personal 
narrative.

creative, expressive reinforce

LA.5.W.3.c
c. Use a variety of transitional words and 
phrases to organize a sequence of 
events that unfolds naturally.

Teacher’s Edition: Unit 5: T242, T244, T248, T250, T252, T256, T258, T265, 
T286 Unit 6: T263, T267, T268

Students will write a 
creative or personal 
narrative.

creative, expressive reinforce

LA.5.W.3.d
d. Provide a conclusion related to the 
creative or expressive event or 
experience.

Teacher’s Edition: Unit 5: T236, T248, T250, T252, T254, T258, T261, T286, 
T309 Unit 6: T252, T254, T262, T264, T266, T311

Students will write a 
creative or personal 
narrative.

creative, expressive reinforce

LA.5.W.4
Write opinion pieces that explain a 
perspective with supporting reasons 
and evidence.

Teacher’s Edition: Unit 1: 63, 230-269 Unit 2: 79 Unit 3: 224-263 Unit 4: 79 Unit 
5: 205, 221

Students will write opinion 
with support and evidence. 

opinion, perspective, 
supporting reasons, 
evidence

reinforce

LA.5.W.4.a

a. Introduce a topic or text clearly, state 
an opinion or perspective, and develop 
a structure in which ideas are grouped 
logically.

Teacher’s Edition: Unit 1: T232, T238, T240, T242, T250, T256, T260, T262, 
T266, T290 Unit 2: T260 Unit 3: T226, T236, T238, T250, T254, T256, T260, 
T262 Unit 4: T108, T256 Unit 5: T182, T192 Unit 6: T288

Students will write opinion 
with support and evidence. 

opinion, perspective, 
supporting reasons, 
evidence

reinforce

LA.5.W.4.b b. Use facts and details to support 
reasons and/or evidence.

Teacher’s Edition: Unit 1: T244, T248, T256, T260, T262, T290 Unit 2: T248, 
T256 Unit 3: T224, T226, T236, T238, T242, T244, T250, T254, T256, T258 Unit 
4: T244, T246, T252 Unit 5: T182, T192

Students will write opinion 
with support and evidence. 

opinion, perspective, 
supporting reasons, 
evidence

reinforce

LA.5.W.4.c
c. Use words, phrases, and key 
vocabulary to connect ideas.

Teacher’s Edition: Unit 1: T235, T238, T247, T277, T291 Unit 2: T18, T69 Unit 3: 
T263, T308 Unit 6: T268

Students will write opinion 
with support and evidence. 

opinion, perspective, 
supporting reasons, 
evidence

reinforce

LA.5.W.4.d
d. Provide a concluding statement or 
section related to the perspective.

Teacher’s Edition: Unit 1: T244 Unit 2: T264, T294 Unit 3: T242, T244, T258 
Unit 4: T260

Students will write opinion 
with support and evidence. 

opinion, perspective, 
supporting reasons, 
evidence

reinforce

LA.5.W.5
Write informative/ explanatory pieces to 
examine a topic or text and clearly 
convey ideas and information.

Teacher’s Edition: Unit 1: 46, 47, 57, 143, 194, 195 Unit 2: 63, 230-269 Unit 3: 
57, 137, 195 Unit 4: 226-265, 297 Unit 5: 55, 61 Unit 6: 55, 137, 143

Students will explain a 
topic or text in an 
informationlal writing 
piece. 

informative, explanatory reinforce

LA.5.W.5.a

a. Introduce a topic clearly and provide 
a general focus, grouping information 
logically and including text features, 
illustrations, and/or multimedia 
elements.

Teacher’s Edition: Unit 2: T232, T234, T236, T240, T242, T256, T260, T268 Unit 
4: T226, T234, T236, T238, T244, T248, T252, T296 Unit 6: T201

Students will explain a 
topic or text in an 
informationlal writing 
piece. 

informative, explanatory reinforce

LA.5.W.5.b
b. Develop the topic with information 
(e.g., facts, definitions, details, 
quotations) related to the topic.

Teacher’s Edition: Unit 2: T242, T244, T266 Unit 3: T236 Unit 4: T238, T240, 
T244, T246, T296 Unit 5: T234, T236

Students will explain a 
topic or text in an 
informationlal writing 
piece. 

informative, explanatory reinforce
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LA.5.W.5.c
c. Use linking words and phrases and 
key vocabulary to connect ideas and 
categories of information.

Teacher’s Edition: Unit 2: T238, T241, T246, T248, T252, T259, T262, T290 Unit 
3: T240 Unit 4: T230, T234, T242, T248, T258, T264

Students will explain a 
topic or text in an 
informationlal writing 
piece. 

informative, explanatory reinforce

LA.5.W.5.d
d. Provide a concluding statement or 
section related to the information or 
explanation(s).

Teacher’s Edition: Unit 1: T244 Unit 2: T264, T294 Unit 3: T242, T244, T256 
Unit 4: T260

Students will explain a 
topic or text in an 
informationlal writing 
piece. 

informative, explanatory reinforce

LA.5.W.6

Locate and summarize relevant 
information and evidence from literary 
and informational text sources to 
answer questions about a topic.

Teacher’s Edition: Unit 1: 26, 27, 108, 109, 188, 189, 221, 295 Unit 2: 26, 27, 108, 
109, 160, 188, 189, 295 Unit 3: 26, 27, 102, 103, 151, 182, 183, 215, 289 Unit 4: 
26, 27, 77, 108, 109, 184, 185, 228, 229, 234, 291 Unit 5: 26, 27, 106, 107, 155, 
186, 187, 232, 233, 290, 291 Unit 6: 26, 27, 106, 107, 293

Students will summarize  
about literary and 
inforamtional text. 

relevant, literary, 
informational, text 
sources

Reinforce 

LA.5.W.6.a
a. Paraphrase information and 
evidence to support ideas while 
avoiding plagiarism.

Teacher’s Edition: Unit 1: 26, 27, 108, 109, 188, 189, 295, 311 Unit 2: 26, 27, 109, 
267, 295 Unit 3: 26, 27, 102, 103, 131, 183, 289 Unit 4: 26, 27, 108, 109, 184, 185, 
228 Unit 5: 26, 27, 107, 186, 187, 232, 307 Unit 6: 26, 27, 106, 107, 188, 189, 293, 
309

Students will summarize  
about literary and 
inforamtional text. 

paraphrase, plagiarism Reinforce 

LA.5.W.6.b

b. Locate and evaluate credibility of 
evidence (e.g., motivation and/or 
potential bias of an information 
product) from print and digital sources 
to generate and answer questions and 
create new understandings.

Teacher’s Edition: Unit 1: 26, 27, 108, 109, 188, 189, 221, 295 Unit 2: 26, 27, 108, 
109, 160, 188, 189, 295 Unit 3: 26, 27, 74, 102, 103, 151, 182, 183, 215, 289 Unit 
4: 26, 27, 77, 108, 109, 153, 155, 156, 184, 185, 228, 229, 234, 291 Unit 5: 26, 27, 
69, 75, 106, 107, 155, 186, 187, 219, 232, 233, 234, 291 Unit 6: 26, 27, 106, 107, 
293

Students will summarize  
about literary and 
inforamtional text. 

credibility, bias, Reinforce 

LA.5.W.6.c
c. Sort evidence into categories using 
an appropriate note-taking format to 
collect and organize information.

Teacher’s Edition: Unit 1: 26, 27, 108, 109, 188, 189, 295, 311 Unit 2: 26, 27, 109, 
267, 295 Unit 3: 26, 27, 102, 103, 131, 183, 289 Unit 4: 26, 27, 108, 109, 184, 185, 
228 Unit 5: 26, 27, 107, 186, 187, 232, 307 Unit 6: 26, 27, 106, 107, 188, 189, 293, 
309

Students will summarize  
about literary and 
inforamtional text. 

Reinforce 

LA.5.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and referencing sources in 
writing and speaking; provide a list of 
sources using a standard format.

Teacher’s Edition: Unit 1: 26, 27, 108, 109, 188, 189, 295, 311 Unit 2: 26, 27, 109, 
267, 295 Unit 3: 26, 27, 102, 103, 131, 183, 289 Unit 4: 26, 27, 108, 109, 184, 185, 
228 Unit 5: 26, 27, 107, 186, 187, 232, 301, 307 Unit 6: 26, 27, 106, 107, 188, 189, 
293, 309

Students will summarize  
about literary and 
inforamtional text. 

academic integrity, 
overrliance Reinforce 

LA.5.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Teacher’s Edition: Safe and ethical online behaviors are not specifically addressed, 
however reading digitally can be found on the following pages: Unit 1: 294-295 
Unit 2: 294-295 Unit 3: 288-289 Unit 4: 290-291 Unit 5: 290-291 Unit 6: 292-293

Students will summarize  
about literary and 
inforamtional text. 

ethical, diverse 
perspectives Reinforce 

Comprehension and Collaboration

S
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LA.5.SL.1
Prepare for and participate in structured 
discussions and collaborations about 5th 
grade topics and texts.

Teacher’s Edition: Unit 1: T26, T52, T108, T188, T244, T306 Unit 2: T18, T22, 
T26, T46, T52, T56, T73, T244, T306 Unit 3: T14, T18, T26, T42, T92, T102, 
T120, T182, T300 Unit 4: T16, T18, T46, T57, T122, T190, T240, T254, T291, 
T294, T297, T300, T302, T304, T306, T308 Unit 5: T4, T14, T22, T26, T54, T94, 
T135, T174, T176, T178, T186, T192, T197, T254, T256, T303 Unit 6: T54, T55, 
T136, T137, T200, T201, T302, T304, T305

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce
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LA.5.SL.1.a
a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Teacher’s Edition: Unit 1: T57, T86, T137, T166, T188, T308, T309, T313 Unit 2: 
T4, T86, T132, T166, T188, T246, T290, T308, T313 Unit 3: T4, T80, T160, 
T182, T240, T258, T284, T300, T302, T303, T307 Unit 4: T4, T8, T57, T242, 
T260, T291, T305, T309 Unit 5: T4, T14, T26, T150, T164, T166, T168, T174, 
T186, T238, T254, T290, T302, T303, T305, T308, T309, T312 Unit 6: T240, 
T244, T256, T306, T310, T311

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce

LA.5.SL.1.b
b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Teacher’s Edition: Unit 1: 4, 86, 166, 168, 309, 313 Unit 2: 4, 86, 166, 168, 306, 
309, 313 Unit 3: 4, 80, 160, 162, 300, 304 Unit 4: 4, 86, 162, 164, 302, 306 Unit 5: 
4, 84, 164, 166, 302, 306 Unit 6: 4, 84, 166

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce

LA.5.SL.1.c

c. Converse with peers and adults an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Teacher’s Edition: Unit 1: 4, 86, 166, 168, 309, 313 Unit 2: 4, 86, 166, 168, 306, 
309, 313 Unit 3: 4, 80, 160, 162, 300, 304 Unit 4: 4, 86, 162, 164, 302, 306 Unit 5: 
4, 84, 164, 166, 302, 306 Unit 6: 4, 84, 166

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce

LA.5.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, recalling, 
questioning).

Teacher’s Edition: Unit 1: 4, 86, 166 Unit 2: 4, 86, 166, 306, 309 Unit 3: 4, 80, 
160, 300, 304 Unit 4: 4, 86, 162, 302, 306 Unit 5: 4, 84, 164, 302, 306 Unit 6: 4, 
84, 166, 307

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce

LA.5.SL.1.e
e. Complete a task following multi-step 
directions.

Teacher’s Edition: Unit 1: T57, T137, T143, T153, T159 Unit 2: T129, T137, 
T188-189, T207, T217, T223 Unit 4: T139, T149, T155 Unit 6: T143, T153, T159

Students will engage in 
critical conversations 
regarding their reading.

Relevant, prepare, 
participate. Reinforce

Presentation of Knowledge and Ideas

LA.5.SL.2

Report on a topic or text, or present an 
opinion, sequencing ideas logically and 
using appropriate facts and relevant, 
descriptive details to support themes or 
central ideas.

Teacher’s Edition: Unit 1: T137, T188, T201, T308, T310, T312 Unit 2: T137, 
T188, T201, T290, T308, T310, T312 Unit 3: T51, T131, T182, T195, T284, T302, 
T304, T306 Unit 4: T108, T133, T304, T306, T308 Unit 5: T55, T286, T300, 
T304, T306, T308 Unit 6: T55, T137, T260, T306, T308, T310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce

LA.5.SL.2.a

a. Demonstrate appropriate speaking 
techniques (e.g., appropriate eye 
contact, adequate volume, clear 
pronunciation) for a variety of purposes 
and situations, including interpreting 5th 
grade texts.

Teacher’s Edition: Unit 1: 296, 297, 308, 309, 310, 311, 312, 313 Unit 2: 296, 297, 
309, 311, 313 Unit 3: 290, 291, 302, 304, 305, 306 Unit 4: 292, 293, 304, 307, 308, 
309 Unit 5: 292, 293, 304, 306, 307, 308 Unit 6: 294, 295, 306, 308, 309, 310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce

LA.5.SL.2.b
b. Convey a perspective with clear 
reasoning and support.

Teacher’s Edition: Unit 1: 296, 297, 308, 309, 310, 311, 312, 313 Unit 2: 296, 297, 
309, 311, 313 Unit 3: 290, 291, 302, 304, 305, 306 Unit 4: 292, 293, 304, 307, 308, 
309 Unit 5: 292, 293, 304, 306, 307, 308 Unit 6: 294, 295, 306, 308, 309, 310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce

LA.5.SL.2.c
c. Identify the purpose and credibility of 
information being presented.

Teacher’s Edition: Unit 1: 296, 297, 308, 309, 310, 311, 312, 313 Unit 2: 296, 297, 
309, 311, 313 Unit 3: 290, 291, 302, 304, 305, 306 Unit 4: 292, 293, 304, 307, 308, 
309 Unit 5: 292, 293, 304, 306, 307, 308 Unit 6: 294, 295, 306, 308, 309, 310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce

LA.5.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Teacher’s Edition: Unit 1: 296, 297, 308, 309, 310, 311, 312, 313 Unit 2: 296, 297, 
309, 311, 313 Unit 3: 290, 291, 302, 304, 305, 306 Unit 4: 292, 293, 304, 307, 308, 
309 Unit 5: 292, 293, 304, 306, 307, 308 Unit 6: 294, 295, 306, 308, 309, 310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce

LA.5.SL.2.e
e. Use appropriate visual and/or digital 
tools to enhance verbal communication 
and add interest.

Teacher’s Edition: Unit 1: T137, T310, T312 Unit 2: T108, T122, T137, T310, 
T312 Unit 3: T51, T102, T131, T304, T306 Unit 4: T26, T304, T306, T308 Unit 5: 
T55, T186, T306, T308 Unit 6: T106, T308, T310

Students will present 
information to the class 
that demonstrates 
understanding of their 
reading.

sequence ideas, 
appropriate facts Reinforce



5

Seward Public 
Schools

A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary Introduce/Reinforce/
Master



5 Reading

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 1 Week 1 and 2 Week 1-2 

We can use primary and secondary sources to read 
dn understand narrative nonfiction. 
We can read and understand narrative nonfiction by 
identifying the cause and effect text structure. 
We can identify the author's perspective to help us 
read and understand an autobiography. 

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

Unit 1 Week 3 and 4 Week 3-4 

We can use the plot to read and understand realistic 
fiction. 
We will read and understand realistic fiction by 
identifying the setting, events, and conflict. 
We can identify text structure to help us read and 
understand a personal narrative. 

Unit 1 Week 5 Week 5

We can use headings and graphs to read and 
understand the argumentative text. 
We can read and understand argumentative text by 
identifying the author's claim.
We can identify the author's purpose to help us read 
and understand a text.  

Unit 1 Week 6 Week 6 Extend, Connect, and Assess 
Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 2 Week 1 and 2 Week 1-2 

We can use these headings and timelines to read and 
understand expository text. 
We can read and understand an expository text by 
identifying the problem and solution. 
We can identify print and graphic features to help us 
read and understand an expository text. 

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

Unit 2 Week 3-4 Week 3-4 

We can make predictions to understand folktales. 
We can identify and analyze the setting to understand 
folktales. 
We can identify a sequence text structure to help us 
read and understand expository text. 

Unit 2 Week 5 Week 5 

We can identify repetition and rhyme in poetry. 
We can identify the characteristics of a narrative and 
a free verse poem to understand poetry. 
We can read and understand poetry by analyzing the 
theme. 
We can identify form and line breaks to help us read 
and understand poetry. 

Unit 2 Week 6 Week 6  Extend, Connect, and Assess 
Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 3 Week 1 and 2 Week 1-2 

We can summarize to understand realistic fiction. 
We can analyze character and plot development in 
realistic fiction.
We can read and understand realistic fiction by 
identifying the theme. 
We can identify author's purpose to help us read and 
understand expository text.  

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing


5 Reading

Unit 3 Week 3 and 4 Week 3-4 

We can ask and answer questions to understand 
expository text. 
We can use photographs, captions, and text structure 
to understand expository text. 
We can read and understand expository text by 
identifying the central idea and relevant details. 
We can identify literal and figurative language to help 
us read and understand expository text. 

Unit 3 Week 5 Week 5

We can summarize to understand argumentative text. 
We can identify the text structure used by the author 
to read and understand the argumentative text. 
We can read and understand argumentative text by 
identifying the author's claim. 
We can identify figurative language to help us read 
and understand expository text. 

Unit 3 Week 6 Week 6 Extend, Connect, and Assess 
Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 4 Week 1 and 2 Week 1-2 

We can summarize to understand a biography. 
We can use photographs and captions to read and 
understand a biography. 
We can read and understand a biography by 
identifying the author's perspective. 
We can identify chronology to help us understand 
expository text. 

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

Unit 4 Week 3 and 4 Week 3-4 

We can visualize to understand a mystery play. 
We can use structural elements to read and 
understand a mystery play.
We can read and understand a mystery by identifying 
the character's perspective. 
We can identify figurative language to help us read 
and understand a legend. 

Unit 4 Week 5 Week 5 

We can identify stanzas and meter to read and 
understand poetry. 
We can identify lyric and free verse forms of poetry. 
We can read and understand poetry by identifying the 
theme. 
We can identify poetic elements like imagery to help 
us read and understand poetry. 

Unit 4 Week 6 Week 6 Extend, Connect, and Assess 
Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 5 Week 1 and 2 Week 1-2 

We can ask and answer questions to understand 
expository text. 
We can use diagrams to read and understand 
expository text. 
We can read and understand expository text by 
identifying the central idea and relevant details. 
We can identify imagery to help us read and 
understand fables. 

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing


5 Reading

Unit 5 Week 3 and 4 Week 3-4 

We can make, confirm, and revise predictions to 
understand historical fiction. 
We can use characterization to read and understand 
historical fiction. 
We can read and understand historical fiction by 
identifying the story's conflict. 
We can identify text structure (compare and 
constrast) to help us read and understand expository 
text. 

Unit 5 Week 5 Week 5 

We can ask and answer questions to understand 
argumentative text.
We can use charts and headings to read and 
understand argumentative text.  
We can read and understand argumentative text by 
identifying authors' perspectives. 
We can identify puns to help us read and understand 
expository text. 

Unit 5 Week 6 Week 6 Extend, Connect, and Assess 
Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment

Unit 6 Week 1 and 2 Week 1-2 

We can summarize to understand historical fiction. 
We can identify and analyze flashbacks to understand 
historical fiction.
We can read and understand historical fiction by 
identifying the theme. 
We can identify print and graphic features to help us 
read and understand expository text.  

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFg
Rek6pD9b/view?usp=sharing

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek
6pD9b/view?usp=sharing

Unit 6 Week 3 and 4 Week 3-4 

We can ask and answer questions to understand 
expository text. 
We can use maps to read and understand expository 
text. 
We can read and understand expository text by 
identifying a cause and effect text structure. 
We can identify character perspectives to help us 
read and understand a Pourquoi story. 

Unit 6 Week 5 Week 5 

We can identify assonance and consonance to 
understand poetry. 
We can identify lyric and narrative forms of poetry. 
We can read and understand poetry by identifying the 
point of view and the speaker's perspective. 
We can identify imagery to help us read and 
understand poetry. 

Unit 6 Week 6 Week 6 Extend, Connect, and Assess 

https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view?usp=sharing


5 Writing

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment
UNIT 1 - Text Set 1:  Week 1 Phon/Spell: TSW spell words with Short Vowels

Grammar: TSW identify different types of Sentences; TSW Punctuate Sentences
Writing Application: TSW will identify 3 types of writing (Step Up: E2 Introduction to Writing) Phonics/Spelling/Grammar

Week 2 Phon/Spell: TSW spell words with Long Vowels, 
Grammar: TSW identify Subjects and Predicates; TSW use Commas
Writing Application: TSW identify the steps of the writing process  (Step Up: E2 The Writing 
Process

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7Pin
sFgRek6pD9b/view

https://drive.google.
com/file/d/1zC57pi3NPKy4JpRxj7Pin
sFgRek6pD9b/view

UNIT 1 - Text Set 2 Week 3 Phon/Spell: TSW spell Words with /ū/, /ů/, and /ü
Grammar: TSW identify Compound Sentences; TSW Punctuate Compound Sentences 
correctly
Writing Application: TSW tell a story through Narrative Writing. (Step Up: E6 Narrative 
Writing)

Writing Application Materials, 
Rubrics/Checklists 
taken/modified/created using from 
Step Up to Writing materials

Week 4 Phon/Spell: TSW spell words with r-controlled Vowels  /är/, /âr/, /ôr/
Grammar: TSW identify Complex Sentences; TSW use Commas correctly
Writing Application: TSW tell a story through Narrative Writing. (Step Up: E6 Narrative 
Writing)

UNIT 1 - Text Set 3 Week 5 Phon/Spell: TSW spell words with r-controlled Vowel /ûr/
Grammar: TSW identify and correct Run-on Sentences
Writing Application: TSW tell a story through Narrative Writing. (Step Up: E6 Narrative 
Writing)

Week 6 Extend, Connect, Assess
UNIT 2 - Text Set 1 Week 1 Phon/Spell: TSW spell words with Variant Vowel /ô/; Diphthongs /oi/, /ou/

Grammar: TSW identify different Kinds of Nouns; TSW Capitalize Proper Nouns
Writing Application: TSW Write creative and/or expressive pieces (Mystery) that describe a 
well-developed event or experience.

Week 2 Phon/Spell: TSW spell words using knowledge of Plurals
Grammar: TSW identify Singular and Plural Nouns; TSW Form Plural Nouns correctly
Writing Application: TSW Write creative and/or expressive pieces (Mystery) that describe a 
well-developed event or experience.

UNIT 2 -  Text Set 2 Week 3 Phon/Spell: TSW spell words with Inflectional Endings
Grammar: TSW will identify Plural Nouns; TSW Use Plural Forms and Appositives correctly
Writing Application: TSW Write creative and/or expressive pieces (Mystery) that describe a 
well-developed event or experience.

Week 4 Phon/Spell: TSW spell words with Plural Nouns; Plural Forms and Appositives
Grammar: Identify Possessive Nouns; TSW will Add -s or -'s to possessive nouns correctly
Writing Application: TSW Write creative and/or expressive pieces (Mystery) that describe a 
well-developed event or experience.

UNIT 2 - Text Set 3 Week 5 Phon/Spell: TSW spell words with Closed Syllables
Grammar: TSW will identify Prepositional Phrases; TSW Punctuate Titles and Letters correctly
Writing Application: TSW Write creative and/or expressive pieces (Mystery) that describe a 
well-developed event or experience.

Week 6 Extend, Connect, Assess
UNIT 3 - Text Set 1 Week 1 Phon/Spell: TSW spell words with Open Syllables

Grammar: Identify Action Verbs; Use correct Subject-Verb Agreement
Writing Application: TSW write opinion pieces (persuasive essay) that explain a perspective 
with supporting reasons and evidence.

Week 2 Phon/Spell: TSW spell words with Open Syllables (V/V)
Grammar: Identify different Verb Tenses; Avoid Shifting Verb Tenses
Writing Application: TSW write opinion pieces (persuasive essay) that explain a perspective 
with supporting reasons and evidence.

https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view
https://drive.google.com/file/d/1zC57pi3NPKy4JpRxj7PinsFgRek6pD9b/view


5 Writing

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment
UNIT 3 -  Text Set 2 Week 3 Phon/Spell: TSW spell words with Vowel Team Syllables

Grammar: TSW will identify Main and Helping Verbs; TSW recognize Special Helping Verbs; 
Contractions; Troublesome Words
Writing Application: TSW write opinion pieces (persuasive essay) that explain a perspective 
with supporting reasons and evidence.

Week 4 Phon/Spell:  TSW spell words with Consonant + le Syllables
Grammar:  TSW identify Linking Verbs; TSW Punctuate Titles and Product Names
Writing Application: TSW write opinion pieces (persuasive essay) that explain a perspective 
with supporting reasons and evidence.

UNIT 3 - Text Set 3 Week 5 Phon/Spell: TSW will spell words with r-controlled Vowel Syllables 
Grammar:  TSW use the past tense of Irregular Verbs correctly; Apply an understanding of 
Correct Verb Usage
Writing Application: TSW write opinion pieces (persuasive essay) that explain a perspective 
with supporting reasons and evidence.

Week 6 Extend, Connect, Assess
UNIT 4 - Text Set 1 Week 1 Phon/Spell: TSW spell Words with Final /əl/ and /ən/

Grammar: TSW identify Pronouns and Antecedents; TSW use correct Pronoun-Antecedent 
Agreement
Writing Application:  TSW Write informative/ explanatory (Revolutionary War Reports) pieces 
to examine a topic or text and clearly convey ideas and information.

Week 2 Phon/Spell: TSW spell words with Prefixes
Grammar: TSW identify different Kinds of Pronouns; TSW use Quotation Marks in Dialogue
Writing Application: TSW Write informative/ explanatory (Revolutionary War Reports) pieces 
to examine a topic or text and clearly convey ideas and information.

UNIT 4 -  Text Set 2 Week 3 Phon/Spell: TSW will spell Homographs
Grammar:  TSW use Pronoun-Verb Agreement; TSW use Abbreviations correctly
Writing Application: TSW Write informative/ explanatory (Revolutionary War Reports) pieces 
to examine a topic or text and clearly convey ideas and information.

Week 4 Phon/Spell: TSW will spell Words with /chər/ and /zhər/
Grammar: TSW identify Possessive Pronouns; TSW use Apostrophes, Possessives, and 
Reflexive Pronouns correctly 
Writing Application: TSW Write informative/ explanatory (Revolutionary War Reports) pieces 
to examine a topic or text and clearly convey ideas and information.

UNIT 4 - Text Set 3 Week 5 Phon/Spell: TSW spell words with Suffixes -ance and -ence 
Grammar: TSW identify Pronouns and Homophones; TSW Punctuate Poetry correctly
Writing Application: TSW Write informative/ explanatory (Revolutionary War Reports) pieces 
to examine a topic or text and clearly convey ideas and information.

Week 6 Extend, Connect, Assess
UNIT 5 - Text Set 1 Week 1 Phon/Spell: TSW spell words with suffixes   

Grammar: TSW identify independent and dependent clauses; TSW use apposotives correctly
Writing Application: TSW Locate and summarize relevant information and evidence from 
literary  (Response to Literature/Book Reports) and informational text sources to answer 
questions about a topic.

Week 2 Phon/Spell: TSW spell Homophones
Grammar: TSW will identify Complex Sentences; TSW will us commas correctly with clauses
Writing Application: TSW Locate and summarize relevant information and evidence from 
literary  (Response to Literature/Book Reports) and informational text sources to answer 
questions about a topic.



5 Writing

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment
UNIT 5 -  Text Set 2 Week 3 Phon/Spell: TSW spell words with Prefixes

Grammar: TSW explain the function of Adjectives; TSW use correct Capitalization and 
Punctuation
Writing Application: TSW Locate and summarize relevant information and evidence from 
literary  (Response to Literature/Book Reports) and informational text sources to answer 
questions about a topic.

Week 4 Phon/Spell: TSW spell words with Suffixes -less and  -ness
Grammar: TSW identify Adjectives That Compare; TSW will Use More and Most correctly with 
adjectives
Writing Application: TSW Locate and summarize relevant information and evidence from 
literary  (Response to Literature/Book Reports) and informational text sources to answer 
questions about a topic.

UNIT 5 - Text Set 3 Week 5 Phon/Spell: Spell words with the Suffix -ion
Grammar: TSW Use Good and Bad to make comparisions; TSW use Irregular Comparative 
Forms correctly
Writing Application: TSW Locate and summarize relevant information and evidence from 
literary  (Response to Literature/Book Reports) and informational text sources to answer 
questions about a topic.

Week 6 Extend, Connect, Assess
UNIT 6 - Text Set 1 Week 1 Phon/Spell: TSW spell Words with Greek Roots

Grammar: TSW Identify Adverbs; TSW use Capitalization and Abbreviations in Letters and 
Formal E-mails
Writing Application: TSW Write informative/ explanatory pieces (Biography project) to 
examine a topic or text and clearly convey ideas and information.

Week 2 Phon/Spell: TSW spell Words with Latin Roots
Grammar: TSW use Adverbs That Compare; TSW will use good, well; more, most; -er, -est
Writing Application: TSW Write informative/ explanatory pieces (Biography project) to 
examine a topic or text and clearly convey ideas and information.

UNIT 6 -  Text Set 2 Week 3 Phon/Spell: TSW spell Words from Mythology
Grammar: TSW Identify Negative words and phrases; TSW Correct Double Negatives
Writing Application: TSW Write informative/ explanatory pieces (Biography project) to 
examine a topic or text and clearly convey ideas and information.

Week 4 Phon/Spell: TSW will spell words with Number Prefixes uni-, bi-, tri-, cent-
Grammar: TSW combine Sentences correctly; TSW use Commas and Colons correctly
Writing Application: TSW Write creative and/or expressive pieces (Figurative Language 
Poetry) that describe a well-developed event or experience.

UNIT 6 - Text Set 3 Week 5 Phon/Spell: Suffixes -ible, -able
Grammar: TSW identify Prepositional Phrases; TSW use Pronouns correctly in Prepositional 
Phrases
Writing Application: TSW Write creative and/or expressive pieces (Figurative Language 
Poetry) that describe a well-developed event or experience.

Unit/GENRE/THEME Pacing Learning Goals Supporting STEP UP to Writing Assessment 
Creative Expressive 
(Personal Narrative) 

September TSW Write creative and/or expressive pieces that describe a well-developed event or 
experience.

Step Up:  E6 Published Personal narrative, 
checklist for self/peer/teacher check

Creative Narrative 
(Mystery)

October TSW Write creative and/or expressive pieces (Mystery) that describe a well-developed event or 
experience.

Step Up: E6 Published Mystery checklist for 
self/peer/teacher check

Creative Expressive 
(Poetry) Flanders Field

November 
TSW Write creative and/or expressive pieces (Poetry) that describe a well-developed event or experience.

Step Up: E-10-15 Published poetry checklist for 
self/peer/teacher check

Opinion Piece 
(Persuasive Essay)

November/ 
December

TSW Write opinion pieces (persuasive essay) that explain a perspective with supporting 
reasons and evidence.

Step Up: E5 Published Essay. checklist for 
self/peer/teacher check



5 Writing

Unit/GENRE/THEME Pacing Learning Goals Supporting Wonders Materials Assessment
Informative/explanatory 
(Revolutionary War 
Reports)

January/ 
February TSW Write informative/explanatory (Revolutionary War Reports) pieces to examine a topic or 

text and clearly convey ideas and information.

Step Up: E7 Published Report with checklist for 
self/peer/teacher check for 
notes/summary/presentation

Informative/explanatory 
(Response to 
Literature/Book Reports)

March TSW Locate and summarize relevant information and evidence from literary  (Response to 
Literature/Book Reports) and informational text sources to answer questions about a topic.

Step Up: E4 Published reportchecklist for 
self/peer/teacher check 

Informative/Explanatory 
(Biography - Mother's 
Day)

April TSW Write informative/ explanatory pieces (Biography project) to examine a topic or text and 
clearly convey ideas and information.

Step Up: E4 Mother's Day Biography checklist for 
self/peer/teacher check for 
conent/presentation 

Creative Expressive 
(Figurative Language 
Poetry)

April/May 
TSW Write creative and/or expressive pieces (Figurative Language Poetry) that describe a well-
developed event or experience.

Step Up: E-10-15 Figurative Language poster checklist 
for self/peer/teacher check for 
poster, poetry, presentation



6

6th Grade
Seward Public 

Schools
A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goals Key Vocabulary Introduce/Reinforce/
Master

R
e
a
d
i
n
g
 
P
r
o
s
e
 
a
n
d
 
P
o
e
t
r
y

Central Ideas and Details

LA.6.RP.1
Determine the implied or explicit theme 
of a literary text and how it develops 
over the course of a text.

TE: 51, 116–118, 120, 143, 145, 148, 152, 156, 183, 184, 
319, 321, 323, 348,355, 479, 481–496, 497, 498, 508, 525, 

528, 533, 542, 543, 545

Determine implied theme 
of text as it develops 
during text

determine, theme, 
develops Reinforce

LA.6.RP.2

Explain how a plot unfolds as well as 
how the characters respond to events 
or changes as the plot moves toward a 
resolution.

TE: 124, 127, 130, 131, 134–135, 139, 141–43, 146–147, 
152, 156, 157, 179,181–188, 190, 235, 238, 246, 248, 391, 
394–398, 481–496, 497, 499, 518, 520–526, 528, 535–542, 
544

Explain plot develops and 
how the characters 
respond to reach a 
resolution.

plot development, 
character reactions, 
resolution

Reinforce

Author's Craft

LA.6.RP.3
Explain how an author establishes and 
conveys the point(s) of view of a 
narrator or speaker in a literary text.

TE: 5–12, 33–38, 40, 41, 48, 50, 60, 195, 197, 307, 310, 314, 
319, 322, 324,391, 518,523

Explain author's narrator 
point of view

point of view, 
narrator/speaker view reinforce

LA.6.RP.4

Analyze how a sequence of chapters, 
scenes, or stanzas contribute to the 
development of literary elements (e.g. 
theme, setting, or plot).

TE: 14, 117–120, 150–151, 323, 400, 40, 424, 427–432, 434, 
535–542

Analyze sequence of 
events to identify theme, 
setting, and plot

analyze, sequence of 
events, theme, setting, 
plot

reinforce

Knowledge and Ideas

LA.6.RP.5

Compare and contrast texts in different 
forms or genres (e.g., stories and poems, 
historical novels, fantasy stories) and 
their treatment of similar themes and 
topics.

TE: 158–159, 252, 351, 354, 407, 422–434, 448, 548–549
Compare and contrast 
texts of same genre to 
identify theme and topics

compare, contrast, 
genres, themes, topics reinforce

LA.6.RP.6

Analyze a literary text to answer and 
develop inferential and evaluative 
questions to enhance the 
comprehension of self and others, 
quoting or paraphrasing specific 
evidence from the text.

TE: 48–50, 54, 117–118, 120, 126–132, 133, 141–154, 189, 
190, 199, 200, 235,237–246, 248, 324, 351, 352, 393–398, 
400, 443–444, 544

Analyze text to 
answer/develop questions 
to better understand the 
text through use of text 
evidence and make 
connections to self

analyze, literary text, reinforce

LA.6.RP.7

Compare and contrast regional, 
national, and/or multicultural 
perspectives within and across literary 
texts.

TE: 56, 407, 448, 543

Compare and contrast 
texts with different 
regional, naitonal, and/or 
multicultural perspectives

compare, contrast, 
regional, national, 
multicutural perspectives

introduce

Range of Reading and Level of 
Text Complexity

LA.6.RP.8

Read and comprehend a wide range 
of literary text of appropriate complexity 
for the 6-8 grade band proficiently, with 
scaffolding as needed at the high end 
of the range.

TE: 35–38, 48–56, 117–118, 126–132, 141–154, 160–161, 
181–188, 197–198,237–246, 309–312, 321–322, 346–347, 
349–350, 393–398, 411–416, 439–442,481–496, 506–508, 
510, 520–526, 535–542

Read and comprehend 
wide range of levels of text 
complexity with layers as 
needed

read, comprehend, 
literary text, scaffolding 
(levels of learning)

introduce
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Central Ideas and Details

LA.6.RI.1
Determine the implied or explicit central 
idea of an informational text and how it 
develops over the course of a text.

TE: 14, 26, 28, 212, 229, 256, 260, 262, 263, 269, 273, 277, 
281, 282, 283, 329,332–336, 467, 471

Determine the central idea 
of a text and explain how 
the details support the 
idea

determine, central idea, 
informational text, 
supporting details

reinforce

LA.6.RI.2

Explain how a key individual, event, or 
idea or concept is introduced and 
developed, drawing on specific 
supporting details in an informational 
text.

TE: 5, 24, 28, 64, 71, 74, 411–416, 418

Explain how individuals, 
events, or ideas develop 
through the use of text 
evidence in informational 
text.

supporting details, text 
evidence,informational 
text

introduce

Author's Craft

LA.6.RI.3
Explain how an author establishes and 
conveys a perspective or purpose in an 
informational text.

TE: 22, 24, 28, 58–66, 68–72, 99–108, 110, 412–416, 419, 
469–472

Explain how shows 
author's purpose in an 
informational text

author's purpose, 
informational text, 
explain

reinforce

LA.6.RI.4

Analyze how a particular sentence, 
paragraph, chapter, or section fits into 
the overall structure of a text and 
contributes to the development of the 
ideas.

TE: 5–12, 110, 205–206, 211, 212, 226, 227–228, 230, 256, 
259, 261, 264, 267,268, 276, 280, 329, 334–335, 337, 38–
339, 413, 417, 471–472, 473–474

Analyze how specific 
sentences, paragraphs, 
chapters, or sections 
support the text features of 
a text.

text features, text 
structure, introduce

Knowledge and Ideas

LA.6.RI.5
Compare and contrast one author’s 
presentation of information with that of 
another.

TE: 78, 252, 254–268, 286–287, 407, 448
Compare and contrast two 
or more author's 
information

compare, contrast, 
multiple author's introduce

LA.6.RI.6

Analyze the development of an 
argument and identify the type(s) of 
reasoning used to support the 
argument.

TE: 58–66, 67–72, 358–361, 362, 363–365, 366, 370
Analyze a persuasive text 
and identify the support for 
the argument

analyze, persuade, 
evidence introduce

LA.6.RI.7

Compare and contrast regional, 
national, and/or multicultural 
perspectives within and across 
informational texts.

TE: 110

Compare and contrast 
texts with various regional, 
national, and/or 
mulitcultural perspectives

compare, contrast, 
regional, national, 
multicultural

introduce

Range of Reading and Level of 
Text Complexity

LA.6.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity for the 6-8 grade band 
proficiently, with scaffolding as needed 
at the high end of the range.

TE: 5–12, 58–66, 68–72, 99–108, 160–161, 205–209, 224–
228, 258–266, 275–280, 321–336, 411–416, 469–472

Read and comprehend 
wide range of levels of text 
complexity with layers as 
needed for informational 
text

read, understand, 
informational text introduce

V
o
c
a
b
u
l
a
r
y

Acquisition and Use
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LA.6.V.1
Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

TE: 20, 21, 24, 30, 36, 62–66, 68–72, 76, 103–104, 106–107, 
127–129, 131,181, 183, 188, 204, 206, 208, 210, 212, 222–
223, 225,227, 230, 232,236, 239,250, 259, 260, 263, 266, 
275–280, 309–312, 321, 331–336, 360–361, 363–364,393–
398, 416, 420, 439–442, 446, 469–472, 476, 483–484, 487, 
490, 492, 521–522, 524, 536, 540–542, 546

Identify and implement 
grade level vocabulary for 
variety of tasks

identify, vocabulary, introduce

LA.6.V.1.a

a. Use context clues (e.g. the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

TE: 20, 21, 24, 30, 36, 62–66, 68–72, 76, 103–104, 106–107, 
127–129, 131,181, 183, 188, 204, 206, 208, 210, 212, 222–
223, 225,227, 230, 232,236, 239,250, 259, 260, 263, 266, 
275–280, 309–312, 321, 331–336, 360–361, 363–364,393–
398, 416, 420, 439–442, 446, 469–472, 476, 483–484, 487, 
490, 492, 521–522, 524, 536, 540–542, 546

Identify and implement 
grade level vocabulary for 
variety of tasks

identify, vocabulary, introduce

LA.6.V.1.b

b. Use commonly occurring Greek and 
Latin affixes and roots to determine the 
meanings of words (e.g., audience, 
audible).

TE: 42, 112, 316, 326, 340
Identify and implement 
grade level vocabulary for 
variety of tasks

identify, vocabulary, introduce

LA.6.V.1.c

c. Consult reference materials to 
determine or clarify the precise 
meanings, pronunciations, or parts of 
speech of words.

TE: 2, 42, 136, 176, 284, 402, 500
Identify and implement 
grade level vocabulary for 
variety of tasks

identify, vocabulary, introduce

Context and Connotations

LA.6.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Understand the way 
author's use words within 
the literary and 
informational texts

figurative language, 
connotations, technical 
language

introduce

LA.6.V.2.a
a. Interpret figures of speech (e.g., 
literary, biblical, or mythological 
allusions) in context.

TE: 35–38, 40, 46-50, 54, 55, 119, 120, 156, 224, 409, 415–
416, 505–507,510-512

Understand the way 
author's use words within 
the literary and 
informational texts

figurative language, 
connotations, technical 
language

introduce

LA.6.V.2.b
b. Determine the relationship between 
words (e.g., cause/effect, part/whole, 
item/category).

TE: 113, 382

Understand the way 
author's use words within 
the literary and 
informational texts

figurative language, 
connotations, technical 
language

introduce

LA.6.V.2.c
c. Distinguish between the connotations 
of words with similar denotations (e.g., 
economical, thrifty).

TE: 30

Understand the way 
author's use words within 
the literary and 
informational texts

figurative language, 
connotations, technical 
language

introduce

W
r
i
t
i
n
g

Production of Writing

LA.6.W.1
Create grammatically correct multi-
paragraph compositions with varied 
sentence structures.

Students will write a 
passage using correct 
grammar, sentences and 
paragraphs. 

passage Reinforce
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LA.6.W.1.a
a. Apply knowledge of rules for 
capitalization.

TE: 113, 193
Students will use 
appropriate capitalization 
when writing.

capitalization
Reinforce

LA.6.W.1.b
b. Use punctuation (e.g., commas, 
parentheses, dashes) to set off non-
restrictive clauses.

TE: 31, 233, 421

Students will use commas, 
parentheses, and dashes 
to set off non-restrictive 
clauses.

commas, parentheses, 
dashes, non-restrictive 
clauses Reinforce

LA.6.W.1.c
c. Use a colon to introduce items in a 
series; use a semicolon to combine 
independent clauses.

Level Up Tutorial: Colon,Level Up Tutorial: Semicolon,
Interactive Grammar Lesson: Semicolons,Interactive 
Grammar Lesson: Colons

Students will use colons to 
introduce items in a series 
and a semicolon to 
combine independent 
clauses.

colons, series, 
semicolon, independent 
clauses

Reinforce

LA.6.W.1.d
d. Explain the function of articles (e.g., 
definite and indefinite) and apply 
knowledge to writing.

Students will explain the 
function of definite (the) 
and indefinite (a / an) 
articles and apply them 
when writing.

definite article - use the if 
the noun is known to the 
reader & indefinite 
articles - use a or an if 
the noun is unkown to 
the reader Reinforce

LA.6.W.1.e e. Identify and use verb tenses (e.g., 
progressive).

TE: 327

Students will identify and 
use progressive verb 
tenses (past, present, & 
future tense).

progressive verb tense 
(past, present, future)

Reinforce

LA.6.W.1.f
f. Distinguish between and use different 
types of phrases (e.g., prepositional and 
appositive).

TE: 137, 403, 501

Students will identify and 
use different types of 
phrases such as 
prepostitional and 
appositive.

prepostional phrase, 
appositivie phrase Introduce

LA.6.W.1.g
g. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tenses.

TE: 317

Students will identify and 
revise fragment and run-
on sentences and incorret 
verb tense.

fragment, run-on, verb 
tense Introduce

LA.6.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Students will draft, revise 
and edit their writing. draft, revise, edit Reinforce

LA.6.W.2.a
a. Use prewriting activities and inquiry 
tools to plan, organize, and draft writing.

TE: 79, 82–85, 159, 162–165, 290–295, 374–377, 452–457, 
552–556

Students will use prewrite 
activites (graphic 
organizers) to plan, 
organize and draft a 
writing.

plan, organize, draft Reinforce

LA.6.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

TE: 15, 29, 32, 45, 59, 79, 82, 90, 96, 111, 114, 121, 123, 
135, 138, 157, 159,162–173, 176, 178, 194, 202, 221, 231, 
234, 255, 272, 290–299, 304, 306, 315,318, 328, 343, 374–
385, 388, 390, 408, 419, 423, 435, 445, 449, 452–461, 
464,466, 475, 478, 503, 513, 517, 529, 532, 552–561

Students will use prewrite 
activites (graphic 
organizers) to plan, 
organize and draft a 
writing.

plan, organize, draft Reinforce

LA.6.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

TE: 15, 159, 168–169, 296–299, 380–381, 458–459, 558–559

Students will use prewrite 
activites (graphic 
organizers) to plan, 
organize and draft a 
writing.

plan, organize, draft Reinforce
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LA.6.W.2.d
d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

TE: 89–90, 159, 170, 298, 382, 460, 560

Students will use prewrite 
activites (graphic 
organizers) to plan, 
organize and draft a 
writing.

plan, organize, draft Reinforce

LA.6.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

TE: 79, 90, 159, 171–173, 298–301, 383–385, 461, 561

Students will use prewrite 
activites (graphic 
organizers) to plan, 
organize and draft a 
writing.

plan, organize, draft Reinforce

Modes of Writing

LA.6.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events in which the development and 
structure are appropriate to the task, 
purpose, and audience.

Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.3.a

a. Engage and orient the reader by 
establishing a context and introducing a 
narrator and/or character(s) and point 
of view; organize an event sequence 
that unfolds naturally and logically.

TE: 162A–162B, 164–165, 315, 552–554
Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.3.b

b. Use literary techniques (e.g. dialogue, 
pacing, description) to develop 
characters, events, settings, and 
conflicts.

TE: 121, 162A–162B, 166–167, 555–556
Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.3.c

c. Use a variety of transitional words and 
phrases to signal shifts from one 
character, time frame, or setting to 
another.

TE: 162A–162B, 557
Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.3.d

d. Use precise words and phrases, 
descriptive/ sensory details, and 
figurative language to express personal 
or narrative voice.

TE: 121, 162A–162B, 166–167, 558
Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.3.e
e. Provide a conclusion that is clearly 
related to and appropriately reflects on 
the literary experiences or events.

TE: 162A–162B, 168, 555, 558
Students will write 
narratives specific to task, 
purpose, and audience.

narrative, task, purpose, 
audience Introduce

LA.6.W.4
Write arguments that explain a 
perspective with supporting reasons 
and evidence.

Students will write an 
argumentive essay by 
developing a perspecitve 
using supporting reasons 
and evidence.

arguementive, 
perspective, reasons, 
evidence

Introduce



6

6th Grade
Seward Public 

Schools
A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goals Key Vocabulary Introduce/Reinforce/
Master

W
r
i
t
i
n
g

LA.6.W.4.a
a. Introduce a claim clearly and 
develop a structure in which the ideas 
are grouped logically.

TE: 82E, 84, 87, 374–377

Students will write an 
argumentive essay by 
developing a perspecitve 
using supporting reasons 
and evidence.

arguementive, 
perspective, reasons, 
evidence

Introduce

LA.6.W.4.b
b. Use relevant evidence from two or 
more credible sources.

TE: 87–88

Students will write an 
argumentive essay by 
developing a perspecitve 
using supporting reasons 
and evidence.

arguementive, 
perspective, reasons, 
evidence

Introduce

LA.6.W.4.c

c. Use words, phrases, and key 
vocabulary to clarify the relationship 
between claim(s) and supporting 
evidence.

TE: 88, 379

Students will write an 
argumentive essay by 
developing a perspecitve 
using supporting reasons 
and evidence.

arguementive, 
perspective, reasons, 
evidence

Introduce

LA.6.W.4.d
d. Provide a concluding statement or 
section that follows from the argument 
presented.

TE: 88, 191,380

Students will write an 
argumentive essay by 
developing a perspecitve 
using supporting reasons 
and evidence.

arguementive, 
perspective, reasons, 
evidence

Introduce

LA.6.W.5
Write informative/ explanatory pieces to 
examine a topic or text and clearly 
convey ideas and information.

Students will explain a 
topic or text in an 
informational writing piece.

informational Reinforce

LA.6.W.5.a

a. Introduce a topic clearly and provide 
a general focus, grouping information 
logically and including text features, 
illustrations, and/or multimedia 
elements.

TE: 41, 79, 84, 157, 294, 455–456
Students will explain a 
topic or text in an 
informational writing piece.

informational Reinforce

LA.6.W.5.b

b. Develop a topic with information (e.
g., facts, definitions, concrete details, 
quotations, examples) related to the 
topic.

TE: 41, 79, 84, 157, 292–293, 294, 339
Students will explain a 
topic or text in an 
informational writing piece.

informational Reinforce

LA.6.W.5.c
c. Use appropriate transitions and key 
vocabulary to clarify relationships 
among ideas and concepts.

TE: 157, 213, 295, 455
Students will explain a 
topic or text in an 
informational writing piece.

informational Reinforce

LA.6.W.5.d
d. Provide a concluding statement or 
section that follows from the information 
or explanation(s).

TE: 296, 458
Students will explain a 
topic or text in an 
informational writing piece.

informational Reinforce

LA.6.W.6

Gather and use credible evidence from 
trustworthy sources and assess its 
relevance in answering a research 
question.

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce
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LA.6.W.6.a
a. Paraphrase and quote evidence to 
support ideas while avoiding plagiarism.

TE: 41, 79, 290, 401, 449

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce

LA.6.W.6.b

b. Locate and evaluate credibility of 
evidence (e.g., motivation and/or 
potential bias of an information 
product) from print and digital sources 
to generate and answer questions and 
create new understandings.

TE: 178, 253, 269

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce

LA.6.W.6.c
c. Select and use appropriate note-
taking formats to collect and organize 
information.

TE: 41, 58, 79, 231

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce

LA.6.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and referencing sources in 
writing and speaking; provide a list of 
sources using a standard format.

TE: 79, 449

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce

S
p
e
a
k
i
n
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n
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LA.6.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Interactive Writing Lesson: Producing & Publishing with 
Technology:

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

evaluate, sources, 
relavancy Introduce

Comprehension and Collaboration

LA.6.SL.1
Prepare for and participate in structured 
discussions and collaborations about 6th 
grade topics and texts.

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce

LA.6.SL.1.a
a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

TE: 79, 191, 269

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce

LA.6.SL.1.b
b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

TE: 213, 300, 526

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce

LA.6.SL.1.c

c. Converse with diverse individuals in 
an all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

TE: 213, 231, 269

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce
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LA.6.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

TE: 57, 269, 339

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce

LA.6.SL.1.e e. Complete a task following multi-step 
directions.

TE: 191, 269, 401

Students will engage in 
collaborative 
conversations regarding 
the text.

discussion, 
collaboration, relevant Reinforce

Presentation of Knowledge and Ideas

LA.6.SL.2

Present claims and findings, sequencing 
ideas logically and using relevant 
descriptions, facts, and details to clarify 
themes or central ideas.

Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce

LA.6.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, adequate volume, 
clear pronunciation) for a variety of 
purposes and situations, including 
interpreting 6th grade texts.

TE: 15, 50, 79, 191, 299–300
Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce

LA.6.SL.2.b
b. Convey a perspective with clear 
reasoning and support.

TE: 79, 171–172, 191, 299–301
Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce

LA.6.SL.2.c
c. Analyze the purpose and credibility of 
information being presented.

TE: 253
Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce

LA.6.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, connotations, 
subtleties of language).

Interactive Speaking & Listening Lesson: Giving a 
Presentation: Knowing your audience

Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce

LA.6.SL.2.e
e. Use appropriate visual and/or digital 
tools to enhance verbal communication 
and add interest.

TE: 75, 78, 157, 162A, 191, 301
Students will present 
information to their peers 
regarding their reading.

sequence ideas, central 
ideas Reinforce



6th Reading

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit 1 Discovering your 
voice Weeks 1-6

Students will analyze text structure and identify 
author's purpose.(LA.6.RP.4)

None for Unit 
#1 From: Brown Girl Dreaming

Students will analyze a memoir and contrast it with 
other reading pieces.(LA.6.RP.7) Selection Test
Students will analyze informational texts and be able 
to distguish features.(LA.6.RI.4) The Changing Face of Self-Portraits
Students will identify and analyze print and graphic 
features(LA.6.RI.4) Selection Test
Students will analyze the author's language to 
determine mood and voice(LA.6.RP.3) What's so Funny, Mr. Scieszka?
Students will determine author's purpose and pioint of 
view and apply to a humorous story(LA.6.RP.1) Selection Test
Students will be able to analyze figurative language 
including, simile/metaphor/personification(LA.6.v.2) Poem:   A Voice Selection Test
Students will make inferences about tone and speaker 
and be able to justify those inferences.  (LA6.RP.6) Poem:  Words LIke Freedom Selection Test
Students will be able to trace and evaluate an 
argument and present to classmates(LA6.RP.6)

Better Than Words:   Say it WIth A 
Selfie Selection Test

Students will be able to determine author's purpose 
and defend their choice.(LA.6.RP.1) OMG, Not ANOTHER Selfie! Selection Test

CHOICES:   Short Stories UNIT TEST

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit #2-  Never Give 
Upv Weeks 7-13

Students will analyze features of informational text
(LA6.RI.4) I am Malala A Schoolgirl's Diary from I Am Malala
Students will generate questions to understand 
informational text(LA6.RI.6)

Esperanza 
Rising Selection Test

Students will analyze poetic forms(LA.6.RP.5) Out of My Mind
Speech to the Young:  Speech to the 
Progress-Toward

Students will identify various themes of texts through 
the use of inferences(LA6.RP.1) Selection Test
Students will analyze characters and plot of a short 
story(LA6.RP.2) The First Day of School
Students will analyze the setting of a short story(LA6.
RP.4) Selection Test



6th Reading

Students will analyze the characters and the plot of a 
graphic novel(LA6.RP.2) FROM New Kid Graphic Novel
Students will anaylze the setting and the theme of a 
graphic novel(LA.6.RP.4) Selection Test

CHOICES:   Short Story UNIT TEST

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit 3- FInding Courage Weeks 14-18
Students will analyze characters and plot of a novel 
excerpt(LA6. RP.2) Wonder

The Breadwinner (excerpt from the 
Novel)

Students will analyze character and setting of a novel
(LA6.Rp.4) Selection Test
Students will identify the speaker's voice/author's 
perspective.(LA.6.RP3) Poem:  Life Doesn't Frighten Me
Students will practice point of view from first person
(LA6. RP.3)
Students will analyze poetry through discovery of 
repetition and refrain(LA6.RP.8) Selection Test
Students will analyze structure of an informational text
(LA6.RI.4) Fears and Phobias
Students will cite evidence of informational text(LA6.
RI.3)
Students will analyze organizational text through 
cause and effect(LA6.RP4)
Students will determine and summarize text's central 
idea(LA6.RP.2) Selection Test
Students will analyze media through visual and sound 
elecments(LA.6.RP8) VIDEO:  Wired for Fear Selection Test
Students will analyze text structure of an informational 
text(LA6.RI.4) Embarassed?   Blame Your Brain
Students will determine the meanings of figurative, 
connotative and technical features of an informational 
text(LA6. RI.4) Selection Test
Students will analyze the characters of a short story
(LA6.RP.2) The Ravine
Students will identify inferences in a short story(LA6.
RP.6) Selection Test
Students will analyze text structure of informational 
texts through a graphic biography(LA6.RI4) Graphic Biography--from Into the Air
Students will determine the central idea of a graphic 
biography(LA6.RI.8) Selection Test



6th Reading

Students will analyze structure of informational text 
through a biography(LA6.RI.4)

Biography--from The Wrigth Brothers:  
How They Invented the Airplane

Students will identify key ideas of a biography(LA6.
RP.8) Selection Test

CHOICES:   Short Stories Unit Test

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit 4--Through An 
Animal's Eyes Week 15-20

Students will analyze the point of view from a novel
(LA6.RP1)

Primates:   The 
Fearless 
Science of Jane 
Goodall From the Novel:   Pax Selection Test

Students will analyze the point of view from a novel
(LA6.RP1)

A Dog's 
Purpose

Students will infer theme in a Science Fiction Passage
(LA6.RP.6) Zoo by Edward Hoch
Students will analyze point of view in a Science Fiction 
passage(LA6.RP6) Selection Test
Students will analyze text structure of an informational 
text (including ideas and supporting 
details/chronological order/caus and effect/compare 
and contrast/problem and solution)(LA6.RI.4)

From Animal Snoops:  The Wondrous 
World of Wildlife Spies

Students will analyze central ideas of informational 
text(LA6.RI.6) Selection Test
Students will identify figurative language, 
personifciation and imagery within a poem(LA6.RP4) Poem:  Animal Wisdom Selection Test
Students will monitor comprehension through 
paraphrasing(LA6.RP.6) Poem:  The Last Wolf Selection Test
Students will analyze written arguments through 
making a claim(LA6.RP.3) Wild Animals Aren't Pets Selection Test
Students will identify deductive and inductive 
reasoning of a written argument(LA6.RP5)
Sutdetns will evaluate written arguments by citing 
facts and opinions(LA6.RP.5) Let People own Exotic Animals Selection Test

CHOICES:   Short Stories Unit Test

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit 5 Surviving the 
Unthinkable Week of 21-28

Students will analyze the setting and characters of a 
novel(LA6.RP.4) From A Long Walk to Water



6th Reading

Students will analyze a novels structure including 
flashbacks and foreshadowing(LA6.RP.4) Selection Test
Students will integrate information from media through 
comparing and contrasting(LA6.RP.5) Salva's Story Selection Test
Students will identify author's point of view including 
subjective and objective points of view(LA.6.RP.1) Memoir:  Into the Lifeboat from Titanic
Students will identify word choice that help create a 
vivid picture/imagery(LA6.RP.3) Selection Test
Students will identify and apply figurative language 
within a poem(LA6.RP.3) Poem:   from After the Hurricane
Students will identify poetice devices such as word 
choice, repetition, alliteration, rhythm(LA6.RP.3) Selection Test
Students will analyze the effect a setting has on the 
plot(LA6.RP.2) from Ninth Ward
Students will analyze and identify the mood of a novel
(LA6.Rp.1) Selection Test

CHOICE:   Short Story Unit Test

Unit/GENRE/THEME Pacing Learning Goals 
Possible 
Novels Supporting Into Literature Materials Assessment

Unit 6 Hidden Truth Students will analyze informational text(LA6.RI.6) From Storytelling 
Students will identify and analyze central ideas (LA6.
RI.5) Selection Test
Students will analyze the elements of drama (including 
playwright, scenes, stage directions, dialogue) (LA6.
RP.5)

The Prince and the Pauper--a 
dramatization

Students will identify the theme of a dramatization(LA.
6.RP.2) Selection Test
Students will analyze poetic forms (to include free 
verse, stanzas, sonnet, end rhymes, meter, internal 
rhyme, and alliteration) (LA6.RP.8) POEM:   Archetype Selection Test
Students will analyze allusions (LA6.RP.3) POEM:  Fairy-tale Logic Selection Test
Students will analyze the plot of a folktale(LA6.RP.2) Folktale Retold:   The Boatman's Flute
Students will identify and explain who the narrator and 
point of view(LA6.RP.3) Selection Test
Students will identify the theme of a folktale throught 
inferencing(LA.6.RP.2) Folktale Retold:  The Mouse Bride
Studetns will analyze the author's purpose of a folktale 
(LA6.RP.2)
Students will identify plot elements of a folktale(LA6.
RP.2) Selection Test



6th Reading

CHOICE:  Short Stories Unit Test



6th Writing

Unit/GENRE/THE
ME Pacing Learning Goals Process Writing Assessment Standards
Informative / 
Explanatory 
(Descriptive) Weeks 1 pre-assessment for descriptive writing Independently written descriptive writing

write a baseline 
descriptive writing

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.5a-d

Outdoor 
Education Thank 
You's Week 2-3

1.  Students will utilize the elements of a 
friendly letter to write two thank you letters 
to counselors or session teachers from 
Outdoor Ed. Friendly letter formatting: date, greeting, body of the letter, closing & signature

write two thank-you's 
for Outdoor Ed 
utilizing the friendly 
letter format

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.SL.2d

Narrative 
(Imaginative / 
descriptive) Week 4-8

 1. Students will write an imaginative 
narrative to convey imagined experiences 
or events.  2. Students will utilze the 
elements of a narrative writing (beginning, 
middle, & end, narrative transitions, 
character development) when writing their 
own imaginative narrative.  3. Students will 
review and utilze the writing process 
(prewrite, plan, draft, revise, edit, final 
copy, proofread, share/publish).  4. 
Students will use speaking & listening skills 
to present their project to others.

Review: narrative transitions, generating ideas, planning & 
developing characters, CUPS (Capitalization, Usage, punctuation, 
spelling), steps to writing process (prewrite, plan, draft, revise, edit, 
final copy, proofread, share/publish), organization, paragraphing, 
intro./ middle/ conclusion, powerful & precise words (PP-word 
choice) & sharing/ presenting the project

Write a retelling of a 
story changing the 
setting while keeping 
the main events the 
same (adaptations to 
any story)

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.3a-e, 
LA.6.SL.1a-d, 
LA.6.SL.2a

Poem 
(descriptive) Week 7-9

1. Students will use free verse or rhyming 
lines / syllables to write a poem.  2.  
Students will utilize / focus on word choice 
to write their descriptive poem. 3. Students 
will utilize the writing process (prewrite, 
plan, draft, revise, edit, final copy, 
proofread, share/publish).  4. Students will 
use speaking & listening skills to present 
their project to others.

Descriptive: show vs. tell, using meaningful word choice (powerful & 
precise words), strong precise verbs, formatting of a 10 line poem, 
sharing/ presenting the project

Write a ten line poem 
using powerful & 
precise words (PP) & 
strong verbs (word 
choice) while using 
showing details 
instead of telling 
details

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.SL.1a-d, 
LA.6.SL.2a

Narrative 
(Imaginative) Week 10-13

1. Students will write an imaginative 
narrative to convey real or imagined 
experiences or events.  2. Students will 
utilize figurative language and the elements 
of a narrative writing when writing their own 
imaginative narrative. 3. Students will 
utilize the writing process (prewrite, plan, 
draft, revise, edit, final copy, proofread, 
share/publish).  4. Students will use 
speaking & listening skills to present their 
project to others.

Narrative: story elements, generating ideas, planning & developing 
characters, how to begin a narrative, showing vs. telling details 
(word choice), figurative language (alliteration, personification, 
simile, metaphor, onomatopoeia, hyperbole), ideas, organization & 
structure of a narrative, beginnings & endings for narrative writings 
(options for endings) & sharing/ presenting the project

Write a story using as 
much alliteration with 
your main character 
as possible, while also 
including two other 
types of figurative 
language

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.3a-e, 
LA.6.SL.1a-d, 
LA.6.SL.2a

Informative / 
Explanatory 
(Descriptive) by 
writing a parody 
for a song Week 14-15

1. Students will use informative / 
explanatory elements to to develop a topic 
with information. 2. Students will utilize 
powerful & precise word choice, ideas 
development, and sentence / line fluency to 
write a parody to a song. 3. Students will 
utilize the writing process (prewrite, plan, 
draft, revise, edit, final copy, proofread, 
share/publish). 4. Students will use 
speaking & listening skills to present their 
project to others.

using powerful & precise words (PP-word choice), transitions for 
different purposes, idea development, sentence / line fluency 
(rhyming, syllables, etc) & presentation elements (voice, actions, 
prompts, etc.)

Analyze a holiday 
song and rewrite your 
own version of it using 
a new subject / theme 
(parody)

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.6a-e,
LA.6.SL.1a-d, 
LA.6.SL.2a



6th Writing

Informative / 
Explanatory 
(Descriptive) 
Analytic Week 16-19

1. Students will use informative / 
explanatory elements to clearly convey 
ideas and information in a five paragraph 
essay. 2. Students will use descriptive 
elements (lead, elaboration, transitions, 
conclusion statement, etc.) to write a five 
paragraph essay responding to a prompt. 
3. Students will utilize the writing process 
(prewrite, plan, draft, revise, edit, final 
copy, proofread, share/publish).

Descriptive: planning outline, leading with blues, elaboration of 
details, transitions sets & variety, successful conclusions, sentence 
variety; Review / revisit: writing process & plan sheets, formatting a 
descriptive writing (hook / lead, topic sentences, plan sentence, 
challenge or clincher statement), analyzing a prompt to restate & 
writing a five paragraph essay to a specific prompts

Write a five paragraph 
descriptive essay 
using elements 
discussed throughout 
the semester, district 
writing test: writing 
utilizing a descriptive 
prompt 

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.6a-e

Text Dependent 
Analysis (TDA) Week 20-22

1. Students will respond to a question in 
paragraph form. 2. Students will use cited 
evidence from text / article (paraphrases & 
quotes) while avoiding plagiarism. 3. 
Students will utilize the writing process 
(prewrite, plan, draft, revise, edit, final 
copy, proofread, share/publish).

Use a graphic organizer / outline to help students create a response 
to a text question (restate, answer, cite & explain text evidence & 
restate the answer & question) & rewriting the response in 
paragraph form

Write a response to a 
question utilizing text 
dependent analysis 
(restating the 
question, answer to 
the question, citing & 
explaining evidence & 
restating the answer & 
question)

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.6a-c & 
e

Letters: 
Persuasive / 
Argumentative 
Writing (Making a 
Claim) Week 23--25

1. Students will utilize persuasive / 
argumentative elements to write a letter. 2. 
Students will develop a claim, supporting 
reason and use relevant evidence from two 
or more credible sources.  3. Students will 
utilize the writing process (prewrite, plan, 
draft, revise, edit, final copy, proofread, 
share/publish). 4. Students will use 
speaking & listening skills to present their 
project to others.

Persuasive / Argumentative: establishing a claim, color coding 
elements, organizing, clarifying ideas & prioritizing / editing / 
sequencing, focusing on the audience, facts vs. opinions, 
elaboration of an argument, transitions, conclusions to support a 
claim, word choice, voice & sharing/ presenting the project

Write a persuasive / 
argumentative letter to 
someone stating 
reasons why you 
should ... (be allowed 
to do something, buy 
something, etc.)

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.4a-d, 
LA.6.SL.1a-d, 
LA.6.SL.2a-b & 
d

Research / 
Narrative / Diary 
or Journal Writing 
(analyzing things 
from an animal's 
perspective while 
giving facts about 
this creature) Week 25-30

1. Students will utilize narrative elements to 
write a diary / journal from an animal's 
perspective. 2. Students will research facts 
from at least two credible sources to use 
within their animal's diary / journal. 3. 
Students will utilize the writing process 
(prewrite, plan, draft, revise, edit, final 
copy, proofread, share/publish). 4. 
Students will use speaking & listening skills 
to present their project to others.

Narrative: sequencing events, elaborating on description, qualities 
of a good narrative / diary / journal (elements), revising verbs; voice 
of the charter, writing from another persons perspective / point of 
view (animal), researching facts using credible sources, 
presentation elements (voice, fluency, etc.), sharing & publishing 
their book

Create a five day diary 
of an animal: including 
five entries & five 
interesting facts you 
researched about you 
animal from at least 
two credible sources

LA.6.W.1a-g, 
LA.6.W.2a-e, 
LA.6.W.3a-e, 
LA.6.W.6a-e, 
LA.6.SL.1a-e, 
LA.6.SL.2a, c & 
e

Pacing Learning Goals Grammar Greek and Latin Roots Assessment Standards



6th Writing

Week 1-2

Students will be able 
to identify the parts of 
a complete sentence.

Into. Literature - Module 1: Sentence or 
Sentence Fragment?, Run-On Sentences, 
The Subject, Complete Subjects and 
Simple Subjects, The Predicate, Complete 
Predicates and Simple Predicates, The 
Verb Phrase Compound Subjects and 
Compound Verbs, Simple Sentences and 
Compound Sentences & Kinds of 
Sentences

Growing Your Vocabulary: Learning from Latin and Greek Roots - 
Chapter 1: Roots gen, gener Teacher Graded Test

All Grammar & 
Vocab. lesson 
utilize 
standards:  LA.
6.V. 1a-c & LA.
6.W.1a-g

Week 3-4

Students will be able 
to identify parts of 
speech.

Module 2: Nouns, Pronouns, 
Demonstrative and Relative Pronouns, 
Adjectives & Proper and Demonstrative 
Adjectives Chapter 2: Roots viv, mor/mort Teacher Graded Test

Week 5-6

Students will be able 
to identify parts of 
speech.

Module 3: The Verb, Transitive and 
Intransitive Verbs, Linking Verbs, Helping 
Verbs, The Adverb, The Preposition, The 
Prepositional Phrase, Conjunctions and 
Interjections & Determining Parts of 
Speech Chapter 3: Roots card, derm, hem/em, nat Teacher Graded Test

Week 7-8

Students will be able 
to identify a 
prepositional phrase 
and determine how it 
is used. 

Module 4: Prepositional Phrases, 
Adjectives Phrases & Adverb Phrases Chapter 4: Roots lumin, luc, phot Teacher Graded Test

Week 9-10

Students will be able 
to identify 
complements within a 
sentence.

Module 5: Recognizing Complements, 
Direct Objects, Indirect Objects, Subject 
Complements, Predicate Nominatives & 
Predicate Adjectives Chapter 5: Roots ject, mob, mot/mov Teacher Graded Test

Week 11-12

Students will be able 
to identify agreement 
within sentences.

Module 6:  Number, Subject-Verb 
Agreement, Phrases Between Subject and 
Verb, Agreement with Indefinite Pronouns, 
Other Problems in Agreement & 
Agreement with Don't & Doesn't Chapter 6: Roots grav, pend/pens Teacher Graded Test

Week 13-14

Students will be able 
to identify and use 
verbs and irregular 
verbs correctly within 
a sentence.

Module 7: Principal Parts of Verbs, Regular 
Verbs, Irregular Verbs, Tense, Sit and Set, 
Rise and Raise, Lie and Lay Chapter 7: Roots lev, alt Teacher Graded Test

Week 15-16

Students will be able 
to the different types 
of pronouns within a 
sentence.

Module 8: The Forms of Personal 
Pronouns, The Subject Form, The Object 
Form & Special Pronoun Problems Chapter 8: Roots capt, cept, cip Teacher Graded Test

Week 17-18

Students will be able 
to identify and use 
modifiers correctly 
within a sentence.

Module 9: Regular Comparison of 
Adjectives and Adverbs, Irregular 
Comparison of Adjectives and Adverbs, 
Using Good and Well, Modifiers After 
Linking Verbs & Double Comparisons and 
Double Negatives Chapter 9: Roots ter, ten/tin, trit Teacher Graded Test



6th Writing

Week 19-20

Students will be able 
to identify and use 
the correct usage of 
words within a 
sentence.

Module 10:  A, An / At, Between Among / 
How Come, Its It's / Than Then, That There 
/ Your You're Chapter 10: Roots hom, anthropo, andro Teacher Graded Test

Week 21-22

Students will be able 
to identify and use 
correct capitalization 
within a sentence.

Module 11: The Pronouns I, Proper Nouns 
and Abbreviations, Places and People, 
Groups, Organizations and Religions, 
Objects, Events, Structures and Awards, 
Titles, First Words, Proper Adjectives, 
School Subjects Chapter 11: Roots art, orn, apt/ept Teacher Graded Test

Week 23-24

Students will be able 
to identify and use 
the correct 
punctuation within a 
sentence.

Module 12: End Marks and Abbreviations, 
Commas in a Series, Commas with 
Compound Sentences, Commas with 
Sentence Interrupters, Commas in 
COnventional Situations, Semicolons and 
Colons Chapter 12: Roots dict, log Teacher Graded Test

Week 25-26

Students will be able 
to identify and use 
the correct 
punctuation within a 
sentence.

Module 13: Italics (Underlining), Quotation 
Marks, Apostrophes & Other Uses of 
Apostrophes Chapter 13: Roots roga, quer/quist Teacher Graded Test

Week 27-28

Students will be able 
to apply and correctly 
use spelling rules 
within a sentence.

Module 14: The Dictionary, Spelling Rules, 
Prefixes and Suffixes & Plurals of Nouns Chapter 14: Roots arch, pot Teacher Graded Test

Week 29-30

Students will be able 
to review grammar 
skills used throughout 
the year.

Finish up Modules that may not be finished 
& / or review grammar skills if needed Chapter 15: Roots leg, jus/jur Teacher Graded Test
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master
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Central Ideas and Details

LA.7.RP.1

Determine two or more implied or 
explicit themes in a literary text and how 
they are supported with key details.

TE: 16, 33–36, 38, 47, 48, 52, 113, 118, 125, 127, 130, 213, 215, 
218, 219, 232,261, 264, 317, 321, 514

Students will find the  
themes of a literary text.

implied, explicit, themes, 
literary text reinforce 

LA.7.RP.2

Analyze how particular events, lines of 
dialogue, or descriptive details develop 
the plot, reveal aspects of characters, 
or create meaning.

TE: 5, 8, 9, 12, 13, 16, 38, 62, 70, 71, 73, 74, 75, 78, 101, 103, 
104, 108, 117,120, 133, 136, 138, 146, 148, 168, 170, 171, 172, 
176, 216, 234, 401, 405, 408,481, 484, 485, 486

Students will analyze 
literary elements in a story. 

plot, dialogue, 
characterization, 
descriptive details reinforce 

Author's Craft

LA.7.RP.3

Analyze how an author establishes, 
conveys, and contrasts the points of 
view of different characters or narrators 
in a literary text.

TE: 58, 59, 60, 61, 65, 73, 78, 79, 105, 120, 144, 221, 230, 233, 
234, 403, 405,406, 411, 414, 449

Students will analyze how 
an author uses point of 
view in a story. 

point of view, characters, 
narrator reinforce 

LA.7.RP.4

Analyze the structure of a literary text, 
and how the structure contributes to its 
theme(s) and meaning.

TE: 16, 33–36, 38, 47, 48, 52, 113, 118, 125, 127, 130, 213, 215, 
218, 219, 232

Students will analyze the 
structure of a literary text 
and how it helps the 
theme. text structures, theme reinforce 

Knowledge and Ideas

LA.7.RP.5

Compare and contrast a fictional 
portrayal of a time, place, or character 
and a historical account of the same 
period. TE: 56, 82–83, 518, 520, 533, 548–549

Students will compare and 
contrast paired fictional 
and a historical account of 
the same time period. 

fiction, historical 
account, compare and 

contrast introduce/reinforce 

LA.7.RP.6

Synthesize the implied or stated theme
(s) in a literary text to draw conclusions 
and deepen understanding of self and 
others. TE: 11, 48, 52, 117, 118, 120, 264

Students will state the 
theme and be able to 
relate it to themselves and 
others.  theme, text connections reinforce

LA.7.RP.7

Compare and contrast regional, 
national, and/or multicultural 
perspectives by explaining how an 
author or narrator/speaker introduces, 
illustrates, or describes characters or 
individuals, events, and ideas within and 
across literary texts. TE: 78, 82–83

Students will be able to 
make connections to a 
variety to different texts. 

compare and contrast, 
text connections, 

perspectives reinforce

Range of Reading and Level of 
Text Complexity

LA.7.RP.8

Read and comprehend a wide range 
of literary texts of appropriate 
complexity for the 6-8 grade band 
proficiently, with scaffolding as needed 
at the high end of the range.

TE: 7–14, 60–68, 115–188, 135–146, 170–174, 215–232, 319–
322, 457–458,483-489

Students will be able to 
read and comprehend 
grade-appropriate texts.

comprehend, grade-
appropriate text reinforce/master 
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Central Ideas and Details
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Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

R
e
a
d
i
n
g
 
I
n
f
o
r

m
a
t
i
o
n
a
l
 
T
e
x
t

LA.7.RI.1

Determine two or more implied or 
explicit central ideas of an informational 
text and how they are supported with 
key details.

TE: 21, 24, 153, 156, 158, 162, 188, 239, 243, 417, 429, 434, 
436, 520, 523,525

Students will find the 
central idea(s) of an 
informational text. central idea, key details reinforce 

LA.7.RI.2

Analyze the relationships and 
interactions between individuals, 
events, and/or ideas or concepts, 
drawing on specific supporting details in 
an informational text.

TE: 23–26, 115–118, 155–160, 183–187, 241–244, 253–254, 
276–280, 286–290, 331–334, 497–500, 506–508, 522–526

Students will be able use 
text evidence to analyze 
the relationships and 
interactions in an 
informational text.  

text evidence, 
informational text, 
supporting details reinforce 

Author's Craft

LA.7.RI.3

Analyze how an author establishes or 
conveys a perspective or purpose and 
distinguishes it from that of others. TE: 125, 251, 256, 329, 336, 362, 419, 426

Students will analyze 
author's purpose and how 
they establish it. 

author's purpose, 
persuasive, 

informational, 
explanatory reinforce 

LA.7.RI.4

Analyze how the major sections of text 
contribute to the development of ideas 
in an informational text.

TE: 21, 28, 153, 162, 181, 188, 234, 239, 246, 256, 269, 270, 
419, 426, 431,438, 520, 528

Students will analyze 
major secttions of a text 
and how they add to the 
text. 

major sections, 
paragraphs reinfoce 

Knowledge and Ideas

LA.7.RI.5

Compare and contrast how two or 
more authors provide conflicting 
information on the same topic, 
including where the texts disagree on 
matters of evidence or interpretation. TE: 153, 156, 158, 160, 162, 244, 256

Students will compare and 
contrast paired texts with 
opposing views. 

compare and contrast, 
conflicting views introduce 

LA.7.RI.6

Analyze the development of an 
argument and identify the type(s) of 
reasoning used to support the 
argument. TE: 251, 274, 276, 278, 286, 287, 329, 334

Students will analyze an 
argument and find the 
reasons that support the 
argument. 

argument, reasoning, 
suppor of an argument introduce 

LA.7.RI.7

Compare and contrast regional, 
national, and/or multicultural 
perspectives by explaining how an 
author or narrator/speaker introduces, 
illustrates, or describes characters or 
individuals, events, and ideas within and 
across informational texts. TE: 184, 188, 192, 296

Students will compare and 
contrast perspectives and 
make text connections 
across a range of 
informational texts. 

compare and contrast, 
perspectives, text 

connections, 
informational text reinforce

Range of Reading and Level of 
Text Complexity

LA.7.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity for the 6-8 grade band 
proficiently, with scaffolding as needed 
at the high end of the range. TE: 23–26, 84, 298–299

Students will be able to 
read and comprehend 
grade-appropriate texts.

comprehend, grade-
appropriate text reinforce/master 
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a
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Acquisition and Use

LA.7.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Students will use grade-
level academic vocabulary 
appropriately. grade-level vocabulary reinfoce/master

LA.7.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

TE: 6, 18, 22, 30, 34, 40, 59, 80, 102, 110, 114, 122, 134, 150, 
154, 164, 169, 178,182, 186, 190, 214, 236, 240, 248, 252, 258, 
275, 284, 294, 318, 326, 330, 338, 342,350, 402, 414, 418, 426, 
432, 440, 482, 492, 496, 504, 521, 530, 534, 546

Students will use grade-
level academic vocabulary 
appropriately. grade-level vocabulary reinfoce/master

LA.7.V.1.b

b. Use commonly occurring Greek and 
Latin affixes and roots to determine the 
meanings of words (e.g., audience, 
audible). TE: 18, 110, 122, 143, 150, 151, 217, 236, 248, 414, 524, 530

Students will use grade-
level academic vocabulary 
appropriately. grade-level vocabulary reinfoce/master

LA.7.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, or parts of speech of 
words. TE: 24, 30, 40, 294, 440, 492

Students will use grade-
level academic vocabulary 
appropriately. grade-level vocabulary reinfoce/master

Context and Connotations

LA.7.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Students will understand 
the way authors use 

words. 

figurative, connotative, 
technical, literary, 

biblical, mythological 
allusions Reinforce

LA.7.V.2.a

a. Interpret figures of speech (e.g., 
literary, biblical, or mythological 
allusions) in context. TE: 341, 350, 362, 374, 445, 516, 518

Students will understand 
the way authors use 

words. 

figurative, connotative, 
technical, literary, 

biblical, mythological 
allusions Reinforce

LA.7.V.2.b

b. Determine the relationship between 
words (e.g., cause/effect, part/whole, 
item/category).

TE: 30, 40, 80, 164, 190, 258, 284, 294, 326, 338, 428, 440, 491, 
546

Students will understand 
the way authors use 

words. 

figurative, connotative, 
technical, literary, 

biblical, mythological 
allusions Reinforce

LA.7.V.2.c

c. Distinguish between the connotations 
of words with similar denotations (e.g., 
polite, diplomatic). TE: 125, 158, 164, 192, 284, 350

Students will understand 
the way authors use 

words. 

figurative, connotative, 
technical, literary, 

biblical, mythological 
allusions Reinforce

Production of Writing

LA.7.W.1

Create grammatically correct multi-
paragraph compositions with varied 
sentence structures.

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

Sentence structure, 
paragraph structure Reinforce
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LA.7.W.1.a

a. Apply knowledge of rules for 
capitalization.

TE: 94, 179, 249

Students will follow 
capitalization rules when 
writing. Capitalization Reinforce

LA.7.W.1.b

b. Use a comma to separate 
coordinate adjectives.

TE: 123, 505

Students will use commas 
to separate coordinate 
adjectives Coordinate, adjectives Introduce

LA.7.W.1.c

c. Distinguish between and use types of 
clauses (e.g., noun, relative, adverbial), 
modifiers (e.g., misplaced and 
dangling), and adjectives (coordinate 
and cumulative). TE: 111, 237, 427

Students will Identify 
differences in types of 
clauses, modifiers, and 
adjectives

-Noun, relative, adverbial 
clauses, misplaced and 

dangling modifiers, 
coordinate and 

cumulative adjectives Introduce

LA.7.W.1.d

d. Use a variety of prepositional and 
appositive phrases in sentences and 
paragraphs. TE: 31, 41, 259, 429, 531, 547

Create sentences  and 
paragraphs with 
prepositional and 
appositive phrases

prepositions, 
prepositional phrases, 

appositive phrase Reinforce

LA.7.W.1.e

e. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tenses. TE: 204, 327, 339, 547

Students will identify and 
revise fragment and run-
on sentences and incorret 
verb tense.

fragment, run-on, verb 
tense Reinforce

LA.7.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Students will draft, revise 
and edit writing for various 
situations 

Recursive, writing 
process, audience, 
purpose, discipline Reinforce

LA.7.W.2.a

a. Use prewriting activities and inquiry 
tools to plan, organize, and draft writing.

TE: 88–91, 197–201, 300–305, 391–393, 469–471, 555–557

Students will complete 
prewriting activities 
(graphic organizer, 
discussions, webs) to plan, 
organize and draft.

prewrite, plan, organize, 
draft Reinforce

LA.7.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity. TE: 86–94, 196–204, 300–308, 391–393, 466–474, 555–557

Students will create writing 
pieces that increase in 
length and complexity.

writing process, sustain, 
engagement, complexity Reinforce

LA.7.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers. TE: 92–93, 202–204, 206–208, 294–295, 472–473, 558–559

Students will revise their 
writing with consideration 
to peer and adult feedback

feedback, revising 
(ARMS) Reinforce

LA.7.W.2.d

d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

TE: 93–94, 203–204, 294–295, 307–308, 395–396, 473–474, 
559–560

Students will edit and 
proofread their writing with 
consideration to peer and 
adult feedback

Editing (CUPS), 
proofreading, feedback Reinforce
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LA.7.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers. TE: 94, 204, 308, 396, 474, 560

Students will use print and 
a word processing tools to 
share/publsih their work.

produce, enhance, 
publish Reinforce

Modes of Writing

LA.7.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events in which the development and 
structure are appropriate to the task, 
purpose, and audience.

Students will write 
narratives specific to task, 
purpose, and audience. 

Development, structure, 
purpose, audience Reinforce

LA.7.W.3.a

a. Engage and orient the reader by 
establishing a context and introducing a 
narrator and/or character(s), 
establishing and maintaining a point of 
view, and organizing an event 
sequence that unfolds naturally and 
logically. TE: 95, 271, 293, 311, 373, 415, 466–474, 509, 517, 545, 563

Students will organize a 
narrative that introduces 
characters and maintains 
a point of view. 

narrator, point of view, 
sequence Reinforce

LA.7.W.3.b

b. Use literary techniques (e.g., 
dialogue, pacing, description) to 
develop characters, events, settings, 
and conflicts. TE: 95, 271, 293, 311, 373, 415, 466–474, 509, 517, 545, 563

Students will use dialogue, 
pacing, and description to 
develop their naratives

dialogue, pacing, 
description Reinforce

LA.7.W.3.c

c. Use a variety of transitional words and 
phrases to signal shifts from one 
character, time frame, or setting to 
another.

TE: 81, 87, 89, 92, 197, 199, 202, 301, 303, 305, 306, 308, 389, 
391, 467, 472,529, 553, 558

Students will incorporate 
transitions within their 
naratives transition Reinforce

LA.7.W.3.d

d. Use precise words and phrases, 
descriptive/sensory details, and 
figurative language to express personal 
or narrative voice. TE: 293, 466–474

Students will use sensory 
details, figurative 
language, and precise 
words to express their 
voice. 

sensory details, 
figurative language, 

precise words Reinforce

LA.7.W.3.e

e. Provide a conclusion that is clearly 
related to and appropriately reflects on 
the literary experiences or events. TE: 467, 472

Students will write an 
appropirate conclusion for 
their narrative. conclusion Reinforce

LA.7.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Students will develop a 
perspective with 
supportive reasons to write 
an argument. 

argument, perspective, 
evidence Introduce/Reinforce

LA.7.W.4.a

a. Develop a structure to sequence 
ideas appropriately; introduce a clear 
claim where appropriate. TE: 300–308, 337, 388–396, 475

Students will indtroduce a 
claim and sequence their 
ideas claim, sequence Introduce/Reinforce
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LA.7.W.4.b

b. Explain and cite relevant evidence 
from multiple credible sources.

TE: 300–308, 337, 388–396, 475

Students will cite and 
explain evidence from 
multiple credible sources

evidence, credible 
source Introduce/Reinforce

LA.7.W.4.c

c. Use words, phrases, and key 
vocabulary to create cohesion and 
clarify the relationship between claim(s) 
and supporting evidence. TE: 259, 391, 429, 441, 505, 558

Students will clarify the 
relationship between claim
(s) and supporting 
evidence

claim, supporting 
evidence Reinforce

LA.7.W.4.d

d. Provide a concluding statement or 
section that follows from and supports 
the argument(s) presented. TE: 303, 306, 391, 394, 397, 475

Students will write a 
conlcusion that supports 
their argument conclusion, argument Reinforce

LA.7.W.5

Write informative/ explanatory pieces to 
examine a topic or text and clearly 
convey ideas and information.

Students will explain a 
topic or text in an 
informational writing piece. 

informative, explanatory, 
convey, examine Reinforce

LA.7.W.5.a

a. Introduce a topic clearly and provide 
a specific focus, grouping information 
logically and including text features, 
illustrations, and/or multimedia 
elements. TE: 87, 89, 92, 198, 199, 200, 202, 203

Students will write a 
focused and organized 
informative writing with 
text features. Focused, text features Reinforce

LA.7.W.5.b

b. Develop a topic with information (e.
g., facts, definitions, concrete details, 
quotations, examples) related to the 
topic. TE: 90, 92, 198, 304, 392

Students will incorporate 
facts, definitions, 
quotations, and examples 

facts, quotations, 
examples Reinforce

LA.7.W.5.c

c. Use appropriate transitions and key 
vocabulary to clarify relationships 
among ideas and concepts. TE: 87, 92, 197, 199, 202, 301, 305, 306

Students will use 
transitions to clarify their 
writing transitions Reinforce

LA.7.W.5.d

d. Provide a concluding statement or 
section that follows from the information 
or explanation(s). TE: 303, 306, 394

Students will provide a 
conclustion for their 
informational writing conclusion Reinforce

LA.7.W.6

Gather and use credible evidence from 
multiple trustworthy sources and assess 
its relevance in answering the research 
question.

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

credible, evicence, 
source, relevance Reinforce

LA.7.W.6.a

a. Integrate evidence into writing by 
quoting or paraphrasing data and 
conclusions while avoiding plagiarism. TE: 552–560

Students will avoid 
plagiarism by quoting and 
paraphrasing correctly

quote, paraphrase, 
plagiarism Reinforce
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LA.7.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., motivation and/or 
potential bias of an information 
product) from print and digital sources 
to generate and answer questions and 
create new understandings. TE: 552–560

Students will be able to 
locate and evauluate the 
credibility of evidence from 
digital and print  sources to 
understand the 
informationand answer 
questions

bias, evaluate credibility 
of sources Reinforce

LA.7.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information. TE: 552–560

Students will use note 
taking formats to collect 
and organize information

note-taking, collect, 
organize Reinforce

LA.7.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and citing sources within text (e.
g., parenthetical and numerical); 
provide a list of sources using a 
standard format. TE: 88, 89, 198, 304, 552–560

Students will avoid 
overreliance on any one 
source while citing sources 
within the text and provide 
a list of sources 

in-text citation 
(parenthetical and 

numerical) Reinforce/Introduce

S
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LA.7.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives). TE: 94, 204

Students will practice safe 
and ethical behavoirs 
when using digital 
communidcation ethical Reinforce

Comprehension and Collaboration

LA.7.SL.1

Prepare for and participate in structured 
discussions and collaborations about 7th 
grade topics and texts.

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce

LA.7.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information. TE: 193, 271, 325, 425, 509, 517, 561–562

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce

LA.7.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation. TE: 271, 325, 425, 509, 517, 561–562

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce

LA.7.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

TE: 14, 26, 37, 48, 51, 68, 77, 100, 107, 119, 128, 146, 160, 174, 
187, 206, 232,245, 254, 265, 271, 280, 290, 322, 325, 334, 346, 
356, 366, 371, 410, 423, 425,437, 450, 459, 489, 500, 509, 515, 
517, 526, 542, 561–562

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce

LA.7.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning). TE: 100, 193, 206, 271, 325, 425, 509, 517, 561–562

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce
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LA.7.SL.1.e

e. Complete a task following multi-step 
directions.

TE: 39, 121, 149, 163, 193, 247, 257, 283, 297, 349, 385

Students will engage in 
collaborative 
conversations regarding 
the text.

Structured, collaboration,  
clarify ideas Reinforce

Presentation of Knowledge and Ideas

LA.7.SL.2

Present claims and findings, 
emphasizing key ideas in a focused, 
coherent manner with relevant 
descriptions, facts, details, and 
examples to clarify themes or central 
ideas.

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce

LA.7.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, adequate volume, 
clear pronunciation) for a variety of 
purposes and situations, including 
interpreting 7th grade texts.

TE: 55, 83, 85, 195, 205–206, 247, 299, 375, 385, 387, 439, 453, 
463, 465, 517,551, 562

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce

LA.7.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

TE: 55, 83, 85, 195, 205–206, 247, 299, 375, 385, 387, 439, 453, 
463, 465, 517,551, 562

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce

LA.7.SL.2.c

c. Analyze the purpose and credibility of 
information being presented.

TE: 55, 83, 85, 195, 205–206, 247, 299, 375, 385, 387, 439, 453, 
463, 465, 517,551, 562

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce

LA.7.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

TE: 55, 83, 85, 195, 205–206, 247, 299, 375, 385, 387, 439, 453, 
463, 465, 517,551, 562

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce

LA.7.SL.2.e

e. Use appropriate visual and/or digital 
tools to enhance verbal communication 
and add interest.

TE: 55, 83, 85, 195, 205–206, 247, 299, 375, 385, 387, 439, 453, 
463, 465, 503,
517, 551, 562

Students will present 
information to their peers 
regarding the text they are 
reading.

Key ideas, coherent 
manner Reinforce



7th Reading

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment

Unit 1 - Reality Check Weeks 1 - 6

Students will analyze the plot structure of a short 
story.(LA7.RP.4)

Students will analyze the character traits and plot 
of a short story.(LA7.RP.3)

None for Unit 1 Mirror Image
Project-Based 
or Selection 

Test

Students will determine the author's purpose for an 
article. (LA7.RP.1)

Students will cite evidence to show their 
comprehension of the text.(LA7.RP.6)

Not Everything It Seems
Project-Based 
or Selection 

Test

Students will analyze folktales and interpret its 
message.(LA7. RP.7)

Students will analyze humor through the use of 
inferences.(LA7.RP.3)

Two Legs or One?
Project-Based 
or Selection 

Test

Students will analyze rhyme and apply it in their 
writing.(LA7.RP.4)

Students will analyze rhyme schemes and mood 
by identifying a poem's scheme.(LA7.RP.4)

Students will analyze sound devices and explain 
how they affect the mood.(LA7.RP.4)

Students will compare the mood of two poems 
through text analysis.(LA7.RP.4)

The Song of Wandering Aengus

Eldorado

Project-Based 
or Selection 

Test

Students will analyze the narrator's point of view 
and describe how it changes throughout the story.
(LA7.RP.3)

Students will analyze the text features and how 
they contribute to the story.(LA7.RP.4)

Students will compare versions of a story through 
analysis of different genres.(LA7.RP.7)

From: Monster (Screenplay)

From: Monster (Graphic Novel)

Project-Based 
or Selection 

Test

Reader's Choice: 
Way Too Cool
Forever New
He-y, Come on Ou-t
A Priceless Lesson in Humility

Selection Test

Outside Resources:



7th Reading

Project-Based 
OR Unit 1 

Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment

Unit 2 - Take Control Weeks 7-12

Students will analyze the character traits and plot 
of a short story.(LA7.RP.2)

Students will analyze the effect of conflict on the 
plot.(LA7.RP.2)

The Westing 
Game Heartbeat

Project-Based 
or Selection 

Test

Students will analyze myths and identify the 
characteristics of a myth.(LA.7.RP.5)

Students will determine the theme of a myth.(LA.7.
RP.1) The Flight of Icarus

Project-Based 
or Selection 

Test

Students will analyze the organization of a poem.
(LA7.RP.8)

Students will analyze the author's word choice to 
create feelings in a poem.(LA7.RP.3)

Icarus's Flight
Project-Based 
or Selection 

Test

Students will analyze the plot structure of a short 
story.(LA.7.RP.2)

Students will make inferences supported by text 
evidence.(LA7.RP.6)

Rogue Wave
Project-Based 
or Selection 

Test

Students will use text evidence and details to 
determine the author's purpose.(LA 7.RP.3)

Students will evaluate supporting details to make 
connections to the author's central idea.(LA7.RP.
1)

Women in Aviation
Project-Based 
or Selection 

Test

Students will analyze characterization through the 
author's description.(LA7. RP.3)

Students will analyze how the setting of a story 
influences the plot. (LA7.RP.4)

Thank You, M'am
Project-Based 
or Selection 

Test

Students will analyze the structure of an 
informational text. (LA7. RI.4)

A Police Stop Changed This 
Teenager's Life

Project-Based 
or Selection 

Test
Reader's Choice: Selection Test



7th Reading

Outside Resources:
Project-Based 

OR Unit 2 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment

Unit 3 - The Terror and 
Wonder of Space Weeks 13 - 18

Students will analyze the features of science 
fiction.(LA.7.RP.4)

Students will analyze and identify the mood of a 
science fiction text.(LA7.RP.2)

A Wrinkle in Time Science Fiction: Dark There Were, and 
Golden-Eyed

Project-Based 
or Selection 

Test

Students will analyze the central ideas of an 
informational text.(LA7.RI.1)

Students will analyze the structure of an 
informational text.(LA7.RI.4)

Science Writing: Martian Metropolis
Project-Based 
or Selection 

Test

Students will analyze tone and voice to identify the 
author's purpose.(LA7.RP.1)

Students will analyze repetition to identify key 
ideas.  (LA7.RP.5)

Argument: Challenges for Space 
Exploration

Project-Based 
or Selection 

Test

Students will analyze the form of a poem.(LA.7.
RP.4)

Students will analyze a poem to determine the 
theme.(LA.7.RP.2)

Poem: What If We Were Alone?
Project-Based 
or Selection 

Test

Students will analyze the features of a video to 
identify its purpose.(LA7.RP.8)

Video: Seven Minutes of Terror
Project-Based 
or Selection 

Test
Students will analyze the structure and details of 
an argument. (LA7.RP.6)

Students will analyze different rhetorical devices in 
an argument.(LA7.RP.8)

Argument: Humans Need to Explore 
Outer Space

Argument: Let Robots Take to the 
Stars

Project-Based 
or Selection 

Test

Reader's Choice: 
Let's Aim for Mars
An Optimistic View of the World
Your World
Sally Ride from Headstrong

Selection Test

Outside Resources
Project-Based 

OR Unit 3 
Assessment



7th Reading

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment

Unit 4 - Inspired by 
Nature Weeks 19 - 24

Students will use the plot to analyze the theme of 
a short story.(LA7.RP.1)

Students will analyze how figurative language 
contributes to the text.(LA7.RP.4)

Peak Short Story: Allied with Green
Project-Based 
or Selection 

Test

Students will analyze the structure and details of 
an argument.(LA7.RP6) 

Students will analyze the point of view in an 
argument.(LA7.RP.3)

Argument: Never Retreat from Eyes 
Wide Open

Project-Based 
or Selection 

Test

Students will analyze a memoir and contrast it with 
other texts.(LA7.RP.5)

Students will analyze and interpret figurative 
language in a memoir.(LA7.RP.2)

Memoir: from Mississippi Solo
Project-Based 
or Selection 

Test

Students will analyze a sonnet and contrast 
various sonnets.(LA7.RP8)

Students will analyze and identify the rhyme 
scheme of a poem.(LA7.RP.4)

Poem: The Drought
Project-Based 
or Selection 

Test

Students will analyze the structure and meaning of 
an ode.(LA7.RP.8)

Students will analyze the mood of lyric poetry.
(LA7.RP.8)

Poem: Ode to enchanted light

Poem: Sleeping in the Forest

Project-Based 
or Selection 

Test

Students will analyze the techniques of persuasive 
media to identify the purpose.(LA7.RP.8)

Students will analyze a video's music and 
narration to identify the tone.(LA7.RP.8)

Video: from Trash Talk

Poster: You're Part of the Solution

Project-Based 
or Selection 

Test

Reader's Choice:
Memoir: from Unbowed
Poem: Problems with Hurricanes
Article: Living Large Off the Grid
Poetry: Haiku

Selection Test

Outside Resources:
Project-Based 

OR Unit 4 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment



7th Reading

Unit 5 - Game On! Weeks 25 - 30

Students will analyze point of view affect the 
narration of a short story(LA7.RP.1)

Students will analyze the effect of conflict on the 
plot.(LA7.RP.2)

The Crossover
Ghost Short Story: Ball Hawk

Project-Based 
or Selection 

Test

Students will make predictions about an 
informational text based on text evidence.(LA7.
RI6)

Students will analyze perspective to identify the 
author's purpose.(LA 7.RP.1)

Informational Text: Get in the Zone: 
The Psychology of Video-Game Design

Project-Based 
or Selection 

Test

Students will analyze informational text to identify 
the central idea and supporting details.(LA7.RP.1)

Students will analyze the organizational structure 
of an informational text.  (LA.7.RI.4)

Informational Text: It's Not Just a Game
Project-Based 
or Selection 

Test

Students will analyze the plot and structure of a 
novel in verse.(LA7.RP.1)

Students will analyze and interpret figurative 
language in a novel.(LA7.RP2)

Students will analyze points of view in a two-voice 
poem. (LA7.RP.3)

Students will make inferences to identify the 
central idea of a poem. (LA7.RP.6)

Novel in Verse: from The Crossover

Poem: Double Doubles

Project-Based 
or Selection 

Test

Reader's Choice:
Short Story: Batting After Sophie
Short Story: Amigo Brothers
Blog: Briding the Generational Divide 
Between a Football Father and Soccer 
Son
Science Writing: Arc of Triumph

Selection Test

Outside Resources:
Project-Based 
OR Unit 5 Test

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment

Unit 6 - Change 
Agents Weeks 31 - 36

Students will analyze realistic fiction and contrast it 
with other texts.(LA7.RP.5)

Students will analyze how character traits 
influence the plot. (LA7.RP.2)

Freedom Walkers Short Story: Sometimes a Dream 
Needs a Push

Project-Based 
or Selection 

Test



7th Reading

Students will write questions to help identify the 
central idea and supporting details. (LA.7.RP.1)

Students will analyze irony and point of view 
through tone and voice.(LA7.RP.2)

Personal Essay: Craig Kielburger 
Reflects on Working Toward Peace

Project-Based 
or Selection 

Test

Students will analyze the features of a 
documentary and explain how they work together.  
(LA7.RP.8)

Documentary: from It Takes a Child
Project-Based 
or Selection 

Test
Students will analyze the author's tone to identify 
the theme of a poem.(LA 7.RP.3)

Students will analyze the techniques of free-verse 
poetry to identify the meaning of the poem. (LA.7.
RP.8)

Poem: A Poem for My Librarian, Mrs. 
Long

Project-Based 
or Selection 

Test

Students will paraphrase an informational text.

Students will ask questions to determine the 
central ideas of an informational text.(LA.7.RP.1)

Students will identify the information included in a 
historical fiction piece. (LA7.RP.6)

Students will identify the setting and character 
motivation in a historical fiction piece.(LA7.RP.7)

History Writing: Frances Perkins and 
the Triangle Factory Fire

Novel: from Ashes of Roses

Project-Based 
or Selection 

Test

Reader's Choice:
History Writing: from The Story of the 
Triangle Factory Fire
Article: Difference Maker: John 
Bergmann and Popcorn Park
Autobiography: from Walking with the 
Wind
Short Story: Doris is Coming
Informational Text: Seeing Is Believing

Selection Test

Outside Resources:
Project-Based 
OR Unit 6 Test



7th Writing

Unit/GENRE/TH
EME Pacing Learning Goals Process Writing Assessment Standards

Narrative Unit Week 1-6

1. Students will compose a writing that conveys 
real or imagined experiences.   2. Students will 
use prewrite activities (graphic organizers) to 
plan, organize and draft a writing. 3. Students 
will use the writing process to prewrite, plan, 
draft, revise, edit, and proofread their writing.  

Introducing narrator/characters, maintain point of 
view, organize an event sequence using 
narrative transitions.  Components of paragraph 
and essay (topic sentence, supporting details, 
introduction paragraph, conclusion paragraph). 
Use dialogue, description and figurative 
language, to develop characters, setting, and 
plot. Precise words and phrases and figurative 
language to express voice, Cups to edit
(capitalization, usage punctuation, and spelling, 
ARMS to revise (Add, remove, move, substitute). 

Paragraph, selfie poem, 
autobiography (5 
paragraph) and action 
picture paragraph

 7.W.2a-e 
7.W.3a-e

Informative Unit Week 7-10

1. Students will write to explain a topic while 
organizing writing logically with transitions 2. 
Students will gather and use credible evidence 
from sources 3. Students will use the writing 
process to prewrite, plan, draft, revise, edit, and 
proofread their writing.  

Introduce topic & group info logicially, concrete details 
and examples, transitions, multi paragraph writing with 
intro and conclusion, evaluate sources, note-taking, 
collect and organize information, citing sources 
correctly, academic integrity. Color coding writing for 
organization,  incorporate text features (graph, 
diagram, etc.), digital tools to produce and publish 
writing, use feedback from peers and adults to 
improve writing

Multi-Paragraph Q& A 
project with research & 
text features

7.W.2a-e     
7.W.5a-d     
7.W.6 a-e

Argument  Unit Week 11- 18

1. Students will write arguments with language 
that clearly introduces a claim with organized 
evidence 2. Students will analyze a text and 
develop a claim that is supported with text-
evidence. 3. Students will gather and use 
credible evidence from sources 3. Students will 
use the writing process to prewrite, plan, draft, 
revise, edit, and proofread their writing.  

Prewriting to develop topic, Graphic organizers (O.R.
E.O, R.A.C.E.R) to organize writing. Adjust writing for 
various audiences.  Short and long-term writing 
projects, increasing  length and complexity, Analyze a 
text, identify key information to use as evidence to 
support claim, cite evidence, address opposing 
claims, transitions, persuasive language,  pros/cons, 
present ideas to an audience, Edit, proofread, and 
consider feedback from adults and peers. 

Opinion paragraph, 
Text-Dependent 
Analysis, Persuasive 
Essay, Persuasive 
Project

7.W.2a-e 
7.W.4a-d.  
7.W.6 a

Pacing Learning Goals Grammar Greek and Latin Roots Assessment Standards

Week 1-2

Students will identify different forms 
of verbs, adverbs, prepositions, 
conjunctions, & interjections and 
apply it to their writing. 

Into Lit-  Grammar Practice Book Module 3: 
Verbs (linking and helping, Adverbs, 
Prepositions, Conjunctions and Interjections

Vocabulary from Latin & Greek Roots Book Unit 2 
Roots: Pos/Pon, Man, Stat/stan

Combined Teacher 
Created Quiz

7.W.1d 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c



7th Writing

Week 3-4 

Students will identify different forms 
of verbs and change in verb tense  
and apply it to their writing. 

Module 9: Principal, regular, and irregular 
verbs, verb tense, sit/set, rise/raise, lie/lay

Unit 3 Roots: Cap/capt/cip, prehend, sum/sumpt, 
rapt/rap

Combined Teacher 
Created Quiz

7.W.1e 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 5-6

Students will identify components 
of a sentences and recognize run-
ons and fragments. 

Module 1: Sentence sense, run-on, the subject, 
the predicate, compound subjects and 
compound verbs Unit 4 Roots: Reg/reig, vict, poss/pot, dom

Combined Teacher 
Created Quiz

7.W.1e. 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 7-8
Students will identify and apply a 
variety of phrases. 

Module 5: Prepositional phrase, adjective 
phrase, adverb phrase, verb phrases and 
verbals, participles and participial phrases, 
infinitive and infinitive phrases Unit 5 Roots: Jac/ject, ball/bol/bl, pass, pend/pens

Combined Teacher 
Created Quiz

7.W.1d. 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 9 Review above Review Above End of quarter test

Week 10-11
Students will identify and apply  a 
variety of clauses.

Module 6: independent and subordinate 
clauses, adjective clause, adverb clause Unit 6 Roots: Serv, strict, solut, lib/liv

Combined Teacher 
Created Quiz

7.W.1c. 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 12-13

Students will identify different 
sentence structures and apply 
them to their writing. 

Module 7: Sentence structure (simple, 
compound, complex) Unit 7 Roots: liter, log, gram/graph, script/scrib

Combined Teacher 
Created Quiz

7.W.1   7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 14-15

Students will identify and apply 
punctuation including commas, 
semicolons, and colons. 

Module 14: Punctuation, end marks and 
abbreviations, commas in a series, commas 
with compound sentences, commas with 
sentence interrupters, other uses of the 
comma, more uses of the comma, semicolons, 
colons Unit 8 Roots: cess, grad/gress, it, cur/cours

Combined Teacher 
Created Quiz

7.W.1b 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 16-17
Students will identify modifiers and 
apply them to their writing

Module 11: Comparison of adjectives and 
adverbs, irregular comparison, special 
problems in using modifiers, double 
comparisons, placement of modifiers, 
placement of participial phrases Unit 9 Roots; Fort, teg, firm, val/valid

Combined Teacher 
Created Quiz

7.W.1c 7.
V.1 b    7.
V.1 c    7.
V.2b    7.
V.2c

Week 18 Review above Review Above End of quarter test

Supplemented 
by Reading 
teacher in 
weeks at their 
discretion

Students will identify nouns, 
pronouns, and different kinds of 
adjectives

Module 2: Nouns, pronouns, adjectives, 
demonstrative and proper adjectives 7.W.1c 

Students will identify and apply 
correct capitalization in a variety of  
situations. 

Module 13: Capital letters, pronoun/proper 
nouns, places and people, groups 
organizations, and religions, objects, events, 
structures, and awards, titles, first words proper 
adjectives, school Subjects 7.W.1a
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Central Ideas and Details

LA.8.RP.1

Determine two or more implied or 
explicit themes of a text and how they 
develop over the course of a literary 
text, including their relationship to 
supporting ideas.

TE: 5, 12, 110, 114, 116, 123, 126, 175–176, 180, 183, 186, 221, 
224, 226, 277,320, 353, 380, 390, 554, 562–563, 565

Students will find themes 
of a literary text.

theme, literary text, 
explicit, implied reinforce

LA.8.RP.2

Analyze how particular events, lines of 
dialogue, or descriptive details develop 
the plot, reveal aspects of characters, 
or create meaning.

TE: 5, 8, 12, 104, 110, 122, 123, 126, 175, 181–182, 186, 187, 
191, 193, 195,196, 198, 201, 206, 208, 211, 216, 221, 250, 252, 
253, 254–256, 277, 281, 287,299–300, 302, 308, 310, 314, 353, 
356, 358, 362, 439, 471, 490, 492, 495, 512–513, 526, 527

Students will analyze 
literary elements in a text. 

plot, dialogue, 
characterization, 
descriptive details reinforce

Author's Craft

LA.8.RP.3

Analyze how an author establishes, 
conveys, and contrasts the points of 
view of the audience and the 
characters to create effects such as 
suspense, humor, or dramatic irony in a 
literary text.

TE: 30, 32, 34, 35, 79, 80, 86, 90, 95, 98, 100, 101, 104, 154, 
156, 162, 252,254, 256, 286 299, 390, 418, 448, 526

Students will analyze how 
an author uses point of 
view to emphasize literary 
devices.

point of view, suspense, 
humor, irony, characters, 
narrator introduce/reinforce

LA.8.RP.4

Compare and contrast the structure of 
two or more literary texts and how their 
structures contribute to style and 
meaning.

TE: 34, 108, 134, 136, 138, 145, 146, 148, 152, 154, 156, 157, 
378, 390–391,405, 444

Students will compare and 
contrast the structure of 
two literary texts. compare, contrast, style reinforce

Knowledge and Ideas

LA.8.RP.5

Analyze how a modern work of fiction 
draws on themes, patterns of events, or 
character types from myths, traditional 
stories, or religious works. TE: 108, 110, 114, 116, 123, 154, 156, 272, 362

Students will analyze how 
a modern work of fiction 
uses elements of past 
works of fiction.

modern, myths, 
traditional, religious 
works introduce/reinforce

LA.8.RP.6

Synthesize the implied or stated theme
(s) in a literary text to draw conclusions 
and deepen understanding of self and 
others.

TE: 5, 12, 104, 110, 114, 116, 123, 126, 154, 157, 175–176, 180, 
183, 186, 221,224, 226, 277, 286, 320, 353, 380, 390, 554, 562–
563, 565

Students will state a theme 
of a text and be able to 
relate it to themselves and 
others. theme, text connections reinforce

LA.8.RP.7

Analyze regional, national, international, 
and/or multicultural perspectives to 
make connections among and 
distinctions between characters or ideas 
within and across a range of literary 
texts. TE: 110, 126, 154, 260, 296, 353, 355, 357

Students will make 
connections to a variety of 
different texts. 

perspective, text 
connections reinforce

Range of Reading and Level of 
Text Complexity
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Instructional Materials: Units, Lessons, etc. Learning Goals Key Vocabulary
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Read and comprehend a wide range 
of literary texts of appropriate 
complexity at the high end of the 6-8 
grade band independently and 
proficiently. TE: 64–65, 158–159, 248–249, 334–335, 420–421, 564–565

Students will read and 
comprehend grade 
appropriate text 
independently.

comprehend, grade 
appropriate reinforce, master

R
e
a
d
i
n
g
 
I
n
f
o
r

m
a
t
i
o
n
a
l
 
T
e
x
t

Central Ideas and Details

LA.8.RI.1

Determine two or more implied or 
explicit central ideas and how they 
develop over the course of an 
informational text, including their 
relationship to supporting ideas. TE: 17, 18, 21, 83, 90

Students will find two or 
more central ideas of 
informational text.

implied, explicit, central 
idea, supporting ideas, 
informational text reinforce

LA.8.RI.2

Analyze how particular events, 
interactions between individuals, or key 
facts and details contribute to meaning.

TE: 24, 90, 314, 374, 414, 538

Students will analyze 
events, interactions 
between individuals and 
key facts using text 
evidence in informational 
text. 

text evidence, supporting 
details, informational text reinforce

Author's Craft

LA.8.RI.3

Analyze how an author establishes, 
conveys, and contrasts perspective or 
purpose in a text and how the author 
acknowledges and responds to 
conflicting evidence or viewpoints. TE: 38, 41, 88, 272, 291, 314, 337, 367, 372, 423

Students will analyze the 
author's perspective or 
purpose when conflicting 
viewpoints are present.

author's perspective, 
author's purpose, 
viewpoint, conflict reinforce

LA.8.RI.4

Compare and contrast the structure of 
a specific paragraph in an informational 
text, including the role of particular 
sentences in developing and refining a 
key concept. TE: 58, 374, 400, 414, 538

Students will identify the 
text structure of an 
informational text.

text structure, 
informational text, key 
concepts introduce

Knowledge and Ideas

LA.8.RI.5

Compare and contrast how two or 
more authors provide conflicting 
information on the same topic, 
including where the texts disagree on 
matters of evidence or interpretation. TE: 36, 58, 62, 418

Students will compare and 
contrast paired texts with 
opposing views.

compare, contrast, 
conflicting views reinforce

LA.8.RI.6

Analyze the development of an 
argument and evaluate the 
effectiveness of the type(s) of reasoning 
used to support the argument.

TE: 38, 41, 51, 62, 66, 68, 70, 315, 394, 397, 400, 405, 414, 422, 
424, 426, 431,551, 575

Students will analyze the 
development of an 
argument and evaluate the 
reasons that support the 
argument.

argument, reasoning, 
support, effectiveness reinforce
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LA.8.RI.7

Analyze regional, national, international, 
and/or multicultural perspectives to 
make connections among and 
distinctions between individuals or ideas 
within and across a range of 
informational texts. TE: 538, 550

Students will analyze 
perspectives and make 
text connections across a 
range of informational text. 

perspectives, text 
connections, 
informational text reinforce

Range of Reading and Level of 
Text Complexity

LA.8.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity at the high end of the 6-8 
grade band independently and 
proficiently. TE: 248–249, 334–335, 420–421, 564–565

Students will read and 
comprehend grade 
appropriate text 
independently.

comprehend, grade 
appropriate reinforce, master

V
o
c
a
b
u
l
a
r
y

Acquisition and Use

LA.8.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Students will use 
academic grade level 
vocabulary appropriately. grade-level vocabulary reinforce/master

LA.8.V.1.a

a. Use context clues (e.g. the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

TE: 9, 10, 14, 19, 23, 40, 41, 42, 44, 80, 87, 97, 98, 99, 102, 112, 
113, 114, 116,119, 120, 201, 177, 178, 182, 218, 303. 304, 306, 
307, 359, 364, 376, 396, 397,398, 402, 407, 409, 445, 455, 463, 
485, 489, 496, 534, 536

Students will use 
academic grade level 
vocabulary appropriately. grade-level vocabulary reinforce/master

LA.8.V.1.b

b. Use commonly occurring Greek and 
Latin affixes and roots to determine the 
meanings of words (e.g., recede, 
precede). TE: 53, 60, 117, 128, 304, 316, 416

Students will use 
academic grade level 
vocabulary appropriately. grade-level vocabulary reinforce/master

LA.8.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, or parts of speech of 
words. TE: 48, 99, 106, 188, 372, 376

Students will use 
academic grade level 
vocabulary appropriately. grade-level vocabulary reinforce/master

Context and Connotations

LA.8.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Students will understand 
the way author's use 
words.

figurative language, 
connotative language, 
technical language, 
figures of speech, 
connotation, denotation reinforce
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Instructional Materials: Units, Lessons, etc. Learning Goals Key Vocabulary
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LA.8.V.2.a

a. Interpret figures of speech (e.g., 
verbal irony, puns) in context.

TE: 30, 32, 35, 283, 288

Students will understand 
the way author's use 
words.

figurative language, 
connotative language, 
technical language, 
figures of speech, 
connotation, denotation reinforce

LA.8.V.2.b

b. Determine the relationship between 
particular words to better understand 
each of the words.

TE: 14, 26, 240, 244

Students will understand 
the way author's use 
words.

figurative language, 
connotative language, 
technical language, 
figures of speech, 
connotation, denotation reinforce

LA.8.V.2.c

c. Distinguish between the connotations 
of words with similar denotations (e.g., 
willful, resolute).

TE: 274, 292, 534, 540

Students will understand 
the way author's use 
words.

figurative language, 
connotative language, 
technical language, 
figures of speech, 
connotation, denotation reinforce

Production of Writing

LA.8.W.1

Create grammatically correct multi-
paragraph compositions with varied 
sentence structures.

Students compose a 
passage with correct 
grammar, sentences, and 
paragraphs. 

Sentence structure, 
paragraph structure Reinforce

LA.8.W.1.a

a. Apply knowledge of rules for 
capitalization.

TE: 529, 574

Students will follow 
capitalization rules when 
writing. Capitalization Reinforce

LA.8.W.1.b

b. Use punctuation (comma, ellipsis, 
dashes) to indicate a pause or break 
and an ellipsis to indicate an omission. TE: 93, 107, 168, 189, 258 Students will use commas and dashes to show a pause or break, and an ellipsis to show an omission. 

Comma, ellipsis, dashes, 
omission Introduce

LA.8.W.1.c

c. Explain the function of and use 
different types of verbals in sentences 
(e.g., gerunds, participles, infinitives). TE: 15, 275, 365, 430

Students will understand 
and use different verbals 
in sentences

Gerunds, participles, 
infinitives Introduce

LA.8.W.1.d

d. Distinguish between and use active 
and passive voice, formal and informal 
tone, and types of grammatical mood 
(e.g. indicative, subjunctive, 
conditional, imperative). TE: 61, 403

Students will identify 
differences in voice, tone, 
and grammatical mood. 

Active and passive 
voice, formal and 
informal tone, and 
indicative, subjunctive, 
condition, and imperative 
grammatical moods Introduce

LA.8.W.1.e
e. Use appropriate parallel structure in 
words, phrases, and clauses. TE: 417, 544, 550

LA.8.W.1.f

f. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tense, number, voice, and mood.

TE: 198, 210

Students will identify and 
revise fragment and run-
on sentences and incorret 
shifts in verb tense, 
number, voice, and mood

fragment, run-on, verb 
tense, voice, mood, 
number (?) 

Introduce & reinforce
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LA.8.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Students will draft, revise 
and edit writing for various 
situations 

Recursive, writing 
process, audience, 
purpose, discipline Reinforce

LA.8.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing. TE: 66, 68–69, 70–71, 160, 162–165, 166, 250–255, 336, 338–

342, 422, 424–427, 563, 566, 568–571

Students will find and use 
resources  to plan, 
organize and draft.

prewrite, plan, organize, 
draft

(Intro-identify and use?) 
Reinforce

LA.8.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity. TE: 66–76, 160–168, 336–346, 422–430, 566–574

Students will create writing 
pieces that increase in 
length and complexity.

writing process, sustain, 
engagement, complexity Reinforce

LA.8.W.2.c

c. Improve and clarify the content, 
structure, and organization of writing by 
revising, considering feedback from 
adults and peers.

TE: 66, 72–73, 160, 166–167, 250, 256–257, 336, 342–343, 422, 
428–429, 563,566, 572–573

Students will revise their 
writing with consideration 
to peer and adult feedback feedback, revising Reinforce

LA.8.W.2.d

d. Improve and clarify writing by editing 
and proofreading, considering 
feedback from adults and peers.

TE: 66, 73, 74, 160, 167, 168, 250, 257, 258, 336, 343, 344, 422, 
429, 430,566, 573, 574

Students will edit and 
proofread their writing with 
consideration to peer and 
adult feedback

Editing (CUPS), 
proofreading, feedback Reinforce

LA.8.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers. TE: 74, 168, 258, 344, 430, 563, 574

Students will use print and 
a word processing tools to 
share/publsih their work.

produce, enhance, 
publish Reinforce

Modes of Writing

LA.8.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events in which the development and 
structure are appropriate to the task, 
purpose, and audience.

Students will write 
narratives specific to task, 
purpose, and audience. 

Development, structure, 
purpose, audience Reinforce

LA.8.W.3.a

a. Engage and orient the reader by 
establishing a conflict, situation, or 
observation, introducing a narrator 
and/or character(s), and establishing 
and maintaining point(s) of view; 
organize an event sequence that 
unfolds naturally and logically. TE: 433, 566–574

Students will organize a 
narrative that introduces 
characters and maintains 
a point of view. 

narrator, point of view, 
sequence Reinforce

LA.8.W.3.b

b. Use literary techniques (e.g., 
dialogue, pacing, description, multiple 
plot lines) to develop experiences, 
events, characters, and settings). TE: 433, 566–574

Students will use dialogue, 
pacing, and description to 
develop their naratives

dialogue, pacing, 
description Reinforce
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LA.8.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole. TE: 433, 566–574

Students will sequence 
events to create a 
coherent whole sequence, coherent Reinforce/Introduce

LA.8.W.3.d

d. Use precise words and phrases, 
descriptive/sensory details, and 
figurative language to establish mood 
and tone and convey a vivid picture. TE: 256, 433, 566–574

Students will use precise 
words, sensory details, 
and figurative language to 
develop mood and tone mood, tone Reinforce/Introduce

LA.8.W.3.e

e. Provide a conclusion that is clearly 
related to and reflects upon what is 
experienced, observed, or left 
unresolved over the course of the 
piece. TE: 433, 566–574

Students will write a 
conclusiton the reflects 
upon the piece conclustion, reflects Reinforce/Introduce

LA.8.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Students will develop a 
perspective with 
supportive reasons to write 
an argument. 

argument, perspective, 
evidence Reinforce

LA.8.W.4.a

a. Develop a structure to sequence 
ideas appropriately; introduce a clear 
claim where appropriate. TE: 66–76, 422–430

Students will indtroduce a 
claim and sequence their 
ideas claim, sequence Reinforce

LA.8.W.4.b

b. Introduce claim(s), acknowledge 
and distinguish the claim(s) from 
alternate or supporting claims, and 
develop a structure in which ideas are 
grouped logically. TE: 66–76, 422–430

Students will develop a 
structure for their 
argument and 
acknoweledge alternate 
claims structure, alternate claims Introduce

LA.8.W.4.c

c. Explain and cite relevant evidence 
from multiple credible sources.

TE: 66–76, 422–430

Students will cite and 
explain evidence from 
multiple credible sources

evidence, credible 
source Reinforce

LA.8.W.4.d

d. Use words, phrases, and key 
vocabulary to create cohesion and 
clarify the relationship between the 
claim(s) and supporting evidence. TE: 66–76, 422–430

Students will clarify the 
relationship between claim
(s) and supporting 
evidence

claim, supporting 
evidence Reinforce

LA.8.W.4.e

e. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline. TE: 66–76, 422–430

Students will adapt style 
and tone to the task style, tone introduce

LA.8.W.4.f

f. Provide a conclusion that follows from 
and supports the argument(s) 
presented. TE: 66–76, 422–430

Students will write a 
conlcusion that supports 
their argument conclusion, argument Reinforce
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LA.8.W.5

Write informative/ explanatory pieces to 
clearly convey ideas and information in 
which the development and structure 
are appropriate to the task, purpose, 
and audience.

Students will explain a 
topic or text in an 
informational writing piece. 

informative, explanatory, 
convey, examine Reinforce

LA.8.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize ideas, 
concepts, and information into broader 
categories or sections including text 
features, illustrations, and/or multimedia 
elements. TE: 25, 160–168

Students will introduce a 
topic and organize ideas 
into broader sections 
including text features

text features, 
illustrations, multimedia 

elements Reinforce/Introduce

LA.8.W.5.b

b. Develop the topic with relevant facts, 
definitions, concrete details, quotations, 
and/or other information and examples. TE: 25, 160–168

Students will incorporate 
facts, definitions, 
quotations, and examples 

facts, quotations, 
examples Reinforce

LA.8.W.5.c

c. Use appropriate transitions and 
domain-specific vocabulary to clarify 
relationships among ideas and 
concepts. TE: 25, 160–168

Students will use 
transitions to clarify their 
writing transitions Reinforce

LA.8.W.5.d

d. Provide a concluding statement or 
section that follows from the information 
or explanation(s). TE: 25, 160–168

Students will provide a 
conclustion for their 
informational writing conclusion Reinforce

LA.8.W.6

Gather and use credible evidence from 
multiple trustworthy sources and assess 
its relevance in answering the research 
question(s).

Students will evaluate 
multiple sources' relevancy 
and trustworthiness to 
answer a research 
question.

credible, evicence, 
source, relevance Reinforce

LA.8.W.6.a

a. Integrate evidence into writing by 
quoting or paraphrasing data and 
conclusions while avoiding plagiarism. TE: 339

Students will avoid 
plagiarism by quoting and 
paraphrasing correctly

quote, paraphrase, 
plagiarism Reinforce

LA.8.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception) from print and digital 
sources to generate and answer 
questions and create new 
understandings. TE: 338, 339

Students will be able to 
locate and evauluate the 
credibility of evidence from 
digital and print  sources to 
understand the 
informationand answer 
questions

bias, evaluate credibility 
of sources Reinforce

LA.8.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information. TE: 339, 342

Students will use note 
taking formats to collect 
and organize information

note-taking, collect, 
organize Reinforce
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LA.8.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source and citing sources within text (e.
g., parenthetical and numerical); 
provide a list of sources using a 
standard format. TE: 341–342

Students will avoid 
overreliance on any one 
source while citing sources 
within the text and provide 
a list of sources 

in-text citation 
(parenthetical and 

numerical) Reinforce/Introduce

S
p
e
a
k
i
n
g
 
a
n
d
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LA.8.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g., safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives). TE: 344

Students will practice safe 
and ethical behavoirs 
when using digital 
communidcation ethical Reinforce

Comprehension and Collaboration

LA.8.SL.1

Initiate and participate in structured 
discussions and collaborations about 8th 
grade topics and texts.

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

LA.8.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

TE: 13, 25, 47, 59, 76, 91, 174, 217, 243, 318, 333, 344–346, 
363, 375, 389,551, 563, 565

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

LA.8.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

TE: 13, 25, 47, 59, 76, 91, 174, 217, 243, 318, 333, 344–346, 
363, 375, 389,551, 563, 565

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

LA.8.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

TE: 13, 25, 47, 59, 76, 91, 174, 217, 243, 318, 333, 344–346, 
363, 375, 389,551, 563, 565

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

LA.8.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

TE: 13, 25, 47, 59, 76, 91, 167, 174, 217, 243, 273, 318, 331, 
333, 343–346,363, 375, 389, 401, 429, 432, 551, 563, 565, 573

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

LA.8.SL.1.e

e. Complete a task following complex, 
multi-step directions.

TE: 66–76, 250–258

Students will engage in 
collaborative 
conversations regarding 
their reading.

relevant questions, 
collboration Reinforce

Presentation of Knowledge and Ideas

LA.8.SL.2

Present claims and findings, 
emphasizing key ideas in a focused, 
coherent manner with relevant 
descriptions, facts, details, and 
examples to clarify themes or central 
ideas.

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce
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LA.8.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, adequate volume, 
clear pronunciation) for a variety of 
purposes and situations, including 
interpreting 8th grade texts.

TE: 35, 75–76, 105, 127, 187, 227, 258, 287, 297, 315, 331, 344, 
363, 389, 401,415, 431–432, 527, 543, 551, 561

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce

LA.8.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

TE: 35, 75–76, 105, 127, 187, 227, 258, 287, 297, 315, 331, 344, 
363, 389, 401,415, 431–432, 527, 543, 551, 561

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce

LA.8.SL.2.c

c. Analyze the purpose of information 
being presented and evaluate its 
motives (e.g., social, commercial, 
political).

TE: 35, 75–76, 105, 127, 187, 227, 258, 287, 297, 315, 331, 344, 
363, 389, 401,415, 431–432, 527, 543, 551, 561

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce

LA.8.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

TE: 35, 75–76, 105, 127, 187, 227, 258, 287, 297, 315, 331, 344, 
363, 389, 401,415, 431–432, 527, 543, 551, 561

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce

LA.8.SL.2.e

e. Select and use appropriate visual 
and/or digital tools to enhance verbal 
communication and add interest. TE: 243, 375, 551

Students will present 
information to their 
classmates regarding the 
selected text.  Relevant facts, Key ideas Reinforce



8th Reading

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 1: Gadgets and Glitches Weeks 1-6 Students will analyze plot structure and conflict in a 

literary text. (LA8.RP.2)
The Boy Who Harnessed the Wind Science Fiction: The Brave Little Toaster Selection Test, 

Project Based 
Assessment

Students will analyze text features of the science 
fiction. (LA.8RP.5)
Students will use context clues to define unfamiliar 
vocabulary words. 

Possible Novels: The Boy Who 
Harnessed the Wind

Students will identify central idea and details of an 
informational text. (LA8.RI.1)

Informational Text: Are Bionic Superhumans on the 
Horizon?

Selection Test, 
Project Based 
Assessment

Short Reads: If You Go Into the 
Woods You Will Find It Has a 
Technology; Hallucination; There 
Will Come Soft Rains; from All the 
Light We Cannot See (Novel 
Passage)

Students will analyze text organizational patterns of 
informational text. (LA.8.RI.4)

Students will identify synonyms and antonyms for 
vocabulary words. 
Students will analyze the structure of a poem 
(rhyme scheme/meter).(LA8.RP.4)

Poem: Interflora Selection Test, 
Project Based 
Assessment

Students will analyze different types of irony. (LA8.
RP.3)
Students will analyze a claim with supporting text 
evidence.(LA.8.RP.6)

Argumentive Text: The Automation Paradox Selection Test, 
Project Based 
Assessment

Students will analyze graphic features in 
informational text. (LA.8.RI.4)
Students will evaluate the validity of text evidence 
from an argumentive text. (LA8.RI.3)

Argumentive Text: Heads Up, Humans Selection Test, 
Project Based 
Assessment

Students will analyze rhetorical (persuasive) 
devices in a argumentive text. (LA8.RI.4)

Unit 1 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 2: The Thrill of Horror Weeks 7-12 Students will examine, analyze, and interpret the 

central idea and supporting details of a text. (LA8.
RP.1)

Code Orange Literary Criticism: What is the Horror Genre? Selection Test; 
Project Based 
Assessment

Students will paraphrase and summarize a text.
(LA8.RP.2)

Possible Novels: Code Orange Students will analyze the different types of point of 
view and an unreliable narrator. (LA8.RP.7)(LA8.
RP.3)

Short Story: The Tell-Tale Heart Selection Test; 
Project Based 
Assessment

Short Reads: Frankenstein; 
beware: do not read this poem; 
Blood; The Outsider; Scary Tales

Students will analyze elements of suspense. (LA8.
RP.3)

Students will analyze a theme in two or more texts.
(LA8.RP.4)

Short Story: The Monkey's Paw Selection Test; 
Project Based 
Assessment

Students will analyze foreshadowing in a text using 
elements of dialogue and imagery. (LA8.RP.3)
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Students will analzye a film adaptation of a short 
story and examine similarities and differences.(LA.
8.RP.3)

Film Clip: from The Monkey's Paw Selection Test; 
Project Based 
Assessment

Students will analyze an epic poem and reflect on 
style, culture, and themes.(lA8.RP.7)

Epic Poem: from The Aeneid of Virgil Selection Test; 
Project Based 
Assessment

Students will analyze a modern adaptation of a 
classical Greek myth.(LA8.RP.5)

Graphic Novel: from Hades: Lord of the Dead 

Unit 2 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 3: Places We Call Home Weeks 13-18 Students will analyze plot structure in a literary text. 

(LA8.RP.2)
Refugee from The book of Unknown Americans (Novel Passage) Selection Test; 

Project Based 
Assessment

Students will analyze a theme in two or more 
literary texts.(LA8.RP.4)

Possible Novels: Refugee Students will analyze plot structure in a literary text. 
(LA8.RP.2)

 Short Story: My Favorite Chaperone Selection Test; 
Project Based 
Assessment

Short Reads: My Father and the 
Figtree; Golden Class; A Place to 
Call Home; Salmon Boy

Students will analyze characterization through 
description, thoughts, speech, and actions.(LA8.
RP.3)
Students will use context clues to define unfamiliar 
vocabulary words. (LA8.RP.4)
Students will analyze a theme in two or more 
literary texts.(LA8.RP.4)

Poem: Spirit Walking in the Tundra Selection Test; 
Project Based 
Assessment

Students will analyze an author's use of imagery to 
create feeling and meaning in a poem.(LA.8.RP.3)
Students will evaluate a documentary for it's 
purpose and motive.(LA8.RP8)

Documentary: New Immigrants Share Their Stories Selection Test; 
Project Based 
Assessment

Students will analzye text features of an 
informational text.(LA8. RI4)

Informational Text: A Common Bond

Students will use context clues to determine the 
meaning of a multiple-meaning word. (LA8.RP.4)

Unit 3 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 4: The Fight for Freedom Weeks 19-24 Students will analyze the elements of an 

autobiography,(LA.8.RP.8)
The Not So Boring Letters of Private 
Nobody

Autobiography: from Narrative of the Life of Frederick 
Douglass, an American Slave

Selection Test; 
Project Based 
Assessment

Students will analyze organizational text structure 
of an informational text.(LA.8.RI.4)
Students will determine the connotation and 
denotation of a vocabulary word.(LA.8.V.1)

Possible Novels: The Not So 
Boring Letters of Private Nobody

Students will analyze the setting of a text (historical 
fiction). (LA8.RP.2)

Historical Fiction: The Drummer Boy of Shiloh Selection Test; 
Project Based 
Assessment
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Short Reads: I Saw Old General at 
Bay; from Bloody Times: The 
Funeral of Abraham Lincoln and 
the Manhunt for Jefferson Davis; A 
Mystery of Heroism; My Friend 
Douglass; Civil War Journal

Students will analyze figurative language in a 
literary text.(LA8.RP.2)

Students will analyze figurative language in a 
poem.(LA8.V.1)

Poem: O Captain! My Captain! Selection Test; 
Project Based 
Assessment

Students will analyze the tone of a poem. (LA8.
RP1)
Students will analyze the elements of a biography. 
(LA8.RP.8)

Biography: from Harriet Tubman: Conductor on the 
Underground Railroad

Selection Test; 
Project Based 
Assessment

Students will analyze word choice for its effect on 
tone.(LA8.RP.2)
Students will analyze figurative language in a 
poem.(LA8.RP.3)

Poem: Not My Bones Selection Test; 
Project Based 
Assessment

Students will analyze chronological order (text 
structure).(LA8.RP.4)

History Writing: from Fortune's Bones

Unit 4 
Assesment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 5: Finding Your Path Weeks 25-30 Students will analyze a character's perspective in a 

literary text.(LA8.RP.3)
The Boy Who Harnessed the Wind; 
Touching Spirit Bear; The Outsiders

Novel: from Bronx Masquerade Selection Test; 
Project Based 
Assessment

Students will analzye the characterization in a 
literary text.(LA8.RP.3)
Students will use context clues to define vocabulary 
words. (LA8.V.1)

Possible Novels: The Boy Who 
Harnessed the Wind; Touching 
Spirit Bear; The Outsiders

Students will analzye the text structure and text 
features of an informational text. (LA8.RI.4)

Informational Text: The Debt We Owe to the Adolescent 
Brain

Selection Test; 
Project Based 
Assessment

Short Reads: Teenagers; Identify; 
Hard on the Gas; Marigolds; My 
Summer of Scooping Ice Cream

Students will analzye the author's purpose for 
writing an informational text. (LA8.RP.1)

Students will compare the structure of two poems. 
(LA8.RP4)

Poem: Hanging Fire; Summer of His Fourteenth Year Selection Test; 
Project Based 
Assessment

Students will analyze a claim and evidence in an 
argumentive text. (LA8.RP.3)

Argument: It's Complicated: The Social Lives of 
Networked Teens

Selection Test; 
Project Based 
Assessment

Students will identify counterclaims in an 
argumentive text.(LA8.RP.3)
Students will use context clues to define vocabulary 
words. (La8.V.1)
Students will analyze the structure of an 
argumentive text.(LA8.RP.4)

Argument: Outsmart Your Smartphone Selection Test; 
Project Based 
Assessment

Students will analyze rhetorical devices used in an 
argumentive text. (LA8.RP.2)
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Unit 5 
Assessment

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Into Literature Materials Assessment
Unit 6: The Legacy of Anne Frank Weeks 31-36 Students will analzye the elements of a drama. 

(LA8.RP.8)
Anne Frank: The Diary of a Young 
Girl

Drama: The Diary of Anne Frank Selection Test; 
Project Based 
Assessment

Possible Novels: Anne Frank: The 
Diary of a Young Girl

Students will analzye the elements of a diary.(LA8.
RP.8)

Diary: from The Diary of a Young Girl Selection Test; 
Project Based 
Assessment

Short Reads: Peace Can Happen; 
The Butterfly/On a Sunny Evening; 
The Singing Women; from A 
Tragedy Revealed: A Heroine's 
Last Days; Nobel Prize 
Acceptance Speech (Elie Wiesel)

Students will make inferences about a text.(LA8.
RP.6)

Students will determine the connotation and 
denotation of a vocabulary word. (LA8.V.1)
Students will analyze different types of appeals to 
support an author's writing.(LA.8.RP.5)

Speech: After Auschwitz Selection Test; 
Project Based 
Assessment

Students will analyze rehetorical devices used by 
an author to enhance their arguments. (LA8. RP.3)
Students will analyze sound devices used in a 
poem.(LA.8.RP.4)

Poem: There But for the Grace; Days Selection Test; 
Project Based 
Assessment

Students will analyze figurative language used in a 
poem.(LA.8.RP.3)

Unit 6 
Assessment



8th Writing

Unit/GENRE/TH
EME Pacing Learning Goals Process Writing Assessment Standards

Narrative Unit Week 1-7

1. Students will compose a writing that 
conveys real or imagined experiences.   
2. Students will use prewrite activities 
(graphic organizers) to plan, organize 
and draft a writing. 3. Students will use 
the writing process to prewrite, plan, 
draft, revise, edit, and proofread their 
writing.  

Introducing narrator/characters, 
maintain point of view, organize an 
event sequence using narrative 
transitions.  Components of 
narrative writing (plot diagram, 
narrative transitions, unfolding 
events). Use dialogue, description 
and figurative language, to 
develop characters, setting, and 
plot. Precise words and phrases 
and figurative language to express 
voice through showing and not 
telling, CUPS to edit(capitalization, 
usage punctuation, and spelling, 
ARMS to revise (Add, remove, 
move, substitute). 

Memoir, narrative short story, 
show/not tell project

8.W.2a-e 8.
W.3a-e

Argument  Unit Week 8-12

1. Students will write arguments with 
language that clearly introduces a claim 
with organized evidence increasing in 
complexity and length 2. Students will 
analyze a text and develop a claim that 
is supported with text-evidence. 3. 
Students will gather and use credible 
evidence from sources 3. Students will 
use the writing process to prewrite, plan, 
draft, revise, edit, and proofread their 
writing.  

Prewriting to develop topic, Graphic 
organizers ( R.A.C.E.R) to organize 
writing. Adjust writing for various 
audiences.  Short and long-term 
writing projects, increasing  length 
and complexity, Analyze a text, 
identify key information to use as 
evidence to support claim, cite 
evidence, address opposing claims, 
transitions, persuasive language, 
defend counterclaims, present ideas 
to an audience, Edit, proofread, and 
consider feedback from adults and 
peers. 

Opinion/Review article, Text 
dependent analysis, Patriot's Pen 
prewrite and plan, advertisement

8.W.2a-e 8.
W.4a-f.  8.W.
6 a

Informative Unit Week 13-18

1. Students will write to explain a topic 
while organizing writing logically with 
transitions increasing in complexity and 
length 2. Students will gather and use 
credible evidence from sources 3. 
Students will use the writing process to 
prewrite, plan, draft, revise, edit, and 
proofread their writing.  

Introduce topic & group info logicially, 
concrete details and examples, 
transitions, multi paragraph writing 
with intro and conclusion, evaluate 
sources, note-taking, collect and 
organize information, citing sources 
correctly, academic integrity. Color 
coding writing for organization,  
incorporate text features (graph, 
diagram, etc.), digital tools to produce 
and publish writing, use feedback 
from peers and adults to improve 
writing.

Informative Research Project,  
Utilizing credible sources quiz

8.W.2a-e 8.
W.5a-d 8.W.
6 a-e

Pacing Learning Goals Grammar Greek and Latin Roots Assessment Standards



8th Writing

Week 1-2

Students will identify and apply 
knowledge of nouns, pronouns, and 
adjectives

Into Lit-  Grammar Practice Book 
Module 2: Nouns (Common, proper, 
abstract, & concrete), pronouns 
(demonstrative and relative), adjectives 
(proper)

Vocabulary from Latin & Greek 
Roots Book Unit 1 Roots: erg/urg, 
vig, ig/ag/act/eg Combined Teacher Created Quiz

8.W.1a 8.V.1 
b    8.V.1 c    
8.V.2b    8.V.
2c

Week 3-4
Students will identify and apply correct 
capitalization  in a variety of situations

Module 13: Capitalization (pronoun I, 
Proper nouns, places, people, groups, 
organizations, religions, objects, events, 
structures, awards, titles, school 
subjects, first words, proper adjectives)

Unit 2 Roots: pos/pon, stan/stat, 
thes/thet Combined Teacher Created Quiz

8.W.1a 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 5-6

Students will identify and apply 
knowledge of verbs, adverbs, 
prepositions, conjunctions, and 
interjections 

Module 3: Parts of Speech Verbs 
(linking/helping, adverbs, prepositions, 
conjunctions, and interjections

Unit 3 Roots: cept/cip/ceive, hab/hib, 
dit, don Combined Teacher Created Quiz

8.W.1c 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 7-8
Students will identify and apply correct 
verbs and verb tense

Module 9: Verbs- Principal parts, regular 
and irregular verbs, verb tense, sit/set, 
rise/raise, lie/lay

Unit 5 Roots: hum, stell, astr, 
neb/nimb, celes, terr Combined Teacher Created Quiz

8.W.1c 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 9 Review above End of quarter assessment

Week 10-11 Students will identify and apply grammatical moods

Supplemented Grammatical Moods 
(indicative, subjunctive, conditional, 
imperative) 

Unit 6 Roots: curs/course, celer, vola, 
mov, fug Combined Teacher Created Quiz

8.W.1d 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 12-13 Students will identify and apply knowledge of subject, predicate, and run-ons

Module 1: Sentence sense, run-ons, 
subject & predicate, simple subject and 
predicate, compound subjects and 
verbs

Unit 7 Roots: val/vail, fort, dur, rob, 
solid Combined Teacher Created Quiz

8.W.1f 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 14-15
Students will identify and apply 
sentence structures 

Module 7: Sentence Structure (simple, 
compound, complex, compound-
complex)

Unit 8 Roots: insul, idio, num, 
plus/plur, sing Combined Teacher Created Quiz

8.W.1 8.V.1 
b 8.V.1 c 8.
V.2b 8.V.2c

Week 16-17

Students will identify and apply correct 
punctuation including end marks, 
commas, semicolons and colons

Module 14: Punctuation (end marks and 
abbreviations, comma usage (in a 
series, compound sentences, commas 
with interrupters, introductory words, 
phrases, and clauses, dates, addresses, 
friendly letters), semicolons, colons

Unit 11 Roots: vet, freq, ann, chron, 
temp Combined Teacher Created Quiz

8.W.1b 8.W.
1e 8.V.1 b 8.
V.1 c 8.V.2b 
8.V.2c

Week 18 Review Above End of quarter assessment

Supplemented 
by Reading 
teacher in 
weeks at their 
discretion

Students will identify and apply correct 
punctuation  including quotations, 
apostrophes, contractions, ellipsis, 

Module 15 Punctuation 
(italics/underlining, quotation marks, 
apostrophes, contractions, ellipses 
points) 8.W.1b

Students will identify and apply  a 
variety of phrases and ensure parallel 
structure

Module 5: Phrases (adjective, adverb, 
participles and participial, gerunds, 
infinitive, and appositives)

8.W.1c, 8.W.
1e
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Central Ideas and Details

LA.10.RP.1

Analyze the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Unit 1 > Integrated Reading and Writing > The Necklace > Skill: Theme > Model Unit 1 > Integrated 
Reading and Writing > The Necklace > Skill: Theme > Your Turn Unit 1 > Integrated Reading and 
Writing > The Necklace > Close Read: The Necklace > Read > Skills Focus Unit 1 > Integrated 
Reading and Writing > The Necklace > Close Read: The Necklace > Write Unit 2 > Integrated Reading 
and Writing > Volar > Skill: Theme > Model Unit 2 > Integrated Reading and Writing > Volar > Skill: 
Theme > Your Turn Unit 2 > Integrated Reading and Writing > Volar > Close Read: Volar > Write 
Unit 5 > Integrated Reading and Writing > Catch the Moon > Skill: Theme > Model Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Close Read: Catch the Moon > Write

Define theme. Define 
implicit and explicit theme 

and articulate the 
difference. Analyze, implicit, explicit Reinforce

LA.9.RP.2

Analyze how the development of 
characters, settings, and important 
events contribute to the meaning of the 
work as a whole.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Character > Model Unit 1 > 
Integrated Reading and Writing > SyncStart: Marigolds > Skill: Character > Your Turn Unit 1 > 
Integrated Reading and Writing > SyncStart: Marigolds > Skill: Textual Evidence > Model Unit 1 > 
Integrated Reading and Writing > SyncStart: Marigolds > Close Read: Marigolds > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Close Read: Marigolds > 
Write Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Skill: Character > Model 
Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Skill: Character > Your Turn 
Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Close Read: The Cask of 
Amontillado > Read > Skills Focus Unit 4 > Integrated Reading and Writing > The Cask of 
Amontillado > Close Read: The Cask of Amontillado > Write Unit 3 > Integrated Reading and Writing 
> Odyssey (Book XII) > Close Read: Odyssey (Book XII) > Write

Analyze and label 
characters 

(characterization, 
round/flat, dynamic, static, 
foils). Analyze setting for 
impact and limitations. 
Idenfity and label plot 

events as a function. Look 
for deeper meanings 
beyond the surface. 

Characters 
(characterization, 

round/flat, dynamic, 
static), setting, plot 

events Reinforce

Author's Craft What makes great craft?

LA.10.RP.3

Analyze how the author's choices 
related to perspective or point of view 
contribute to the meaning, significance, 
or aesthetic of a literary text.

Unit 2 > Integrated Reading and Writing > The Journey > Skill: Point of View > Model Unit 2 > 
Integrated Reading and Writing > The Journey > Skill: Point of View > Your Turn Unit 5 > Integrated 
Reading and Writing > Catch the Moon > Skill: Point of View > Model Unit 5 > Integrated Reading 
and Writing > Catch the Moon > Skill: Point of View > Your Turn Unit 5 > Integrated Reading and 
Writing > Catch the Moon > Close Read: Catch the Moon > Skills Focus

Note author's choices and 
examine alternatives. 

Analyze how POV impacts 
story. 

POV (narrator), great 
craft Reinforce

LA.9.RP.4

Analyze how an author uses text 
structure, including the manipulation of 
time (e.g., foreshadowing, flashbacks) 
to create literary effects such as 
mystery, tension, and suspense.

Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Skill: Story Structure > Model 
Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Skill: Story Structure > Your 
Turn Unit 4 > Integrated Reading and Writing > The Cask of Amontillado > Close Read: The Cask of 
Amontillado > Read > Skills Focus 4 Unit 5 > Integrated Reading and Writing > Catch the Moon > 
Skill: Story Structure > Model Unit 5 > Integrated Reading and Writing > Catch the Moon > Skill: 
Story Structure > Your Turn Unit 5 > Integrated Reading and Writing > Catch the Moon > Close Read: 
Catch the Moon > Read > Skills Focus 1-2 Unit 4 > Integrated Reading and Writing > The Tragedy of 
Romeo and Juliet (Act II, Scene II) > Skill: Dramatic Elements and Structure > Model Unit 4 > 
Integrated Reading and Writing > The Tragedy of Romeo and Juliet (Act II, Scene II) > Your Turn 
Unit 2 > Integrated Reading and Writing > The Journey > Skill: Poetic Elements and Structure > Model 
Unit 2 > Integrated Reading and Writing > The Journey > Close Read: The Journey > Read > Skills 
Focus

Identify and label time 
manipulations. Explain 
how tension is built in a 

story. 

Annotate for attention to 
text structure, 

manipulation of time 
(flashback, flashforward, 
foreshadowing), tension Reinforce

Knowledge and Ideas

LA.10.RP.5

Analyze how an author draws on and 
transforms source material in a specific 
work (e.g., how Shakespeare treats a 
theme or topic from the Bible).

Unit 1 > Integrated Reading and Writing > St. Lucy’s Home for Girls Raised by Wolves > Skill: 
Allusion > Model Unit 1 > Integrated Reading and Writing > St. Lucy’s Home for Girls Raised by 
Wolves > Skill: Allusion > Your Turn Unit 1 > Integrated Reading and Writing > St. Lucy’s Home for 
Girls Raised by Wolves > Close Read: St. Lucy’s Home for Girls Raised by Wolves > Write Unit 4 > 
Integrated Reading and Writing > The Tragedy of Romeo and Juliet (Act II, Scene II) > Skill: Allusion 
> Model Unit 4 > Integrated Reading and Writing > The Tragedy of Romeo and Juliet (Act II, Scene II) 
> Skill: Allusion > Your Turn Unit 4 > Integrated Reading and Writing > The Tragedy of Romeo and 
Juliet (Act II, Scene II) > Close Read: The Tragedy of Romeo and Juliet (Act II, Scene II) > Write

The student will analyze 
an author's craft and 
identify trends with 

authors.

Allusions, source 
material, building 

historical context, how 
text becomes source 

material itself Reinforce
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LA.9.RP.6

Analyze the implied or stated theme(s) 
in a literary text to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Unit 1 > Integrated Reading and Writing > The Necklace > Skill: Theme > Model + Your Turn Unit 1 
> Integrated Reading and Writing > The Necklace > Close Read: The Necklace > Write Unit 1 > 
Integrated Reading and Writing > The Necklace > Close Read: The Necklace > Teacher Edition > 4. 
Write > Beyond the Book Unit 2 > Integrated Reading and Writing > Volar > Skill: Theme > Model + 
Your Turn Unit 2 > Integrated Reading and Writing > Volar > Close Read: Volar > Write Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Skill: Theme > Model + Your Turn Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Close Read: Catch the Moon > Write Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Close Read: Catch the Moon > Read > Skills 
Focus 3-4

The student will analyze 
theme and explore 

connections to the text. 

Noting repetition (motif) 
and inferencing, active 

reading Reinforce

LA.10.RP.7

Analyze multiple perspectives within 
and across a wide range of literary texts.

Unit 5 > Integrated Reading and Writing > Catch the Moon > Skill: Point of View > Model Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Skill: Point of View > Your Turn Unit 5 > 
Integrated Reading and Writing > Catch the Moon > Close Read: Catch the Moon > Skills Focus Unit 5 
> Integrated Reading and Writing > Catch the Moon > Close Read: Catch the Moon > Write Unit 2 > 
Integrated Reading and Writing > The Journey > Skill: Point of View > Model Unit 2 > Integrated 
Reading and Writing > The Journey > Skill: Point of View > Your Turn Unit 2 > Integrated Reading 
and Writing > The Journey > Close Read: The Journey > Skills Focus Unit 2 > Integrated Reading and 
Writing > The Journey > Close Read: The Journey > Write

The student will explore 
multiple perspectives  

using a variety of 
literature.

Tracking and noting 
perspectives Reinforce

Range of Reading and Level of 
Text Complexity

LA.10.RP.8

Read and comprehend a wide range 
of literary texts of appropriate 
complexity at the high end of the 9-10 
grade band proficiently, with 
scaffolding as needed at the high end 
of the range.

Grade 9 ELA Overview > Text Complexity > Pages 3-97 Unit 1 > Integrated Reading and Writing > 
Metamorphoses > Independent Read: Metamorphoses > Read Unit 6 > Integrated Reading and Writing 
> The Scarlet Ibis > First Read: The Scarlet Ibis > Read Unit 3 > Integrated Reading and Writing > 
Odyssey (Book XII) > First Read: Odyssey (Book XII) > Read Unit 4 > Integrated Reading and 
Writing > Blues Ain't No Mockin Bird > First Read: Blues Ain't No Mockin Bird > Read Unit 5 > 
Integrated Reading and Writing > The Raven > First Read: The Raven > Read Unit 1 > Integrated 
Reading and Writing > The Big Idea > Recognizing Genre > Model Unit 1 > Integrated Reading and 
Writing > The Big Idea > Recognizing Genre > Your Turn Unit 4 > Integrated Reading and Writing > 
The Big Idea > Recognizing Genre > Model Unit 5 > Integrated Reading and Writing > The Big Idea > 
Recognizing Genre > Model Unit 5 > Integrated Reading and Writing > The Big Idea > Recognizing 
Genre > Your Turn Unit 5 > Integrated Reading and Writing > Self-Selected Reading > Blast: Self-
Selected

The student will read and 
engage in grade level text.

Tracking comprehension 
and independantly 

monitor success and 
confusion. Reinforce

R
e
a
d
i
n
g
 
I
n
f
o
r

m
a
t
i
o
n
a
l
 
T
e
x
t

Central Ideas and Details

LA.10.RI.1

Analyze the development of two or 
more implied or explicit central ideas 
over the course of an informational text 
or texts.

Unit 2 > Integrated Reading and Writing > Wild: From Lost to Found on the Pacific Crest Trail > Skill: 
Central or Main Idea > Model Unit 2 > Integrated Reading and Writing > Wild: From Lost to Found on 
the Pacific Crest Trail > Skill: Central or Main Idea > Your Turn Unit 5 > Integrated Reading and 
Writing > Love in a Headscarf > Skill: Central or Main Idea > Model Unit 5 > Integrated Reading and 
Writing > Love in a Headscarf > Skill: Central or Main Idea > Your Turn Unit 4 > Integrated Reading 
and Writing > Quiet: The Power of Introverts in a World That Can’t Stop Talking > Close Read: Quiet: 
The Power of Introverts in a World That Can’t Stop Talking > Read > Skills Focus Unit 4 > Integrated 
Reading and Writing > Quiet: The Power of Introverts in a World That Can’t Stop Talking > Close 
Read: Quiet: The Power of Introverts in a World That Can’t Stop Talking > Read > Write

The student will explore 
central ideas in 

informational text.
Analyze, implicit, explicit, 

fiction vs. nonfiction Reinforce
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LA.10.RI.2

Analyze how the interaction of 
individuals, important events, and key 
ideas contribute to the meaning of the 
work as a whole.

Unit 2 > Integrated Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and 
Finding His Voice: You Can’t Teach Soul > Skill: Informational Text Elements > Model Unit 2 > 
Integrated Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and Finding His 
Voice: You Can’t Teach Soul > Skill: Informational Text Elements > Your Turn Unit 2 > Integrated 
Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and Finding His Voice: You 
Can’t Teach Soul > Close Read: Leon Bridges on Overcoming > Childhood Isolation and Finding His 
Voice: You Can’t Teach Soul > Read > Skills Focus Unit 4 > Integrated Reading and Writing > Quiet: 
The Power of Introverts in a World That Can’t Stop Talking > Skill: Informational Text Elements > 
Model Unit 4 > Integrated Reading and Writing > Quiet: The Power of Introverts in a World That Can’
t Stop Talking > Skill: Informational Text Elements > Your Turn Unit 4 > Integrated Reading and 
Writing > Quiet: The Power of Introverts in a World That Can’t Stop Talking > Close Read: Quiet: The 
Power of Introverts in a World That Can’t Stop Talking > Read > Skills Focus 1, 2, and 3. Unit 6 > 
Integrated Reading and Writing > Maus > Skill: Informational Text Elements > Model Unit 6 > 
Integrated Reading and Writing > Maus > Skill: Informational Text Elements > Your Turn Unit 6 > 
Integrated Reading and Writing > Maus > Close Read: Maus > Read > Skills Focus 3 Unit 2 > 
Integrated Reading and Writing > Wild: From Lost to Found on the Pacific Crest Trail > Close Read: 
Wild: From Lost to Found on the Pacific Crest Trail > Write

The student will analyze 
key ideas and concepts of 
the text to build meaning.

Characters 
(characterization, 

round/flat, dynamic, 
static), setting, plot 
events, key ideas Reinforce

Author's Craft

LA.10.RI.3

Analyze an author's perspective or 
purpose in a text and analyze how an 
author uses rhetoric to advance that 
point of view or purpose.

Unit 4 > Integrated Reading and Writing > Remarks to the Senate in Support of a Declaration of 
Conscience > Skill: Author’s Purpose and Point of View > Model Unit 4 > Integrated Reading and 
Writing > Remarks to the Senate in Support of a Declaration of Conscience > Skill: Author’s Purpose 
and Point of View > Your Turn Unit 4 > Integrated Reading and Writing > Remarks to the Senate in 
Support of a Declaration of Conscience > Close Read: Remarks to the Senate in Support of a 
Declaration of Conscience > Write Unit 2 > Integrated Reading and Writing > Wild: From Lost to 
Found on the Pacific Crest Trail > Skill: Author’s Purpose and Point of View > Model Unit 2 > 
Integrated Reading and Writing > Wild: From Lost to Found on the Pacific Crest Trail > Skill: Author’
s Purpose and Point of View > Your Turn Unit 3 > Integrated Reading and Writing > An Indian Father’
s Plea > Skill: Author’s Purpose and Point of View > Model Unit 3 > Integrated Reading and Writing > 
An Indian Father’s Plea > Skill: Author’s Purpose and Point of View > Your Turn Unit 3 > Integrated 
Reading and Writing > An Indian Father’s Plea > Close Read: An Indian Father’s Plea > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > I Have a Dream > Skill: Rhetoric > Model Unit 1 > 
Integrated Reading and Writing > I Have a Dream > Skill: Rhetoric > Your Turn Unit 1 > Integrated 
Reading and Writing > I Have a Dream > Close Read: I Have a Dream > Read > Skills Focus Unit 1 > 
Integrated Reading and Writing > I Have a Dream > Close Read: I Have a Dream > Write

Students will explore 
authors perpective and 
how they present their 

point of view.
Diction and purpose, 
ethos, pathos, logos Reinforce

LA.10.RI.4

Analyze in detail how an author’s ideas 
or claims are developed and refined by 
particular sentences, paragraphs, or 
larger portions of a text (e.g., a section 
or chapter).

Unit 2 > Integrated Reading and Writing > Restless Genes > Skill: Informational Text Structure > 
Model Unit 2 > Integrated Reading and Writing > Restless Genes > Skill: Informational Text Structure 
> Your Turn Unit 2 > Integrated Reading and Writing > Restless Genes > Close Read: Restless Genes 
> Read > Skills Focus 2-3 Unit 3 > Integrated Reading and Writing > An Indian Father’s Plea > Skill: 
Informational Text Structure > Model Unit 3 > Integrated Reading and Writing > An Indian Father’s 
Plea > Skill: Informational Text Structure > Your Turn Unit 3 > Integrated Reading and Writing > An 
Indian Father’s Plea > Close Read: An Indian Father’s Plea > Read > Skills Focus Unit 3 > Integrated 
Reading and Writing > An Indian Father’s Plea > Close Read: An Indian Father’s Plea > Write Unit 2 > 
Integrated Reading and Writing > Restless Genes > Close Read: Restless Genes > Write

Students will explore 
authors perpective and 
how they present their 

point of view.
Author's purpose and 

development Reinforce

Knowledge and Ideas

LA.10.RI.5

Analyze informational texts of historical 
and/or cultural significance, including 
their treatment of related topics and 
concepts.

Unit 1 > Integrated Reading and Writing > I Have a Dream > Skill: Primary and Secondary Sources > 
Model Unit 1 > Integrated Reading and Writing > I Have a Dream > Skill: Primary and Secondary 
Sources > Your Turn Unit 1 > Integrated Reading and Writing > I Have a Dream > Close Read: I Have 
a Dream > Read > Skills Focus Unit 4 > Integrated Reading and Writing > Remarks to the Senate in 
Support of a Declaration of Conscience > Skill: Primary and Secondary Sources > Model Unit 4 > 
Integrated Reading and Writing > Remarks to the Senate in Support of a Declaration of Conscience > 
Skill: Primary and Secondary Sources > Your Turn Unit 4 > Integrated Reading and Writing > 
Remarks to the Senate in Support of a Declaration of Conscience > Close Read: Remarks to the Senate 
in Support of a Declaration of Conscience > Read > Skills Focus

Students will analyze 
informational texts to 
expand knowledge of 
historical and cultural 

significance.

Allusion, cultural 
significance (lens), who 

is telling the story for 
whom, who/what is 

missing? Reinforce
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LA.10.RI.6

Compare and contrast the 
development of different arguments on 
the same topic, evaluating the 
effectiveness and validity of the claims.

Unit 3 > Integrated Reading and Writing > The Origin of Intelligence > Skill: Arguments and Claims > 
Model Unit 3 > Integrated Reading and Writing > The Origin of Intelligence > Skill: Arguments and 
Claims > Your Turn Unit 3 > Integrated Reading and Writing > The Origin of Intelligence > Close 
Read: The Origin of Intelligence > Read > Skills Focus Unit 3 > Integrated Reading and Writing > The 
Origin of Intelligence > Skill: Logical Fallacies > Model Unit 3 > Integrated Reading and Writing > 
The Origin of Intelligence > Skill: Logical Fallacies > Your Turn Unit 3 > Integrated Reading and 
Writing > The Origin of Intelligence > Close Read: The Origins of Intelligence > Read > Skills Focus 
Unit 3 > Integrated Reading and Writing > The Origin of Intelligence > Close Read: The Origins of 
Intelligence > Write

Students will compare and 
contrast two pieces of 

work on the same topic.

Compare AND contrast, 
exposure to different 

arguments Reinforce

LA.10.RI.7

Analyze how an author or speaker 
unfolds a series of events, ideas, or 
perspectives within and across a wide 
range of informational texts.

Unit 2 > Integrated Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and 
Finding His Voice: You Can’t Teach Soul > Skill: Informational Text Elements > Model Unit 2 > 
Integrated Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and Finding His 
Voice: You Can’t Teach Soul > Skill: Informational Text Elements > Your Turn Unit 2 > Integrated 
Reading and Writing > Leon Bridges on Overcoming Childhood Isolation and Finding His Voice: You 
Can’t Teach Soul > Close Read: Leon Bridges on Overcoming > Childhood Isolation and Finding His 
Voice: You Can’t Teach Soul > Read > Skills Focus Unit 4 > Integrated Reading and Writing > Quiet: 
The Power of Introverts in a World That Can’t Stop Talking > Skill: Informational Text Elements > 
Model Unit 4 > Integrated Reading and Writing > Quiet: The Power of Introverts in a World That Can’
t Stop Talking > Skill: Informational Text Elements > Your Turn Unit 4 > Integrated Reading and 
Writing > Quiet: The Power of Introverts in a World That Can’t Stop Talking > Close Read: Quiet: The 
Power of Introverts in a World That Can’t Stop Talking > Read > Skills Focus 1, 2, and 3. Unit 6 > 
Integrated Reading and Writing > Maus > Skill: Informational Text Elements > Model Unit 6 > 
Integrated Reading and Writing > Maus > Skill: Informational Text Elements > Your Turn Unit 6 > 
Integrated Reading and Writing > Maus > Close Read: Maus > Read > Skills Focus 3 Unit 2 > 
Integrated Reading and Writing > Wild: From Lost to Found on the Pacific Crest Trail > Close Read: 
Wild: From Lost to Found on the Pacific Crest Trail > Write

Students will analyze how 
an author unforlds a series 

of events.

Intentional sequencing - 
noting it and evaluating 

effectiveness. Reinforce

Range of Reading and Level of 
Text Complexity

LA.10.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity at the high end of the 9- 10 
grade band proficiently, with 
scaffolding as needed at the high end 
of the range.

Grade 9 ELA Overview > Text Complexity > Page 3-97 Unit 1 > Integrated Reading and Writing > 
Why I Lied to Everyone in High School About Knowing Karate > Independent Read: Why I Lied to 
Everyone in High School About Knowing Karate > Read Unit 4 > Integrated Reading and Writing > 
Remarks to the Senate in Support of a Declaration of Conscience > First Read: Remarks to the Senate 
in Support of a Declaration of Conscience > Read Unit 3 > Integrated Reading and Writing > Self-
Selected Reading > Blast: Self-Selected Unit 5 > Integrated Reading and Writing > Love in a 
Headscarf > First Read: Love in a Headscarf > Read Unit 6 > Integrated Reading and Writing > Advice 
to Little Girls > Independent Read: Advice to Little Girls > Read Unit 4 > Integrated Reading and 
Writing > Self-Selected Reading > Blast: Self-Selected Unit 2 > Integrated Reading and Writing > 
Restless Genes > First Read: Restless Genes > Read Unit 2 > Integrated Reading and Writing > The 
Big Idea > Recognizing Genre > Model Unit 3 > Integrated Reading and Writing > The Big Idea > 
Recognizing Genre > Model

Students will read and 
comprehend a wide range 

of informational texts.
Active reading and 

annotation Reinforce
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Acquisition and Use

LA.10.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Unit 4 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Vocabulary 
Unit 4 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Model Unit 4 
> Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Your Turn Unit 1 > 
Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Vocabulary Unit 1 > 
Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Model Unit 1 > 
Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Your Turn Unit 3 > 
Integrated Reading and Writing > The Most Dangerous Game > Close Read: The Most Dangerous 
Game > Vocabulary

Students will explore 
grade level vocabulary to 
increase comprehension. Tone vocabulary Reinforce
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LA.10.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Context Clues > Model Unit 1 
> Integrated Reading and Writing > SyncStart: Marigolds > Skill: Context Clues > Your Turn Unit 3 > 
Integrated Reading and Writing > Georgia O’Keeffe > Skill: Context Clues > Model Unit 3 > 
Integrated Reading and Writing > Georgia O’Keeffe > Skill: Context Clues > Your Turn

Students will explore 
grade level vocabulary to 
increase comprehension. 

Context clues and 
function Reinforce

LA.10.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
analyze, analysis).

Unit 4 > Integrated Reading and Writing > Quiet: The Power of Introverts in a World That Can’t Stop 
Talking > Skill: Word Patterns and Relationships > Model Unit 4 > Integrated Reading and Writing > 
Quiet: The Power of Introverts in a World That Can’t Stop Talking > Skill: Word Patterns and 
Relationships > Your Turn Unit 6 > Integrated Reading and Writing > Letters to a Young Poet > Skill: 
Word Patterns and Relationships > Model Unit 6 > Integrated Reading and Writing > Letters to a 
Young Poet > Skill: Word Patterns and Relationships > Your Turn

Students will explore 
grade level vocabulary to 
increase comprehension. Reinforce

LA.10.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, or 
etymology of words.

Unit 2 > Integrated Reading and Writing > Restless Genes > Skill: Word Meaning > Model Unit 2 > 
Integrated Reading and Writing > Restless Genes > Skill: Word Meaning > Your Turn Unit 6 > 
Integrated Reading and Writing > The Scarlet Ibis > Skill: Word Meaning > Model Unit 6 > Integrated 
Reading and Writing > The Scarlet Ibis > Skill: Word Meaning > Your Turn

Students will explore 
grade level vocabulary to 
increase comprehension. etymology Reinforce

Context and Connotations

LA.10.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Library > Skills > Search: Technical Language > Filter: Grade 9 > Spotlight: Technical Language > 
Model Library > Skills > Search: Technical Language > Filter: Grade 9 > Spotlight: Technical 
Language > Your Turn For correlations to cover figurative and connotative language, see the breakout 
standards below.

Students will explore 
figurative languge in 
informational text. 

Connotation vs 
denotation, figurative 

language, nuance, text 
features Reinforce

LA.10.V.2.a

a. Interpret figures of speech (e.g., 
euphemism, oxymoron) in context and 
analyze their role in text.

Unit 6 > Integrated Reading and Writing > I Know Why the Caged Bird Sings > Skill: Figurative 
Language > Model Unit 6 > Integrated Reading and Writing > I Know Why the Caged Bird Sings > 
Skill: Figurative Language > Your Turn Unit 5 > Integrated Reading and Writing > Integrated Reading 
and Writing > Dusting > Skill: Figurative Language > Model Unit 5 > Integrated Reading and Writing 
> Integrated Reading and Writing > Dusting > Close Read: Dusting > Write Unit 5 > Integrated 
Reading and Writing > A Song of Changgan > Independent Read: A Song of Changgan > Write

Students will explore 
figurative languge in 
informational text. Reinforce

LA.10.V.2.b

b.Analyze nuances in the meanings of 
words with similar denotations.

Unit 5 > Integrated Reading and Writing > The Raven > Skill: Connotation and Denotation > Model 
Unit 5 > Integrated Reading and Writing > The Raven > Skill: Connotation and Denotation > Your 
Turn Unit 2 > Integrated Reading and Writing > Restless Genes > Skill: Connotation and Denotation > 
Model Unit 4 > Integrated Reading and Writing > Blues Ain’t No Mockingbird > Skill: Connotation 
and Denotation > Model Unit 1 > Integrated Reading and Writing > Angela’s Ashes > Skill: Language, 
Style, and Audience > Model Unit 1 > Integrated Reading and Writing > Angela’s Ashes > Skill: 
Language, Style, and Audience > Your Turn

Students will explore 
figurative languge in 
informational text. Reinforce

Production of Writing

LA.10.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and add variety, interest, and 
fluency to written and spoken 
language.

Unit 2 > Extended Writing Project and Grammar > Plan > Informative Writing Process: Plan > Read 
Unit 2 > Extended Writing Project and Grammar > Draft > Informative Writing Process: Draft > Write 
Unit 2 > Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise > 
Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Informative Writing 
Process: Edit and Publish > Write

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.
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LA.10.W.1.a

a. Apply knowledge of rules for 
capitalization.

Library > Skills > Filter > Select: Grade 9 > Select: Grammar > Search: Capitalization > Capitalization 
- Other Proper Nouns > Model + Your Turn Library > Skills > Filter > Select: Grade 9 > Select: 
Grammar > Search: Capitalization > Capitalization - Quotations > Model + Your Turn Library > Skills 
> Filter > Select: Grade 9 > Select: Grammar > Search: Capitalization > Capitalization - Proper 
Adjectives > Model + Your Turn Library > Skills > Filter > Select: Grade 9 > Select: Grammar > 
Search: Capitalization > Capitalization -Sentences > Model + Your Turn Unit 3 > Extended Writing 
Project and Grammar > Edit and Publish > Argumentative Writing Process: Edit and Publish > Write - 
Checklist

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.b

b. Use a colon to introduce a quotation, 
definition, or to expand on information 
in a sentence; use a semicolon with a 
conjunctive adverb.

Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Colons and Semicolons > 
Model Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Colons and 
Semicolons > Your Turn Unit 4 > Extended Writing Project and Grammar > Edit and Publish > Skill: 
Conjunctive Adverbs > Model Unit 2 > Extended Writing Project and Grammar > Edit and Publish > 
Skill: Colons > Model Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: 
Colons > Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.c

c. Apply knowledge of function and 
usage to revise personal writing while 
resolving issues of complex or contested 
usage, consulting appropriate and 
reliable reference materials.

Unit 4 > Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style Guide > 
Model Unit 4 > Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style 
Guide > Your Turn Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style 
> Model Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your 
Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.d

d. Select and use verbs with 
appropriate voice and mood.

Library > Skills > Filter > Select: Grade 9 > Select: Grammar > Search: Verbs > Active and Passive 
Voice > Model + Your Turn Library > Skills > Filter > Select: Grade 9 > Select: Grammar > Search: 
Verbs > Verbs - Consistent Verb Voice and Mood > Model + Your Turn Library > Skills > Filter > 
Select: Grade 9 > Select: Grammar > Search: Verbs > Verbs - Verb Moods > Model + Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.e

e. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tense, number, voice, mood, and 
parallel structure.

Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Sentence Structure > 
Sentence Structure - Sentence Fragments > Model + Your Turn Library > Skills > Filter > Select: 
Grade 10 > Select: Grammar > Search: Sentence Structure > Sentence Structure - Run-On Sentences > 
Model + Your Turn Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Grammar 
Skill: Independent and Dependent Clauses > Model + Your Turn Library > Skills > Filter > Select: 
Grade 10 > Select: Grammar > Search: Subject-Verb > Subject-Verb Agreement > Model + Your Turn 
Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Verbs > Verbs - 
Distinguishing Tenses > Model + Your Turn Library > Skills > Filter > Select: Grade 10 > Select: 
Grammar > Search: Verbs > Verbs - Consistent Verb Tenses > Model + Your Turn Library > Skills > 
Filter > Select: Grade 10 > Select: Grammar > Search: Verbs > Verbs - Consistent Verb Voice and 
Mood > Model + Your Turn Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: 
Verbs > Verbs - Verb Moods > Model + Your Turn Unit 3 > Extended Writing Project and Grammar > 
Edit and Publish > Skill: Parallel Structure > Model > Teacher Edition - Instruction 2. Model Unit 3 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Parallel Structure > Model > Your 
Turn Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Skill: Independent and 
Dependent Clauses > Model > Teacher Edition - Instruction 2. Model Unit 1 > Extended Writing 
Project and Grammar > Edit and Publish > Skill: Independent and Dependent Clauses > Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Unit 3 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > 
Write Unit 3 > Extended Writing Project and Grammar > Draft > Argumentative Writing Process: 
Draft > Write Unit 3 > Extended Writing Project and Grammar > Revise > Argumentative Writing 
Process: Revise > Write Unit 3 > Extended Writing Project and Grammar > Edit and Publish > 
Argumentative Writing Process: Edit and Publish > Write Unit 1 > Integrated Reading and Writing > 
SyncStart: Marigolds > Skill: Peer Review > Model

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce
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LA.10.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Unit 5 > Extended Writing Project and Grammar > Plan > Literary Analysis Writing Process: Plan > 
Write Unit 5 > Extended Writing Project and Grammar > Draft > Literary Analysis Writing Process: 
Draft > Write Unit 2 > Extended Writing Project and Grammar > Plan > Informative Writing Process: 
Plan > Write Unit 2 > Extended Writing Project and Grammar > Draft > Informative Writing Process: 
Draft > Write Unit 1 > Extended Writing Project and Grammar > Plan > Narrative Writing Process: 
Plan > Write Unit 1 > Extended Writing Project and Grammar > Draft > Narrative Writing Process: 
Draft > Write Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > 
Model Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your 
Turn Unit 2 > Integrated Reading and Writing > Apollo 13: Mission Highlights > Independent Read: 
Apollo 13: Mission Highlights > Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Unit 1 > Integrated Reading and Writing > Metamorphoses > Independent Read: Metamorphoses> 
Write (Personal Response) Unit 3 > Integrated Reading and Writing > Georgia O’Keeffe> Close Read: 
Georgia O’Keeffe > Write (Rhetorical Analysis) Unit 6 > Integrated Reading and Writing > 
Lumberjanes Vol. 1: Beware the Kitten Holy > Close Read: Lumberjanes Vol. 1: Beware the Kitten 
Holy > Write (Literary Analysis) Unit 1 > Integrated Reading and Writing > Timed Writing > Write: 
Timed Writing Unit 4 > Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 
6 > Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 1 > Extended 
Writing Project and Grammar > Plan > Narrative Writing Process: Plan > Write Unit 1 > Extended 
Writing Project and Grammar > Draft > Narrative Writing Process: Draft > Write Unit 1 > Extended 
Writing Project and Grammar > Revise > Narrative Writing Process: Revise > Write Unit 1 > Extended 
Writing Project and Grammar > Edit and Publish > Narrative Writing Process: Edit and Publish > 
Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Peer Review > Model Unit 1 
> Extended Writing Project and Grammar > Revise > Narrative Writing Process: Revise > Write > 
Teacher Edition: 1. Write - Review Revision Guide + Peer Review and Reflect Unit 1 > Extended 
Writing Project and Grammar > Edit and Publish > Narrative Writing Process: Edit and Publish > 
Write Unit 2 > Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise 
> Write > Teacher Edition: 1. Write - Review Revision Guide + Peer Review and Reflect Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit and 
Publish > Write Unit 3 > Extended Writing Project and Grammar > Revise > Argumentative Writing 
Process: Revise > Write > Teacher Edition: 1. Write - Review Revision Guide + Peer Review and 
Reflect Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Argumentative Writing 
Process: Edit and Publish > Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Unit 5 > Extended Writing Project and Grammar > Edit and Publish > Literary Analysis Writing 
Process: Edit and Publish > Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish 
> Informative Writing Process: Edit and Publish > Write Unit 1 > Extended Writing Project and 
Grammar > Edit and Publish > Narrative Writing Process: Edit and Publish > Write Unit 1 > A Voice > 
Independent Read: A Voice > Write > View Rubric – Language and Conventions Unit 1 > Integrated 
Reading and Writing > SyncStart: Marigolds > Skill: Peer Review > Model + Your Turn

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Grade 9 > Additional Resources > Project Based Learning > Page 25 > The Art of Disguise Grade 9 > 
Additional Resources > Project Based Learning > Page 26 > Community Cleanup Day Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit and 
Publish > Write Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Narrative 
Writing Process: Edit and Publish > Write Unit 4 > Integrated Reading and Writing > Self-Selected 
Reading > Write: Self-Selected Response > Write Unit 4 > Extended Writing Project and Grammar > 
Edit and Publish > Research Writing Process: Edit and Publish > Write Unit 6 > Integrated Reading 
and Writing > I Know Why the Caged Bird Sings > Blast: Growing Paynes > Create Your Blast

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

Modes of Writing
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LA.10.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and audience.

Unit 4 > Integrated Reading and Writing > West Side Story > Close Read: West Side Story > Write 
(Drama) Unit 6 > Integrated Reading and Writing > Letters to a Young Poet > Close Read: Letters to a 
Young Poet > Write (Correspondence) Unit 6 > Integrated Reading and Writing > The Girl Who Can > 
Independent Read: The Girl Who Can > Write (Narrative) See additional correlations for breakout 
standards below

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Story Beginnings > Your Turn Unit 1 > Extended 
Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > Your Turn

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Model Unit 
1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Your Turn Unit 1 
> Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Sequencing > Your Turn 
Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Sequencing > Your Turn 1 
Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Sequencing > Your Turn 2

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to establish mood and 
tone.

Unit 1 > Extended Writing Project and Grammar > Draft > Skill: Descriptive Details > Model Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Descriptive Details > Your Turn Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Descriptive Details > Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 3 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 3 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 3 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 3 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Write Unit 3 > Extended Writing Project and 
Grammar > Revise > Skill: Introductions > Your Turn Unit 3 > Extended Writing Project and Grammar 
> Draft > Skill: Organize Argumentative Writing > Model Unit 3 > Extended Writing Project and 
Grammar > Draft > Skill: Organize Argumentative Writing > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 3 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 3 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 3 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 3 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Write Unit 3 > Extended Writing Project and 
Grammar > Revise > Skill: Introductions > Your Turn Unit 3 > Extended Writing Project and Grammar 
> Draft > Skill: Organize Argumentative Writing > Model Unit 3 > Extended Writing Project and 
Grammar > Draft > Skill: Organize Argumentative Writing > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce
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LA.10.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Reason and Relevant Evidence > 
Model Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Reason and Relevant Evidence 
> Your Turn Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reason and Relevant 
Evidence > Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reason and 
Relevant Evidence > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 3 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 3 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Transitions > Model Unit 5 > Extended Writing Project and 
Grammar > Revise > Skill: Transitions > Write Unit 5 > Extended Writing Project and Grammar > 
Revise > Skill: Transitions > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 3 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 5 > Extended 
Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Informative Writing > Model Unit 2 > Extended 
Writing Project and Grammar > Draft > Skill: Organizing Informative Writing > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 2 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Model Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Your Turn Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Print and Graphic Features > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Informative Writing > Model Unit 2 > Extended 
Writing Project and Grammar > Draft > Skill: Organizing Informative Writing > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 2 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Model Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Your Turn Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Print and Graphic Features > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.b

b. Develop the topic with relevant, 
sufficient facts, extended definitions, 
concrete details, quotations, and/or 
other information and examples. Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Model Unit 2 > 

Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce
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LA.10.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic. Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 2 > 

Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.6

Gather and use credible evidence from 
multiple authoritative sources and assess 
its relevance in answering the research 
question(s).

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Sources and Citations >Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Sources and Citations >Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 6 > Extended 
Oral Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Model 
Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Your Turn 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Model 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce
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LA.10.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g. MLA, APA, Chicago).

Unit 6 > Extended Writing Project and Grammar > Revise > Skill: Sources and Citations > Model Unit 
6 > Extended Writing Project and Grammar > Revise > Skill: Sources and Citations >Write Unit 4 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style Guide > Model Unit 
4 > Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style Guide > Your 
Turn Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 2 
> Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Library > Blasts > Filter > Search: To Be Honest > Blast: To Be Honest > Background Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model + Your Turn Unit 
4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model + Your Turn Unit 
6 > Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model + Your Turn

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

Comprehension and Collaboration

LA.10.SL.1

Initiate and participate in structured 
discussions and collaborations about 
grade-level topics and texts.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative 
Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Your Turn Unit 3 > Integrated Reading and Writing > The Singularity is Near > Close 
Read: The Singularity is Near > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative 
Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Your Turn Unit 3 > Integrated Reading and Writing > The Singularity is Near > Close 
Read: The Singularity is Near > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative 
Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Communicating Ideas > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Communicating Ideas > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Engaging in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Engaging in Discourse > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative 
Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Your Turn Unit 3 > Integrated Reading and Writing > The Singularity is Near > Close 
Read: The Singularity is Near > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model 
Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Write Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Model Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Edit and Present > Oral Presentation Process - Edit and Present 
> Model - Active Listening Checklist

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce
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LA.10.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Grade 9 > Additional Resources > Project Based Learning > Page 22 > Welcome Packet Grade 9 > 
Additional Resources > Project Based Learning > Page 23 > Book Festival Grade 9 > Additional 
Resources > Project Based Learning > Page 24 > Community Service Matching Tool Grade 9 > 
Additional Resources > Project Based Learning > Page 25 > Community Performance Grade 9 > 
Additional Resources > Project Based Learning > Page 26 > Community Cleanup Day Grade 9 > 
Additional Resources > Project Based Learning > Page 27 > Mentorship Program

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

Presentation of Knowledge and Ideas

LA.10.SL.2

Present information, findings, and 
supporting evidence clearly and 
concisely and in which the organization, 
development, and style are appropriate 
to a variety of tasks, purposes, and 
audiences.

Unit 6 > Extended Oral Project and Grammar > Skill: Communicating Ideas > Model Unit 6 > 
Extended Oral Project and Grammar > Skill: Communicating Ideas > Your Turn + Write Unit 6 > 
Extended Oral Project and Grammar > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral 
Project and Grammar > Skill: Engaging in Discourse > Write Unit 6 > Extended Oral Project and 
Grammar > Revise > Skill: Reasons and Evidence > Model Unit 4 > Extended Oral Project and 
Grammar > Revise > Skill: Reasons and Evidence > Your Turn Unit 4 > Extended Oral Project and 
Grammar > Oral Presentation Process: Edit and Present > Write - Presentation Checklist

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Unit 6 > Extended Oral Project and Grammar > Skill: Communicating Ideas > Model Unit 6 > 
Extended Oral Project and Grammar > Skill: Communicating Ideas > Your Turn + Write Unit 6 > 
Extended Oral Project and Grammar > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral 
Project and Grammar > Skill: Engaging in Discourse > Write Unit 6 > Extended Oral Project and 
Grammar > Revise > Skill: Reasons and Evidence > Model Unit 4 > Extended Oral Project and 
Grammar > Revise > Skill: Reasons and Evidence > Your Turn Unit 4 > Extended Oral Project and 
Grammar > Oral Presentation Process: Edit and Present > Write - Presentation Checklist

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Marigolds > Skill: Collaborative 
Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Your Turn Unit 6 > Extended Oral Project and Grammar > Edit and Present > Edit and 
Present: Write Unit 3 > Integrated Reading and Writing > The Singularity is Near > Close Read: The 
Singularity is Near > Write Unit 4 > Integrated Reading and Writing > Blues Ain’t No Mockin Bird > 
Close Read: Blues Ain’t No Mockin Bird > Write

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.c

c. Analyze the purpose of information 
being presented, evaluate its motives 
(e.g., social, commercial, political), and 
determine its credibility.

Unit 6 > Extended Oral Project > Revise > Skill: Reasons and Evidence > Model Unit 6 > Extended 
Oral Project > Revise > Skill: Reasons and Evidence > Your Turn Unit 4 > Integrated Reading and 
Writing > Remarks to the Senate in Support of a Declaration of Conscience > Skill: Author’s Purpose 
and Point of View > Model Unit 4 > Integrated Reading and Writing > Remarks to the Senate in 
Support of a Declaration of Conscience > Close Read: Remarks to the Senate in Support of a 
Declaration of Conscience > Write Unit 1 > Integrated Reading and Writing > I Have a Dream > Skill: 
Rhetoric > Model Unit 1 > Integrated Reading and Writing > I Have a Dream > Skill: Rhetoric > Your 
Turn Unit 1 > Integrated Reading and Writing > I Have a Dream > Close Read: I Have a Dream > Read 
> Skills Focus Unit 1 > Integrated Reading and Writing > I Have a Dream > Close Read: I Have a 
Dream > Write

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Unit 5 > Integrated Reading and Writing > The Raven > Skill: Connotation and Denotation > Model 
Unit 5 > Integrated Reading and Writing > The Raven > Skill: Connotation and Denotation > Your 
Turn Unit 2 > Integrated Reading and Writing > Restless Genes > Skill: Connotation and Denotation > 
Model + Your Turn Unit 4 > Integrated Reading and Writing > Blues Ain’t No Mockin Bird > Skill: 
Connotation and Denotation > Model + Your Turn Unit 4 > Integrated Reading and Writing > Blues 
Ain’t No Mockin Bird > Close Read: Blues Ain’t No Mockin Bird > Write Library > Blast > Search: In 
the Deep > Blast: In the Deep Library > Blast > Search: Word for Word > Blast: Word for Word

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.e

e. Select and use appropriate visual 
and/or digital tools to enhance verbal 
communication and add interest.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing Oral Presentation > Model 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write 
Unit 6 > Extended Oral Project and Grammar > Plan > Oral Presentation Process: Plan > Intro Unit 6 > 
Extended Oral Project and Grammar > Plan > Oral Presentation Process: Plan > Read Unit 6 > 
Extended Oral Project and Grammar > Plan > Oral Presentation Process: Plan > Write Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.
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English 9 Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment
SHAKESPEARE

4 weeks

SWBAT recognize and define elements of drama (soliloquy, 
monologue, dialogue, aside, stage directions, prologue, 
tragedy).   SWBAT define summary, paraphrase, and parallel 
structure. Students will provide examples of each through the 
play. SWBAT recognize literary devices and plot elements in 
use and analyze their significance & efficacy: (alliteration, 
allusion, characterization, dynamic vs. static characters, foils, 
climax, types of irony, foreshadowing, metaphor, motif, pun, 
simile, theme). SWBAT apply understanding of sound devices 
(rhyme scheme, couplet, meter, iambic pentameter) to create 
a standard Shakespearean sonnet. SWBAT incorporate text 
evidence to support summary and analysis (introducing 
citations). Students will also learn about interview techniques 
when interviewing own parents/guardians and then will write a 
synopsis of that interview while comparing and contrasting 
these results with those of the characters to synthesize a 
statement about relationship values. Students will then 
analyze motif for meaning and will then produce a written 
representation about the meaning and value of the motif. 

The Tragedy of Romeo and Juliet "Sonnet 116" Student scene adaptions, sonnet, 
quizzes, Act 1&2 test, Final

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

MEMOIR: Lit Circles, 
Topic: Divided We Fall 2 weeks

SWBAT define notice and note sign posts and apply those to 
the group reading; SWBAT identify author's purpose and 
analyze craft with attention to sequencing and voice Persepolis,  Night

"Marigolds" - the importance of 
learning other perspectives, poem 
"Welcome to America," Poem 
"Ode to the Selfie," Brené Brown's 
"Braving the Wilderness," TED 
"Power of Vulnerability," 

Student choice assessment; "This I 
Believe" Speech

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

ALLEGORY 2 weeks

SWBAT define symbolism, allegory, and lens (government, 
psychological, trauma); SWBAT develop symbolic 
interpretation through their selected lens (focusing on 
characters) and defend it with text evidence; SWBAT create 
their own symbols with explanation Lord of the Flies

"The Cask of Amontillado," "The 
Scarlet Ibis," "St. Lucy's Home for 
Girls Raised by Wolves" Mask project; reading checks

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

UNIVERSAL THEME 4 weeks

SWBAT track thematic development through textual passages 
and apply those in the novel and to their own lives; SWBAT 
identify historical/cultural influences on the novel (specifically 
Jim Crow, court language, and gender expectations); SWBAT 
generate a stance on controversial novels To Kill a Mockingbird

"To My Younger Self," Just Mercy 
excerpts; "A Woman's Place"  One pager; Part one test, final

STATE FAIR: 
Scholarship Writing



English 9 Support- Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync Materials/Supporting 

Materials Assessment

Short Stories 3 weeks

SWBAT: identify, define, and use plot 
elements, including exposition, rising 
action, climax, falling action, resolution, 
setting, and climax.

"The Bass, The River, and Shelia Mant," "Sniper," "A 
Sound of Thunder," "The Pedestrian," "The Most 
Dangerous Game," "The Cask of Amontillado," "The 
Scarlet Ibis," "The Lady or the Tiger," "If There Be 
Sorrow" Reading Checks

SWBAT: identify, define, and use 
figurative language, including simile, 
metaphor, personification, and hyperbole. Blasts Class and Group Discussions
SWBAT: identify, define, and use 
figurative elements, including but not 
limited to foreshadowing, predictions, and 
suspense. ELL Resourses- extended writing and tools Written Responses
SWBAT: identify, define, and use author’s 
purpose, author’s tone, and the different 
forms of irony (situational, verbal, 
dramatic). Vocabulary and Grammar Skills Summative Test
SWBAT: identify and define 
symbolism.
SWBAT: identify and define 
inference.

Drama/Shakespeare 5 weeks

SWBAT: Identify and define the 
elements of a drama, including but 
not limited to soliloquy, monologue, 
dialogue, aside, stage directions, 
prologue, and tragedy. Romeo and Juliet Blasts Reading Checks
SWBAT: define and identify 
summary, paraphrase, and parallel 
structure throughout the play. ELL Resourses- extended writing and tools Class and Group Discussions
SWBAT: recognize literary devices 
and plot elements in use and analyze 
their significance and efficacy 
(alliteration, allusion, characterization, 
types of characters, foils, climax, 
types of irony, foreshadowing, 
metaphor, motif, pun, simile, theme). Grammar and Vocabulary Skills Written Responses
SWBAT: apply understanding of 
sound devices (rhyme scheme, 
couplet, meter, iambic pentameter). Thematic Selections (short stories and sonnets) Summative Test
SWBAT: incorporate text evidence to 
support summary and analysis of the 
play.

Memoir 5 weeks

SWBAT: reflect on identity, how it is 
formed, and how it connects to 
elements of the Holocaust. Night Blasts Reading Checks
SWBAT: annotate historical 
resources to use text evidence as 
support. Thematic Selection (short stories) Class and Group Discussions
SWBAT: reflect on the moral complexity 
represented in resources about and from 
the Holocaust. ELL Resourses- extended writing and tools Written Responses
SWBAT: identify author’s purpose 
and voice. Vocabulary/Grammar Skills Summative Test
SWBAT: analyze, compare, and 
contrast different stories of survival 
during the Holocaust to Elie’s 
experiences. Thematic Selection (short stories)

Research and Writing 4 weeks
SWBAT: develop a strong research 
question. Research Notes (slides or cards)
SWBAT: create a working thesis 
statement. Outline
SWBAT: support their thesis 
statement with strong sub-questions. Introduction Paragraph, Body Paragraph, Conclusion Paragraph
SWBAT: understand and apply 
standards of source credibility. MLA Works Cited Page
SWBAT: take effective notes while 
researching to support the thesis. Self-Revision Copy
SWBAT: create an effective outline. Peer-Revision Copy
SWBAT: construct a proper 
introduction paragraph, body 
paragraph, and conclusion 
paragraph.
SWBAT: use MLA in-text citations 
and properly cite evidence.
SWBAT: create an MLA works cited 
page
SWBAT: effectively participate in and 
use individual and peer revision 
techniques. 

Allegory 5 weeks

SWBAT:  define and recognize 
symbolism and allegory in use and 
analyze their significance and 
efficacy. Lord of the Flies Blasts Reading Checks
SWBAT: develop interpretations and 
opinions on human nature, 
considering studied sources on the 
fundamental goodness/evilness of 
human beings. ELL Resourses- extended writing and tools Class and Group Discussions
SWBAT: to determine, defend, and 
investigate thematic topics (nature of 
evil, survival, order versus chaos, loss 
of innocence, identity). "The Cask of Amontillado" and "The Scarlet Ibis" Written Responses

Vocabulary/Grammar Skills Mask Project
Summative Test

Theme 5 weeks

SWBAT: define, interpret, and find 
text evidence to support the theme(s) 
in studied texts To Kill a Mockingbird Blasts Reading Checks
SWBAT: track and apply thematic 
development through studied texts ELL Resourses- extended writing and tools Class and Group Discussions
SWBAT: historical and cultural 
influences on studied texts Vocabulary/Grammar Skills Written Responses
SWBAT: research, develop, and 
support a stance on themes in 
studied text Thematic Selections (short stories) One Pager

Summative Test
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Central Ideas and Details

LA.10.RP.1

Analyze the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Unit 1 > Integrated Reading and Writing > She Unnames Them > Skill: Theme > Model Unit 1 > 
Integrated Reading and Writing > She Unnames Them > Skill: Theme > Your Turn Unit 1 > 
Integrated Reading and Writing > She Unnames Them > Close Read: She Unnames Them > 
Read > Skills Focus Unit 1 > Integrated Reading and Writing > She Unnames Them > Close 
Read: She Unnames Them > Write Unit 1 > Integrated Reading and Writing > Things Fall Apart 
> Skill: Theme > Model Unit 1 > Integrated Reading and Writing > Things Fall Apart > Close 
Read: Things Fall Apart > Write

Students will recognize 
and identify patterns to 

clues toward theme 
development and will 

identify supporting details 
to defend analysis. Analyze, implicit, explicit Reinforce

LA.10.RP.2

Analyze how the development of 
characters, settings, and important 
events contribute to the meaning of the 
work as a whole.

Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Character > Model 
Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Character > Your 
Turn Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Textual 
Evidence > Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Close 
Read: The Refusal > Read > Skills Focus Unit 1 > Integrated Reading and Writing > SyncStart: 
The Refusal > Close Read: The Refusal > Write Unit 1 > Integrated Reading and Writing > 
Things Fall Apart > Skill: Point of View > Model + Your Turn Unit 3 > Integrated Reading and 
Writing > Persepolis > Skill: Character > Model + Your Turn Unit 3 > Integrated Reading and 
Writing > Persepolis > Close Read: Persepolis > Read > Skills Focus Unit 3 > Integrated Reading 
and Writing > Persepolis > Close Read: Persepolis > Write Unit 4 > Integrated Reading and 
Writing > Macbeth, Act I, Scene iii > Skill: Character > Model + Your Turn Unit 4 > Integrated 
Reading and Writing > Macbeth, Act I, Scene iii > Close Read: Macbeth, Act I, Scene iii > Read 
> Write

Students will analyze 
elements of literature to 

establish meaning.

Characters 
(characterization, 

round/flat, dynamic, 
static), setting, plot 

events Reinforce

Author's Craft

LA.10.RP.3

Analyze how the author's choices 
related to perspective or point of view 
contribute to the meaning, significance, 
or aesthetic of a literary text.

Unit 4 > Integrated Reading and Writing > Antigone > Skill: Point of View > Model Unit 4 > 
Integrated Reading and Writing > Antigone > Skill: Point of View > Your Turn Unit 4 > 
Integrated Reading and Writing > Antigone > Close Read: Antigone > Read > Skills Focus Unit 
6 > Integrated Reading and Writing > A Very Old Man with Enormous Wings > Close Read: A 
Very Old Man with Enormous Wings > Write Unit 3 > Integrated Reading and Writing > The 
God of Small Things > Independent Read: The God of Small Things > Write Unit 6 > Integrated 
Reading and Writing > A Very Old Man with Enormous Wings > Skill: Point of View > Model 
Unit 6 > Integrated Reading and Writing > A Very Old Man with Enormous Wings > Close 
Read: A Very Old Man with Enormous Wings > Read > Write Unit 1 > Integrated Reading and 
Writing > Things Fall Apart > Skill: Point of View > Model Unit 1 > Integrated Reading and 
Writing > Things Fall Apart > Close Read: Things Fall Apart > Read > Skills Focus

Students will analyze 
author's choices and how 

they contribute to 
meaning.

POV (narrator), great 
craft Reinforce

LA.10.RP.4

Analyze how an author uses text 
structure, including the manipulation of 
time (e.g., foreshadowing, flashbacks) 
to create literary effects such as 
mystery, tension, and suspense.

Unit 3 > Integrated Reading and Writing > Persepolis > Skill: Story Structure > Model Unit 3 > 
Integrated Reading and Writing > Persepolis > Skill: Story Structure > Your Turn Unit 3 > 
Integrated Reading and Writing > Persepolis > Close Read: Persepolis > Read > Skills Focus 
Unit 4 > Integrated Reading and Writing > Hotel Rwanda > Skill: Dramatic Elements and 
Structure > Model Unit 4 > Integrated Reading and Writing > Hotel Rwanda > Close Read: Hotel 
Rwanda > Read > Skills Focus Unit 4 > Integrated Reading and Writing > La Juanita > Skill: 
Story Structure > Model Unit 4 > Integrated Reading and Writing > La Juanita > Skill: Story 
Structure > Your Turn Unit 4 > Integrated Reading and Writing > La Juanita > Close Read: La 
Juanita > Read > Skills Focus Unit 4 > Integrated Reading and Writing > La Juanita > Close 
Read: La Juanita > Write Unit 2 > Integrated Reading and Writing > Rámáyana > Skill: Poetic 
Elements and Structure > Model Unit 2 > Integrated Reading and Writing > Rámáyana > Skill: 
Poetic Elements and Structure > Your Turn Unit 2 > Integrated Reading and Writing > 
Rámáyana > Close Read: Rámáyana > Write

Students will analyze text 
structure and its impact on 

literature.

Annotate for attention to 
text structure, 

manipulation of time 
(flashback, flashfoward, 
foreshadowing), tension Reinforce

Knowledge and Ideas
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LA.10.RP.5

Analyze how an author draws on and 
transforms source material in a specific 
work (e.g., how Shakespeare treats a 
theme or topic from the Bible).

Unit 1 > Integrated Reading and Writing > She Unnames Them > Skill: Allusion > Model Unit 1 
> Integrated Reading and Writing > She Unnames Them > Skill: Allusion > Your Turn Unit 1 > 
Integrated Reading and Writing > She Unnames Them > Close Read: She Unnames Them > 
Read > Skills Focus Unit 5 > Integrated Reading and Writing > B. Wordsworth > Skill: Allusion 
> Model Unit 5 > Integrated Reading and Writing > B. Wordsworth > Skill: Allusion > Your 
Turn Unit 5 > Integrated Reading and Writing > B. Wordsworth > Close Read: B. Wordsworth > 
Read > Skills Focus Unit 1 > Integrated Reading and Writing > Things Fall Apart > Close Read: 
Things Fall Apart > Read > Skills Focus Unit 3 > Integrated Reading and Writing > The God of 
Small Things > Independent Read: The God of Small Things > Write Unit 6 > Integrated 
Reading and Writing > A Very Old Man with Enormous Wings > Close Read: A Very Old Man 
with Enormous Wings > Read > Skills Focus

The student will analyze 
an author's craft and 
identify trends with 

authors.

Allusions, source 
material, building 

historical context, how 
text becomes source 

material itself Reinforce

LA.10.RP.6

Analyze the implied or stated theme(s) 
in a literary text to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Unit 1 > Integrated Reading and Writing > She Unnames Them > Skill: Theme > Model Unit 1 > 
Integrated Reading and Writing > She Unnames Them > Skill: Theme > Your Turn Unit 1 > 
Integrated Reading and Writing > She Unnames Them > Close Read: She Unnames Them > 
Read > Skills Focus Unit 1 > Integrated Reading and Writing > She Unnames Them > Close 
Read: She Unnames Them > Write Unit 1 > Integrated Reading and Writing > Things Fall Apart 
> Skill: Theme > Model Unit 1 > Integrated Reading and Writing > Things Fall Apart > Close 
Read: Things Fall Apart > Write Unit 4 > Integrated Reading and Writing > Macbeth, Act I, 
Scene iii > Close Read: Antigone > Read > Skills Focus 4 Unit 6 > Integrated Reading and 
Writing > A Very Old Man with Enormous Wings > Close Read: A Very Old Man with 
Enormous Wings > Read > Skills Focus 3-4

The student will analyze 
theme and explore 

connections to the text. 

Noting repetition (motif) 
and inferencing, active 

reading Reinforce

LA.10.RP.7

Analyze multiple perspectives within 
and across a wide range of literary texts.

Unit 4 > Integrated Reading and Writing > Antigone > Skill: Point of View > Model Unit 4 > 
Integrated Reading and Writing > Antigone > Skill: Point of View > Your Turn Unit 4 > 
Integrated Reading and Writing > Antigone > Close Read: Antigone > Read > Skills Focus Unit 
6 > Integrated Reading and Writing > A Very Old Man with Enormous Wings > Close Read: A 
Very Old Man with Enormous Wings > Write Unit 3 > Integrated Reading and Writing > The 
God of Small Things > Independent Read: The God of Small Things > Write Unit 6 > Integrated 
Reading and Writing > A Very Old Man with Enormous Wings > Skill: Point of View > Model 
Unit 6 > Integrated Reading and Writing > A Very Old Man with Enormous Wings > Close 
Read: A Very Old Man with Enormous Wings > Read > Skills Focus Unit 1 > Integrated 
Reading and Writing > Things Fall Apart > Skill: Point of View > Model Unit 1 > Integrated 
Reading and Writing > Things Fall Apart > Close Read: Things Fall Apart > Read > Skills Focus

The student will explore 
multiple perspectives  

using a variety of 
literature.

Tracking and noting 
perspectives Reinforce

Range of Reading and Level of 
Text Complexity

LA.10.RP.8

Read and comprehend a wide range 
of literary texts of appropriate 
complexity at the high end of the 9-10 
grade band proficiently, with 
scaffolding as needed at the high end 
of the range.

Grade 10 ELA Overview > Text Complexity > Page 3-89 Unit 1 > Integrated Reading and 
Writing > The Big Idea > Recognizing Genre > Model Unit 1 > Integrated Reading and Writing 
> The Big Idea > Recognizing Genre > Your Turn Unit 1 > Integrated Reading and Writing > 
Heart of Darkness > Independent Read: Heart of Darkness > Read Unit 1 > Integrated Reading 
and Writing > Things Fall Apart > Analyzing Modernist and Postmodernist Literature > Model 
Unit 1 > Integrated Reading and Writing > Things Fall Apart > Analyzing Modernist and 
Postmodernist Literature > Your Turn Unit 2 > Integrated Reading and Writing > Civil Peace > 
Independent Read: Civil Peace > Read Unit 6 > Integrated Reading and Writing > A Very Old 
Man with Enormous Wings > First Read: A Very Old Man with Enormous Wings > Read Unit 3 
> Integrated Reading and Writing > Self-Selected Reading > Blast: Self-Selected Unit 5 > 
Integrated Reading and Writing > Self-Selected Reading > Blast: Self-Selected

The student will read and 
engage in grade level text.

Tracking comprehension 
and independantly 

monitor success and 
confusion. Reinforce
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LA.10.RI.1

Analyze the development of two or 
more implied or explicit central ideas 
over the course of an informational text 
or texts.

Unit 2 > Integrated Reading and Writing > Republic > Skill: Central or Main Idea > Model Unit 
2 > Integrated Reading and Writing > Republic > Skill: Central or Main Idea > Your Turn Unit 2 
> Integrated Reading and Writing > Republic > Close Read: Republic > Read > Skills Focus Unit 
2 > Integrated Reading and Writing > Republic > Close Read: Republic > Write Unit 3 > 
Integrated Reading and Writing > Facial expressions—including fear—may not be as universal 
as we thought > Skill: Central or Main Idea > Model Unit 3 > Integrated Reading and Writing > 
Facial expressions—including fear—may not be as universal as we thought > Skill: Central or 
Main Idea > Your Turn Unit 3 > Integrated Reading and Writing > Facial expressions—including 
fear—may not be as universal as we thought > Close Read: Facial expressions—including fear—
may not be as universal as we thought > Read > Skills Focus Unit 3 > Integrated Reading and 
Writing > Facial expressions—including fear—may not be as universal as we thought > Close 
Read: Facial expressions—including fear—may not be as universal as we thought > Write

The student will explore 
central ideas in 

informational text.
Analyze, implicit, explicit, 

fiction vs. nonfiction Reinforce

LA.10.RI.2

Analyze how the interaction of 
individuals, important events, and key 
ideas contribute to the meaning of the 
work as a whole.

Unit 4 > Integrated Reading and Writing > Claudette Colvin Explains Her Role in the Civil 
Rights Movement > Skill: Informational Text Elements > Model Unit 4 > Integrated Reading and 
Writing > Claudette Colvin Explains Her Role in the Civil Rights Movement > Skill: 
Informational Text Elements > Your Turn Unit 4 > Integrated Reading and Writing > Claudette 
Colvin Explains Her Role in the Civil Rights Movement > Close Read: Claudette Colvin 
Explains Her Role in the Civil Rights Movement > Read > Skills Focus Unit 4 > Integrated 
Reading and Writing > Claudette Colvin Explains Her Role in the Civil Rights Movement > 
Close Read: Claudette Colvin Explains Her Role in the Civil Rights Movement > Write Unit 5 > 
Integrated Reading and Writing > The New Food Fights: U.S. Public Divides Over Food Science 
> Skill: Informational Text Elements > Model + Your Turn Unit 5 > Integrated Reading and 
Writing > The New Food Fights: U.S. Public Divides Over Food Science > Close Read: The New 
Food Fights: U.S. Public Divides Over Food Science > Read > Skills Focus Unit 4 > Integrated 
Reading and Writing > Funny in Farsi: A Memoir of Growing Up Iranian in America > Skill: 
Informational Text Elements > Model + Your Turn Unit 4 > Integrated Reading and Writing > 
Funny in Farsi: A Memoir of Growing Up Iranian in America > Close Read: Funny in Farsi: A 
Memoir of Growing Up Iranian in America > Read > Skills Focus

The student will analyze 
key ideas and concepts of 
the text to build meaning.

Characters 
(characterization, 

round/flat, dynamic, 
static), setting, plot 
events, key ideas Reinforce

Author's Craft

LA.10.RI.3

Analyze an author's perspective or 
purpose in a text and analyze how an 
author uses rhetoric to advance that 
point of view or purpose.

Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Skill: 
Author’s Purpose and Point of View > Model Unit 1 > Integrated Reading and Writing > Speech 
to the Second Virginia Convention > Skill: Author’s Purpose and Point of View > Your Turn 
Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Close 
Read: Speech to the Second Virginia Convention > Read > Skills Focus Unit 1 > Integrated 
Reading and Writing > Speech to the Second Virginia Convention > Close Read: Speech to the 
Second Virginia Convention > Write Unit 1 > Integrated Reading and Writing > Letter from 
Birmingham Jail > Skill: Rhetoric > Model Unit 1 > Integrated Reading and Writing > Letter 
from Birmingham Jail > Skill: Rhetoric > Your Turn Unit 1 > Integrated Reading and Writing > 
Letter from Birmingham Jail > Close Read: Letter from Birmingham Jail > Read > Skills Focus 
Unit 1 > Integrated Reading and Writing > Letter from Birmingham Jail > Close Read: Letter 
from Birmingham Jail > Write Unit 4 > Integrated Reading and Writing > Claudette Colvin 
Explains Her Role in the Civil Rights Movement > Skill: Author’s Purpose and Point of View > 
Model + Your Turn Unit 4 > Integrated Reading and Writing > Claudette Colvin Explains Her 
Role in the Civil Rights Movement > Close Read: Claudette Colvin Explains Her Role in the 
Civil Rights Movement > Read > Skills Focus

Students will explore 
authors perpective and 
how they present their 

point of view.
Diction and purpose, 
ethos, pathos, logos Reinforce
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LA.10.RI.4

Analyze in detail how an author’s ideas 
or claims are developed and refined by 
particular sentences, paragraphs, or 
larger portions of a text (e.g., a section 
or chapter).

Unit 2 > Integrated Reading and Writing > The Power of the Hero’s Journey > Skill: 
Informational Text Structure > Model Unit 2 > Integrated Reading and Writing > The Power of 
the Hero’s Journey > Skill: Informational Text Structure > Your Turn Unit 2 > Integrated 
Reading and Writing > The Power of the Hero’s Journey > Close Read: The Power of the Hero’s 
Journey > Read > Skills Focus Unit 2 > Integrated Reading and Writing > The Perils of 
Indifference > Skill: Informational Text Structure > Model + Your Turn Unit 2 > Integrated 
Reading and Writing > The Perils of Indifference > Close Read: The Perils of Indifference > 
Write Unit 3 > Integrated Reading and Writing > Rituals of Memory > Skill: Informational Text 
Structure > Model + Your Turn Unit 3 > Integrated Reading and Writing > Rituals of Memory > 
Close Read: Rituals of Memory > Read > Skills

Students will explore 
authors perpective and 
how they present their 

point of view.
Author's purpose and 

development Reinforce

Knowledge and Ideas

LA.10.RI.5

Analyze informational texts of historical 
and/or cultural significance, including 
their treatment of related topics and 
concepts.

Unit 1 > Integrated Reading and Writing > Letter from Birmingham Jail > Skill: Primary and 
Secondary Sources > Model Unit 1 > Integrated Reading and Writing > Letter from Birmingham 
Jail > Skill: Primary and Secondary Sources > Your Turn Unit 1 > Integrated Reading and 
Writing > Letter from Birmingham Jail > Close Read: Letter from Birmingham Jail > Read > 
Skills Focus Unit 1 > Integrated Reading and Writing > Letter from Birmingham Jail > Close 
Read: Letter from Birmingham Jail > Write Unit 1 > Integrated Reading and Writing > Speech to 
the Second Virginia Convention > Skill: Compare and Contrast > Model Unit 2 > Integrated 
Reading and Writing > Speech to the Second Virginia Convention > Skill: Compare and Contrast 
> Your Turn Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia 
Convention > Close Read: Speech to the Second Virginia Convention > Read > Skills Focus Unit 
1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Close Read: 
Speech to the Second Virginia Convention > Write

Students will analyze 
informational texts to 
expand knowledge of 
historical and cultural 

significance.

Allusion, cultural 
significance (lens), who 

is telling the story for 
whom, who/what is 

missing? Reinforce

LA.10.RI.6

Compare and contrast the 
development of different arguments on 
the same topic, evaluating the 
effectiveness and validity of the claims.

Unit 2 > Integrated Reading and Writing > Methods of Motivation > Skill: Reasons and Evidence 
> Model Unit 2 > Integrated Reading and Writing > Methods of Motivation > Skill: Reasons and 
Evidence > Your Turn Unit 2 > Integrated Reading and Writing > Methods of Motivation > Skill: 
Logical Fallacies > Model Unit 2 > Integrated Reading and Writing > Methods of Motivation > 
Skill: Logical Fallacies > Your Turn Unit 2 > Integrated Reading and Writing > Methods of 
Motivation > Close Read: Methods of Motivation > Read > Skills Focus Unit 2 > Integrated 
Reading and Writing > Methods of Motivation > Close Read: Methods of Motivation > Write 
Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Skill: 
Compare and Contrast > Model Unit 1 > Integrated Reading and Writing > Speech to the Second 
Virginia Convention > Skill: Compare and Contrast > Your Turn Unit 1 > Integrated Reading 
and Writing > Speech to the Second Virginia Convention > Close Read: Speech to the Second 
Virginia Convention > Read > Skills Focus 4 Unit 1 > Integrated Reading and Writing > Speech 
to the Second Virginia Convention > Close Read: Speech to the Second Virginia Convention > 
Write

Students will compare and 
contrast two pieces of 

work on the same topic.

Compare AND contrast, 
exposure to different 

arguments Reinforce
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LA.10.RI.7

Analyze how an author or speaker 
unfolds a series of events, ideas, or 
perspectives within and across a wide 
range of informational texts.

Unit 4 > Integrated Reading and Writing > Claudette Colvin Explains Her Role in the Civil 
Rights Movement > Skill: Informational Text Elements > Model Unit 4 > Integrated Reading and 
Writing > Claudette Colvin Explains Her Role in the Civil Rights Movement > Skill: 
Informational Text Elements > Your Turn Unit 4 > Integrated Reading and Writing > Claudette 
Colvin Explains Her Role in the Civil Rights Movement > Close Read: Claudette Colvin 
Explains Her Role in the Civil Rights Movement > Read > Skills Focus Unit 4 > Integrated 
Reading and Writing > Claudette Colvin Explains Her Role in the Civil Rights Movement > 
Close Read: Claudette Colvin Explains Her Role in the Civil Rights Movement > Write Unit 5 > 
Integrated Reading and Writing > The New Food Fights: U.S. Public Divides Over Food Science 
> Skill: Informational Text Elements > Model + Your Turn Unit 5 > Integrated Reading and 
Writing > The New Food Fights: U.S. Public Divides Over Food Science > Close Read: The New 
Food Fights: U.S. Public Divides Over Food Science > Read > Skills Focus Unit 4 > Integrated 
Reading and Writing > Funny in Farsi: A Memoir of Growing Up Iranian in America > Skill: 
Informational Text Elements > Model Unit 4 > Integrated Reading and Writing > Funny in Farsi: 
A Memoir of Growing Up Iranian in America > Close Read: Funny in Farsi: A Memoir of 
Growing Up Iranian in America > Read > Skills Focus

Students will analyze how 
an author unforlds a series 

of events.

Intentional sequencing - 
noting it and evaluating 

effectiveness. Reinforce

Range of Reading and Level of 
Text Complexity

LA.10.RI.8

Read and comprehend a wide range 
of informational texts of appropriate 
complexity at the high end of the 9- 10 
grade band proficiently, with 
scaffolding as needed at the high end 
of the range.

Grade 10 ELA Overview > Text Complexity > Page 3-89 Unit 1 > Integrated Reading and 
Writing > Letter from Birmingham Jail > First Read: Letter from Birmingham Jail > Read Unit 3 
> Integrated Reading and Writing > Facial expressions—including fear—may not be as universal 
as we thought > First Read: Facial expressions—including fear—may not be as universal as we 
thought > Read Unit 5 > Integrated Reading and Writing > Curry: A Tale of Cooks and 
Conquerors > Independent Read: Curry: A Tale of Cooks and Conquerors > Read Unit 5 > 
Integrated Reading and Writing > Self-Selected Reading > Blast: Self-Selected Unit 2 > 
Integrated Reading and Writing > The Big Idea > Recognizing Genre > Model Unit 2 > 
Integrated Reading and Writing > The Big Idea > Recognizing Genre > Your Turn Unit 2 > 
Integrated Reading and Writing > The Big Idea > Literary Focus: The Classics > Think Unit 2 > 
Integrated Reading and Writing > Republic > Analyzing Ancient and Classical Literature > 
Model Unit 2 > Integrated Reading and Writing > Republic > Analyzing Ancient and Classical 
Literature > Your Turn

Students will read and 
comprehend a wide range 

of informational texts.
Active reading and 

annotation Reinforce
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Acquisition and Use

LA.10.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Unit 1 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > 
Vocabulary Unit 1 > Integrated Reading and Writing > The Big Idea > Skill: Academic 
Vocabulary > Model Unit 1 > Integrated Reading and Writing > The Big Idea > Skill: Academic 
Vocabulary > Your Turn Unit 5 > Integrated Reading and Writing > The Big Idea > Skill: 
Academic Vocabulary > Vocabulary Unit 5 > Integrated Reading and Writing > The Big Idea > 
Skill: Academic Vocabulary > Model Unit 5 > Integrated Reading and Writing > The Big Idea > 
Skill: Academic Vocabulary > Your Turn Unit 3 > Integrated Reading and Writing > Seeing at 
the Speed of Sound > Close Read: Seeing at the Speed of Sound > Vocabulary Unit 1 > 
Integrated Reading and Writing > Things Fall Apart > Close Read: Things Fall Apart > 
Vocabulary

Students will explore 
grade level vocabulary to 
increase comprehension. Tone vocabulary Reinforce

LA.10.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Context Clues > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Context Clues 
> Your Turn Unit 1 > Integrated Reading and Writing > Things Fall Apart > First Read: Things 
Fall Apart > Think Unit 2 > Integrated Reading and Writing > Republic > Skill: Context Clues > 
Model Unit 2 > Integrated Reading and Writing > Republic > Skill: Context Clues > Your Turn 
Unit 2 > Integrated Reading and Writing > Republic > Close Read: Republic > Read > Skills 
Focus Unit 3 > Integrated Reading and Writing > Love Is Not All > First Read: Love Is Not All > 
Think

Students will explore 
grade level vocabulary to 
increase comprehension. 

Context clues and 
function Reinforce
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LA.10.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
analyze, analysis).

Unit 4 > Integrated Reading and Writing > Funny in Farsi: A Memoir of Growing Up Iranian in 
America > Skill: Word Patterns and Relationships > Model Unit 4 > Integrated Reading and 
Writing > Funny in Farsi: A Memoir of Growing Up Iranian in America > Skill: Word Patterns 
and Relationships > Your Turn Unit 4 > Integrated Reading and Writing > Funny in Farsi: A 
Memoir of Growing Up Iranian in America > Close Read: Funny in Farsi: A Memoir of Growing 
Up Iranian in America > Skills Focus Unit 6 > Integrated Reading and Writing > A Quilt of a 
Country > Skill: Word Patterns and Relationships > Model Unit 6 > Integrated Reading and 
Writing > A Quilt of a Country > Skill: Word Patterns and Relationships > Your Turn Unit 6 > 
Integrated Reading and Writing > A Quilt of a Country > Close Read: A Quilt of a Country > 
Read > Skills Focus

Students will explore 
grade level vocabulary to 
increase comprehension. Reinforce

LA.10.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, or 
etymology of words.

Unit 2 > Integrated Reading and Writing > The Perils of Indifference > Skill: Word Meaning > 
Model Unit 2 > Integrated Reading and Writing > The Perils of Indifference > Skill: Word 
Meaning > Your Turn Unit 2 > Integrated Reading and Writing > The Perils of Indifference > 
Close Read: The Perils of Indifference > Read > Skills Focus Unit 4 > Integrated Reading and 
Writing > La Juanita > Skill: Word Meaning > Model Unit 4 > Integrated Reading and Writing > 
La Juanita > Skill: Word Meaning > Your Turn Unit 4 > Integrated Reading and Writing > La 
Juanita > Close Read: La Juanita > Read > Skills Focus

Students will explore 
grade level vocabulary to 
increase comprehension. etymology Reinforce

Context and Connotations

LA.10.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Unit 3 > Integrated Reading and Writing > Facial expressions—including fear—may not be as 
universal as we thought > Skill: Technical Language > Model Unit 3 > Integrated Reading and 
Writing > Facial expressions—including fear—may not be as universal as we thought > Skill: 
Technical Language > Your Turn

Students will explore 
figurative languge in 
informational text. 

Connotation vs 
denotation, figurative 

language, nuance, text 
features Reinforce

LA.10.V.2.a

a. Interpret figures of speech (e.g., 
euphemism, oxymoron) in context and 
analyze their role in text.

Unit 3 > Integrated Reading and Writing > Rituals of Memory > Skill: Figurative Language > 
Model Unit 3 > Integrated Reading and Writing > Rituals of Memory > Skill: Figurative 
Language > Your Turn Unit 3 > Integrated Reading and Writing > Rituals of Memory > Close 
Read: Rituals of Memory > Read > Write Unit 4 > Integrated Reading and Writing > Antigone > 
Skill: Figurative Language > Model Unit 4 > Integrated Reading and Writing > Antigone > Close 
Read: Antigone > Read > Skills Focus Unit 6 > Integrated Reading and Writing > A Quilt of a 
Country > Skill: Figurative Language > Model Unit 6 > Integrated Reading and Writing > A 
Quilt of a Country > Close Read: A Quilt of a Country > Read > Skills Focus

Students will explore 
figurative languge in 
informational text. Reinforce

LA.10.V.2.b

b.Analyze nuances in the meanings of 
words with similar denotations.

Unit 3 > Integrated Reading and Writing > Seeing at the Speed of Sound > Skill: Connotation 
and Denotation > Model Unit 3 > Integrated Reading and Writing > Seeing at the Speed of Sound 
> Skill: Connotation and Denotation > Your Turn Unit 3 > Integrated Reading and Writing > 
Love is Not All > Skill: Connotation and Denotation > Model Unit 5 > Integrated Reading and 
Writing > Parsley > Skill: Connotation and Denotation > Model Unit 5 > Integrated Reading and 
Writing > Parsley > Skill: Connotation and Denotation > Your Turn Unit 5 > Integrated Reading 
and Writing > Parsley > Close Read: Parsley > Read > Skills Focus

Students will explore 
figurative languge in 
informational text. Reinforce

Production of Writing

LA.10.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and add variety, interest, and 
fluency to written and spoken 
language.

Unit 1 > Extended Writing Project and Grammar > Plan > Literary Analysis Writing Process: 
Plan > Write Unit 1 > Extended Writing Project and Grammar > Draft > Literary Analysis 
Writing Process: Draft > Write Unit 1 > Extended Writing Project and Grammar > Revise > 
Literary Analysis Writing Process: Revise > Write Unit 1 > Extended Writing Project and 
Grammar > Edit and Publish > Literary Analysis Writing Process: Edit and Publish > Write

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.



English 10

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.W.1.a

a. Apply knowledge of rules for 
capitalization.

Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Capitalization > 
Capitalization - Other Proper Nouns > Model + Your Turn Library > Skills > Filter > Select: 
Grade 10 > Select: Grammar > Search: Capitalization > Capitalization -Quotations > Model + 
Your Turn Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: 
Capitalization > Capitalization - Proper Adjectives > Model + Your Turn Library > Skills > Filter 
> Select: Grade 10 > Select: Grammar > Search: Capitalization > Capitalization -Sentences > 
Model + Your Turn Unit 1 > Extended Writing Project and Grammar > Edit and Publish > 
Literary Analysis Writing Process: Edit and Publish > Write - Checklist

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.b

b. Use a colon to introduce a quotation, 
definition, or to expand on information 
in a sentence; use a semicolon with a 
conjunctive adverb.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Grammar Skill: 
Semicolons > Model + Your Turn Unit 1 > Extended Writing Project and Grammar > Edit and 
Publish > Literary Analysis Writing Process: Edit and Publish > Write - Checklist Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Grammar Skill: Colons > Model + 
Your Turn Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Informative 
Writing Process: Edit and Publish > Write - Checklist Unit 6 > Extended Writing Project and 
Grammar > Edit and Publish > Grammar Skill: Conjunctive Adverbs > Model + Your Turn Unit 
6 > Extended Writing Project and Grammar > Edit and Publish > Research Writing Process: Edit 
and Publish > Write - Checklist

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.c

c. Apply knowledge of function and 
usage to revise personal writing while 
resolving issues of complex or contested 
usage, consulting appropriate and 
reliable reference materials.

Unit 5 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 
5 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn > 
Your Turn 2 Unit 6 > Extended Writing Project and Grammar > Edit and Publish > Skill: Using a 
Style Guide > Model Unit 6 > Extended Writing Project and Grammar > Edit and Publish > Skill: 
Using a Style Guide > Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.d

d. Select and use verbs with 
appropriate voice and mood. Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Verbs > Active and 

Passive Voice > Model + Your Turn Library > Skills > Filter > Select: Grade 10 > Select: 
Grammar > Search: Verbs > Verbs - Consistent Verb Voice and Mood > Model + Your Turn 
Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Verbs > Verbs - Verb 
Moods > Model + Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.

LA.10.W.1.e

e. Identify and revise fragment and run-
on sentences and inappropriate shifts in 
verb tense, number, voice, mood, and 
parallel structure.

Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Sentence Structure > 
Sentence Structure - Sentence Fragments > Model + Your Turn Library > Skills > Filter > Select: 
Grade 10 > Select: Grammar > Search: Sentence Structure > Sentence Structure - Run-On 
Sentences > Model + Your Turn Unit 1 > Extended Writing Project and Grammar > Edit and 
Publish > Grammar Skill: Independent and Dependent Clauses > > Model + Your Turn Library > 
Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Subject-Verb > Subject-Verb 
Agreement > Model + Your Turn Library > Skills > Filter > Select: Grade 10 > Select: Grammar 
> Search: Verbs > Verb - Distinguishing Tenses > Model + Your Turn Library > Skills > Filter > 
Select: Grade 10 > Select: Grammar > Search: Verbs > Verbs - Consistent Verb Tenses > Model 
+ Your Turn Library > Skills > Filter > Select: Grade 10 > Select: Grammar > Search: Verbs > 
Verbs - Consistent Verb Tense and Mood > Model + Your Turn Library > Skills > Filter > 
Select: Grade 10 > Select: Grammar > Search: Verbs > Verbs - Verb Moods > Model + Your 
Turn Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Parallel 
Structure > Model > Teacher Edition - Instruction > 2. Model Unit 2 > Extended Writing Project 
and Grammar > Edit and Publish > Skill: Parallel Structure > Your Turn Unit 1 > Extended 
Writing Project and Grammar > Edit and Publish > Grammar Skill: Independent and Dependent 
Clauses > Model Unit 1 > Extended Writing Project and Grammar > Edit and Publish > 
Grammar Skill: Independent and Dependent Clauses > Your Turn Unit 3 > Extended Writing 
Project and Grammar > Edit and Publish > Skill: Verb Phrases > Model Unit 3 > Extended 
Writing Project and Grammar > Edit and Publish > Skill: Verb Phrases > Your Turn

Students will compose 
grammatically correct 

writing.

Write, write, write 
(paragraphs - topic 

sentence, supporting 
ideas, transitions 

between ideas and 
paragraphs), 

proofreading and 
revision Reinforce.



English 10

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Unit 5 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan 
> Write Unit 5 > Extended Writing Project and Grammar > Draft > Argumentative Writing 
Process: Draft > Write Unit 5 > Extended Writing Project and Grammar > Revise > 
Argumentative Writing Process: Revise > Write Unit 5 > Extended Writing Project and Grammar 
> Edit and Publish > Argumentative Writing Process: Edit and Publish > Write Unit 1 > 
Integrated Reading and Writing > SyncStart: Marigolds > Skill: Peer Review > Model

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Unit 1 > Extended Writing Project and Grammar > Plan > Literary Analysis Writing Process: 
Plan > Write Unit 1 > Extended Writing Project and Grammar > Draft > Literary Analysis 
Writing Process: Draft > Write Unit 2 > Extended Writing Project and Grammar > Plan > 
Informative Writing Process: Plan > Write Unit 2 > Extended Writing Project and Grammar > 
Draft > Informative Writing Process: Draft > Write Unit 3 > Extended Writing Project and 
Grammar > Plan > Narrative Writing Process: Plan > Write Unit 3 > Extended Writing Project 
and Grammar > Draft > Narrative Writing Process: Draft > Write Unit 6 > Extended Writing 
Project and Grammar > Draft > Skill: Planning Research > Model Unit 6 > Extended Writing 
Project and Grammar > Draft > Skill: Planning Research > Your Turn Unit 6 > Extended Writing 
Project and Grammar > Draft > Skill: Research and Note-Taking > Model Unit 6 > Extended 
Writing Project and Grammar > Draft > Skill: Research and Note-Taking > Your Turn

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Unit 1 > Integrated Reading and Writing > A Voice > Independent Read: A Voice > Write 
(Personal Response) Unit 3 > Integrated Reading and Writing > Seeing at the Speed of Sound > 
Close Read: Seeing at the Speed of Sound > Write (Argumentative) Unit 6 > Integrated Reading 
and Writing > The Best We Could Do > Close Read: The Best We Could Do > Write 
(Informative) Unit 1 > Integrated Reading and Writing > Timed Writing > Write: Timed Writing 
Unit 4 > Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 6 > 
Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 1 > Extended 
Writing Project and Grammar > Plan > Literary Analysis Writing Process: Plan > Write Unit 1 > 
Extended Writing Project and Grammar > Draft > Literary Analysis Writing Process: Draft > 
Write Unit 1 > Extended Writing Project and Grammar > Revise > Literary Analysis Writing 
Process: Revise > Write Unit 1 > Extended Writing Project and Grammar > Edit and Publish > 
Literary Analysis Writing Process: Edit and Publish > Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Peer Review > Model 
Unit 1 > Extended Writing Project and Grammar > Revise > Literary Analysis Writing Process: 
Revise > Write > Teacher Edition: 1. Write - Review Revision Guide + Peer Review and Reflect 
Unit 2 > Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise 
> Write > Teacher Edition: 1. Write - Review Revision Guide + Peer Review and Reflect Unit 2 
> Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit 
and Publish > Write Unit 3 > Extended Writing Project and Grammar > Revise > Narrative 
Writing Process: Revise > Write > Teacher Edition: 1. Write – Review Revision Guide + Peer 
Review and Reflect Unit 1 > Integrated Reading and Writing > Self-Selected Reading > Write: 
Self-Selected Response > Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

LA.10.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Literary Analysis Writing 
Process: Edit and Publish > Write Unit 2 > Extended Writing Project and Grammar > Edit and 
Publish > Informative Writing Process: Edit and Publish > Write Unit 3 > Extended Writing 
Project and Grammar > Edit and Publish > Narrative Writing Process: Edit and Publish > Write 
Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Peer Review > Model 
+ Your Turn

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce
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Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Grade 10 > Additional Resources > Project Based Learning > Page 32 > Food Market Exhibition 
Grade 10 > Additional Resources > Project Based Learning > Page 33 > Career Day Unit 1 > 
Extended Writing Project and Grammar > Edit and Publish > Literary Analysis Writing Process: 
Edit and Publish > Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish > 
Informative Writing Process: Edit and Publish > Write Unit 3 > Extended Writing Project and 
Grammar > Edit and Publish > Narrative Writing Process: Edit and Publish > Write Unit 1 > 
Integrated Reading and Writing > Self-Selected Reading > Write: Self-Selected Response > 
Write

Students will use a 
recursive writing process  

to produce writiing.
Recursive, editing, 

strengthening Reinforce

Modes of Writing

LA.10.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and audience.

Unit 3 > Extended Writing Project and Grammar > Plan > Narrative Writing Process: Plan > 
Intro Unit 2 > Integrated Reading and Writing > Night > Independent Read: Night > Write - 
Narrative Unit 3 > Integrated Reading and Writing > Rock, Ghost, Willow, Deer: A Story of 
Survival > Independent Read: Rock, Ghost, Willow, Deer: A Story of Survival > Write - Personal 
Essay Unit 5 > Integrated Reading and Writing > Maple Sugaring (in Aunt Alberta’s Backyard) > 
Close Read: Maple Sugaring (in Aunt Alberta’s Backyard) > Write - Personal Response/Poetry 
Unit 5 > Integrated Reading and Writing > Melons > Independent Read: Melons > Write – Haiku

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Story Beginnings > Model Unit 
3 > Extended Writing Project and Grammar > Draft > Skill: Story Beginnings > Write Unit 3 > 
Extended Writing Project and Grammar > Draft > Skill: Story Beginnings > Your Turn Unit 3 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model 
Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > 
Your Turn

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Model 
Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Your 
Turn Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > 
Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole. Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 3 > 

Extended Writing Project and Grammar > Revise > Skill: Transitions > Model > Your Turn

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to establish mood and 
tone.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Model 
Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Your 
Turn Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > 
Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce

LA.10.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 3 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 3 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will use a variety 
of literary forms to convey 

text elements.

Layer fiction and 
nonfiction in units for 
students to explore in 

writing. Writing 
organization and 

features Reinforce
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LA.10.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 
5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Organize Argumentative Writing > 
Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Organize Argumentative 
Writing > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 
5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Organize Argumentative Writing > 
Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Organize Argumentative 
Writing > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Unit 5 > Extended Writing Project and Grammar > Revise > Skill: Reasons and Relevant 
Evidence > Model Unit 5 > Extended Writing Project and Grammar > Revise > Skill: Reasons 
and Relevant Evidence > Your Turn Unit 1 > Extended Writing Project and Grammar > Revise > 
Skill: Reasons and Relevant Evidence > Model Unit 1 > Extended Writing Project and Grammar 
> Revise > Skill: Reasons and Relevant Evidence > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Your Turn Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 5 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Transitions > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Transitions > Write

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 
1 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn Unit 1 
> Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Write Unit 5 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 5 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Unit 5 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will write 
arguments that develop a 

perspective.

Claim and defense, 
works cited, source 
credibility, multiple 

viewpoints 
(counterclaim) Reinforce

LA.10.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 
> Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > 
Extended Writing Project and Grammar > Draft > Organizing Informative Writing > Model Unit 
2 > Extended Writing Project and Grammar > Draft > Organizing Informative Writing > Your 
Turn Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 
6 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic Features > 
Model Unit 6 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic 
Features > Your Turn

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce
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Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/
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LA.10.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 
> Extended Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > 
Extended Writing Project and Grammar > Draft > Organizing Informative Writing > Model Unit 
2 > Extended Writing Project and Grammar > Draft > Organizing Informative Writing > Your 
Turn Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 
6 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic Features > 
Model Unit 6 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic 
Features > Your Turn

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.b

b. Develop the topic with relevant, 
sufficient facts, extended definitions, 
concrete details, quotations, and/or 
other information and examples.

Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Model 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Your Turn 
Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Write Unit 
3 > Integrated Reading and Writing > The Secret Life of Salvador Dalí > Independent Read: The 
Secret Life of Salvador Dalí > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic. Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 2 > 

Extended Writing Project and Grammar > Revise > Skill: Transitions > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 
2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn Unit 6 
> Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style Guide > 
Model Unit 6 > Extended Writing Project and Grammar > Edit and Publish > Skill: Using a Style 
Guide > Your Turn

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write

Students will write 
informative pieces that 

convey ideas.

Infographics, citations, 
writing modes, source 

credibility, organization, 
key words, navigating 

databases, using 
abstracts, formal English 

vs. informal (code 
switching) Reinforce

LA.10.W.6

Gather and use credible evidence from 
multiple authoritative sources and assess 
its relevance in answering the research 
question(s).

Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-Taking > 
Model Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-
Taking > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Model Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce



English 10

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-Taking > 
Model Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-
Taking > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Model Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-Taking > 
Model Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-
Taking > Your Turn Unit 4 > Extended Oral Project and Grammar > Draft > Skill: Evaluating 
Sources > Model Unit 4 > Extended Oral Project and Grammar > Draft > Skill: Evaluating 
Sources > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Critiquing Research > Model Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Critiquing Research > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > 
Skill: Critiquing Research > Write

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Model 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Planning Research > Your Turn 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-Taking > 
Model Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Research and Note-
Taking > Your Turn Unit 4 > Extended Oral Project and Grammar > Draft > Skill: Organizing an 
Oral Presentation > Model Unit 4 > Extended Oral Project and Grammar > Draft > Skill: 
Organizing an Oral Presentation > Write Unit 4 > Extended Oral Project and Grammar > Draft > 
Skill: Organizing an Oral Presentation > Your Turn

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g. MLA, APA, Chicago).

Unit 4 > Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model + 
Your Turn Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Sources and Citations 
> Model + Your Turn + Write Unit 6 > Extended Writing Project and Grammar > Draft: Skill: 
Evaluating Sources > Model + Your Turn Unit 6 > Extended Writing Project and Grammar > 
Revise > Skill: Paraphrasing > Model Unit 6 > Extended Writing Project and Grammar > Revise 
> Skill: Paraphrasing > Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > 
Skill: Paraphrasing > Write Unit 6 > Extended Writing Project and Grammar > Revise > Skill: 
Sources and Citations > Model + Your Turn + Write Unit 6 > Extended Writing Project and 
Grammar > Edit and Publish > Skill: Using a Style Guide > Model + Your Turn

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

LA.10.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Library > Blasts > Filter > Search: To Be Honest > Blast: To Be Honest > Background Unit 4 > 
Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model + Your Turn 
Unit 6 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model + 
Your Turn Unit 6 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > 
Model + Your Turn

Students will use credible 
evidence to support 
research question

Infographics, citations, 
writing modes, source 
credibility, organization, 
key words, navigating 
databases, using 
abstracts, formal English 
vs. informal (code 
switching), summary vs. 
paraphrase, citation Introduce

Comprehension and Collaboration

LA.10.SL.1

Initiate and participate in structured 
discussions and collaborations about 
grade-level topics and texts.

Unit 1 > Integrated Reading and Writing > Sync Start > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Your Turn Unit 1 > Integrated Reading and Writing > In Between Cultures: A 
Granddaughter's Advantage > Independent Read: In Between Cultures: A Granddaughter's 
Advantage > Write Unit 4 > Extended Oral Project and Grammar > Revise > Engaging in 
Discourse > Model + Your Turn + Write Unit 5 > Integrated Reading and Writing > Curry: A 
Tale of Cooks and Conquerors > Independent Read: Curry: A Tale of Cooks and Conquerors > 
Write Unit 6 > Integrated Reading and Writing > Coming-of-Age Traditions for Around the 
World > Close Read: Coming-of-Age Traditions for Around the World > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce



English 10

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Unit 1 > Integrated Reading and Writing > Sync Start > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Your Turn Unit 1 > Integrated Reading and Writing > In Between Cultures: A 
Granddaughter's Advantage > Independent Read: In Between Cultures: A Granddaughter's 
Advantage > Write Unit 4 > Extended Oral Project and Grammar > Revise > Engaging in 
Discourse > Model + Your Turn + Write Unit 5 > Integrated Reading and Writing > Curry: A 
Tale of Cooks and Conquerors > Independent Read: Curry: A Tale of Cooks and Conquerors > 
Write Unit 6 > Integrated Reading and Writing > Coming-of-Age Traditions for Around the 
World > Close Read: Coming-of-Age Traditions for Around the World > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Unit 1 > Integrated Reading and Writing > Sync Start > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Your Unit 4 > Extended Oral Project and Grammar > Revise > Skill: 
Communicating Ideas > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: 
Communicating Ideas > Your Turn Unit 4 > Extended Oral Project and Grammar > Revise > 
Skill: Engaging in Discourse > Model Unit 4 > Extended Oral Project and Grammar > Revise > 
Skill: Engaging in Discourse > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Unit 1 > Integrated Reading and Writing > Sync Start > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Your Turn Unit 4 > Extended Oral Project and Grammar > Revise > Engaging 
in Discourse > Model + Your Turn Unit 5 > Integrated Reading and Writing > Curry: A Tale of 
Cooks and Conquerors > Independent Read: Curry: A Tale of Cooks and Conquerors > Write 
Unit 6 > Integrated Reading and Writing > Coming-of-Age Traditions for Around the World > 
Close Read: Coming-of-Age Traditions for Around the World > Write

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging 
in Discourse > Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Your Turn Unit 4 > Extended Oral Project and Grammar > Edit and Present > Oral 
Presentation Process - Edit and Present > Model - Active Listening Checklist

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

LA.10.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Grade 10 > Additional Resources > Project Based Learning > Page 28 > Persuasive Letter Grade 
10 > Additional Resources > Project Based Learning > Page 29 > Random Acts of Kindness 
Grade 10 > Additional Resources > Project Based Learning > Page 30 > Public Service 
Announcement Grade 10 > Additional Resources > Project Based Learning > Page 31 > Personal 
Action Plan Grade 10 > Additional Resources > Project Based Learning > Page 32 > Food 
Market Exhibition Grade 10 > Additional Resources > Project Based Learning > Page 33 > 
Career Day

Students will participate in 
collaborative 

conversations regarding 
their reading.

Graded Class 
discussions, silent 

discussions, learning to 
develop questions; 
managing personal 
response to diverse 

perspectives Reinforce

Presentation of Knowledge and Ideas

LA.10.SL.2

Present information, findings, and 
supporting evidence clearly and 
concisely and in which the organization, 
development, and style are appropriate 
to a variety of tasks, purposes, and 
audiences.

Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model 
Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your 
Turn + Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Your Turn Unit 4 > Extended Oral Project and Grammar > Oral Presentation Process: 
Edit and Present > Write - Presentation Checklist

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.



English 10

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key vocabulary
Introduce/Reinforce/

Master

LA.10.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model 
Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your 
Turn + Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and 
Evidence > Your Turn Unit 4 > Extended Oral Project and Grammar > Oral Presentation Process: 
Edit and Present > Write - Presentation Checklist

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Unit 1 > Integrated Reading and Writing > Sync Start > Skill: Collaborative Conversations > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: The Refusal > Skill: Collaborative 
Conversations > Your Turn Unit 2 > Methods of Motivation > Close Read > Methods of 
Motivation > Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Model Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Write Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Engaging in 
Discourse > Your Turn Unit 4 > Extended Oral Project and Grammar > Edit and Present > Edit 
and Present: Write Unit 5 > Integrated Reading and Writing > Curry: A Tale of Cooks and 
Conquerors > Independent Read: Curry: A Tale of Cooks and Conquerors > Write Unit 6 > 
Integrated Reading and Writing > Coming-of-Age Traditions for Around the World > Close 
Read: Coming-of-Age Traditions for Around the World > Write

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.c

c. Analyze the purpose of information 
being presented, evaluate its motives 
(e.g., social, commercial, political), and 
determine its credibility.

Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Skill: 
Author’s Purpose and Point of View > Model Unit 1 > Integrated Reading and Writing > Speech 
to the Second Virginia Convention > Skill: Author’s Purpose and Point of View > Your Turn 
Unit 1 > Integrated Reading and Writing > Speech to the Second Virginia Convention > Close 
Read: Speech to the Second Virginia Convention > Read > Skills Focus Unit 1 > Integrated 
Reading and Writing > Letter from Birmingham Jail > Skill: Rhetoric > Model Unit 1 > 
Integrated Reading and Writing > Letter from Birmingham Jail > Skill: Rhetoric > Your Turn 
Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Model 
Unit 4 > Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Your 
Turn Unit 4 > Extended Oral Project and Grammar > Revise > Oral Presentation Process: Revise 
> Write Unit 2 > Integrated Reading and Writing > Methods of Motivation > Skill: Logical 
Fallacies > Model Unit 2 > Integrated Reading and Writing > Methods of Motivation > Skill: 
Logical Fallacies > Your Turn

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Unit 3 > Integrated Reading and Writing > Seeing at the Speed of Sound > Skill: Media > Model 
(audio) Unit 3 > Integrated Reading and Writing > Seeing at the Speed of Sound > Skill: 
Connotation and Denotation > Model Unit 3 > Integrated Reading and Writing > Seeing at the 
Speed of Sound > Skill: Connotation and Denotation > Your Turn Unit 3 > Integrated Reading 
and Writing > Love is Not All > Skill: Connotation and Denotation > Model Unit 5 > Integrated 
Reading and Writing > Parsley > Skill: Connotation and Denotation > Model Unit 5 > Integrated 
Reading and Writing > Parsley > Skill: Connotation and Denotation > Your Turn Library > Blast 
> Search: In the Deep > Blast: In the Deep Library > Blast > Search: Word for Word > Blast: 
Word for Word

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.

LA.10.SL.2.e

e. Select and use appropriate visual 
and/or digital tools to enhance verbal 
communication and add interest.

Unit 4 > Extended Oral Project and Grammar > Oral Presentation Process: Plan > Intro Unit 4 > 
Extended Oral Project and Grammar > Oral Presentation Process: Plan > Read Unit 4 > Extended 
Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Model Unit 4 > 
Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write 
Unit 4 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > 
Your Turn Unit 4 > Extended Oral Project and Grammar > Draft > Oral Presentation Process: 
Draft > Write

Students will present 
information about their 

reading to their 
classmates. 

Collaboration, listen and 
respond, reasoning and 

supporting evidence, 
source credibilty, author 
bias, knowing audience 
(ethos, pathos, logos) Reinforce.



English 10 Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

Power of Communication: Why do 
words matter? 4 weeks

1. Students will be able annotate to check and increase 
comprehension.
2. Students will begin to engage in collaborative conversations
3.Students will be able to identify and give text support for theme
4. TSWBAT define, identify and create literary elements
5. TSWBAT define, identify and create literary devices
6. TSWBAT find their narrative writing voice

I Will Always Write Back
How the Garcia Girls Lost Their 
Accents
"The Refusal"
"I am Offering this Poem"
 Before reading the poem: https:
//www.tiktok.
com/@thisiszohair/video/7132922545
786948869
"My Grandmother Washes her Feet"
"Letter from Birmingham Jail"

Blast Away
Skill: Annotation
Skill: Collaborative Conversation
Grammar Skill: 
Idependent/Dependent Clauses
Grammar Skill: Semicolon
Skill:Thesis
Literary Analysis: Draft
Skill:Theme
Skill: Primary and Secondary 
Sources
Skill: Rhetoric
Write: Timed Writing

Extended writing project with 
drafting emphasis

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

Moving Forward: How does Culture 
Influence your voice and your goals? 

4 weeks

1. TSWBATdevelop a research thesis
2. TSWBAT utilize programs such as Google Slides, Docs, Sheets 
and Canva to create detailed infographic
3. TSWBAT create an introduction and utilize text-appropriate 
transitions
4. TSWBAT improve writing through the drafting process

Of Mice and Men 
House of Spirits
"Contents of a Dead Man's Pockets"
"Possibility of Evil"
"Lamb to the Slaughter"
"A Rose for Emily
"The Gathering Place"
Valedictorian Address a AHS

Skill: Thesis Statement
Skill: Supporting Details
Skill: Introductions
Skill: Transitions
Skill: Conclusions
Informative Writing Process: 
Revise
Grammar Skill: Parallel Structure
Grammar Skill: 
Prepositions/Phrases
Grammar Skill: Colon
Text Talks

100 Word Memoir
Informational Essay
Infographic

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

Shakespeare- Julius Caesar 3 weeks

1. Students will move from identifying theme topics to identifying 
theme statements
2. Students will learn to cite text evidence to support theme 
development
3. Students will learn to identify persuasive techniques (ethos, 
pathos, logos)
4. Students will close read and annotate for persuasive 
techniques in Shakespeare's writing
5. Students will learn to build compare and contrast essay writing 
from graphic organizers.
6. Students will learn to utilize appropriate transitions in essay 
wriiting
7. Students will learn to peer edit and apply appropriate feedback 
to their own writing Julius Caesar

Hamilton (the musical)
Vocabulary
Quiz
Think Questions
Blasts Compare/Contrast Essay

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

Research 3 weeks

1. TSWBAT develop a research thesis statement
2. TSWBAT distinguish between popular and scholarly sources
3. TSWBAT select an effective nonfiction text structure
4. TSWBAT skillfully integrate multiple sources to support each 
main point
5. TSWBAT apply balance to main points as required for a longer 
writing project
6. Students will be able to apply the mulitple steps of editing and 
revision
7. Students will be able to create an MLA style paper complete 
with works cited page
8. Students will be able to identify and evaluate rubric 
requirements within their own paper The Book Thief

Student Models and Reference 
Materials
Skill:Evaluating Resources
Skill:Considering Audience and 
Purpose
Various Blasts 2-3 page Research Paper

Unit/GENRE/THEME Pacing Learning Goals Possible Novels
Supporting Study Sync 

Materials Assessment

Fallen Angels 4 weeks

1. TSWBAT develop a timeline for the Vietnam Conflict
2. TSWBAT track static and dynamic characters
3. TSWBAT identify great craft moves made by the author (Myers)
4. TSWBAT identify flashbacks 
5. Students will identify and support symbols found in the story
6. Students will use text evidence to support a symbol that relates 
to their selected theme from the novel

Fallen Angels

Formative Assessments
Practice Activities
Blasts
Grammar Skills

Beautiful Sentences/One-
Pager



Speech

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Students will be able to 
communicate effectively in 
a variety of tasks

Communicate, 
effectively, express, 
share, generate Reinforce/Master

LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Students will be able to 
ask purposeful questions

Relevant, build, ideas, 
clarity, acquire, confirm Reinforce/Master

LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Students will be able to 
interpret different 
messages in conversation 

Interpretation, verbal, 
non-verbal Reinforce/Master

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Students will be able to 
converse respectfully

Converse, all-inclusive, 
foster, positive, respect, 
diverse Reinforce/Master

LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Students will be able to be 
a strong audience member

Active, attentive, 
listening skills Master

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Students will be able to 
complete a task following 
directions

Task, complex, mulit-
step directions Master

Presentation of Knowledge and Ideas



Speech

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Students will be able to 
present information 
appropriately for a variety 
of tasks, purposes, and 
audiences

Present information, 
findings, supporting 
evidence, organization, 
development, style Reinforce/Master

LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Students will be able to 
use speaking techniques 
for a variety of purposes

Demonstrate, adjust, 
speaking techniques, 
interpreting, grade-level Reinforce/Master

LA.12.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Students will be able to 
use evidence to support a 
perspective

Perspective, reasoning, 
valid, evidence Reinforce/Master

LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Students will be able to 
evaluate a presentation for 
credibility

Evaluate, motives, 
credibility Reinforce/Master

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Students will be able to 
understand the 
appropriate use of words

Awareness, sensitivity, 
appropriate Reinforce/Master

LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Students will be able to 
use visual/digital tools to 
enhance presentation

Strategic use, 
visual/digital tools, 
enhance, findings, 
reasoning, evidence Master

Comprehension and Collaboration



Speech

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.10.SL.1

Initiate and participate in structured 
discussions and collaborations about 
grade-level topics and texts.

Students will be able to 
initiate and participate in 
grade-level discussions

Initiate, participate, 
discussions, 
collaborations, grade-
level Reinforce

LA.10.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Students will be able to 
ask meaningful questions 
to gain knowledge

Relevant, build, clarify, 
acquire, confirm Reinforce

LA.10.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Students will be able to 
interpret different 
messages in conversation

Interpretation, verbal, 
non-verbal, conversation Reinforce

LA.10.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Students will be able to 
converse respectfully

Converse, all-inclusive, 
foster, positive, 
respecting, diverse, 
persepctives Reinforce

LA.10.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Students will be able to 
listening skills

Active, attentive, 
listening skills Reinforce

LA.10.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Students will be able to 
follow directions to 
complete a task

Complete, task, 
complex, mulit-step Reinforce

Presentation of Knowledge and Ideas

LA.10.SL.2

Present information, findings, and 
supporting evidence clearly and 
concisely and in which the organization, 
development, and style are appropriate 
to a variety of tasks, purposes, and 
audiences.

Students will be able to 
present supported, 
organized information 
appropriate to different 
tasks and audiences

Present, information, 
findings, supporting 
evidence, organization, 
development, style, 
appropriate, variety Reinforce



Speech

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.10.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Students will be able to 
use speaking techniques 
for a variety of purposes

Adjust, speaking 
techniques, variety, 
interpreting, grade-level Reinforce

LA.10.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Students will be able to 
share a supported 
perspective

Convey, perspective, 
reasoning, valid, 
evidence Reinforce

LA.10.SL.2.c

c. Analyze the purpose of information 
being presented, evaluate its motives 
(e.g., social, commercial, political), and 
determine its credibility.

Students will be able to 
analyze and evaluate 
presented information

Analyze, purpose, 
evaluate, motives Reinforce

LA.10.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Students will be able to 
understand the 
appropriate use of words

Awareness, sensitivity, 
appropriate Reinforce

LA.10.SL.2.e

e. Select and use appropriate visual 
and/or digital tools to enhance verbal 
communication and add interest.

Students will be able to 
use visual/digital tools to 
enhance presentation

select, use, visual/digital 
tools, enhance Reinforce



Speech

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/
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Master



Speech Planning

Unit/GENRE/THEME Pacing Learning Goals Supporting Materials Assessment

Communication

SWBAT: understand and 
identify the different elements 
of communication, including 
the process, messages, and 
meanings. (verbal and 
nonverbal) Daily Bell Ringer 
SWBAT: understand and 
identify the different types of 
communication.
(Public, Group, Interpretive, 
Interpersonal)

Notes
SWBAT: Identify the 
elements of voice (pitch, rate, 
volume, vocal quality) Review Handout
SWBAT: Understand the 
listening process.
(Receive, interpret, evaluate, 
respond)

SWBAT: understand how the 
body produces sounds and 
forms words. 

Memorization

SWBAT: Understand 
memorization tools and be 
able to use the methods 
while memorizing a poem. Notes Daily Bell Ringer 
SWBAT: Convey a 
perspective with clear 
reasoning and be able to 
apply understanding to their 
poems.

Poetry Out Loud Website: Poem Selections, Tips and 
Tools Document, Adapted Rubric, Poem Recitation 
Example Videos

Poem Interpretation 
Paragraph

SWBAT: Understand the 
importance of emotional tone 
in poetry and use it in 
recitation. 

"Jenny Kissed Me" poem audio,  "Jenny Kissed Me" tone 
table

Poem work: 
highlighting, 
"chunking", rewrites

SWBAT: Identify and analyze 
the elements of the rubric 
and be able to apply the 
elements throughout the 
activities. 

Labeled emotional 
tones and emotional 
tone table

SWBAT: Evaluate the 
purpose of the information 
being presented and convey 
the meaning through their 
recitation. 

Recitation example(s): 
group discussions and 
individual written 
questions

SWBAT: Understand the 
different speaking techniques 
and be able to demonstrate 
and adjust them in the 
presentation. Group recitation 
SWBAT: Understand 
attentive listening skills and 
be able to demonstrate the 
skills.

Poem recitation from 
memory (summative)

Construction and Delivery
SWBAT: Use the provided 
format to develop outlines. Notes Daily Bell Ringer 
SWBAT: Integrate grade-
level vocabulary Outline
SWBAT: “Compose 
grammatically correct multi-
paragraph compositions to 
convey meaning and add 
variety, interest, and fluency 
to written and spoken 
language.”

Introduction 
Paragraph, One Body 
Paragraph, Conclusion 
Paragraph

SWBAT:  “Use a recursive 
writing process to develop, 
strengthen, and produce 
writing appropriate to the 
audience, purpose, and 
discipline.” (Introduction, 3 
Body Paragraphs, 
Conclusion)

Social Ritual Speech 
(formative)

SWBAT: Understand and use 
the elements of delivery
(Gestures, Movement, 
Expression, Eye Contact)

Process Order (Demonstrative Speech)
SWBAT:  Use the provided 
format to develop outlines. Notes Daily Bell Ringer
SWBAT: Follow the process 
order by demonstrating 
something from beginning to 
end. Outline
SWBAT: Integrate grade-
level vocabulary Typed Speech
SWBAT:  “Compose 
grammatically correct multi-
paragraph compositions to 
convey meaning and add 
variety, interest, and fluency 
to written and spoken 
language.” (Introduction, 
Three body paragraphs, 
Conclusion)

Turnitin.com 
Submission

SWBAT: “Use a recursive 
writing process to develop, 
strengthen, and produce 
writing appropriate to the 
audience, purpose, and 
discipline.” Practice Assignment
SWBAT: use the elements of 
delivery while presenting
(Gestures, Movement, 
Expression, Eye Contact)

Final Speech 
Presentation 
(summative)

SWBAT: Understand 
attentive listening skills and 
be able to demonstrate the 
skills.

Proper Audience 
Attention

Interviews
SWBAT: Write open-ended 
questions. Interview/Open-ended Quesiton Notes Daily Bell Ringer
SWBAT: Evaluate and 
analyze published podcasts. Anchor

Interview Scenerio 
Document



Speech Planning

Unit/GENRE/THEME Pacing Learning Goals Supporting Materials Assessment
SWBAT: Organize and write 
a podcast script Notes

Podcast Evaluation 
Document

SWBAT: Interview a peer 
using open-ended questions.

Podcast Planner/ 
Podcast Open-Ended 
Questions

SWBAT: record an effective 
podcast (structure, space, 
conversation structure) Podcast Script
SWBAT: Evaluate and 
critique peer podcasts using 
rubrics

Peer Podcast 
(summative)
Peer Podcast 
Evaluation

Informative
SWBAT: Use online 
databases and libraries. DHMO.org website/source evaulation document Daily Bell Ringer
SWBAT: Evaluate and 
analyze credible sources Online Databases/Online Libraries

Credible Sources 
Document

SWBAT: Use the provided 
format to develop an outline. Notes Source Pages
SWBAT: “Compose 
grammatically correct multi-
paragraph compositions to 
convey meaning and add 
variety, interest, and fluency 
to written and spoken 
language.” (Introduction, 
Three Body Paragraphs, 
Conclusion) Outline
SWBAT: “Use a recursive 
writing process to develop, 
strengthen, and produce 
writing appropriate to the 
audience, purpose, and 
discipline.”

Informative Speech 
Presentaiton

SWBAT: Correctly cite 
sources within a speech. Works Cited Page
SWBAT: Integrate grade-
level vocabulary Practice Assignment
SWBAT: Compose an MLA 
works cited page reflective of 
the sources cited within the 
speech.

turnitin.com 
submission

SWBAT: Create and use an 
effective visual aid in 
accordance with the speech.
SWBAT: Understand and use 
the elements of delivery ( 
Gestures, Movement, 
Expression, Eye contact)

Persuasion Techniques

SWBAT: Define and use the 
three persuasive techniques 
of ethos, pathos, and logos. Commericals Daily Bell Ringer
SWBAT: Analyze resources 
to determine the persuasive 
technique used. Notes

Commerical Analysis

Persuasive
SWBAT: Use online 
databases and libraries. Notes Daily Bell Ringer
SWBAT: Create a purpose 
statement that contains a 
topic and stance. Source Pages
SWBAT: Evaluate and 
analyze credible sources Outline
SWBAT: Use the provided 
format to develop an outline. Works Cited Page
SWBAT: “Compose 
grammatically correct multi-
paragraph compositions to 
convey meaning and add 
variety, interest, and fluency 
to written and spoken 
language.” (Introduction, 
Three Body Paragraphs, 
Conclusion)

turnitin.com 
submission

SWBAT: “Use a recursive 
writing process to develop, 
strengthen, and produce 
writing appropriate to the 
audience, purpose, and 
discipline.” Persuasive Speech
SWBAT: Correctly cite 
sources within a speech. Practice Assignment
SWBAT: Integrate grade-
level vocabulary
SWBAT: Compose an MLA 
works cited page reflective of 
the sources cited within the 
speech.
SWBAT: Understand and use 
the elements of delivery ( 
Gestures, Movement, 
Expression, Eye contact)

Debate
SWBAT: Understand the 
debate process. Notes Daily Bell Ringer
SWBAT: Create a strong 
proposition (claim) statement A Few Good Men- Opening/Closing Examples

Claim/Proposition 
Handout

SWBAT: Research, organize, 
and analyze support for their 
argument.

Documents: Counterarguments, Opening Statement, 
Closing Statement

Counterarguments 
and Rebuttals

SWBAT: Develop 
counterarguments and 
rebuttals to those arguments. Research Questions
SWBAT: Create and use 
research questions Opening Statement
SWBAT: Create a strong 
opening statement that 
includes all necessary 
elements. Closing Statement
SWBAT: Create a strong 
closing statement that 
includes all necessary 
elements. Debate Notes
SWBAT: Participate in an 
effective group debate. Group Debate
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Central Ideas and Details

LA.12.RP.1

Evaluate the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of Wall Street > Skill: 
Theme > Model Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of 
Wall Street > Skill: Theme > Your Turn Unit 1 > Integrated Reading and Writing > Bartleby, the 
Scrivener: A Story of Wall Street > Close Read: Bartleby, the Scrivener: A Story of Wall Street > 
Read > Skills Focus Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of 
Wall Street > Close Read: Bartleby, the Scrivener: A Story of Wall Street > Write Unit 4 > 
Integrated Reading and Writing > A Raisin in the Sun > Skill: Theme > Model Unit 4 > Integrated 
Reading and Writing > A Raisin in the Sun > Skill: Theme > Your Turn Unit 4 > Integrated 
Reading and Writing > A Raisin in the Sun > Close Read: A Raisin in the Sun > Read > Skills 
Focus Unit 4 > Integrated Reading and Writing > A Raisin in the Sun > Close Read: A Raisin in the 
Sun > Write

Evalutate stated or implied 
theme developement implied, stated, theme MASTER

LA.12.RP.2

Analyze the development and 
interaction of literary elements such as 
characterization, setting, and plot, and 
how they contribute to the meaning of 
the work as a whole.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > Skill: Story Elements 
> Model Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > Close Read: 
The Story of an Hour > Read > Skills Focus Unit 1 > Integrated Reading and Writing > SyncStart: 
The Story of an Hour > Skill: Story Elements > Your Turn Unit 6 > Integrated Reading and Writing 
> The Night Before Christmas > Skill: Story Elements > Model Unit 6 > Integrated Reading and 
Writing > The Night Before Christmas > Close Read: The Night Before Christmas > Read > Skills 
Focus Unit 6 > Integrated Reading and Writing > The Night Before Christmas > Skill: Story 
Elements > Your Turn Unit 4 > Integrated Reading and Writing > A Raisin in the Sun > Skill: 
Dramatic Elements and Structure > Model Unit 4 > Integrated Reading and Writing > A Raisin in 
the Sun > Close Read: A Raisin in the Sun > Read > Skills Focus Unit 4 > Integrated Reading and 
Writing > A Raisin in the Sun > Skill: Dramatic Elements and Structure > Your Turn

Analyze literary elements 
(development and 

interaction)
characterization, setting, 

plot

NEW/DEEPEN: using an 
element of literature as a 

lens for analysis

Author's Craft

LA.12.RP.3

Evaluate an author’s use of point of 
view and how it contributes to the 
meaning, significance, or aesthetic of a 
literary text.

Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of Wall Street > Skill: 
Point of View > Model Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story 
of Wall Street > Skill: Point of View > Your Turn Unit 1 > Integrated Reading and Writing > 
Bartleby, the Scrivener: A Story of Wall Street > Close Read: Bartleby, the Scrivener > Read > 
Skills Focus Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of Wall 
Street > Close Read: Bartleby, the Scrivener > Write Unit 6 > Integrated Reading and Writing > 
American Horse > Skill: Point of View > Model Unit 6 > Integrated Reading and Writing > 
American Horse > Skill: Point of View > Your Turn Unit 6 > Integrated Reading and Writing > 
American Horse > Close Read: American Horse > Read > Skills Focus

Evalutate how point of 
view affects the text point of view, aesthetic REINFORCE/APPLY

LA.12.RP.4

Evaluate how an author develops 
structure in a literary text to contribute 
to its overall meaning and aesthetic 
impact.

Unit 2 > Integrated Reading and Writing > A Good Man is Hard to Find > Skill: Story Structure > 
Model Unit 2 > Integrated Reading and Writing > A Good Man is Hard to Find > Close Read: A 
Good Man is Hard to Find > Read > Skills Focus Unit 2 > Integrated Reading and Writing > A 
Good Man is Hard to Find > Skill: Story Structure > Your Turn Unit 2 > Integrated Reading and 
Writing > A Good Man is Hard to Find > Close Read: A Good Man is Hard to Find > Write Unit 6 
> Integrated Reading and Writing > American Horse > Skill: Story Structure > Model Unit 6 > 
Integrated Reading and Writing > American Horse > Skill: Story Structure > Your Turn Unit 6 > 
Integrated Reading and Writing > American Horse > Close Read: American Horse > Read > Skills 
Focus

Evluate how structure 
affects the overall text text structure REINFORCE

Knowledge and Ideas
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LA.12.RP.5

Apply knowledge of eighteenth-, 
nineteenth- and early-twentieth-century 
foundational works of literature, 
including how two or more texts from 
the same period treat similar themes or 
topics.

Unit 1 > Integrated Reading and Writing > An Address to Miss Phillis Wheatley > Skill: Compare 
and Contrast > Model Unit 1 > Integrated Reading and Writing > An Address to Miss Phillis 
Wheatley > Skill: Compare and Contrast > Your Turn Unit 1 > Integrated Reading and Writing > 
An Address to Miss Phillis Wheatley > Close Read: An Address to Miss Phillis Wheatley > Read > 
Skills Focus Unit 5 > Integrated Reading and Writing > The Great Gatsby > Skill: Compare and 
Contrast > Model Unit 5 > Integrated Reading and Writing > The Great Gatsby > Skill: Compare 
and Contrast > Your Turn Unit 5 > Integrated Reading and Writing > The Great Gatsby > Close 
Read: The Great Gatsby > Write Unit 5 > Integrated Reading and Writing > The Great Gatsby > 
Close Read: The Great Gatsby > Read > Skills Focus

Make comparisons 
between texts across time 

periods for theme 
development 

theme development, 
compare and contrast REINFORCE

LA.12.RP.6

Evaluate themes within and across 
literary texts to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Unit 1 > Integrated Reading and Writing > An Address to Miss Phillis Wheatley > Close Read: An 
Address to Miss Phillis Wheatley > Write Unit 1 > Integrated Reading and Writing > Bartleby, the 
Scrivener: A Story of Wall Street > Skill: Theme > Model Unit 1 > Integrated Reading and Writing 
> Bartleby, the Scrivener: A Story of Wall Street > Close Read: Bartleby, the Scrivener: A Story of 
Wall Street > Write Unit 2 > Integrated Reading and Writing > A Good Man Is Hard to Find > 
Close Read: A Good Man Is Hard to Find > Write Unit 3 > Integrated Reading and Writing > 
Given to Rust > Close Read: Given to Rust > Write Unit 4 > Integrated Reading and Writing > A 
Raisin in the Sun > Close Read: A Raisin in the Sun > Write Unit 4 > Integrated Reading and 
Writing > The Yellow Wallpaper > Close Read: The Yellow Wallpaper > Write G11U6 > 
Integrated Reading and Writing > American Horse > Close Read: American Horse > Write G11U6 
> Integrated Reading and Writing > Demeter's Prayer to Hades > Close Read: Demeter's Prayer to 
Hades > Write

Use identified themes to 
draw conclusions and 

generate questions
theme development, 
conclusions, inquiry REINFORCE

LA.12.RP.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of literary texts.

Unit 1 > Integrated Reading and Writing > An Address to Miss Phillis Wheatley > Skill: Compare 
and Contrast > Model Unit 1 > Integrated Reading and Writing > An Address to Miss Phillis 
Wheatley > Skill: Compare and Contrast > Your Turn Unit 1 > Integrated Reading and Writing > 
An Address to Miss Phillis Wheatley > Close Read: An Address to Miss Phillis Wheatley > Write 
Unit 2 > Integrated Reading and Writing > Adventures of Huckleberry Finn > Close Read: 
Adventures of Huckleberry Finn > Write Unit 4 > Integrated Reading and Writing > The Yellow 
Wallpaper > Skill: Compare and Contrast > Model Unit 4 > Integrated Reading and Writing > The 
Yellow Wallpaper > Skill: Compare and Contrast > Your Turn Unit 4 > Integrated Reading and 
Writing > The Yellow Wallpaper > Close Read: The Yellow Wallpaper > Write Unit 5 > Integrated 
Reading and Writing > The Great Gatsby > Skill: Compare and Contrast > Model Unit 5 > 
Integrated Reading and Writing > The Great Gatsby > Skill: Compare and Contrast > Your Turn 
Unit 5 > Integrated Reading and Writing > The Great Gatsby > Close Read: The Great Gatsby > 
Write Unit 6 > Integrated Reading and Writing > Demeter's Prayer to Hades > Close Read: 
Demeter's Prayer to Hades > Write

Analyze (compare) a 
variety of perspectives 
across various literary 

texts 
analysis, perspective, 

literary text REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RP.8

Read and comprehend a wide range 
of literary texts in the 12-CCR grade 
band independently and proficiently.

Grade 11 ELA Overview > Text Complexity > Page 3-94 Unit 1 > Integrated Reading and Writing 
> Bartleby, the Scrivener: A Story of Wall Street > First Read: Bartleby, the Scrivener: A Story of 
Wall Street > Read Unit 4 > Integrated Reading and Writing > The Fall of the House of Usher > 
Independent Read: The Fall of the House of Usher > Read Unit 5 > Integrated Reading and Writing 
> The Great Gatsby > First Read: The Great Gatsby > Read Unit 4 > Integrated Reading and 
Writing > The Big Idea > Skill: Recognizing Genre > Model Unit 3 > Integrated Reading and 
Writing > The Midnight Zone > Skill: Analyzing Realist, Naturalist, and Regionalist Literature > 
Model Unit 2 > Integrated Reading and Writing > Self-Selected Reading > Blast: Self-Selected

Read a range of grade-
level literary texts 

independently 
grade-level, 

independent, proficient REINFORCE
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LA.12.RI.1

Evaluate the development of central 
ideas over the course of an 
informational text or texts.

Unit 4 > Integrated Reading and Writing > How It Feels to Be Colored Me > Skill: Central or Main 
Idea > Model Unit 4 > Integrated Reading and Writing > How It Feels to Be Colored Me > Skill: 
Central or Main Idea > Your Turn Unit 4 > Integrated Reading and Writing > How It Feels to Be 
Colored Me > Close Read: How It Feels to be Colored Me > Write Unit 6 > Integrated Reading and 
Writing > I've Been to the Mountaintop > Skill: Central or Main Idea > Model Unit 6 > Integrated 
Reading and Writing > I've Been to the Mountaintop > Skill: Central or Main Idea > Your Turn 
Unit 6 > Integrated Reading and Writing > I've Been to the Mountaintop > Close Read: I've Been to 
the Mountaintop > Write

Find central ideas in 
informational texts

central ideas, 
informational texts REINFORCE

LA.12.RI.2

Synthesize and evaluate how the 
interaction of individuals, important 
events, and key ideas contribute to the 
meaning of the work as a whole.

Unit 6 > Integrated Reading and Writing > Second Inaugural Address > Skill: Informational Text 
Elements > Model Unit 6 > Integrated Reading and Writing > Second Inaugural Address > Skill: 
Informational Text Elements > Your Turn Unit 6 > Integrated Reading and Writing > Second 
Inaugural Address > Close Read: Second Inaugural Address > Write Unit 2 > Integrated Reading 
and Writing > The Negro Motorist Green Book > Skill: Informational Text Elements > Model Unit 
2 > Integrated Reading and Writing > The Negro Motorist Green Book > Skill: Informational Text 
Elements > Your Turn Unit 2 > Integrated Reading and Writing > The Negro Motorist Green Book 
> Close Read: The Negro Motorist Green Book > Read > Skills Focus

Recognize that all aspects 
of a text work together to 

create meaning
synthesis, contribute to 

the whole REINFORCE

Author's Craft

LA.12.RI.3

Citing relevant and thorough evidence 
to support ideas, evaluate the 
development and interaction of 
individuals, ideas, and events in grade-
level informational text.

Unit 1 > Integrated Reading and Writing > Declaration of Independence > Skill: Rhetoric > Model 
Unit 1 > Integrated Reading and Writing > Declaration of Independence > Skill: Rhetoric > Your 
Turn Unit 1 > Integrated Reading and Writing > Declaration of Independence > Close Read: 
Declaration of Independence > Read > Skills Focus Unit 4 > Integrated Reading and Writing > 
How It Feels to Be Colored Me > Skill: Author's Purpose and Point of View > Model Unit 4 > 
Integrated Reading and Writing > How It Feels to Be Colored Me > Skill: Author's Purpose and 
Point of View > Your Turn Unit 4 > Integrated Reading and Writing > How It Feels to Be Colored 
Me > Close Read: How It Feels to Be Colored Me > Read > Skills Focus

Cite evidence to support 
ideas and track 

developement of key ideas 
cite, evidence, 
development REINFORCE

LA.12.RI.4

Evaluate an author’s perspective or 
purpose and how it contributes to the 
meaning, significance, or aesthetic of 
an informational text.

Unit 2 > Integrated Reading and Writing > Driving My Own Destiny > Skill: Informational Text 
Structure > Model Unit 2 > Integrated Reading and Writing > Driving My Own Destiny > Close 
Read: Driving My Own Destiny > Read > Skills Focus Unit 2 > Integrated Reading and Writing > 
Driving My Own Destiny > Skill: Informational Text Structure > Your Turn Unit 5 > Integrated 
Reading and Writing > The Marshall Plan Speech > Skill: Informational Text Structure > Model 
Unit 5 > Integrated Reading and Writing > The Marshall Plan Speech > Close Read: The Marshall 
Plan Speech > Read > Skills Focus Unit 2 > Integrated Reading and Writing > The Marshall Plan 
Speech > Skill: Informational Text Structure > Your Turn Unit 5 > Integrated Reading and Writing 
> The Marshall Plan Speech > Close Read: The Marshall Plan Speech > Write

Understand author's 
purpose author's purpose REINFORCE

Knowledge and Ideas

LA.12.RI.5

Analyze seventeenth-, eighteenth-, and 
nineteenth-century works of historical 
and literary significance for their central 
ideas, purposes, and rhetorical style.

Unit 1 > Integrated Reading and Writing > Declaration of Independence > Skill: Primary and 
Secondary Sources > Model Unit 1 > Integrated Reading and Writing > Declaration of 
Independence > Skill: Primary and Secondary Sources > Your Turn Unit 1 > Integrated Reading 
and Writing > Declaration of Independence > Close Read: Declaration of Independence > Read > 
Skills Focus Unit 6 > Integrated Reading and Writing > Second Inaugural Address > Skill: Primary 
and Secondary Sources > Model Unit 6 > Integrated Reading and Writing > Second Inaugural 
Address > Skill: Primary and Secondary Sources > Your Turn

Understand and recognize 
purposes and different 
rhetorical styles of texts 

from various time periods. rhetorical styles REINFORCE
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LA.12.RI.6

Compare and contrast the 
development of multiple arguments in 
texts of related topics, evaluating the 
effectiveness and validity of the claims.

Unit 1 > Integrated Reading and Writing > Declaration of Independence > Skill: Rhetoric > Model 
Unit 1 > Integrated Reading and Writing > Declaration of Independence > Skill: Rhetoric > Your 
Turn Unit 1 > Integrated Reading and Writing > Declaration of Independence > Close Read: 
Declaration of Independence> Write Unit 2 > Integrated Reading and Writing > Remarks at the 
Signing of the Highway Beautification Act > Skill: Arguments and Claims > Model Unit 2 > 
Integrated Reading and Writing > Remarks at the Signing of the Highway Beautification Act > 
Skill: Arguments and Claims > Your Turn Unit 2 > Integrated Reading and Writing > Remarks at 
the Signing of the Highway Beautification Act > Close Read: Remarks at the Signing of the 
Highway Beautification Act > Read > Skills Focus Unit 3 > Integrated Reading and Writing > 
Barracoon: The Story of the Last “Black Cargo” > Close Read: Barracoon: The Story of the Last 
“Black Cargo” > Write Unit 4 > Integrated Reading and Writing > Letter from Chief John Ross > 
Skill: Reasons and Evidence > Model Unit 4 > Integrated Reading and Writing > Letter from Chief 
John Ross > Skill: Reasons and Evidence > Your Turn Unit 4 > Integrated Reading and Writing > 
Letter from Chief John Ross > Close Read: Letter from Chief John Ross > Read > Skills Focus

Compare arguements for 
validity and effectiveness Validity REINFORCE

LA.12.RI.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of informational texts.

Unit 1 > Integrated Reading and Writing > Declaration of Independence > Close Read: Declaration 
of Independence> Write Unit 1 > Integrated Reading and Writing > Life After High School > Close 
Read: Life After High School > Write Unit 2 > Integrated Reading and Writing > Remarks at the 
Signing of the Highway Beautification Act > Close Read: Remarks at the Signing of the Highway 
Beautification Act > Write Unit 3 > Integrated Reading and Writing > The Story of the Last "Black 
Cargo" > Close Read: The Story of the Last "Black Cargo" > Write Unit 4 > Integrated Reading 
and Writing > Letter from Chief John Ross > Close Read: Letter from Chief John Ross > Write 
Unit 4 > Integrated Reading and Writing > Dream House > Close Read: Dream House > Write

Analyze (compare) a 
variety of perspectives 
across various 
informational texts perspective REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RI.8

Read and comprehend a wide range 
of informational texts in the 12-CCR 
grade band independently and 
proficiently.

Grade 11 ELA Overview > Text Complexity > Page 3-94 Unit 2 > Integrated Reading and Writing 
> Walden > Independent Read: Walden > Read Unit 4 > Integrated Reading and Writing > Letter 
from Chief John Ross > First Read: Letter from Chief John Ross > Read Unit 6 > Integrated 
Reading and Writing > Civil Rights Act of 1964 > Independent Read: Civil Rights Act of 1964 > 
Read Unit 2 > Integrated Reading and Writing > The Big Idea > Skill: Recognizing Genre > Model 
Unit 4 > Integrated Reading and Writing > The Big Idea > Literary Focus: The Harlem Renaissance 
> Think Unit 4 > Integrated Reading and Writing > Self-Selected Reading > Blast: Self-Selected

Read a range of grade-
level informational texts 
independently

idependent, proficient, 
grade-level REINFORCE

V
o
c
a
b
u
l
a
r
y

Acquisition and Use

LA.12.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Unit 5 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Model 
Unit 5 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Your 
Turn Unit 6 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > 
Model Unit 6 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > 
Your Turn Unit 4 > Integrated Reading and Writing > Fences > Close Read: Fences > Write > 
Teacher Edition - Instruction > 3. Write > Academic Vocabulary Focus Unit 6 > Integrated Reading 
and Writing > Second Inaugural Address > Close Read: Second Inaugural Address > Vocabulary 
Unit 6 > Integrated Reading and Writing > The Marshall Plan Speech > Close Read: The Marshall 
Plan Speech > Vocabulary Unit 2 > Extended Writing Project and Grammar > Revise > Skill: 
Precise Language > Model Unit 2 > Extended Writing Project and Grammar > Revise > Skill: 
Precise Language > Your Turn Unit 2 > Extended Writing Project and Grammar > Revise > Skill: 
Precise Language > Write

Use approprirate grade-
level vocabulary vocabulary REINFORCE

LA.12.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour: The Story of an Hour 
> Skill: Context Clues > Model Unit 1 > Integrated Reading and Writing > SyncStart: The Story of 
an Hour: The Story of an Hour > Skill: Context Clues > Your Turn Unit 2 > Integrated Reading and 
Writing > Remarks at the Signing of the Highway Beautification Act > Skill: Contexts Clues > 
Model Unit 1 > Integrated Reading and Writing > Remarks at the Signing of the Highway 
Beautification Act > Skill: Context Clues > Your Turn

Use approprirate grade-
level vocabulary context-clues Reinforce



English 11

Seward Public 
Schools

A L I G N M E N T
U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

V
o
c
a
b
u
l
a
r
y

LA.12.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
conceive, conception, conceivable).

Unit 2 > Integrated Reading and Writing > Driving My Own Destiny > Skill: Word Patterns and 
Relationships > Model Unit 2 > Integrated Reading and Writing > Driving My Own Destiny > 
Skill: Word Patterns and Relationships > Your Turn Unit 2 > Integrated Reading and Writing > 
Driving My Own Destiny > Close Read: Driving My Own Destiny > Read > Skills Focus Unit 5 > 
Integrated Reading and Writing > The Marshall Plan > Skill: Word Patterns and Relationships > 
Model Unit 5 > Integrated Reading and Writing > The Marshall Plan > Skill: Word Patterns and 
Relationships > Your Turn Unit 5 > Integrated Reading and Writing > The Marshall Plan Speech > 
Close Read: The Marshall Plan Speech > Read > Skills Focus

Use approprirate grade-
level vocabulary forms of words Reinforce

LA.12.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, 
etymology, or standard usage of words.

Unit 2 > Integrated Reading and Writing > The Negro Motorist Green Book > Skill: Word Meaning 
> Model Unit 2 > Integrated Reading and Writing > The Negro Motorist Green Book > Skill: Word 
Meaning > Your Turn Unit 2 > Integrated Reading and Writing > The Negro Motorist Green Book 
> Close Read: The Negro Motorist Green Book > Read > Skills Focus Unit 5 > Integrated Reading 
and Writing > Brown v. Board of Education > Skill: Word Meaning > Model Unit 5 > Integrated 
Reading and Writing > Brown v. Board of Education > Skill: Word Meaning > Your Turn Unit 5 > 
Integrated Reading and Writing > Brown v. Board of Education > Close Read: Brown v. Board of 
Education > Read > Skills Focus

Use approprirate grade-
level vocabulary

refererence materials, 
etymology, precise 

meanings Reinforce

Context and Connotations

LA.12.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Unit 5 > Integrated Reading and Writing > Brown v. Board of Education > Skill: Technical 
Language > Model Unit 5 > Integrated Reading and Writing > Brown v. Board of Education > 
Skill: Technical Language > Your Turn Unit 5 > Integrated Reading and Writing > Brown v. Board 
of Education > Close Read: Brown v. Board of Education > Read > Skills Focus Unit 4 > 
Integrated Reading and Writing > Letter From Chief John Ross > Skill: Technical Language > 
Model Unit 4 > Integrated Reading and Writing > Letter From Chief John Ross > Skill: Technical 
Language > Your Turn

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.a

a. Interpret figures of speech (e.g., 
hyperbole, paradox) in context and 
analyze their role in text.

Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of Wall Street > Skill: 
Figurative Language > Model Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A 
Story of Wall Street > Close Read: Bartleby, the Scrivener: A Story of Wall Street > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > Bartleby, the Scrivener: A Story of Wall Street > 
Close Read: Bartleby, the Scrivener: A Story of Wall Street > Write Unit 1 > Integrated Reading 
and Writing > Bartleby, the Scrivener: A Story of Wall Street > Skill: Figurative Language > Your 
Turn Unit 3 > Integrated Reading and Writing > The Midnight Zone > Skill: Figurative Language > 
Model Unit 3 > Integrated Reading and Writing > The Midnight Zone > Close Read: The Midnight 
Zone > Read > Skills Focus Unit 3 > Integrated Reading and Writing > The Midnight Zone > Close 
Read: The Midnight Zone > Write Unit 3 > Integrated Reading and Writing > The Midnight Zone > 
Skill: Figurative Language > Your Turn

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.b

b. Analyze nuances in the meanings of 
words with similar denotations.

Unit 3 > Integrated Reading and Writing > My True South: Why I Decided to Return Home > Skill: 
Connotation and Denotation > Model Unit 3 > Integrated Reading and Writing > My True South: 
Why I Decided to Return Home > Close Read: My True South: Why I Decided to Return Home > 
Read > Skills Focus Unit 3 > Integrated Reading and Writing > My True South: Why I Decided to 
Return Home > Skill: Connotation and Denotation > Your Turn Unit 2 > Integrated Reading and 
Writing > A Good Man is Hard to Find > Skill: Connotation and Denotation > Model Unit 2 > 
Integrated Reading and Writing > A Good Man is Hard to Find > Close Read: A Good Man is Hard 
to Find > Read > Skills Focus Unit 2 > Integrated Reading and Writing > A Good Man is Hard to 
Find > Skill: Connotation and Denotation > Your Turn

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

Production of Writing



English 11

Seward Public 
Schools

A L I G N M E N T
U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.12.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and to add variety, interest, 
and fluency to written and spoken 
language.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 
1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 2 > 
Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise > Write 
Unit 3 > Extended Writing Project and Grammar > Draft > Literary Analysis Writing Process: 
Draft > Write Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and 
Relevant Evidence > Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: 
Reasons and Relevant Evidence > Your Turn Unit 6 > Extended Oral Project and Grammar > Plan 
> Oral Presentation Process: Plan > Intro

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.a

a. Demonstrate understanding that 
usage is a matter of convention, can 
evolve, and is sometimes contested.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Grammar Skill: 
Capitalization > Model Unit 1 > Extended Writing Project and Grammar > Edit and Publish > 
Grammar Skill: Capitalization > Your Turn Unit 1 > Extended Writing Project and Grammar > Edit 
and Publish > Narrative Writing Process: Edit and Publish > Write Library > Skills > Filter > 
Select: Grade 11 > Select: Grammar > Search: Capitalization > Capitalization - Other Proper Nouns 
Library > Skills > Filter > Select: Grade 11 > Select: Grammar > Search: Capitalization > 
Capitalization - Proper Adjectives Library > Skills > Filter > Select: Grade 11 > Select: Grammar > 
Search: Capitalization > Capitalization - Quotations Library > Skills > Filter > Select: Grade 11 > 
Select: Grammar > Search: Capitalization > Capitalization - Sentences

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.b

b. Apply knowledge of function and 
usage to revise personal and peer 
writing while resolving issues of complex 
or contested usage, consulting 
appropriate and reliable reference 
materials.

Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Grammar Skill: Colons and 
Semicolons - Semicolons > Model Unit 3 > Extended Writing Project and Grammar > Edit and 
Publish > Grammar Skill: Colons and Semicolons - Semicolons > Your Turn Unit 3 > Extended 
Writing Project and Grammar > Edit and Publish > Literary Analysis Writing Process: Edit and 
Publish Library > Skills > Filter > Select: Grade 11 > Select: Grammar > Search: Colons and 
Semicolons

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Unit 5 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > 
Write Unit 5 > Extended Writing Project and Grammar > Draft > Argumentative Writing Process: 
Draft > Write Unit 5 > Extended Writing Project and Grammar > Revise > Argumentative Writing 
Process: Revise > Write Unit 5 > Extended Writing Project and Grammar > Edit and Publish > 
Argumentative Writing Process: Edit and Publish > Write Unit 1 > Integrated Reading and Writing 
> SyncStart: The Story of an Hour > Skill: Peer Review: Model

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Unit 2 > Extended Writing Project and Grammar > Plan > Informative Writing Process: Plan > 
Write Unit 2 > Extended Writing Project and Grammar > Draft > Informative Writing Process: 
Draft > Write Unit 1 > Extended Writing Project and Grammar > Plan > Narrative Writing Process: 
Plan > Write Unit 1 > Extended Writing Project and Grammar > Draft > Narrative Writing Process: 
Draft > Write Unit 1 > Integrated Reading and Writing > Self-Selected Reading > Write: Self-
Selected Response > Write Unit 5 > Integrated Reading and Writing > Self-Selected Reading > 
Write: Self-Selected Response > Write Unit 4 > Extended Writing Project and Grammar > Draft > 
Skill: Evaluating Sources > Model Unit 4 > Extended Writing Project and Grammar > Draft > 
Skill: Evaluating Sources > Your Turn

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE
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LA.12.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Unit 5 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > 
Write Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant 
Evidence > Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and 
Relevant Evidence > Your Turn Unit 5 > Extended Writing Project and Grammar > Draft > 
Argumentative Writing Process: Draft > Write Unit 5 > Extended Writing Project and Grammar > 
Revise > Argumentative Writing Process: Revise > Write Unit 5 > Extended Writing Project and 
Grammar > Edit and Publish > Argumentative Writing Process: Edit and Publish > Write Unit 5 > 
Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 4 > Integrated 
Reading and Writing > Fences > Close Read: Fences > Write > Organizer (left blue tab) Unit 4 > 
Integrated Reading and Writing > Fences > Close Read: Fences > Write Teacher Edition > 4. Write 
- Peer Review and Reflect

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Unit 1 > Extended Writing Project and Grammar > Revise > Narrative Writing Process: Revise > 
Write Unit 2 > Extended Writing Project and Grammar > Revise > Informative Writing Process: 
Revise > Write Unit 3 > Extended Writing Project and Grammar > Revise > Literary Analysis 
Writing Process: Revise > Write Unit 4 > Extended Writing Project and Grammar > Revise > 
Research Writing Process: Revise > Write Unit 5 > Extended Writing Project and Grammar > 
Revise > Argumentative Writing Process: Revise > Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Narrative Writing Process: 
Edit and Publish > Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish > 
Informative Writing Process: Edit and Publish > Write Unit 3 > Extended Writing Project and 
Grammar > Edit and Publish > Literary Analysis Writing Process: Edit and Publish > Write Unit 4 
> Extended Writing Project and Grammar > Edit and Publish > Research Writing Process: Edit and 
Publish > Write Unit 5 > Extended Writing Project and Grammar > Edit and Publish > 
Argumentative Writing Process: Edit and Publish > Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Unit 5 > Extended Writing Project and Grammar > Revise > Argumentative Writing Process: 
Revise > Write Unit 5 > Extended Writing Project and Grammar > Edit and Publish > 
Argumentative Writing Process: Edit and Publish > Write Unit 4 > Extended Writing Project and 
Grammar > Edit and Publish > Research Writing Process: Edit and Publish > Write Unit 1 > 
Integrated Reading and Writing > Self-Selected Reading > Write: Self-Selected Response > Write 
Unit 5 > Integrated Reading and Writing > Self-Selected Reading > Write: Self-Selected Response 
> Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

Modes of Writing

LA.12.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and discipline.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 
1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Your Turn Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model 
Unit 1 > Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > 
Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 
1 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Your Turn Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model 
Unit 1 > Extended Writing Project and Grammar > Draft > Skill: Organizing Narrative Writing > 
Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Model 
Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Write 
Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Your 
Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE
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LA.12.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to set mood and tone.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Model 
Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Write Unit 
1 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 5 
> Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Argumentative Writing > Model Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Argumentative Writing > Your 
Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 5 
> Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Argumentative Writing > Model Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Organizing Argumentative Writing > Your 
Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > 
Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant 
Evidence > Your Turn Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Reasons 
and Relevant Evidence > Model Unit 3 > Extended Writing Project and Grammar > Draft > Skill: 
Reasons and Relevant Evidence > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Unit 5 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 5 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Unit 5 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 5 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Write Unit 5 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Unit 5 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 5 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write Unit 5 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE
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LA.12.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Organizing Informative Writing > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Organizing Informative Writing > Your 
Turn Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic Features 
> Model Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic 
Features > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and 
Graphic Features > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Organizing Informative Writing > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Organizing Informative Writing > Your 
Turn Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic Features 
> Model Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and Graphic 
Features > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Print and 
Graphic Features > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.b

b. Develop the topic thoroughly with 
relevant, sufficient facts, extended 
definitions, concrete details, quotations, 
and/or other information and examples.

Unit 2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Model Unit 
2 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Write Unit 2 > 
Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn Unit 2 > Extended Writing 
Project and Grammar > Revise > Skill: Precise Language > Model Unit 2 > Extended Writing 
Project and Grammar > Revise > Skill: Precise Language > Write Unit 2 > Extended Writing 
Project and Grammar > Revise > Skill: Precise Language > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Write Unit 2 > 
Extended Writing Project and Grammar > Edit and Publish > Style > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.6

Gather and use credible evidence from 
multiple authoritative sources, evaluate 
the strengths and limitations of sources 
in terms of the task, purpose, and 
audience, and assess their relevance in 
answering the research question(s).

Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 
4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn Unit 4 
> Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Write Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Your Turn Unit 4 
> Extended Writing Project and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Sources and Citations > Write Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Sources and Citations > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Model 
Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Your 
Turn Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > Skill: 
Annotation > Model Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > 
Skill: Annotation > Your Turn Unit 2 > Extended Writing Project > Draft > Skill: Organizing 
Informative Writing > Model Unit 2 > Extended Writing Project > Draft > Skill: Organizing 
Informative Writing > Your Turn > Item 2 Unit 3 > Integrated Reading and Writing > Their Eyes 
Were Watching God > Independent Read: Their Eyes Were Watching God > Write > Organizer 
(left blue tab)

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g., MLA, APA, Chicago).

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 
4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn Unit 4 
> Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Write Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Your Turn Unit 4 
> Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Write Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Sources and Citations > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Library > Blasts > Search: To Be Honest > Blast: To Be Honest Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing Project and Grammar 
> Revise > Skill: Paraphrasing > Your Turn Unit 4 > Extended Writing Project and Grammar > 
Draft > Skill: Evaluating Sources > Model Unit 4 > Extended Writing Project and Grammar > Draft 
> Skill: Evaluating Sources > Your Turn Unit 6 > Extended Oral Project and Grammar > Draft > 
Skill: Evaluating Sources > Model Unit 6 > Extended Oral Project and Grammar > Draft > Skill: 
Evaluating Sources > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > The Story of an Hour 
> Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: The Story of an Hour > The Story of an Hour > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Your Turn

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE
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LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > The Story of an Hour 
> Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: The Story of an Hour > The Story of an Hour > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Your Turn

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model Unit 
6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Write Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Write Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Edit and Present > Oral Presentation Process - Edit and 
Present > Active Listening Checklist

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > The Story of an Hour 
> Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: The Story of an Hour > The Story of an Hour > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Write Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > 
Your Turn Unit 3 > Integrated Reading and Writing > South > Independent Read: South > Write 
Unit 1 > Integrated Reading and Writing > The Namesake > Independent Read: The Namesake > 
Write

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model 
Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Write Unit 
6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Your Turn Unit 
6 > Extended Oral Project and Grammar > Edit and Present > Oral Presentation Process - Edit and 
Present > Active Listening Checklist

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Core ELA > Grade 11 > Additional Resources > Project Based Learning > Grade 11 > Community 
Form, page 34 Core ELA > Grade 11 > Additional Resources > Project Based Learning > Grade 11 
> Public Awareness Campaign, page 35 Core ELA > Grade 11 > Additional Resources > Project 
Based Learning > Grade 11 > Physical Space Revamp, page 36 Core ELA > Grade 11 > Additional 
Resources > Project Based Learning > Grade 11 > Found Objects Art Exhibit, page 37 Core ELA > 
Grade 11 > Additional Resources > Project Based Learning > Grade 11 > Team-Building 
Workshop, page 38 Core ELA > Grade 11 > Additional Resources > Project Based Learning > 
Grade 11 > Service Project, page 39

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

Presentation of Knowledge and Ideas

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > Skill: Collaborative 
Conversations > Model Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour 
> Skill: Collaborative Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral Project and Grammar > 
Edit and Present > Oral Presentation and Process: Edit and Present > Write Unit 6 > Extended Oral 
Project and Grammar > Draft > Skill: Considering Audience and Purpose > Model Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > Your 
Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > 
Your Turn Unit 4 > Integrated Reading and Writing > How It Feels to Be Colored Me > Close 
Read: How It Feels to Be Colored Me > Write Unit 3 > Integrated Reading and Writing > South > 
Independent Read: South > Write Unit 5 > Integrated Reading and Writing > The Moor's Account 
> Independent Read: The Moor's Account > Write

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour > Skill: Collaborative 
Conversations > Model Unit 1 > Integrated Reading and Writing > SyncStart: The Story of an Hour 
> Skill: Collaborative Conversations > Your Turn Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral Project and Grammar > 
Edit and Present > Oral Presentation and Process: Edit and Present > Write Unit 6 > Extended Oral 
Project and Grammar > Draft > Skill: Considering Audience and Purpose > Model Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > Your 
Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > 
Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > 
Your Turn Unit 4 > Integrated Reading and Writing > How It Feels to Be Colored Me > Close 
Read: How It Feels to Be Colored Me > Write Unit 3 > Integrated Reading and Writing > South > 
Independent Read: South > Write Unit 5 > Integrated Reading and Writing > The Moor's Account 
> Independent Read: The Moor's Account > Write

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > 
Model Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral 
Presentation > Write Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an 
Oral Presentation > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Reasons and Evidence > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Reasons and Evidence > Your Turn Unit 6 > Extended Oral Project and Grammar > Draft > Skill: 
Persuasive Techniques > Model Unit 6 > Extended Oral Project and Grammar > Draft > Skill: 
Persuasive Techniques > Write Unit 6 > Extended Oral Project and Grammar > Draft > Skill: 
Persuasive Techniques > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Unit 6 > Integrated Reading and Writing > I've Been to the Mountaintop > Skill: Rhetoric > Model 
Unit 6 > Integrated Reading and Writing > I've Been to the Mountaintop > Close Read: I've Been to 
the Mountaintop > Read > Skills Focus Unit 6 > Integrated Reading and Writing > I've Been to the 
Mountaintop > Close Read: I've Been to the Mountaintop > Write Unit 6 > Integrated Reading and 
Writing > I've Been to the Mountaintop > Skill: Rhetoric > Your Turn Unit 5 > Integrated Reading 
and Writing > The Marshall Plan Speech > Skill: Author's Purpose and Point of View > Model Unit 
5 > Integrated Reading and Writing > The Marshall Plan Speech > Close Read: The Marshall Plan 
Speech > Read > Skills Focus Unit 5 > Integrated Reading and Writing > The Marshall Plan 
Speech > Close Read: The Marshall Plan Speech > Write Unit 5 > Integrated Reading and Writing 
> The Marshall Plan Speech > Skill: Author's Purpose and Point of View > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Model Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Unit 3 > Integrated Reading and Writing > My True South: Why I Decided to Return Home > Skill: 
Connotation and Denotation > Model Unit 3 > Integrated Reading and Writing > My True South: 
Why I Decided to Return Home > Skill: Connotation and Denotation > Your Turn Unit 5 > 
Integrated Reading and Writing > Hunger: A Memoir of (My Body) > Skill: Connotation and 
Denotation > Model Unit 5 > Integrated Reading and Writing > Hunger: A Memoir of (My Body) > 
Skill: Connotation and Denotation > Your Turn Library > Blast > Search: In the Deep > Blast: In 
the Deep Library > Blast > Search: Word for Word > Blast: Word for Word

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > 
Model Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral 
Presentation > Write Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an 
Oral Presentation > Your Turn Unit 6 > Extended Oral Project and Grammar > Plan > Oral 
Presentation Process: Plan > Intro Unit 6 > Extended Oral Project and Grammar > Plan > Oral 
Presentation Process: Plan > Read Unit 6 > Extended Oral Project and Grammar > Plan > Oral 
Presentation Process: Plan > Write

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Mythology (Pre-Odyssey) 3 days
Students will recognize the influence of Greek mythology in our 
culture. Hamilton's Mythology Teacher created 
Students will understand the roles of the Greek Olympians and 
some lesser gods, and be able to identify them.
Students will practice a short answer style question to master basic 
requirements: paraphrase shows understanding, repetition is for 
emphasis (doesn't build an argument or count as a separate idea), answers 
must be meaningful 
Students practice two reading styles with Hamilton's intro: find a 
fact vs. read for meaning and be able to paraphrase a more 
complex idea.       Students will identify 5 Elements of Mythology, 
and apply them to several myths.  Students will practice finding 
evidence with Zeus and Prometheus' relationship.
Students will Lead and participate in small and large groups 
discussion

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

The Hero Archetype 5 days
Students will be able to explain the difference between Sign, 
Symbol and Archetype

Jung's monomyth/ 
Cambell's hero traits/ 
paraphrase of Theseus

We explore the idea of the hero throughout 
the sememster (hero/ anti hero/ tragic 
hero). These three types have novels that 
are in studysync.  This unit is prep work for 
that. If I find blasts or articles that relate to 
these concepts in studysync, I will add 
them in. 

Write an essay 
to apply the 
hero archetype 
to a story.

Students will understand the classic hero role and recognize it as 
one of many archetypes.
Students will understand Campbell's Monomyth and apply it to 
several hero stories.
Students will understand Stillman's Hero Traits and apply them to 
various hero stories.
Students will write an essay to show mastery of applying the Hero 
Traits to a hero story.  Honors students will both apply the hero 
traits and make a comparison between two hero stories. 
Students will lead and participate in small and large groups 
discussions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

The Odyssey/ Traditional Hero 24 days Students will identify the elements of an epic poem

The Odyssey, Fagles 
translation, and also 
Odyssey Seminar 
packets

Novel guide in studysync. Vocab, guide 
questions, possible writings

Teacher 
Created quizzes 
and final 
assessment; 
Graded on Peer 
Review doc and 
Participation in 
Seminar, 
characterization 
posters

students will follow the plot of an epic hero story, The Odyssey
Students will identify details that create characterization: in study 
guide questions, on graphics, on posters in group work. This 
includes both finding support to build an identity, and to track a 
character's change 
Students will use the hero archeytpe to find overall patterns in 
Odysseus' story, including the appearance of guides, the need for 
the hero to grow and change, etc.
Students will find evidence and track a character's purpose, or 
what a character has learned
Students will review the simile, and unpack extended (or Epic) 
similes found in The Odyssey. Students will recognize that epic 
similes can add to characterization and mood.   
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Students will work in groups and present information to their 
classmates.
Students will prepare for and then lead/ participate in a Class 
Seminar.  This seminar will use The Odyssey Ch. 1-12 and several 
question about the ideas of Fate and Responsibility.  They will 
make connections between what we have read and real world 
examples. Students keep this conversation going without the 
teacher for 15 minutes.  Peers track their participation, and then 
the groups switch. 
students will recognize what characteristics are admired by the 
ancient Greeks, and find evidence for or against these norms, and 
tie this information to characterization.  
Students will trace Light Images in the latter chapters of The 
Odyssey, and draw conclusions about the use of light
Students will prepare for and then lead/ participate in a final Class 
Seminar.  This seminar will use ideas from Stillman's Hero Traits 
and several other short readings about Mythic Structures. They will 
make connections between what we have read and real world 
examples. Students keep this conversation going without the 
teacher for 15 minutes.  Peers track their participation, and then 
the groups switch. 
Students will lead and participate in small and large groups 
discusions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Multi-Cultural Short Stories 5-6 days Students will read literature for understanding

The Daughter of 
Inverntion--J.Alvarez, By 
Any Other Name--S. 
Rama Rau, The Book of 
the Dead--E.Danticatt, 
The sun Still Rises in the 
Same Sky--J. Bruchac, # 
Native Myths/ poem (Sky 
Tree/ Coyote Finishes His 
Work/The Earth Only)

I will add studysync short stories over the 
next few semesters.  

Teacher 
Created       
Short essays 
with a focus on 
making 
characterization 
connections 
between the 
stories.

       examine another culture's attitudes and ideas
       recognize and identify elements of literature used in the text.  
Focus on conflict, characterization, irony

       find essential details and examples that support a given 
subject, idea or theme  (Analyze)

       use details and examples in literature to identify a recurring 
subject, idea or theme (Synthesize)

Students will lead and participate in small and large groups 
discussions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Research Paper 8 days. At the start of Term 2 or 4 The student will access the databases N/A
Student models and some reference 
materials.

English 11 
writes a 3-4 
page paper, 
double spaced. 
Page count 
does not 
include the 
works cited 
page. There are 
also progress 
grade checks 
on source 
count/ notes 
made/ outline

search databases to find and narrow a topic 
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take a stance on a topic/ create a thesis 
read on a topic and refine arguments to defend a stance
take notes on slides or cards to show which information is being 
used
Create a works cited page in MLA format
Cite sources parenthetically (in text), using direct quotes or 
paraphrases (create paraphrases)
Connect ideas with transitional statements
Proof read and Edit

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Satire 6 days Students will define satire

We will practice this skill 
with a variety of sources: 
political cartoons, 5 short 
satirical articles, the short 
story "Game," an essay, 
and a Twilight Zone 
episode.

On my second roundof updating I'll look for 
studysync options for satire examples.

Students will identifty the tools of the satirist
Students will practice finding the target of a satire by finding and 
examining the tools (irony and exaggeration)

Students will show mastery of finding the Target of a Satire by 
reading a satirical story on their own and writing a paragraph to 
identify the target, giving examples of exaggeration and/or irony 
that support that idea. 

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

The Catcher in the Rye/ The Anti 
Hero 10 days

Students will review/define and give examples of elements of 
literature, focusing on setting, point of view, conflict, 
characterization, symbolism, and theme Studysync reading checks     

Inference 
activities (1st 
person 
narrative)

students will identify the hallmarks of the Anti-Hero, and compare/ 
contrast with the archetypal hero

on the 
summative 
assessment 
students will be 
asked to defend 
or refute a 
quote about the 
text

students will find evidence (details and examples) to support an 
idea or identify a pattern
students will use use inference skills to draw conclusions
students will generate possible meanings for symbols and defend 
their ideas from the text
students will use symbols and their likely meanings to arrive at 
possible themes 

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Lit Analysis 1 day/ done in class Students will follow a prompt

This is a cumulative 
assessment done near 
the end of the semester. I 
pick a story to work with.  
They aren't supposed to 
have pre read it. 

This is a cumulative assesment that draws 
from skills taught in studysync and other 
sources.

Writing an 
analysis essay

students will write an essay that demonstrates an understanding of 
the use of an element of literature in a story.
         --write a thesis that reflects the prompt
         --find examples/ details from the story to support the thesis
         --follow rules of standard grammar with attention to word 
choice, syntax, and transitions



English 11 Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Macbeth/ Tragic Hero 15 days Read Literature for Understanding Shakespeare's Macbeth

Studysync novel unit: vocab/ guide 
questions/ blasts.  Also organizers for 
characterization, repeating images, and 
the structure of a tragedy.  Director's 
notebook work to examine scenes/ quotes/ 
comparisons.

Quizzes and a 
final test, 
objective and 
esssay

   a) recognize and identify elements of literature used in the text

   b) examine the literature carefully to find essential details and 
examples that support a given subject, idea or theme (Analyze)

   c) use details and examples in literature to identify a recurring 
subject, idea or theme (Synthesize)

Explain/Chart the structure of a tragedy, and compare the Tragic 
Hero to the Hero Archetype

Lead and Participate in small and large group discussions

Recognize key differences between a script and a novel
Examine a soliloquy to find evidence of character
Identify and gather repeated images (darkness, blood, animals, and 
clothing) to lead to possible themes.
Compare the accepted hierarchy of the Elizabethan era to ideas 
presented in the play.
Explain the meaning and significance of selected quotes from the 
play. 
Compare and contrast Lady Macbeth and Lacy Macduff
Watch each act performed for plot and clarity
Watch selected scenes from different performances, and make 
comparisons among them.  What is the effect? How might it change the 
ideas in the script? etc.

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

ACT Prep
2 days.  Done toward the end of Sem I and 
shortly before the ACT test in Sem 2.

Prep for the ACT style essay, and in the spring we do review for 
each section.  I generally cover the Reading section. N/A

Will suppliment with studysync prep 
sources. Have past prompts from ACT 
tests, and practice tests.

No in-class 
assessment.  
Students take 
the ACT test.
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Central Ideas and Details

LA.12.RP.1

Evaluate the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Evaluate stated or implied 
theme developement implied, stated, theme MASTER

LA.12.RP.2

Analyze the development and 
interaction of literary elements such as 
characterization, setting, and plot, and 
how they contribute to the meaning of 
the work as a whole.

Analyze literary elements 
(development and 

interaction)
characterization, setting, 

plot

NEW/DEEPEN: using an 
element of literature as a 

lens for analysis

Author's Craft

LA.12.RP.3

Evaluate an author’s use of point of 
view and how it contributes to the 
meaning, significance, or aesthetic of a 
literary text.

Evaluate how point of view 
affects the text point of view, aesthetic REINFORCE/APPLY

LA.12.RP.4

Evaluate how an author develops 
structure in a literary text to contribute 
to its overall meaning and aesthetic 
impact.

Evaluate how structure 
affects the overall text text structure REINFORCE

Knowledge and Ideas

LA.12.RP.5

Apply knowledge of eighteenth-, 
nineteenth- and early-twentieth-century 
foundational works of literature, 
including how two or more texts from 
the same period treat similar themes or 
topics.

Make comparisons 
between texts across time 

periods for theme 
development 

theme development, 
compare and contrast REINFORCE
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LA.12.RP.6

Evaluate themes within and across 
literary texts to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Use identified themes to 
draw conclusions and 

generate questions
theme development, 
conclusions, inquiry REINFORCE

LA.12.RP.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of literary texts.

Analyze (compare) a 
variety of perspectives 
across various literary 

texts 
analysis, perspective, 

literary text REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RP.8

Read and comprehend a wide range 
of literary texts in the 12-CCR grade 
band independently and proficiently.

Read a range of grade-
level literary texts 

independently 
grade-level, 

independent, proficient REINFORCE
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Central Ideas and Details

LA.12.RI.1

Evaluate the development of central 
ideas over the course of an 
informational text or texts.

Find central ideas in 
informational texts

central ideas, 
informational texts REINFORCE

LA.12.RI.2

Synthesize and evaluate how the 
interaction of individuals, important 
events, and key ideas contribute to the 
meaning of the work as a whole.

Recognize that all aspects 
of a text work together to 

create meaning
synthesis, contribute to 

the whole REINFORCE

Author's Craft

LA.12.RI.3

Citing relevant and thorough evidence 
to support ideas, evaluate the 
development and interaction of 
individuals, ideas, and events in grade-
level informational text.

Cite evidence to support 
ideas and track 

developement of key ideas 
cite, evidence, 
development REINFORCE
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LA.12.RI.4

Evaluate an author’s perspective or 
purpose and how it contributes to the 
meaning, significance, or aesthetic of 
an informational text.

Understand author's 
purpose author's purpose REINFORCE

Knowledge and Ideas

LA.12.RI.5

Analyze seventeenth-, eighteenth-, and 
nineteenth-century works of historical 
and literary significance for their central 
ideas, purposes, and rhetorical style.

Understand and recognize 
purposes and different 
rhetorical styles of texts 

from various time periods. rhetorical styles REINFORCE

LA.12.RI.6

Compare and contrast the 
development of multiple arguments in 
texts of related topics, evaluating the 
effectiveness and validity of the claims.

Compare arguements for 
validity and effectiveness Validity REINFORCE

LA.12.RI.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of informational texts.

Analyze (compare) a 
variety of perspectives 
across various 
informational texts perspective REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RI.8

Read and comprehend a wide range 
of informational texts in the 12-CCR 
grade band independently and 
proficiently.

Read a range of grade-
level informational texts 
independently

idependent, proficient, 
grade-level REINFORCE
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Acquisition and Use

LA.12.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Use approprirate grade-
level vocabulary vocabulary REINFORCE
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LA.12.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Use approprirate grade-
level vocabulary context-clues REINFORCE

LA.12.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
conceive, conception, conceivable).

Use approprirate grade-
level vocabulary forms of words REINFORCE

LA.12.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, 
etymology, or standard usage of words.

Use approprirate grade-
level vocabulary

refererence materials, 
etymology, precise 

meanings REINFORCE

Context and Connotations

LA.12.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.a

a. Interpret figures of speech (e.g., 
hyperbole, paradox) in context and 
analyze their role in text.

Understand how authors 
use language: figurative, 
connotative, and technical figurative language REINFORCE

LA.12.V.2.b

b. Analyze nuances in the meanings of 
words with similar denotations.

Understand how authors 
use language: figurative, 
connotative, and technical nuances, denotation REINFORCE
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Production of Writing

LA.12.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and to add variety, interest, 
and fluency to written and spoken 
language.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.a

a. Demonstrate understanding that 
usage is a matter of convention, can 
evolve, and is sometimes contested.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! usage questions REINFORCE

LA.12.W.1.b

b. Apply knowledge of function and 
usage to revise personal and peer 
writing while resolving issues of complex 
or contested usage, consulting 
appropriate and reliable reference 
materials.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! REINFORCE

LA.12.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE
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Introduce/Reinforce/

Master

LA.12.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

Modes of Writing
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Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.12.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and discipline.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to set mood and tone.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE
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Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.12.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE
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Introduce/Reinforce/

Master

LA.12.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.b

b. Develop the topic thoroughly with 
relevant, sufficient facts, extended 
definitions, concrete details, quotations, 
and/or other information and examples.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE
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LA.12.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.6

Gather and use credible evidence from 
multiple authoritative sources, evaluate 
the strengths and limitations of sources 
in terms of the task, purpose, and 
audience, and assess their relevance in 
answering the research question(s).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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Master

LA.12.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g., MLA, APA, Chicago).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE
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LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

Presentation of Knowledge and Ideas

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.b
b. Convey a perspective with clear 
reasoning and valid evidence.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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Honors English Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment
The first 5-6 weeks of Honors 
English are writing focused, with 
AP-style lessons, F.451/ Synthesis 
work, and the Research Paper.

Advanced Comp 10 days

Students will read, recognize, and 
model the composition skills of 
Analysis, Argument, and Synthesis.

Students will read, recognize, 
and model the composition skills 
of Analysis, Argument, and 
Synthesis.

AP Skills book and Connections 
Book. I will look to supplement these 
current choices with articles in 
Studysync. Several of the essays are scored. 

students will learn argument stategies 
and common logical fallacies

students will learn argument 
stategies and common logical 
fallacies

Students will read examples and write 
to model/ practice the following skills:

Students will read examples and 
write to model/ practice the 
following skills:

--Rosa Parks essay: diction, tone, 
argument

--Rosa Parks essay: diction, 
tone, argument

--Frederick Douglas Narrative: 
paraphrase, author's purpose, the 
thesis, argument

--Frederick Douglas Narrative: 
paraphrase, author's purpose, 
the thesis, argument

--Weisel's "Perils of Indifference": 
rhetorical questions, syntax, argument

--Weisel's "Perils of Indifference": 
rhetorical questions, syntax, 
argument

--Connections #3 "Cold Mountain" and 
"Journal" excerpts: theme, 
comparisons, synthesis

--Connections #3 "Cold 
Mountain" and "Journal" 
excerpts: theme, comparisons, 
synthesis

--Diadem and Salgo articles: 
connotations, argument

--Diadem and Salgo articles: 
connotations, argument

--Gorman article: diction, connotation
--Gorman article: diction, 
connotation

--King's "I Have a Dream" speech: 
rhetorical devices and their effect, 
following an image, Analysis

--King's "I Have a Dream" 
speech: rhetorical devices and 
their effect, following an image, 
Analysis

--Hurston essay: tone, analysis --Hurston essay: tone, analysis
Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Fahrenheit 451 9-10 days
Writing continues with this novel--focus 
on synthesis Fahrenheit 451--Bradbury

DBQ resource, with several 
handouts, and synthesis essays to 
choose from. Studysync has this as 
an exceprt, but there is an intro 
video, and some focus questions 
and writing prompts that could used.  

Synthesis essay will be scored, 
and the final assesssment is 
open-book essay questions.

Students will draw conclusions by 
examing cover art
Students will practice close reading, 
pulling out and sharing a short 
passage
Synthesis: students will write dense 
questions, answer their own and 
others, and then synthesize the best of 
what's on their question sheet and 
share it on a google doc.



Honors English Planning

Synthesis: students will prep the DBQ 
docs, have a class discussion, and 
then write a Synthesis essay, following 
the prompt given.
Students will use analysis skills to 
explain the purpose of different 
machines in Bradbury's satire.
Students will analyze the poem recited 
in F.451, "Dover Beach," and use that 
information to explain why Mrs. P cries 
in this scene.
Students will use analysis skills to give 
possible meanings for several symbols 
in the story.
Students will use analysis skills to 
relate the poem The Tyger to the text.
Synthesis: students will prep the DBQ 
docs, have a class discussion, and 
then write a Synthesis essay, following 
the prompt given.

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment
Research Paper 8 days The student will access the databases

search databases to find and narrow a 
topic 

take a stance on a topic/ create a 
thesis N/A

Student models and some reference 
materials.

Honors English writes a 4-5 page 
paper, double spaced. Page 
count does not include the works 
cited page. There are also 
progress grade checks on source 
count/ notes made/ outline

read on a topic and refine arguments 
to defend a stance
take notes on slides or cards to show 
which information is being used
Create a works cited page in MLA 
format
Cite sources parenthetically (in text), 
using direct quotes or paraphrases 
(create paraphrases)
Connect ideas with transitional 
statements
Proof read and Edit

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Hero Archtype 5-6 days

Students will be able to explain the 
difference between Sign, Symbol and 
Archetype

Choose from classic hero 
stories: Theseus, Odysseus, 
Perseus

I haven't found much yet focused on 
the classic hero in studysync.  I'll 
keep checking, and can probably 
incorporate Blasts.   

Honors English reads two classic 
hero stories more independently 
than English 11, applies the traits 
to the story, and compares and 
evaluates the applications. Their 
essay will be evaluated.  

Students will understand the classic 
hero role and recognize it as one of 
many archetypes.
Students will understand Campbell's 
Monomyth and apply it to several hero 
stories.



Honors English Planning

Students will understand Stillman's 
Hero Traits and apply them to various 
hero stories.
Students will write an essay to show 
mastery of applying the Hero Traits to 
a hero story.  Honors students will both 
apply the hero traits and make a 
comparison between two hero stories. 
Students will lead and participate in 
small and large groups discussions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Someday This Pain Will Be Useful 
to You/ Anti Hero 10 days (? new unit). 

Students will review/define and give 
examples of elements of literature, 
focusing on setting, point of view, 
conflict, characterization, symbolism, 
and theme

Someday This Pain Will Be 
Useful To You--P.Cameron and 
excerpts from The Catcher in the 
Rye--J.D. Salinger

This novel isn't part of Studysync, 
but any I can use any sources they 
have that discuss the anti-hero

on the summative assessment 
students will be asked to write a 
well developed essay to do with 
James's characterization, and 
pull support from the text and/or 
to make comparisons between 
the anti-heros in these two 
stories.  

students will identify the hallmarks of 
the Anti-Hero, and compare/ contrast 
with the archetypal hero
students will find evidence (details and 
examples) to support an idea or 
identify a pattern
students will use use inference skills to 
draw conclusions
students will generate possible 
meanings for symbols and defend their 
ideas from the text
students will use symbols and their 
likely meanings to arrive at possible 
themes 

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Satire 12 days students will define satire
Brave New World--Huxley. 
1984--Orwell

Possible Assesments: read a 
satirical poem and ID the target. 
Support that conclusions with 
examples of irony and 
exaggeration

studens will identity and recognize the 
tools of the satirist

Write an essay response that 
relates a quote by the author to 
concepts found in the story

students will use those tools 
(exaggeration and irony) to identify the 
target of a satire
students will define and recognize 
allusions
students will give examples of the 
setting doing the job of creating 
atmosphere
Students will find and explain 
examples of characterization
Students will use characterization to 
evaluate the dystopian society 
depicted



Honors English Planning

Students will use scenes and 
characterization to identify the 
competing philosophies presented in 
the story.
students will recognize and explain 
examples of irony in BNW
Students will analyze scenes to reveal 
the author's point of view/ purpose of 
the satire

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Multi Cultural Short Stories/ 
Essays/Poems 6 days

Family Matters--xx, Walk on By--
B. Staples, All-American Slurp--
Namioka, The Struggle to Be an 
American Girl--xx, For the White 
Poets Who Would be Indian--xx, 
White Lies--Trelawny, By Any 
Other Name--Rama Rau, Me 
Talk Pretty One Day--Sedaris, 
Persona Errata--Tan

Short essays that show 
understanding of characterization 
or an idea expressed in the 
reading.

 Students will read literature for 
understanding
         examine another culture's 
attitudes and ideas
         recognize and identify elements 
of literature used in the text.  Focus on 
conflict, characterization, irony, 
symbolism
         find essential details and 
examples that support a given subject, 
idea or theme  (Analyze)
         use details and examples in 
literature to identify a recurring subject, 
idea or theme (Synthesize)

Students will make comparisons 
between texts
Students will use diction to reveal a 
speaker's attitude
Students will lead and participate in 
small and large groups discussions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Literature Analysis 1 1/2 days.  Written in class Story not read together N/A

Students are given a new story 
and a prompt that focuses on one 
element of literature. They find 
examples from the story that 
show how that elelment is used 
or developed, and write an essay.

 Students will read literature for 
understanding
         examine another culture's 
attitudes and ideas
         recognize and identify elements 
of literature used in the text.  Focus on 
conflict, characterization, irony, 
symbolism



Honors English Planning

         find essential details and 
examples that support a given subject, 
idea or theme  (Analyze)
         use details and examples in 
literature to identify a recurring subject, 
idea or theme (Synthesize)

Students will make comparisons 
between texts
Students will use diction to reveal a 
speaker's attitude
Students will lead and participate in 
small and large groups discussions

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Macbeth 15 days Read Literature for Understanding Shakespeare's Macbeth

not this first semester, but I will be 
using the guide questions/ 
vocabulary once I have a chance to 
prepare it

Quizzes and a final test, objective 
and esssay

   a) recognize and identify elements of 
literature used in the text

   b) examine the literature carefully to 
find essential details and examples that 
support a given subject, idea or theme 
(Analyze)

   c) use details and examples in literature 
to identify a recurring subject, idea or 
theme (Synthesize)

Explain/Chart the structure of a 
tragedy, and compare the Tragic Hero to 
the Hero Archetype

Lead and Participate in small and large 
group discussions

Recognize key differences between a 
script and a novel
Examine a soliloquy to find evidence of 
character
Identify and gather repeated images 
(darkness, blood, animals, and clothing) to 
lead to possible themes.
Compare the accepted hierarchy of the 
Elizabethan era to ideas presented in 
the play.
Explain the meaning and significance 
of selected quotes from the play. 
Compare and contrast Lady Macbeth 
and Lady Macduff
Watch each act performed for plot and 
clarity
Watch selected scenes from different 
performances, and make comparisons 
among them.  What is the effect? How might 
it change the ideas in the script? etc.
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Central Ideas and Details

LA.12.RP.1

Evaluate the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Unit 2 > Integrated Reading and Writing > The Postmaster > Skill: Theme > Model Unit 2 > Integrated 
Reading and Writing > The Postmaster > Skill: Theme > Your Turn Unit 2 > Integrated Reading and 
Writing > The Postmaster > Close Read: The Postmaster > Write Unit 6 > Integrated Reading and Writing 
> A Temporary Matter > Skill: Theme > Model Unit 6 > Integrated Reading and Writing > A Temporary 
Matter > Skill: Theme > Your Turn Unit 6 > Integrated Reading and Writing > A Temporary Matter > 
Close Read: A Temporary Matter > Read > Skills Focus

Evalutate stated or implied 
theme developement implied, stated, theme MASTER

LA.12.RP.2

Analyze the development and 
interaction of literary elements such as 
characterization, setting, and plot, and 
how they contribute to the meaning of 
the work as a whole.

Unit 2 > Integrated Reading and Writing > The Postmaster > Skill: Story Elements > Model Unit 2 > 
Integrated Reading and Writing > The Postmaster > Close Read: The Postmaster > Write Unit 2 > 
Integrated Reading and Writing > The Postmaster > Skill: Story Elements > Your Turn Unit 6 > Integrated 
Reading and Writing > Ghosts > Skill: Story Elements > Model Unit 6 > Integrated Reading and Writing > 
Ghosts > Close Read: Ghosts > Write Unit 6 > Integrated Reading and Writing > Ghosts > Skill: Story 
Elements > Your Turn Unit 2 > Integrated Reading and Writing > Hamlet > Skill: Dramatic Elements and 
Structure > Model Unit 2 > Integrated Reading and Writing > Hamlet > Close Read: Hamlet > Write Unit 
2 > Integrated Reading and Writing > Hamlet > Skill: Dramatic Elements and Structure > Your Turn Unit 
5 > Integrated Reading and Writing > The Glass Menagerie > Skill: Dramatic Elements and Structure > 
Model Unit 5 > Integrated Reading and Writing > The Glass Menagerie > Close Read: The Glass 
Menagerie > Write Unit 5 > Integrated Reading and Writing > The Glass Menagerie > Skill: Dramatic 
Elements and Structure > Your Turn

Analyze literary elements 
(development and 

interaction)
characterization, setting, 

plot

NEW/DEEPEN: using an 
element of literature as a 

lens for analysis

Author's Craft

LA.12.RP.3

Evaluate an author’s use of point of 
view and how it contributes to the 
meaning, significance, or aesthetic of a 
literary text.

Unit 3 > Integrated Reading and Writing > Gulliver’s Travels > Skill: Point of View > Model Unit 3 > 
Integrated Reading and Writing > Gulliver’s Travels > Close Read: Gulliver’s Travels > Read > Skills 
Focus Unit 3 > Integrated Reading and Writing > Gulliver’s Travels > Close Read: Gulliver’s Travels > 
Write Unit 3 > Integrated Reading and Writing > Gulliver’s Travels > Skill: Point of View > Your Turn 
Unit 2 > Integrated Reading and Writing > The Pardoner’s Prologue > Skill: Point of View > Model Unit 2 
> Integrated Reading and Writing > The Pardoner’s Prologue > Close Read: The Pardoner’s Prologue > 
Read > Skills Focus Unit 2 > Integrated Reading and Writing > The Pardoner’s Prologue > Close Read: 
The Pardoner’s Prologue > Write Unit 2 > Integrated Reading and Writing > The Pardoner’s Prologue > 
Skill: Point of View > Your Turn

Evalutate how point of 
view affects the text point of view, aesthetic REINFORCE/APPLY

LA.12.RP.4

Evaluate how an author develops 
structure in a literary text to contribute 
to its overall meaning and aesthetic 
impact.

Unit 6 > Integrated Reading and Writing > The Mysterious Anxiety of Them and Us > Skill: Story 
Structure > Model Unit 6 > Integrated Reading and Writing > The Mysterious Anxiety of Them and Us > 
Close Read: The Mysterious Anxiety of Them and Us > Read > Skills Focus Unit 6 > Integrated Reading 
and Writing > The Mysterious Anxiety of Them and Us > Close Read: The Mysterious Anxiety of Them 
and Us > Write Unit 6 > Integrated Reading and Writing > The Mysterious Anxiety of Them and Us > 
Skill: Story Structure > Your Turn Unit 5 > Integrated Reading and Writing > The Love Song of J. Alfred 
Prufrock > Skill: Poetic Elements and Structure > Model Unit 5 > Integrated Reading and Writing > The 
Love Song of J. Alfred Prufrock > Skill: Poetic Elements and Structure > Your Turn Unit 1 > Integrated 
Reading and Writing > The Metamorphosis > Skill: Story Structure > Model Unit 1 > Integrated Reading 
and Writing > The Metamorphosis > Close Read: The Metamorphosis > Write Unit 1 > Integrated Reading 
and Writing > The Metamorphosis > Skill: Story Structure > Your Turn Unit 5 > Integrated Reading and 
Writing > The Glass Menagerie > Skill: Dramatic Elements and Structure > Model Unit 5 > Integrated 
Reading and Writing > The Glass Menagerie > Skill: Dramatic Elements and Structure > Your Turn

Evluate how structure 
affects the overall text text structure REINFORCE

Knowledge and Ideas
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LA.12.RP.5

Apply knowledge of eighteenth-, 
nineteenth- and early-twentieth-century 
foundational works of literature, 
including how two or more texts from 
the same period treat similar themes or 
topics.

Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > Skill: Compare and 
Contrast > Model Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > 
Close Read: To His Excellency, General Washington > Read > Skills Focus Unit 3 > Integrated Reading 
and Writing > To His Excellency, General Washington > Close Read: To His Excellency, General 
Washington > Write Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > 
Skill: Compare and Contrast > Your Turn Unit 5 > Integrated Reading and Writing > The Love Song of J. 
Alfred Prufrock > Skill: Compare and Contrast > Model Unit 5 > Integrated Reading and Writing > The 
Love Song of J. Alfred Prufrock > Close Read: The Love Song of J. Alfred Prufrock > Read > Skills Focus 
Unit 5 > Integrated Reading and Writing > The Love Song of J. Alfred Prufrock > Skill: Compare and 
Contrast > Your Turn Unit 5 > Integrated Reading and Writing > The Love Song of J. Alfred Prufrock > 
Close Read: The Love Song of J. Alfred Prufrock > Write

Make comparisons 
between texts across time 

periods for theme 
development 

theme development, 
compare and contrast REINFORCE

LA.12.RP.6

Evaluate themes within and across 
literary texts to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Unit 2 > Integrated Reading and Writing > The Postmaster > Skill: Theme > Model Unit 2 > Integrated 
Reading and Writing > The Postmaster > Skill: Theme > Your Turn Unit 2 > Integrated Reading and 
Writing > The Postmaster > Close Read: The Postmaster > Write Unit 3 > Integrated Reading and Writing 
> To His Excellency, General Washington > Skill: Compare and Contrast > Model Unit 3 > Integrated 
Reading and Writing > To His Excellency, General Washington > Skill: Compare and Contrast > Your 
Turn Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > Close Read: To 
His Excellency, General Washington > Read > Skills Focus Unit 3 > Integrated Reading and Writing > To 
His Excellency, General Washington > Close Read: To His Excellency, General Washington > Write Unit 
4 > Integrated Reading and Writing > Ode on a Grecian Urn > Close Read: Ode on a Grecian Urn > Write 
Unit 5 > Integrated Reading and Writing > A Cup of Tea > Close Read: A Cup of Tea > Write

Use identified themes to 
draw conclusions and 

generate questions
theme development, 
conclusions, inquiry REINFORCE

LA.12.RP.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of literary texts.

Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > Skill: Compare and 
Contrast > Model Unit 3 > Integrated Reading and Writing > To His Excellency, General Washington > 
Skill: Compare and Contrast > Your Turn Unit 3 > Integrated Reading and Writing > To His Excellency, 
General Washington > Close Read: To His Excellency, General Washington > Read > Skills Focus Unit 3 
> Integrated Reading and Writing > To His Excellency, General Washington > Close Read: To His 
Excellency, General Washington > Write Unit 4 > Integrated Reading and Writing > Ode on a Grecian Urn 
> Close Read: Ode on a Grecian Urn > Write Unit 5 > Integrated Reading and Writing > A Cup of Tea > 
Close Read: A Cup of Tea > Write

Analyze (compare) a 
variety of perspectives 
across various literary 

texts 
analysis, perspective, 

literary text REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RP.8

Read and comprehend a wide range 
of literary texts in the 12-CCR grade 
band independently and proficiently.

Grade 12 ELA Overview > Text Complexity > Page 3-96 Unit 1 > Integrated Reading and Writing > The 
Metamorphosis > First Read: The Metamorphosis > Read Unit 2 > Integrated Reading and Writing > 
Hamlet > First Read: Hamlet > Read Unit 6 > Integrated Reading and Writing > A Temporary Matter > 
First Read: A Temporary Matter > Read Unit 5 > Integrated Reading and Writing > The Big Idea > Skill: 
Recognizing Genre > Model Unit 3 > Integrated Reading and Writing > Blast: Self-Selected

Read a range of grade-
level literary texts 

independently 
grade-level, 

independent, proficient REINFORCE
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Central Ideas and Details

LA.12.RI.1

Evaluate the development of central 
ideas over the course of an 
informational text or texts.

Unit 1 > Integrated Reading and Writing > Overcoming Impostor Syndrome > Skill: Central or Main Idea 
> Model Unit 1 > Integrated Reading and Writing > Overcoming Impostor Syndrome > Skill: Central or 
Main Idea > Your Turn Unit 1 > Integrated Reading and Writing > Overcoming Impostor Syndrome > 
Close Read: Overcoming Impostor Syndrome > Read > Skills Focus Unit 2 > Integrated Reading and 
Writing > Shakespeare: The World As Stage > Skill: Central or Main Idea > Model Unit 2 > Integrated 
Reading and Writing > Shakespeare: The World As Stage > Skill: Central or Main Idea > Your Turn Unit 
2 > Integrated Reading and Writing > Shakespeare: The World As Stage > Close Read: Shakespeare: The 
World As Stage > Read > Skills Focus Unit 2 > Integrated Reading and Writing > Shakespeare: The World 
As Stage > Close Read: Shakespeare: The World As Stage > Write Unit 5 > Integrated Reading and 
Writing > Be Ye Men of Valour > Skill: Central or Main Idea > Model Unit 5 > Integrated Reading and 
Writing > Be Ye Men of Valour > Skill: Central or Main Idea > Your Turn Unit 5 > Integrated Reading 
and Writing > Be Ye Men of Valour > Close Read: Be Ye Men of Valour > Write

Find central ideas in 
informational texts

central ideas, 
informational texts REINFORCE
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LA.12.RI.2

Synthesize and evaluate how the 
interaction of individuals, important 
events, and key ideas contribute to the 
meaning of the work as a whole.

Unit 6 > Integrated Reading and Writing > Honesty on Social Media > Skill: Informational Text Elements 
> Model Unit 6 > Integrated Reading and Writing > Honesty on Social Media > Close Read: Honesty on 
Social Media > Read > Skills Focus Unit 6 > Integrated Reading and Writing > Honesty on Social Media > 
Close Read: Honesty on Social Media > Write Unit 6 > Integrated Reading and Writing > Honesty on 
Social Media > Skill: Informational Text Elements > Your Turn Unit 1 > Integrated Reading and Writing > 
SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: Informational Text Elements > 
Model Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the 
New Novels? > Close Read: Are the New "Golden Age" TV Shows the New Novels? > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the 
New Novels? > Close Read: Are the New "Golden Age" TV Shows the New Novels? > Write Unit 1 > 
Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New Novels? > 
Skill: Informational Text Elements > Your Turn

Recognize that all aspects 
of a text work together to 

create meaning
synthesis, contribute to 

the whole REINFORCE

Author's Craft

LA.12.RI.3

Citing relevant and thorough evidence 
to support ideas, evaluate the 
development and interaction of 
individuals, ideas, and events in grade-
level informational text.

Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > Skill: Author's Purpose and 
Point of View > Model Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > Close 
Read: We Choose to Go to the Moon > Read > Skills Focus Unit 1 > Integrated Reading and Writing > We 
Choose to Go to the Moon > Skill: Author's Purpose and Point of View > Your Turn Unit 1 > Integrated 
Reading and Writing > We Choose to Go to the Moon > Close Read: We Choose to Go to the Moon > 
Write Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > Skill: Rhetoric > Model 
Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > Skill: Rhetoric > Your Turn 
Unit 4 > Integrated Reading and Writing > Why I Write > Skill: Author’s Purpose and Point of View > 
Model Unit 4 > Integrated Reading and Writing > Why I Write > Close Read: Why I Write > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > Plessy v. Ferguson > Skill: Rhetoric > Model Unit 1 > 
Integrated Reading and Writing > Plessy v. Ferguson > Skill: Rhetoric > Your Turn Unit 1 > Integrated 
Reading and Writing > Plessy v. Ferguson > Close Read: Plessy v. Ferguson > Read > Skills Focus Unit 1 
> Integrated Reading and Writing > Plessy v. Ferguson > Close Read: Plessy v. Ferguson > Write

Cite evidence to support 
ideas and track 

developement of key ideas 
cite, evidence, 
development REINFORCE

LA.12.RI.4

Evaluate an author’s perspective or 
purpose and how it contributes to the 
meaning, significance, or aesthetic of 
an informational text.

Unit 1 > Integrated Reading and Writing > Overcoming Impostor Syndrome > Skill: Informational Text 
Structure > Model Unit 1 > Integrated Reading and Writing > Overcoming Impostor Syndrome > Close 
Read: Overcoming Impostor Syndrome > Read > Skills Focus Unit 1 > Integrated Reading and Writing > 
Overcoming Impostor Syndrome > Close Read: Overcoming Impostor Syndrome > Write Unit 1 > 
Integrated Reading and Writing > Overcoming Impostor Syndrome > Skill: Informational Text Structure > 
Your Turn Unit 3 > Integrated Reading and Writing > Leadership During a Crisis > Skill: Informational 
Text Structure > Model Unit 3 > Integrated Reading and Writing > Leadership During a Crisis > Close 
Read: Leadership During a Crisis > Read > Skills Focus Unit 3 > Integrated Reading and Writing > 
Leadership During a Crisis > Close Read: Leadership During a Crisis > Write Unit 3 > Integrated Reading 
and Writing > Leadership During a Crisis > Skill: Informational Text Structure > Your Turn

Understand author's 
purpose author's purpose REINFORCE

Knowledge and Ideas

LA.12.RI.5

Analyze seventeenth-, eighteenth-, and 
nineteenth-century works of historical 
and literary significance for their central 
ideas, purposes, and rhetorical style.

Unit 3 > Integrated Reading and Writing > The Federalist Papers: No. 10 > Skill: Primary and Secondary 
Sources > Model Unit 3 > Integrated Reading and Writing > The Federalist Papers: No. 10 > Close Read: 
The Federalist Papers: No. 10 > Read > Skills Focus Unit 3 > Integrated Reading and Writing > The 
Federalist Papers: No. 10 > Close Read: The Federalist Papers: No. 10 > Write Unit 3 > Integrated Reading 
and Writing > The Federalist Papers: No. 10 > Skill: Primary and Secondary Sources > Your Turn Unit 3 > 
Integrated Reading and Writing > United States v. The Amistad > Skill: Primary and Secondary Sources > 
Model Unit 3 > Integrated Reading and Writing > United States v. The Amistad > Close Read: United 
States v. The Amistad > Read > Skills Focus Unit 3 > Integrated Reading and Writing > United States v. 
The Amistad > Close Read: United States v. The Amistad > Write Unit 3 > Integrated Reading and Writing 
> United States v. The Amistad > Skill: Primary and Secondary Sources > Your Turn

Understand and recognize 
purposes and different 
rhetorical styles of texts 

from various time periods. rhetorical styles REINFORCE
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LA.12.RI.6

Compare and contrast the 
development of multiple arguments in 
texts of related topics, evaluating the 
effectiveness and validity of the claims.

Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Close Read: Are the New “Golden Age” TV Shows the New Novels? > Read > Skills Focus 
Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Close Read: Are the New “Golden Age” TV Shows the New Novels? > Write Unit 1 > 
Integrated Reading and Writing > Plessy v. Ferguson > Skill: Rhetoric > Model Unit 1 > Integrated 
Reading and Writing > Plessy v. Ferguson > Skill: Rhetoric > Your Turn Unit 1 > Integrated Reading and 
Writing > Plessy v. Ferguson > Close Read: Plessy v. Ferguson > Read > Skills Focus Unit 1 > Integrated 
Reading and Writing > Plessy v. Ferguson > Close Read: Plessy v. Ferguson > Write Unit 6 > Integrated 
Reading and Writing > Honesty on Social Media > Close Read: Honesty on Social Media > Read > Skills 
Focus Unit 6 > Integrated Reading and Writing > Honesty on Social Media > Close Read: Honesty on 
Social Media > Write

Compare arguements for 
validity and effectiveness Validity REINFORCE

LA.12.RI.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of informational texts.

Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Skill: Informational Text Elements > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: Informational Text Elements > 
Your Turn Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows 
the New Novels? > Close Read: Are the New "Golden Age" TV Shows the New Novels? > Read > Skills 
Focus Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the 
New Novels? > Close Read: Are the New "Golden Age" TV Shows the New Novels? > Write Unit 2 > 
Integrated Reading and Writing > Shakespeare: The World As Stage > Skill: Informational Text Elements 
> Model Unit 2 > Integrated Reading and Writing > Shakespeare: The World As Stage > Skill: 
Informational Text Elements > Your Turn Unit 2 > Integrated Reading and Writing > Shakespeare: The 
World As Stage > Close Read: Shakespeare: The World As Stage > Read > Skills Focus Unit 2 > 
Integrated Reading and Writing > Shakespeare: The World As Stage > Close Read: Shakespeare: The 
World As Stage > Write Unit 3 > Integrated Reading and Writing > Leadership During a Crisis > Skill: 
Informational Text Structure > Model Unit 3 > Integrated Reading and Writing > Leadership During a 
Crisis > Skill: Informational Text Structure > Your Turn Unit 3 > Integrated Reading and Writing > 
Leadership During a Crisis > Close Read: Leadership During a Crisis > Read > Skills Focus Unit 3 > 
Integrated Reading and Writing > Leadership During a Crisis > Close Read: Leadership During a Crisis > 
Write Unit 6 > Integrated Reading and Writing > Honesty on Social Media > Close Read: Honesty on 
Social Media > Write

Analyze (compare) a 
variety of perspectives 
across various 
informational texts perspective REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RI.8

Read and comprehend a wide range 
of informational texts in the 12-CCR 
grade band independently and 
proficiently.

Grade 12 ELA Overview > Text Complexity > Page 3-96 Unit 1 > Integrated Reading and Writing > 
Booster Staff Investigates > Independent Read: Booster Staff Investigates > Read Unit 3 > Integrated 
Reading and Writing > I Am Prepared to Die > Independent Read: I Am Prepared to Die > Read Unit 5 > 
Integrated Reading and Writing > Be Ye Men of Valour > First Read: Be Ye Men of Valour > Read Unit 4 
> Integrated Reading and Writing > The Big Idea > Skill: Recognizing Genre > Model Unit 5 > Integrated 
Reading and Writing > Blast: Self-Selected

Read a range of grade-
level informational texts 
independently

idependent, proficient, 
grade-level REINFORCE

V
o
c
a
b
u
l
a
r
y

Acquisition and Use

LA.12.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Unit 1 > Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Model Unit 1 > 
Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Your Turn Unit 4 > 
Integrated Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Model Unit 4 > Integrated 
Reading and Writing > The Big Idea > Skill: Academic Vocabulary > Your Turn Unit 5 > Integrated 
Reading and Writing > A Room of One’s Own > Independent Read: A Room of One’s Own > Write Unit 4 
> Integrated Reading and Writing > Dear Mama > Close Read: Dear Mama > Vocabulary Unit 5 > 
Integrated Reading and Writing > The Glass Menagerie > Close Read: The Glass Menagerie > Vocabulary

Use approprirate grade-
level vocabulary vocabulary REINFORCE
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V
o
c
a
b
u
l
a
r
y

LA.12.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Unit 6 > Integrated Reading and Writing > The Mysterious Anxiety of Them and Us > Skill: Context Clues 
> Model Unit 6 > Integrated Reading and Writing > The Mysterious Anxiety of Them and Us > Close 
Read: The Mysterious Anxiety of Them and Us > Read > Skills Focus Unit 6 > Integrated Reading and 
Writing > The Mysterious Anxiety of Them and Us > Skill: Context Clues > Your Turn Unit 1 > Integrated 
Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: 
Context Clues > Model Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” 
TV Shows the New Novels? > Skill: Context Clues > Your Turn Unit 4 > Integrated Reading and Writing 
> Lines Composed a Few Miles Above Tintern Abbey > Skill: Context Clues > Model Unit 4 > Integrated 
Reading and Writing > Lines Composed a Few Miles Above Tintern Abbey > Close Read: Lines 
Composed a Few Miles Above Tintern Abbey > Read > Skills Focus Unit 4 > Integrated Reading and 
Writing > Lines Composed a Few Miles Above Tintern Abbey > Close Read: Lines Composed a Few 
Miles Above Tintern Abbey > Write Unit 4 > Integrated Reading and Writing > Lines Composed a Few 
Miles Above Tintern Abbey > Skill: Context Clues > Your Turn

Use approprirate grade-
level vocabulary context-clues REINFORCE

LA.12.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
conceive, conception, conceivable).

Unit 5 > Integrated Reading and Writing > A Cup of Tea > Skill: Word Patterns and Relationships > 
Model Unit 5 > Integrated Reading and Writing > A Cup of Tea > Skill: Word Patterns and Relationships 
> Your Turn Unit 5 > Integrated Reading and Writing > A Cup of Tea > Close Read: A Cup of Tea > Read 
> Skills Focus Unit 2 > Integrated Reading and Writing > Beowulf (Lines 144-300 – Heaney Translation) 
> Skill: Word Patterns and Relationships > Model Unit 2 > Integrated Reading and Writing > Beowulf 
(Lines 144-300 – Heaney Translation) > Skill: Word Patterns and Relationships > Your Turn Unit 2 > 
Integrated Reading and Writing > Beowulf (Lines 144-300 – Heaney Translation) > Close Read: Beowulf 
(Lines 144-300 – Heaney Translation) > Read > Skills Focus

Use approprirate grade-
level vocabulary forms of words REINFORCE

LA.12.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, 
etymology, or standard usage of words.

Unit 3 > Integrated Reading and Writing > Gulliver’s Travels > Skill: Word Meaning > Model Unit 3 > 
Integrated Reading and Writing > Gulliver’s Travels > Skill: Word Meaning > Your Turn Unit 3 > 
Integrated Reading and Writing > Gulliver’s Travels > Close Read: Gulliver’s Travels > Read > Skills 
Focus Unit 5 > Integrated Reading and Writing > Be Ye Men of Valour > Skill: Word Meaning > Model

Use approprirate grade-
level vocabulary

refererence materials, 
etymology, precise 

meanings REINFORCE

Context and Connotations

LA.12.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Unit 1 > Integrated Reading and Writing > Plessy v. Ferguson > Skill: Technical Language > Model + 
Your Turn Unit 1 > Integrated Reading and Writing > Plessy v. Ferguson > Skill: Technical Language > 
Your Turn Unit 1 > Integrated Reading and Writing > Plessy v. Ferguson > Close Read: Plessy v. Ferguson 
> Read > Skills Focus Unit 3 > Integrated Reading and Writing > Leadership During a Crisis > Skill: 
Technical Language > Model

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.a

a. Interpret figures of speech (e.g., 
hyperbole, paradox) in context and 
analyze their role in text.

Unit 5 > Integrated Reading and Writing > Shooting an Elephant > Skill: Figurative Language > Model 
Unit 5 > Integrated Reading and Writing > Shooting an Elephant > Close Read: Shooting an Elephant > 
Read > Skills Focus Unit 5 > Integrated Reading and Writing > Shooting an Elephant > Close Read: 
Shooting an Elephant > Write Unit 5 > Integrated Reading and Writing > Shooting an Elephant > Skill: 
Figurative Language > Your Turn Unit 5 > Integrated Reading and Writing > Lines Composed a Few 
Miles Above Tintern Abbey > Skill: Figurative Language > Model Unit 5 > Integrated Reading and 
Writing > Lines Composed a Few Miles Above Tintern Abbey > Close Read: Lines Composed a Few 
Miles Above Tintern Abbey > Read > Skills Focus Unit 5 > Integrated Reading and Writing > Lines 
Composed a Few Miles Above Tintern Abbey > Close Read: Lines Composed a Few Miles Above Tintern 
Abbey > Write Unit 5 > Integrated Reading and Writing > Lines Composed a Few Miles Above Tintern 
Abbey > Skill: Figurative Language > Your Turn

Understand how authors 
use language: figurative, 
connotative, and technical figurative language REINFORCE

LA.12.V.2.b

b. Analyze nuances in the meanings of 
words with similar denotations.

Unit 1 > Integrated Reading and Writing > The Metamorphosis > Skill: Connotation and Denotation > 
Model Unit 1 > Integrated Reading and Writing > The Metamorphosis > Skill: Connotation and Denotation 
> Your Turn Unit 2 > Integrated Reading and Writing > Shakespeare: The World as Stage > Skill: 
Connotation and Denotation > Model Unit 2 > Integrated Reading and Writing > Shakespeare: The World 
as Stage > Skill: Connotation and Denotation > Your Turn

Understand how authors 
use language: figurative, 
connotative, and technical nuances, denotation REINFORCE
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Production of Writing

LA.12.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and to add variety, interest, 
and fluency to written and spoken 
language.

Unit 1 > Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise > Write 
Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit 
and Publish > Write Unit 2 > Extended Writing Project and Grammar > Revise > Narrative Writing 
Process: Revise > Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Narrative 
Writing Process: Edit and Publish > Write Unit 6 > Extended Oral Project and Grammar > Revise > Oral 
Presentation Process: Revise > Write Unit 6 > Extended Oral Project and Grammar > Edit and Publish > 
Oral Presentation Process: Edit and Publish > Write

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.a

a. Demonstrate understanding that 
usage is a matter of convention, can 
evolve, and is sometimes contested.

Library > Skills > Filter > Select: Grade 12 > Select: Grammar > Search: Capitalization > Capitalization - 
Other Proper Nouns Library > Skills > Filter > Select: Grade 12 > Select: Grammar > Search: 
Capitalization > Capitalization - Proper Adjectives Library > Skills > Filter > Select: Grade 12 > Select: 
Grammar > Search: Capitalization > Capitalization - Quotations Library > Skills > Filter > Select: Grade 
12 > Select: Grammar > Search: Capitalization > Capitalization - Sentences

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! usage questions Reinforce

LA.12.W.1.b

b. Apply knowledge of function and 
usage to revise personal and peer 
writing while resolving issues of complex 
or contested usage, consulting 
appropriate and reliable reference 
materials.

Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Semicolons, Colons, and 
Dashes > Model Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Semicolons, 
Colons, and Dashes > Your Turn Unit 3 > Extended Writing Project and Grammar > Edit and Publish > 
Argumentative Writing Process: Edit and Publish > Write Library > Skills > Filter > Select: Grade 12 > 
Select: Grammar > Search: Colons and Semicolons > Colons and Semicolons

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! usage questions Reinforce

LA.12.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Unit 1 > Extended Writing Project and Grammar > Plan > Informative Writing Process: Plan > Write Unit 
1 > Extended Writing Project and Grammar > Draft > Informative Writing Process: Draft > Write Unit 1 > 
Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise > Write Unit 1 > 
Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit and 
Publish > Write Unit 1 > Integrated Reading and Writing > SyncStart: Are the New ‘Golden Age’ TV 
Shows the New Novels? > Skill: Peer Review > Model

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Unit 3 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > Intro 
Unit 3 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > Read 
Unit 3 > Extended Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > Write 
Unit 3 > Extended Writing Project and Grammar > Draft > Argumentative Writing Process: Draft > Write 
Unit 1 > Extended Writing Project and Grammar > Plan > Informative Writing Process: Plan > Write Unit 
1 > Extended Writing Project and Grammar > Draft > Informative Writing Process: Draft > Write Unit 6 > 
Integrated Reading and Writing > Self-Selected Reading > Write: Self-Selected Response > Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Unit 1 > Integrated Reading and Writing > Timed Writing > Write: Timed Writing Unit 3 > Extended 
Writing Project and Grammar > Plan > Argumentative Writing Process: Plan > Write Unit 3 > Extended 
Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > Model Unit 3 > Extended 
Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > Your Turn Unit 3 > 
Extended Writing Project and Grammar > Draft > Argumentative Writing Process: Draft > Write Unit 3 > 
Extended Writing Project and Grammar > Revise > Argumentative Writing Process: Revise > Write Unit 3 
> Extended Writing Project and Grammar > Edit and Publish > Argumentative Writing Process: Edit and 
Publish > Write Unit 4 > Integrated Reading and Writing > Dear Mama > Close Read: Dear Mama > Write 
> Organizer (left blue tab) Unit 4 > Integrated Reading and Writing > Dear Mama > Close Read: Dear 
Mama > Write Teacher Edition > 4. Write - Peer Review and Reflect

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE
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LA.12.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Unit 1 > Extended Writing Project and Grammar > Revise > Informative Writing Process: Revise > Write 
Unit 2 > Extended Writing Project and Grammar > Revise > Narrative Writing Process: Revise > Write 
Unit 3 > Extended Writing Project and Grammar > Revise > Argumentative Writing Process: Revise > 
Write Unit 4 > Extended Writing Project and Grammar > Revise > Research Writing Process: Revise > 
Write Unit 5 > Extended Writing Project and Grammar > Revise > Literary Analysis Writing Process: 
Revise > Write Unit 6 > Extended Oral Project and Grammar > Revise > Oral Presentation Process: Revise 
> Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Informative Writing Process: Edit 
and Publish > Write Unit 2 > Extended Writing Project and Grammar > Edit and Publish > Narrative 
Writing Process: Edit and Publish > Write Unit 3 > Extended Writing Project and Grammar > Edit and 
Publish > Argumentative Writing Process: Edit and Publish > Write Unit 4 > Extended Writing Project and 
Grammar > Edit and Publish > Research Writing Process: Edit and Publish > Write Unit 5 > Extended 
Writing Project and Grammar > Edit and Publish > Literary Analysis Writing Process: Edit and Publish > 
Write Unit 6 > Extended Oral Project and Grammar > Edit and Publish > Oral Presentation Process: Edit 
and Publish > Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Unit 5 > Extended Writing Project and Grammar > Revise > Literary Analysis Writing Process: Revise > 
Write Unit 5 > Extended Writing Project and Grammar > Edit and Publish > Literary Analysis Writing 
Process: Edit and Publish > Write Unit 3 > Integrated Reading and Writing > To His Excellency, General 
Washington > Blast: Candidates Want Your Clicks Unit 4 > Integrated Reading and Writing > Self-
Selected Reading > Write: Self-Selected Response > Write Unit 6 > Integrated Reading and Writing > 
Self-Selected Reading > Write: Self-Selected Response > Write

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

Modes of Writing

LA.12.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and discipline.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Story Beginnings > Your Turn Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Narrative Writing > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Story Beginnings > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Story Beginnings > Your Turn Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Narrative Writing > Model Unit 2 > Extended Writing 
Project and Grammar > Draft > Skill: Organizing Narrative Writing > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Narrative Techniques > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Narrative Techniques > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Your Turn 2 Unit 2 > Extended Writing 
Project and Grammar > Revise > Skill: Transitions > Your Turn 1

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to set mood and tone.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Descriptive Details > Write Unit 2 > Extended 
Writing Project and Grammar > Revise > Skill: Descriptive Details > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE
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LA.12.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Unit 2 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 2 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Write Unit 2 > Extended Writing 
Project and Grammar > Revise > Skill: Conclusions > Your Turn

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > Extended Writing Project and 
Grammar > Revise > Skill: Introductions > Write Unit 5 > Extended Writing Project and Grammar > 
Revise > Skill: Introductions > Your Turn Unit 5 > Extended Writing Project and Grammar > Draft > Skill: 
Organizing Argumentative Writing > Model Unit 5 > Extended Writing Project and Grammar > Draft > 
Skill: Organizing Argumentative Writing > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Model Unit 5 > 
Extended Writing Project and Grammar > Draft > Skill: Thesis Statement > Write Unit 5 > Extended 
Writing Project and Grammar > Draft > Skill: Thesis Statement > Your Turn Unit 5 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Model Unit 5 > Extended Writing Project and 
Grammar > Revise > Skill: Introductions > Write Unit 5 > Extended Writing Project and Grammar > 
Revise > Skill: Introductions > Your Turn Unit 5 > Extended Writing Project and Grammar > Draft > Skill: 
Organizing Argumentative Writing > Model Unit 5 > Extended Writing Project and Grammar > Draft > 
Skill: Organizing Argumentative Writing > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > Model 
Unit 3 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > Your 
Turn Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > 
Model Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > 
Write Unit 5 > Extended Writing Project and Grammar > Draft > Skill: Reasons and Relevant Evidence > 
Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 3 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 3 > Extended Writing Project and 
Grammar > Revise > Skill: Transitions > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Unit 3 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 3 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Write Unit 3 > Extended 
Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Unit 3 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 3 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 3 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Write

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 1 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 1 > Extended Writing Project and 
Grammar > Draft > Skill: Organizing Informative Writing > Model Unit 1 > Extended Writing Project and 
Grammar > Draft > Skill: Organizing Informative Writing > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Model Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Print and Graphic Features > Write Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Print and Graphic Features > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE
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LA.12.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Introductions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Introductions > Write Unit 1 > Extended Writing 
Project and Grammar > Revise > Skill: Introductions > Your Turn Unit 1 > Extended Writing Project and 
Grammar > Draft > Skill: Organizing Informative Writing > Model Unit 1 > Extended Writing Project and 
Grammar > Draft > Skill: Organizing Informative Writing > Your Turn Unit 4 > Extended Writing Project 
and Grammar > Revise > Skill: Print and Graphic Features > Model Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Print and Graphic Features > Write Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Print and Graphic Features > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.b

b. Develop the topic thoroughly with 
relevant, sufficient facts, extended 
definitions, concrete details, quotations, 
and/or other information and examples.

Unit 1 > Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Model Unit 1 > 
Extended Writing Project and Grammar > Draft > Skill: Supporting Details > Your Turn Unit 3 > 
Integrated Reading and Writing > Hawaii’s Story by Hawaii’s Queen > Independent Read: Hawaii’s Story 
by Hawaii’s Queen > Write

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Transitions > Model Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Transitions > Write Unit 1 > Extended Writing Project and 
Grammar > Revise > Skill: Transitions > Your Turn Unit 1 > Extended Writing Project and Grammar > 
Revise > Skill: Precise Language > Model Unit 1 > Extended Writing Project and Grammar > Revise > 
Skill: Precise Language > Your Turn 1 Unit 1 > Extended Writing Project and Grammar > Revise > Skill: 
Precise Language > Your Turn 2

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Unit 1 > Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Model Unit 1 > 
Extended Writing Project and Grammar > Edit and Publish > Skill: Style > Write Unit 1 > Extended 
Writing Project and Grammar > Edit and Publish > Skill: Style > Your Turn

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Unit 1 > Extended Writing Project and Grammar > Revise > Skill: Conclusions > Model Unit 1 > 
Extended Writing Project and Grammar > Revise > Skill: Conclusions > Your Turn Unit 1 > Extended 
Writing Project and Grammar > Revise > Skill: Conclusions > Write

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.6

Gather and use credible evidence from 
multiple authoritative sources, evaluate 
the strengths and limitations of sources 
in terms of the task, purpose, and 
audience, and assess their relevance in 
answering the research question(s).

Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 6 > Extended Oral Project and 
Grammar > Revise > Skill: Sources and Citations > Model Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Sources and Citations > Write Unit 6 > Extended Oral Project and Grammar > Revise > 
Skill: Sources and Citations > Your Turn Unit 4 > Extended Writing Project and Grammar > Revise > 
Skill: Critiquing Research > Model Unit 4 > Extended Writing Project and Grammar > Revise > Skill: 
Critiquing Research > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Critiquing 
Research > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 6 > Extended Oral Project and 
Grammar > Revise > Skill: Sources and Citations > Model Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Sources and Citations > Write Unit 6 > Extended Oral Project and Grammar > Revise > 
Skill: Sources and Citations > Your Turn Unit 4 > Extended Writing Project and Grammar > Revise > 
Skill: Critiquing Research > Model Unit 4 > Extended Writing Project and Grammar > Revise > Skill: 
Critiquing Research > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Critiquing 
Research > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 4 > 
Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Critiquing Research > Model Unit 4 > Extended 
Writing Project and Grammar > Revise > Skill: Critiquing Research > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Critiquing Research > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Model Unit 4 
> Extended Writing Project and Grammar > Draft > Skill: Research and Notetaking > Your Turn Unit 1 > 
Integrated Reading and Writing > SyncStart: Are the New ‘Golden Age’ TV Shows the New Novels? > 
Skill: Annotation > Model Unit 1 > Integrated Reading and Writing > SyncStart: Are the New ‘Golden 
Age’ TV Shows the New Novels? > Skill: Annotation > Your Turn Unit 1 > Extended Writing Project > 
Draft > Skill: Organizing Informative Writing > Model Unit 1 > Extended Writing Project > Draft > Skill: 
Organizing Informative Writing > Your Turn > Item 2 Unit 3 > Integrated Reading and Writing > United 
States v. The Amistad > Independent Read: United States v. The Amistad > Write > Organizer (left blue 
tab)

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g., MLA, APA, Chicago).

Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > 
Extended Writing Project and Grammar > Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing 
Project and Grammar > Revise > Skill: Paraphrasing > Your Turn Unit 6 > Extended Oral Project and 
Grammar > Revise > Skill: Sources and Citations > Model Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Sources and Citations > Write Unit 6 > Extended Oral Project and Grammar > Revise > 
Skill: Sources and Citations > Your Turn Unit 4 > Extended Writing Project and Grammar > Revise > 
Skill: Critiquing Research > Model Unit 4 > Extended Writing Project and Grammar > Revise > Skill: 
Critiquing Research > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: Critiquing 
Research > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Library > Blasts > Search: To Be Honest > Blast: To Be Honest Unit 4 > Extended Writing Project and 
Grammar > Revise > Skill: Paraphrasing > Model Unit 4 > Extended Writing Project and Grammar > 
Revise > Skill: Paraphrasing > Write Unit 4 > Extended Writing Project and Grammar > Revise > Skill: 
Paraphrasing > Your Turn Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating 
Sources > Model Unit 4 > Extended Writing Project and Grammar > Draft > Skill: Evaluating Sources > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Model Unit 
6 > Extended Oral Project and Grammar > Draft > Skill: Evaluating Sources > Your Turn

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model 
Unit 6 > Integrated Reading and Writing > The Museum > Independent Read: The Museum > Write

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model 
Unit 6 > Integrated Reading and Writing > The Museum > Independent Read: The Museum > Write

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Write Unit 6 > Extended 
Oral Project and Grammar > Revise > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral 
Project and Grammar > Revise > Skill: Engaging in Discourse > Your Turn Unit 6 > Extended Oral Project 
and Grammar > Revise > Skill: Engaging in Discourse > Write

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Unit 1 > Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New 
Novels? > Skill: Collaborative Conversations > Model Unit 1 > Integrated Reading and Writing > 
SyncStart: Are the New “Golden Age” TV Shows the New Novels? > Skill: Collaborative Conversations > 
Your Turn Unit 6 > Integrated Reading and Writing > Love After Love > Independent Read: Love After 
Love > Write > Teacher Edition - Instruction > 4. Write Unit 6 > Extended Oral Project and Grammar > 
Revise > Skill: Engaging in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > 
Skill: Engaging in Discourse > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Engaging in Discourse > Write

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE
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LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Unit 6 > Extended Oral Project and Grammar > Edit and Publish > Oral Presentation Process: Edit and 
Present > Write - Active Listening Checklist Unit 6 > Extended Oral Project and Grammar > Revise > 
Skill: Engaging in Discourse > Model Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Engaging in Discourse > Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: 
Engaging in Discourse > Write Unit 1 > Integrated Reading and Writing > SyncStart: Are the New 
“Golden Age” TV Shows the New Novels? > Skill: Collaborative Conversations > Model Unit 1 > 
Integrated Reading and Writing > SyncStart: Are the New “Golden Age” TV Shows the New Novels? > 
Skill: Collaborative Conversations > Your Turn

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Core ELA > Grade 12 > Additional Resources > Project Based Learning > Grade 12 > Podcast, page 40 
Core ELA > Grade 12 > Additional Resources > Project Based Learning > Grade 12 > Multimodal 
Autobiography, page 41 Core ELA > Grade 12 > Additional Resources > Project Based Learning > Grade 
12 > Photomosaic Mural, page 42 Core ELA > Grade 12 > Additional Resources > Project Based Learning 
> Grade 12 > Community Zine, page 43 Core ELA > Grade 12 > Additional Resources > Project Based 
Learning > Grade 12 > Art-Making Workshop, page 44 Core ELA > Grade 12 > Additional Resources > 
Project Based Learning > Grade 12 > Community Maker Faire, page 45

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

Presentation of Knowledge and Ideas

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Model 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Your 
Turn Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > 
Model Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > 
Your Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model 
Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Write Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Persuasive Techniques > Model Unit 6 > Extended 
Oral Project and Grammar > Draft > Skill: Persuasive Techniques > Write Unit 6 > Extended Oral Project 
and Grammar > Draft > Skill: Persuasive Techniques > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > Model 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Considering Audience and Purpose > Your 
Turn Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Model Unit 6 
> Extended Oral Project and Grammar > Revise > Skill: Communicating Ideas > Write Unit 6 > Extended 
Oral Project and Grammar > Revise > Skill: Communicating Ideas > Your Turn Unit 6 > Extended Oral 
Project and Grammar > Draft > Skill: Persuasive Techniques > Model Unit 6 > Extended Oral Project and 
Grammar > Draft > Skill: Persuasive Techniques > Write Unit 6 > Extended Oral Project and Grammar > 
Draft > Skill: Persuasive Techniques > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.b

b. Convey a perspective with clear 
reasoning and valid evidence.

Unit 6 > Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Model Unit 6 > 
Extended Oral Project and Grammar > Revise > Skill: Reasons and Evidence > Your Turn Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Model Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write Unit 6 > 
Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Your Turn Unit 6 
> Extended Oral Project and Grammar > Draft > Skill: Persuasive Techniques > Model Unit 6 > Extended 
Oral Project and Grammar > Draft > Skill: Persuasive Techniques > Write Unit 6 > Extended Oral Project 
and Grammar > Draft > Skill: Persuasive Techniques > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > Skill: Rhetoric > Model Unit 1 
> Integrated Reading and Writing > We Choose to Go to the Moon > Close Read: We Choose to Go to the 
Moon > Read > Skills Focus Unit 1 > Integrated Reading and Writing > We Choose to Go to the Moon > 
Close Read: We Choose to Go to the Moon > Write Unit 1 > Integrated Reading and Writing > We Choose 
to Go to the Moon > Skill: Rhetoric > Your Turn Unit 1 > Integrated Reading and Writing > We Choose to 
Go to the Moon > Skill: Author’s Purpose and Point of View > Model Unit 1 > Integrated Reading and 
Writing > We Choose to Go to the Moon > Skill: Author’s Purpose and Point of View > Your Turn

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Unit 1 > Integrated Reading and Writing > The Metamorphosis > Skill: Connotation and Denotation > 
Model Unit 1 > Integrated Reading and Writing > The Metamorphosis > Skill: Connotation and Denotation 
> Your Turn Library > Blast > Search: In the Deep > Blast: In the Deep Library > Blast > Search: Word 
for Word > Blast: Word for Word

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE



English 12

Seward Public 
Schools A L I G N M E N T U N P A C K I N G

Instructional Materials: Units, Lessons, etc. Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

S
p
e
a
k
i
n
g
 
a
n
d
 
L
i
s
t
e
n
i
n
g LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Model 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Write 
Unit 6 > Extended Oral Project and Grammar > Draft > Skill: Organizing an Oral Presentation > Your 
Turn Unit 6 > Extended Oral Project and Grammar > Plan > Oral Presentation Process: Plan > Write Unit 6 
> Extended Oral Project and Grammar > Edit and Present > Oral Presentation Process: Edit and Present > 
Write

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE



English 12 Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment
Unit 12.1 "What's Next?" 2 weeks Analyze development of a central idea When Breath Becomes Air Are the New ‘Golden Age’ TV Shows the New Novels? (Argumentative) Reading Checks

How can we transform the future? Cite evidence to support conclusions Community Colleges vs. Technical Schools (Informational) Class Discussion and Feedback

Informational Texts Interact with a text (annotation) Overcoming Impostor Syndrome (Informational)

Evaluate author's purpose and perspective What’s Next Podcast #1-3 Personal Statement Essay

Compare arguments between related texts Bird by Bird: Some Instructions on Writing and Life (Informational)

We Choose to Go to the Moon (Argumentative)

How Much Indian Was I?, My Fellow Students Asked (Informational)

Analyze a prompt Commencement Address at Wellesley College (Argumentative)

Plan, organize, draft, revise/edit Plessy vs. Ferguson (Argumentative)

What’s Next Podcast #7-9

Booster Staff Investigates (Informational)

Unit 11.2 "Becoming" 2 weeks Evaluate development of theme Into the Wild “Nature” by Emerson Reading Checks
What are the forces that shape one's 
identity? Cite evidence to support conclusions “Self-Reliance” by Emerson Class Discussion and Feedback

Nonfiction Evaluate author's propse and perspective “Civil Disobedience” by Thoreau

Notice author's text structure choices Remarks at the Signing of the Highway Beautification Act Teacher-Created Test

Compare themes between related texts “Because I could not stop for death” by Emily Dickinson One-Pager Theme Project 

Synthesize ideas across genres 

Research Writing 2 weeks Use a recursive writing process n/a Skill Spotlight lessons Rough Draft 

How is meaning created? Defend a thesis Student Models Final Draft 

Evaluate source credibility MLA Reference Materials 
Improve and clarify writing through revision, 
editing 

Unit 11.2 "The Journey" 2 weeks Analyze author's style through multiple texts The Adventures of Huck Finn Mark Twain’s Life: “Inventing Mark Twain” Reading Checks
How do life experiences shape one's 
perspective? Evaluate theme development “Autobiography of Mark Twain” Class Discussion and Feedback

Historical Nonfiction and Fiction  Analyze plot and character development “Life on the Mississippi”

Analyze author's tone and purpose “The Celebrated Jumping Frog of Calaveras County” Teacher-Created Test

Notice historical context details Expository Essay 

END OF TERM END OF TERM END OF TERM END OF TERM END OF TERM END OF TERM

Unit 11.1 "Breaking Away" 3 weeks Sythesize ideas across genres    The Crucible        Puritan Texts: Historical Context Synthesis Essay
How does independence define the 
American Spirit? Notice historical context details across genre “Of Plymouth Plantation”

Historical Drama Notice elements of drama “Young Goodman Brown” Reading Checks

Evaluate theme development “Sinners in the Hands of an Angry God” Class Discussion and Feedback

Analyze plot and character development        Poetry:

“Upon the Burning of Our House” Teacher-Created Test

“To My Dear and Loving Husband” One-Pager Theme Project 

Selected StudySync resources re: McCarthyism and The Red Scare

Unit 11.5 "Time" 3 weeks Analyze tone and purpose The Great Gatsby “Ozymandias” (poem) Reading Checks
What influence does the past have on 
our future? Notice historical context details The Outsiders Class Discussion and Feedback 

Historical Novel Analyze plot and character development Selected StudySync resources re: American Dream Teacher-Created Test

Evaluate point of view Theme Analysis Essay

Unit 12.5 "Fractured Selves" 3 weeks Analyze use of poetic elements 1984 The Great Figure (Poetry)
What causes individuals to feel 
alienated? Sythesize ideas across genre The Love Song of J. Alfred Prufrock (Poetry)

Modernism Analyze author's tone and purpose miss rosie (Poetry)

Interact with text (annotation) The Idler (Poetry)

Analyze theme across genre A Cup of Tea (Fiction)

The Glass Menagerie (Drama)

A Room of One’s Own (Argumentative)

The New Dress (Fiction)

Hurricane Season (Poetry)

Be Ye Men of Valour (Argumentative)

The Pearl Divers’ Daughters (Poetry)

Killers Of The Dream (Informational)

Shooting an Elephant (Informational)

Unit 12.6 "Times of Transition" 2 weeks Analyze author's style n/a The Mysterious Anxiety of Them and Us (Fiction)

How are we shaped by change? Cite evidence to support conclusions Love After Love (Poetry)

Fiction Evaluate author's propse and perspective The Museum (Fiction)

Notice author's text structure choices A Temporary Matter (Fiction)

Analyze theme across genre Tryst with Destiny (Argumentative)

A Small Place (Informational)

Ghosts (Fiction)

ARK (Fiction)

Blindspot: Hidden Biases of Good People (Argumentative)

News Literacy in the Misinformation Age (Informational)

Honesty on Social Media (Argumentative)

Dawn Revisited (Poetry)

Commencement Address at the New School (Argumentative)
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Central Ideas and Details

LA.12.RP.1

Evaluate the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Evalutate stated or implied 
theme developement implied, stated, theme MASTER

LA.12.RP.2

Analyze the development and 
interaction of literary elements such as 
characterization, setting, and plot, and 
how they contribute to the meaning of 
the work as a whole.

Analyze literary elements 
(development and 

interaction)
characterization, setting, 

plot

NEW/DEEPEN: using an 
element of literature as a 

lens for analysis

Author's Craft

LA.12.RP.3

Evaluate an author’s use of point of 
view and how it contributes to the 
meaning, significance, or aesthetic of a 
literary text.

Evalutate how point of 
view affects the text point of view, aesthetic REINFORCE/APPLY

LA.12.RP.4

Evaluate how an author develops 
structure in a literary text to contribute 
to its overall meaning and aesthetic 
impact.

Evluate how structure 
affects the overall text text structure REINFORCE

Knowledge and Ideas

LA.12.RP.5

Apply knowledge of eighteenth-, 
nineteenth- and early-twentieth-century 
foundational works of literature, 
including how two or more texts from 
the same period treat similar themes or 
topics.

Make comparisons 
between texts across time 

periods for theme 
development 

theme development, 
compare and contrast REINFORCE
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LA.12.RP.6

Evaluate themes within and across 
literary texts to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Use identified themes to 
draw conclusions and 

generate questions
theme development, 
conclusions, inquiry REINFORCE

LA.12.RP.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of literary texts.

Analyze (compare) a 
variety of perspectives 
across various literary 

texts 
analysis, perspective, 

literary text REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RP.8

Read and comprehend a wide range 
of literary texts in the 12-CCR grade 
band independently and proficiently.

Read a range of grade-
level literary texts 

independently 
grade-level, 

independent, proficient REINFORCE
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Central Ideas and Details

LA.12.RI.1

Evaluate the development of central 
ideas over the course of an 
informational text or texts.

Find central ideas in 
informational texts

central ideas, 
informational texts REINFORCE

LA.12.RI.2

Synthesize and evaluate how the 
interaction of individuals, important 
events, and key ideas contribute to the 
meaning of the work as a whole.

Recognize that all aspects 
of a text work together to 

create meaning
synthesis, contribute to 

the whole REINFORCE

Author's Craft

LA.12.RI.3

Citing relevant and thorough evidence 
to support ideas, evaluate the 
development and interaction of 
individuals, ideas, and events in grade-
level informational text.

Cite evidence to support 
ideas and track 

developement of key ideas 
cite, evidence, 
development REINFORCE
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LA.12.RI.4

Evaluate an author’s perspective or 
purpose and how it contributes to the 
meaning, significance, or aesthetic of 
an informational text.

Understand author's 
purpose author's purpose REINFORCE

Knowledge and Ideas

LA.12.RI.5

Analyze seventeenth-, eighteenth-, and 
nineteenth-century works of historical 
and literary significance for their central 
ideas, purposes, and rhetorical style.

Understand and recognize 
purposes and different 
rhetorical styles of texts 

from various time periods. rhetorical styles REINFORCE

LA.12.RI.6

Compare and contrast the 
development of multiple arguments in 
texts of related topics, evaluating the 
effectiveness and validity of the claims.

Compare arguements for 
validity and effectiveness Validity REINFORCE

LA.12.RI.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of informational texts.

Analyze (compare) a 
variety of perspectives 
across various 
informational texts perspective REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RI.8

Read and comprehend a wide range 
of informational texts in the 12-CCR 
grade band independently and 
proficiently.

Read a range of grade-
level informational texts 
independently

idependent, proficient, 
grade-level REINFORCE
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Acquisition and Use

LA.12.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Use approprirate grade-
level vocabulary vocabulary REINFORCE
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LA.12.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Use approprirate grade-
level vocabulary context-clues REINFORCE

LA.12.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
conceive, conception, conceivable).

Use approprirate grade-
level vocabulary forms of words REINFORCE

LA.12.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, 
etymology, or standard usage of words.

Use approprirate grade-
level vocabulary

refererence materials, 
etymology, precise 

meanings REINFORCE

Context and Connotations

LA.12.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.a

a. Interpret figures of speech (e.g., 
hyperbole, paradox) in context and 
analyze their role in text.

Understand how authors 
use language: figurative, 
connotative, and technical figurative language REINFORCE

LA.12.V.2.b

b. Analyze nuances in the meanings of 
words with similar denotations.

Understand how authors 
use language: figurative, 
connotative, and technical nuances, denotation REINFORCE
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Production of Writing

LA.12.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and to add variety, interest, 
and fluency to written and spoken 
language.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.a

a. Demonstrate understanding that 
usage is a matter of convention, can 
evolve, and is sometimes contested.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! usage questions REINFORCE

LA.12.W.1.b

b. Apply knowledge of function and 
usage to revise personal and peer 
writing while resolving issues of complex 
or contested usage, consulting 
appropriate and reliable reference 
materials.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! REINFORCE

LA.12.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE
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LA.12.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

Modes of Writing
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LA.12.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and discipline.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to set mood and tone.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE
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LA.12.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE



Writing and Research

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master

LA.12.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.b

b. Develop the topic thoroughly with 
relevant, sufficient facts, extended 
definitions, concrete details, quotations, 
and/or other information and examples.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE
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LA.12.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.6

Gather and use credible evidence from 
multiple authoritative sources, evaluate 
the strengths and limitations of sources 
in terms of the task, purpose, and 
audience, and assess their relevance in 
answering the research question(s).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g., MLA, APA, Chicago).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE
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LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

Presentation of Knowledge and Ideas

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.b
b. Convey a perspective with clear 
reasoning and valid evidence.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE



Writing and Research

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master



Writing and Research

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master



Writing and Research

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
Introduce/Reinforce/

Master



Writing and Research Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment
Learning to Write Your Story 2 weeks Notice author's craft in a model novel When Breath Becomes Air Novel unit materials Reading Checks
How does time give one perspective 
on the significance of experiences?

Reflect on and find meaning in personal 
experiences Skill Spotlight lessons Class Discussion and Feedback

Personal Narrative Writing Organize a response in a genre-specific structure Student Models 

Captivate a reader with effective language choices Personal Narrative Essay

Research Writing 4 weeks Use a recursive writing process n/a Skill Spotlight lessons Rough Draft 

How is meaning created? Defend a thesis Student Models Final Draft 

Evaluate source credibility MLA Reference Materials 

Improve and clarify writing through revision, editing 

Author's Craft 3 weeks Identify elements of author's craft The Great Gatsby Novel unit materials Author's syle essay

What allows a text to endure the test 
of time?

Analyze how craft affects reader's experience and 
contributes to a novel's impact

"Bernice Bobs Her Hair" 
(short story by Fitzgerald)

Literary analysis essay

Literary Analysis Analyze author's purpose and perspective

Notice plot and character development Skill Spotlight lessons 

Student Models 
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Central Ideas and Details

LA.12.RP.1

Evaluate the development of two or 
more implied or explicit themes over the 
course of a literary text or texts.

Evalutate stated or implied 
theme developement implied, stated, theme MASTER

LA.12.RP.2

Analyze the development and 
interaction of literary elements such as 
characterization, setting, and plot, and 
how they contribute to the meaning of 
the work as a whole.

Analyze literary elements 
(development and 

interaction)
characterization, setting, 

plot

NEW/DEEPEN: using an 
element of literature as a 

lens for analysis

Author's Craft

LA.12.RP.3

Evaluate an author’s use of point of 
view and how it contributes to the 
meaning, significance, or aesthetic of a 
literary text.

Evalutate how point of 
view affects the text point of view, aesthetic REINFORCE/APPLY

LA.12.RP.4

Evaluate how an author develops 
structure in a literary text to contribute 
to its overall meaning and aesthetic 
impact.

Evluate how structure 
affects the overall text text structure REINFORCE

Knowledge and Ideas

LA.12.RP.5

Apply knowledge of eighteenth-, 
nineteenth- and early-twentieth-century 
foundational works of literature, 
including how two or more texts from 
the same period treat similar themes or 
topics.

Make comparisons 
between texts across time 

periods for theme 
development 

theme development, 
compare and contrast REINFORCE
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LA.12.RP.6

Evaluate themes within and across 
literary texts to draw conclusions, 
deepen understanding of self and 
others, and generate questions for 
further inquiry.

Use identified themes to 
draw conclusions and 

generate questions
theme development, 
conclusions, inquiry REINFORCE

LA.12.RP.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of literary texts.

Analyze (compare) a 
variety of perspectives 
across various literary 

texts 
analysis, perspective, 

literary text REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RP.8

Read and comprehend a wide range 
of literary texts in the 12-CCR grade 
band independently and proficiently.

Read a range of grade-
level literary texts 

independently 
grade-level, 

independent, proficient REINFORCE
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Central Ideas and Details

LA.12.RI.1

Evaluate the development of central 
ideas over the course of an 
informational text or texts.

Find central ideas in 
informational texts

central ideas, 
informational texts REINFORCE

LA.12.RI.2

Synthesize and evaluate how the 
interaction of individuals, important 
events, and key ideas contribute to the 
meaning of the work as a whole.

Recognize that all aspects 
of a text work together to 

create meaning
synthesis, contribute to 

the whole REINFORCE

Author's Craft

LA.12.RI.3

Citing relevant and thorough evidence 
to support ideas, evaluate the 
development and interaction of 
individuals, ideas, and events in grade-
level informational text.

Cite evidence to support 
ideas and track 

developement of key ideas 
cite, evidence, 
development REINFORCE
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LA.12.RI.4

Evaluate an author’s perspective or 
purpose and how it contributes to the 
meaning, significance, or aesthetic of 
an informational text.

Understand author's 
purpose author's purpose REINFORCE

Knowledge and Ideas

LA.12.RI.5

Analyze seventeenth-, eighteenth-, and 
nineteenth-century works of historical 
and literary significance for their central 
ideas, purposes, and rhetorical style.

Understand and recognize 
purposes and different 
rhetorical styles of texts 

from various time periods. rhetorical styles REINFORCE

LA.12.RI.6

Compare and contrast the 
development of multiple arguments in 
texts of related topics, evaluating the 
effectiveness and validity of the claims.

Compare arguements for 
validity and effectiveness Validity REINFORCE

LA.12.RI.7

Analyze and evaluate multiple 
perspectives within and across a wide 
range of informational texts.

Analyze (compare) a 
variety of perspectives 
across various 
informational texts perspective REINFORCE

Range of Reading and Level of 
Text Complexity

LA.12.RI.8

Read and comprehend a wide range 
of informational texts in the 12-CCR 
grade band independently and 
proficiently.

Read a range of grade-
level informational texts 
independently

idependent, proficient, 
grade-level REINFORCE

V
o
c
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u
l
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Acquisition and Use

LA.12.V.1

Integrate grade-level academic 
vocabulary appropriately for a variety 
of tasks and purposes.

Use approprirate grade-
level vocabulary vocabulary REINFORCE
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LA.12.V.1.a

a. Use context clues (e.g., the overall 
meaning of a sentence or paragraph; a 
word’s position or function in a 
sentence) to determine the meanings 
of words and phrases.

Use approprirate grade-
level vocabulary context-clues REINFORCE

LA.12.V.1.b

b. Identify and correctly use patterns of 
word changes that indicate different 
meanings or parts of speech (e.g., 
conceive, conception, conceivable).

Use approprirate grade-
level vocabulary forms of words REINFORCE

LA.12.V.1.c

c. Consult general and specialized 
reference materials to determine or 
clarify the precise meanings, 
pronunciations, parts of speech, 
etymology, or standard usage of words.

Use approprirate grade-
level vocabulary

refererence materials, 
etymology, precise 

meanings REINFORCE

Context and Connotations

LA.12.V.2

Interpret an author’s use of figurative, 
connotative, and technical language in 
grade-level literary and informational 
text.

Understand how authors 
use language: figurative, 
connotative, and technical

figurative, connotation, 
technical REINFORCE

LA.12.V.2.a

a. Interpret figures of speech (e.g., 
hyperbole, paradox) in context and 
analyze their role in text.

Understand how authors 
use language: figurative, 
connotative, and technical figurative language REINFORCE

LA.12.V.2.b

b. Analyze nuances in the meanings of 
words with similar denotations.

Understand how authors 
use language: figurative, 
connotative, and technical nuances, denotation REINFORCE
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Production of Writing

LA.12.W.1

Compose grammatically correct multi-
paragraph compositions to convey 
meaning and to add variety, interest, 
and fluency to written and spoken 
language.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! conventions, fluency REINFORCE

LA.12.W.1.a

a. Demonstrate understanding that 
usage is a matter of convention, can 
evolve, and is sometimes contested.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! usage questions REINFORCE

LA.12.W.1.b

b. Apply knowledge of function and 
usage to revise personal and peer 
writing while resolving issues of complex 
or contested usage, consulting 
appropriate and reliable reference 
materials.

Use grammar not only to 
convey meaning, but to 
add variety and interest.  
Make grammar work for 

you! REINFORCE

LA.12.W.2

Use a recursive writing process to 
develop, strengthen, and produce 
writing appropriate to the audience, 
purpose, and discipline.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE
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LA.12.W.2.a

a. Identify and use resources and inquiry 
tools to plan, organize, and draft writing.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.b

b. Adapt writing processes to sustain 
engagement in short and long-term 
writing tasks of increasing length and 
complexity.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.c

c. Improve and clarify writing by 
revising, considering feedback from 
adults and peers to address the needs 
of a particular audience and enhance 
the purpose and structure.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.d

d. Improve and clarify writing by editing 
and proofreading to enhance style 
appropriate to audience, purpose, and 
task.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

LA.12.W.2.e

e. Use appropriate print and 
digital/multimedia tools to produce, 
enhance, and/or publish writing 
individually or in collaboration with 
peers.

Use an effective writing 
process that is aware of 
audience and purpose audience, purpose REINFORCE

Modes of Writing
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LA.12.W.3

Write in a variety of literary forms to 
convey real or imagined experiences or 
events, themes, and perspectives in 
which the development, structure, and 
style are appropriate to the task, 
purpose, and discipline.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.a

a. Engage and orient the reader by 
setting out a problem, situation, or 
observation, establishing multiple points 
of view, and introducing a narrator 
and/or characters; create a smooth 
progression of experiences or events.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.b

b. Use literary techniques, such as 
dialogue, pacing, description, 
reflection, and multiple plot lines, to 
develop experiences, events, settings, 
and/or characters.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.c

c. Use a variety of techniques to 
sequence events so that they build on 
one another to create a coherent 
whole.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.3.d

d. Use precise words and phrases, telling 
details, and sensory language to 
convey a vivid picture of the 
experiences, events, setting, and/or 
characters and to set mood and tone.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE



World Literarture

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
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LA.12.W.3.e

e. Provide a conclusion that follows from 
and reflects upon what is experienced, 
observed, resolved or left unresolved, 
and what new implications or questions 
are raised over the course of the piece.

Write in a variety of forms 
with appropriate 

developement, structure, 
and style.

perspectives, task, 
discipline REINFORCE

LA.12.W.4

Write arguments that develop a 
perspective with supporting reasons 
and evidence, organized as 
appropriate to the task, purpose, and 
audience.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.a

a. Develop a structure to sequence 
ideas logically; introduce a clear claim 
where appropriate, and/or distinguish 
the claim(s) from alternate or supporting 
claims.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.b

b. Demonstrate understanding and 
engagement with multiple viewpoints 
and sources to create and support 
nuanced claims as a recursive process 
of inquiry and exploration.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.c

c. Use words, phrases, key vocabulary, 
and varied syntax to clarify relationships 
between claim(s), counterclaim(s), and 
supporting evidence.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.4.d

d. Adapt style and tone appropriate to 
the norms and conventions of the task 
and discipline.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE



World Literarture

Seward Public 
Schools U N P A C K I N G

Learning Goal Key Vocabulary
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LA.12.W.4.e

e. Provide a conclusion that follows from 
and supports the argument(s) 
presented.

Write an effective 
argument with appropriate 

support 
argument, perspective, 

audience REINFORCE

LA.12.W.5

Write informative/ explanatory pieces to 
clearly convey ideas, information, and 
concepts in which the development 
and structure are appropriate to the 
task, discipline, purpose, and audience.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.a

a. Introduce a topic clearly and provide 
a specific focus; organize complex 
ideas, concepts, and information to 
make clear connections and distinctions 
including text features, illustrations, 
and/or multimedia elements.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.b

b. Develop the topic thoroughly with 
relevant, sufficient facts, extended 
definitions, concrete details, quotations, 
and/or other information and examples.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.c

c. Use appropriate and varied 
transitions, domain-specific vocabulary, 
and varied syntax to manage the 
complexity of the topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.5.d

d. Establish and maintain a formal style 
and objective tone while attending to 
the norms and conventions of the 
discipline.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE
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LA.12.W.5.e

e. Provide a conclusion that follows from 
and supports the information or 
explanations and articulates the 
implications and/or significance of the 
topic.

Write a clear, well-
developed, explanatory 

response 
explanatory, structure, 

informational REINFORCE

LA.12.W.6

Gather and use credible evidence from 
multiple authoritative sources, evaluate 
the strengths and limitations of sources 
in terms of the task, purpose, and 
audience, and assess their relevance in 
answering the research question(s).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.a

a. Integrate information and evidence 
into writing selectively, accurately 
quoting or paraphrasing data and 
conclusions to maintain the flow of 
ideas while avoiding plagiarism.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.b

b. Locate and evaluate the credibility of 
evidence (e.g., the expertise or 
motivation of the creator of an 
information product, potential bias 
and/or deception, and social, political, 
and/or historical perspectives) from print 
and digital sources to generate and 
answer questions and create new 
understandings.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

LA.12.W.6.c

c. Select and use appropriate note-
taking formats to collect and organize 
information.

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE
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LA.12.W.6.d

d. Demonstrate academic integrity by 
avoiding overreliance on any one 
source; cite sources using a variety of in-
text citations to enhance fluency; 
develop a list of sources that conforms 
to a style guide appropriate to the 
discipline (e.g., MLA, APA, Chicago).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

S
p
e
a
k
i
n
g
 
a
n
d
 
L
i
s
t
e
n
i
n
g

LA.12.W.6.e

e. Practice safe and ethical behaviors 
when communicating and interacting 
with others digitally (e.g. safe 
information to share, utilize appropriate 
sites and materials, appropriate 
language use, respect diverse 
perspectives).

Find, evaluate and use 
authorative/ credible 

sources
credibility, limitations, 

relevance REINFORCE

Comprehension and Collaboration

LA.12.SL.1

Communicate effectively and 
appropriately in collaborative activities 
for a variety of tasks, purposes, and 
audiences to express ideas, share 
knowledge, and generate new 
understandings.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.a

a. Ask relevant questions to build on 
ideas, clarify own ideas, or acquire or 
confirm information.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE
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LA.12.SL.1.b

b. Demonstrate interpretation of verbal 
and non-verbal messages in a 
conversation.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.c

c. Converse with peers and adults in an 
all-inclusive manner to foster positive 
relationships while respecting diverse 
perspectives.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.d

d. Demonstrate active and attentive 
listening skills (e.g., eye contact, 
nonverbal cues, taking notes, 
summarizing, questioning).

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

LA.12.SL.1.e

e. Complete a task following complex, 
multi-step directions.

Communicate and 
collaborate to achieve a 

purpose/ fulfill a task collaborate REINFORCE

Presentation of Knowledge and Ideas

LA.12.SL.2

Present information, findings, and 
supporting evidence effectively and in 
which the organization, development, 
and style are appropriate to a variety of 
tasks, purposes, and audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.a

a. Demonstrate and adjust speaking 
techniques (e.g., appropriate eye 
contact, pacing, nonverbal cues, 
intonation) for a variety of purposes and 
situations, including interpreting grade-
level texts.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.b
b. Convey a perspective with clear 
reasoning and valid evidence.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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LA.12.SL.2.c

c. Evaluate the purpose of information 
being presented, its motives (e.g., 
social, commercial, political), and 
determine its credibility.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.d

d. Demonstrate awareness of and 
sensitivity to the appropriate use of 
words (e.g., stereotypes, multiple 
meanings of words).

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE

LA.12.SL.2.e

e. Make strategic use of appropriate 
visual and/or digital tools to enhance 
understanding of findings, reasoning, 
and evidence for specific audiences.

Effectively present findings 
with audience awareness

task, purpose, audience 
awarenness REINFORCE
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World Lit Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment
BR 12.1: "Against the Wind" 2 weeks Evaluate development of theme n/a Beowulf (A Graphic Novel) (Fiction) Reading Checks
How are leaders forged from 
circumstances? Cite evidence to support conclusions

Beowulf (Lines 144–300 – Gummere 
Translation) (Poetry) Class Discussion and Feedback

Medieval Period Evaluate author's purpose and perspective 
Beowulf (Lines 144–300 – Heaney 
Translation) (Poetry)

Notice author's text structure choices Grendel (Fiction) Synthesis Essay 

Compare themes between related texts The Pardoner’s Prologue (Poetry)

Synthesize ideas across genres 

Unsolved Mysteries of History: An Eye-
Opening Investigation into the Most Baffling 
Events of All Time (Informational)

Sir Gawain and the Green Knight (Poetry)

Le Morte d’Arthur (Fiction)
Conversation with Geoffrey Ashe re: King 
Arthur (Informational)

The Lord of the Rings (Fiction)

BR 12. 2 "The Human Condition" 3 weeks Notice elements of drama Hamlet
Speech to the Troops at Tilbury 
(Argumentative) Reading Checks

How do we express the complexities 
of being human? Evaluate theme development Long Way Down On Monsieur’s Departure (Poetry) Class Discussion and Feedback

English Renaissance Analyze plot and character development Richard III (Drama) Teacher-Created Tests

Interpret use of symbols
Shakespeare: The World as Stage 
(Argumentative) Comparison Essay 

Notice author's text structure choices Hamlet and His Problems (Argumentative)

Synthesize ideas across genres Hamlet (Drama)
Interact with complex texts to make meaning 
(annotation 

Rosencrantz and Guildenstern Are Dead 
(Drama)

Sonnet 18 (Poetry)

Sonnet 73 (Poetry)

Sonnet 29 (Poetry)

A Valediction: Forbidding Mourning (Poetry)

To Lucasta, Going to the Wars (Poetry)

BR 12. 4 "Visions of Progress" 4 weeks Evaluate author's purpose and perspective Pride and Prejudice Factory Children (Argumentative) Reading Checks
When is it necessary to question the 
status quo? Analyze the use of satire The Cry of the Children (Poetry) Class Discussion and Feedback

Victorianism Notice the use of motifs A Tale of Two Cities (Fiction) Teacher-Created Test

Notice historical context details 
Charles Dickens: The Shonda Rhimes of 
Victorian Letters (Informational)

Analyze character development 
Are the New “Golden Age” TV Shows the 
New Novels? (Argumentative)

Track the use of setting to advance plot Honesty on Social Media (Argumentative)

Jane Eyre (Fiction)

Wide Sargasso Sea (Fiction)



Short Stories planning

Unit/GENRE/THEME Pacing Learning Goals Possible Stories
Supporting Study Sync 

Materials Assessment

History of Short Stories 1 week

SWBAT: 1. Identify 
characteristics of short 
stories as genre 2. Identify 
first short story writer. 3. 
Connect short stories to 
oral traditions 4. Formulate 
an opinion on the main 
character and 
constructively critique 
others' claims. "Rip Van Winkle" Debate: is Rip Van Winkle Hero or Villain?

Realism 1-2 weeks

SWBAT identify the 
characteristics of realism and 
its historic role in literature. 
Students will summarize plots 
of the stories. SWBAT apply 
concepts of point of view and 
diction to the stories and 
discuss impact. 

"The Occurrence at Owl Creek Bridge," 
"To Build a Fire," "The Open Boat" Test

Romanticism 1 week

SWBAT identify the qualities 
of romanticism and correct 
fools who think it's a kissing 
story. Students will annotate 
romantic poem for 
understanding. Students will 
define framed narrative. 
Students will examine cause & 
effect of the plot events. 
Students will compare the 
wedding guest with the 
mariner and develop claims 
about what they understand 
at the end. "Rime of the Ancient Mariner" One-pager 

Mad Scientist Archetypes 2-3 weeks

SWBAT describe the mad 
scientist archetype. 
SWBAT will thematically 
analyze the archtype for 
messages about forbidden 
knowledge. Students will 
then construct a literary 
argument with textual 
evidence. SWBAT apply 
archetypical understanding 
to design a mad scientist 
story of their own. 

Nathaniel Hawthorne's "The Birthmark," 
"Rappaccini's Daughter," or "Dr. 
Heidegger's Experiment" Essay, short story

Westerns 1-2 weeks

SWBAT analyze archtypes 
presented in Westerns and 
synthesize statements 
about thematic 
contributions and conflicts 
in such archtypes. "A Bride Comes to Yellow Sky," "The 

Outcasts of Poker Flat" Literary analysis essay

Magical Realism 2 weeks

 SWBAT identify the 
characteristics of magical 
realism, synthesize 
statements about thematic 
development with particular 
attention to characters

"The Book of Sand," "A Very Old Man 
with Enormous Wings," "The 
Handsomest Drowned Man in the 
World" One-pager



Short Stories planning

Author Study: Flannery 
O'Connor and the Southern 
Gothic 2 weeks

SWBAT summarize the life of 
Flannery O'Connor. Students 
will differentiate between 
gothic romance and southern 
gothic genres. Students will 
critque the influence of irony 
in the stories. 

"A Good Man is Hard to Find," 
"Everything that Rises Must Converge," 
"Good Country People" Test, essay, or one-pager

Walter Mitty 1.5 weeks

Students will compare and 
contrast the short story with 
the 2013 film. 

"The Secret Life of Walter Mitty," story 
and movie Socratice seminar 

The Metamorphis 1-2 weeks

SWBAT apply allegorical 
understanding to a literary 
interpretation of Kafka's 
story focusing on one of the 
following lenses: 
autobiographical elements 
of the writer's life, social-
emotional health, or 
capitalist critque. Students 
will use text evidence to 
defend their hypotheses The Metamorphosis Essay

Bartleby the Scrivener 1 week

Students will apply notice 
and note techniques to the 
story. Students will share 
their observations in a 
socratic seminar and 
collaboratively construct 
meaning. "Bartelby the Scrivener" Socratice seminar 

Dealing with Disappointment 1-2 weeks

Students will research 
biographical information 
about the authors. Students 
will connect this information 
as potentially influential to 
the stories. Students may 
analyze symbolism, irony, 
or characterization. 
Students will connect the 
stories to social issues and 
create infographics to raise 
awareness of healthy 
responses vs. unhealthy 
responses. 

"The Rockinghorse Winner," "A Clean 
Well-Lighted Place," "A&P," "Paul's 
Case" Infographic poster

Women in Literature 2 weeks

SWBAT analyze irony's role 
in each story. Cite evidence 
of each protagonist's 
development and struggle 
for autonomy. 

"The Story of an Hour," "The Yellow 
Wallpaper," "St. Lucy's Home for Girls," 
"As I Stand Here Ironing," "Girl" Socratic seminar or one-pager 

War Stories 2 weeks

SWBAT define juxtaposition 
and investigate its 
appearance in literature. 
Students will apply this to 
synthesize a literary criticism 
of either story. 

"The Red Convertible," "The Things 
They Carried" Essay 

Essay as Story 2 weeks

SWBAT connect short story 
characteristics with 
personal essay writing. 
Students will then imitate 
the style to create their own 
personal story. GK Chesterton's "A Piece of Chalk" Personal essay 



Short Stories planning

What is heritage? 1 week

Students will define 
heritage. SWBAT answer 
the question of who doesn't 
understand heritage. 
Students will present 
speeches about items 
items they feel connect to 
their heritage. "Everyday Use" Speech on what makes the student an individual

Family Roles 1 week

Students will examine 
family expectations and 
motives in the story and 
discuss the impact of 
changing roles. 

Alice Munroe "Boys and Girls" & Amy 
Tan's "Two Kinds" Socratic seminar

Neil Gaiman Author Study 1-2 weeks Summarize development 
"Click Clack the Rattlebag" and The 
Graveyard Book *This may end up in the writing seminar class



Cinema as Literature Planning

Unit/GENRE/THEME Pacing Learning Goals Possible Novels Supporting Study Sync Materials Assessment

Director Study

*All presentations will be 
dependent upon how many 
students are in the class

Students will choose a director 
and watch any three films by 
this person. Students will then 
construct presentations about 
what qualities are recognizable 
as this director's. 

Hitchcock or Christopher Nolan 
film tbd Speeches

Genre Study

Students will choose a genre 
and watch any three films in 
this genre. Students will then 
construct presentations about 
what define this genre Speeches

Compare and Contrast 

Students will compare and 
contrast two films (either a 
reboot, remake, or adaptation 
of literature). Students will then 
create presentations about 
their findings and make 
arguments about which is most 
effective. Speeches

What makes a classic?

Students will watch 
Casablanca and then make 
claims about why it's 
considered a classic. Casablanca Socratic seminar 

Heist Movies 

Students will theorize why "the 
lovable criminal" is a trope. 
Students will identify 
archetypes within the films. 

The Italian Job, National 
Treasure, Gone in 60 Seconds, 
or The Maiden Heist Poster

Juxtaposition 
Students will explore 
juxtaposition in film. 

The Grand Budapest Hotel, 
Lost in Translation, Driving 
Lessons Socratic seminar 

Sound and Light 

Students will examine the 
manipulation of lighting and 
sound on films. 

Movie tbd with parent approval 
letters* Esssay

Foreign Film

Students will discuss the 
difficulties in translation 
choices. 

Movie tbd with parent approval 
letters Socratic seminar 

Notice and Note

Students will learn about notice 
and note techniques, define 
each and apply them to short 
films Disney shorts Essay

* Any films above G would be 
approved through the office 
first, and then with parent 
letters. The struggle is finding 
movies most students have not 
already seen and being able to 
have variabilty when students 
repeat the class. 
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3001 
Budget and Property Tax Request 

 
The board of education shall adopt a budget each year to support the school 
district’s programs and services for the ensuing fiscal year.   The 
superintendent of schools shall be responsible for developing the budget 
subject to the direction and decisions of the board.  The budget document 
shall be under continuous development, based upon the requirements of the 
adopted educational program.  
 

BUDGET PROCEDURES 
 
Proposed Budget.  The superintendent shall prepare the proposed budget in 
accordance with board policies and goals, state statutes, and regulations.  As 
the district’s spending plan, the budget will be based on up-to-date revenue 
estimates, and will reflect the assessed needs and programs approved by the 
board. 
 
Budget Hearing Notice.  Notice of place and time of the hearing, together 
with a summary of the proposed budget statement, must be published at least 
four calendar days prior to the date set for hearing in a newspaper of general 
circulation within the school district.  The four calendar days shall include the 
day of publication but not the day of hearing.  The notice shall include the 
following statement: 
 

For more information on statewide receipts and expenditures, and 
to compare cost per pupil and performance to other school 
districts, go to: [Insert Internet address for the web site 
established pursuant to Laws 2021, LB528, section 5]. 
https://nep.education.ne.gov/ 

 
In addition, the district must electronically publish this statement on the 
school district web site. Such electronic publication must be prominently 
displayed with an active link to the Internet address for the web site 
established by the Nebraska Budget Act to allow the public access to the 
information. 
 
Budget Hearing.  The board must conduct a hearing prior to adopting the 
budget.  The hearing must be held separately from any regularly scheduled 
meeting and may not be limited by time.  The board must make a presentation 
outlining key provisions of the proposed budget statement, including, but not 
limited to, a comparison with the prior year's budget.  Any member of the 
public desiring to speak on the proposed budget statement shall be allowed to 
address the board at the hearing and must be given a reasonable amount of 
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time to do so.  Five minutes shall generally be considered a reasonable amount 
of time.   
 
Budget Hearing Documents.  The board must make at least three copies of 
the proposed budget statement and at least one copy of all other reproducible 
written material to be discussed at the hearing available to the public at the 
hearing.   
 
Budget Adoption.  After the budget hearing, the proposed budget statement 
shall be adopted or amended and adopted as amended.  If the adopted budget 
statement reflects a change from that shown in the published proposed budget 
statement, a summary of the changes (including the items changed and the 
reasons for such changes) must be published in a newspaper of general 
circulation within the school district within twenty calendar days after its 
adoption without further hearing.   
 
Certification and Filing.  The amount to be received from personal and real 
property taxation shall be certified to the appropriate levying board as 
provided by law.  The budget shall also be filed with the state auditor. 
 
Purchase Authorization.  Except for bids required under the section "Bid 
Letting and Contracts,” the board’s adoption of the budget shall authorize the 
purchases without further board action. 
 
Monthly Report.  At each monthly board meeting, the superintendent will 
provide a report on the current status of the major sections of the budget. 
 
PROPERTY TAX REQUEST PROCEDURES – PROPERTY TAX REQUEST IS EQUAL TO OR 

LOWER THAN THE ALLOWABLE GROWTH PERCENTAGE 
 
Property Tax Request Hearing.  The board must hold a special public 
hearing called for the purpose of passing a property tax request resolution. 
 
Property Tax Request Hearing Notice.   The district must publish a hearing 
notice in a newspaper of general circulation in the school district at least four 
calendar days prior to the hearing.  The four calendar days shall include the 
day of publication but not the day of hearing.  The hearing notice must contain 
the following information: The certified taxable valuation under section 13-
509 for the prior year, the certified taxable valuation under section 13-509 for 
the current year, and the percentage increase or decrease in such valuations 
from the prior year to the current year; the dollar amount of the prior year’s 
tax request and the property tax rate that was necessary to fund that tax 
request; the property tax rate that would be necessary to fund last year's tax 
request if applied to the current year's valuation; the proposed dollar amount 
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of the tax request for the current year and the property tax rate that will be 
necessary to fund that tax request; the percentage increase or decrease in 
the property tax rate from the prior year to the current year; and the 
percentage increase or decrease in the total operating budget from the prior 
year to the current year. 
 
Increase in Total Property Taxes Levied.  If the annual assessment of 
property would result in an increase in the total property taxes levied as 
determined using the previous year’s rate of levy, the district’s property tax 
request for the current year shall be no more than its property tax request in 
the prior year, and the district’s rate of levy for the current year shall be 
decreased accordingly when such rate is set by the county board of 
equalization.   
 
Decrease or No Change in Total Property Taxes Levied.  If the annual 
assessment of property would result in no change or a decrease in the total 
property taxes levied as determined using the previous year’s rate of levy, the 
district’s property tax request for the current year shall be no more than its 
property tax request in the prior year, and the district’s rate of levy for the 
current year shall be adjusted accordingly when such rate is set by the county 
board of equalization.  
 
Resolution.  The board shall pass a resolution to set the amount of its 
property tax request only after holding the public hearing.  The resolution 
setting the district’s property tax request at an amount that exceeds the prior 
year’s property tax request shall include, but not be limited to, the information 
required by section 77-1601.02(4) 77-1632(4). 
 
Certification.  The resolution setting the property tax request shall be 
certified and forwarded to the county clerk on or before October 15th of the 
year for which the tax request is to apply. 
 

PROPERTY TAX REQUEST PROCEDURES – PROPERTY TAX REQUEST IS GREATER 
THAN THE ALLOWABLE GROWTH PERCENTAGE 

 
Property Tax Request Hearing.  The board must hold a public hearing 
called for the purpose of passing a property tax request resolution.  If another 
political subdivision within the county also seeks to exceed the allowable 
growth percentage, the hearing will be a joint hearing.  In the event of a joint 
hearing, each political subdivision must designate one representative to 
attend the joint public hearing on behalf of the political subdivision.  If a 
political subdivision includes area in more than one county, the political 
subdivision shall be deemed to be within the county in which the political 
subdivision's principal headquarters are located.  The hearing agenda will only 
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include discussion on each political subdivision’s intent to increase its property 
tax request by more than the allowable growth percentage to the extent 
allowed by law. 
 
The hearing must be held after 6 p.m. on or after September 17th and before 
September 28th and before the district files its adopted budget statement.  
Any member of the public must be allowed a reasonable amount of time to 
speak at the hearing. 
 
At the joint public hearing, the representative of each political subdivision 
must give a brief presentation on the political subdivision’s intent to increase 
its property tax request by more than the allowable growth percentage to the 
extent allowed by law and the effect of such request on the political 
subdivision's budget.  The presentation must include, at a minimum, all 
information and statements required by law.   
 
Property Tax Request Hearing Notice.   Notice of the joint public hearing 
must be provided by: 
 

● The County Assessor sending a postcard with all required information to 
all affected property taxpayers.  The postcard shall be sent to the name 
and address to which the property tax statement is mailed; 

● Posting notice of the hearing with all required information on the home 
page of the relevant county's web site, except that this requirement 
shall only apply if the county has a population of more than twenty-five 
thousand inhabitants; and 

● Publishing notice of the hearing with all required information in a legal 
newspaper in or of general circulation in the relevant county. 

 
Provide Information to County Clerk.  Each political subdivision that 
participates in the joint public hearing shall provide the following information 
to the county clerk by September 5th:  the date, time, and location for the 
joint public hearing; a listing of and telephone number for each political 
subdivision that will be participating in the joint public hearing; and the 
amount of each participating political subdivision's property tax request. 
 
Resolution.  The board shall pass a resolution to set the amount of its 
property tax request only after holding the public hearing.  The resolution 
setting the district’s property tax request at an amount that exceeds the prior 
year’s property tax request, including any increase in excess of the allowable 
growth percentage shall include, but not be limited to, the information 
required by law. 
 
Certification.  The resolution setting the property tax request shall be 
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certified and forwarded to the county clerk on or before October 15th of the 
year for which the tax request is to apply. 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
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 3003.1 
Bidding for Construction, Remodeling, Repair, or Related Projects 

Financed with Federal Funds 

I. Applicability of the Policy 
 
This policy applies only to construction and contracts undertaken with federal 
funds which are subject to the federal Uniform Grant Guidance (UGG) and 
other applicable federal law, including but not limited to the Education 
Department and General Administration Regulations (EDGAR) and the United 
States Department of Agriculture (USDA) regulations governing school food 
service programs.  In the event this policy conflicts or is otherwise inconsistent 
with mandatory provisions of the UGG, EDGAR or other applicable federal law, 
the mandatory provisions of the laws shall control. 
 
The District will also comply with the requirements of the public lettings laws 
(NEB. REV. STAT. §§ 73-101 through 73-106) when the contemplated 
expenditure for the complete project exceeds $109,000, the Political 
Subdivisions Construction Alternatives Act (NEB. REV. STAT. §§ 13-2901 
through 13-2914), energy financing contracts (NEB. REV. STAT. §§ 66-1062 
through 66-1066), other applicable state laws, and the board’s general policy 
on Bidding for Construction and Related Projects.  In addition, all procurement 
and construction shall comply with the rules and requirements of 2 CFR part 
200.317 through 200.326 and 34 CFR sections 75.601 through 75.615.  In 
the event of a conflict between state and federal law, the more stringent 
requirement shall apply. 

II. All projects undertaken pursuant to this policy will be subject to 
the following bond requirements 

A. A bid guarantee from each bidder equivalent to five percent of the 
bid price.  The “bid guarantee” must consist of a firm commitment 
such as a bid bond, certified check, or other negotiable instrument 
accompanying a bid as assurance that the bidder will, upon 
acceptance of the bid, execute such contractual documents as may 
be required within the time specified. 

B. A performance bond on the part of the contractor for 100 percent of 
the contract price.  A “performance bond” is one executed in 
connection with a contract to secure fulfillment of all the contractor's 
obligations under such contract. 

C. A payment bond on the part of the contractor for 100 percent of the 
contract price.  A “payment bond” is one executed in connection with 



Page 2 of 13 

a contract to assure payment as required by law of all persons 
supplying labor and material in the execution of the work provided 
for in the contract. 

III. Construction Projects with an Anticipated Cost of Under 
$250,000 

A. Methods of Bidding/Soliciting Quotations or Estimates 
 
The type of procedures required depends on the anticipated cost of the 
project.   

1. Construction with an Anticipated Cost of up to $10,000 (Micro-
Purchases)  

 
Micro-purchase means a purchase of supplies or services using 
simplified acquisition procedures, the annual aggregate amount of which 
does not exceed $10,000.  Micro-purchases may be made or awarded 
without soliciting competitive quotations, to the extent district staff 
determine that the cost of the purchase is reasonable.  For purposes of 
this policy “reasonable” means the purchase is comparable to market 
prices for the geographic area.  
 
To the extent practicable, the District distributes micro-purchases 
equitably among qualified suppliers. The District will follow its standard 
policy on purchasing.   
 

2. Construction with an Anticipated Cost of between $10,000 and 
$250,000 (Small Purchase Procedures)  

 
For construction projects subject to this policy, small purchases are 
purchases that, in the aggregate amount, is more than $10,000 and less 
than $250,000 annually.  For small purchases, price or rate quotes shall 
be obtained in advance from a reasonable number of qualified sources 
as detailed in the district’s standard policies on purchasing and on bid 
letting and contracts.  
 

B. Construction Projects with an estimated cost of between $109,000 
and $249,999 will be made pursuant to the District’s Policy on Bid 
Letting and Contracts.  
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Pursuant to Nebraska law, construction projects which have an 
anticipated aggregate cost of $109,000 or more are subject to state 
public lettings laws (NEB. REV. STAT. §§ 73-101 through 73-106).  The 
board will follow its standard policy on bid letting and contracts for 
construction projects financed with federal funds which have an 
anticipated aggregate cost of between $109,000 and $250,000.   

 

IV. Construction Projects with an Anticipated Cost Over $250,000  

A. Sealed Bids: All constructions projects subject to this policy with an 
anticipated cost of $250,000 or more will be publicly solicited using 
the sealed bid method 

1. Bids must be solicited from an adequate number of known 
suppliers, providing them sufficient response time prior to the 
date set for opening the bids, for state, local, and tribal 
governments, the invitation for bids must be publicly advertised; 

2. The invitation for bids, which will include any specifications 
and pertinent attachments, must define the items or services in 
order for the bidder to properly respond; 

3. Sealed bids will be publicly opened in a place and at the 
specific time stated in the bid solicitation.  Bidders shall be notified 
of the opening and invited to be present.   

4. The contract will be awarded to the lowest responsive and 
responsible bidder.  

a) Where specified in bidding documents, factors such as 
discounts, transportation cost, and life cycle costs must be 
considered in determining which bid is lowest.   
b) Payment discounts will only be used to determine the 
low bid when prior experience indicates that such discounts 
are usually taken advantage of.   
c) Any or all bids may be rejected if there is a sound 
documented reason. 

5. The board shall have discretion in determining which bidders 
are responsible and responsive and shall award the contract to the 
lowest, responsible, and responsive bidder whose bid meets the 
bid specifications.  This means that the board will select the bid 
that offers the best value and award a contract based upon the 
amount of the bid and the bidder’s ability and capacity to carry on 
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the work, its equipment and facilities, honesty, integrity, skills, 
business judgment, experience, equipment, facilities, financial 
stability, past performance, and other relevant factors.   

6. The board will generally complete its review of bids and 
select a vendor within 30 days of bid submission.   

B. Advertising for Bids.   

1. The superintendent or designee will arrange to advertise for 
bids by publishing notice in any newspaper of general circulation 
within the school district at least 7 calendar days prior to the date 
on which bids are due.   

2. Nothing shall prevent the superintendent or designee from 
advertising in additional media outlets or for a longer period of 
time. 

C. Bid Documents 

1. The bid documents shall identify the day upon which the 
bids shall be returned, received, or opened and shall identify the 
hour at which the bids will close or be received or opened.   

2. The bid documents shall also provide that such bids shall be 
opened simultaneously in the presence of the bidders or their 
representatives.   

3. Bids received after the date and time specified in the bid 
documents shall be returned to the bidder unopened. 

4. If bids are being opened on more than one contract, the 
board, in its discretion, may award each contract as the bids are 
opened. 

5. Sealed bids will be opened in a place and at the specific time 
stated in the bid solicitation.  Bidders shall be notified of the 
opening and invited to be present.   

6. Bids will be reviewed by the Superintendent and/or designee 
and submitted to the board for approval. 

7. The board shall have discretion in determining which bidders 
are responsible and responsive and shall award the contract to the 
lowest, responsible, and responsive bidder whose bid meets the 
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bid specifications.  This means that the board will select the bid 
that offers the best value and award a contract based upon the 
amount of the bid and the bidder’s ability and capacity to carry on 
the work, its equipment and facilities, honesty, integrity, skills, 
business judgment, experience, equipment, facilities, financial 
stability, past performance, and other relevant factors.   

8. The board will generally complete its review of bids and 
select a vendor within 30 days of bid submission.   

D. The terms of any construction project undertaken pursuant to this 
policy will be memorialized in a written contract which has been 
reviewed by the district’s legal counsel and approved by the board.   

V. Other Contract Matters. 

A. Required Terms 
 
The non-Federal entity's contracts must contain the applicable provisions 
required by section 200.326 and described in Appendix II to Part 200—
Contract Provisions for non-Federal Entity Contracts Under Federal Awards.  
This includes a “Buy American” provision that provides that as appropriate and 
to the extent consistent with law, the District and contractor should, to the 
greatest extent practicable under a Federal award, provide a preference for 
the purchase, acquisition, or use of goods, products, or materials produced in 
the United States (including but not limited to iron, aluminum, steel, cement, 
and other manufactured products). The requirements of the Buy American 
provision must be included in all subawards including all contracts and 
purchase orders for work or products under this award. 

B. Contracting with Certain Vendors 
 
Pursuant to the standards contained in 2 C.F.R. § 200.321, the District will 
take all necessary affirmative steps to assure that minority businesses, 
women's business enterprises, and labor surplus area firms are used when 
possible and consistent with state law. 
 
To the maximum extent practicable, the school food program shall purchase 
domestic commodities or products produced in the U.S. or processed in the 
U.S. substantially using agricultural commodities produced in the U.S. 

C. Full and Open Competition  
 
The district’s procurement transactions will be conducted in a manner 
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providing full and open competition consistent with 2 C.F.R §200.319. 

D. Debarment and Suspension   
 
The District awards contracts only to responsible contractors possessing the 
ability to perform successfully under the terms and conditions of a proposed 
procurement.  Consideration will be given to such matters as contractor 
integrity, compliance with public policy, record of past performance, and 
financial and technical resources.  
 
The District may not subcontract with or award subgrants to any person or 
company who is debarred or suspended.  For all contracts over $25,000 the 
District verifies that the vendor with whom the District intends to do business 
with is not excluded or disqualified.  2 C.F.R. Part 200, Appendix II(1) and 2 
C.F.R. §§ 180.220 and 180.300. 
   
The District will verify debarment or suspension by revising the excluded 
parties list on SAM.gov, collecting a certification through the bidding process, 
and/or by including a debarment and suspension provision in the bid and 
contract documents. The Superintendent or his/her designee shall be 
responsible for such verification. 

E. Settlements of Issues Arising Out of Contract 
 
The District alone is responsible, in accordance with good administrative 
practice and sound business judgment, for the settlement of all contractual 
and administrative issues arising out of procurements.  These issues include, 
but are not limited to, source evaluation, protests, disputes, and claims.  
These standards do not relieve the District of any contractual responsibilities 
under its contracts.  Violations of law will be referred to the local, state, or 
federal authority having proper jurisdiction. 

F. Record Keeping  

1. Record Retention 
 

a) The District maintains all records that fully show (1) the 
amount of funds under the grant or subgrant; (2) how the 
subgrantee uses those funds; (3) the total cost of each 
project; (4) the share of the total cost of each project 
provided from other sources; (5) other records to facilitate an 
effective audit; and (6) other records to show compliance with 
federal program requirements. 34 C.F.R. §§ 76.730-.731 and 
§§ 75.730-.731.  The District also maintains records of 
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significant project experiences and results.  34 C.F.R. § 
75.732.  These records and accounts must be retained and 
made available for programmatic or financial audit.   
 

b) The U.S. Department of Education is authorized to recover 
any federal funds misspent within 5 years before the receipt 
of a program determination letter.  34 C.F.R. § 81.31(c).  
Schedule 10 (Local School Districts) and Schedule 24 (Local 
Agencies General Records) of the Nebraska Records 
Management Division as approved by the Nebraska Secretary 
of State/State Records Administrator requires the District to 
maintain records regarding construction projects for a 
minimum of five (5) years after the sale or demolition of the 
building. However, if any litigation, claim, or audit is started 
before the expiration of the record retention period, the 
records will be retained until all litigation, claims, or audit 
findings involving the records have been resolved and final 
action taken.  2 C.F.R. § 200.333. 
 

c) Records will be destroyed in compliance with Schedule 10, 
Schedule 24, and State law.  This includes the completion of 
a Records Disposition Report. 

2. Maintenance of Construction Records for Projects Financed with 
Federal Funds   

 
a) The District must maintain records sufficient to detail the 

history of all construction projects financed with federal 
funds.  These records will include, but are not necessarily 
limited to the following: rationale for the method of 
construction, selection of contract type, contractor selection 
or rejection, the basis for the contract price (including a cost 
or price analysis), and verification that the contractor is not 
suspended or debarred.   
 

b) Retention of construction records shall be in accordance with 
applicable law and Board policy. 
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VI. Conflict of Interest and Code of Conduct  

A. Board and staff member conflicts of interest are governed by the 
district’s conflict of interest policies.   

B. Contracts covered by this policy are subject to the following 
additional provisions. 

1. Employees, officers, and agents engaged in the selection, award, 
and/or administration of district contracts which are prohibited 
from engaging in such actions if a real or apparent conflict of 
interest is present.  

2. Such a conflict of interest would arise when the employee, officer, 
or agent, any member of his or her immediate family, his or her 
partner, or an organization which employs or is about to employ 
any of the parties indicated herein, has a financial or other interest 
in or a tangible personal benefit from a firm considered for a 
contract.  

3. The board may determine at its discretion that a financial interest 
is not substantial enough to give rise to a conflict of interest. 

C. Favors and Gifts 
 
The officers, employees, and agents of the District may neither solicit nor 
accept gratuities, favors, or anything of monetary value from contractors or 
parties to subcontracts, with the limited exception of unsolicited items of 
nominal value. 

D. Enforcement 
 
Disciplinary Actions will be applied for violations of such standards by officers, 
employees, or agents of the District at the board’s discretion. 

VII. Financial Management 

A. Identification.   

The District will identify, in its accounts, all federal awards received and 
expended and the federal programs under which they were received.  Federal 
program and award identification include, as applicable, the CFDA title and 
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number, federal award identification number and year, name of the federal 
agency, and, if applicable, name of the pass-through entity. 

B. Financial Reporting  

The District will make an accurate, current, and complete disclosure of the 
financial results of each federal award or program in accordance with the 
financial reporting requirements set forth in the Education Department 
General Administrative Regulations (EDGAR). 

C.  Accounting Records   

The District maintains records which adequately identify the source and 
application of funds provided for federally-assisted activities.  These records 
must contain information pertaining to grant or subgrant awards, 
authorizations, obligations, unobligated balances, assets, expenditures, 
income and interest and be supported by source documentation. 

D. Internal Controls   

The Superintendent or his/her designee must maintain effective control and 
accountability for all funds, real and personal property, and other assets 
through board review and approval of claims, an annual audit of the district’s 
finances pursuant to the applicable Nebraska Department of Education and 
federal rules and regulations, and comparison of expenditures and outlays to 
budgeted amounts.  The District adequately safeguards all such property and 
assures that it is used solely for authorized purposes.  

E. Budget Control   

Actual expenditures or outlays will be compared with budgeted amounts for 
each federal award at least annually and more often as required by law or 
deemed prudent by the board or administrative staff. 

F. Payment Methods 
 
The District will comply with applicable methods and procedures for payment 
that minimize the time elapsing between the transfer of funds and 
disbursement by the District, in accordance with the Cash Management 
Improvement Act at 31 CFR Part 205.  Generally, the District receives 
payment from the Nebraska Department of Education on a reimbursement 
basis.  2 CFR § 200.305. However, if the District receives an advance in federal 
grant funds, the District will remit interest earned on the advanced payment 
quarterly to the federal agency.  The District may retain interest amounts up 
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to $500 per year for administrative expenses.  2 CFR § 200.305(b)(9). 
 
Consistent with state and federal requirements, the District will maintain 
source documentation supporting the federal expenditures (invoices, time 
sheets, payroll stubs, etc.) and will make such documentation available for 
the Nebraska Department of Education to review upon request.  

G. Allowability of Costs 
 
Expenditures must be aligned with approved budgeted items.  Any changes or 
variations from the state-approved budget and grant application need prior 
approval.   
 
When determining how the District will spend its grant funds, the 
Superintendent or his/her designee will review the proposed cost to determine 
whether it is an allowable use of federal grant funds before obligating and 
spending those funds on the proposed good or service.  All costs supported by 
federal education funds must meet the standards outlined in EDGAR, 2 CFR 
Part 3474 and 2 CFR Part.  The Superintendent or his/her designee must 
consider these factors when making an allowability determination. 

 
The Superintendent or his/her designee will consider Part 200’s cost guidelines 
when federal grant funds are expended.  The Superintendent or his/her 
designee will also consider whether all state - and District-level requirements 
and policies regarding expenditures have been followed. 

H. Use of Program Income – Deduction, Addition, or Cost Sharing or 
Matching 

The default method for the use of program income for the District is the 
deduction method.  2 C.F.R. § 200.307(e).  Under the deduction method, 
program income is deducted from total allowable costs to determine the net 
allowable costs.  Program income will only be used for current costs unless 
the District is otherwise directed by the federal awarding agency or pass-
through entity.  2 C.F.R. § 200.307(e)(1).  The District may also request prior 
approval from the federal awarding agency to use the addition method.  Under 
the addition method, program income may be added to the Federal award by 
the Federal agency and the non-Federal entity.  The program income must 
then be used for the purposes and under the conditions of the Federal award.  
2 C.F.R. § 200.307(e)(2). The District may also request prior approval from 
the federal awarding agency to use the cost sharing or matching method.         

While the deduction method is the default method, the District always refers 
to the grant award notice prior to determining the appropriate use of program 
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income.     

I. Cost Sharing or Matching 
 
For all Federal awards, any shared costs or matching funds and all 
contributions, including cash and third-party in-kind contributions, must be 
accepted as part of the non-Federal entity's cost sharing or matching when 
such contributions meet all of the following criteria:  
 
 

(1)  Are verifiable from the non-Federal entity's records;  
(2)  Are not included as contributions for any other Federal award;  
(3)  Are necessary and reasonable for accomplishment of project or 

program objectives;  
(4)  Are allowable under subpart E (Cost Principles) of this part;  
(5)  Are not paid by the Federal Government under another Federal 

award, except where the Federal statute authorizing a program 
specifically provides that Federal funds made available for such 
program can be applied to matching or cost sharing requirements 
of other Federal programs;  

(6)  Are provided for in the approved budget when required by the 
Federal awarding agency; and  

(7)  Conform to other provisions of this part, as applicable. 
 

J. Documentation of Personnel Expenses 
 
Records that reflect charges to federal awards for salaries and wages will 
comply with the rules and requirements of 2 CFR 200.430. 

VIII. Other Contract Matters. 

A. Required Terms 
 
The non-Federal entity's contracts must contain the applicable provisions 
required by section 200.326 and described in Appendix II to Part 200—
Contract Provisions for non-Federal Entity Contracts Under Federal Awards. 

B. Contracting with Certain Vendors 
 
Pursuant to the standards contained in 2 C.F.R.  § 200.321, the District will 
take all necessary affirmative steps to assure that minority businesses, 
women's business enterprises, and labor surplus area firms are used when 
possible consistent with state law. 
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To the maximum extent practicable, the school food program shall purchase 
domestic commodities or products produced in US or processed in US 
substantially using agricultural commodities produced in US. 

C. Record Keeping  

1. Record Retention 
 

a) The District maintains all records that fully show (1) 
the amount of funds under the grant or subgrant; (2) how 
the subgrantee uses those funds; (3) the total cost of each 
project; (4) the share of the total cost of each project 
provided from other sources; (5) other records to facilitate 
an effective audit; and (6) other records to show compliance 
with federal program requirements. 34 C.F.R. §§ 76.730-
.731 and §§ 75.730-.731.  The District also maintains 
records of significant project experiences and results.  34 
C.F.R. § 75.732.  These records and accounts must be 
retained and made available for programmatic or financial 
audit.   

 
b) The U.S. Department of Education is authorized to 
recover any federal funds misspent within 5 years before 
the receipt of a program determination letter.  34 C.F.R. § 
81.31(c).  Schedule 10 (Local School Districts) and Schedule 
24 (Local Agencies General Records) of the Nebraska 
Records Management Division as approved by the Nebraska 
Secretary of State/State Records Administrator requires the 
District to maintain records regarding federal awards for a 
minimum of six (6) years.  Consequently, the District shall 
retain records for a minimum of six (6) years from the date 
on which the final Financial Status Report is submitted, 
unless otherwise notified in writing to extend the retention 
period by the awarding agency, cognizant agency for audit, 
oversight agency for audit, or cognizant agency for indirect 
costs.  However, if any litigation, claim, or audit is started 
before the expiration of the record retention period, the 
records will be retained until all litigation, claims, or audit 
findings involving the records have been resolved and final 
action taken.  2 C.F.R. § 200.333. 

 
c) Records will be destroyed in compliance with Schedule 
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10, Schedule 24, and State law.  This includes the 
completion of a Records Disposition Report. 

2. Maintenance of Procurement Records  
 

a) The District must maintain records sufficient to detail 
the history of all procurements.  These records will include, 
but are not necessarily limited to the following: rationale for 
the method of procurement, selection of contract type, 
contractor selection or rejection, the basis for the contract 
price (including a cost or price analysis), and verification 
that the contractor is not suspended or debarred.   

 
b) Retention of procurement records shall be in 
accordance with applicable law and Board policy. 

D. Privacy 
 
The District has protections in place to ensure that the personal information 
of both students and employees is protected.  These include the use of 
passwords that are changed on a regular basis; staff training on the 
requirements of the Family Educational Rights and Privacy Act (FERPA) and 
State confidentiality requirements; and training on identifying whether an 
individual requesting access to records has the right to the documentation. 
  
 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
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3004.1 
Fiscal Management for Purchasing and Procurement Using Federal 

Funds 
 

I. Applicability of Policy 
 
This policy applies only to non-construction related purchases undertaken with 
federal funds which are subject to the federal Uniform Grant Guidance (UGG) 
and other applicable federal law, including but not limited to the Education 
Department and General Administration Regulations (EDGAR) and the United 
States Department of Agriculture (USDA) regulations governing school food 
service programs.  In the event this policy conflicts or is otherwise inconsistent 
with mandatory provisions of the UGG, EDGAR or other applicable federal law, 
the mandatory provisions of the laws shall control. 
 
All other non-construction purchases will be governed by the Board’s general 
purchasing policy, which can be found earlier in this subsection.  In the event 
of a conflict between state and federal law, the more stringent requirement 
shall apply. 
 
This procurement policy shall govern all purchasing activities that relate to 
any aspect of the National School Lunch and Breakfast Programs.  The 
district’s goal is to fully implement all required procurement rules, regulations 
and policies set forth in 2 CFR 200, 7 CFR parts 210, 3016 and 3019, and by 
the Nebraska Department of Education. 
 
II.   Procurement System  
 
The District maintains the following purchasing procedures. 
 

A. Responsibility for Purchasing 
 
The authority to make purchases shall be governed by the District’s 
purchasing policy, which can be found elsewhere in this section. Except as 
otherwise provided in the District’s purchasing policy, the acquisition of 
services, equipment, and supplies shall be centralized in the administration 
office under the supervision of the superintendent of schools, who shall be 
responsible for developing and administering the purchasing program of the 
school district.  Purchases or commitments of district funds that are not 
authorized by this policy will be the responsibility of the person making the 
commitment. 
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B. Methods of Purchasing 
 

The type of purchase procedures required depends on the cost of the item(s) 
being purchased.   
 

1. Purchases up to $10,000 (Micro-Purchases)  
 

Micro-purchase means a purchase of supplies or services using simplified 
acquisition procedures, the annual aggregate amount of which does not 
exceed $10,000.  Micro-purchases may be made or awarded without soliciting 
competitive quotations, to the extent district staff determine that the cost of 
the purchase is reasonable.  For purposes of this policy “reasonable” means 
the purchase is comparable to market prices for the geographic area.  

 
To the extent practicable, the District distributes micro-purchases equitably 
among qualified suppliers. The District will follow its standard policy on 
purchasing, which can be found earlier in this subsection.   
 

2. Purchases between $10,000 and $250,000 (Small 
Purchase Procedures)  

 
Small purchases are purchases that, in the aggregate amount, is more than 
$10,000 and less than $250,000 annually.  For small purchases, price or rate 
quotes shall be obtained in advance from a reasonable number of qualified 
sources as detailed in the district’s standard policies on purchasing and on bid 
letting and contracts, which can be found earlier in this subsection.  
 

3. Purchases Over $250,000 
 

a) Sealed Bids (Formal Advertising)         
 

For purchases over $250,000, the district will generally follow the bidding 
process outlined in the board’s policy on Bidding for Construction, Remodeling, 
Repair or Site Improvement.  
 

b) Contract/Price Analysis  
 

The District performs a cost or price analysis in connection with every 
procurement action in excess of $250,000, including contract modifications. 
The district will make an independent estimate of costs prior to receiving bids 
or proposals.    
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4. Noncompetitive Proposals (Sole Sourcing) 
 

a) Procurement by noncompetitive proposals is 
procurement through solicitation of a proposal from 
only one source and may be used only when one or 
more of the following circumstances apply: 

 
1) The item is available only from a single source; 

 
2) The public exigency or emergency for the 

requirement will not permit a delay resulting from 
competitive solicitation; 

 
3) The federal awarding agency or pass-through 

entity expressly authorizes noncompetitive 
proposals in response to a written request from the 
District; or 

 
4) After solicitation of a number of sources, 

competition is determined inadequate. 
 

b) Noncompetitive proposals may only be solicited with the 
approval of the superintendent or the board.  Sufficient 
and appropriate documentation that justifies the sole 
sourcing decision must be maintained by the 
superintendent or designee.  

 
c) A cost or price analysis will be performed for 

noncompetitive proposals when the price exceeds 
$250,000. 

  
5. Competitive Proposals.   

 
a) The technique of competitive proposals is normally 

conducted with more than one source submitting an 
offer, and either a fixed price or cost-reimbursement type 
contract is awarded. It is generally used when conditions 
are not appropriate for the use of sealed bids. If this 
method is used, the following requirements apply: 
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1) Requests for proposals must be publicized and 
identify all evaluation factors and their relative 
importance. Any response to publicized requests 
for proposals must be considered to the maximum 
extent practical; 

 
2) Proposals must be solicited from an adequate 

number of qualified sources; and 
 

3) Contracts must be awarded to the responsible firm 
whose proposal is most advantageous to the 
program, with price and other factors considered. 

 
b) The District may use competitive proposal procedures for 

qualifications-based procurement of 
architectural/engineering (A/E) professional services 
whereby competitors' qualifications are evaluated and 
the most qualified competitor is selected, subject to 
negotiation of fair and reasonable compensation. The 
method, where price is not used as a selection factor, can 
only be used in procurement of A/E professional services. 
It cannot be used to purchase other types of services 
though A/E firms are a potential source to perform the 
proposed effort. 

 
c) The District may select a proposal that offers the best 

value and that is based upon the proposer’s 
responsiveness to the proposal, experience, reputation, 
staff qualifications, ability and capacity to carry on the 
work, price, honesty, integrity, skills, business judgment, 
financial stability, past performance, and other relevant 
factors.  The evaluation may be conducted by the school 
board, a designated committee, or another designee of 
the school board. 

 
C. Use of Purchase (Debit & Credit) Cards 
 

District use of purchase cards is subject to the policy on purchase cards which 
can be found elsewhere in this subsection.  
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D. Federal Procurement System Standards 
 

The district’s procurement transactions will be conducted in a manner 
providing full and open competition consistent with 2 C.F.R §200.319. 

 
The District will maintain and follow general procurement standards consistent 
with 2 C.F.R.  §200.318.  
 

E. Debarment and Suspension   
 

The District awards contracts only to responsible contractors possessing the 
ability to perform successfully under the terms and conditions of a proposed 
procurement.  Consideration will be given to such matters as contractor 
integrity, compliance with public policy, record of past performance, and 
financial and technical resources.  

 
The District may not subcontract with or award subgrants to any person or 
company who is debarred or suspended.  For all contracts over $25,000 the 
District verifies that the vendor with whom the District intends to do business 
with is not excluded or disqualified.  2 C.F.R. Part 200, Appendix II(1) and 2 
C.F.R. §§ 180.220 and 180.300. 
   
The District will verify debarment or suspension by revising the excluded 
parties list on SAM.gov, collecting a certification through the bidding process, 
and/or by including a debarment and suspension provision in the bid and 
contract documents. The Superintendent or his/her designee shall be 
responsible for such verification. 
 

F. Settlements of Issues Arising Out of Procurements 
 
The District alone is responsible, in accordance with good administrative 
practice and sound business judgment, for the settlement of all contractual 
and administrative issues arising out of procurements.  These issues include, 
but are not limited to, source evaluation, protests, disputes, and claims.  
These standards do not relieve the District of any contractual responsibilities 
under its contracts.  Violations of law will be referred to the local, state, or 
federal authority having proper jurisdiction. 
 
III. Conflict of Interest and Code of Conduct  
 

A. Board and staff member conflicts of interest are governed by 
the district’s conflict of interest policies.   
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B. Purchases covered by this policy are subject to the following 
additional provisions. 

 
1. Employees, officers, and agents engaged in the selection, 

award, and/or administration of district contracts which are 
prohibited from engaging in such actions if a real or apparent 
conflict of interest is present.  

 
2. Such a conflict of interest would arise when the employee, 

officer, or agent, any member of his or her immediate family, 
his or her partner, or an organization which employs or is about 
to employ any of the parties indicated herein, has a financial or 
other interest in or a tangible personal benefit from a firm 
considered for a contract.  

 
3. The board may determine at its discretion that a financial 

interest is not substantial enough to give rise to a conflict of 
interest. 

 
C. Favors and Gifts 

 
The officers, employees, and agents of the District may neither solicit nor 
accept gratuities, favors, or anything of monetary value from contractors or 
parties to subcontracts, except that this provision does not prohibit the receipt 
of unsolicited items of nominal value.  For purposes of this policy, “nominal 
value” means a fair market value of $25 or less. 
 

D. Enforcement 
 
Disciplinary Actions including, but not limited to, counseling, oral reprimand, 
written reprimand, suspensions without pay, or termination of employment, 
will be applied for violations of such standards by officers, employees, or 
agents of the District. 
 
IV. Property Management Systems 
 

A. Property Classifications 
 

1. Equipment means tangible personal property (including 
information technology systems) having a useful life of more 
than one year and a per-unit acquisition cost which equals or 
exceeds the lesser of the capitalization level established by the 
District for financial statement purposes, or $5,000.  
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2. Supplies means all tangible personal property other than those 
described in §200.33 Equipment.  A computing device is a 
supply if the acquisition cost is less than the lesser of the 
capitalization level established by the District for financial 
statement purposes or $5,000, regardless of the length of its 
useful life.  2 C.F.R. §200.94.  

 
3. Computing Devices means machines used to acquire, store, 

analyze, process, and publish data and other information 
electronically, including accessories (or “peripherals”) for 
printing, transmitting and receiving, or storing electronic 
information.  2 C.F.R. §200.20.  

 
4. Capital Assets means tangible or intangible assets used in 

operations having a useful life of more than one year which are 
capitalized in accordance with GAAP.  Capital assets include:  

 
a) Land, buildings (facilities), equipment, and intellectual 

property (including software) whether acquired by 
purchase, construction, manufacture, lease-purchase, 
exchange, or through capital leases; and  

 
b) Additions, improvements, modifications, replacements, 

rearrangements, reinstallations, renovations or 
alterations to capital assets that materially increase their 
value or useful life (not ordinary repairs and 
maintenance).  2 C.F.R. §200.12.  

 
B. Inventory Procedure 
 

Newly purchased property shall be received and inspected by the staff 
member who ordered it to ensure that that it matches the purchase order, 
invoice, or contract and that it is in acceptable condition. 

 
Equipment, Computing Devices, and Capital Assets must be tagged with an 
identification number, manufacturer, model, name of individual who tagged 
the item, and date tagged). 
 

C. Inventory Records 
 

For equipment, computing devices, and capital assets purchased with federal 
funds, the following information is maintained in the property management 
system: 
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1. Serial number; 
2. District identification number; 
3. Manufacturer; 
4. Model; 
5. Date tagged and individual who tagged it; 
6. Source of funding for the property; 
7. Who holds title; 
8. Acquisition date and cost of the property;  
9. Percentage of federal participation in the project costs for the 

federal award under which the property was acquired;  
10. Location, use and condition of the property; and 
11. Any ultimate disposition data including the date of disposal and 

sale price of the property.   
 
The inventory list shall be adjusted by the superintendent of schools or his/her 
designee for property that is sold, lost, stolen, cannot be repaired, or that 
cannot be located. 
 

D. Physical Inventory 
 

1. A physical inventory of the property must be taken and the 
results reconciled with the property records at least once every 
two years.   

 
2. The Superintendent or his/her designee will ensure that the 

physical inventory is performed.  The physical inventory will 
generally occur during the months of June or July, but may be 
conducted during other time periods with the approval of the 
superintendent.  

 
E. Maintenance  

 
In accordance with 2 C.F.R. 313(d)(4), the District maintains adequate 
maintenance procedures to ensure that property is kept in good condition.  
 

F. Lost or Stolen Items 
 
The District maintains a control system that ensures adequate safeguards are 
in place to prevent loss, damage, or theft of the property.   
 

G. Use of Equipment 
 
Equipment must be used in the program or project for which it was acquired 
as long as needed, whether or not the project or program continues to be 
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supported by the federal award, and the District will not encumber the 
property for any non-federal program use without prior approval of the federal 
awarding agency and the pass-through entity.   
 

H. Disposal of Equipment 
 
When it is determined that original or replacement equipment acquired under 
a federal award is no longer needed for the original project or program or for 
other activities currently or previously supported by a federal awarding 
agency, the Superintendent or his/her designee will contact the awarding 
agency (or pass-through for a state-administered grant) for disposition 
instructions.   

 
If the item has a current FMV of $5,000 or less, it may be retained, sold, or 
otherwise disposed of with no further obligation to the federal awarding 
agency.  
 

I. Equipment and Capital Expenditures 
 
All equipment and capital expenditures shall comply with the rules and 
requirements of 2 CFR 200.439. 
 

J. Depreciation 
 
All depreciation shall comply with the rules and requirements of 2 CFR 
200.436. 
 
V. Financial Management 

 
A. Identification   

 
The District will identify, in its accounts, all federal awards received and 
expended and the federal programs under which they were received.  Federal 
program and award identification include, as applicable, the CFDA title and 
number, federal award identification number and year, name of the federal 
agency, and, if applicable, name of the pass-through entity. 
 

B. Financial Reporting  
 

The District will make an accurate, current, and complete disclosure of the 
financial results of each federal award or program in accordance with the 
financial reporting requirements set forth in the Education Department 
General Administrative Regulations (EDGAR).    
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C.  Accounting Records   
 

The District maintains records which adequately identify the source and 
application of funds provided for federally-assisted activities.  These records 
must contain information pertaining to grant or subgrant awards, 
authorizations, obligations, unobligated balances, assets, expenditures, 
income and interest and be supported by source documentation. 

 
D. Internal Controls   

 
The Superintendent or his/her designee must maintain effective control and 
accountability for all funds, real and personal property, and other assets 
through board review and approval of claims, an annual audit of the district’s 
finances pursuant to the applicable Nebraska Department of Education and 
federal rules and regulations, and comparison of expenditures and outlays to 
budgeted amounts.  The District adequately safeguards all such property and 
assures that it is used solely for authorized purposes.  
 

E. Budget Control   
 

Actual expenditures or outlays will be compared with budgeted amounts for 
each federal award at least annually and more often as required by law or 
deemed prudent by the board or administrative staff.   
 

F. Payment Methods 
 
The District will comply with applicable methods and procedures for payment 
that minimize the time elapsing between the transfer of funds and 
disbursement by the District, in accordance with the Cash Management 
Improvement Act at 31 CFR Part 205.  Generally, the District receives 
payment from the Nebraska Department of Education on a reimbursement 
basis.  2 CFR § 200.305. However, if the District receives an advance in federal 
grant funds, the District will remit interest earned on the advanced payment 
quarterly to the federal agency.  The District may retain interest amounts up 
to $500 per year for administrative expenses.  2 CFR § 200.305(b)(9). 
 
Consistent with state and federal requirements, the District will maintain 
source documentation supporting the federal expenditures (invoices, time 
sheets, payroll stubs, etc.) and will make such documentation available for 
the Nebraska Department of Education to review upon request.  
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G. Allowability of Costs 
 

Expenditures must be aligned with approved budgeted items.  Any changes or 
variations from the state-approved budget and grant application need prior 
approval.   
 
When determining how the District will spend its grant funds, the 
Superintendent or his/her designee will review the proposed cost to determine 
whether it is an allowable use of federal grant funds before obligating and 
spending those funds on the proposed good or service.  All costs supported by 
federal education funds must meet the standards outlined in EDGAR, 2 CFR 
Part 3474 and 2 CFR Part.  The Superintendent or his/her designee must 
consider these factors when making an allowability determination. 

 
The Superintendent or his/her designee will consider Part 200’s cost guidelines 
when federal grant funds are expended.  The Superintendent or his/her 
designee will also consider whether all state - and District-level requirements 
and policies regarding expenditures have been followed. 
 

H. Use of Program Income – Deduction, Addition, or Cost Sharing 
or Matching 

 
The default method for the use of program income for the District is the 
deduction method.  2 C.F.R. § 200.307(e).  Under the deduction method, 
program income is deducted from total allowable costs to determine the net 
allowable costs.  Program income will only be used for current costs unless 
the District is otherwise directed by the federal awarding agency or pass-
through entity.  2 C.F.R. § 200.307(e)(1).  The District may also request prior 
approval from the federal awarding agency to use the addition method.  Under 
the addition method, program income may be added to the Federal award by 
the Federal agency and the non-Federal entity.  The program income must 
then be used for the purposes and under the conditions of the Federal award.  
2 C.F.R. § 200.307(e)(2). The District may also request prior approval from 
the federal awarding agency to use the cost sharing or matching method.         
 
While the deduction method is the default method, the District always refers 
to the grant award notice prior to determining the appropriate use of program 
income.     
   

I. Cost Sharing or Matching 
 
For all Federal awards, any shared costs or matching funds and all 
contributions, including cash and third-party in-kind contributions, must be 
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accepted as part of the non-Federal entity's cost sharing or matching when 
such contributions meet all of the following criteria:  
 

(1)  Are verifiable from the non-Federal entity's records;  
(2)  Are not included as contributions for any other Federal award;  
(3)  Are necessary and reasonable for accomplishment of project or 

program objectives;  
(4)  Are allowable under subpart E (Cost Principles) of this part;  
(5)  Are not paid by the Federal Government under another Federal 

award, except where the Federal statute authorizing a program 
specifically provides that Federal funds made available for such 
program can be applied to matching or cost sharing requirements 
of other Federal programs;  

(6)  Are provided for in the approved budget when required by the 
Federal awarding agency; and  

(7)  Conform to other provisions of this part, as applicable. 
 

J. Documentation of Personnel Expenses 
 
Records that reflect charges to federal awards for salaries and wages will 
comply with the rules and requirements of 2 CFR 200.430. 
 
VI. Written Compensation Policies 
 

A. Time and Effort Standards 
 
All employees who are paid in full or in part with federal funds must keep 
specific documents to demonstrate the amount of time they spent on grant 
activities.  This includes an employee whose salary is paid with state or local 
funds but is used to meet a required “match” in a federal program.  These 
documents, known as time and effort records, are maintained in order to 
charge the costs of personnel compensation to federal grants.  Charges to 
federal awards for salaries and wages must be based on records that 
accurately reflect the work performed.  These records must:  
 

(1) Be supported by a system of internal controls which provides 
reasonable assurance that the charges are accurate, allowable, 
and properly allocated;  

(2) Be incorporated into official records;  
(3) Reasonably reflect total activity for which the employee is 

compensated, not exceeding 100% of compensated activities;  
(4) Encompass both federally assisted and all other activities 

compensated by the District on an integrated basis;  
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(5) Comply with the established accounting policies and practices of 
the District and  

(6) Support the distribution of the employee’s salary or wages among 
specific activities or costs objectives. 

 
B. Time and Effort Procedures 

 
Time and effort procedures will follow and comply with 2 CFR 200.430(i). 
 

C. Fringe Benefits 
 
Except as provided otherwise by federal law, the costs of fringe benefits will 
be allowable provided that the benefits are reasonable and required by law, a 
district-employee agreement, or another policy of the District. 
 

D. Leave   
 
The cost of fringe benefits in the form of regular compensation paid to 
employees during periods of authorized absences from the job, such as for 
annual leave, family-related leave, sick leave, holidays, court leave, military 
leave, administrative leave, and other similar benefits, are allowable if they 
are provided under established written District leave policies. 
 

E. Unexpected or Extraordinary Circumstances 
 
In the event of a pandemic or other unexpected or extraordinary 
circumstance, the District may close school or individual buildings.  In such 
case, the District may compensate federally funded or other employees during 
such closure to ensure the return of staff to employment after the closure as 
allowed by state or federal law.  
 

F. Documentation for Personnel Expenses 
 
Records that reflect charges to federal awards for salaries and wages will 
comply with the rules and requirements of 2 CFR 200.430. 

 
VII. Other Contract Matters. 
 

A. Required Terms 
 
The non-Federal entity's contracts must contain the applicable provisions 
required by section 200.326 and described in Appendix II to Part 200—
Contract Provisions for non-Federal Entity Contracts Under Federal Awards. 
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B. Contracting with Certain Vendors 
 
Pursuant to the standards contained in 2 C.F.R.  § 200.321, the District will 
take all necessary affirmative steps to assure that minority businesses, 
women's business enterprises, and labor surplus area firms are used when 
possible consistent with state law. 
 
 
Buy American.  The District participates in the National School Lunch 
Program and School Breakfast Program and is required to use the nonprofit 
food service funds, to the maximum extent practicable, to buy domestic 
commodities or products for Program meals.  A “domestic commodity or 
product” is defined as one that is either produced in the U.S. or is processed 
in the U.S. substantially using agricultural commodities that are produced in 
the U.S. as provided in 7 CFR 210.21(d). 
The District may deviate from this general requirement only if: 

• The product is not produced or manufactured in the U.S. in sufficient 
and reasonably available quantities of a satisfactory quality; or 

• Competitive bids reveal the costs of a U.S. product are significantly 
higher than the non-domestic product. 

 
 
 

C. Record Keeping  
 

1. Record Retention 
 

a) The District maintains all records that fully show (1) the 
amount of funds under the grant or subgrant; (2) how 
the subgrantee uses those funds; (3) the total cost of 
each project; (4) the share of the total cost of each 
project provided from other sources; (5) other records to 
facilitate an effective audit; and (6) other records to show 
compliance with federal program requirements. 34 C.F.R. 
§§ 76.730-.731 and §§ 75.730-.731.  The District also 
maintains records of significant project experiences and 
results.  34 C.F.R. § 75.732.  These records and accounts 
must be retained and made available for programmatic 
or financial audit.   

 
b) The U.S. Department of Education is authorized to 

recover any federal funds misspent within 5 years before 
the receipt of a program determination letter.  34 C.F.R. 
§ 81.31(c).  Schedule 10 (Local School Districts) and 
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Schedule 24 (Local Agencies General Records) of the 
Nebraska Records Management Division as approved by 
the Nebraska Secretary of State/State Records 
Administrator requires the District to maintain records 
regarding federal awards for a minimum of six (6) years.  
Consequently, the District shall retain records for a 
minimum of six (6) years from the date on which the final 
Financial Status Report is submitted, unless otherwise 
notified in writing to extend the retention period by the 
awarding agency, cognizant agency for audit, oversight 
agency for audit, or cognizant agency for indirect costs.  
However, if any litigation, claim, or audit is started before 
the expiration of the record retention period, the records 
will be retained until all litigation, claims, or audit findings 
involving the records have been resolved and final action 
taken.  2 C.F.R. § 200.333. 

 
c) Records will be destroyed in compliance with Schedule 

10, Schedule 24, and State law.  This includes the 
completion of a Records Disposition Report. 

 
2. Maintenance of Procurement Records  

 
a) The District must maintain records sufficient to detail the 

history of all procurements.  These records will include, 
but are not necessarily limited to the following: rationale 
for the method of procurement, selection of contract 
type, contractor selection or rejection, the basis for the 
contract price (including a cost or price analysis), and 
verification that the contractor is not suspended or 
debarred.   

 
b) Retention of procurement records shall be in accordance 

with applicable law and Board policy. 
 

D. Privacy 
 
The District has protections in place to ensure that the personal information 
of both students and employees is protected.  These include the use of 
passwords that are changed on a regular basis; staff training on the 
requirements of the Family Educational Rights and Privacy Act (FERPA) and 
State confidentiality requirements; and training on identifying whether an 
individual requesting access to records has the right to the documentation. 
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Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
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3033 
Lending Textbooks to Children Enrolled in Private Schools 

 
Through June 30, 2024, the school district shall make textbooks available to 
private school children who reside within the district or are otherwise entitled 
to borrow them pursuant to statute and 92 Nebraska Administrative Code, 
section 4.  The district is obligated to purchase and lend textbooks only to the 
extent that the Legislature appropriates funds to the Nebraska Department of 
Education to be distributed for this purpose.  As used in this policy, “textbooks” 
shall have the definition adopted by the Nebraska State Board of Education in 
Rule 4.   
 
The district shall make a request for funds by filing an application on the form 
prescribed by the Department of Education no later than February 15th prior 
to the school year for which the application is made. The application shall 
include: the number of applications received; the number of textbooks 
requested; the number of textbooks needed to be purchased to fill the 
requests; the purchase price of the textbooks needed to be purchased which 
may include up to 5% of the cost to defray administrative expense; the title, 
purchase price, and number requested of each textbook including any shipping 
or handling charges; and if applicable the amount of carryover funds 
remaining from the previous year, amount of funds on hand from sale of 
unused textbooks, and amount of funds on hand from reimbursements for 
damaged textbook.  
 
Textbooks which have not been requested for three consecutive years may be 
classified as unused and disposed of by sale or otherwise.  
 
On or before November 15th, the district shall prepare a list of textbooks that 
are designated for use in the district during the current year and a list of new 
textbooks designated for use the following school year.  The lists shall be kept 
current and in a place where they may be viewed during regular business 
hours. The district shall maintain a separate inventory of textbooks purchased 
for the use of private school children residing in the district.  
 
Any parent or legal guardian who wishes to borrow textbooks shall submit an 
application on the form prescribed by the Department of Education to the 
district’s administration offices on or before January 15th prior to the school 
year for which the application is made. The district shall maintain a supply of 
blank application forms and receipt forms.  It shall keep the forms that have 
been signed by parents and guardians in a separate file for at least 5 years. 
It shall notify the parents and guardians at least 10 days prior to the start of 
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school when and where the textbooks will be available.  It shall make 
textbooks available to parents or guardians on or before August 15th.  If the 
number of textbooks for a particular subject or grade level is insufficient to fill 
all of the requests, the textbooks shall be distributed to parents and guardians 
based on a random drawing. 
 
Parents and guardians shall sign a receipt on the form prescribed by the 
Department of Education when they pick up the textbooks and shall return 
the textbooks that can be returned no later than 15 days after the district’s 
last day of class.  The district shall assess the returned textbooks for damage 
beyond normal wear and tear.  The parent or guardian who signed the receipt 
is responsible for paying the reasonable cost of the repair or replacement of 
any book that is damaged, lost, stolen, or not returned. 
 
The school district shall limit the loan each year to ten textbooks per student 
for students in grades K-6 and to eight textbooks per student for students in 
grades 7-12. 
 
This policy shall terminate July 1, 2024. 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
 



4003 
Drug Policy Regarding Drivers 

 
Policy Statement.  Drivers for the school district must be free from 
drug and alcohol abuse, and the use of illegal drugs or improper use of 
alcohol is prohibited.  The overall goal of drug and alcohol testing is to 
insure a drug-free and alcohol-free transportation environment, and to 
reduce accidents, injuries and fatalities. 
 
Designated Contact.  The school district has designated the 
transportation director as the individual any driver may contact with 
questions about this policy or the school district’s drug testing program 
and procedures for drivers.  This individual further maintains and will 
provide drivers informational materials concerning the effects of 
alcohol and controlled substances use on an individual’s health, work, 
and personal life; signs and symptoms of an alcohol or a controlled 
substances problem (the driver’s or a co-worker’s); and available 
methods of intervening when an alcohol or controlled substances 
problem is suspected, including confrontation, referral to any 
employee assistance program and/or referral to management.   
 
Transportation Director may be contacted at (402) 643-6069 
 
Covered Drivers.  Any person who operates a commercial motor 
vehicle on behalf of the school district is covered by this policy and the 
school district’s drug testing program and procedures for drivers.  All 
covered drivers must provide the school district a signed statement 
certifying that he or she has received a copy of this policy and related 
materials. 
 
Covered Workday.  A driver is required to comply with this policy 
and the terms of the school district’s drug testing program and 
procedures for drivers at all times they are assigned, or may be 
assigned, to perform safety-sensitive functions.  This includes all time 
from the time a driver begins to work or is required to be in readiness 
to work until the time he/she is relieved from work and all 
responsibility for performing work.  Safety-sensitive functions include: 
(1) all time at a school district facility or property, contractor facility or 
property, or on any public property, waiting to be dispatched, unless 
the driver has been relieved from duty by the school district; (2) all 
time inspecting equipment as required by state or federal law or 
regulation and any and all other time inspecting, servicing, or 
conditioning any commercial motor vehicle; (3) all time spent at the 
driving controls of a commercial motor vehicle in operation; (4) all 



time, other than driving time, in or upon any commercial motor 
vehicle; (5) all time loading or unloading a vehicle, supervising, or 
assisting in the loading or unloading, attending a vehicle being loaded 
or unloaded, remaining in readiness to operate the vehicle, or in giving 
or receiving receipts for shipments loaded or unloaded; and (6) all 
time repairing, obtaining assistance, or remaining in attendance upon 
a disabled vehicle. 
 
Prohibited Conduct.  No driver shall: (1) report for duty or remain 
on duty requiring the performance of safety-sensitive functions while 
having an alcohol concentration of 0.04 or greater; (2) use alcohol 
while performing safety-sensitive functions; (3) perform safety-
sensitive functions within four hours after using alcohol; or (4) refuse 
to submit to a pre-employment controlled substance, a post-accident 
alcohol or controlled substance test, a random alcohol or controlled 
substances test, a reasonable suspicion alcohol or controlled substance 
test, a return-to-duty alcohol or controlled substances test, or a 
follow-up alcohol or controlled substance test required under state or 
federal law or this policy.  No driver required to take a post-accident 
alcohol test shall use alcohol for eight hours following the accident, or 
until he/she undergoes a post-accident alcohol test, whichever occurs 
first.   
 
No driver shall: (1) report for duty or remain on duty requiring the 
performance of safety sensitive functions when the driver uses any 
drug or substance identified in 31 CFR 1308.11 Schedule 1; (2) report 
for duty or remain on duty requiring the performance of safety-
sensitive functions when the driver uses any non-Schedule I drug or 
substance that is identified in the other Schedules in 21 CFR part 1308 
except when the use is pursuant to the instructions of a licensed 
medical practitioner who is familiar with the driver's medical history 
and has advised the driver that the substance will not adversely affect 
the driver's ability to safely operate a commercial motor vehicle; or (3) 
report for duty, remain on duty or perform a safety-sensitive function, 
if the driver tests positive or has adulterated or substituted a test 
specimen for controlled substances. 
 
Types of Testing.  Pursuant to regulations promulgated by the 
Department of Transportation (DOT), the district has implemented four 
types of testing: (1) pre-employment testing, (2) reasonable cause 
testing, (3) post-accident testing and (4) random testing. 
 
Refusal to Submit to Testing.  A driver shall not refuse to submit to 
testing.  A driver will be considered to have refused to submit to 



testing if the driver fails to provide a sample or specimen necessary for 
testing upon a lawful request, consistent with the required testing 
protocols.  The refusal to submit to the testing used by the district will 
be grounds for refusal to hire driver applicants and to terminate the 
employment of existing drivers.   
 
Consequences for Violations.  Any driver who becomes unqualified 
on the basis of violation of the terms of this policy will be subject to 
disciplinary action which may include termination of the driver’s 
employment, and shall include the immediate removal from safety-
sensitive functions in compliance with federal law.  No driver tested 
pursuant to this policy and the school district’s drug testing program 
and procedures who is found to have an alcohol concentration of 0.02 
or greater but less than 0.04 shall perform or continue to perform 
safety-sensitive functions until the start of the driver’s next regularly 
scheduled duty period, but not less than 24 hours following 
administration of the test. 
 
Return to Duty Process.  A driver who has violated this policy or the 
school district drug testing program and procedures cannot again 
perform any safety-sensitive functions until and unless the employee 
completes the return-to-duty process, including the substance-abuse 
professional’s (SAP) evaluation, referral, and recommended education 
or treatment.  The school district will provide employees the relevant 
contact information for available and acceptable SAPs as necessary, 
but the school district is not required under the law to provide a SAP 
evaluation or any subsequent recommended education or treatment 
for a driver.  Any driver completing the return-to-duty process must 
complete a return-to-duty test and test negatively.  
 
Disqualification.  Any applicant who tests positive for the presence of 
the following drugs is medically unqualified to drive and will not be 
considered for the position of driver: (1) marijuana, (2) cocaine, (3) 
opiates, (4) amphetamines, or (5) phencyclidine (PCP).  Any district 
driver who tests positive shall be medically unqualified and removed 
from service immediately. 
 
Pre-employment Testing.  All applicants for employment must 
submit to drug and alcohol tests as a condition of being considered for 
employment. 
 
Reasonable Cause Testing.  The district shall have reasonable cause 
to require a driver to submit to drug testing when a driver manifests 



physical or physiological symptoms or reactions commonly attributed 
to the use of controlled substances or alcohol.  
 
Post-Accident Testing.  A driver who has been involved in a 
reportable accident must submit to drug and alcohol testing as soon as 
possible.  A reportable accident includes any accident in which there is 
a fatality, a person is injured and must be treated away from the 
accident site, the driver receives a citation for a moving violation, or a 
vehicle is towed from the scene.  The driver must notify the district 
immediately regarding any reportable accident.  
 
Serious Injury to the Driver.  If a driver is so seriously injured that 
he or she cannot submit to testing at or immediately after the time of 
the accident, the driver must provide the necessary authorization for 
the district to obtain hospital reports or other documents that would 
indicate whether there were controlled substances or alcohol in the 
driver's system. 
 
Random Testing.  All drivers will be subject to unannounced random 
testing for drugs and alcohol.  The district or its agents will periodically 
select drivers at random for testing.  A district official will notify a 
driver when his or her name has been selected and will instruct the 
driver to report immediately for testing.  By its very nature, random 
selection may result in one driver being tested more than once in a 
12-month period, while another driver may not be selected at all 
during the same 12 months. 
 
Frequency of Random Testing.  Under DOT regulations, the district 
must test at least 50 percent of its average number of driver positions 
for drugs and 25 percent of its average number of driver positions for 
alcohol each year.  The tests must be unannounced and spread evenly 
throughout the year.  DOT regulations also require that every driver 
selected at random must have his or her name placed back in the 
random pool for the next selection period. 
 
Testing Procedure.  All urine and blood specimens collected under 
the policy will be submitted to an approved laboratory for testing.  
Specimens that initially test positive for drugs will be subjected to a 
subsequent confirmation test before being reported by the laboratory 
as positive.  All such specimens collected and submitted will be 
maintained securely to safeguard the validity of the test results and 
maintain the integrity of the testing process while ensuring the results 
are attributed to the correct driver.  
 



Medical Review Officer.  All laboratory test results will be reported 
by the laboratory to a medical review officer (MRO) designated by the 
district.  Negative test results will be reported as such by the MRO to 
the district.  Before reporting a positive test result to the district, the 
MRO will attempt to contact the driver to discuss the test result.  If the 
MRO is unable to contact the driver directly, the MRO will contact a 
district official designated in advance by the district, who shall in turn 
contact the driver and direct the driver to contact the MRO.  Upon 
being so directed, the driver shall contact the MRO immediately or, if 
after the MRO's business hours and the MRO is unavailable, at the 
start of the MRO's next business day.  If required by DOT regulations, 
personal information collected and maintained pursuant to this policy 
shall be reported to the Clearinghouse by the MRO in the event of: (1) 
a verified positive, adulterated, or substituted drug test result; (2) an 
alcohol confirmation test with a concentration of 0.04 or higher; (3) a 
refusal to submit to any test required by this policy and the school 
district’s drug testing program and procedures; (4) an employer’s 
report of actual knowledge that a driver has used alcohol or controlled 
substances based on the employer's direct observation of the 
employee, information provided by the driver's previous employer(s), 
a traffic citation for driving a CMV while under the influence of alcohol 
or controlled substances or an employee's admission of alcohol or 
controlled substance use; (5) on duty alcohol use as prohibited above; 
(6) pre-duty alcohol use as prohibited above; (7) alcohol use following 
an accident as prohibited above; (8) controlled substance use as 
prohibited above; (9) a substance abuse professional report of the 
successful completion of the return-to-duty process; (10) a negative 
return-to-duty test; and (11) an employer’s report of completion of 
follow-up testing.  
 
Confidentiality.  Pursuant to DOT regulations, individual test results 
for applicants and drivers will be released to the district and will be 
kept confidential unless the tested individual consents to their release 
or release is required by law (such as the release of information to the 
Clearinghouse.)  Any person who has submitted to drug testing in 
compliance with this policy is entitled to receive the results of such 
testing upon timely written request.   
 
Retesting.  An individual who tested positive for the presence of 
drugs may request that the original sample be retested.  The request 
for a retest must be submitted in writing on a form provided by the 
district within 3 working days of the district’s notification to the 
individual that he or she has a positive test result.  The individual 
making the request must pay all costs associated with the retest and 



transfer of the sample to another laboratory before the retest will be 
performed. 
 
 
Adopted on: June 14, 2010 
Revised on: August 10, 2020 
Reviewed on: ______________ 
 



4045 
Milk Expression 

 
 Except as otherwise provided by law, tThe district will provide 
reasonable break time for an employee who wishes to breastfeed or express 
breast milk for her nursing child each time such employee has the need to do 
so.  The District will provide in a place, other than a bathroom, which is 
shielded from view and free from intrusion from co-workers and the public for 
one year after the child’s birth.  These accommodations will be provided for 
one year after the child’s birth, unless otherwise required by law. 
 
Adopted on: _______________ 
Revised on: _______________ 
Reviewed on: ______________ 
 
 



4059 
Suicide PreventionBehavioral and Mental Health Training  

 
All public school employees who interact with students and any other 
appropriate personnel are required to complete at least one hour of behavioral 
and mental health training with a focus on suicide awareness and prevention 
training every year.  The superintendent will determine the appropriate 
personnel required to receive the training.:  The training materials for this 
training must be included in the Nebraska Department of Education’s list of 
approved training materials.   
school nurses 
teachers 
counselors 
school psychologists 
administrators 
school social workers 
community coaches  
paraeducators 
bus drivers 
kitchen staff 
custodians  
secretarial and clerical staff  

 
These employees must complete the online training designated by the school 
district or superintendent provided by the Nebraska Department of Education 
no later than October 31 of each school year or within 30 days of their initial 
employment, whichever is later.  Failure to complete this training shall 
constitute just cause for the termination or nonrenewal of anmay subject the 
employee to employment-related discipline employee’s contract.   
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
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5003 
Admission of Part-Time Students  

 
A student may be permitted to enroll on a part-time basis pursuant to this 
policy and applicable curricular practices when enrollment is appropriate for 
reasons that include but are not limited to the following: the student attends 
another education institution on a part-time basis; is enrolled for a limited 
number of credit hours needed to graduate; has a modified schedule because 
of a disability or as part of an individualized education plan; or is a student 
who resides in the school district but attends a private, denominational, or 
parochial school or a school that elects not to meet accreditation or approval 
requirements (referred to herein as an exempt school student or an exempt 
school, respectively).  
 
Application for Enrollment.  The parent or guardian of an exempt school 
student who is of appropriate age to attend school, resides inis a resident of 
the school district, has not graduated from high school, and has not received 
a graduate equivalency diploma must meet all of the district’s admission 
requirements and file an application for enrollment on forms provided by the 
school district by ____August 1_________ of the year of enrollment.  For 
second semester high school courses, the application must be filed by 
______December 1_______.  For students who move into the district mid-
semester, the application must be filed within 20 days of moving into the 
district.  The administration shall review the application, determine whether 
to approve or deny it, notify the parent or guardian, and schedule enrollment 
at an educationally appropriate time in the building or attendance center of 
the administration’s choice.  Enrollment does not carry over from one school 
year to the next, and the parent or guardian of an exempt school student must 
apply for enrollment each school year. 
 
Limitations Based on Resources.  The enrollment of exempt school 
students is subject to limitations established by the district for grades, classes, 
courses, and programs based on the limited resources available to the school 
district.  Full-time students shall be given priority for enrollment in grades, 
classes, courses, and programs. 
 
Placement of Students.  Exempt school students shall be placed in courses 
for which they have adequate preparation and which are determined to be 
educationally appropriate based on criteria that include, but are not limited to 
the student’s age, achievement test scores, academic record, evaluation by 
school personnel and any other standards used by the district for the 
placement of students. 
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Grades and Academic Honors.  Exempt school students shall receive 
grades, report cards, and transcripts, but shall not be eligible to graduate, 
receive a diploma or qualify for class ranking unless they meet all district 
requirements for such including earning a sufficient number of credit hours 
and semesters of attendance. 
 
Applicability of School Rules.  Exempt school students are subject to all 
rules and standards of the board of education and administration as set forth 
in policy, handbooks or other communications, as well as the rules and 
directives of the building administration and teaching personnel.  They must 
remain on the school campus during scheduled classes but must leave the 
school campus when not engaged in a course or course-related activity unless 
the course or course-activity requires their presence or the building principal 
approves their presence.  Students who violate school policies, rules, or 
directives shall be subject to disciplinary procedures up to and including 
suspension and expulsion. 
 
Extracurricular Sports and Activities.  Students who are enrolled in a 
private, denominational or parochial school may not participate in 
extracurricular sports and activities sponsored by the public school district if 
they participate in extracurricular sports and activities offered by the private, 
denominational or parochial school.  Exempt school students may participate 
in extracurricular sports and activities if they are enrolled in at least 20 credit 
hours per semester, with at least 10 5 credit hours per semesterof enrollment 
in the public school district.  Exempt school students who are not enrolled in 
at least 10-credit hours may not participate in extracurricular sports and 
activities.  All part-time students must also meet all other eligibility 
requirements set by the board, administration and coach/sponsor prior to 
participating and for continued participation in the sport or activity. This 
includes all eligibility and other requirements of the Nebraska School Activities 
Association and any other governing bodies for the activity. 
 
Exempt school students who transfer into the district will be considered a 
transfer student and shall be ineligible for varsity competition for ninety school 
days unless the home school is located in the same school district as the high 
school to which the student is transferring.   
 
The school district will determine whether credits awarded to exempt transfer 
students will be accepted for the purpose of eligibility for extracurricular sports 
and activities pursuant to the board’s policy on Grade Placement and Academic 
Credits of Transfer Students. 
 
Transportation. Part-time school students are not entitled to transportation 
or reimbursement for transportation to and from the school for class 
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attendance purposes, unless required by law. by virtue of their status as part-
time students.Eligible part-time students are entitled to transportation to and 
from practices and extracurricular events to the same extent as the school 
district’s full-time students, but part-time students must arrange their own 
transportation and arrive timely to the designated pick-up point for such 
transportation. 
 
Option Enrollment.  Students may not enroll on a part-time basis pursuant 
to the school’s option enrollment program.  
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
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5004 
Option Enrollment 

  
The board of education supports the concept embodied in the Enrollment 

Option Program that parents and legal guardians have the primary 
responsibility for insuring that their children receive the best education 
possible.  Accordingly, the school district will participate in the option 
enrollment program and receive option students as provided herein.  
  
1. Definitions 
 

a. Option Student Defined.  Option student shall mean a 
nonresident student who has chosen to attend the school district 
under the provisions of the option enrollment program. 

 
b. Resident School District Defined.  Resident school district shall 

mean the school district in which a student resides or in which the 
student is admitted as a resident of the school district pursuant to 
state law.  

 
c. Option School District Defined.  Option school district shall 

mean the school district that a student chooses to attend other 
than his or her resident school district.   

 
2. Persons Entitled to Apply for Option Enrollment of Students.  Only 

parents and legal guardians may apply for option enrollment of 
students.  Applications filed by foster parents and adults acting in loco 
parentis are not authorized and will be automatically denied.  
 

3. Duties, Entitlements and Rights of Option Students.  Except as 
otherwise provided herein, once an option student’s option enrollment 
application has been accepted he/she shall be treated as a resident 
student of the school district.   

  
4. Standards for Acceptance or Rejection of Option Students.   
 

a. Special Education Capacity.  Capacity for special education 
services will be determined on a case-by-case basis.  If an 
application for option enrollment received by the school district 
indicates that the student has an individualized education program 
under the  federal Individuals with Disabilities Education Act, 20 
U.S.C. 1400 et seq., or has been diagnosed with a disability as 
defined in section 79-1118.01, the application will be evaluated 
by the director of special education services or the director's 
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designee who must determine if the school district and the 
appropriate class, grade level, or school building has the capacity 
to provide the applicant the appropriate services and 
accommodations.  The Federal Educational Rights and Privacy 
Rights Act (FERPA) (20 U.S.C. § 1232g) permits the release of 
education records when a student seeks or intends to enroll in a 
different school district.   
 

a.b. Numeric Capacity.  The board of education may set the numeric 
capacity of programs, classes, grade levels, or school buildings by 
operation of this policy or through freestanding action by the 
board.  Numeric Capacity will be determined based upon available 
staff, facilities, projected enrollment of resident students, and 
projected number of students with which the option school district 
will contract based on existing contractual arrangements, and 
availability of appropriate special education programs. Individuals 
seeking information about the numeric capacity set by the board 
may contact the superintendent for a copy of that resolution.   
 

b.c. Programmatic Capacity.   In addition to the numeric capacity 
standards referred to above, the board may, by resolution, prior 
to October 15 of each school year, declare a program, a class, or 
a school unavailable for the next school year to option students 
due to lack of capacity.  Individuals seeking information about the 
programs that have been declared to be unavailable due to lack 
of capacity may contact the superintendent for a copy of the 
board’s resolution.   

 
c.d. Other Standards for Acceptance or Rejection of Option 

Enrollment Applications.   In addition to the numeric and 
programmatic capacity standards outlined above, the school 
district shall not accept an option student when acceptance of the 
student:  
 
i. Would increase the operating costs of the school district, 

such as by requiring the hiring of new staff or contracting 
with outside entities to provide services to the student;  

ii. Would require the procurement of new equipment, 
technology, or furnishings;  

iii. Would cause or require the rearrangement of caseloads for 
staff and contracted professionals;  

iv. Is reasonably deemed by appropriate school staff to pose a 
potential risk to the health or safety of students or staff; 
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v. May pose a risk of adversely affecting the quality of 
educational services being provided to resident students, as 
determined by appropriate school staff.   

 
d. The school district shall accept an option student with a disability 

only to the extent that the school district's then current staff and 
facilities are sufficient to accommodate the student’s needs 
without significantly increasing the operating costs of the school 
district, such as by requiring the hiring of new staff.  

 
e. Prohibited Standards.  The school district shall not base the 

decision to accept or reject an option student on the student's 
previous academic achievement, athletic or other extracurricular 
ability, disabling condition(s), proficiency in the English language, 
or previous disciplinary proceedings. 

 
f. Order of Acceptance.  If there are more option student 

applicants for any program, class, grade level or school building 
than can be accepted into such program, class, grade level or 
school building, applicants shall be accepted in the following 
order:   

 
i. students with brothers or sisters attending the school 

district, either as resident students or as option students, 
shall be granted first priority;  

 
ii. thereafter, option students shall be accepted into such 

program, class, grade level or school building in the order in 
which written applications were received by the school 
district. 

 
g.  Maximum Capacity Report.  The school district will annually 
establish, publish, and report the capacity for each school building 
under the district's control pursuant to procedures, criteria, and 
deadlines established by the Nebraska Department of Education. 

 
5. False or Misleading Option Applications.  If, prior to the student’s 

attendance as an option student, the school district discovers that a 
previously accepted option application contained false or substantively 
misleading information, the option application will be rejected. 

 
 
6. Academic Credits and Graduation.  The school district shall accept 

credits toward graduation that were awarded by another school district, 
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and shall award a diploma to an option student if the student meets the 
graduation requirements of the school district.   

 
7. Information Regarding Schools, Programs, Policies and 

Procedures.  The school district, its officers and employees, shall make 
information about the school district and its schools, programs, policies 
and procedures available to all interested people. 

 
8. Procedure for Students Optioning Into or Out of the School 

District.  
 

a. The parent or legal guardian of any student desiring to option into 
or out of the school district shall submit a proper and timely 
application to the board of education and the other affected school 
district for enrollment during the following and subsequent school 
years.  Any application requiring the approval of the school district 
shall be deemed submitted when the application is actually 
received in the school district's business office. 

 
b. On or before April 1st, the school district shall notify the parent or 

legal guardian of any student who has submitted an application to 
option into the school district and the resident school district, in 
writing, whether the application is accepted or rejected.  If an 
application is rejected, the reason for such rejection shall be 
stated in the notification.  This written notice shall be sent via 
certified mail to the address listed on the option application.  

 
9. Late Applications and Requests for Release  
 

a. The board of education may refuse a request of a student seeking 
to option out of the school district when the option application is 
submitted after March 15th under the following conditions: 
 
i. When the district has already entered into contracts with 

teaching staff for the following school year; 
 

ii. When the district has already contracted for the 
performance of specific services for the student; 
 

iii. When the release of the student would have a negative 
financial impact or loss of revenue for the district. 

 
b. The board of education will approve late applications to option into 

the district under the following conditions: 
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i. When the resident district has released the student; 

 
ii. When the student’s late enrollment into the district meets 

the standards for acceptance or rejection of option students 
contained elsewhere in this policy; 
 
OR 
 

b. The board of education will deny all applications to option into the 
district that are received by the district after March 15 of the 
school year prior to the student’s requested enrollment.   

 
 
c. The superintendent will notify parents or guardians who have 

submitted properly completed option applications after March 15th 
no later than 60 days following submission of the application of 
the board’s acceptance or rejection of the application.     

   
10. Students Who Do Not Need a Release from the Resident District  

 
a. A student does not need to be released from his/her resident 

district under the following circumstances: 
i. When the student has relocated to a different resident 

school district after February 1 
ii. When a student's option school district merges with another 

district effective after February 1 
 

b. The school district shall accept or reject an application from a 
student under this paragraph using the criteria set forth in this 
policy and will accept or reject the application within forty-five 
days. 
 

11. Cancellation of Option.   
 
Students who option either into or out of the school district shall:   
 

a. Attend the option school district until graduation or relocation/re-
option in a different resident school district unless the student 
chooses to return to the resident school district, in which case the 
student's parent or legal guardian shall timely submit a 
cancellation form to the school board or board of education of the 
option school district and the resident school district for approval 
for the following year.   
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b. Attend an option school district for not less than one school year 

unless the student relocates to a different resident school district, 
completes requirements for graduation prior to the end the school 
year, transfers to a parochial or private school, or upon mutual 
agreement of the resident and option school districts cancels the 
enrollment option and returns to the resident school district. 

 
12. Authority of Superintendent.   
 
The board of education authorizes the superintendent of schools to make 
decisions on its behalf pursuant to and to apply the criteria articulated by this 
policy in determining whether to grant or deny option enrollment applications. 

 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
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5035 
Student Discipline 

 
Administrative and teaching personnel may take actions regarding student 
behavior, other than those specifically provided in this policy and the Student 
Discipline Act, which are reasonably necessary to aid the student, further 
school purposes, or prevent interference with the educational process. Such 
actions may include, but need not be limited to, counseling of students, parent 
conferences, referral to restorative justice practices or services, 
rearrangement of schedules, requirements that a student remain in school 
after regular hours to do additional work, restriction of extracurricular activity, 
or requirements that a student receive counseling, psychological evaluation, 
or psychiatric evaluation upon the written consent of a parent or guardian to 
such counseling or evaluation.  Disciplinary consequences may also include in-
school suspension, Saturday School, and any other consequence authorized 
by law.  District administrators may develop building-specific protocols for the 
imposition of student discipline.   
 
In this policy, references to "Principal" shall include building principals, the 
principal's designee, or other appropriate school district administrators.   
 
Any statement, notice, recommendation, determination, or similar action 
specified in this policy shall be effectively given at the time written evidence 
thereof is delivered personally to or upon receipt of certified or registered mail 
or upon actual knowledge by a student or his or her parent or guardian. 
 
Any student who is suspended or expelled from school pursuant to this policy 
may not participate in any school activity during the duration of that exclusion 
including adjacent school holidays and weekends.  The student activity 
eligibility of a student who is mandatorily reassigned shall be determined on 
a case-by-case basis by the principal of the building to which the student is 
reassigned. 
 
Pre-Kindergarten through Second Grade Students 
 
Notwithstanding any other provision of this policy, an elementary school shall 
not suspend a student in pre-kindergarten through second grade unless the 
student brings a deadly weapon as defined in section 28-109 on school 
grounds, in a vehicle owned, leased, or contracted by a school being used for 
a school purpose or in a vehicle being driven for a school purpose by a school 
employee or his or her designee, or at a school-sponsored activity or athletic 
event.  As an alternative to suspension, the school district may take any action 
authorized by law, including those provided in section 79-258.   
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Makeup Work for Suspended Students 
 
Any student who is suspended must be given an opportunity to complete any 
classwork and homework missed during the period of suspension, including, 
but not limited to, examinations (“makeup work”).  Any makeup work must 
be completed and turned in within 2 school days after completion of the 
suspension.  This makeup guideline shall be provided to the student and a 
parent or guardian at the time of suspension.  Suspended students may not 
be required to attend the school’s alternative program for expelled students 
in order to complete classwork or homework. 
 
 
Short-Term Suspension 
 
The Principal may exclude students from school or any school function for a 
period of up to five school days (short-term suspension) on the following 
grounds: 
 
1. Conduct constituting grounds for expulsion as hereinafter set forth; or, 
2. Other violations of rules and standards of behavior adopted by the Board 

of Education or the administrative or teaching staff of the school, that 
occur on or off school grounds, if such conduct interferes with school 
purposes or there is a connection between such conduct and school. 

 
The following process applies to short-term suspension: 
 
1. The Principal shall make a reasonable investigation of the facts and 

circumstances.  Short-term suspension shall be imposed only after a 
determination that the suspension is necessary to help any student, to 
further school purposes, or to prevent an interference with school 
purposes. 

2. Prior to commencement of the short-term suspension, the student will 
be given oral or written notice of the charges against the student.  The 
student will be advised of what he or she is accused of having done, be 
given an explanation of the evidence the authorities have, and be given 
an opportunity to explain the student's version of the facts. 

3. Within 24 hours or such additional time as is reasonably necessary, not 
to exceed an additional 48 hours, following the suspension, the Principal 
will send a written statement to the student, and the student's parent 
or guardian, describing the student's conduct, misconduct or violation 
of the rule or standard and the reasons for the action taken.  An 
opportunity will be given to the student, and the student's parent or 
guardian, to have a conference with the Principal ordering the short-
term suspension before or at the time the student returns to school and 



Page 3 of 11 

shall document such effort in writing.  The Principal shall determine who, 
in addition to the parent or guardian, is to attend the conference. 

4. Students who are short-term suspended will/will notmust be given the 
opportunity to complete classwork and homework missed during the 
period of suspension, including but not limited to examinations, as 
provided herein.   

 
Emergency Exclusion 
 
Students may be emergency excluded from school pursuant to the board's 
separate policy on emergency exclusion or state law.   
 
 
 
Weapons and/or Firearms 
 
Students may be disciplined for the possession of weapons and/or firearms 
pursuant to the board's separate policy on weapons and firearms or state law.   
 
 
 
 
Long-Term Suspension   
 
Students may be excluded by the Principal from school or any school function 
for a period of more than five school days but less then than twenty school 
days (long-term suspension) for any conduct constituting grounds for 
expulsion as hereinafter set forth.  The process for long-term suspension is 
set forth below. 
 
Expulsion 
 
1. Meaning of Expulsion.  Expulsion means exclusion from attendance in 

all schools, grounds and activities of or within the system for a period 
not to exceed the remainder of the semester in which it took effect 
unless the misconduct occurred (a) within ten school days prior to the 
end of the first semester, in which case the expulsion shall remain in 
effect through the second semester, or (b) within ten school days prior 
to the end of the second semester, in which case the expulsion shall 
remain in effect for summer school and the first semester of the 
following school year, or (c) unless the expulsion is for conduct specified 
in these rules or in law as permitting or requiring a longer removal, in 
which case the expulsion shall remain in effect for the period specified 
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therein.  Such action may be modified or terminated by the school 
district at any time during the expulsion period. 

2. Summer Review.  Any expulsion that will remain in effect during the 
first semester of the following school year will be automatically 
scheduled for review before the beginning of the school year.  The 
review will be conducted by the hearing officer who conducted the initial 
expulsion hearing, or a hearing officer appointed by the Superintendent 
in the event no hearing was previously held or the initial hearing officer 
is no longer available or willing to serve, after the hearing officer has 
given notice of the review to the student and the student's parent or 
guardian.  This review shall be limited to newly discovered evidence or 
evidence of changes in the student's circumstances occurring since the 
original hearing.  This review may lead to a recommendation by the 
hearing officer that the student be readmitted for the upcoming school 
year.  If the school board or board of education or a committee of such 
board took the final action to expel the student, the student may be 
readmitted only by action of the board.  Otherwise the student may be 
readmitted by action of the Superintendent. 

3. Suspension of Enforcement of an Expulsion:  Enforcement of an 
expulsion action may be suspended (i.e., "stayed") for a period of not 
more than one full semester in addition to the balance of the semester 
in which the expulsion takes effect, and as a condition of such suspended 
action, the student may be assigned to a school, class, or program/plan 
and to such other consequences which the school district deems 
appropriate.   

4. Alternative School or Pre-expulsion Procedures. The school shall 
either provide an alternative school, class or educational program for 
expelled students, or shall follow the pre-expulsion procedures outlined 
in NEB. REV. STAT. 79-266. 

4.5. Conclusion of Expulsion.  At the conclusion of an expulsion, the 
school district will reinstate the student and accept nonduplicative, 
grade-appropriate credits earned by the student during the term of 
expulsion from any Nebraska accredited institution or institution 
accredited by one of the six regional accrediting bodies in the United 
States.   

 
Grounds for Long-Term Suspension, Expulsion or Mandatory 
Reassignment:  
 
 The following conduct constitutes grounds for long-term suspension, 
expulsion, or mandatory reassignment, subject to the procedural provisions 
of the Student Discipline Act, NEB. REV. STAT. § 79-254 through 79-296, when 
such activity occurs on school grounds, in a vehicle owned, leased, or 
contracted by a school being used for a school purpose or in a vehicle being 
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driven for a school purpose by a school employee or by his or her designee, 
or at a school-sponsored activity or athletic event: 
  
1. Use of violence, force, coercion, threat, intimidation, or similar conduct 

in a manner that constitutes a substantial interference with school 
purposes; 

2. Willfully causing or attempting to cause substantial damage to property, 
stealing or attempting to steal property of substantial value, or repeated 
damage or theft involving property; 

3. Causing or attempting to cause personal injury to a school employee, to 
a school volunteer, or to any student. Personal injury caused by 
accident, self-defense, or other action undertaken on the reasonable 
belief that it was necessary to protect some other person shall not 
constitute a violation of this subdivision; 

4. Threatening or intimidating any student for the purpose of or with the 
intent of obtaining money or anything of value from such student; 

5. Knowingly possessing, handling, or transmitting any object or material 
that is ordinarily or generally considered a weapon (see also board policy 
on weapons and firearms); 

6. Engaging in the unlawful possession, selling, dispensing, or use of a 
controlled substance or an imitation controlled substance, as defined in 
section 28-401, a substance represented to be a controlled substance, 
or alcoholic liquor as defined in section 53-103.02 or being under the 
influence of a controlled substance or alcoholic liquor (note:  the term 
“under the influence” for school purposes has a less strict meaning than 
it does under criminal law; for school purposes, the term means any 
level of impairment and includes even the odor of alcohol on the breath 
or person of a student; also, it includes being impaired by reason of the 
abuse of any material used as a stimulant); 

7. Public indecency as defined in section 28-806, except that this 
prohibition shall apply only to students at least twelve years of age but 
less than nineteen years of age; 

8. Engaging in bullying as defined in section 79-2,137 and in these policies; 
9. Sexually assaulting or attempting to sexually assault any person if a 

complaint has been filed by a prosecutor in a court of competent 
jurisdiction alleging that the student has sexually assaulted or 
attempted to sexually assault any person, including sexual assaults or 
attempted sexual assaults which occur off school grounds not at a school 
function, activity, or event. For purposes of this subdivision, sexual 
assault means sexual assault in the first degree as defined in section 
28-319, sexual assault in the second degree as defined in section 28-
320, sexual assault of a child in the second or third degree as defined in 
section 28-320.01, or sexual assault of a child in the first degree as 
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defined in section 28-319.01, as such sections now provide or may 
hereafter from time to time be amended; 

10. Engaging in any other activity forbidden by the laws of the State of 
Nebraska which activity constitutes a danger to other students or 
interferes with school purposes; or  

11. A repeated violation of any of the following rules if such violations 
constitute a substantial interference with school purposes: 

a. The use of language, written or oral, or conduct, including 
gestures, which is profane or abusive to students or staff 
members.  Profane or abusive language or conduct includes, but 
is not limited to, that which is commonly understood and intended 
to be derogatory toward a group or individual based upon race, 
gender, national origin, or religion; 

b. Dressing or grooming in a manner which violates the school 
district’s dress code and/or is dangerous to the student's health 
and safety, a danger to the health and safety of others, or which 
is disruptive, distracting or indecent to the extent that it interferes 
with the learning and educational process; 

c. Violating school bus rules as set by the school district or district 
staff; 

d. Possessing, using, selling, or dispensing tobacco, drug 
paraphernalia, an electronic nicotine delivery system, or a tobacco 
imitation substance or packaging, regardless of form, including 
cigars, cigarettes, chewing tobacco, and any other form of 
tobacco, tobacco derivative product or imitation or electronic 
cigarettes, vapor pens, etc.; 

e. Possessing, using, selling, or dispensing any drug paraphernalia 
or imitation of a controlled substance regardless of whether the 
actual substance possessed is a controlled substance by Nebraska 
law;  

f. Possession of pornography;  
g. Sexting or the possession of sexting images (a combination of sex 

and texting - the act of sending sexually explicit messages or 
photos electronically); 

h. Engaging in hazing, defined as any activity expected of someone 
joining a group, team, or activity that humiliates, degrades or 
risks emotional and/or physical harm, regardless of the person's 
willingness to participate.  Hazing activities are generally 
considered to be:  physically abusive, hazardous, and/or sexually 
violating and include but are not limited to the following: personal 
servitude; sleep deprivation and restrictions on personal hygiene; 
yelling, swearing and insulting new members/rookies; being 
forced to wear embarrassing or humiliating attire in public; 
consumption of vile substances or smearing of such on one's skin; 
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branding; physical beatings; binge drinking and drinking games; 
sexual simulation and sexual assault; 

i. Bullying which shall include cyberbullying, defined as the use of 
the internet, including but not limited to social networking sites 
such as Facebook, cell phones or other devices to send, post or 
text message images and material intended to hurt or embarrass 
another person.  This may include, but is not limited to; continuing 
to send e-mail to someone who has said they want no further 
contact with the sender; sending or posting threats, sexual 
remarks or pejorative labels (i.e., hate speech); ganging up on 
victims by making them the subject of ridicule in forums, and 
posting false statements as fact intended to humiliate the victim; 
disclosure of personal data, such as the victim's real name, 
address, or school at websites or forums; posing as the identity of 
the victim for the purpose of publishing material in their name that 
defames or ridicules them; sending threatening and harassing 
text, instant messages or emails to the victims; and posting or 
sending rumors or gossip to instigate others to dislike and gang 
up on the target; 

j. Violations of the district’s computer acceptable computer use 
policy are subject to discipline, up to and including expulsion;  

k. Knowingly possessing, handling, or transmitting any object or 
material that is ordinarily or generally considered a simulated or 
“look-a-like” weapon; 

l. Using any object to simulate possession of a weapon;  
m. Knowingly making a false statement or knowingly submitting false 

information during the Title IX grievance process or any other 
school investigation or making a materially false statement in bad 
faith in the course of a Title IX grievance proceeding or any other 
school investigation; 

m.n. Violation of the school’s audio and video recording policy; 
and 

n.o. Any other violation of any board policy, handbook provision, 
or a rule or regulation established by a school district staff 
member pursuant to authority delegated by the board. 

  
Due Process Afforded to Students Facing Long-term Suspension or 
Expulsion 
 
The following procedures shall be followed regarding any long-term 
suspension, expulsion, or mandatory reassignment: 
 
1. The decision as to recommend discipline shall be made within two school 

days after learning of the alleged student misconduct.  On the date of 
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the decision to discipline, the Principal shall file with the Superintendent 
a written charge and a summary of the evidence supporting such 
charge.   

2. The Principal shall serve the student and the student's parents or 
guardian with a written notice by registered or certified mail or personal 
service within two school days of the date of the decision to recommend 
long-term suspension or expulsion.  The notice shall include the 
following: 

 
a. The rule or standard of conduct allegedly violated and the acts of 

the student alleged to constitute a cause for long-term 
suspension, expulsion, or mandatory reassignment, including a 
summary of the evidence to be presented against the student; 

b. The penalty, if any, which the principal has recommended in the 
charge and any other penalty to which the student may be 
subject; 

c. A statement that, before long-term suspension, expulsion, or 
mandatory reassignment for disciplinary purposes can be invoked, 
the student has a right to a hearing, upon request, and that if the 
student is suspended pending the outcome of the hearing, the 
student may complete classwork and homework, including, but 
not limited to, examinations, missed during the period of 
suspension pursuant to district guidelines which shall not require 
the student to attend the school district's alternative programs for 
expelled students in order to complete classwork oron the 
specified charges; 

d. A description of the hearing procedures provided by the act, along 
with procedures for appealing any decision rendered at the 
hearing; 

e. A statement that the principal, legal counsel for the school, the 
student, the student's parent, or the student's representative or 
guardian has the right (i) to examine the student's academic and 
disciplinary records and any affidavits to be used at the hearing 
concerning the alleged misconduct and (ii) to know the identity of 
the witnesses to appear at the hearing and the substance of their 
testimony; and 

f. A form on which the student, the student's parent, or the student's 
guardian may request a hearing, to be signed by such parties and 
delivered to the principal or superintendent in person or by 
registered or certified mail to the address provided on the form. 
 

3. When a notice of intent to discipline a student by long-term suspension, 
expulsion, or mandatory reassignment is filed with the superintendent, 
the student may be suspended by the principal until the date the long-
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term suspension, expulsion, or mandatory reassignment takes effect if 
no hearing is requested or, if a hearing is requested, the date the 
hearing examiner makes the report of his or her findings and a 
recommendation of the action to be taken to the superintendent, if the 
principal determines that the student must be suspended immediately 
to prevent or substantially reduce the risk of (a) interference with an 
educational function or school purpose or (b) a personal injury to the 
student himself or herself, other students, school employees, or school 
volunteers. 

4. Nothing in this policy shall preclude the student, student's parents, 
guardian or representative from discussing and settling the matter with 
appropriate school personnel prior to the time the long-term suspension, 
expulsion, or mandatory reassignment takes effect hearing stage. 

5. If a hearing is requested within five days after receipt of the notice, the 
Superintendent shall appoint recommend appointment of a hearing 
officer examiner within two school days after receipt of the hearing 
requestwho shall follow the "hearing procedures" outlined below.  The 
student or the student’s parent or guardian may request designation of 
a hearing examiner oth’er than the hearing examiner recommended by 
the superintendent if notice of the request is given to the superintendent 
within two school days after receipt of the superintendent’s 
recommended appointment.  Upon receiving such request, the 
superintendent must provide one alternative hearing examiner who is 
not an employee of the school district or otherwise currently under 
contract with the school district and whose impartiality may not 
otherwise be reasonably questioned.  The superintendent may also 
provide an additional list of hearing examiners that may include hearing 
examiners employed by or under contract with the school district.  The 
student or the student’s parent or guardian must, within five school 
days, select a hearing examiner to conduct the hearing who was 
recommended, or provided as an alternative hearing examiner, or 
included on an additional list, if any, pursuant to this subdivision and 
shall notify the superintendent in writing of the selection.  The 
superintendent must appoint the selected hearing examiner upon 
receipt of such notice. 

6. The hearing examiner must, within two school days after being 
appointed, give written notice to the principal, the student, and the 
student’s parent or guardian of the time and place for the hearing. 

7. The hearing shall be held within a period of five school days after 
appointment of the hearing examiner, but such time may be changed 
by the hearing examiner for good cause with consent of the parties. No 
hearing shall be held upon less than two school days' actual notice to 
the principal, the student, and the student's parent or guardian, except 
with the consent of all the parties.  
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5.8. The principal or legal counsel for the school, the student, and the 
student's parent, guardian, or representative have the right to receive 
a copy of all records and written statements referred to in the Student 
Discipline Act as well as the statement of any witness in the possession 
of the school board or board of education no later than forty-eight hours 
prior to the hearing. 

6.9. If a hearing is requested more than five school days following the receipt 
of the written notice, but not more than thirty calendar days after 
receipt, the Superintendent shall appoint a hearing officer examinerwho 
shall follow the "hearing procedures" outlined below, except that the 
time constraints set forth may differ as provided by law and this policy.  
The hearing will be held according to the requirements of section 79-
269.  The student shall be entitled to a hearing but the consequence 
imposed may continue in effect pending final determination.   

7.10. If a request for hearing is not received within thirty calendar days 
following the mailing or delivery of the written notice, the student shall 
not be entitled to a hearing. 

 
In the event a hearing is requested, the hearing, hearing procedures, 

the student's rights and any appeals or judicial review permitted by law shall 
be governed by the applicable provisions of the Nebraska Student Discipline 
Act (NEB. REV. STAT. § 79-254 to 79-294).  The school district will provide 
parents with copies of the relevant statutes upon request.   
 
Makeup Work for Suspended Students 
 
Any student who is suspended must be given an opportunity to complete any 
classwork and homework missed during the period of suspension, including, 
but not limited to, examinations (“makeup work”).  Any makeup work must 
be completed and turned in within 2 school days after completion of the 
suspension.  This makeup guideline shall be provided to the student and a 
parent or guardian at the time of suspension.  Suspended students may not 
be required to attend the school’s alternative program for expelled students 
in order to complete classwork or homework. 
 
Reporting Requirement to Law Enforcement 
 
Violations of this section will result in a report to law enforcement if:  
 

1. The violation includes possession of a firearm; 
2. The violation results in child abuse; 
3. It is a violation of the Nebraska Criminal Code that the administration 

believes cannot be adequately addressed solely by discipline from the 
school district; 
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4. It is a violation of the Nebraska Criminal Code that endangers the health 
and welfare of staff or students;  

5. It is a violation of the Nebraska Criminal Code that interferes with school 
purposes; 

6. The report is required or requested by law enforcement or the county 
attorney. 

 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
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5045 
Student Fees 

 
 The school district shall provide free instruction in accordance with the Nebraska State 
Constitution and the Nebraska statutes.  The district also provides activities, programs, and 
services that extend beyond the minimum level of constitutionally required free instruction.  
Under the Public Elementary and Secondary Student Fee Authorization Act, the district is 
permitted to charge students fees for these activities or to require students to provide 
specialized equipment and attire for certain purposes.  This policy is subject to further 
interpretation or guidance by administrative or board regulations.  Students are encouraged to 
contact their building administration, their teachers or their coaches, and sponsors for further 
specifics.  

A. Definitions. 
 

1. “Students” means students, their parents, guardians or other legal 
representatives. 

2. “Extracurricular activities” means student activities or organizations that 
(1) are supervised or administered by the district; (2) do not count toward 
graduation or advancement between grades; and (3) are not otherwise 
required by the district. 

3. “Post-secondary education costs” means tuition and other fees 
associated with obtaining credit from a post-secondary educational 
institution.   

 
B. Listing of Fees Charged by this District. 
 

1. Guidelines for Clothing Required for Specified Courses and Activities. 
 
 Students are responsible for complying with the district’s grooming and attire guidelines 
and for furnishing all clothing required for any special programs, courses or activities in which 
they participate.  The teacher, coach, or sponsor of the activity will generally provide students 
with written guidelines that detail any special clothing requirements and explain why the special 
clothing is required for the specific program, course or activity. 
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 2. Safety Equipment and Attire. 
 
 The district will provide students with all safety equipment and attire that is required by 
law.  Building administrators will assure that (a) such equipment is available in the appropriate 
classes and areas of the school buildings, (b) teachers are directed to instruct students in the 
use of such devices, and (c) students use the devices as required.  Students are responsible for 
using the devices safely and as instructed.   
 

3. Personal or Consumable Items. 
 
 The district will provide students with personal or consumable items for participation in 
courses and activities including, but not limited to, pencils, paper, pens, erasers and notebooks.  
Students who wish to supply their own personal or consumable items may do so, as long as 
those items comply with the requirements of the district.  The district will provide students with 
facilities, equipment, materials and supplies, including books.  Students are responsible for the 
careful and appropriate use of such property.  Students will be charged for damage to school 
property caused by the student and will be held responsible for the reasonable replacement cost 
of any school property that they lose. 
  
 4. Materials Required for Course Projects. 
 
 The district will provide students with the materials necessary to 
complete all basic curricular projects.  In courses where students choose to 
produce a project that requires materials beyond the basic materials 
provided by the district, the students will furnish the materials, purchase the 
materials from the school, or purchase the materials from an outside vendor 
with an order form provided by the school.  
  
  
 The maximum dollar amount charged by the district for course materials shall be: 

  
§ Industrial Technology Classes $15.00 
 
§ Art Classes $15.00 
 
§ Ceramics  $15.00 

 
§ High School FCS $20.00 

 
§ Band $10.00 

 
§ Outdoor Education – Middle School $25.00 

 
§ Middle School Honor Choir – if selected $25.00 
 
§ Elementary After School Program $20.00 
 
§ Introduction to STS- Career Safe OSHA 10 certification-   $12.50 
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§ Welding Class $20.00 
 
§ Annual Technology () Fee $5.00 
  

 
   
5. Extracurricular Activities. 
  
 The district may charge students a fee to participate in extracurricular activities to cover 
the district’s reasonable costs in offering such activities.  The district may require students to 
furnish specialized equipment and clothing that is required for participation in extracurricular 
activities, or may charge a reasonable fee for the use of district-owned equipment or attire.  
Attached to this policy is a list of the fees charged for particular activities.  The coach or sponsor 
will provide students with additional written guidelines detailing the fees charged, the equipment 
and/or clothing required, or the usage fee charged.  The guidelines will explain the reasons that 
fees, equipment and/or clothing are required for the activity. 
  
 The following list details the maximum dollar amount of all extracurricular activities fees 
and the specifications for any equipment or attire required for participation in extracurricular 
activities: 
   

§ Student activity card     $20.00  
 Covers admission to most regular season athletic events 

   
§ Student participation fee  $20.00  
 Required of all students who participate in athletics and/or other extracurricular 

activities (Pay only one fee per year) 
   

§ Middle School Builders Club  $  3.00 
  
   

§ Football  students must provide their 
own football shoes, and 
undergarments  

   
§ Golf students must provide their 

own 
 Golf shoes, undergarments, 

and clubs 
 
§ Softball and Baseball students must provide their 

own shoes, gloves, and 
undergarments 

 
§ Track, Volleyball, Wrestling,  

Soccer, Bowling and Basketball ,   students must provide their 
own  shoes and 
undergarments 

   
§ FFA, FCCLA, FBLA, Key Club, Skills USA Dues 



Page 4 of 6  

 student pay dues of $20.00 
per activity 

 
 

  
  

§  Dance and Cheerleading Students must 
purchase outfits and shoes selected by the 
sponsor and/or student group.   

 
   

 6. Post-Secondary Education Costs. 
  
 Some students enroll in postsecondary courses while still enrolled in the district’s high 
school.  As a general rule, students must pay all costs associated with such post-secondary 
courses.  However, for a course in which students receive high school credit or a course being 
taken as part of an approved accelerated or differentiated curriculum program, the district shall 
offer the course without charge for tuition, transportation, books, or other fees.  Students who 
chose to apply for post-secondary education credit for these courses must pay tuition and all 
other fees associated with obtaining credits from a post-secondary educational institution. 
       
 7. Transportation Costs. 
  
 The district will charge students reasonable fees for transportation services provided by 
the district to the extent permitted by federal and state statutes and regulations. 
  
 8. Copies of Student Files or Records. 
  
 The district will charge a fee for making copies of a student’s files or records for the 
parents or guardians of such student.  The Superintendent or the Superintendent’s designee 
shall establish a schedule of student record fees.  Parents of students have the right to inspect 
and review the students’ files or records without the payment of a fee, and the district shall not 
charge a fee to search for or retrieve any student’s files or records. 
  
      
   9. Participation in Before-and-After-School or Pre-Kindergarten Services. 
  
 The district will charge reasonable fees for participation in pre-kindergarten services 
offered by the district pursuant to statute. 
  
 The maximum dollar amount charged by the district for these services shall be $3.00 per 
day. 
  
 10. Participation in Summer School or Night School. 
  
     The district will charge reasonable fees for participation in summer school or night 
school and may charge reasonable fees for correspondence courses.  
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 11. Charges for Musical Extracurricular Activities. 
  

Students who qualify for fee waivers under this policy will be provided, at no charge, the 
use of a musical instrument in optional music courses that are not extracurricular activities.  For 
musical extracurricular activities, the school district will require students to provide the following 
equipment and/or attire:  

   
§ Band Students must provide their own instruments 

and marching band shoes. 
§ Show Choir Students must purchase outfits and shoes 

selected by the sponsor and/or student group.   
 

 
 12. Contributions for Junior and Senior Class Extracurricular Activities.   
  

Students are eligible to participate in a number of unique extracurricular activities during 
their last two years in high school, including prom, various senior recognitions, and graduation.  
In order to fund these extracurricular activities, the school district will ask each student to make 
a contribution to their class’s fund. This contribution is completely voluntary.  Students who 
chose not to contribute to the class fund are still eligible to participate in the extra activities.  The 
suggested donation to the class fund will be $10.00.  
 
C. Waiver Policy. 
 
 Students who qualify for free or reduced-price lunches under United States Department 
of Agriculture child nutrition programs shall be provided a fee waiver or be provided the 
necessary materials or equipment without charge for (1) participation in extracurricular activities, 
(2) materials for course projects, and (3) the use of a musical instrument in optional music 
courses that are not extracurricular activities.  Actual participation in the free or reduced-price 
lunch program is not required to qualify for the waivers provided in this section.  The district is 
not obligated to provide any particular type or quality of equipment or other material to eligible 
students.  Students who wish to be considered for waiver of a particular fee must submit a 
completed fee waiver application to their building principal. 
 
D. Distribution of Policy. 
 
 This policy will be published in the Student Handbook or its equivalent that will be 
provided to students at no cost. 
   
E. Voluntary Contributions to Defray Costs.  

  
 The district will, when appropriate, request donations of money, materials, equipment or 
attire from parents, guardians and other members of the community to defray the costs of 
providing certain services and activities to students.  These requests are not requirements and 
staff members of the district are directed to clearly communicate that fact to students, parents 
and patrons. 
   
F. Student Fee Fund. 
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 The school board hereby establishes a Student Fee Fund.  The Student Fee Fund shall 
be a separate school district fund that will not be funded by tax revenue, and that will serve a 
depository for all monies collected from students for (1) participation in extracurricular activities, 
(2) post-secondary education costs, and (3) summer school or night school courses.  Monies in 
the Student Fee Fund shall be expended only for the purposes for which they were collected 
from students. 
 
 
G. Student Fee Hearing 
 
 Annually the Board of Education of The School District of Seward will hold a public 
hearing on the student fee policy.  Such hearing will include a review of the amount of money 
collected from students and uses of said fees.   
 
                                _________________________________ 
       

 
Adopted on: June 9, 2014_____________ 
Revised on: _June 13, 2016, August 13, 2018, August 12, 2019, August 8, 2022 
Reviewed on: ________________________ 
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5049 
Firearms and Weapons  

 
 
Weapons.  No student may possess, handle, or transmit any weapon while 
on school grounds or at any school activity or event off school grounds except 
as permitted by this policy.  No visitor under the age of 18 may possess, 
handle, or transmit any weapon while on school grounds or at any school 
activity or event off school grounds except as permitted by this policy.  
Definition of Weapon.  The term “weapon” means any object, device, 
instrument, material, or substance which is capable of causing injury in the 
manner it is used or intended to be used.   
 
Firearms.  No person may bring, possess, handle or transmit a firearm on 
school grounds, in a school owned vehicle, or at a school activity or event off 
school grounds, except as permitted by this policy.  Definition of Firearm.  
The term “firearm, as defined in 18 U.S.C. 921, means any weapon (including 
a starter gun) which will or is designed to or may readily be converted to expel 
a projectile by the action of an explosive, the frame or receiver of any such 
weapon, any firearm muffler or firearm silencer, or any destructive device 
(excluding an antique firearm). 
 
Exceptions Regarding Firearms.  The prohibition against firearms does not 
apply to: 

1. The issuance of firearms to or possession by members of the armed 
forces of the United States, active or reserve, National Guard of this 
State, or Reserve Officers Training Corps or peace officers or other duly 
authorized law enforcement officers when on duty or training; or  

 
2. Firearms that may lawfully be possessed by a person who is receiving 

instruction at the school under the immediate supervision of an adult 
instructor;  
 

3. Firearms which may lawfully be possessed by a person for the purpose 
of using them, with the approval of the school, in a historical 
reenactment, in a hunter education program, or as part of an honor 
guard; 

 
4. Firearms contained within a private vehicle operated by a nonstudent 

adult that are not loaded and are encased or are in a locked firearm 
rack that is on a motor vehicle; or 
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5. A handgun carried as a concealed handgun by a nonstudent adult who 
holds a valid permit issued under the Concealed Handgun Permit Act in 
a vehicle or on his or her person while riding in or on a vehicle into or 
onto any parking area, which is open to the public and used by the 
school if, prior to exiting the vehicle, the handgun is locked inside the 
glove box, trunk, or other compartment of the vehicle, a storage box 
securely attached to the vehicle, or, if the vehicle is a motorcycle, a 
hardened compartment securely attached to the motorcycle while the 
vehicle is in or on such parking area, except as prohibited by federal 
law.   

 
Definition of Encased.  The term “encased” means enclosed in a case 
that is expressly made for the purpose of containing a firearm and that 
is completely zipped, snapped, buckled, tied, or otherwise fastened with 
no part of the firearm exposed.   

 
Exceptions for Students.  The only exceptions for a student to bring or 
possess a weapon, including a firearm, are as follows: 
 

 1. The firearm or weapon has been brought to school grounds or to an 
activity or event off school grounds for some educational purpose;  

  
 2. The person bringing the firearm or weapon has requested and received 

the prior approval of both the instructor and the building principal to do 
so; and 
 

3. All arrangements to use and store the firearm or weapon safely while it 
is on school premises have been agreed to and carried out. 

 
Consequences - Firearm.   Any student who brings a firearm, as that term 
is defined in 18 United States Code 921, to school will be expelled from school 
for one calendar year.  The superintendent of schools and the board of 
education shall have the authority to modify the expulsion requirement on a 
case-by-case basis. 
 
Consequences – Weapon.  State law and this policy provide that any 
student who violates this policy by knowingly bringing, possessing, handling 
or transmitting a weapon, other than a firearm, on school grounds, in a school 
owned vehicle, or at a school activity or event off school grounds may be 
suspended on a long-term basis, mandatorily reassigned, or expelled for the 
remainder of the school year in which the expulsion takes effect (if the 
misconduct occurs during the first semester) or the remainder of the second 
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semester, summer school, and the first semester of the following school year 
(if the misconduct occurs during the second semester).   
 
Confiscation of Firearms.  Administrative and teaching personnel are 
statutorily authorized, without a warrant, to confiscate any firearm possessed 
in violation of this policy.  By statute, any firearm that is confiscated by school 
personnel shall be delivered to a peace officer as soon as practicable.  Such 
firearms are subject to being destroyed by law enforcement authorities. 
 
Report to Law Enforcement Authorities.  All school personnel are required 
to report any violation of this policy to a principal or the superintendent of 
schools.  Pursuant to state and federal law, school personnel are required to 
report to law enforcement authorities when a student brings a firearm or 
weapon to school. 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
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5052 

School Wellness Policy  
 
The school district is committed to providing a school environment that 
enhances learning and the development of lifelong wellness.  The goals 
outlined in this policy were determined and selected after reviewing and 
considering evidence-based strategies.* 
 
1. Goals for Nutrition Promotion and Education 
 

a. The district will promote healthy food and beverage choices 
for all students, as well as encourage participation in school 
meal programs by such methods as implementing evidence-
based healthy food promotion techniques through the 
school meal programs and promoting foods and beverages 
that meet or exceed the USDA Smart Snacks in School 
nutrition standards. 
   

b. The health curriculum will include information on good 
nutrition and healthy living habits.  

 
c. Teachers will incorporate information on nutrition and 

wellness into the classroom curriculum as appropriate. 
 

d. The district will collaborate with public and private entities 
to promote student wellness. 
  

e. Water will be made available to students throughout the 
school day. 

  
2. Goals for Physical Activity 

 
a. The school district’s curriculums shall include instruction on 

physical activity and habits for healthy living. 
 
b. Students will be encouraged to engage in physical activities 

throughout the school day and will be provided with 
opportunities to do so. 

 
c. The district encourages parents and guardians to support 

their children's participation in physical activity, to be 
physically active role models, and to include physical activity 
in family events. 
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3. Goals for Other School-Based Activities Designed to 

Promote Student Wellness   
 
a. The district will participate in state and federal child nutrition 

programs as appropriate. 
 

b. The district will provide professional development, support, 
and resources for staff about student wellness. 

 
c. Students will be provided sufficient time in which to eat 

school-provided meals. 
 
d. The district’s lunchrooms will be attractive and well-lighted. 

 
e. The district will allow other health-related entities to use 

school facilities for activities such as health clinics and 
screenings so long as the activities meet the district’s 
requirements and criteria for the use of facilities.   
  

f. The district may partner with other individuals or entities in 
the community to support the implementation of this policy. 
 

g. The district will strive to provide physical activity breaks for 
all students, recess for elementary students, and before and 
after school activities, as well as encourage students to use 
active transport (walking, biking, etc.) 
 

h. The district will use evidence-based strategies to develop, 
structure, and support student wellness.   

 
 
4. Standards and Nutrition Guidelines for All Foods and 

Beverages Sold to Students on the School Campus and 
During the School Day 
 
a. The district will ensure that student access to foods and 

beverages meet federal, state and local laws and guidelines 
including, but not limited to:  

 
i. USDA National School Lunch and School Breakfast 

nutrition standards 
 

ii. USDA Smart Snacks in School nutrition standards. 
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b. The district will offer students a variety of age-appropriate, 

healthy food and beverage selections with plenty of fruits, 
vegetables, and whole grains aimed at meeting the nutrition 
needs of students within their calorie requirements in order 
to promote student health and reduce childhood obesity. 

 
5. Standards for All Foods and Beverages Provided, But Not 

Sold to Students During the School Day 
 

The district may provide a list of healthy party ideas or food and 
beverage alternatives to parents, teachers, and students for classroom 
parties, rewards and incentives, or classroom snacks.  The district 
discourages the use of food and beverages as a reward or incentive for 
performance or behavior. 
 
6. Food and Beverage Marketing 

 
Marketing and advertising is only allowed on school grounds or at school 
activities for foods and beverages that meet or exceed the USDA Smart 
Snacks in School nutrition standards, except as follows: 
 

a. This requirement does not apply to marketing that occurs at 
events outside of school hours such as after school sporting 
or any other events, including school fundraising events. 

  
b. The district will not immediately replace menu boards, 

coolers, tray liners, beverage cups, and other food service 
equipment with depictions of noncompliant products or 
logos to comply with the new USDA Smart Snacks in Schools 
nutrition requirements.  All previously purchased products 
will be used, and all existing contracts honored.  

 
c. All equipment that currently displays noncompliant 

marketing materials will not be removed or replaced (e.g., 
a score board with a Coca-Cola logo).  However, as the 
district reviews and considers new contracts, and as 
scoreboards or other such durable equipment are replaced 
or updated over time, any products that are marketed and 
advertised will meet or exceed the USDA Smart Snacks in 
School nutrition standards 

 
7. Public Participation  
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Parents, students, representatives of the school food authority, 
teachers, school health professionals, board members, school 
administrators, and members of the general public shall be allowed to 
provide their input to the school district during the wellness policy 
adoption and review process. 
 
8. Competitive Foods (Includes Food and Beverages Sold in 

Vending Machines, School Stores, Fundraisers or in 
Competition with the National School Lunch and Breakfast 
Programs) 
 

a. Except as otherwise allowed by the Nebraska Department of 
Education (NDE), all foods and beverages sold during the 
school day as part of a fundraiser or for any other purpose 
in competition with the National School Lunch and Breakfast 
Programs must meet the nutrition standards of those 
programs.   
 

b. Fundraiser food or beverages are NOT exempt from the 
USDA Smart Snacks in School nutrition standards. 
Therefore, if food is sold as a fundraiser:  

 
(1) It shall not be sold in competition with school 
meals in the food service area during the meal service. 
 
(2) It shall not be sold or otherwise made available to 
students anywhere on school premises during the 
period beginning one half hour prior to the serving 
period for breakfast and/or lunch and lasting until one 
half hour after the serving of breakfast and/or lunch. 
 
(3) The sale of food items during the school day shall 
meet the USDA Smart Snacks in School nutrition 
requirements 
 
(4) This restriction does not apply to food sold during 
non-school hours, weekends, and off-campus 
fundraising events such as concessions during after-
school sporting events, school plays or concerts; or to 
bulk food items that are sold for consumption at 
home. (Ex: frozen pizzas, cookie dough tubs, etc.) 

 
9. Triennial Assessment 
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The school board shall assess and review this policy at least every three 
years to determine: 
 

a. Compliance with this policy; 
 

b. How this policy compares to NDE model wellness policies; 
 

c. Progress made in attaining the goals of this policy. 
 
The school board will update or modify this policy as appropriate. 
 
10. Public Notice 

 
In addition to identifying the topic on its meeting agenda as required by 
the Open Meetings Act, the school district will provide notice of this 
policy at least annually to the public and other stakeholders identified in 
this policy by one or more of the following methods:  on its webpage, in 
its newsletter, in the student and employee handbooks, newspaper 
advertisements, direct mailings, electronic mail, and public postings.   
 
In addition to identifying the topic on its meeting agenda as required by 
the Open Meetings Act, the school district will provide notice of the 
Triennial Assessment and progress reports towards meeting the goals 
in this policy using one or more of those same methods. 
 
11. Recordkeeping 

 
The District will retain records to document compliance with the 
requirements of the wellness policy at its central office. 
 
12. Operational Responsibility   

 
The superintendent is responsible for coordinating the implementation 
of this policy and for monitoring the district’s progress in meeting the 
goals established by this policy.  The superintendent will periodically 
report to the board on the district’s progress in implementing this policy. 
 

 
* These strategies include, but are not necessarily limited to, 
those cited in the Alliance for a Healthier Generation’s Model 
Wellness Policy (Updated 9/2016June 2020 to Reflect the USDA 
Final Rule) found at  
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https://www.healthiergeneration.org/_asset/wtqdwu/14-
6372_ModelWellnessPolicy.doc found at 
https://api.healthiergeneration.org/resource/2.   

 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
 



5062 
Lice and Nits 

 
 

Option A 
 
 Students found to have head lice, louse eggs, or nits will not be 
permitted at school and will be sent home.  Upon discovering the presence of 
any indication of lice, louse eggs, or nits, the student’s parent(s) or 
guardian(s) will be notified, and if appropriate will be asked to pick up the 
student from school immediately. 
 
 Students will not be permitted to return to school until the district finds 
that no live lice, eggs, or nits can be detected.  The parent(s) or guardian(s) 
will be required to treat the student and accompany the student to school to 
be examined. 
 
 The student cannot ride the school bus until the district has cleared the 
student to return to school. 
 
Option B 
 
 Students found to have live head lice or louse eggs will not be permitted 
at school and will be sent home.  Upon discovering the presence of any 
indication oflive lice or louse eggs, the school will notify the student’s parent(s) 
or guardian(s) will be notified, and if appropriate will be asked to pick up the 
student from school immediately.  The student will be isolated from contact 
with other students and their belongings, and a parent or guardian must pick 
the child up from school immediately. 
 
 Students By Nebraska DHHS regulation, students will are not be 
permitted to return to school until the student is treated such that the district 
finds that no live lice or louse eggs can be detected.  The parent(s) or 
guardian(s) will be required to treat the student and accompany the student 
to school to be examined.   
 
 The student cannot ride the school bus until the district has cleared the 
student to return to school. 
 
 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
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50633059 
Audio and Video Recording  

 
Students, staff, and their parents/ or guardians, and patrons should assume 
that any class in which students are enrolledor activitiesy in the school may 
be recorded by the school district or other students for legitimate educational 
purposes.  There is no reasonable expectation of privacy within classrooms, 
common areas of the school building or on school grounds outside of the 
building.  Recordings permitted pursuant to this policy may only be used for 
authorized purposes and may not be republished without additional, written 
consent from a school administrator.  For purposes of this policy “recording” 
includes still photographs, video, audio, and other similar data captured in any 
medium. 
 
Secret Recordings.  No person is permitted to make surreptitious recordings 
on school grounds unless authorized by the superintendent. 
 
Recordings Made by The District.  The district may use cameras or other 
devices for purposes of making security, safety, or other recordings without a 
specific purpose or for a specific purpose when such recordings are deemed 
necessary or appropriate by the administrationan authorized representative 
of the district.  The district will not maintain the recordings unless the 
recording is purposefully copied and saved.  Any recording not copied and 
maintained separately , and the recordings will may only be available 
accessible by the administrationauthorized representative for review for a 
limited time. based on the district’s then-current recording capacity.  The 
district administrators estimate that this is approximately 10 days but may 
change at any time. Recordings made by the district may be destroyed by an 
authorized representative at any time unless retention is required by law. 
 
Recordings Made by Parents/Guardians and Patrons.    
Parents/guardians and patrons may make recordings of school activities in a 
non-disruptive manner including things like athletic contests and school board 
meetings to the extent permitted by law, unless otherwise lawfully restricted 
by the administration.  Parents/guardians or patrons may not make recordings 
if they are volunteering or visiting school during the school day without 
permission of the administration or supervising staff member and subject to 
this policy, such as recording their child’s classroom activities or recess.  
Violation of this policy may be grounds for exclusion from school 
propertyproperty, loss of volunteer privileges, or other restrictions deemed 
appropriate by the administration. 
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Classroom Recordings Made by Staff.  Staff members may make audio 
and video recordings of classroom instruction, student behavior or 
performance, and school activities only upon authorization of without prior 
administrative approval only for legitimate educational purposes the 
superintendent or supervising administratoradministration or to comply with 
a student’s education plan, as described below.  Staff members may not make 
secret recordings while on duty, even if those recordings do not violate state 
or federal criminal or privacy laws.  Staff members who violate this provision 
may be subject to consequences up to termination for classified staff and 
cancellation of contract for certificated staff. 
 
Prohibited Recordings Made by Students.  This policy applies to students 
Unless otherwise authorized by this policy or law, students are prohibited from 
making audio or video recordings during the school day on school grounds; 
when being transported to and from school activities or programs in a vehicle 
owned, leased, or contracted by a school being used for a school purpose by 
a school employee or by his or her designee; or at a school-sponsored activity 
or athletic event.  Students may make recordings of school activities in a non-
disruptive manner including things like athletic contests and other 
extracurricular performances to the extent permitted by law.  Students 
generally are not permitted to record classroom instruction or members of the 
school community during the school day without the express consent of a staff 
member or as required by the student’s education plan.  Student use of 
assistive technology that has the capacity to record and/or transmit recordings 
(e.g. AngelSense) must be approved by the student’s education team or 
administration. , unless the recording is made in a manner permitted by the 
schoolthis policy for other members of the public.  In such an instance, the 
sStudents remain subject to the district’s appropriate use and student 
disciplineall other district policies and rules.  For example, this policy does not 
prohibit students from making recordings of an athletic event for their 
personal use similar to a parent or other patron, subject to other applicable 
board policy.  In no event shall photographs or video recordings be taken or 
made in restrooms, locker rooms, or other areas where there is a reasonable 
expectation of privacy. 
 
However, this policy generally prohibits students from using smart-speakers 
or other devices which actively or passively create or transmit audio or video 
recordings, including Google Home, Amazon Alexa, Apple HomePod, and 
AngelSense devices. 
 
Permitted Classroom Recordings Made by Students.  Students may 
make audio or video recordings of classroom lectures or discussions: 
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(1) For their convenience after providing notice to the classroom teacher 

and receiving the teacher’s permission; 
(2) For the benefit of another student who is absent after providing 

notice to the classroom teacher and receiving the teacher’s 
permission; 

(3) If recording is necessary to accommodate the student’s disability and 
is required by the student’s Individualized Education Plan (IEP) or 
Section 504 Plan. 

 
Staff may revoke permission to record if the recording distracts from or 
disrupts the classroom environment, unless the recording is necessary to 
accommodate a student’s disability.   
 
Permitted Non-classroom Recordings.  Students may make audio or video 
recordings otherwise prohibited by this policy outside the classroom only with 
the permission of a teacher or school administrator, provided that such 
recordings otherwise comply with any applicable state and federal laws and 
district policy.  In no event shall photographs or video recordings be taken or 
made in restrooms, locker rooms, or other areas where there is a reasonable 
expectation of privacy.   
 
Use of Smart Devices.  This policy generally prohibits anyone (including staff 
orand students) from using smart speakers or other devices which actively or 
passively create or transmit audio or video recordings, including Google Home, 
Amazon Alexa, Apple HomePod, and AngelSense devices, without the 
permission of the administration or as permitted by law. 
 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
 
 



5064 New Policy 
Title I, Title II, or Title IV Supplement, Not Supplant 

 
The district will use Title I, Title II, and Title IV, and any other funds 
subject to to Supplement, Not Supplant requirements as required by 
law.  The district will use said funds to Supplement, Not Supplant, state 
and local funds that would, in the absence of Title I, Title II, and Title IV 
such funds, be spent on Title I programs.  The district will ensure that 
Title I funds will not be used to provide services which otherwise take 
the place of public education services that are to be provided to all 
students. 
 
The district maintains records of the professional development provided 
at the district level that is funded with Title I  funds. The Superintendent 
will ensure that professional development is aligned with the needs of 
the district's Title I programs. Title I professional development will not 
duplicate that which the district provides for non-Title I purposes which, 
in the absence of Title I funds, would be provided to all staff. 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________  
 
 



6003 
Instructional Program 

 
1. The minimum number of instructional hours in the school year will be 

1,080 for grades 9 through 12, 1,032 for grades 1 through 8, and 400 
for kindergarten, _____ for middle school and high school students, 
_____ for elementary students, and ______ for kindergarten students, 
exclusive of lunchtime.  == 
 

 
1.2. The district may establish special programs for individual students that 

may deviate from these requirements.  All special programs must either 
be adopted pursuant to applicable law or approved by the 
superintendent in advance.  Prior to the district’s commencement of a 
specialized program, the district will provide the student’s parents or 
guardians with notice of the program.     

 
2.3. The board, acting with the advice of the administration and certificated 

staff, will adopt a curriculum and procure textbooks and materials to 
support that curriculum.  The administration and certificated staff will 
design instructional strategies and assessments to implement the 
curriculum.   

 
3.4. To the extent possible, practice for, travel to, and participation in 

activities sponsored by the Nebraska School Activities Association and 
the Nebraska Department of Education will be scheduled outside of 
instructional time.  Individual student absences because of illness or 
family-centered activities will be governed by district attendance 
policies.  

 
4.5. The board intends to strike a sensible balance between the time spent 

on academics and time spent on extra-curricular activities, 
acknowledging that both work and play are important in each student’s 
total development and education. 

 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
 



6004 
Curriculum Development 

 
 
The board of education jealously guards its right, prerogative, and discretion 
to exercise local control of the curriculum development of the district to the 
greatest extent permitted by state and federal law, and has no intention of 
ceding such right, prerogative, or discretion. 
 
The superintendent or his/her designee shall be responsible for providing and 
directing system-wide planning for curriculum, instruction, assessment and 
staff development.   
 
The curriculum shall be standards-driven and accountability-based. The 
district’s academic content standards shall be those required by the Nebraska 
State Board of Education in the subject areas of reading and writing (language 
arts), mathematics, and science only. The curriculum shall be articulated to 
include all programs and grade levels offered within the district, K-12 and, if 
applicable, shall include a preschool program.  The curriculum shall reflect the 
comprehensive plan of the school district. All professional staff members are 
responsible for implementing the curriculum.   
 
The superintendent or his/her designee will present this curriculum to the 
board for approval or modification.    
 
The superintendent shall be responsible for establishing curriculum guides to 
articulate and coordinate the written curriculum, and to provide consistency 
of the written curriculum from one level of the district to the next.  Curriculum 
guides shall provide for the development of the school district’s curriculum 
and shall set academic standards, identify essential educational outcome 
criteria, and provide for the implementation, monitoring and evaluation of 
student learning.  
 
Teachers are responsible for following the curriculum guides and teaching the 
written curriculum. Principals are responsible for monitoring the curriculum 
and evaluating teachers to ensure that they are teaching in compliance with 
the curriculum guides and written curriculum. The superintendent and his/her 
designee shall ensure that principals monitor the curriculum and evaluate 
teachers. 
 
Curriculum and Textbook Adoption Schedule 
 
The District will review curriculum and adopt associated textbooks on the 
following schedule. 



 
 
Year Implemented Review 

21-22 CTE Science 

22-23 Science ELA 

23-24 ELA Social Studies/Art 

24-25 Social Studies/Art Math 

25-26 Math Business/Tech/PE/ Health 

26-27 Business/Tech/PE/Health World Language, FCS, Music 

27-28 World Language, FCS, Music CTE 

28-29 CTE Science 

29-30 Science ELA 

30-31 ELA Social Studies/Art 

31-32 Social Studies/Art Math 

32-33 Math Business/Tech/PE/ Health 

33-34 Business/Tech/PE/Health World Language/FCS/Music 

34-35 World Language/FCS/Music CTE 

35-36 CTE Science 

36-37 Science ELA 

 
 
Adopted on: _________________________ 
Revised on: _________________________ 
Reviewed on: ________________________ 
 



 

 

3051 New For SPS 
Opioid Overdose Prevention and Response  

 
The district will maintain an opioid antagonist in its schools, specifically 
naloxone, otherwise known by its brand name Narcan.  Pursuant to 
Nebraska law and the Naloxone Standing Order issued by the Nebraska 
DHHS, Division of Public Health, the board will permit school nurses, 
trained school staff, or other individuals qualified by law to administer 
naloxone to any person at school or a school event displaying symptoms 
of an opioid overdose.  
 
This policy shall not create a duty on the part of the school district and/or 
its personnel to administer naloxone.  School representatives will not 
administer naloxone under the following circumstances: 
 

a. Naloxone is not available during the overdose emergency; 
b. There is no individual available who is qualified to administer 

naloxone; or 
c. School representatives are uncertain as to whether an opioid 

overdose is occurring.  
 

Nothing in this policy is intended to regulate, restrict or otherwise deter 
a law enforcement officer, emergency medical technician, volunteer fire 
fighter, licensed medical professional or other authorized individual from 
administering his/her own supply of naloxone when responding in good 
faith to a suspected drug overdose occurring on school district property 
or at a school-sponsored event.  
 
Procurement and Storage.  The superintendent, in consultation with 
the school’s nursing staff, will make the necessary arrangements to 
obtain naloxone.  The naloxone will be stored unlocked in the nurses’ 
office(s).  The superintendent, in consultation with the school’s nursing 
staff, will reorder naloxone.   
 
Naloxone that is nearing its expiration date will be replaced.  The school 
nurse shall maintain a log of naloxone supplies consistent with the 
district’s practices for logging other medications.   
 
Training.  Licensed health care professionals and school resource 
officers employed on the high school and middle school levels shall all 
complete an approved naloxone training prior to carrying and/or 
administering naloxone.  Other school staff members may be trained as 
determined by the administration. Once trained, staff members shall 



 

 

review the DHHS standing order and applicable naloxone administration 
protocols as needed. 
 
Recordkeeping and Reporting.  Any individual who administers 
naloxone on behalf of the school district will promptly notify the building 
principal and superintendent of the facts and circumstances surrounding 
the drug overdose incident. The administration of naloxone to any 
student will be documented in his/her cumulative health record.  The 
administration of naloxone to any staff member will be documented in 
his/her personnel file. 
 
 
 
Adopted on: _______________ 
Revised on: _______________ 
Reviewed on: ______________ 
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5018 
Parent and Guardian Involvement In Education Practices 

 
The school district recognizes the importance of parental and guardian 
involvement in the education of their children.  The school district will take 
the following steps to ensure that the rights of parents and guardians to 
participate in the education of their children are preserved. 
 
1. Parents/Guardians will be provided access, as described in district 

procedures, to district-approved textbooks and other curricular 
materials and tests used in the district upon request. 

 
a. A parental request to review specific approved textbooks and 

other district- or building-approved curricular materials (written, 
visual, and audio) should be made to the principal of the building 
where the textbooks and curriculum materials are used.   

b. Parents may check out textbooks and may review curricular 
materials such as video and audio recordings within a time frame 
determined by the building principal to prevent disruption of the 
instructional process.   

c. A parental request to review specific standardized and criterion- 
referenced tests used in the district should be made in writing to 
the building principal.  Copies of the most recent tests used in 
the district will be available for parent review.  Parents wishing 
to review statewide assessments will be provided with sample 
questions and a copy of a practice test, but will not be provided 
with copies of the actual assessment due to testing security.  In 
the case of other secure tests such as the ACT, parents must 
contact the publisher to obtain copies of the test. 

 
2. Parents/Guardians will be permitted, within district procedures, to 

attend and observe courses, assemblies, counseling sessions, and 
other instructional activities. 

 
a. Parents/guardians are invited to make appointments with the 

building principal to visit classes, assemblies and other 
instructional activities.  The principal shall give permission after 
determining that parental/guardian observation would not 
disrupt the activity.  Observations that last more than 60 
minutes or occur on consecutive days are typically disruptive and 
will not be permitted absent unusual circumstances, in the sole 
discretion of the building principal.  
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b. Parents/guardians may contact the building principal to request 

permission to attend counseling sessions in which their child is 
involved.   

 
3. Parents/guardians will be permitted, within district procedures, to ask 

that their children be excused from school experiences that parents 
find objectionable. 

 
a. Building principals may excuse a student from any single school 

experience at the parent's written request.   
 

b. When appropriate, alternative experiences will be provided for 
the student by the school. 

 
4. Parents/guardians will be informed through the student handbook and 

district policies of the manner that the district will provide access to 
records of students. 

 
5. Parents/guardians will be informed of the standardized and criterion-

referenced district testing program.  Parents may request additional 
information from the building principal. 

 
6. Parents/guardians will be informed of the circumstances under which 

they may opt-out of state and federal assessments.  
 

a. In accordance with federal law, at the beginning of the school 
year, the District shall provide notice of the right to request a 
copy of this policy to parents/guardians of students attending 
schools receiving Title I funds. The District will provide a copy of 
this policy to a requesting parent in a timely manner. 
 

b. State Assessments 
 

State and federal law simultaneously require students to take 
state assessments, with few exceptions, but also permit parents 
or guardians to request to opt their students out of these 
assessments.  Approval of opt out requests is contrary to the 
mandatory testing laws, so the District cannot “approve” the 
request.  Parents who do not present their child for testing will 
result in the child receiving the lowest score possible on the 
assessment. 
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c. National Assessment of Educational Progress 

 
As a condition of receiving federal funds, the District participates 
in the National Assessment of Educational Progress (NAEP).  To 
help ensure that the District has a representative sample of 
students taking the NAEP, which will allow the District to assess 
the quality and effectiveness of its programming on a national 
level, the District strongly encourages all eligible students to 
participate. However, student participation in NAEP is voluntary. 
 
The District shall provide parents/guardians of eligible students 
with reasonable notice prior to the exam being administered.  
Parents/guardians wishing to opt their students out of the NAEP 
assessment must notify the district in writing at least three days 
prior to the exam date to ensure that the District can coordinate 
supervision and alternative activities for students who have 
opted out. 

 
7. Parents/guardians will be notified of their right to remove their 

children from surveys prior to district participation in surveys. 
 

a. The principal must approve all surveys intended to gather 
information from students before they are administered to 
students.   

 
b. Students’ participation in surveys is voluntary.  

Parents/guardians may restrict their child from participating in 
any survey. 

 
 
Adopted on: June 14, 2010 
Revised on: August 15, 2017, November 9, 2020 
Reviewed on: ________________________  
 



 

 

5054 
Student Bullying 

 
Definition of Bullying. Nebraska statute defines bullying as “an 
ongoing pattern of physical, verbal or electronic abuse.”  The Centers 
for Disease Control and Prevention defines bullying as “any unwanted 
aggressive behavior(s) by another youth or group of youths who are 
not siblings or current dating partners that involves an observed or 
perceived power imbalance and is repeated multiple times or is highly 
likely to be repeated.”  The District’s administrators will consider these 
definitions when determining whether any specific situation constitutes 
bullying.  These definitions include both in-person and cyberbullying 
behaviors.  
 
Bullying Prohibited.  Students are prohibited from engaging in any 
form of bullying behavior.  
 
Reporting Bullying.  Students who experience or observe bullying 
behavior must immediately report what happened to a teacher or 
administrator. Students may always confer with their parents or 
guardians about bullying they experience or witness, but the students 
must also ultimately report the situation to a teacher or administrator.  
 
Bullying Investigations.  School district staff will investigate 
allegations of bullying using the same practices and procedures that 
the district observes for student disciplinary matters.  In no 
circumstance will school district staff be deliberately indifferent to 
allegations of bullying.      
 
Disciplinary Consequences.  The disciplinary consequences for 
bullying behavior will depend on the frequency, duration, severity and 
effect of the behavior. 
 
A student who engages in bullying behavior on school grounds, in a 
vehicle owned, leased, or contracted by a school being used for a 
school purpose by a school employee or his or her designee, or at 
school-sponsored activities or school-sponsored athletic events may be 
subject to disciplinary consequences including but not limited to long-
term suspension, expulsion, or mandatory reassignment. 
 
Without limiting the foregoing, a student who engages in bullying 
behavior that materially and substantially interferes with or disrupts 
the educational environment, the district’s day-to-day operations, or 
the education process, regardless of where the student is at the time 



 

 

of engaging in the bullying behavior, may be subject to discipline to 
the extent permitted by law. 
 
Bullying Based on Protected Class Status.  Bullying based on 
protected class status is unique and may require additional 
investigation.  The appropriate district staff member or coordinator will 
promptly investigate bullying complaints that violate the district’s 
antidiscrimination policies. 
 
Support for Students Who Have Experienced Bullying.  
Regardless of where the bullying occurred, the district will consider 
whether victims of bullying are suffering an adverse educational 
impact and, if appropriate, will refer those students to the district’s 
student assistance team.  
 
Bullying Prevention and Education.  Students and parents are 
encouraged to inform teachers or administrators orally or in writing 
about bullying behavior or suspected bullying behavior.  School 
employees are required to inform the administrator of all such reports.  
The appropriate administrator shall promptly investigate all such 
reports.  Each building shall engage in activities which educate 
students about bullying, bullying prevention and digital citizenship.  

 
Policy Review.  The school district shall review this policy annually. 
 
 
 
Adopted on: June 14, 2010 
Revised on: August 13, 2018, August 10, 2020 
Reviewed on: ________________________ 



5001 
Compulsory Attendance and Excessive Absenteeism 

 
Required Attendance 
 
Every person residing in the school district who has legal or actual 
charge or control of any child who is of mandatory attendance age 
shall cause that child to attend a public or private school regularly 
unless the child has graduated from high school or has been allowed to 
disenroll pursuant to this policy. 
 
Mandatory Attendance Age 
 
All children who are or will turn six years old before January 1 of the 
current school year are of mandatory attendance age.  Children who 
have not turned eighteen years of age are of mandatory attendance 
age.   
 
Exceptions 
 
This policy does not apply when attendance is made impossible or 
impracticable by severe weather conditions or by the temporary illness 
of the student or a child whom the student is parenting.  
 
A child who will not reach age 7 before January 1 of the current school 
year may be excused from mandatory attendance if the child’s parent 
or guardian completes an affidavit affirming that alternative 
educational arrangements have been made for the child.  A copy of the 
required affidavit is attached to this policy. 
 
Discontinuing Enrollment – 5 Year Old Students 
 
The person seeking to discontinue the enrollment of a student who will 
not reach six years of age prior to January 1 of the current school year 
shall submit a signed, written request and to the superintendent using 
the form which is attached to this policy.  The school district may 
request written verification or documentation that the person signing 
the form has legal or actual charge or control of the student.  The 
school district shall discontinue the enrollment of any student who 
satisfies these requirements.  Any student whose enrollment is 
discontinued under this subsection shall not be eligible to reenroll in 
this school district until the beginning of the following school year 
unless otherwise required by law.    
 



 
 
 
Discontinuing Enrollment – 16 and 17 Year Old Students 
 
Only children who are at least 16 years of age may be disenrolled from 
the district.  The person seeking to discontinue the child’s enrollment 
shall submit a signed, written request and submit it to the 
superintendent using the form which is attached to this policy.  The 
district will follow the procedures outlined on the attached form in 
considering requests to disenroll. 
 
Only children disenrolling to attend a non-accredited school may be 
exempt from this policy.  The person with legal or actual charge or 
control of the child must provide the superintendent with a copy of the 
signed request submitted to the State Department of Education for 
attending non-accredited schools.  The superintendent may confirm 
the validity of the submission with the State Department of Education. 
 
Attendance Officer 
 
Each building principal is designated as an attendance officer for the 
district.  Each building principal, at his or her discretion, may delegate 
these responsibilities to any other qualified individual.  The attendance 
officer is responsible for enforcing the provisions of state law relating 
to compulsory attendance.  This responsibility includes but is not 
limited to filing a report with the county attorney of the county in 
which a student resides. Compensation for the duties of attendance 
officer is included in the salary for the superintendent or designee. 
 
Excused Absences 
 
The following absences will be considered excused if they are 
confirmed by communication to the school from the student's 
parent/guardian: 
 

1.  Physical or mental illness of the student (a physician’s 
verification is required after four (4) consecutive days of absence 
for illness)  
 

2. Severe weather 
 

3. Medical appointments for the student 
 



4. Death or serious illness of the student’s family member  
 

5. Attending a funeral, wedding or graduation  
 

6. Appearance at court or for other legal matters 
  

7. Observance of religious holidays of the student's own faith 
  
8. College planning visits 

  
9. Personal or family vacations 

 
Excessive Absenteeism  
 
When a student receives 5 unexcused absences or the hourly 
equivalent in any semester, the Attendance Officer will follow the 
attached procedure for addressing barriers to the student’s 
attendance. 
 
When a student is absent more than twenty days per year or the 
hourly equivalent and any portion of the absences is unexcused, the 
Attendance Officer must file a report with the county attorney of the 
county in which the student resides.  For example, if the student 
accumulates 23 days of excused absences due to documented illness 
and is tardy one time, the Attendance Officer must file a report with 
the appropriate county attorney. 
 
Adopted on: June 14, 2010 
Revised on: November 14, 2011, August 13, 2012, October 14, 2013, 
August 11, 2014, August 15, 2017 
Reviewed on: _________________  
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